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Trademarks
© 2022 Clarivate

All rights reserved worldwide. No part of this publication may be reproduced, transmitted, transcribed, stored 
in a retrieval system or translated into any language in any form by any means, without written permission 
from Clarivate.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

LibreOffice is a trademark of The Document Foundation.

PDF technology in EndNote is powered by PDFKit licensed under the MIT license. It is a complete PDF 
toolkit, distributed by Clarivate with EndNote desktop.

All other product and service names cited in this help file may be trademarks or service marks of their 
respective companies.

Notice regarding legal use of downloaded reference data

EndNote gives you the capability to import references from online databases and store them in your 
personal EndNote libraries. Some producers of online reference databases expressly prohibit such use and 
storage of their data; others charge an extra fee for a license to use the data in this way. Before you 
download references from a database, be sure to check the copyright and fair use notices for the database. 
Note that different databases from the same provider may have varying restrictions.
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Introduction

Overview of Clarivate EndNote

Help

EndNote Documentation Updates

Welcome to EndNote—the complete reference solution!

EndNote is a bibliography maker.

Cite While You Write™ allows you to format references in Apple Pages, Microsoft® Word, OpenOffice.org 
Writer 3.x–4.x, and LibreOffice 4.x–6.x (32-bit) for Windows. You can also create bibliographies for other 
word processors using Format Paper (RTF files). There is no better tool than EndNote for handling diverse 
bibliographic style requirements.

EndNote is an online search tool.

Search online bibliographic resources and retrieve references directly into your EndNote library. You can 
also export references to EndNote from your favorite online resource. See Direct Export Providers for more 
information about this feature.

EndNote is a reference and full-text organizer with a collaborative Web tool.

Your personal reference library will save you countless hours of organizing your research.

Group references according to your research projects and attach up to 45 files per record for 
managing related materials.

▪

Locate full-text PDF files or create a reference when importing a PDF file.▪

Synchronize references and file attachments with your EndNote online library.▪

Share groups with other EndNote users easily.▪

EndNote desktop and EndNote online are collaborative tools to simplify working with colleagues.

See the What's New in EndNote 20 video for information about the most recent features added to 
EndNote.

▪

Find useful information about EndNote at EndNote Learning.▪

For documentation updates and correction notes, refer to the Readme.txt file installed in the 
EndNote folder.

▪

For updates to the EndNote program, select Check for Updates from the Help menu in EndNote.▪
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New Features in EndNote 20

View Our What's New Video

Contacting Clarivate

Customer Care

Sales Information

Customer and Account Support (Orders, Billing, and 
Shipping)

Technical Support

Newly redesigned user interface for a better user experience▪

Tabbed interface▪

Filter groups panel by group name▪

Retraction Alerts▪

Library sharing limit raised to 400▪

Clarivate recommends that you view our What's New video on our YouTube channel.

Contact Sales for general product information, pricing, quantity discounts, and referrals to dealers.

Contact Customer Service to order new copies or upgrades of EndNote, to check billing/shipping status, and 
to register your software.

Phone: 1-888-418-1937 (toll-free in the U.S. and Canada, country code is 01) 
E-mail: https://endnote.com/buy/contact-our-sales-team

Phone: 800-336-4474, press 3 (toll-free in the U.S. and Canada, country code is 01) 
Web: https://endnote.com/contact

Contact Technical Support if you encounter problems while using EndNote. When you contact us, have a 
clear description of the problem and know the version of your Windows or Macintosh operating system and 
word processor.

To find the EndNote version and serial number, start EndNote and select About EndNote from the EndNote 
menu (Macintosh) or the Help menu (Windows).

Phone: 800-336-4474, press 4 (toll-free in the U.S. and Canada, country code is 01)▪
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EndNote Training

EndNote Downloads

EndNote Discussion Forums

For questions regarding your EndNote software, including questions about orders, billing, shipping, 
and serial numbers, go to http://endnote.com//support/contact-support.

▪

For web/email or phone contact, including hours and holiday closures, go to https://clarivate.com/ 
contact-us/support.

▪

For technical support tips, go to the EndNote User Forum at http://community.endnote.com.▪

The EndNote home page contains a Training menu that offers free training options including online videos, 
live training, an online user manual, and trainer resources. Access training material at http://endnote.com/ 
training.

To download EndNote styles, filters, and connections, go to the EndNote Downloads page.

If you wish to join an ongoing forum of EndNote users like yourself, go to http://community.endnote.com.

You can browse several EndNote message lists, easily search for topics, and join to add messages.

Join the EndNote social network at:

www.twitter.com/EndNoteNews▪

www.youtube.com/endnotetraining▪
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The EndNote Library

The Library Window

The Library Window

The Library Toolbar

Your EndNote Library is a database  for tracking all of your references and information about them. It's 
flexible, searchable, and can be used to create formatted bibliographies. You can store related files, such as 
PDFs and graphic files. If you work with colleagues, you can share your EndNote libraries with them.

When you first open a Library in EndNote, you see a Library window made up of four different panels.

The Groups and Group Sets Panel1.

The Reference List Panel2.

The Search Panel (see Searching EndNote References)3.

The Reference Panel4.

You can click on a panel to make it active.

The Library toolbar provides various commands that allow you to manage your references.
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Resizing the Library Window

Tabs in the Library

Changing the Library Display Font Size

The commands on the Library toolbar include (from left to right):

Insert Citation: This command will insert the selected references into a word-processing document at the 
location of the cursor in Word.

New Reference: Creates a new reference for data entry.

Share This Group: Allows you to share the selected group through EndNote online.

Export: Exports references in a format that can be imported into another library or application.

Find Full Text: Searches online for the full-text article for the selected references. EndNote downloads the 
file of the article and displays a paper clip in the Attachments (Paper Clip) column.

Create a Web of Science Citation Report: Creates a citation report providing aggregate citation statistics 
for the selected reference(s). (This feature requires a Web of Science™ subscription.)

Resize the Library window by clicking the window border in the lower right window corner of the library and 
dragging to the desired size or by clicking the maximize/minimize buttons in the upper corner of the Library 
window.

EndNote remembers the new size of the Library window as well as its location on the screen. The next time 
you open EndNote, the library appears with the same dimensions and in the same location as when you last 
closed it. Each EndNote library can have its own unique dimensions and screen location.

The tabbed interface allows you to work with multiple groups or references in the library. The tab will show 
the name of the group selected for that tab. Select  the New Tab  button (the + button) above the Search 
panel to open a new tab in the library, then select the group you want to work with. 

EndNote displays the recommended system font specified for your operating system.

Select a different size for the text displayed in the Library by using EndNote’s preferences. The Reference 
List and the Reference panel displays both use the font size selected in the Display Font section of 
the preferences.

See Display Font Preferences.

Note:  Changing the display font  size does  not affect the font EndNote uses when it creates a 
bibliography. EndNote uses the Normal style font of your paper for the bibliography.

Page 7 of 586

 



Clarivate EndNote 20 User Help Guide

The Groups Panel

The Reference List Panel

Changing the Display Fields

Changing the Order of the Display Fields or Adding/Removing Display Fields

Groups are subsets of references saved for easy retrieval. The left panel of the Library window lists several 
group sets that include various types of groups: automatic groups (which EndNote creates and the user 
cannot control), custom groups, smart groups, Groups Shared by Others, Find Full Text, and Online Search 
groups. See The Groups and Group Sets Panel in the Groups and Group Sets section for more information.

The Reference List displays all the references in the currently selected group. Options are available from the 
References and Library menus, and from the Library Window toolbar. See The Library Toolbar.

By default, the first column in the Library window displays a File Attachment indicator followed by:

Author▪

Year▪

Title▪

Journal▪

Last Updated▪

Reference Type▪

Reorder the fields in the Library window heading columns using drag and drop. Select a field heading and 
move it to the desired location in the column headings. For example, you can move the Last Updated field to 
be the last field or the first field in the heading column. Your changes are reflected in the Display Fields 
preference dialog.

Customize which columns/fields display in the Library reference list by right-clicking on the column headings 
to display a contextual menu. Select or remove fields.

You can change the order of the fields, add fields, remove fields, or change the name of a field in the column 
headings of the Library window. See Display Fields Preferences for more information.

From the Edit menu, select Preferences.1.

Click the Display Fields option in the list.2.

Select the desired field from the Field list. You may select up to ten fields to be displayed in the 
Library window. Select [Do not display] instead of a field name if you want to show fewer than ten 
fields.

3.

By default, the column heading in the Library window is the same as the Generic name of the field 
(the Figure field is indicated by a figure icon and  the File Attachments field is indicated by a paper 

4.
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Changing the Reference List Sort Order

Navigating in the Reference List

clip icon). To change the field name for the Reference List display, enter a new name in the Heading 
section next to the chosen field.

To display all author names under the Author heading in the Reference List, select the checkbox next 
to the Display all authors in the Author field. Leave this box unchecked if you only want to see the 
last name of the first author in the column.

5.

Click OK to save your changes and to close the Preferences dialog.6.

Note: These settings apply to all libraries.

See also Display Fields Preferences.

By default, the references listed in the Library window are sorted by the first author’s last name.

Change the sort order by selecting Sort Library from the Library menu or by clicking the column headings. 
When you sort a library, that sort order is retained even after you close and reopen a library. See Sorting the 
Library for more information about sorting.

When you sort the library, character sorting is carried out according to the language and local settings of 
your operating system—unless you specify a different language in the Sort Options dialog. This determines 
whether a plain "a" is sorted before or after "ä."

EndNote does not remember the sort order for all groups. EndNote displays the results of a search in the 
order in which they are found. Similarly, after importing references, EndNote displays the newly imported 
references in the order in which they were imported. This behavior greatly enhances the speed of these two 
functions. Selecting the Show All References group shows all references in the Library window and lists 
them according to the last sort order specified.

Note:  See Sort Order: Bibliographies and Multiple Citations  about how to set the sort order for a 
bibliographic style. See Sorting Preferences for information about having EndNote ignore certain words or 
names when sorting references.

There are a number of ways to browse through your references.

Scroll through the list of references in the Reference List by clicking in the vertical scroll bar with the 
mouse.

▪

Use the Up and Down arrow keys to move up or down the reference list.▪

Sort references in the list by clicking on a column heading. For example, click the Year heading to 
sort the references by descending or ascending year.

▪

Type a letter to select the first matching reference. Matching depends on the order in which the 
library is sorted. If the library is sorted by the Author field, typing a letter selects the first reference in 
which the first author’s last name begins with that letter. 
 
For example, typing the letter "Z" selects the Zorina reference in the sample  library since Zorina is 

▪
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The Search Panel

The Reference Panel (Formerly The Tabs Panel)

The Summary Panel

The Preview Subpanel

Choosing the Current Style

the first author’s name to begin with a "Z." Type several letters and the selection jumps to the first 
name that begins with those typed letters. Letter matching starts over after a half-second pause.

On extended keyboards, the Home and End keys go to the first or last reference, respectively. The 
Page Up and Page Down keys allow you to move up or down the reference list.

▪

The Search panel allows you to search your EndNote library, and is also used for searching online 
databases from EndNote.

The Simple Search option displays a single line where you can enter a search term and search all fields.

Click on Advanced search  to display multiple search lines. With this option you can create advanced 
searches by selecting each field you want to search and entering the terms you want to search for in that 
field.

To begin a search of your EndNote library, select the search option, then select the group of references you 
want to search. To search your whole library, select the All References group. Enter your search term(s) and 
press the Enter key on your keyboard to see the list of found references.

To begin a search of an online database, click on the database name in the Groups panel under Online 
Search or go to the Tools  menu and select Online Search. See Searching Online Databases  for more 
information.

The Reference panel includes three options, formerly called "tabs," which open up the following panels: 
Summary, Edit, and PDF.

The Summary panel contains a Summary subpanel, showing a summary of the reference at top, and a 
Preview subpanel at bottom, showing how the selected reference would appear in the style of your choice. 
The size of the subpanels can be changed by dragging the line separating them.

Select the Preview subpanel to view the formatted style of the selected reference.

Note: The Preview subpanel may originally show only the top toolbar, where you can select the style for 
the preview. Drag it up to see more of the preview, or click the chevron button ( ).

The preview displays the selected reference in your current style. If multiple references are selected, it 
displays just the last one in the selection. Fields within the Preview feature are not editable. To edit the 
reference, select the Edit panel.

The Preview panel uses the current style. To select another style:
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Previewing Multiple References

Using the Preview Feature to Display Notes or Abstracts

The Edit Panel

On the Preview toolbar, shown between the Summary and Preview subpanels, use  the drop-down 
Output Styles menu to select a new style.

▪

From the Tools menu, select Output Styles, and select a style in the list. The check mark next to a 
style name indicates that it is the current style

▪

EndNote provides over 7,000 styles. Although not all styles are installed with a default installation, you can 
add more later. Styles installed on your computer are available from the Style Manager. Go to the Tools 
menu, select Output Styles, and then select Open Style Manager. Mark the style or styles that you would 
like to see in the Output Styles menu. You should now be able to select the style that you need from the 
Output Styles menu. For more information, see The Style Manager.

The Preview panel displays a preview for only one reference at a time, formatted according to the current 
style. To preview multiple references:

Select (highlight) the references in the Reference List.1.

From the References  menu, select Copy Formatted Reference  to copy the formatted references to 
the Clipboard.

2.

Use the Clipboard Viewer to view the contents of the Clipboard or paste the formatted references 
into a word processor document.

3.

You may find it useful to configure the Library window so that the reference list displays bibliographic data 
(such as author, year, title, and journal) and the Preview subpanel displays notes or abstracts. That would 
allow you to browse through the references in the Reference List without having to move through the Edit 
panel of individual references to see more about them.

To get the preview to display notes or the abstract, you will need to create a custom style to include just 
those fields.

You can use the Show All Fields style to display all reference fields in the Preview subpanel.

Select Edit from the Reference panel to edit the contents of the selected reference.

Enter text in a field by clicking on the field. All edit commands are available via the menus including context- 
sensitive menus. Right-click in the reference to display common options such as Cut, Copy, and Paste.

Open the context-sensitive menu to view the following options.

Revert Reference▪

Cut▪

Copy▪

Paste▪

Paste with Text Styles▪

Select All▪
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Navigation Keys

The PDF Panel

The PDF Panel

Authors Term List▪

Keywords Term List▪

Journals Term List▪

Spell Check▪

OpenURL Link▪

URL▪

The Tab key allows you to move to the next field in the Edit panel in order to edit the contents of a 
field.

▪

The Shift+Tab keys allow you to move to the previous field within the Edit panel.▪

Select PDF to view and annotate attached PDF files.

EndNote allows you to open, preview, and annotate PDF files within the PDF panel. Select a reference from 
the reference library, and then select the PDF panel to view a PDF file.

If no PDF files are attached to the reference, EndNote displays a "No PDFs attached to this reference" 
message in the PDF panel. In this instance, you can begin attaching PDFs to the reference by clicking the 
Attach PDF button, and then selecting Attach File from the menu.

Note: Although the button to attach files is called Attach PDF, many file types can be attached to an 
EndNote record. If attaching another type of file, the file can be opened in its default application from the 
Edit panel.

EndNote allows you to view and annotate PDF files within the PDF panel. Select a reference with attached 
PDFs, then select PDF in the Reference panel to view a PDF file. If there are multiple PDFs attached to a 
reference, you can select a PDF from the drop-down list of attached PDFs.

If you want to open the PDF in a larger window, in the PDF panel click Open this PDF in a separate window 

 ( ) to open the PDF in the PDF Viewer, a window you can resize..

Note: The PDF panel is within the Reference panel, the PDF Viewer is a separate window that can be 
resized or shown full screen.

To open a PDF file  attached to a reference in an application  other than EndNote, select Edit  in the 
Reference panel, navigate to the File Attachments field, and select the option to Open with… from the drop- 
down list.

If there are no PDFs attached to a reference, you will see an Attach PDF button in the PDF panel.
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Attaching PDF Files

Using the PDF Toolbar(s)

Note: Although the button to attach files is called Attach PDF, many file types can be attached to an 
EndNote record. If attaching another type of file, the file can be opened in its default application from the 
Reference Edit panel.

You can attach PDF files and view them in the PDF panel in various ways.

Click the Attach File button near the File Attachments field in the Edit panel.▪

Click the Attach File button at the top of the Summary panel.▪

If the reference has no attached PDFs, click the Attach PDF  button in the PDF  panel to open a 
Select File dialog.

▪

If the reference has attached PDFs, select Attach PDF… from the drop-down list in the PDF panel.  ▪

Select a reference in the References List, select References  > File Attachments  > Attach File  to 
open a select file dialog.

▪

Select a reference. Press Ctrl+Alt+A to open a select file dialog.▪

Click the Save PDF icon in the Edit panel to save your work. You can also navigate to another reference and 
EndNote will prompt you to save your work.

A toolbar appears within the PDF panel that displays the following options.

Move your cursor over an icon on the toolbar to see Alt text to explain its function.

If you open a PDF document in the PDF Viewer, you will see the following toolbar. You can move to the next 
or previous page, zoom and select text, and use various tools such as Find  to work within the PDF 
document.

Click the Markup/annotation button ( ) to open the Markup/annotation toolbar, with commands for editing 
the PDF. Use this toolbar to add annotations, highlight text, underline text, or strikeout text.
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Using the Find Feature

Using the Markup/Annotation Toolbar

Other PDF Toolbar(s) Commands

Select the magnifying glass icon to open the Find feature. This feature allows you to search for words and 
phrases within a PDF document. Enter your terms in the text box and press Enter. Use the Next  and 
Previous buttons to find the next/previous instance of a search term.

The Find  feature only searches within the currently open PDF. You cannot use this feature to search the 
reference fields in the Reference Edit panel or to search other PDF files that are attached to the current 
reference.

The Find  feature highlights and returns matches that contain the search query followed by any other 
characters. For example, searching for "reduc" will find "reduce," "reduced," or "reducing."

Using the Markup/annotation toolbar, you can add annotations (sticky notes), highlight  selected text, 
underline selected text, or strikeout selected text within a PDF. Hover over the buttons to identify the 
commands available.

Add a Comment (a sticky note): Select the Add a sticky note button, click in the location in the PDF where 
you want to add a comment. A small comment icon will appear in the PDF. Double-click on the icon to open 
the Comment window, type in your text, then click the Close  button to close the comment. It will again 
appear as a small icon until you double-click it to see the comment.

Notes: You cannot move  sticky notes in a PDF. Sticky  note comments are searchable using the "Any 
Field + PDF with Notes" or "PDF Notes" options in the Advanced Search panel, or when using the Simple 
Search panel.

To Highlight, Underline, or Strikeout Text: Select the text you want to annotate in the document, then 
select the appropriate command on the Markup/annotation toolbar.

To Delete an Annotation: Right-click on  the annotation to open a contextual menu, and then select the 
Delete Annotation option.

To Hide the Annotations: Right-click within the PDF to display a contextual menu. Select the Hide Notes/ 
Markup  option from the menu. To show the annotations again, Right-click within  the PDF and select the 
Show Notes/Markup option.

Rotate PDF: This command will rotate the PDF counter-clockwise or clockwise.

Save changes to this PDF: This will save any annotations you have made to the PDF in a format that can 
be read by most PDF applications. This means you can send a copy of the annotated PDF to others and 
they should be able to read your annotations.

Print this PDF or pages from this PDF: This command allows to print all of your PDF or just the pages you 
choose.

Attach a copy of this PDF to an email: This command will open up your desktop email application and 
create a new email with a copy of the PDF attached.
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Important Points About Libraries

Note: The Attach a copy of this PDF to an email feature will not work with online email systems, only 
desktop applications.

Listed below are some important points about the EndNote library.

You can create up to 999,995 references in an EndNote library. However, it is recommended that the 
number not exceed 50,000 to maintain efficient database performance.

▪

There is no limit to the number of libraries you can create, assuming that you have the disk space to 
store them. We recommend that you keep all the references you cite in your papers in one primary 
library.

▪

You can select default libraries to open automatically when EndNote is started.▪

You can open more than one library at a time.▪

Libraries created with the Windows version of EndNote can be used by the macOS version of 
EndNote and vice versa (see Transferring Libraries between Computers or Platforms).

▪

Each library can be independently moved, copied, or deleted using the Windows Explorer. Always 
move, copy, or delete both the main .enl file and the .Data folder; otherwise, you can lose reference 
data.

▪

Figures, Groups, and other significant files are stored in a [library name].Data folder which is in the 
same folder as your main library file. This folder is an extension of the library, so remember to move, 
copy, or delete the associated .Data folder along with the main library file.

▪

Library filenames include the extension .enl. If  your library filename does not include an .enl 
extension, Windows Explorer may not be displaying file extensions. You can change this setting in 
Windows Explorer if you wish.

▪

If you wish to rename a library, it is best to save a copy of the library with the new name, then use 
the copy you created instead of the original library. When you are sure the new library is working 
correctly, you can delete the original library.

▪

The Library window can be resized and the display font size can be changed.▪

The Reference List displays a multi-column reference list. This list can be customized to meet your 
needs.

▪

The record number displayed in an EndNote record is not a permanent number. It will change if the 
record is copied between libraries, cut and pasted within the same library, or synchronized using 
EndNote online.

▪

Note: Changes made to the library you are syncing with EndNote online can have consequences for your 
online library and any other EndNote libraries that are syncing to that online library. Do not move or 
rename libraries used with Sync. When syncing a library on a new computer, it is best to use an empty 
library to avoid creating duplicates of your references.

You can change the order of the fields, add fields, remove fields, or change the name of a field in the column 
headings of the Reference List display. See Display Fields Preferences for more information.
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The Sync Feature

I Already Have an EndNote Online Account

I Do Not Have an EndNote Online Account

Your purchase of EndNote desktop entitles you to a two-year free subscription to EndNote online—our Web- 
based version of EndNote.

The Sync feature allows you to synchronize the references (including file and figure attachments) in one 
EndNote desktop library with the references in your EndNote online library. You must register and have an 
active EndNote account to initiate the Sync process.

The Sync feature provides an online backup of all your references and attachments for your current library, 
as well as providing access to your references from anywhere through EndNote online.

Click Sync Configuration  in the Groups  panel to go to a Sync Configuration dialog.Click the Sync 
Now button to go to an EndNote Login dialog.

1.

Enter your EndNote account email address.2.

Enter your EndNote account password.3.

Click OK.4.

Read the terms and conditions, then click Agree to accept the terms and conditions, and to link your 
account to your new copy of EndNote.

5.

Click Sync to begin synchronizing your EndNote online library with your EndNote library.6.

Since you already have an EndNote account, EndNote populates the fields on the Sync Preferences page 
with the e-mail address and password that you entered on the EndNote online login dialog. You can change 
the data in these fields if you ever change your email address or password.

Note: The Sync library that you defined in Sync Preferences must be open and currently active to perform 
the Sync process.

Since you do not have an EndNote account, you must create one. Registration is fast and easy and 
activates your two-year EndNote account enhancement when completed.

Click Sync Configuration in the Groups panel to go to a Sync Configuration dialog.1.

Click the Sync Now button to go to an EndNote Login dialog.2.

Click the Sign Up button to go to an EndNote Registration dialog.3.

Enter your email address in the EndNote Registration dialog. Retype your email address, and then 
click the Submit button.

4.

Enter your name and a secure password, read the EndNote End User License Agreement, then click 
the Agree button if you wish to create your account.

5.
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Library Management

Back Up Your Libraries

Saving a Copy of a Library

Click the Sync button to begin synchronizing your EndNote online library with your EndNote library.6.

Before synchronizing for the first time, you will be prompted to create a compressed library backup. 
Click the Yes button to create the backup.

7.

Choose the location for your backup, then click the Save button.8.

EndNote will save the backup and begin synchronizing your library references.

Once you create your EndNote account, EndNote populates the fields on the Sync Preferences page with 
the email  address and password that you entered during registration. Later you can change the data in 
these fields if you ever change your email address or password.

Note: Although it is possible to synchronize your library without creating a compressed library backup 
during your first synchronization, we suggest creating the backup. You can also create a compressed 
backup of your library at any time. See Saving a Compressed Copy of a Library for more information.

Your EndNote library becomes increasingly valuable to you as you add references to it. Consequently, it is 
imperative that you back up your libraries, along with any other important documents. Each library is made 
up of a file with the extension .enl plus a corresponding .Data folder. Always back up both the .enl file and 
the .Data folder.

Use the Save a Copy command or one of the Compressed Library commands to save a copy of your library 
to a removable disk (or elsewhere) for safekeeping. See Backing Up Your EndNote Files  for more 
information about making backup copies of your files. See Saving a Compressed Copy of a 
Library and Saving a Copy of a Library for ways to back up your library.

EndNote automatically saves changes to your library as you work with it, so there is no Save or Save As 
command for the library. You can, however, use the Save a Copy command to create an exact copy of your 
library.

To create a copy of your library:

With a library open, select Save a Copy from the File menu.1.

Name the new library and choose where to save it.2.

Click Save and EndNote creates a copy of the library.3.

The new library does not open, it is saved to disk, where you can then open it with EndNote. EndNote 
leaves your original library open as it was before the command was chosen.

Note: The Save a Copy command creates a [library name].enl file as well as a [library name].Data folder 
for the new library, and copies all necessary files and figures to it.
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Saving a Compressed Copy of a Library

Creating a Compressed Library File

The Sync Feature provides a backup of your current library, but if you have deleted references from your 
library and emptied the trash, they will also be deleted from the online copy of the library; if you have deleted 
references from the online library and emptied the trash, they will be deleted from the EndNote library at the 
next sync. Making a backup of your library at regular intervals ensures you have access to older material, if 
you ever need it.

You can save an EndNote library, including the filename.enl file, its associated .Data folder, and all of its 
contents, to a single compressed file in order to back up your library or to send a copy to a colleague. Later, 
you can restore the compressed library with EndNote.

Note: EndNote libraries larger than 4 gigabytes or 65,535 files cannot be compressed with EndNote’s 
Compressed Library command. See Saving a Copy of a Library for information on making backup copies 
of larger libraries.

Open the library in EndNote.1.

From the File menu, select Compress Library (.enlx) to display a Compress Library dialog.2.

Use the radio buttons to determine these options:3.

Specify whether you want to Create a compressed library or to Create & Email the library.▪

Specify whether you want to save file attachments with the library or not.▪

Specify whether you want to save all references to the compressed library, only selected 
references, or only the references in a specific group or group set.

▪

Click Next to display a file dialog.4.

Save the compressed library to a folder on your hard drive. You can change the file name but you 
cannot use the following characters.

5.

Invalid Characters for Naming 
a Compressed Library

\  back slash
/  forward slash
:  colon
*  asterisk
?  question mark
"  quotation mark
<  less than
>  greater than
|  vertical bar

If you selected the Create & Email option, EndNote will launch your default email application, create 
a new email, and attach the compressed library file to the email. Enter additional information to the 
email, such as a recipient, subject, and message. Click the Send button.

5.
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Restoring a Compressed Library File

The Library Summary

Setting a Favorite Library

Note: The Create & Email option will only work with desktop email applications. It will not work 
with online email sites. Emails attachment sizes may also be restricted by your email provider.

Use EndNote to open the filename.enlx file, which will extract the .enl file and the .Data folder to the same 
folder where the .enlx file is located.

After restoring the compressed library, use EndNote to open the filename.enl file as you normally would to 
use the library.

Note: Be careful not to open the compressed library in the same location as an original library of the same 
name. This would overwrite the original library's .enl file and .Data folder when the compressed library is 
uncompressed.

To see a summary of statistics about the currently open library, go to the Library menu and select Library 
Summary.

If you wish to save and print this information, use the Copy text to clipboard button and then paste the text 
into a word processor document.

For a list of statistics about a specific reference, see Reference Summary.

EndNote allows you to specify the libraries that you want to open automatically when EndNote starts up. We 
call these the "favorite" libraries.

You do not need to select a favorite library. By default, EndNote will open the last used library.

To assign or change the favorite library:

Open the library (or libraries) that you would like to set as your favorite(s). You must have a library 
open in order to set it as your favorite library.

1.

From the Edit menu, select Preferences, and then select Libraries.2.

In the drop-down list at the top of the window, select Open the specified libraries.3.

Click Add Open Libraries  and all of the currently open libraries will be added to the list of favorite 
libraries that should open every time EndNote starts.

4.

Click OK to save your changes and close the Preferences dialog.5.

To remove a library from the list of favorite libraries:

From the Edit menu, select Preferences and select Libraries from the list of options.1.
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Opening a Library

Closing a Library

Deleting a Library

Select the library that you would like to remove from the list of favorite libraries and click Remove 
Library. (This will only remove the library from your favorites list, it will not delete the library.)

2.

Click OK to save your changes and close the Preferences dialog.3.

To open a library when the EndNote program is already running, select Open from the File menu and select 
Open Library. If you have previously opened a library, you can use the Open Recent list to open a recently 
opened library and skip the dialog below.

When you select the Open Library command, EndNote displays a file dialog.

By default, this dialog displays all files with an extension .enl, .enlx, .enlp, or .lib. (.lib was the extension for 
very early versions of EndNote.) If your library name has a different extension, you should change the Files 
of Type option to All files (*.*). If your library is listed in the dialog, select it and click Open. If your library is 
not listed there, then it is probably saved in a different place on your hard drive or removable disk.

To locate a library not on the list, use your operating system's search feature to look for files ending 
in .enl, .enlp, or .enlx. Note the location of the file, then use the File > Open Library command in EndNote to 
locate and open the file.

When you open a compressed library (with the extension .enlx), EndNote uncompresses the files and opens 
the uncompressed version (with the extension .enl). After uncompressing a library, you should open the .enl 
file, not the .enlx file.

To close a library, do one of the following:

From the File menu, select Close Library.▪

Type Ctrl+W when the Library window is active.▪

Click the Close button in the top right corner of the Library window.▪

Type Ctrl+Shift+W to close all open libraries.▪

EndNote saves changes to references in your library as you work. As a result, closing the library does not 
invoke the familiar "Save changes?" question unless changes to a reference you were working in have 
not been saved. EndNote will ask if you want to save changes to the open reference, but not changes to the 
library as a whole.

Closing the only open library will quit the EndNote program. If you want to quit from EndNote, select Exit 
from the File  menu or type Ctrl-Q . Exit  from the File  menu and any open libraries are saved and closed 
automatically.

You can delete an EndNote library in one of two ways.

One option is to exit EndNote and delete the library file and its associated .Data folder by dragging the icons 
to the Recycle Bin.
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Moving a Library

Recovering a Damaged Library

The other option is to delete a library from within EndNote.

Close the library, but keep EndNote open.1.

From the File menu, select Open and then Open Library.2.

In the file dialog, select the libraryname.enl file, right-click and select Delete from the menu.3.

Next, highlight the libraryname.Data folder, right-click and select Delete from the menu.4.

Click Cancel to close the file dialog.5.

Each EndNote library  can be independently moved using the File Explorer. When moving a library, we 
recommend that you move both the main .enl file and the .Data folder.

If you move an .enl file without moving the corresponding .Data folder, EndNote will try to recreate the .Data 
folder to accompany the .enl file the next time you try to open the .enl file. However, you may lose data, 
including PDF file attachments, term lists, and even reference information.

EndNote will display an Alert when you try to open the .enl file without the corresponding .Data folder that 
includes the text below:

You are attempting to open an EndNote Library without its associated .Data Folder. This is not 
recommended because it may result in the loss of data including, but not limited to: reference information, 
file attachments, and term lists. 
 
In order to prevent the loss of data you should locate the original .Data folder and copy it to the same 
location as the EndNote library you are attempting to open. The .Data folder was created in the same 
directory in which the EndNote library was originally created.

We recommend that you click Cancel and go find and move your original .Data folder before attempting to 
open a moved library.

Note: Please do not move or rename your EndNote library files after they are synchronized, as this will 
break the link to the Sync target library.

See also Important Points About Libraries

If an EndNote library gets damaged, you may get an error message when trying to open it or work with the 
references. The best way to protect yourself from damaged files is to make regular backup copies of your 
important files and documents (see Backing Up Your EndNote Files). If you do not have a backup copy of a 
damaged EndNote library, you can use the Recover Library command to repair the damaged file.

Note: If you have synced the damaged library, we suggest contacting EndNote support  for information on 
recovering a synced library safely.

To repair a damaged EndNote library:

Close the library if it is currently open.1.
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Differences Between Saved Libraries and the Original

Find Broken Attachments Links

Fix or Remove Broken Attachment Links

From the Library  menu, select Recover Library. Read the information about the Recover Library 
command, and click OK.

2.

In the dialog that appears, locate and select the library that needs to be repaired, and click Open.3.

EndNote creates a copy of the library with the suffix "-Saved" added to the name. For example, if you were 
repairing a library called "References" the original library would remain untouched and a new, repaired 
library called "References-Saved" would be created in the same location.

Once the new library has been saved, you should be able to open it and use it in place of the damaged 
library.

The purpose of the Recover Library command is to recover as many references from the original library as 
possible. This means that it may also recover references that had previously been deleted from the library, 
but not yet emptied from the Trash. If there are more references recovered in the saved library than existed 
at the time the original library was damaged, it means that EndNote was able to reconstruct references that 
had recently been deleted. These references must be deleted again.

Term lists are not recovered with the library. Consequently, you will need to rebuild each term list  by 
selecting Define Term Lists  from the Library  menu, highlighting the list, and then clicking Update List  to fill 
the term list with the terms used in your library. For the Journals term list, you may find it a better option to 
import one of the predefined term lists instead of using the Update List feature.

Broken file attachment links occur when EndNote cannot locate the file in the path specified in the File 
Attachment field. In these instances, EndNote cannot display or index the attached file or include the file 
when compressing a library.

To find broken file attachments in the currently open library, go to the Library menu and select Find Broken 
Attachment Links.

EndNote finds all references with broken file attachment links and displays them in the Library window. In 
the Groups panel, EndNote creates a new group called Broken Attachments.

This situation may occur when you:

Open a library that has one or more broken file and figure links.▪

Import a library that has one or more broken file and figure links.▪

Open a library without the accompanying .Data folder that contains the PDF files.▪

Transfer PDFs and figure files using the Sync function and EndNote finds one or more broken file 
and figure links.

▪

To fix broken links, delete the link for the broken attachment and reattach the original file.
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Sorting the Library

Special Cases in Sorting

Author Names

To remove broken attachment links, select Remove Broken Attachment Links  from the Library  menu. 
Removing broken links using this command cannot be undone, so you may want to create a backup of your 
library first. See Saving a Compressed Copy of a Library  and Saving a Copy of a Library  for methods of 
backing up your library.

The Sort Library command provides a way to arrange all references showing in the Reference List for 
browsing, exporting, printing, or copying.

By default, the references in the list are automatically sorted by the first author’s last name.

You can change the sort order by selecting Sort Library… from the Library menu or by clicking the column 
headings. When you sort a library, the sort order is retained even after you close and reopen a library.

To change the sort order:

From the Library menu, select Sort Library…1.

Select one or more field  names from the menus. Enter the field names in the order you want the 
references sorted. You do not have to use all five options.

2.

Click the button to the right of each field to indicate ascending or descending order.3.

Click OK.4.

The Sort Options dialog is initially set to sort the library by author names, in alphabetical order, and then 
references published by the same author are sorted by year (from oldest to newest).

Note: EndNote reads the default language setting from your operating system and uses it as the default 
language for character sorting. However, you can override the default language from this dialog.

Except for title fields, quotation marks, parentheses, and other punctuation marks are considered during a 
sort. In an alphabetic sort, punctuation comes first, then numbers, then letters A-Z.

If the field you selected to sort by is empty in a particular reference, or not included in the selected reference 
type, that reference will sort before the other references in ascending order.

When you select the Author field for sorting, author names from the first Author field are sorted by last name 
first, then first initial. Next, author names from the Secondary Author field are compared for sorting. Then, 
author names from the Tertiary Author field are compared for sorting.

If a reference has more than one author in a single field, EndNote includes the additional authors in the sort 
(up to 255 characters) before moving on to other fields.

If you select the specific First Author field to sort, only the surname is used for sorting.
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Titles

Sorting Diacritical Characters

Creating a New Library

If your EndNote library includes author names with connectives such as de, di, van, and von, you may want 
EndNote to skip these parts of the name in order to sort the references by the principal element of the 
surname. See Sorting Preferences.

When sorting by title fields, EndNote ignores the words A, An, and The as well as punctuation at the start of 
the titles. You may enter additional words that should be ignored for sorting purposes when they appear at 
the beginning of a title. To do so, see Sorting Preferences.

Characters with diacritics are sorted differently in English, Spanish, Swedish, and other languages. EndNote 
reads the default  language (or locale) setting from your operating system and uses it as the default 
language for sorting. EndNote typically sorts diacritical characters according to the rules of the language 
selected for your operating system; however, you can override the default language setting on the Sort 
Options dialog.

Although you can create as many libraries as you like, we strongly recommend that you keep all of your 
references together in one main EndNote library. Having all of the references you need in one place avoids 
unnecessary complexity when you are writing papers, creating bibliographies, or moving files between 
computers. Instead of making different "specialty" libraries, you will find it more useful to create one library 
and use Groups to help you organize and categorize your references. You can also use the Keywords and 
Label fields to assign terms to references, and easily assign them to a smart group or find them with 
EndNote’s Search and Sort References commands.

To create a library:

From the File menu, select New.1.

EndNote presents a dialog prompting you to name and save the new library.2.

By default, EndNote will call the new library "My EndNote Library," but you can change the name. 
Enter a name for your new library. Using a unique name for your library will make it easier to identify 
if you ever have to work with multiple libraries, or with libraries others have given to you. Do not 
include an extension, EndNote will add the ".enl" extension  for the main library file and the ".Data" 
extension for the linked Data folder automatically.

3.

Select the location where you would like to save the library. For simplicity, we suggest that you save 
your EndNote libraries in your Documents folder.

4.

Click Save and the new library appears as an empty EndNote library.5.

Note: Do not save EndNote libraries in any cloud-syncing folders or drives. Cloud-syncing programs can 
corrupt EndNote libraries over time. The only suggested method for syncing EndNote libraries is through 
EndNote online.

Now that you have created a new library, you can begin entering references into it. The following topics 
illustrate the different ways to add references to an EndNote library:

Creating a New Reference discusses how to enter individual references manually.▪
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Merging Libraries

Merging Libraries through Sync

How to Search an Online Database  describes how to connect directly to online databases and 
retrieve references from them.

▪

Importing Reference Data into EndNote  shows you how to import references that you have 
previously downloaded from online bibliographic databases.

▪

If you have just created the library that will be the main library you use, you can set it to open automatically 
every time you start EndNote by setting it to be your "favorite library" (see Setting a Favorite Library).

There are two ways  to merge complete libraries: Merging Libraries through Sync  or Importing EndNote 
Libraries to import one library into another. (For information on copying selected references from one library 
to another, see Copying and Pasting Complete References.)

Any time you add references to a library, the newly added references are assigned new record numbers in 
the order that they are added to the library. This means that a reference that was #23 in a smaller 
library could become #600 in a larger library.

Note: Before merging libraries, we strongly suggest making a backup copy of the library into which you 
are transferring references. See Saving a Compressed Copy of a Library  for information on creating a 
backup.

If you sync a new EndNote library  to an EndNote online  account that contains references in it, the 
references will be merged together into a single library, and the last library you synced to your EndNote 
account will become the library you use for syncing from that time on. The advantage of this method of 
merging libraries is that all the references, group sets, and groups from both libraries will be included in the 
merged library. The disadvantage is that references that exist in both original libraries will be duplicated.

Steps to merge two libraries together using Sync:

If you have previously synced a library, close that library in EndNote, then proceed to step 3.1.

If you have not previously synced a library, open the library you do not  want to use for your final 
synced library in EndNote and follow the instructions in The Sync Feature to sync the library to your 
EndNote account. After syncing, close that library.

2.

(Optional) To identify which references were in each original library, before syncing you might find it 
helpful to create a custom group containing all the references in each library and labeling it with 
something like "All from [original library name]." The groups would need to be created before syncing 
any libraries, with all the references in a given library added to that group.

3.

Open the library you want to merge with the previously synced library. Please note this will be the 
library that you will sync in the future.

4.

Select Sync Status in  the Groups  panel. A message will be displayed saying, "You already have a 
synced library. If you choose to sync this library, it will be merged with your existing synced library..."

5.
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Importing EndNote Libraries

Click the Sync Now button. A warning will appear saying, "Warning: You are about to sync or share a 
library that is different than the last library you synced. This will merge the libraries. Do you wish to 
proceed?" If you wish to merge the libraries, click the Yes button.

6.

You will be asked if you want to create a backup of the library. We suggest clicking Yes to create a 
backup before syncing. If you chose Yes to make a backup, save the backup and the sync process 
will begin; if you chose No, the sync process will begin immediately.

7.

When the sync has finished, you will see all the references, group sets, and groups that appeared in both 
original EndNote libraries. Be sure to use this library in the future for syncing.

Note: If you had previously set another library as a favorite to open when starting EndNote, you may wish 
to make your merged library the favorite instead. You can find instructions for this in Choosing a Library to 
Open.

The advantage of using the Import command to combine libraries is its ability to filter  out duplicate 
references during the import operation.

Note: Before merging libraries, it is a good idea to make a backup copy of the library into which you are 
transferring references. See Saving a Compressed Copy of a Library for information an making a backup.

To import an EndNote library into an EndNote library:

Open the library into which you want to import the references.1.

From the File menu, select Import > File.2.

Click the Choose button. Locate and select the library you want to import, then click the Open button.3.

From the Import Options, select EndNote Library.4.

Select an option from the Duplicates list:5.

Import All: Imports the references, including duplicates.▪

Discard Duplicates: Imports the references, except duplicates.▪

Import into Duplicates Library:  Duplicate references are imported into a library called File- 
Dupl.enl, where "File" is the name of the library into which you are importing. 
 
By default, a reference is considered a duplicate when the Author, Year, Title, and Reference 
Type match a reference already in the library. See Duplicates Preferences if you would like to 
change the duplicates criteria.

▪

Set the Text Translation  option to No Translation. Extended characters, saved as Unicode  in 
EndNote, will transfer correctly.

6.

Click Import to import the file.7.

Note: The time required to import an EndNote library is proportionate to the size of the library.
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About Shared Libraries

To begin sharing:

The Share Dialog allows you to do the following:

Inviting People to your shared library:

When the import is complete, the library displays the contents of the Imported References temporary group. 
This is the time to add a keyword to each imported reference with the Change Fields command or to peruse 
the imported data to make sure it imported as expected. Make sure to check references that contain 
extended characters.

EndNote 20 offers users the option to share your entire sync library with up to 399 other users.  

Library sharing provides entire teams with immediate and real-time access to an entire EndNote library, 
meaning the same set of references, attachments, notes, and annotations. Changes are sent and received 
via sync, so all members of the shared library need to have the desktop activated with sync preferences 
completed, and be connected to the internet in order to send and receive changes. Library sharing is 
recommended as an alternative to saving a library on a shared drive, or emailing a compressed copy 
around to a group of collaborators.

Notes: The EndNote database  engine was upgraded in EndNote X9.3. This means EndNote X9.2 or 
earlier cannot open libraries created in EndNote X9.3 or later. However, libraries from EndNote X9.3 or 
later can be shared through EndNote Sync with users of EndNote X9.2 or earlier without problems. 
 
Libraries are synced approximately every 15 minutes, so members may not all see changes immediately 
after they are made.

Select Share… from the File menu.

You will be presented with the Share Dialog, where invitations can be sent.

Invite people to have access to your Shared Library.▪

Check the status of your invitations.▪

Resend (remind) prior recipients of invitations.▪

Add or change access level for colleagues invited to share your library.▪

Remove colleagues from your Shared Library.▪

Open your synced library.1.

Select Share… from the File menu.2.

If you are not logged into EndNote online, you will be prompted to log in.3.

The Share dialog will pop up.4.
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Being Invited to a Shared Library

If you have an EndNote Online account:

If you do not have an EndNote Online account:

How to open a library that was shared with you:

The Shared Library Activity Feed

Enter the email address (or addresses, separated by commas) of the people that you would like to 
invite in the box under Invite more people.

5.

For each invitee, use the Permission drop-down to select the desired access level: Read & Write or 
Read Only.

6.

If desired, enter an optional message in the Add a message box.7.

Click the Invite button.8.

Once users have accepted the Shared Library invitation, their activity in that library will be reflected in The 
Shared Library Activity Feed.

You can remove or change a person's access to your library by clicking the Settings button (the gear) next 
to their name.

When you are invited to a Shared Library, you will receive an email.

Click on the Accept button,  and a browser window should appear.

Log in using your existing user name and password.

Create your account,  using the on-screen instructions.

From the File menu,  select Open Shared Library…1.

Click on the desired shared library,  based on the sharer's email address.2.

Click the Open button.3.

Note: Libraries shared with you will always show the email address for the owner's EndNote account as 
the name of the library. This library name cannot be changed.

The Shared Library Activity Feed provides Shared Library members with insight into who is doing what to 
the shared library, as well as when new members join.

Each Shared Library comes with an Activity Feed, both the library you are sharing with others, and those 
libraries that others have shared with you. This feature has been available since EndNote X8.
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Activity Feed Button

How is the activity displayed?

What activity is reflected in the feed?

Which activity lines are active versus inactive?

The Feed is attached to the associated Shared Library window. You can click on the Activity Feed drop- 
down button, to the right of the bell icon in the Sync Status, to display it, scroll through the updates listed 
and click outside the feed to dismiss it.

Activity is presented in reverse chronological order, and the Feed will update to display all the new activity 
that has happened since you last synced changes to the Shared Library. Next to each sync span, you will 
see the sync icon with a sync timestamp and below it all the latest activity that was retrieved. The activity is 
displayed in this way to update you with all the latest activity since you were last working on the library.

All Shared Library member activity including:

Activities: Adding, modifying, moving to or restoring from Trash, deleting (emptying Trash)▪

Library objects: references, attachments and figures, Groups and Groups Sets.▪

New member joining the library by accepting the invitation▪

When a user has performed an action more than 1 time, that activity is consolidated into one line. 
Example: adding 145 new references

▪

Exceptions are Groups (Smart, Combined, Custom) or Group Sets being created. These are listed 
out individually so a user can select that activity line and be taken to the Group or Group Set to 
display contents.

▪

The deletion of one or more Groups or Group Sets is consolidated to one line. The user can select 
that activity line and see the deleted Group or Group Set names listed out on individual lines.

▪

What is considered a "modification" of a Smart or Combined Group: 1) New search criteria or group 
being added or taken away 2) Group is renamed 3) moved to new Group Set

▪

Items listed in the feed are distinguished as active vs. inactive by the font color. Inactive lines, such as a 
member joining the Shared Library, are a light shade of gray, indicating to the user that they are unable to 
select that line.

Activity lines not in light gray are meant to signify that they will show more information. For example, 
selecting a line that says “Bob Smith added 145 references” will display those 145 references that Bob 
Smith added in a temporary Activity Feed group. Selecting a line that says “Bob Smith created a new Smart 
Group” will cause that Smart Group to be highlighted in the Groups pane and its reference contents to 
display in the library view.
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What activity is not in the Shared Library Activity Feed?

What  happens when I select a line of activity and some content has since 
been deleted?

Can I undo a line of activity?

Multiple People Opening One Library

Converting a Reference Manager Database to 
EndNote

Members being invited or revoked will not be reflected in the feed, it is only when a user has joined by 
accepting the invitation. Also excluded is activity done by the library owner in the EndNote online 
environment, though activity done by the owner on an iPad/iPhone will be reflected.

If you select a line of activity to which changes have since been made (e.g. “Bob  Smith added 200 
references” but more recently, another member of the library, Mike Hammer, deleted 75 of those) you will be 
presented with the remaining references. You will be viewing the most up-to-date set of references and 
attachments.

No. The Feed is meant to inform and does not offer the ability for users to roll back changes or access an 
earlier version of the Shared Library.

It is possible to share a read-only copy of a library on a local area network (LAN) drive. However, keeping a 
read-write library on a network drive is strongly discouraged and  can lead to library corruption. To avoid 
library corruption, keep the master library on the computer of the library administrator and put a read- 
only copy of  the library on the network drive. If there is more than one administrator, the administrators 
should share access to the library through EndNote's Sync's Library Sharing, not by trying to update the 
library on a network drive, then the "main" administrator should put the copy on the network drive, to keep 
the record numbers consistent (record numbers change with sync). See The EndNote Library is 
Corrupted, Record Numbers, and About Shared Libraries.

EndNote does not perform record-locking functions that would allow multiple users to edit one library at the 
same time. However, multiple users can access one EndNote library simultaneously as long as the library is 
restricted to read-only or locked status. This will allow users to perform searches, copy information to their 
documents, and format their papers. Use  File Explorer  to change the Properties of your EndNote library; 
select the Read-Only attribute for the .enl file and the .Data folder.

The simplest way to set up an EndNote library for shared network access is to use the network’s system of 
file permissions to control the type of access allowed for users and groups. Except for the person who posts 
the database, grant all users read-only access.

One person should be assigned the responsibility for maintaining and updating the library on their computer, 
not on the network. This user should be granted full access to the file and should periodically post an 
updated copy of the library on the network for all other users, with read-only access.

EndNote can easily convert Reference Manager databases to EndNote databases. The original Reference 
Manager database is left intact while references are copied and converted.
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Note: This feature is available to users of Reference Manager, versions 11 and 12.

While every effort has been made to map Reference Manager reference types to corresponding EndNote 
reference types and Reference Manager fields to corresponding EndNote fields, you may want to make 
some adjustments by using the Field Mapping tool during the conversion process. Alternatively, you can 
make changes to reference types in a Reference Manager database before converting the database to 
EndNote.

To convert a Reference Manager database to an EndNote library:

From the File menu, select Open > Open Library to display a Select a Reference Library dialog.1.

At the bottom of the dialog, select Reference Manager Databases (*.RMD)  from the Files of 
type menu.

2.

Use the file dialog to navigate to the folder that contains the Reference Manager database that you 
want to convert to EndNote. Highlight the database name, and then click the Open button.

3.

A "Convert Reference Manager Database" dialog will appear that lets you know that the database 
must be converted for use. You can either:

4.

Click Convert  to proceed with the conversion. This option allows EndNote to automatically 
convert Reference Manager reference types and fields to EndNote. It also leaves all file 
attachments stored in Reference Manager references in their original location.

▪

Click Customize if you want to modify the mapping of individual Reference Manager reference 
types to EndNote reference types and Reference Manager fields to EndNote fields. This option 
is useful if you have created customized reference types in Reference Manager.  
 
Use the top panel of the dialog to map each reference type  to a corresponding EndNote 
reference type. When you highlight a setting in the top panel of the dialog, you can change the 
field  mapping for that reference type in the bottom panel of the dialog. Click OK  to save 
changes to the mapping. See Mapping Reference Manager Reference Types and Fields to 
EndNote for a list of reference types.  
 
Click the Reset to Default Map  button if you want to discard your changes and return to the 
default mapping set.  
 
Click OK to save your changes when you are finished using the Field Mapping tool.

▪

Click the Convert button if you do not have any additional changes to make.5.

On the "Save Converted Library as" dialog, give the new EndNote library a name (the default file 
name is the same as the old Reference Manager file name).

6.

After the conversion completes, EndNote displays a "Convert Reference Manager Database" dialog. Click 
Yes if you want to convert your file attachments to relative links, which will put them in the .Data folder for 
the library. Click No to retain your file attachments as absolute links in their original location.

Note: Each EndNote library is made up of both an .enl file and a .Data folder. Each library can be 
independently moved, copied, or deleted after the conversion process. See Closing a Library  for more 
information. Always move, copy, or delete both the main .enl file and the .Data folder; otherwise, you can 
lose reference data.
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Converting Absolute Links to Relative Links

Converting Reference Manager Attachments to EndNote

Mapping Reference Manager Reference Types and Fields 
to EndNote

Note: The Cancel button allows you to cancel the entire conversion process. The Reference Manager 
database is not converted and cannot be opened in EndNote.

After the conversion completes, the new library opens in EndNote. All document and figure files appear in 
the File Attachments field within an EndNote reference. Move your cursor over a particular file to displays a 
tool tip that shows the full path (absolute path) of the file location. Files that show they are within the .Data 
folder for the library are relative links. This means the .Data folder can be moved with the .enl file and the 
links will continue to work, even if the library is moved to a different computer, or if the library is synced to 
another computer. Files that are not shown within the .Data folder to the library are absolute links and would 
become unavailable if the library were moved to a different computer, and would not be available on another 
computer if the library were synced.

In EndNote, you can easily change an absolute path to a relative path for each reference within a library list.

Select (highlight) each reference containing file attachments.1.

Note: You can easily sort all records with file attachments by clicking the paper clip that appears in 
the Attachments (Paper Clip) column of the Library window.

From the References menu, select File Attachments > Convert to Relative Links.1.

Click OK when the message appears.2.

The folder path for all attachments are quickly converted to relative links.

See Selecting a Relative Path or an Absolute Path for File Attachments for more information about absolute 
path versus relative path.

When you use EndNote to convert a Reference Manager database, Reference Manager reference types are 
mapped to EndNote reference types as shown in the table below. You can override these default  settings 
when you convert the Reference Manager database.

To change the field mapping during the Reference Manager to EndNote conversion:

Page 32 of 586

 



Clarivate EndNote 20 User Help Guide

Click the Customize button when the dialog below appears. 
 

1.

In the dialog show below you can set the reference types and fields you want your customized 
Reference Manager data to map to. From the top panel, select an EndNote reference type from the 
EndNote list, then select the fields you want mapped from the bottom panel. 
 

2.
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Reference Type Mapping Table

Reference Type Mapping Table

The table below lists the Reference Manager and the corresponding EndNote reference types. These are 
the default values for both databases.

Reference Manager 
Reference Types

EndNote 
Reference Types

Generic Generic

Abstract Journal Articles

Art Work Artwork

Audiovisual Material Audiovisual Material

Bill/Resolution Bill

Book Chapter Book Section

Book, Whole Book

Case Case

Catalog Catalog

Computer Program Computer Program

Conference Proceeding Conference Proceedings

Data File Dataset

Edited Book Edited Book

Electronic Citation Electronic Article

Grant Grant

Hearing Hearing

In Press Journal Article

Internet Communication Personal Communication

Journal (Full) Journal Article

Journal Journal Article

Magazine Article Magazine Article

Map Map

Motion Picture Film or Broadcast

Music Score Music

Newspaper Newspaper Article

Online Source Web Page
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Reference Type Mapping Table

Field Mapping Table

 

Reference Manager 
Reference Types

EndNote 
Reference Types

Pamphlet Pamphlet

Patent Patent

Personal Communication Personal Communication

Report Report

Serial (Book,Monograph) Serial

Slide Audiovisual Material

Sound Recording Audiovisual Material

Statute Statute

Thesis/Dissertation Thesis

Unenacted Bill/Resolution Bill

Unpublished Work Unpublished Work

Video Recording Film or Broadcast

 

See List of Reference Types for a complete list of EndNote reference types.

As much as possible, Reference Manager fields are mapped to corresponding EndNote fields. You can 
override these default settings when you convert the Reference Manager database. From the bottom panel, 
select an EndNote field from the EndNote list.

In some instances, the list of Reference Manager fields for a selected reference type may contain 
"dashes" (made up of multiple hyphens) that are mapped to the Notes field in the EndNote fields column. 
This occurs during the conversion when a Reference Manager field does not exist in the incoming reference 
type, and thus, appears as a dashed line in the Reference Manager Fields panel.

These are the default values for both databases.

Page 35 of 586

 



Clarivate EndNote 20 User Help Guide

Field Mapping Table

Reference Manager Fields  EndNote Fields  

Title, primary Title

Authors, primary Author

Dates primary Date

Notes Notes

Keywords Keywords

Reprint Notes

Start Section Section

End Section Section

Periodical Secondary Title

--------- Notes

Title/Code Num Volume

---------- Notes

---------- Notes

---------- Notes

Code Secondary Title

---------- Notes

User Def 1 Notes

User Def 2 Notes

User Def 3 Notes

User Def 4 Notes

User Def 5 Notes

History Original Publication

---------- Notes

Abstract Abstract

ISSN/ISBN Notes

Availability Database Provider

Date Access Date

---------- Notes

---------- Notes
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Special Field Mapping Conditions

Field Mapping Table

Reference Manager Fields  EndNote Fields  

UNIQUE ID (DOI) DOI

Address Author Address

Web/URL URL

File Attachments File Attachments

Link to Full-text URL

Related Links URL

Image(s) Figure

While the EndNote conversion tool allows you to make changes to most of the reference types and field 
mappings, there are some special mappings that you cannot modify. They include:

The REF ID field in Reference Manager always maps to the Label field in EndNote.▪

The End Page field in Reference Manager maps to the Pages or Section field in depending on the 
reference type.

▪

Note: If the receiving field already contains data, then EndNote appends the End Page data with a 
preceding hyphen character in order to create ranges. For example: 123-128

Any Reference Manager field that maps to the Date field in EndNote: For all reference types (except 
Conference Proceeding, Electronic Citation, Grant, and Patent), year data is copied to the Year field 
in EndNote.

▪

In the Conference Proceeding reference type, when the Reference Manager Pub Date [Date, 
Primary] field is mapped to the Year Published [Custom 2] field in EndNote, any year information is 
copied to the Year Published [Custom 2] field in EndNote and the complete field information is 
copied to Notes.

▪

In the Electronic Citation reference type, when the Reference Manager Last Updated [Date, Primary] 
field is mapped to the Epub Date [Section] field in EndNote, any year information is copied to the 
Year field in EndNote.

▪

In the Grant reference type, when Reference Manager Pub Date [Date, Primary] field is mapped to 
the Year field in EndNote, any year information is copied to Year and the complete field information is 
copied to Notes.

▪

In the Online Source reference type, when Reference Manager Access Date [Date Secondary] field 
is mapped to the Access Date [Number] field in EndNote, any year information is copied to the 
Access Year [Volume] field in EndNote.

▪

In the Patent reference type, when Reference Manager Date Issued [Date, Primary] field is mapped 
to the Issue Date [Custom 2] field in EndNote, any year information is copied to the Year field in 
EndNote.

▪
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Opening and Converting Old EndNote Libraries

Transferring Libraries between Computers or 
Platforms

Transferring a Library through Sync

For the Journal references in Reference Manager: If the Conference Title [Title, secondary] in 
Reference Manager contains data, the reference will not convert using typical Journal field 
mappings. EndNote maps as appropriate for a Conference Paper.

▪

For Thesis/Dissertation references in Reference Manager: If the Periodical field in Reference 
Manager contains data, the reference will not convert using typical Thesis/Dissertation reference 
type mappings. EndNote will use mappings similar to those for a Journal.

▪

When opening a library from a version of EndNote prior to EndNote X9.3, EndNote will convert the library to 
the current format and leave the original library unchanged. EndNote libraries  consist of an .enl file  and 
a .Data folder that must be kept together when sharing libraries.

To open or convert an older EndNote library:

Start EndNote.1.

From the File menu, select Open and then Open Library.2.

On the file dialog, locate and highlight the old library, and then click Open. EndNote will warn you 
that the selected library was created with an older version and ask you for permission to convert it.

3.

Click OK to convert the library.4.

EndNote will give the new library a default  name of [oldlibraryname]-Converted.enl, but you can 
change it. Name the new library and click Save.

5.

The conversion makes a copy of the original library in the latest file format, and leaves the original library 
intact.

Any library  created or updated with EndNote X9.3 can be used by EndNote X9.3 or later on Windows or 
macOS. No conversion is necessary. Therefore the methods described below can be used for transferring 
libraries between computers, no matter the platform.

With EndNote X9.3 the database engine changed. This means EndNote X9.3 or later are able to open and 
use libraries from EndNote 20, but EndNote 20 libraries cannot be opened in EndNote X9.2 or earlier.

The easiest way to transfer the contents of a library from one computer to another, whether Windows or 
macOS operating system, is to use EndNote Sync. This method will work even if not all of the libraries being 
synced are from the same version of EndNote.

If you have not yet done so, sync the library on your original computer to EndNote online. You can 
find instructions in the section The Sync Feature.

1.
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Transferring a Compressed Library

Transferring a Copy Made through the Save a Copy 
Command

On the computer you are transferring your library to, create an empty library and sync it to the same 
EndNote account. The empty library will be populated with all the references, group sets, and groups 
from the original library (if you use a library with references in it, they will be merged and you may 
end up with duplicate references). Attachments that are in the .Data folder of the original library will 
also be transferred. These will be attachments created as relative links. See Selecting a Relative 
Path or an Absolute Path for File Attachments for more information on relative links.

2.

If automatic sync is turned off, be sure to manually sync the library before closing EndNote to update 
the online library.

3.

Note: EndNote record numbers are not permanent and may change during sync.

The two copies of the library will continue to synchronize changes made to to the library on either computer.

If you want to copy a library to another computer, or give a copy of it to a colleague, but do not want to 
synchronize your references, the safest way to do so is by creating a compressed copy of the library. A 
compressed copy can be transferred through a network, through syncing services such as OneDrive,  
iCloud, or Dropbox, or attached to an email (if small enough),

To transfer a compressed library:

Create a compressed copy of the library. See Saving a Compressed Copy of a Library for detailed 
instructions. The compressed library will have a .enlx extension.

1.

Copy the compressed library file to the new computer via a thumbdrive, a syncing folder, a network 
drive, or email.

2.

On the new computer, place the compressed library in the location you want to permanently store it.3.

Open the compressed library from EndNote, uncompressing it. See Restoring a Compressed Library 
File for instructions. In the future, open the .enl file to open the library. This will be an uncompressed 
file.

4.

Note: If using a cloud-syncing service such as OneDrive, iCloud, or Dropbox to transfer the compressed 
library, move it out of the syncing folder before opening the library. Uncompressed libraries should not be 
used in cloud-syncing folders to avoid data corruption.

Note: EndNote libraries larger than 4 gigabytes or 65,535 files cannot be compressed with EndNote’s 
Compressed Library command.

If your library is too large to compress, you could save an uncompressed copy of the library and transfer it 
via a network or thumb drive. See Saving a Copy of a Library for more information.

To transfer an uncompressed copy of a library:
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Sharing a Library

Select Save a Copy from the File menu in EndNote.1.

Name the file and select the location you want to save the copy, such as an external hard drive or 
thumb drive. By default, EndNote will use the original file name and add "Copy" at the end, but you 
can change the name.

2.

The recipient of the library can use Windows Explorer to copy the library files to their own computer.3.

If you wish to give a colleague access to your EndNote library, with automatic updates, consider sharing 
your library with them through EndNote Sync. This would enable both of you to make changes to the library 
and have them automatically synchronized between computers, and would eliminate any problems with 
incompatibility from using different versions of EndNote. You can find information on this in About Shared 
Libraries.
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Working with References

The Reference Panel

Reference Panel Options

Reference Panel Controls

The heart of your EndNote library  is your references. EndNote provides many tools for working with 
references and their related files.

The Reference panel displays the contents of a reference, allows editing of the reference, and viewing and 
annotation of PDFs. Each part of the reference is stored in its own field; field names and data can be seen 
in the Edit panel. The Reference Type field displays the type of reference that you are viewing, such as 
journal article, book, or conference proceeding. Changing the Reference Type field will change the names of 
the fields displayed.

The first author’s  last name, the year, and the EndNote record number appear at the top of the Reference 
panel in the title bar.

Note: Record numbers should not be considered permanent identifiers. The same record may have a 
different number if it is copied to another library or synced to another computer.

When you select a reference in the library, by default  EndNote displays the Summary panel, showing a 
summary of the reference and a preview of the reference. The preview subpanel may only be displayed as a 
toolbar at the bottom of the panel, but you can drag it up to see both the summary and preview in the panel.

To edit the reference, select Edit in the Reference panel.

To see PDFs for the reference, select PDF in the Reference panel.

If you change the Reference panel option, your choice will be remembered when you next start EndNote. So 
if you select the Edit option in the Reference panel, then close EndNote, the Edit panel will be displayed the 
next time you open EndNote.

To open a context-sensitive menu, right-click anywhere in the Reference panel.▪

Press Ctrl+Alt+A to attach a file to the current reference.▪

To open a PDF in the default PDF application on your computer, in the Edit panel click the drop-down 
arrow for the PDF, then select the option to Open with… (the name of the application to open the 
PDF with will depend on the default PDF application for your computer).

▪

Click the Attach File button in the Summary panel to attach a file such as a PDF, document, or text 
file.

▪
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Reference Commands

New Reference

Edit Reference

Copy References To

Copy Formatted Reference

E-mail Reference

Move References to Trash

Commands affecting an entire reference, or set of references, are available under the References menu. 
Most of these commands are also available by right-clicking on a reference, then selecting the command 
from the list.

Select References > New Reference to create a new reference. Enter your data, then click the Close button 
to save and close the reference. You will be asked if you want to save the changes.

Select References > Edit Reference to move to the Edit panel for the selected reference.

Select References > Copy References To to copy a set of selected reference(s) to a new library or another 
EndNote library on your computer.

Select References  > Copy Formatted Reference to copy selected reference(s) as they would be formatted 
according to the currently selected style. The reference(s) can then be pasted into emails or documents.

Note: The Copy Formatted Reference command pastes the reference(s) as formatted text, not as a Cite 
While You Write (CWYW) code, so the pasted references cannot be updated.

Select References  > E-mail Reference  to have EndNote open your default  desktop email application and 
create a new email with a formatted version of the reference inserted as text, and a subject line based on 
the reference. The format used will be the one selected in the Reference Preview subpanel. If there is a 
PDF attached to the reference, it will be included as an attachment of the email.

Note: This feature will not work with online email websites or within browsers; it requires a dedicated 
desktop application, such as Outlook.

Select References > Move References to Trash to have all selected references sent to the EndNote Trash. 
They will remain in the Trash until the Trash is emptied. If the library is synced, the contents of the Trash will 
be synced along with the rest of the library's contents.
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File Attachments

Find Full Text

Find Reference Updates

URL

Figure

Web of Science

Select References  > File Attachments to  attach files to a reference, open an attachment in the default 
program for its file type, save a copy of an attachment outside of the EndNote library, convert attachments 
with absolute links to relative links, or rename attached PDFs.

Note: Although PDFs tend to be the most common attachments, almost any file type can be attached to 
an EndNote record. Attachments with relative links will be stored in the .Data folder and will sync; 
attachments with absolute links are not stored in the .Data folder and will not sync. See Selecting a 
Relative Path or an Absolute Path for File Attachments for more information.

Select References > Find Full Text to have EndNote attempt to find and download available PDFs matching 
the reference(s).

Select a reference, or set of references, in the Reference List, then select References  > Find Reference 
Updates  to look for updated information for the reference(s). EndNote searches for and retrieves available 
field updates for the selected reference(s). If a reliable match is found, EndNote displays a Review Available 
Updates dialog that shows you the updates that were found. See Find Reference Updates  for more 
information.

The References > URL command contains two options:

It can use OpenURL to find local copies of the reference. If Find Full Text does not find the PDF you 
need, try selecting References > URL > OpenURL Link to connect to your library services and find 
the PDF.

1.

It can open the website of the URL in the URL field or the record.2.

Select References  > Figure  to attach a graphic file to the reference using the Figure field, or to open a 
graphic in the Figure field. The Figure field can contain only one file and can be used to insert graphic files 
into Word documents using Cite While You Write. If you have previously attached a file to the reference 
using the Figure field that you would prefer to move to the File Attachments field, there is also an option to 
convert the file to an attachment.

Select References  > Web of Science  to quickly access the Web of Science™  source record for the 
reference, related records for the reference, or to create a citation report for selected reference(s).
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Reference Summary

Important Points About References

Note: You must have access to the Web of Science to use this feature.

Select a single reference, then select References > Reference Summary to view a summary of information 
about the selected reference. An example of the information included is shown below.

Web of Science Times Cited:   18 
Date Added:  Thursday, September 17, 2020, 10:08 AM 
Last Updated:  Thursday, September 17, 2020, 10:08 AM 
Fields Used:  17 
Custom and Smart Groups:  Citation Report Example

There are various ways to add references to an EndNote library. This topic, and the following topics, discuss 
how to type information into EndNote, edit EndNote references, and insert graphics and files.

See How to Search an Online Database for information about connecting to online bibliographic databases 
and retrieving references directly into EndNote. Importing Reference Data into EndNote describes how to 
import references from a variety of sources using EndNote’s Import command.

Here is an overview of important aspects of EndNote references:

Each EndNote reference stores the information required to cite it in a bibliography. Keywords, notes, 
abstracts, URLs, and other information can be stored in a reference as well.

▪

Each reference added to a library is automatically assigned a unique record number for that library. If 
a reference is copied to another library, synced to a library on another computer, or even cut-and- 
pasted within the same library, the record number will change, so these numbers should not be 
considered permanent identifiers. EndNote uses these record numbers to format papers. You cannot 
change these record numbers.

▪

You can create up to 999,995 references in an EndNote library. However, we suggest limiting 
libraries to about 50,000 references for best performance.

▪

Fifty-eight reference types are already defined (such as Journal Article, Book, Conference 
Proceedings, and so on). Three additional Unused reference types are available so you can define 
your own. See the List of Reference Types.

▪

The fields (Author, Title, Year, and so on) displayed for each reference type  can be modified or 
deleted. New fields can also be added, up to a total of 52 fields per reference, including the 
reference type name.

▪

The text of the references should remain as Plain Text unless a special font, size, or style of text is 
required for a specific term or character.

▪

The font size used to display the text in references can be changed using the Display 
Font Preferences.

▪
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Special Fields

Selecting References

You can insert one graphic or file into the Figure field  of a record, and the figure can be cited in 
Microsoft Word. See Figures. However, you can insert up to 45 files into the File Attachments field. 
See Linking a File to an EndNote Reference.

▪

New references are automatically saved when they are closed; however, you may save a reference 
while editing the reference using the Save command from the File menu.

▪

There are two special tagging fields which appear in the library display, not in the Reference panel: Mark as 
Read/Mark as Unread and Rating. If you choose not to display these fields in the Reference List, you can 
still edit them by right-clicking on a reference, then select them from the list.

Mark as Read/Mark as Unread Button: Use these toggle buttons to apply a Read or Unread status tag to 
the current reference. EndNote automatically saves your selection. You can set options for this field in the 
preferences.

Rating: Apply a rating to the reference selected in the library list to signify the importance of the current 
reference to your research. Apply up to five stars (or none) by clicking a dot in the Rating field in the library 
list.

To work with individual references (for example to copy, export, or edit them), first select them in the 
Reference List. The simplest way is to click on a reference in the Reference List. That reference is then 
highlighted to indicate it is selected.

You can also select a reference by typing the first few letters found in the field  by which the library  is 
currently sorted. For example, if the library is sorted by the author field, type the first few letters of an 
author’s last name to select the first reference by that author. If the library is sorted based on title, type the 
first few letters of the title of the reference that you want to select. (When typing the letters to match a title, 
articles such as "a," "an," and "the" are skipped.)

To select multiple references:

Mark the box to the left of the reference. (This works with temporary online search results only.)▪

Hold down the Ctrl  key while  clicking on individual references. Press the Ctrl key  and click on a 
selected reference to deselect that reference and retain the rest of the selection.

▪

Select a range of references by clicking on the first reference, then press the Shift key and click on 
the last reference of the range.

▪

You can also select a range of references by holding down the mouse button and dragging the 
mouse vertically across a range of references.

▪

Choose Select All from the Edit menu to select all of the references showing in the current reference 
list. When all the references are selected, the Select All command changes to Unselect All.

▪
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The Reference Summary

Saving References

Deleting References

To see a list of statistics about a reference, select the reference, then go to the References menu and select 
Reference Summary.

If you wish to save and print this information, use the Copy text to clipboard button and then paste the text 
into a word processor document.

For a list of statistics about the library, see The Library Summary.

To save a reference that you have just created or to save any changes made to an existing reference:

Click the Save button.▪

Select a different reference. You will be asked if you want to save the changes to the reference you 
were working with.

▪

From the File menu, select Save.▪

Use the keyboard shortcut of Ctrl+S.▪

If you Exit from EndNote while editing a reference, a confirmation window will appear asking if you want to 
save the changes to the reference.

To delete references:

Select (highlight) those references you want to delete.1.

Do one of these, which moves the selected references to the Trash group:2.

Drag the selected references and drop them on the Trash group.▪

From the References menu, select Move References to Trash.▪

Press the Delete key on your keyboard.▪

When you are absolutely certain that you want to delete the references in the Trash, right-click on the Trash 
group and select Empty Trash.

You must confirm that you want to remove the references from the library.

If you want to permanently delete only some of the references in the Trash, select those references in the 
Trash, then select Delete Trash References from the References menu.

Note: You cannot undo the Empty Trash or Delete Trash References commands, so be sure you want to 
delete the reference(s) in the Trash before dismissing the EndNote warning.
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About the Trash Group

Find Reference Updates

The Trash group contains references you have removed from the library by using any of the methods 
mentioned above. While the references are officially no longer in your library (they will not appear in any 
other group or reference list, they are not included in your reference count, and they cannot be searched or 
cited), they are not completely deleted until you empty them from Trash.

Until you select Empty Trash, you can still drag references from the Trash group back to the All References 
group of your active library. You can also highlight a reference in the Trash group, right-click the reference, 
and select Restore to Library. However, references restored to the Library will not be restored to any custom 
groups they belonged to, you will need to restore the custom group associations manually.

Note: When you delete a reference, you delete its record number in that library forever. Even if you paste 
the reference back into the same library, it is assigned a new, unique record number. This may cause 
incompatibilities with older papers that have unformatted citations that use old record numbers. We 
strongly recommend that you do not delete references that have been used in papers that you might want 
to reformat later, and keep backups of your libraries!

Select and update individual or multiple references using the Find Reference Updates feature by retrieving 
information from source databases outside EndNote such as Web of Science™  Core Collection and 
PubMed.

The Find Reference Updates feature is available from the References menu.

When you select this feature, EndNote searches for and retrieves available field  updates for the selected 
reference.

EndNote uses the following process when searching for field updates.

EndNote first looks for the DOI (Digital Object Identifier) that matches the DOI of the selected record. 
If a reliable match is found, EndNote displays the Review Reference Updates dialog and displays the 
field updates.

1.

If EndNote cannot find a matching DOI number, it looks for the author name, year of publication, and 
journal title that matches the selected record. If a reliable match is found, EndNote displays the 
Review Reference Updates dialog and displays the field updates.

2.

If no match is found, then a message that all references are up to date is displayed.3.

Note: The Find Reference Updates feature is designed for journal articles. It will probably not work for 
other reference types, even if they are available in PubMed or Web of Science™.

To update a reference:

Select one or more references from the Reference List.1.

From the References menu, select Find Reference Updates.2.
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Editing a Reference in Find Reference Updates

Creating a New Reference

Entering References

All updates are highlighted in blue in both the Available Updates and the My Reference panels. An 
update exists for a field in the My Reference panel when the field is empty or differs from the 
information in the same field in the Available Updates panel. For each update that EndNote finds for 
a record, you can:

3.

Click the Update All Fields  button to update all the fields in the My References panel with 
updated information from the Available Updates panel. EndNote will ask if you want to apply 
this choice to all references to be updated. If you click Yes, you will not be given a choice of 
how to update the rest of the references to be updated.

▪

Click the Update Empty Fields button to update every empty field in the My Reference panel 
with the new information from the Available Updates panel. EndNote will ask if you want to 
apply this choice to all references to be updated. If you click Yes, you will not be given a 
choice of how to update the rest of the references to be updated.

▪

Edit the reference manually by selecting the Edit Reference  option, making your  changes, 
then clicking the Save and Continue  button to save your changes and continue to the next 
record.

▪

Note: If you have selected more than one reference, click the Skip  button to skip a particular 
reference that you do not wish to update. 
 
All fields in the My Reference panel will display, even if they are empty.

After selecting the Edit Reference option, you can copy any of the information from a retrieved field and 
paste the information into the same field in the My Reference panel. You can also edit any of the fields in the 
My Reference panel. The following edit options are available: Cut, Copy, Paste, Paste with Text Styles, and 
Select All.

You cannot edit any of the retrieved fields from the Available Updates panel.

To add a new reference to an open library:

From the References menu, select New Reference (Ctrl+N). This opens an empty Reference window:

Select a reference type from the Reference Type field at the top of the window.

Enter bibliographic data into each of the fields in the reference. For guidance, see Entering References. 
When you are finished, Close the reference to save it and add it to the library.

After a new reference has been saved, you can edit it in the Reference Edit panel.

Bibliographic information (as well as keywords, notes, and other relevant information) is entered into 
separate fields in each EndNote reference. By storing the pieces of bibliographic data in different fields, 

Page 48 of 586

 



Clarivate EndNote 20 User Help Guide

EndNote can later rearrange the elements to conform to various bibliographic formats (such as APA or 
MLA).

Special bibliographic formatting and punctuation should not be included when you enter reference data into 
EndNote. For example, you do not need to put quotes around titles, italicize journal names, or include the 
abbreviation "Vol." along with volume numbers. Enter only the raw data, and leave the formatting to 
EndNote.

Note: There are a few exceptions to this punctuation rule, notably in the Author, Editor, and Edition fields. 
See the detailed topics on those fields for more information.

Keyboard commands are available for many functions, reducing the need to use the mouse. See Keyboard 
Commands.

The Reference Type selected for a reference determines which fields will be available. The Generic 
Reference Type is the one all others are based on, so it is the only Reference Type where all fields will be 
available. It is possible to customize Reference Types if you need a field that is not available in the default 
set. See Customizing Reference Types for more information.

Note: Selecting a font from the Edit > Font menu should not be used for changing the display. Overriding 
the plain font will affect your  bibliographies.

For details about entering data into specific fields, see these topics:

Field Size Restrictions▪

Changing the Default Reference Type▪

Using Term Lists with Data Entry▪

Author and Editor Names▪

The Year Field▪

Title Fields▪

Journal Name Fields▪

The Pages Field▪

The Edition Field▪

The Date Field▪

Auto Date Stamps▪

The Short Title Field▪

The Original Publication Field▪

The Reprint Edition Field▪

The Reviewed Item Field▪

The ISBN/ISSN Field▪

The DOI Field▪

The Call Number Field▪

The Accession Number Field▪

The Label Field▪
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Field Size Restrictions

Choosing a Reference Type

Customizing Fields and Reference Types

Tips for Choosing the Right Reference Type

The Keywords Field▪

The Abstract, Notes, and Research Notes Fields▪

The URL Field▪

The File Attachments Field▪

The Figure and Caption Fields▪

The Figure field can contain a single graphic.

All other fields can contain up to 64 KB or approximately 16 pages of plain text. The exact number of pages 
will depend on the font size.

When you create a new reference, that reference is assigned the default reference type. If you want to add 
a different type of reference, click the List of Reference Types at the top of the Edit panel, and select the 
reference type that you need.

Normally, you should select the reference type before entering information in the reference because the 
fields available will vary by reference type. However, you can change the reference type at any time, and the 
information you have entered is retained and transferred to the corresponding fields for the new reference 
type.

In addition to determining how the reference is formatted in the bibliography, the reference type determines 
which fields appear in the Reference window. For example, a Journal Article reference would have fields for 
Journal, Volume, and Issue, whereas a Book would have fields for Editor and Publisher.

Fields can be removed, added, or renamed. You can also rename reference types. See Customizing 
Reference Types for more information.

Use Book for books written by one or more authors, and use Edited Book for books edited by one or more 
editors (whether they are books in a series or not).

Use Book Section for references to parts of edited or nonedited books (a chapter, for example).

The Conference Paper reference type is best used for unpublished papers. Articles that are published as 
part of the comprehensive conference proceedings should be entered as Conference Proceedings 
references.

Use the Electronic Article, Electronic Book, or Web Page reference type for citing material from a Web page 
or FTP site. If you are citing a journal article that appears both online and in print, most style guides prefer 
that you use the print information and cite it as a regular journal article. Email discussions should be cited as 
Personal Communications, just like any other correspondence.
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Changing the Default Reference Type

Using Term Lists with Data Entry

Author and Editor Names

Use the Chart or Table reference type if you want to include an image and later insert that image as a table 
in Microsoft Word. Images in all other reference types will insert into Word as figures, which are listed and 
numbered separately from tables.

By default, new references appear as Journal Article references. You may change this by selecting the 
Default Reference Type option in the Preferences panel.

From the Edit menu, select Preferences.1.

Click the Reference Types option in the list.2.

At the top of that Reference Types preferences panel, select the Default Reference Type  list, and 
then select the reference type that new references should use.

3.

See Reference Types Preferences for more information.

EndNote uses term lists for the Author and Editor names, Journals, and Keywords. Term lists can also be 
created for other fields. These lists are updated automatically as you enter or import new terms into these 
fields. The benefit of this is that the term lists also help with data entry. If you begin to enter a name, journal 
or keyword that you have used before in that library, EndNote will complete the term for you to speed up 
data entry.

To accept a term that EndNote has suggested, press Enter, Tab, or click in the next field. Terms that are new 
(that is, those that do not already appear in the corresponding Author, Journals, or Keyword term list) 
appear in red text.

A more complete discussion of EndNote’s term lists is provided in Introduction to Term Lists.

Note: Both the "Auto-Update" and "Auto-Complete" term list features described here may be turned off 
using the Term Lists Preferences settings in the EndNote preferences.

The following information about Author and Editor fields applies to the following "Generic" field  names: 
Author, Secondary Author, Tertiary Author, and Subsidiary Author.

Always enter author and editor names with one name per line. If an author’s name is too long to fit on a 
single line, let it wrap to the next line as you type it.

Author names can be entered either with the last name followed by a comma and the first name or the first 
name followed by the last name. Both are correct. However, if you have the "Suggest Terms as You Type" 
feature of the term lists turned on, EndNote suggests author names based on names entered with the last 
name first.

EndNote can abbreviate first and middle names, so for maximum flexibility enter whole names whenever 
possible. If you are entering initials instead of full names, be sure to type a period, a space, or a period and 
a space between initials; otherwise EndNote interprets the initials as a single name. For example, entering 
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Using "et al." or Similar Abbreviations

Anonymous Works

Corporate Authors

"JO Fisher" or "Fisher, JO" would result in "JO" being perceived as the single name "Jo" and formatted as 
"J." in the APA style instead of "J. O." However, using any of the data entry formats below would result in the 
name being formatted according to the APA requirements.

James Oscar Fisher▪

James O. Fisher▪

Fisher, James Oscar▪

Fisher, James O.▪

Fisher, J. O.▪

Fisher, J.O.▪

Fisher, J O▪

J. O. Fisher▪

J.O. Fisher▪

J O Fisher▪

Note: EndNote will not perceive an author's name entered as a full name to be the same author as a 
name entered with initials. EndNote's author term list  is not designed to work with full and abbreviated 
versions of a name. This means that to meet requirements for styles which require special formatting 
when there are multiple works by the same author, such as a solid line instead of repeating the author's 
name in the reference list, it is important to enter the author's name the same way in all records.

See Additional Style Formatting Options for information about how EndNote can use style settings to format 
author names in bibliographies. For more information about term lists, see Introduction to Term Lists.

Enter all author names for a particular reference. EndNote will truncate the list of authors with "et al." or "and 
others" as required by the bibliographic style. If you do not know all of the authors’ names, then the last 
author should be "et al." or "and others" followed by a comma.

If a reference has no author, leave the Author field blank. Do not enter "Anonymous." The style that you use 
to format the bibliography determines how anonymous references are treated.

Note that if a work is published with "Anonymous" printed on the title page, most style guides request that 
"Anonymous" be entered as though it were the author name.

When entering corporate authors, put a comma after the name:

U.S. Department of Agriculture,

Apple Computer Inc.,

This ensures that the entire name is treated as a last name, so no name manipulation will be applied.
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Complex Author Names

The Year Field

Title Fields

If a corporate author name includes a comma in the name itself, use two commas in place of the first 
comma:

Apple Computer,, Inc.

EndNote treats this as a last name, followed by a blank first name, and then a suffix. As a result, everything 
after the (blank) first name is appended, with the second comma treated as text instead of the identifier 
between the first and last name. The formatted result of the corporate name above would be "Apple 
Computer, Inc."

For multiple-word last names, like Charles de Gaulle, enter the name with the last name first, such as:

de Gaulle, Charles

Entering a name this way ensures that both words "de" and "Gaulle" will format as the last name.

Enter authors with titles, such as "Jr." or "III" as Last, First, Title. For example, "Alfred Smith, Jr." must be 
entered as:

Smith, Alfred, Jr.

The text after the second comma will print exactly as entered and the second comma will always be 
included as part of the suffix. For the example above, the name would show as "Alfred Smith, Jr." but could 
not be formatted as "Alfred Smith Jr."

Note:  See the Sorting Preferences  section of the EndNote preferences if you do not want EndNote to 
include prepositions (such as de, van, von, and so on) when it alphabetizes references in a bibliography.

Normally, you should enter the four numbers of the year of publication, as in 2013. When appropriate, you 
may enter "in press," or "in preparation," or some other notation.

Note: When you transfer references from an outside source into EndNote, only valid dates are parsed 
and transferred. Text such as "submitted" or "in print" is ignored, and year ranges such as 2010-11 may 
not import as expected. However, you can manually type this information into the reference. Also, only 
one item can be imported into the year field, so if year information appears more than once in import data, 
only the first item will be imported into the Year field.

The following information about Title fields applies to the "Generic" fields Title, Secondary Title, Tertiary Title, 
and Alternate Title.

Enter titles without a period or any other punctuation at the end. Do not press the Enter  key while typing 
titles into EndNote; allow long titles to just wrap to the next line. Although the EndNote styles can change 
the capitalization of titles, it is best to capitalize the title in the same way you would like it to be capitalized in 
your bibliographies.
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Journal Name Fields

The Journal Field

The Alternate Journal Field

The Journals Terms List

The Pages Field

The Journal field is automatically set up to work with the Journals term list. This means that the Journals list 
is updated as you add new journal names to your references, and EndNote will use this list to facilitate data 
entry by suggesting journal names as you enter them into the Journal field.

The Journal fields (in the Journal Article reference type) can be used with the Journals term list to allow for 
multiple formats of a journal name to be used in your bibliographies, depending on the format required (see 
Creating Bibliographies with Journal Abbreviations). When the different forms of the journal name are 
entered into the Journals term list, all it takes to change the format of your journal names in a bibliography is 
one change in the style used (see Journal Names). All of the appropriate substitutions are made when the 
bibliography is created.

EndNote includes several predefined journal lists in the Terms folder. If you would like to use these lists, you 
should import them into your Journals list as described in Loading Supplied Journal Abbreviations.

When using a Journals term list, new contents  in the Journal field will be interpreted as a full journal name 
and added to the list as such. If an entry shows up in red, the name has not been used in the Journals term 
list before.

When using a Journals term list, new contents in the Alternate Journal field will be interpreted as the journal 
abbreviation and added to the list as such.

If EndNote has a predefined journals term list for your area of study, importing it when you create your 
library will eliminate many problems.

Some databases export the full journal name, some export the abbreviation, and some export both. If the 
term list  is automatically updated from references where the names are not consistent in the Journal and 
Alternate Journal fields, EndNote will be unable to create a bibliography where the journal name formats are 
consistent. EndNote will not add a new name if that name already exists anywhere in the term list, so having 
an abbreviation in the Journal field or the full name in the Alternate Journal field is not a problem when an 
"official" version of the name already exists in the term list—because you imported the list before adding 
references!

Page ranges can be entered as complete (1442-1449) or abbreviated (1442-9) ranges. The style  used to 
create the bibliography will change the page numbers to match the style requirements, either full number 
ranges, abbreviated page ranges, just the first page (see Page Numbers).

Do not use commas in the Pages field  for page numbers in the thousands. EndNote will add them, if 
needed.

This field is one of three than can be used in EndNote temporary citations in place of the EndNote record 
number. The other two fields are Accession Number and Label. You  can find more information on this 
in Temporary Citations Preferences.
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The Edition Field

The Date Field

Auto Date Stamps

The Short Title Field

The text of the Edition field is not modified by EndNote for your bibliographies, so be sure to enter it exactly 
as you want it to appear. For example, "1st," "2nd," and so on for this field if that is what you need in your 
bibliography.

In the Date field of your references, enter dates as you would like them to appear in your formatted list or 
bibliography; EndNote does not reformat dates. The output style determines which date field prints in your 
bibliographic references.

Note: When you transfer references from an outside source into EndNote, only valid dates are parsed 
and transferred. Text such as "submitted" or "in print" is ignored. However, you can manually type this 
information into the reference.

Two Auto Date Stamp fields are tracked in EndNote and can be added to the Reference List panel display.

The Added to Library and Last Updated date fields are inserted when you save a new reference. The Last 
Updated date is reset each time you save changes to a reference. The date format of the Auto Date Stamp 
fields matches your default operating system settings (for example, 4/16/2020).

To add the two Auto Date Stamp fields to the Reference List panel, select Edit > Preferences  > Display 
Fields. From the Field column, select the Added to Library and/or Last Updated fields. EndNote populates 
the Heading column with your selection.

You cannot edit, print, or export either of the Auto Date Stamp fields. You can, however, display and sort 
these fields from the Reference List panel just as you can any other EndNote field.

Note: For references entered with EndNote version X1 or earlier, the Added to Library field is left blank 
and the Last Updated field displays the date of conversion to EndNote.

Use the Short Title field to enter abbreviated versions of the regular title which should be used as part of an 
in-text citation or a footnote citation. This is a common request for many of the humanities styles, which use 
a shortened form of the title in the citation to help identify which reference is being cited. For example, MLA 
typically lists just the author name and the specifically cited pages in the in-text citation:

(Perin 141)

But if there are multiple works by that author, MLA requires that the title or a shortened form of it be added to 
the citation. If the full title of the reference is fairly long, such as Burning the Midnight Oil: Tales from Working 
the Night Shift, you should enter an easily recognizable form of the title that starts with the first word on 
which the normal title would be sorted. For example:

(Perin, Burning the Midnight Oil 141)
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The Original Publication Field

The Reprint Edition Field

The Reviewed Item Field

The ISBN/ISSN Field

The DOI Field

If an EndNote style is configured to use the Short Title field, and that field is empty for a particular reference, 
the normal Title field is used instead

Use the Original Publication field  to enter any information about the original publication that you 
need included in the cited reference. For example, when citing a republished book you might want to include 
the original publication date, as well as any other supplementary information about the original publication 
(such as place published and publisher). Enter this information just as you would want it to appear in your 
formatted bibliography reference (including text formatting and punctuation).

Use the Reprint Edition field  for references that were originally published under a different title. The field 
should include the original title and year to indicate that this reference is a reprint of an earlier publication. 
Enter this information exactly as you would want it to appear in your formatted reference (including text 
formatting and punctuation).

Note: This field is not intended to be used to indicate whether or not you have a reprint of the article on 
file.

Use the Reviewed Item field for articles or chapters that are critical reviews of books, cinema, art, or other 
works. The contents of the Reviewed Item field varies depending on the type of review that you are citing, 
but typically you should enter the title of the reviewed work and the primary person responsible for it (author, 
artist, performer, and so on). Additional information about a production or performance may also be 
included. Enter the information exactly as you want it to appear in the formatted references (including 
punctuation and text formatting).

ISSN (International Standard Serial Number) and ISBN (International Standard Book Number) are codes 
used to identify a particular publication. An ISSN number would refer to an entire journal (such as the 
Journal of Virology), and an ISBN would refer to a particular edition of a book. An electronic edition of a 
book would have a different ISBN than a print edition, for example.

These numbers help to identify a specific publication if you need to order it or locate it. This field is also used 
for Report Number and Patent Number in the Report and Patent reference types.

A DOI (Digital Object Identifier) is a unique ID for locating a digital version of a document, PDF, or image. It 
is most useful if you are importing reference data or retrieving references directly from an online source. In 
early versions of EndNote, this field was titled "Electronic Resource Number."
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The Accession Number Field

The Call Number Field

The Label Field

The Keywords Field

This field is used to identify the internal tracking number for references imported from online databases. For 
example, if you import a reference from Clarivate Web of Science, the Web of Science Unique Identifier 
number will be imported into this field; if you import a reference from PubMed, the PMID will be imported 
into this field.

This field is one of three than can be used in EndNote temporary citations in place of the EndNote record 
number. The other two fields are Label and Pages. You can find more information on this in Temporary 
Citations Preferences.

Note: Only one item can be imported into this field. This means if a record from an online database 
contains both a Web of Science Unique Identifier and a PMID, only one of them can be imported into the 
Accession Number field. The other identifier will likely be imported into the Notes field.

The Call Number field is used to store library call numbers. These are the codes that help you to locate a 
particular publication on the shelves in your library. When available, the EndNote connection files import the 
call number information into this field.

The Label field can be used for many purposes, such as special in-text citations or reprint numbers.

When converting references from other reference management systems, the record number from the 
previous system is imported into the Label field, for example, when converting a Reference Manager 
database to EndNote.

Some citation styles require that citations include only part of the author’s  name, such as [SMIT 90]. 
EndNote cannot create this citation for you, but if you type " SMIT 90" into the Label field and use the Label 
field in your style’s citation template, EndNote will insert the Label field into the citation.

This field is one of three than can be used in EndNote temporary citations in place of the EndNote record 
number. The other two fields are Accession Number and Pages. You can find more information on this 
in Temporary Citations Preferences.

If you do not need the Label field for citation purposes, it can be used as an additional field for categorizing 
references or storing reprint numbers. (Do not use EndNote’s record numbers to number reprints because 
these numbers change when references are moved to different libraries. EndNote’s record numbers cannot 
be assigned or changed by the user, but the Label field can be edited.)

Use the Keywords field  to store keywords that you want to associate with a reference. You can restrict a 
search to just the Keywords field, so the terms you enter into this field can be used to later retrieve the 
references when using EndNote’s Search command.

By default, EndNote will also import keywords from online databases into the Keywords field.
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The Abstract, Notes, and Research Notes Fields

The URL Field

The File Attachments Field

The Keywords term list  (which maintains a list of terms used in the Keywords field) can be set up to 
recognize semicolons (;), slashes (/), backslashes (\), and returns as delimiters that separate individual 
keywords. If you would prefer to use other punctuation to separate your keywords, you may change these 
settings using the Define Term Lists command under the Library menu.

The Abstract, Notes, and Research Notes fields can each hold up to 64,000 characters, which is equivalent 
to about 16 pages of text. Use the Notes field  to store personal reminders, such as the location of a 
quotation in a book or the quotation itself. Use the Abstract field for a brief description of the contents of the 
work. Use the Research Notes field to create personal annotated bibliographies.

URL (Uniform Resource Locator) is the term for the address used to locate a specific page of information 
with your Web browser.

To link a URL to a reference in your EndNote library:

Select a reference in the Reference List and select the Edit panel. Put your cursor in the URL field.1.

Type or paste a valid URL into the field. For example:2.

https://endnote.com/

or

https://clarivate.com/

The URL becomes a hyperlink (blue and underlined).3.

If you need to enter multiple links into the URL field, enter them one per line. Adding any other information 
along with the URL or path and filename may keep the Open URL command from successfully finding the 
desired site.

When a correctly formatted URL is entered into the URL field, the URL  > Open URL  command on the 
References menu can be used to launch a Web browser and take you to that site or file.

Some online reference databases include a URL for the full text of an article online. When importing or 
retrieving references directly from these sources, the URLs can import directly into this field to take 
advantage of the Open URL command. You can also store a URL to related information on the Web or other 
relevant material.

EndNote automatically recognizes URLs if they are entered with the correct prefix, such as "https://," 
"http://," or "ftp://." When recognized, they become clickable Web links and appear as blue and underlined 
text. Simply clicking on one of these links will open your Web browser and go to the address given. This 
feature is not specific to the URL field. See Linking References to Files and Web Sites.

Use the File Attachments field to store the path to PDF files (and other file types) on your hard drive.
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Note: Use the Figure field to attach a graphic or file that you want to insert into a Word document with 
Cite While You Write.

To link a file to a reference in your EndNote library:

Select a reference in the Reference List.1.

From the References menu, select File Attachments > Attach File.2.

On the file dialog, select the file to attach to your reference.3.

Note the checkbox along the bottom titled, "Copy this file to the default  file attachments folder and 
create a relative link." This gives you the option to:

4.

Select the checkbox to copy the original file and place the copy in the .Data\PDF folder that is 
part of your EndNote library. In this location, it will sync through EndNote online.

▪

Deselect the checkbox to always have EndNote look in the original folder for the inserted file. 
If kept in the original location, the attachment will not sync through EndNote online.

▪

For more information about this option, see Selecting a Relative Path or an Absolute Path for File 
Attachments.

Click Open.5.

EndNote will display an icon indicating the type of file inserted. You can insert up to 45 files into the same 
File Attachments field.

Note: Another way to link a file to the File Attachments field is to drag and drop the file onto the reference 
in either the Library window or the Reference Edit panel. Whether the file is saved with the database or is 
linked with an absolute path is determined by the default file attachment setting. See URLs & Links 
Preferences.

Note: In order to maintain cross-platform compatibility, any of the following characters in a filename will be 
replaced by an underscore when EndNote saves a copy of the file in the .Data\PDF folder with a relative 
path.

These characters are 
replaced with an underscore

\  back slash
/  forward slash
:  colon
*  asterisk
?  question mark
"  quotation mark
<  less than
>  greater than
|  vertical bar

For more information, see Linking a File to an EndNote Reference and Opening a Linked File or URL.
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The Figure and Caption Fields

The PMCID and NIHMSID Fields

To automatically search online to locate and attach the full text of a referenced document, see Finding Full 
Text for a Reference.

Note: Never rename attached files within the DATA folder. EndNote assigns each file a unique name that 
helps link it to a specific reference.

The Figure field can contain a graphic or file attachment. See Figures.

The Figure field is included by default for all reference types, but you can remove it from any reference type 
or rename it in any reference type.

Note: Each reference can contain only one item in the Figure field.

The figure itself is copied to the [library name].Data folder found in the same folder as the library file.

A related Caption field appears directly under the Figure field in a reference. Use this field for a short 
description of the image or file.

Cite While You Write allows you to insert the figure and its caption into a Microsoft Word document. See 
Finding and Inserting Figures and Tables. Figures in most reference types will insert into Word as figures. 
The only exception is the Chart or Table reference type; use the Chart or Table reference type if you want to 
include an image and later insert that image as a table in Microsoft Word. Tables are listed and numbered 
separately from figures in Word.

Unlike most of the fields described in this section, the PMCID and NIHMSID fields are not generic fields. 
They occur only in the Journal Article and Electronic Article reference types.  As you can see below, the 
generic names for these fields are Custom 2 and Custom 6.

Page 60 of 586

 



Clarivate EndNote 20 User Help Guide

The U.S. National Institutes of Health (NIH) requires that the PMCID be reported by some authors, so it is 
important to track this information and be able to use it if you are working with the NIH. You can find 
information on requirements for using these numbers at https://publicaccess.nih.gov/include-pmcid- 
citations.htm.

What is the difference between these two? The PMCID is the unique permanent identifier assigned when an 
article is approved for publication at PubMed  Central (PMC). The NIHMSID is a temporary identifier 
assigned when an article is submitted for publication at PubMed Central. The NIHMSID is only to be used 
for the first 90 days after it is assigned or until an article has been granted a PMCID. You can find more 
information on this at https://www.ncbi.nlm.nih.gov/pmc/about/public-access-info/.

Note: The PMID is not equivalent to either of these numbers. The PMID is the unique identifier for an 
article in the PubMed database and would be imported into the Accession Number field when importing 
references from PubMed, or into the Notes field when importing references from the Web of Science™.
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Font, Size, and Style

Plain Text

Keyboard Commands

EndNote is designed to produce bibliographies that automatically use the font  and size of the text in your 
word-processing documents. Normally, when you type text into an EndNote reference, it is entered in a 
default Plain font, size, and style, which means that your references follow the font settings in your paper.

If any fonts, sizes,  or styles other than the default are entered into your library, they will appear in your 
bibliography regardless of the font of your paper. For example, you can italicize species names, add a 
superscript number, or enter Greek characters such as D.

To apply font or text styles, select the text to be changed and then select the desired font options from 
the Edit menu or the Font toolbar.

EndNote supports Unicode UTF-8, allowing you to enter Unicode characters into references as well as the 
characters available through the font options.

Note: If the Font, Size, and Style (bold, etc.) options are dim, it is either because you are not in an editing 
window (such as a Reference or Style window), or you have not selected (highlighted) any text to 
change. 

The Plain Font, Plain Size, and Plain Style commands on the Edit menu remove overriding formatting from 
the selected text.

When EndNote creates a bibliography, text in Plain Font and Plain Size uses the font and size of your paper. 
To use these commands, first select the text you want to change, and then select Plain Font, Plain Size, or 
Plain Style from the Edit menu.

Text entered into EndNote without any special font, size, or style applied is considered plain text, which is 
formatted in the font  and size  of your paper. Once you specifically apply a font, size  or style to text, that 
formatting overrides the plain text setting.

The default  font used to display EndNote’s  "Plain Text" is the default font of your operating system. The 
General font setting does not affect the font of a bibliography created for a word processing document.

A full set of key commands is available so that you can enter references without using the mouse. For 
example, to create and enter a new reference without touching the mouse, select Ctrl+N  to add a new 
reference, type the bibliographic information using Tab or Shift+Tab to move forward or backward between 
the fields, and then press Ctrl+W to save and close the reference.
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Action When Entering Text Key Command

Create a new reference Ctrl+N

Go to Reference Edit panel Ctrl+E

Select the next field Tab

Select the previous field Shift+Tab

When the cursor is in a field linked to a 
term list, such as Author, Journal, or 
Keywords, display the appropriate term list 
for term selection

Ctrl+1

Undo the previous command Ctrl+Z

Cut selected text and put it on the 
clipboard Ctrl+X

Copy selected text and put it on the 
clipboard Ctrl+C

Paste text from the clipboard at the 
insertion point Ctrl+V

Select all text in a field Ctrl+A

Check spelling Ctrl+Y

Set the text style to Plain Ctrl+T

Turn bold on or off Ctrl+B

Turn italic on or off Ctrl+I

Turn underline on or off Ctrl+U

Special Characters

Note: Use the Arrow keys to navigate within a field.

EndNote references can include special characters, including characters with diacritics, Greek, 
mathematical, and typographical symbols. Diacritical characters are a part of standard Windows fonts, and 
many common symbols can be entered using the Symbol font.

EndNote uses Unicode  to encode special characters, so that data can be easily translated between 
platforms, programs, and languages.

EndNote uses the default  language setting of your operating system. If the characters you wish to use 
require installing a different language, see Working with Multiple Languages.

Special characters can be entered into EndNote using any of these text-entry methods:

Type the character on the keyboard (if the character is part of the language supported by the 
keyboard).

▪
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The Character Map

For common symbol characters, especially Greek characters, you can use the Symbol font by 
selecting Font > Symbol from the Edit menu.

▪

Copy the character from another program, and paste it into your EndNote library.▪

Use The Character Map program supplied with Windows to copy characters into EndNote.▪

menu.▪

Characters with diacritics can be entered into EndNote references and into EndNote term lists. If you 
frequently use certain diacritical characters, or words that include diacritical characters, you can store them 
in a term list  and then select them from the list when entering references. See Introduction to Term Lists. 
However, only one term list can be associated with an EndNote field, so you will not be able to insert a 
special character from a term list into a field that already has a term list associated with it. You would need 
to enter it in another field, then cut-and-paste it into the field where you need it.

Note: If characters from other languages do not appear as they should in EndNote, see Working with 
Multiple Languages.

The Character Map program (CHARMAP.EXE) is supplied with all versions of Windows. Both diacritical 
characters and symbols can be entered using the Character Map.

To use the Character Map program:

Click the Search button on the Windows Taskbar.1.

Type "character map" to find the application. The window showing the application will also show 
options to add it to Start or pin it to the Windows Taskbar. Setting one of these options will make it 
easier to access in the future.

2.

Open the Character Map program.3.

Choose the font for the character from the drop-down list. Below is the list of fonts EndNote supports.4.

Arial▪

Courier New▪

MS Serif▪

MS Sans Serif▪

Symbol▪

Times New Roman▪

Wingdings▪

Select the character you want to copy to EndNote and click the Select  button. The character will 
appear in the Characters to copy field.

5.

Click the Copy button, then paste the character into EndNote.6.

If the character does not appear as you expect, select the character in EndNote, then select Font 
from the Edit menu, and then select the font that matches the one you selected in Character Map.

7.
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Working with Multiple Languages

Adding Languages

Entering Several Articles from the Same 
Source

Note: If you want to enter characters in another language that requires more than just adding diacritics or 
common symbols, you will need to add that language to your copy of Windows. See Working with Multiple 
Languages for more information.

The default  font used in EndNote will support Unicode characters, including symbols and standard Greek 
and mathematical characters. However, if you want to work in more than one language, you may need to 
install those additional languages to be able to work with them easily in EndNote.

For Windows 10:

Click the Start button, then select Settings.1.

Select Time & Language, then Language.2.

Select Add a language.3.

Select the language you want from the list and click Next.4.

Choose the options you want for that language, then click Install.5.

The language will be downloaded and installed.6.

The language will now appear on your list of available languages.7.

Click Keyboard to change options for accessing the different language keyboards.8.

Click Language Bar Options. These options will allow you to select how you switch between 
keyboards and languages.

9.

Select the Language Bar Options you want, then click OK to save your settings and close the dialog.10.

Choose any other Keyboard settings you want, then close and save your settings.11.

Note: Steps may vary with different versions of the Windows operating system.

Use a reference "template" to facilitate entering a series of references that have some information in 
common (such as various sections from one book or a number of papers presented at the same 
conference). The template you create is an incomplete EndNote reference with just the common information 
entered into it.

To create a reference template:
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Figures

Selecting the Appropriate Reference Type

From the References menu, select New Reference.1.

Enter all of the bibliographic information that the references have in common (such as the year, book 
title, publisher, and city for different sections from one book).

2.

Close the reference when you are finished.3.

Select the reference you just created in the Reference List.4.

Select Copy (Ctrl+C) from the Edit menu to copy it.5.

Use the Paste  (Ctrl+V) command to paste the reference several times, to create as many partially 
filled references as you need. You should paste directly to the Reference List—do not open a new 
reference and select Paste.

6.

Select the first of the partially filled references that you just created and add the information unique to 
it. Save the reference, then go to the next partially filled reference and edit it. Continue until you have 
completed all the references.

7.

EndNote extends the organization of reference information by including the ability to embed files in an 
EndNote library  using the Figure field  and insert them in Microsoft Word documents. This feature is most 
useful for graphic files or tables. You can insert a graphic, figure, or file into the Figure field of any EndNote 
reference. See Inserting Graphics and Files.

Note: While the Figure and Caption fields are included by default for all reference types, you can remove 
them at any time if you do not intend to use them. See Adding, Changing, and Hiding Reference Types.

Note: While it is possible to insert almost any file in the Figure field, it is better to reserve this field for 
graphics you want to insert into Microsoft Word. The Figure field can only hold one file attachment while 
the File Attachments field can hold up to 45 file attachments, of almost any kind.

Once you have a figure in your EndNote reference, Cite While You Write allows you to insert the figure and 
its caption into a Microsoft Word document. See Finding and Inserting Figures and Tables  for more 
information about using images with Cite While You Write.

You can insert a graphic or file into the Figure field of an EndNote reference. Depending on the reference 
type, the field may be labeled "Figure" or have a custom label assigned by you.

By default, the Figure and Caption fields are included in all reference types. So, while a reference to a 
journal may contain primarily bibliographic information, you can also include an illustration that appeared 
with the journal article.

The Figure, Chart or Table, and Equation reference types should be used specifically to catalog image files, 
and may contain minimal reference information.
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Inserting Graphics and Files

Notes on Figures:

Inserting Figures into EndNote References

Note: Figures in the "Chart or Table" reference type are inserted into Word as tables, and are labeled and 
numbered separately from the figures found in all other reference types.

To add or remove the Figure and Caption fields from a reference type, go to the Edit  menu, select 
Preferences, and then select Reference Types. For more information about modifying reference types, see 
Customizing Reference Types.

Always use the Figure  > Attach Figure  command to insert graphics and other files into the Figure 
field. If you use Copy and Paste, System settings are used and colors and other attributes from the 
original file could be lost.

▪

Each EndNote reference can contain only one graphic or file attachment in the Figure field. A second 
graphic or file inserted into a reference will replace the first one. The previous graphic or file will be 
deleted from the DATA folder. See Storing and Sharing Figure Files for more information about the 
DATA folder.

▪

After inserting a graphic, you should always type Caption text into the Caption field, particularly if you 
intend to later insert the figure into a Word document. The Caption will label the graphic in the figure 
list at the end of the Word document. The Caption also helps you search for the figure.

▪

You can insert a figure only into a reference that contains the Figure field. If you need to add the 
Figure field to a reference type, see Customizing Reference Types.

▪

In order to maintain cross-platform compatibility, any of the following characters in a filename will be 
replaced by an underscore when EndNote saves a copy of the file in the .Data folder.

▪

These characters are 
replaced with an underscore

\  back slash
/  forward slash
:  colon
*  asterisk
?  question mark
"  quotation mark
<  less than
>  greater than
|  vertical bar

To insert a graphic (picture) or other file into the Figure field:1.

Select the reference from the Reference List.2.

Select Figure > Attach Figure from the References menu.3.
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Click Choose File to open a dialog where you can select the file to attach.4.

Locate and select the graphic file, then click Open.5.

If returned to the Attach Figure dialog, click OK to copy the file to your EndNote reference. A graphic 
appears as a thumbnail within the reference.

6.

EndNote recognizes at least these graphic file types:

Windows Bitmap — BMP▪

Graphics Interchange Format — GIF▪

JPEG File Interchange Format — JPEG▪

Portable Network Graphics — PNG▪

Portable Document Format — PDF▪

Tag Image File Format — TIFF▪

Valid picture files are those that Microsoft Word recognizes as pictures.

Other types of files will appear as an attachment, with the program icon and filename. (If the application 
used to create the document is not available on your system, the icon gives generic Windows file 
information.)

Double-clicking on the thumbnail or file icon will launch an associated application to open the file, with the 
same effect as if you had double-clicked the file on your computer desktop.

EndNote also recognizes at least these other file formats:

Audio files (WAV, MP3)▪

Microsoft Access files▪

Microsoft Excel files▪

Microsoft Power Point files▪

Microsoft Project files▪

Microsoft Visio files▪

Microsoft Word files▪

Multimedia files (MOV, QuickTime)▪

Technical drawing files▪

Text files (TXT, RTF, HTML)▪

Note: Unless you want to later insert the file into Microsoft Word, it is better to use the File Attachments 
field to attach files to records. The Figure field can hold only one file, the File Attachments field can hold 
up to 45 files.
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The Figure Caption

Editing Figure Files

Deleting or Replacing Figure Files

A related Caption field  appears directly under the Figure field in a reference. Use this field for a short 
description of the image or file. The Caption field allows you to easily search for figures.

If you insert an EndNote figure into a Word document with Cite While You Write, the corresponding caption 
appears either above or below the figure in your paper (the placement is determined by the current output 
style).

To edit a figure stored in an EndNote reference:

Select the reference containing the figure in the Reference List.1.

Select Figure > Open Figure from the References menu.2.

This launches an associated application to open the file for editing.

Editing changes are made to the file stored in the library’s .Data folder for the reference, not to the original 
figure file that was inserted.

Note: Never rename figure files within the .Data folder. EndNote assigns each figure a unique name that 
helps link it to a specific reference.

To delete a figure from an EndNote reference:

Select the reference in the Reference List1.

Scroll down and click in the Figure field.2.

Press the backspace key on your keyboard.3.

Click the Save button to save your changes.4.

Deleting a figure from the reference also deletes it from the .Data folder.

Note: If you insert the same figure in two different references, EndNote stores two copies of the figure in 
the .Data folder. Deleting the figure from one of the references will not affect the other reference.

To replace a figure in an EndNote reference, you can do one of these:

Select the reference from the Reference List and attach the new figure. The existing figure is deleted 
from the .Data folder and is replaced with the new figure.

1.

Delete the old figure from the reference, and then attach the new figure.2.
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Converting from Figures to File Attachments

Storing and Sharing Figure Files

Linking References to Files and Web Sites

You can move a linked file from the Figures field to the File Attachments field in a reference. Keep in mind 
that only figures stored in the Figure field can be inserted as graphics in Microsoft Word with Cite While You 
Write.

Early versions  of EndNote did not include a File Attachments field. You may have linked a file to the 
Figure field in the past, and now would prefer to have the file linked to the File Attachments field.

To convert file links from the Figures field to the File Attachments field:

In Reference List, highlight the reference(s) you wish to change.1.

Select Figure > Convert Figures to File Attachments from the References menu.2.

When you insert a figure, EndNote copies the figure file and places the copy in the .Data  folder for your 
library, which is found in the same folder as the main library file. The copied figure file is specifically linked to 
a single EndNote reference.

Note: Simply putting a figure file into the .Data folder does not link it to a reference. You must use the 
References > Figure > Attach Figure command.

If you move your library to a different computer or if you want to share your library with someone, remember 
to always copy the .Data folder along with the library.

EndNote includes a URL field and a File Attachments field that you can use to link URLs and local files to 
EndNote references.

See the related topics below for details.

Linking a URL to an EndNote Reference▪

Linking a File to an EndNote Reference▪

Selecting a Relative Path or an Absolute Path for File Attachments▪

Removing a Linked File from File Attachments▪

Opening a Linked File or URL▪

Finding Full Text for a Reference▪
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Linking a URL to an EndNote Reference

Linking a File to an EndNote Reference

The term "URL" stands for "Uniform Resource Locator" and is a common term for the "address" used to 
identify the location of an item online. Most often, URLs refer to Web pages, such as this example of the 
Clarivate Web page:

https://clarivate.com/

To link a URL to a reference in your EndNote library:

Select a reference in the Reference List.1.

Put your cursor in the URL field.2.

Type or paste a valid URL into the field. EndNote will recognize URLs beginning with http://, https://, 
or ftp:// as valid URLs.

3.

The URL becomes a hyperlink (blue and underlined).4.

For more information about linking to a URL, see The URL Field.

You can link a file on your computer—such as a PDF, a word processing document, or a spreadsheet file— 
to an EndNote reference.

The File Attachments options are available only when a single reference is selected in the Library window or 
when you are editing a reference.

To link a file to the File Attachments field in a reference:

Select a reference in the Reference List.1.

From the References menu, select File Attachments > Attach File.2.

On the file dialog, select a file to link to the selected reference.3.

4.
Note the checkbox along the bottom titled, "Copy this file to the default  file attachments folder and 
create a relative link." This gives you the option to:

Select the checkbox to copy the original file and place the copy in the .Data\PDF folder that is 
part of your EndNote library. Files in the .Data folder will sync and can be shared.

▪

Deselect the checkbox to always have EndNote look in the original folder for the inserted file. 
Files that are in their original locations, not in the .Data folder, will not be synced and cannot be 
shared. If the original file is moved, the link will break and you will not be able to open it from 
EndNote.

▪

For more information about this option, see Selecting a Relative Path or an Absolute Path for File 
Attachments.

Click Open.4.
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Selecting a Relative Path or an Absolute Path for File 
Attachments

What is a Relative Path Versus an Absolute Path?

Relative Path (checkbox selected)

EndNote will display an icon indicating the type of file inserted. You can insert up to 45 files into the File 
Attachments field.

Note: Another way to link a file to the File Attachments field is to drag and drop the file onto the reference 
in the Reference List or the Reference panel. Whether the file is saved with the database or is linked with 
an absolute path is determined by the default file attachment setting. See URLs & Links Preferences.

Note: In order to maintain cross-platform compatibility, any of the following characters in a filename will be 
replaced by an underscore when EndNote saves a copy of the file in the DATA\PDF folder with a relative 
path.

Note: Never rename attached files within the DATA folder. EndNote assigns each file a unique name that 
helps link it to a specific reference.

These characters are 
replaced with an underscore

\  back slash
/  forward slash
:  colon
*  asterisk
?  question mark
"  quotation mark
<  less than
>  greater than
|  vertical bar

When you link a file to the File Attachments field in a reference, you have the option of saving a relative path 
to the file or an absolute path to the file.

When you insert a link to a file with the File Attachments > Attach File command from the References menu, 
the file dialog includes a checkbox titled, "Copy this file to the default  file attachments folder and create a 
relative link."

When the checkbox is selected, EndNote makes a copy of the original file and places it in the .Data\PDF 
folder that is part of your EndNote library. This saves the file as a "portable link" that can move as part of the 
library. EndNote will always be able to access the file, even when you share your library with a colleague 
through Library Sharing or by giving them a copy of your library files (always include the complete .Data 
folder along with the .enl file).

File attachments stored in the .Data folder will sync and be included in libraries shared through the Library 
Sharing feature.
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Absolute Path (checkbox blank)

How Can I Tell Which Type of Path Was Used?

In the Summary Panel

In the Edit Panel

If you edit the original file on your computer, those changes will not be reflected in EndNote. You would need 
to make the changes to the copy in your library or clear the file from your EndNote reference and reinsert 
the file. To make changes to the copy in your library, open the file in the default application for that file type 
by selecting File Attachments > Open File from the References menu.

When the checkbox is blank, EndNote will use the complete path and filename to look in the original folder 
for the inserted file. This can be helpful if you plan to edit the original file and  you want those changes 
reflected when you access the file from within EndNote. However, if you ever move the file from the original 
folder, EndNote will not be able to access it unless you clear the file from your EndNote reference and 
reinsert it from the new folder location. If you send your library to a colleague, the file will not be available.

File attachments outside the .Data folder will not sync and will not be shared through the Library Sharing 
feature.

At the top of the Summary panel you will see a list of attached files. Files showing only a file name are 
stored in the .Data\PDF folder and have relative links. Files showing path information are not stored in 
the .Data\PDF folder and have absolute links.

Go to the Edit panel for the reference, then scroll to the File Attachments field. Hold your mouse pointer over 
the file icon.

If the file was linked with an absolute link, the file name will not include the .Data\PDF folder for your 
library.

▪

If the file was linked with a relative path, the file name will include the .Data\PDF folder for your 
library.

▪

You can also determine the type of path by previewing the File Attachments field. Use an output style such 
as Show All Fields, which includes the File Attachments field, or make your own custom style. 
See Introduction to Output Styles for information on creating custom styles. In the preview, file attachments 
appear as:

Files with relative links in the .Data folder begin with "internal-pdf" while files with absolute links show a full 
path name.
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Selecting a Default Setting for the Path

Converting Absolute Paths to Relative Paths

Inserting the Same File Again

Removing a Linked File from File Attachments

Since you likely will want most of your linked files treated the same way, you can select a default setting for 
the "Copy this file to the default file attachments folder and create a relative link" checkbox. You can change 
the default setting from the Preferences panel. See URLs & Links Preferences.

You still have the option to override the default setting each time you insert a file into the File Attachments 
field.

If you are working with a library that was created with a version of EndNote prior to version X, all of your 
existing linked files are saved with absolute paths. You can easily change your absolute paths to relative 
paths, which will allow you to easily share your library, along with linked files, with colleagues.

To convert absolute paths to relative paths:

Before you begin, back up your EndNote library. This change cannot be reversed. You can find 
information on creating a compressed library as a backup at Saving a Compressed Copy of a 
Library.

1.

In the Reference List, select the references you wish to modify.2.

From the References menu, select File Attachments > Convert to Relative Links.3.

For each selected reference, EndNote locates each file linked in the File Attachments field and copies those 
files into the .Data\PDF folder for the library.

If you try to insert a link to the same filename again in the same reference, your results are different 
depending on whether you are inserting files with a relative path or an absolute path.

Relative Path: The relative path always points to the library’s .Data\PDF folder. EndNote will attach the file 
again, giving it a new name.

Absolute Path: Because you could have several absolute paths pointing to the same filename in different 
folders, it is possible to link to the same filename numerous times.

Before you remove a linked file, make sure you have a backup of the original file. This process cannot be 
undone. You can find information on creating a compressed library as a backup at Saving a Compressed 
Copy of a Library.

To remove a linked file from the File Attachments field:

Select the reference in the Reference List.1.

In the Summary  panel for the reference, select the drop-down list for the attachment you wish to 
remove, then select Delete from the list.

2.

OR
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Saving a Copy of an Attached File

Opening a Linked File or URL

In the Edit  panel for the reference, scroll to the File Attachments  field, select the drop-down list for 
the attachment you wish to remove, then select Delete from the list.

3.

If the file was linked with an absolute path, the File Attachments field no longer points to the file. The original 
file remains intact.

If the file was linked with a relative path, that file is deleted from the library’s .Data\PDF folder, and the File 
Attachments field no longer points to it. You will not be able to reinsert the link unless you have the original 
file stored elsewhere on your computer.

Note:  See How Can I Tell Which Type of Path Was Used?  for information on identifying relative or 
absolute links for files.

Whether an attached file is saved with a relative path in a library’s .Data\PDF folder or with an absolute path 
to a specific location, you can save a copy of the attached file to any location.

To save a copy of an attached file from the Reference panel:

Select the reference in the Reference List.1.

Select the Summary panel.2.

Select the file attachment you want to copy.3.

Select Save As… from the drop-down list.4.

Use the file dialog to select a folder, enter a file name, then click Save to save the file.5.

To save a copy of an attached file from the References menu:

Select the reference in the Reference List.1.

Select File Attachments > Save As… from the References menu.2.

Use the file dialog to select a folder, enter a file name, then click Save to save the file.3.

Note: From the References menu, if more than one file is attached to the reference, only the first one is 
saved to disk.

Once a valid URL or file attachment appears in EndNote, you can use them to quickly access the linked web 
site or file.

To open a URL in a selected reference, select URL > Open URL from the References menu. If there 
is more than one URL listed in the URL field, the first one listed will open.

▪

To open a file attachment in a selected reference, select File Attachments  > Open  from the 
References menu. If there is more than one file attachment, the first one listed will be opened.

▪
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Using Keyboard Command Shortcuts

Renaming Attachments and PDF Files

Renaming Individual Attachments with Custom Names

Renaming PDFs Based on EndNote Field Contents

If you have more than one file attachment in a selected reference and don't want to open the first 
one, go to the Summary panel, select the attachment you want to open, then select Open from the 
drop-down list.

▪

You must have the necessary program installed on your computer in order for EndNote to open a file 
created by another program. For example, to open a Word document file, you must have Microsoft Word or 
another program that can read Word files installed on your computer.

Keyboard command shortcuts can also be used to open URLs and file attachments. The command shortcut 
for References > URL > Open URL is (Ctrl+G). The command shortcut for References > File Attachments > 
Open File is (Ctrl +Alt+P). Below are the expected actions for these commands.

The Open URL command (Ctrl+G) opens the first URL listed in the selected reference’s URL field.▪

The Open File command (Ctrl +Alt+P) opens the first linked file listed in the selected reference’s File 
Attachments field.

▪

If you need to enter multiple links into the URL field of one reference, enter them one per line. EndNote will 
open the first link in the field when you select Open URL. If you have multiple links, you can click on any one 
of them to activate the link.  (We recommend that you enter multiple URLs on separate lines. However, if 
more than one URL is entered on a single line, separated by semicolons, hold down the Alt key while you 
click on the URL you wish to open.)

EndNote includes two options to rename your attached files from within EndNote:

You can rename individual files, including PDFs, with custom names.▪

You can have EndNote rename PDFs with new names based on EndNote fields, either one EndNote 
reference at a time or or an entire group of references at once.

▪

This method allows renaming any file type, not just PDFs, but must be applied to one attachment at a time. 
To rename a selected attachment with a name of your choice:

In the Reference Summary or Edit panel, open the drop-down menu for the attached file you want to 
rename, and then select Rename Attachment… from the menu.

1.

In the Rename field, give the file a new name of less than 50 characters (remember to keep the 
extension part of the name intact), and then click the OK button to rename the file.

2.

The new file name for the attachment will appear in the EndNote record.

Along with being able to rename PDFs as you do other attachments using the method above, you can also 
have EndNote rename PDF file attachments based on data in the EndNote records they are attached to. 
This method can be applied to a single EndNote reference or the PDFs attached to multiple references.
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Renaming PDF Documents

Renaming Multiple PDF Documents

The Rename Options

Note: This method will change the name for all PDF files attached to a record. If you have more than one 
PDF attached to a record, they will have the same name except for a number at the end of the name. The 
new name is not based on the contents of the PDF; it is based on the data in the EndNote record holding 
the PDF.

In the Reference Summary  or Edit  panel, open the drop-down menu for an attached PDF file you 
want to rename, and then select Rename PDFs… from the menu.

1.

Select up to three fields to use in renaming the PDF. EndNote will remember your field choices for 
future renaming of PDF files. (See below for a list of fields that cannot be used in renaming PDFs.) 
The format of the PDF filename is First Field, Second Field, Third Field.

2.

Choose First: EndNote uses the selected field as the first field in PDF filename. For example, 
by Author.

a.

Then: EndNote uses the selected field as the second field in the PDF filename. For example, by 
Year.

b.

Then:  EndNote uses the selected field as the third field in the PDF filename. For example: by 
Title.

c.

Click the OK button to rename the PDF attachments for the reference.3.

Note: Data must exist in a selected field in order for renaming to occur. If no data is available, then 
EndNote inserts a hyphen between selected fields that have data.

You can also rename multiple PDF documents attached to multiple references.

Select one or more references that have attached PDF files.1.

From the References menu, select File Attachments, and then select Rename PDFs....2.

You will receive a warning message that this change cannot be undone, with a suggestion to backup 
the library first. Click OK to continue renaming the PDFs or Cancel to stop the process. See Saving a 
Compressed Copy of a Library and Saving a Copy of a Library for  information on backing up 
EndNote Libraries.

3.

If you chose OK to continue renaming PDFs, select your field choices for renaming.4.

Click the OK button to rename the files.5.

The Rename Options dialog allows you to select the fields used to rename your PDF attachments. You can 
select any field from the menu when renaming your PDF documents except the following fields.

Figure▪

File Attachments▪
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Changing Text in References

Find and Replace, Change Field, and Move Field

Last Updated▪

Rating▪

Read Status▪

You may use up to 50 characters to rename your PDF documents. This includes the period (.) and the 
filename extension. If a PDF that you are renaming exceeds the 50 character limit, then EndNote truncates 
the name of the PDF to meet the 50 character limit.

See also PDF Handling Preferences.

Global editing commands make it easy to keep your reference data consistent.

The Find and Replace command is available from the Library menu▪

The Change/Move/Copy Fields command is available from the Library menu.▪

The Find and Replace command searches for text in your library and either deletes that text or replaces it 
with other text that you specify. The Change Fields  command modifies any field  in your library by either 
inserting text at the beginning or end of the field, replacing all contents of the field with different text or 
deleting the contents of the field. The Move/Copy Fields command moves the entire contents of a field to a 
different field.

Note: Be sure that you have a current backup of your library; these operations cannot be undone with the 
Undo command.

The Find and Replace, Change Field, and Move Field commands can be used to make changes to a large 
number of references at once.  Here are some of the common uses for these commands.

Correcting consistently misspelled words or names.  
 
Use the Find and Replace command from the Edit menu to search for the misspelled term and 
replace it with the correct spelling.

▪

Updating author’s names.  
 
There may be variations of an author’s name in your data. For example, "Joe Cool," "Joe A. Cool," 
"J. A. Cool.," and so on. Since some styles prefer whole names and others abbreviated first and 
middle names, it is best to update names to full names and leave the work of abbreviating to the 
EndNote styles.

▪

Cleaning up your keywords.  
 
You can add a keyword  to a group of references using Change Fields. Use Find and Replace to 
replace a term with a new one. If there is a keyword that you no longer want in your references, use 

▪
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Find and Replace

Find and Replace to search for that text and replace it with nothing, thereby deleting it (you might 
also want to open your term list and delete it from there so that you do not use that term again).

Dating or labeling a set of imported references.  
 
It can be useful to add the date or source of data to a batch of newly imported references. Only the 
imported references are "showing" in the Reference List after importing. At this point, use Change 
Fields to add a word or phrase to any field in just those references.

▪

Moving fields of information in a set of imported references.  
 
Maybe your import filter  or connection file  consistently sent Note information to the Abstract field. 
Use the Move Fields option to cut all information from the Abstract field and move it into the Notes 
field. Don’t  forget to update your filter or connection file so it directs information to the correct field 
next time!

▪

Use the Find and Replace command to find text in your references and replace it with other text. Changes 
can be restricted to a particular field in your references. You can also apply:

Match Case and Match Words restrictions▪

Style changes that include bold, italics, underline, plain text, superscript, subscript, or symbol font▪

Caution: The Undo command from the Edit menu cannot undo the results of the Find and Replace 
command. Make sure you have a backup before making changes. See Saving a Compressed Copy of a 
Library for information on making a backup of your library.

The Find and Replace command will only be applied to the references showing in the current Reference 
List. Use the following options to control which references are showing:

Selecting the All References group will show all the references in the library and the change will be 
applied to any that match the Find and Replace criteria.

▪

Selecting a group will limit Find and Replace to only the references in that group.▪

Performing a search in advance of Find and Replace will bring up a set of search results in the 
Reference List, allowing you to limit Find and Replace to the showing results. You can find detailed 
information on searching EndNote libraries in Searching EndNote References.

▪

If you wish to confine Find and Replace to a specific set of references that none of the methods 
above will provide, create a custom group and put all the references you want to use with Find and 
Replace in that group, then select that group to show only those references. You can find information 
on creating custom groups in Creating a Custom Group.

▪

To use Find and Replace to replace text in your references:

After using one of the options above to limit the references in the Reference List to show only those 
you want to change, select Find and Replace from the Library menu.

1.

From the Select a Field list, select the field to be searched.2.
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Change Fields

In the Find text box, type the text you wish to change. To enter a Carriage Return or Tab in the text 
box, use the Insert Special button.

3.

Change the Match Case or Match Words settings, if necessary.4.

By default, the Match Words option is always selected. If you change this setting, pay close attention to 
whether or not the term you are changing could appear as part of another word or in a different context 
depending on the capitalization.

In the Replace with text box, type the text that should replace the original text. To enter a Carriage 
Return or Tab in the text box, use the Insert Special button.

5.

Select the Retain Capitalization option to maintain the same capitalization as the text being replaced.

Retain Capitalization should be selected if replacing a term that might appear with different 
capitalization. For example, any word may have its first letter capitalized if it is the first word in a title, but 
may also appear in all lowercase in other places. Do not select Retain Capitalization if you are replacing 
an acronym with its unabbreviated version.

Click the Change button to search the selected references for the specified text and replace it with the new 
text. Before replacing any text, EndNote has you verify the changes.

Click OK if all of those items in the dialog are correct. EndNote replaces the text and displays the number of 
references that were changed.

The Change Fields command allows you to change the contents of a field  for the references that are 
showing in the Reference List.

Caution:  You cannot undo the Change Fields operation. Once you perform this operation, EndNote 
changes the data in the selected field in all the references in the showing Reference List. We recommend 
that you make a backup copy of your library before making changes. See Saving a Compressed Copy of 
a Library for information on making a backup of your library.

The Change Fields command will only be applied to the references showing in the current Reference List. 
Use the following options to control which references are showing:

Selecting the All References group will show all the references in the library and the change will be 
applied to any that match the Change Fields criteria.

▪

Selecting a group will limit Change Fields to only the references in that group.▪

Performing a search in advance of Change Fields will bring up a set of search results in the 
Reference List, allowing you to limit Change Fields to  the showing results. You can find detailed 
information on searching EndNote libraries in Searching EndNote References.

▪

If you wish to confine Change Fields to a specific set of references that none of the methods above 
will provide, create a custom group and put all the references you want to use with Move/Copy in 
that group, then select that group to show only those references. You can find information on 
creating custom groups in Creating a Custom Group.

▪

To change the contents of a field:
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After using one of the options above to limit the references in the Reference List to show only those you 
want to change, select Change/Move/Copy Fields from the Library menu.

From the Select a Field list, select the field that you want to modify.

Select one of the following options:1.

Insert after field’s  text  appends text at the end of the chosen field. It does not modify the text 
already in the field.  
 
By default, when you select this option, the "Include a space before the new text" checkbox is 
selected at the bottom of the dialog, to insert a space between the existing text and the new 
text.  
 
You could also use the Insert Special  button to insert a carriage return before the new text. If 
you do this, unmark Include a space before the new text  to avoid having both a space and a 
carriage return.

▪

Insert before field’s text inserts the text at the beginning of the chosen field. It does not modify 
text that is already in the field.  
 
By default, when you select this option, the "Include a space after the new text" checkbox is 
selected at the bottom of the dialog, to insert a space between the new text and the existing 
text.  
 
You could also use the Insert Special button to insert a carriage return after the new text. If you 
do this, unmark Include a space after the new text to avoid having both a space and a carriage 
return.

▪

Replace whole field with replaces the entire contents of the field with the text entered in the text 
box.

▪

Clear field deletes the entire contents of the chosen field. You cannot enter text in the text box.▪

Change Case  applies new case formatting to the entire contents of a field. Options include: 
Sentence case, lowercase, UPPERCASE, Every Word, and tOGGLE cASE. You cannot enter 
text in the text box.

▪

In the text box, type the text that you want to add to the field. To enter a Carriage Return or Tab in the 
text box, use the Insert Special button.

2.

Select (highlight) the text that you entered in the text box, and then select a font style: Bold, Italics, 
Underline, Plain, Superscript, or Subscript, or Symbol Font. This is optional.

3.

Click the OK  button. EndNote will ask you to confirm the changes. The dialog EndNote presents 
provides this information:

4.

How many references will be changed▪

The library in which the changes will be made▪

The type of change that will be made▪

Click OK to continue with the changes or click Cancel to cancel the operation.5.
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Move/Copy Fields
The Move/Copy Fields command allows you to move and copy field data. Both commands apply to all of the 
references that are showing in the Reference List.

The Move Fields option allows you to move the entire contents of one field to another field within a 
reference. All data, including any formatting that you applied to the source field, is moved to the destination 
field.

Caution:  You cannot undo the Move operation. Once you perform this operation, EndNote removes the 
source field from all the references in the Reference List. We recommend that you make a backup copy of 
your library  before making changes. See Saving a Compressed Copy of a Library  for information on 
making a backup of your library.

The Copy option allows you to copy the entire contents of one field to another field within a reference. Both 
the source field and the destination field will contain the same data. All data retains any formatting that you 
applied to the source field and to the destination field.

The Move/Copy Fields command will only be applied to the references showing in the current Reference 
List. Use the following options to control which references are showing:

Selecting the All References group will show all the references in the library and the change will be 
applied to any that match the Move/Copy criteria.

▪

Selecting a group will limit Move/Copy to only the references in that group.▪

Performing a search in advance of Move/Copy will bring up a set of search results in the Reference 
List, allowing you to limit Move/Copy to  the showing results. You can find detailed information on 
searching EndNote libraries in Searching EndNote References.

▪

If you wish to confine Move/Copy to a specific set of references that none of the methods above will 
provide, create a custom group and put all the references you want to use with Move/Copy in that 
group, then select that group to show only those references. You can find information on creating 
custom groups in Creating a Custom Group.

▪

To move/copy the contents of one field to another:

After using one of the options above to limit the references in the Reference List to show only those 
you want to change, select Change/Move/Copy Fields from the Library menu.

1.

Select the Move/Copy Fields tab.2.

In the dialog that appears:3.

Select the Move Field radio button to move information to another field.▪

Select the Copy Field radio button to copy information to another field.▪

Use the From list to select the source field from which you want to move or copy the data.4.

Use the To list to select the destination field to which you want to move or copy the data.5.

Select one of the following options:6.

Insert after field's text (the default option).▪
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Checking Spelling

Spell Check

Check Spelling Dialog

Insert before field's text.▪

Replace entire field.▪

Click OK to  move or copy the data from one field to another field within each reference in the 
showing Reference List. Click Cancel to stop the operation.

7.

Caution: When using the Move option, you have the choice of inserting the moved text before or after the 
data in the destination field or replacing the entire contents of the destination field. If replacing the entire 
field, you have the additional option of whether or not to move empty fields. If you clear the "Don’t move 
empty fields" checkbox, then any reference with an empty originating field deletes the contents of the 
corresponding destination field (thereby making it empty as well). If this option is marked (turned on), the 
contents of the destination field will not be deleted if the originating field is empty.

EndNote's Spell Check can check the spelling of one reference at a time.

If text is highlighted in the active reference, that selection is checked first, and then you are prompted to 
check the rest of the reference.

EndNote’s  spell checker can check spelling accuracy in all fields except the Author fields (Author, 
Secondary Author, Tertiary Author, Subsidiary Author, and Translated Author) and the URL, Figure, and File 
Attachments fields.

To start spell checking:

Select the Edit panel of the reference you wish to check.1.

(Optional) If you want to check only a portion of the text, highlight only that text.2.

Right-click  within the Edit  panel, then select Spell Check from  the drop-down menu, or select Spell 
Check from the Library menu, or press Ctrl+Y on the keyboard.

3.

If EndNote finds a word that is not found in the selected dictionaries, it displays a Check Spelling dialog.

Note: The Spell Check option under the Library menu will only be available when in the Edit panel.

The Check Spelling dialog works just like a spell checker in a word processor. For a complete description of 
each button in the dialog, see Check Spelling Dialog.

The Check-Spelling Dialog appears if a word requiring your attention is detected. You can use the dialog to 
specify whether the word should be ignored or replaced. Descriptions of how the various parts of the dialog 
work are below.
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Note: The labels of some buttons and text boxes in the dialog change according to the context.

Note:  If you are unable to add dictionaries, or to add words to or edit dictionaries, it is probably because 
your Windows security settings are preventing you from making changes in the \\Program Files (x86) 
folder. The best option is to copy the C:\Program Files (x86)\EndNote 20\Spell folder and all its contents 
to another location, then load the dictionary files from that location. This should allow you to make 
changes to the files or create your own dictionary files.

The Check Spelling dialog includes the following options:

Add button: Causes the reported word to be added to the dictionary selected in the Add Words To 
list. Use the Add  button if a correctly spelled word you use often is reported as a misspelling (for 
example, your family name). If the word is not used frequently, you may want to select the Ignore or 
Ignore All  buttons instead. This button is enabled only if a user dictionary has been selected in the 
Add Words To list.

▪

Add Words To list: Indicates which user dictionary words will be added to when you select the Add 
button. The Add Words To list shows all user dictionaries currently open. You can open or close other 
dictionaries via the Dictionaries dialog, which is accessible by selecting the Dictionaries button.

▪

Cancel button: Stops the current spelling check.▪

Capitalization box: Contains an uncapitalized word that exists in the dictionaries in capitalized form 
only. You can edit the word in this box or select a suggestion from the list, then click the Change 
button to correct the word, or click the Ignore button to skip the word.

▪

Change button:  Causes the reported word to be replaced. If the problem word was edited, the 
edited word is used as the replacement. Otherwise, the selected suggestion is used as the 
replacement. Only this occurrence of the reported word is replaced. If you want this and all following 
occurrences of the word replaced, select the Change All button.

▪

Change All button: Causes this and all following occurrences of the reported word to be replaced. If 
the problem word was edited, the edited word is used as the replacement. Otherwise, the selected 
suggestion is used as the replacement. If you want only this occurrence of the word to be replaced, 
use the Change  button. If the reported word is one you frequently misspell, you might consider 
adding it to a user dictionary via the Dictionaries dialog. You can display the Dictionaries dialog by 
selecting the Dictionaries button.

▪

Consider Changing box: Contains a word which may be misspelled or otherwise incorrect, and is 
presented with a candidate replacement word. You can change the word by selecting the Change 
button, or skip it by selecting the Ignore button.

▪

Delete button:  Removes the word from the text. This button appears when a doubled word has 
been detected, or when the contents of the problem-word box are deleted.

▪

Dictionaries button:  Causes the Dictionaries dialog to be displayed. You can use the Dictionaries 
dialog to open or close user dictionaries, and to edit the contents of user dictionaries.

▪

Ignore button: Causes this occurrence of a misspelled word to be skipped. If the same misspelled 
word appears later, it will be reported again.

▪

Ignore All button: Causes this and all further occurrences of a misspelled word to be skipped. You 
might use this button if the word reported as a misspelling is actually spelled correctly. If the word is 
one you use frequently, you may wish to ignore it permanently by selecting the Add button.

▪
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Spell Check Options and Dictionaries

Reverting References

Not in dictionary box:  Indicates that a misspelled word was detected. The word is considered 
misspelled because it could not be located in any open dictionaries, or was marked with an exclude 
action. You can edit the word in this box or select a suggestion from the list, then click the Change 
button to correct the word, or click the Ignore button to skip the word.

▪

Options button: Displays the Options dialog. You can use the Options dialog to set spelling-checker 
options.

▪

Suggest button:  Search more thoroughly for suggested replacements for the current misspelled 
word. Each time you click the Suggest  button, a "deeper" search is made. The Suggest button is 
disabled once all possible suggestions have been located.

▪

Suggestions list:  Contains a list of suggested replacements for the word reported as misspelled. 
Subsequent presses of the Suggest button may yield more suggestions. The word selected in the 
Suggestions list will be used as the replacement when the Change or Change All buttons are 
pressed, unless the word in the problem box was edited.

▪

Undo Edit button: Remove any changes made to the text in the problem box. This button appears 
only if the text in the problem box has been changed.

▪

You can access Spell Check Options and Dictionaries in two ways:

From the Edit menu, select Preferences, then Spell Check.▪

Start Spell Check. When EndNote detects a misspelled word, the Check Spelling dialog appears. An 
Options button and a Dictionaries button are available on the dialog.

▪

Note:  If you are unable to add dictionaries, or to add words to or edit dictionaries, it is probably because 
your Windows security settings are preventing you from making changes in the \\Program Files (x86) 
folder. The best option is to copy the C:\Program Files (x86)\EndNote 20\Spell folder and all its contents 
to another location, then load the dictionary files from that location. This should allow you to make 
changes to the files or create your own dictionary files.

For information about the Spell Check Options and Dictionaries preferences, including a list of dictionaries 
supplied with EndNote, see Spell Check Preferences.

The Revert Reference command undoes (reverts) all changes made to a reference since it was last opened 
or saved. Revert Reference is not available after you close the reference.

To revert changes, right-click in the Edit panel, then select Revert Reference from the list.

To remove the very last change made to a reference, use the Undo  (Ctrl+Z) command in the Edit  menu 
before leaving the field.

Page 85 of 586

 



Clarivate EndNote 20 User Help Guide

Cut, Copy, and Paste Text in References

Using Drag-and-Drop Within a Reference

Copying and Pasting Complete References

Copying References Using the Copy and Paste Commands

The Cut, Copy, and Paste commands in the Edit menu can be used to move text from one field  in a 
reference to another field by selecting and copying or cutting the text and then pasting it in the desired 
location. You can also Copy and Paste text from a field in an EndNote reference to your word processor. 
Similarly, you can Copy text from a word-processing document and Paste it into a reference. If it is important 
to paste the text along with the fonts and text styles, use the Paste with Text Styles command in the Edit 
menu. The regular Paste command does not include font, size, or text style information when pasting into 
EndNote from another program. Avoid pasting unwanted fonts and text styles into EndNote references 
because those fonts and text styles will carry through into future bibliographies.

Text may be moved within a reference by selecting the text in the Edit panel, and then dragging and 
dropping it in a new location.

Note: When text is moved this way within a reference, it is moved from one location to another. When it is 
dragged from a reference  in one library to a reference in another library, or to another program (such as 
your word processor), the text is moved to the target reference and removed from the original location.

To drag-and-drop text:

Select the text to be moved.1.

Click on the selection, and keep the mouse button pressed while you drag the text to another 
location. When the cursor is positioned in the right place, release the mouse button to drop the text in 
the selected location.

2.

See also Copying and Pasting Complete References.

In addition to copying and pasting text between fields, EndNote can Copy and Paste entire references 
between libraries.

Select one or more references in the Reference List (hold down the Ctrl  key to select multiple 
references or the Shift key to select a range of references).

1.

Select Copy from the Edit menu and those references are copied to the Clipboard.2.

Open another EndNote library and select Paste from the Edit menu. The references you copied are 
pasted into the library and sorted correctly with the existing references.

3.
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Copying References Using Drag-and-Drop

Copy References To

An easy way to copy references between libraries is to use the drag-and-drop functionality. Simply select the 
references you want to copy, click on any part of the selection, and use the mouse to drag them to another 
open library. Release the mouse button when the cursor is over the destination library, and all of the 
selected references will be copied into the library.

If you need to copy all of the references in one library to another library, you can also use the Import 
command to import one library into the other.

Note: Any time you copy a reference and paste it into another library or import a reference into another 
library, the reference is assigned a new record number in the destination library.

The Copy Reference To command allows copying a set of references to an EndNote library of your choice.

From the References menu, select Copy References To. You will have these options:

New Library: This will create a new library and copy the selected references into it.▪

Choose Library: This will allow you to choose an EndNote library on your computer and copy the 
references into it. The library does not need to be open in EndNote. When the references are copied 
into it, the library you chose will be opened and display the copied references in a Copied 
References group.

▪

[YourCurrentLibraryName].enl: The third option will only appear when you have selected 
references from online search results. It will show the name of the library you are currently working in 
and will allow you to copy the references from your online search results into your current library.

▪
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Searching EndNote References

The Simple Search Panel

The Advanced Search Panel

Search Line

EndNote provides Search features that enable you to locate specific references or groups of references. For 
example, you can select a very general search, one that scans the entire library; or you can limit your 
searches to specific fields (such as the Author or Keywords fields). You can also create more complex 
searches using a variety of operators such as And, Or, Not, Greater than, Less than, and others.

You can use the Search panel to search EndNote libraries as well as remote databases that are available 
online. See Searching Online Databases for information about online database searches.

The default Simple Search panel allows you to quickly search your entire library (and PDFs and PDF Notes) 
by typing a word or phrase into the single text box. EndNote executes a general search of all fields.

EndNote uses an implied AND Boolean operator  when you enter two or more adjacent terms in Simple 
Search. For example, entering rainbow trout fish farm is equivalent to entering rainbow AND trout AND 
fish AND farm.

Use double quotation marks (" ") to search for exact phrases and to override the implied AND Boolean 
operator.

If you need to perform a more specific or complicated search, click the Advanced Search button  to 
access The Advanced Search Panel.

The Advanced Search panel offers far more control over your EndNote search, using Boolean 
operators and comparison options, as well as abilities to save search strategies and  reload saved search 
strategies.

A search line includes a Logical operator, the field  to be searched from the Field list, the Comparison 
operator, and a blank field in which you enter your search terms. Use the plus or close (X) buttons to the 
right of each search line to insert or delete a line. You can have up to ten lines in your search.
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Boolean Operators List

Field List

Comparison List

Search Fields

The AND, OR, and NOT operators between the search lines indicate how the search lines are to be 
combined. See Combining Search Lines with AND, OR, and NOT Operators.

The Field list allows you to restrict your search to a particular field—such as Author, Year, or Keywords— 
or expand  it to Any Field. By default, the Field lists are set to search Author, then Year, then Title. You can 
change the default search strategy by setting the operators, fields, and comparison terms you want to use 
for your new default strategy, then selecting Set Default from the Search Options drop-down menu.

You can also restrict your search to PDF files attached to references by selecting the PDF option from the 
field list. The Any Field + PDF with Notes option allows you to search any field within a reference and all 
PDF files in the selected group that you are searching.

See Restricting Searches to Specific Fields for more information.

Select an item from the Comparison list to indicate how the search term should relate to the field(s) being 
searched. For example, you can find references in which:

The Journal field begins with the term "science."▪

The Journal field contains "science" anywhere in the field.▪

The full Journal name is "science."▪

See Using Comparison Operators for more information.

The search term is the word or phrase that you want to locate in a reference. Enter your search terms in one 
or more search fields. Search terms can be typed or pasted into the fields. For special search items, such as 
tab or paragraph break characters, try copying and pasting them from Notepad. Copying from Notepad 
assures special characters will be copied without extra formatting.
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Asterisk (*) Wildcard

Save Search and Load Search

Set Default and Restore Default

Searching a Group or Group Set

Restricting Searches to Specific Fields

Expand your library  retrieval results by adding wildcards before and after search terms. The asterisk 
represents any group of characters.

Fields and PDF files can be searched using the asterisk wildcard.▪

No minimum character length is required.▪

Note: EndNote automatically applies left- and right-hand truncation to your search terms. So, by default, 
searching for "look" would find "look," "looking," or "outlook." However, you can still use the asterisk (*) 
wildcard before and after a search term, if you prefer.

If you frequently use the same search strategies on the Search panel, you can use the Search Options 
menu to save these searches and later load them when you need them. See Saving Search Strategies.

Use the Search Options drop-down menu and select Set Default to save the configuration of all of the items 
on the Search panel except for the search terms. Use the Search Options drop-down menu and select 
Restore Default at any time to return the original configuration. See Saving Search Strategies.

You can limit your search to a specific group or group set of references.

To search a group or group set:

Select the group or group set. The Reference List will change to display only the references in that 
group or group set.

1.

Select either the Simple Search or Advanced Search panel.2.

Enter your search strategy and click Search.3.

Use the Field list on the Advanced Search panel to narrow your search to a specific field. You can select 
Any Field to look for your search terms in any of the fields in your references.

For example, to find references published in 2013, restrict the search to the Year field to avoid finding 
entries that include 2013 in the abstract, title, or elsewhere.

The field names in the Field list are EndNote’s  "generic" field names. For example, Author represents 
Reporter, Editor, Artist, or any other variations of the Author field used in the different reference types. 
See The Generic Reference Type for a complete list of generic field names. To find the generic name that 
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Searching Fields and PDF Files

Rules for Single Word Searching

matches a field for a specific reference type, select that reference type from the List of Reference Types or 
by selecting it from the Modify Reference Types dialog.

To access the Modify Reference Types dialog:

From the Edit menu, select Preferences.1.

Click the Reference Types option in the list of preferences.2.

Click the Modify Reference Types button and the Modify Reference Types dialog will open.3.

EndNote can import references from hundreds of sources, each of which uses its own set of field names. 
Once you have transferred references into EndNote, you will search for information by using the destination 
EndNote generic field names, and not the original field names from the information provider. For example, 
the PMID number, when importing data from PubMed, typically transfers into the Accession Number field in 
EndNote. To search for a specific PMID in EndNote, search the Accession Number field.

You can search all fields, the attached PDF files, and added PDF notes in your selected Reference List.

Select the Any Field + PDF with Notes option from the Field list.1.

Select an item from the Comparison  list to indicate how the search term(s) should relate to the 
search.

2.

Enter the search term(s) that you want to locate.3.

Click the Search button.4.

The following rules apply when you select the PDF option or the Any Field + PDF with Notes from the Field 
list.

By default, EndNote ignores capitalization when searching for text. For example, a search for the 
term hospital also finds Hospital.

▪

If you enter a phrase, EndNote retrieves references that contain the words you entered in any field or 
in a PDF file. The words appear together if they are in any EndNote field or any PDF file. For 
example the query, hospital care retrieves references containing the term "hospital care" in either a 
field or a PDF file.

▪

When using the Advanced Search panel, EndNote searches quotation marks (" ") as characters 
when you select a specific field, the PDF option, or the Any Field + PDF with Notes option. For 
example, the query “poured cold water” only retrieves references that contain the phrase showing 
within a set of quotation marks somewhere in the reference, a  linked PDF  file, or within a Sticky 
Note. The phrase without quotation marks would be ignored in Advanced Search.

▪

When searching for a single word in any field using the Contains comparison operator, EndNote applies 
both left- and right-hand truncation. For example, the term plant finds:
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Combining Search Lines with AND, OR, and 
NOT Operators

A Strategy Tip for the AND, OR, and NOT Operators

Plant 
plant 
plant classification 
planter 
"plant" 
transplant

You can combine search lines on the Search panel with the Boolean operators AND, OR, and  NOT to 
produce the following effects:

AND  finds references that match the preceding search line(s) and the following search line. 
AND narrows search results.  
 
Example: A search for parrot AND corvid finds only those references that mention both terms.

▪

OR  finds references that match either the preceding search line(s) or following search term. 
OR broadens the search.  
 
Example: A search for parrot OR corvid finds all references that include either term.

▪

NOT finds all references containing the preceding term(s) and then omits references that contain the 
subsequent term. NOT narrows search results.  
 
Example: A search for parrot Not corvid finds all references including parrot, excluding any parrot 
references that mentioned corvid.

▪

You can use the Boolean operators (AND, OR and NOT) in sequence with as many as ten search lines to 
build your search strategy.

Items in combination searches are executed from the top field to the bottom field of the Search panel. If you 
will be mixing the AND, OR, and NOT operators in your search, you will generally get the best results by 
following this strategy:

Use the OR operator first, to broaden the search.1.

Use the AND operator next, to narrow the search.2.

Use the NOT operator last, to exclude items from the search.3.
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Using Comparison Operators

Comparison Operators

Field Comparison Operator Search Term
Title Contains parrot

For example, in the search strategy shown above, EndNote will try to find any reference in the Reference 
List that contains either parrot or corvid in any field, but those references must also contain 2008 in the year 
field, and cannot have the term bat in any field. In this search of the sample library, five references were 
found.

However, with the search below twenty-three references were found. This was because instead of 
broadening the search first with the OR  operator, then narrowing (refining) it with the AND  operator, this 
search first narrowed the search with the AND  operator and then broadened it with the OR  operator, 
producing poor results.

The "comparison operators" are used to indicate how the search term relates to the chosen field  in that 
search line. For example, if you have a search line that looks like this:

You will be searching for references where the Title (the search field) contains (the comparison operator) 
parrot (the search term).

The comparison operators function as follows:

Contains:  Finds all references where the search field includes the search term. The search term 
includes both left and right truncation, so a search for "house" would find "house," "greenhouse," and 
"household" anywhere in the field.

▪

Note:  Only the "Contains" comparison operator is available when searching online databases. The 
following operators are available only for searching the EndNote library. Please note that some operators 
may not work together with some options selected from the Field list.

Is:  finds all references in which the entire content of the search field is exactly the same as the 
search term.

▪

Note:  This operator does not work in searches where you select the Any Field + PDF with 
Notes option from the Field list.

Is Less Than: finds all references in which the search term is less than the contents of the search 
field.

▪
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Is Less Than or Equal To: finds all references in which the search term is less than or identical to 
the contents of the search field.

▪

Is Greater Than:  finds all references in which the search term is greater than the contents of the 
search field.

▪

Is Greater Than or Equal To:  finds all references in which the search term is greater than or 
identical to the contents of the search field.

▪

Note: For all of the Greater Than and Less Than comparisons, the comparison is either numerical 
or alphabetical based on the nature of the term. When the fields have both numbers and letters, 
numbers are considered less than letters, and empty fields are ignored.

Field Begins With:  finds all references in which the search term is found at the beginning of the 
selected field (also referred to as right field truncation). The search term can be a partial word, a full 
word, or several words, and will be compared to the initial text in the field. If you enter more than a 
single word, remember that punctuation and spaces are significant, so you must enter exactly what 
is found in the reference.

▪

Note:  This operator does not work in searches where you select the Any Field + PDF with 
Notes option from the Field list.

Field Ends With: finds all references in which the search term is found at the end of the field (also 
referred to as left field truncation). The search term can be a partial word, a full word, or several 
words, and will be compared to the ending text in the field. If you enter more than a single word, 
remember that punctuation and spaces are significant, so you must enter exactly what is found at the 
end of the field.

▪

Note:  This operator does not work in searches where you select the Any Field + PDF with 
Notes option from the Field list.

Word Begins With: finds all references in which the search term is found at the beginning of a word 
anywhere in the field (also referred to as right word truncation). Punctuation and spaces are ignored. 
This can help you find words that start with the same root. For example, searching for a word that 
begins with "land," would also find "landing" and "landfill," but not "Iceland" or "island."

▪

Note: The Field begins with, Field ends with, and Word begins with comparisons all treat Author fields like 
any other field. There is no manipulation of surnames and first names; EndNote looks at the literal string 
of text in the field.
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Examples of Comparison Operators in Searches

Field
Comparison 
Operator

Search 
Term EndNote Finds

Year Is greater than 2020 all references published after 2020
Year Is less than 2020 all references published before 2020

Year
Is greater than 
or equal to 2015 references published during or after 2015

Title Is less than A all references where titles start with a number

Author
Is less than 
or equal to C

all references with authors whose last names 
begin with A, B, or a number; this would not 
match a name such as "Carter," as "Ca is 
greater than C

Author
Is greater than 
or equal to S

all references with authors whose last names 
begin with S-Z

Title Contains bird all references with "bird" in the title

Title Is bird
all references with "bird" as the exact title, 
"birding" or "birdlike" would not be found

Abstract Is   all references with no abstract (empty field)

Title
Field begins 
with bird

all references where titles start with "bird" 
including "birding," and "birdlike behavior," but 
not "Once a bird"

Abstract
Field ends 
with bird

all references where abstracts end with "bird," 
which would include "a single bird," but not 
"two birds" or "birding"

Any field
Word begins 
with house

all references where any field includes a word 
that begins with "house," which would include 
text such as "U.S. House of Representatives" 
and "household," but not "greenhouse"

Search Command Tips

Canceling Searches

Finding Tabs and Carriage Returns

 

Pressing Esc cancels a search in progress.

For special search items, such as tab or paragraph break characters, try copying and pasting them from 
Notepad. Copying from Notepad assures special characters will be copied without extra formatting.
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Searching for Numbers

Author Fields

The Year Field

Finding Empty Fields

Finding File Attachments

  File Attachments Contains [name of the file]

  Record Number Is greater than or equal to 1
NOT File Attachments Is [blank]

When you search for a number, EndNote looks for that exact text string  in your reference text. For example, 
a search on "Any Field" which "Contains" the search text "0025" will match the numbers 00025 and 0025, 
but it will not match 25.

There is an exception for record numbers. Record numbers, which are assigned by EndNote, cannot include 
leading zeros. When you search Any Field for a number, EndNote looks for an exact match in all text fields; 
however, leading zeros are stripped from your search text before comparing it to record numbers. Only an 
exact match of a record number will be returned. So, a search of the Record Number field for "0025" will 
match record number 25. It will not match record number 250.

The field names in the Field list are EndNote’s "Generic" field names, which means that Author represents 
Reporter, Editor, Artist, or any other variations of the Author field used in the different reference types.

If you wish to search for author initials, make sure to include a space between the first and second initial. 
For example:

Smith, J P

If you do not include a space between initials, EndNote will assume that JP is a complete first name.

When searching in the Year field, a search for "1994" retrieves only references published in 1994, where as 
a search for "94" retrieves references from the 1940s and 1994.

EndNote can search for empty fields. Select the desired field from the Field list, select "Is" as the 
comparison operator, and leave the search term blank. Click Search and EndNote finds references in which 
the chosen field is blank.

You can easily search for a specific file attachment by name. Search for:

To search for all references that include file attachments, enter these two search lines:

 
The first line ensures that all references are searched and gives EndNote something to apply the NOT 
command against, and the second line looks for references in which the File Attachments field is not blank.
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Setting and Restoring Defaults for the Advanced Search 
Panel

Saving Search Strategies

Note: Another easy way to see references with file attachments is to click on the paper clip header in the 
Library window to sort those references at the top of the list of references.

Use the Search Options  drop-down and select Set Default  to save the current configuration of the Search 
panel as your default. The default configuration will appear whenever you first display the Advanced Search 
panel.

The layout of the window (such as the number of search lines) is saved, as are all of the operators and field 
names. The search terms are not saved.

Use the Search Options drop-down and select Restore Default to clear out all of the search terms currently 
entered in the Search panel, and reset all of the settings back to the default configuration.

The Save Search and Load Search commands on the Search Options drop-down menu allow you to 
save the settings currently on the Search panel and recall them for later use. Most of the options on the 
Search panel are saved, including the search terms; however, the target of the search (the EndNote library 
or online database) is not saved.

To save a search:

Configure the Search panel.1.

From the Search Options drop-down select Save Search.2.

A dialog appears, prompting you to name the search strategy. Enter the name and click Save. The 
search files are saved by default  in the C:\Users\[YourProfileName] 
\AppData\Roaming\EndNote\Searches  folder. You may save them elsewhere if you prefer, but 
EndNote will open to this Searches folder when you choose to Load a saved search. (Note that the 
AppData folder is a hidden folder in Windows by default.) EndNote adds .enq  as the file name 
extension for saved searches.

3.

To load a saved search:

On the Search panel, from the Search Options drop-down select Load Search.1.

In the dialog that appears, select the search strategy that you would like to use, and click Open.2.

The contents and settings of the Search window change to reflect the saved search. Click Search to 
initiate the search.

3.

Saved searches are especially useful if you use EndNote's connection files to search online databases. 
When saving search strategies for online databases, it is helpful to include an abbreviation of the online 
database  name the search is intended for in the file name. See How to Search an Online Database  for 
information on using connection files.
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Finding Text in a Single Reference

Finding Duplicate References

You can save the search results (the set of matching references) as a group. You can use saved search 
strategies to set up Smart Groups. Smart groups are updated as you add references to your library. Or, you 
can save specific results to Custom Groups. Custom groups are not updated as you add references to your 
library.

When you have a reference that contains a significant amount of text, such as long abstracts or notes, it can 
get hard to find things.

To jump to specific text within a reference, use the Find Text command in the Edit panel.

Select the reference to search in the Reference List.1.

Select the Edit panel.2.

Click the Find Text button (the magnifying glass) to open the Find Text dialog.3.

Enter the search term and press the Enter key.4.

EndNote will jump to the first occurrence of the text and highlight it within the reference. You can use the 
Next button (the down arrow) to jump to the next occurrence of the text.

In order to help locate duplicate references, EndNote offers a Find Duplicates command. This command 
searches the references that are currently showing in the Library window to identify duplicates. Duplicates 
are determined based on the duplicate criteria specified in preferences. See Duplicates Preferences.

To find all of the duplicate references in a library:

With the library open, click on the All References group to show all references.1.

From the Library menu, select Find Duplicates.2.

EndNote will display a Find Duplicates dialog where you can compare duplicates and decide which 
version to keep and which to delete.

Differences between reference fields are shown with blue highlighting. In addition, EndNote takes 
you to the first reference field  in which there is dissimilar content between the two duplicate 
references. Scroll through the list to see which fields contain duplicate content and which contain 
dissimilar content.

For each set of duplicates, you have the option to:3.

Click Keep This Record to save that particular reference and throw the other one in the Trash.▪

Click Skip  to leave both references in the library, intact. They will appear in a temporary 
Duplicate References group, so you can review them later.

▪

Click Cancel  bypasses the side-by-side comparison process. All duplicates will appear in a 
temporary Duplicate References group if you wish to review them.

▪
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The older (first entered) reference will always appear in the left column in the Find Duplicates dialog.

Warning: Before selecting Keep This Record, which will delete the duplicate, check the record numbers 
to be sure that you are not deleting a reference already cited in a paper.

By default, references are considered duplicates if they have the same reference type  (such as Journal 
Article or Book), and the Author, Year, and Title fields are identical. The criteria for detecting duplicates can 
be changed using the Duplicates Preferences settings in EndNote’s Preferences dialog.

References that appear identical may not show up as duplicates if the information in the fields EndNote 
checks is slightly different or if the reference types are different. When trying to determine how references 
differ, it is helpful to know exactly how EndNote compares them.

Author:  Compares last name and first initials (even if the first or middle name are written in full). 
Capitalization is not important.

Year: Compared exactly as entered.

Title: Leading articles A, An, or The are ignored, but punctuation is included. Capitalization is not important.

Reference Type: Compared exactly as entered.

When there are no more sets of duplicates to compare, the Find Duplicates dialog closes. The Duplicate 
References group is refreshed, the Trash group contains the unwanted duplicate references, and all other 
groups  are updated appropriately. The Duplicate References group is empty unless at least one set of 
duplicates was skipped or the Duplicate References operation was cancelled.
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Groups and Group Sets

The Groups and Group Sets Panel

The Types of Groups in EndNote

Automatically Generated Groups

Groups make it easy to break a large library  into subsets for later viewing. A group points to a subset of 
references that already exist in the library.

You can further organize your references by storing multiple groups in group sets.

You can have up to 5,000 groups and 5,000 group sets in a library.

The left panel of the Library window displays the groups and group sets available in your library.

To display a group of references in the Reference List panel, click the group name.

There are several types of groups to organize your references in EndNote. The first section of groups are 
automatically generated, and include both permanent groups and temporary groups.

Permanent Groups include the All References, Sync Status, Unfiled, and Trash groups. These are groups 
that will always appear in your library, which you cannot remove or rename.

All References displays every reference in the library.▪

Sync Status is not really a group. The Sync Status button allows you to open the Sync Status dialog 
to review information about the EndNote library that you selected to synchronize with your EndNote 
account.

▪

Unfiled  displays those references that are not part of a custom group (and, optionally,  of a smart 
group).

▪

Trash  is a holding place for references you have removed from the library but have not yet 
permanently discarded. 

▪

Temporary Groups  include the Retractions, Sync Conflicts, Copied References, Duplicate References, 
Imported References, and Recently Added groups. These are groups that will sometimes appear in your 
library, which you cannot remove or rename. These temporary groups may be replaced as you use 
commands in EndNote, and are always deleted when you close a library. (Only the groups are deleted; the 
references remain in the library.)

Retractions displays articles in the library which have been retracted. It works with Retraction Watch 
to check for new retractions and provide information on the reason for the retraction.

▪

Sync Conflicts contains all of the references for which EndNote has identified a conflict between an 
EndNote reference and an EndNote online reference.

▪
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Manually Created Groups

Group Sets

Find Full Text

Copied References contains the references last copied to your library using the References > Copy 
References To command.

▪

Imported References contains the references last imported using the File > Import command.▪

Recently Added is built into each library  (shared, unshared, syncing and unsyncing). This group 
allows users to see the latest references added. The group is handled on a library-by-library basis 
and is not built into global preferences so that it can be set to display the last 24 hours in one library 
and last 30 days in another.

▪

Custom groups, smart groups, and combination groups are user defined. You can create up to 5,000 user- 
defined groups and organize them in group sets.

Custom Groups  are manually created by the user to help organize the library; you can drag-and- 
drop to copy individual references into a custom group. Custom groups are updated only when you 
specifically add or remove references. Custom Groups are listed alphabetically.

▪

Smart Groups use search criteria to dynamically update groups as existing references are edited or 
new references are added to the library.

▪

Combination Groups allow you to better organize your EndNote references. Combine groups and 
use AND, OR, and NOT to create new, useful smart groups based on other groups. Save references 
in groups and then save sets of groups in group sets. You can collect both custom groups and smart 
groups within the same combination group set.

▪

Online Search groups allow you to easily initiate a search of a favorite online database and quickly 
view the latest download.

▪

Find Full Text  groups are temporary, and appear only when you use the Find Full Text command.▪

Group sets are indicated by group set headings in the Groups panel. Some group sets are automatic and 
cannot be removed or renamed. These include Find Full Text, Groups Shared by Others, Online Search, 
and more. A new library begins with one group set you can rename: My Groups. Group sets can contain any 
combination of custom groups and smart groups, as described below.

Expand a group set by clicking the expand arrow.

Collapse a group set by clicking the collapse arrow.

Click and drag a group set heading to move the group set to a new location.

For more information about group sets, see Group Sets.

The Find Full Text group set lists temporary groups that appear when you select Find Full Text from the 
References menu. The groups remain for the current session, but disappear when you close the library.
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Groups Shared by Others

Online Search

Custom Groups

Creating a Custom Group

Searching…: This group displays the current set of references for which EndNote is attempting to 
find the full text file  of each referenced work. When the full text search is completed, this group is 
deleted. Those references for which the full text was found are displayed in a Found PDF group.

▪

Found PDF: This group displays the set of references for which EndNote inserted the PDF file of the 
referenced work as an attachment. These references display a paper clip icon in the File 
Attachments column of the reference list. If a URL is also found, it is added to the reference, but the 
reference is not included in the Found URL group.

▪

Found URL: This group displays references that EndNote was unable to download the full text for, 
but for which it found a link that appears to allow access to a copy of the PDF. That link is added to 
the URL field of the reference.

▪

Not Found: This group displays the set of references for which EndNote could not identify a full text 
PDF file. These are only from the set of references searched with the Find Full Text command during 
this session of working in the EndNote library.

▪

For more information about Find Full Text, see Finding Full Text for a Reference  and How to Find and 
Retrieve Full Text.

Groups that others have shared with you through EndNote  online will appear here. See About Shared 
Libraries for information on sharing libraries.

The Online Search group set in the Groups panel lists your "favorite" connection files for online searching. 
When you click on one of these connection file names, The Advanced Search Panel becomes active and 
you are connected to the selected online service in order to begin searching. You can add or remove 
connection files from this group using The Connection Manager. For more information about online 
searching, see How to Search an Online Database.

Custom groups are perfect for when you want to build a group of references that are not easily found by 
index term or other common text. You can browse through your reference list and drag individual references 
to a custom group.

Create group sets in order to organize your custom groups and smart groups. See Group Sets.

Custom groups and smart groups are listed alphabetically within each group set.

You have options for creating a custom group. You can select references and then add them to a new group 
or you can create an empty group and then add references to it.
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Create an Empty Custom Group from the Groups Menu

Create an Empty Custom Group under a Group Set

Create a Custom Group from a Selected Set of References

Adding References to a Custom Group

A group name can be up to 255 characters in length, but shorter names will show better in the Groups 
panel. There are no restrictions on the characters you can use in a group name. Although it is possible to 
give two different groups  the same name, this may cause some confusion if you work in EndNote online 
because no group sets appear online to organize custom groups under.

You are limited to 5,000 total custom, smart, and combination groups per library. Once you reach that limit, 
you must delete a group before you can add a new one.

Select the group set you want to create the new group under. If you do not select a group set, the 
new group will be created under the top level My Groups heading.

1.

Select Create Group from the Groups menu.2.

Give the new group a name and press Enter.3.

Add references to the new group. See Adding References to a Custom Group.4.

Right-click on a group set.1.

Select Create Group from the list.2.

Give the new group a name and press Enter.3.

Add references to the new group. See Adding References to a Custom Group.4.

Select references in the Reference List. If the references are selected from a group set, the new 
group will be added to that group set, if they are selected from All References, the new group will be 
added to the first group set in the library.

1.

From the Groups menu select Add References To > Create Custom Group.2.

A new custom group with the name New Group will appear.3.

Right-click on the new group and select Rename Group from the list.4.

Enter the new name and press Enter.5.

Drag the new group to the group set you want it in.6.

You can add references to a new or existing custom group at any time. You do not have to worry about 
copying the same reference to a group more than once; EndNote will not allow duplicates (based on 
EndNote record numbers, which are unique to each library).

To add references to a group:
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How to Know Which References Are not Included in Any Custom Groups

Removing References from a Custom Group

First, select the references you want to add to the group. You can do this in many ways, for example:1.

Click on an individual reference to select it.▪

Display a list of references (such as search results), click in the list of references, and then go 
to the Edit menu and choose Select All.

▪

Hold down the Shift key and click on two references to select a range of contiguous references.▪

Hold down the Ctrl key and click on individual references to select them.▪

Add the selected references to a group. Several methods are available:2.

Drag and drop the selected references onto an existing custom group name in the left panel of 
the Library window.

▪

From the Groups  menu, select Add References To  and then select either the name of an 
existing custom group (or select Create Group to create a new custom group).

▪

Right-click on the selected reference or selected list of references to display a menu, select Add 
References To, and then select either the name of an existing custom group, or select Create 
Group to create a new custom group.

▪

The automatic Unfiled group includes references that do not appear in any custom groups.

The Unfiled group may or may not include references that are part of a smart group. Right-click on Unfiled to 
display a context sensitive menu and toggle the setting to Exclude Smart Groups in Unfiled or Include Smart 
Groups in Unfiled.

You can remove references from any of your custom groups. The references will still be in your library and 
appear under All References—they just will not appear in that particular custom group.

To remove references from a custom group:

In the left Groups panel of the Library window, click on the name of the group.1.

In the reference list, select the reference(s) you want to remove. You can select multiple references:2.

Hold down the Shift key and click on two references to select a range of contiguous references.▪

Hold down the Ctrl key and click on individual references to select them.▪

Select the Remove References from Group command in one of these ways:3.

Press the Delete key on your keyboard.▪

From the Groups menu, select Remove References from Group (Ctrl+D).▪

Remember that the selected references are only removed from this group. They still exist in All References 
and possibly in other groups.
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Smart Groups

Creating a Smart Group

Creating a Smart Group from an Existing Search Strategy

If you really want to delete the references from your library, see Deleting References from a Group.

Notes:  When you delete a record from a smart group, EndNote also deletes the record from All 
References without warning. To restore the reference, go to Trash and select the reference, then right- 
click to bring up a menu. Select Restore to Library and EndNote returns the reference to the smart group.  
 
If you delete a reference that is in a custom group, then restore it to the library, the reference's association 
with the custom group will not be restored. You will need to add it to the custom group again.

Smart groups are built with search strategies. Smart groups are dynamically updated as you add references 
to and edit references in the library.

You can create group sets in order to further organize your smart groups and custom groups. See Group 
Sets.

Smart groups are built with search strategies and are dynamically updated as you add references to and 
edit references in the library.

Note: You cannot create a smart group when an Online Search group is displayed.

To create a smart group:

Display the set of references that you would like to search. This would typically be All References.1.

From the Groups menu, select Create Smart Group… An advanced search dialog appears.2.

Enter a name for the group, then your search strategy, and then click Create.3.

The Smart Group search dialog works the same as the Advanced Search panel. If you need more 
information about how to use the Search dialog, see Searching EndNote References.

The new smart group will be added to the current group set. If you are searching all references, it will be in 
the top-most group set. You can drag-and-drop the new smart group to any group set.

You may have already created, and possibly saved, a search strategy to find a subset of references. Rather 
than run the search again each time you enter and edit references, you can use the existing search strategy 
to create a smart group.

To create a smart group from a search strategy:

Select a group, or select All References to display all references in the library.1.

Navigate to The Advanced Search Panel.2.
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Editing a Smart Group

Combination Groups

Creating a Combination Group

Create your search strategy or, if you have saved a search strategy, select Load Search from the 
Search Options drop-down.

3.

If loading a saved search, locate, select, and open the search strategy to load it into the Advanced 
Search panel.

4.

From the Search Options drop-down, select Convert to Smart Group.5.

A smart group named Converted Search is created and stored in the current group set. If you searched all 
references, the Converted Search group will appear in the first group set.You can drag-and-drop the smart 
group to any group set.

To rename the Converted Group, see Renaming a Group.

The smart group will be updated with matching references each time you save a reference.

You may have created a smart group only to find that you need to tweak the search strategy for the group.

To edit a smart group:

Select the smart group name in the Groups panel.1.

From the Groups menu, select Edit Group to display the smart group search dialog, or right-click on 
the smart group and select Edit Group from the list. The current search strategy is displayed.

2.

Modify the search strategy as needed, and click Save. (If you need more information about how to 
use the Search dialog, see Searching EndNote References.)

3.

The smart group updates based on the new search strategy.4.

Combine custom and smart groups under a single group to better organize your EndNote references. Use 
AND, OR, and NOT logic to create new, useful combination groups.

To create a combination group:

From the Groups panel, select Create from Groups… to display the Create from Groups dialog.1.

Enter a name for the combination group.2.

In the fields under the Include References In heading, select up to 10 custom and/or smart groups to 
use as your search criteria.

3.

Use AND, OR, NOT to include or exclude custom and/or smart groups in your combination group. 
(See A Strategy Tip for the AND, OR, and NOT Operators.)

4.
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Editing a Combination Group

Deleting a Combination Group

Group Sets

You can also use the Add (+) and Remove (-) buttons to manage which groups you want to include 
in and/or remove from your combination group set.

5.

You are limited to 5,000 custom, smart, and combination groups per library. Once you reach that limit, you 
must delete a group before you can add a new one.

Note: You cannot include group sets in a combination group.

To edit a combination group:

Select the group that you want to edit.1.

From the Groups menu, select Edit Group to display the Create from Groups dialog, or right-click on 
the combination group and select Edit Group.

2.

Enter a new name for the group (optional).3.

Use AND, OR, and NOT to include or exclude custom and/or smart groups in your combined group 
set (optional). (See A Strategy Tip for the AND, OR, and NOT Operators.)

4.

You can also use the Add (+) and Remove (-) buttons to manage which groups you want to include 
in and/or remove from your combined group set.

5.

Click Save to save your changes.6.

To delete a combination group:

Select the group that you want to delete.1.

From the Groups  menu, select Delete Group  to display a dialog, or right-click  on the 
combination group and select Delete Group.

2.

In the confirmation dialog, select Yes to delete the group or No to cancel and keep the group.3.

To help organize your groups, you can create up to 5,000 group sets. Group sets can contain any 
combination of custom groups, smart groups, and combination groups.

Use the Expand or Collapse icons next to a group set header to expand or collapse the list of groups found 
in that group set.

Expand a group set by clicking the expand arrow.

Collapse a group set by clicking the collapse arrow.
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Creating a Group Set

Moving a Group Set

Deleting a Group Set

When the list is collapsed, the number next to the group set header reflects the total number of references 
found in each group set. This number could include duplicates (references that are included in more than 
one group).

Some group sets are automatic and cannot be removed or renamed. These include Online Search and Find 
Full Text.

A new library begins with a single editable group set titled My Groups. However, you can create up to 5,000 
group sets in your EndNote library.

To create a group set:

From the Groups menu, select Create Group Set.1.

Enter a name for the new group set and press Enter.2.

When you first create a group set, there are no groups listed below the heading. You can drag groups to 
move them from other group sets to the new group set or you can create new custom groups, smart groups, 
and combination groups under the new group set.

Selecting a group set shows all the references from the various custom groups, smart groups, and 
combination groups under the set.

To move a group set in the Groups panel, click on the group set heading, hold down the mouse button, and 
drag and drop the group heading to its new position in the Groups panel. The new position will be 
remembered each time you start EndNote.

You can change the position of any group set, including Online Search and Find Full Text.

Are you sure you want to delete that group set? When you delete a group set, all of the groups within that 
set are also deleted! The references are not deleted; they still reside in your library.

To delete a group set:

From the Groups menu, select Delete Group Set, or right-click  on a group set, then select Delete 
Group Set from the list.

1.

A confirmation dialog will appear. Select Delete  if you want to delete the group set and all groups 
within it, or select Cancel if you do not want to delete the group set and the groups within it.

2.

You cannot delete any of the permanent group sets, such as Online Search or Find Full Text.

You also cannot delete the last group set left in a library. Each library must have at least one group set as a 
place to store new custom groups, smart groups, or combination groups.
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Managing Groups

Renaming a Group

Renaming a Group Set

Deleting a Group

To rename a group:

Select the group in the Groups panel.1.

Select the Rename Group command in one of these ways:2.

From the Groups menu, select Rename Group.▪

Right-click on the group name to display a menu, and select Rename Group.▪

You cannot rename the automatically created groups: All References, Duplicate References, Imported 
References, Search Results, Unfiled, Trash, Find Full Text, etc..

To rename a group set:

Select the group set in the Groups panel.1.

Select the Rename Group Set command in one of these ways:2.

From the Groups menu, select Rename Group Set.▪

Right-click on the group set name to display a menu, and select Rename Group Set.▪

Renaming does not affect the groups found in the set. Your groups will remain intact.

You cannot rename the permanent group sets: Online Search, Groups Shared by Others, or Find Full Text.

When you delete a group, the group is deleted but the references themselves are still part of the library.

Temporary groups are always removed when you close the library.

When you delete an Online Search group, it does not mean that you can no longer search that online 
database. You have not deleted the connection file, but you have removed it as a favorite. You can go to 
Tools > Connection Files > Open Connection Manager to add it as a favorite again. To use a connection file 
without making it a favorite, select Tools > Online Search and select the connection file you want from the 
list. (If you do not see the connection file you want in the list, see Installing Additional Connection Files.)

To delete a group:

Select the group you want to delete.1.

Select the Delete Group command in one of these ways:2.
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Deleting References from a Group

Recently Added Groups

From the Groups menu, select Delete Group.▪

Right-click on the group name to display a context-sensitive menu, and select Delete Group.▪

In the confirmation dialog, select Yes to delete the group or No to cancel and keep the group.

Note: If the group you are trying to delete is used in a combination group, you will receive a warning to 
that effect, asking if you still want to delete the group.

The group is deleted from the library, but the references that were in the group are still part of the library.

When you delete a reference from a group, it is moved to the Trash and is deleted from all groups in your 
library.

If you want to remove the reference from a custom group without deleting it from your library, see Removing 
References from a Custom Group.

To delete a reference from your library:

Select the reference(s) to delete in the Reference List.1.

Select Move References to Trash from the References menu, or drag the selected references to the 
Trash group.  
 
The references are now moved to the Trash group. The Trash group is a temporary holding place. 
The references are no longer in your library and cannot be cited or searched, but they have not yet 
been irrevocably discarded. If you change your mind, you can still drag a reference from the Trash 
back to the All References group to bring it back into the library, but any associations to custom 
groups it belonged to will be lost. It will need to be added to any custom groups manually.

2.

When you are absolutely certain that you no longer want the reference(s) you have moved to the 
Trash, select the Trash  group and then go to the References  menu and select Delete Trash 
References.

3.

The Recently Added Group is built into each library  (shared, unshared, syncing, and unsyncing) to 
allow users to see the latest references added.

The Recently Added Group displays above the Unfiled Group.

Right-click on the Recently Added Group to select the time frame for the references shown.

The time frame choices are:

In the last 24 hours▪

In the last 7 days▪

In the last 14 days▪
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The Lost & Found Group Set

Sharing Groups

Sharing a Custom Group

In the last 30 days▪

The Added to Library time/date stamp is used to determine when the reference was added to the library.

The group is handled on a library-by-library basis and is not built into global preferences, so it can be set to 
display the last 24 hours in one library and last 30 days in another.

The Lost & Found group set has special properties. Chances are that you will never see this group set. It 
appears only when some combination of events has caused a group to be separated from the group set it 
belongs to. This is incredibly rare.

The Lost & Found group set is a temporary holding place. You cannot add any groups to this set, rename 
them, or search them. The only thing that you can do is drag a group from this set to another group set. 
Once you do that, all functionality returns to the group. Once you have moved all groups from the Lost & 
Found group set, the Lost & Found group set is removed.

EndNote allows you to share an entire EndNote Library with colleagues, but sometimes you might not want 
to share your whole library. Sometimes you just want to share a set of references within your library. For 
this, use the EndNote Shared Groups feature.

EndNote allows you to share custom groups within your library with up to 1,000 other EndNote desktop or 
EndNote online users per group, and to have others share their custom groups with you. Smart groups and 
combination groups are not available in EndNote online, so they cannot be shared.

Before you can share groups, you will first need to sync your library to your EndNote account. Only groups 
from your synced library can be shared. See The Sync Feature for more information.

To share a group with a colleague:

Select the custom group in EndNote.1.

Select Share Group from the Groups menu.2.

Enter the email address (or addresses, separated by commas) of the people that you would like to 
invite in the email box. You must use the email address they are using for their EndNote account.

3.

For each invitee, use the drop-down box to select the desired access level: Read & Write  or Read 
Only. These can be edited later in the Sharing with list, if needed. If access rights are changed later, 
they will receive a notice.

4.

Enter an optional message to be sent to the above email address(es).5.

Click the Invite button.6.

The icon by your custom group will change to show that it is now being shared. (This may not show 
until the next time you open EndNote.)

7.
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Removing Someone from a Shared Group or Changing Their Permissions

Important Points about Groups

Your colleague will receive an email telling them a group has been shared with them. When they next open 
their synced EndNote library, they will see your group listed under the Groups Shared by Others group set. 
Clicking on this group will send them to their EndNote online library, where they can find the group listed 
under their online Groups Shared by Others heading. They can access the references online and use them 
in their word-processing documents using Cite While You Write's EndNote Online option.

Colleagues do not need to be using EndNote on the desktop to share a group with them. Groups can also 
be shared with colleagues using the free version of EndNote online.

Note: Attachments are not shared when sharing a group.

To remove someone from a shared group or change their permissions:

Select the custom group in EndNote.1.

Select Share Group from the Groups menu.2.

Click the Settings (the Gear icon) button to the right of a person's name.3.

Select from the following options:4.

Remove: This will remove them from your shared group. They will no longer have access to 
your references.

▪

Remind: This will allow you to remind people they have access to your shared group.▪

Read Only: If their current permission level is Read & Write, this will change it to Read Only.▪

Read & Write: If their current permission level is Read Only, this will change it to Read & Write.▪

Make your changes and click the Close button.5.

Keep these points in mind as you work with groups:

You can create up to 5,000 custom groups, smart groups, and combination groups (5,000 combined) 
in a single library.

▪

You can create a maximum of 5,000 group sets in a single library.▪

You can add a reference to a particular group only once (based on the unique record number). A 
single reference will never appear more than once in a particular group. However, you can add that 
reference to any number of groups.

▪

When you are viewing a group of references with selected references, and then switch to viewing All 
References, the references are selected in the All References group until you deselect them.

▪

You can drag references from one library directly into a custom group in another open library. The 
references are copied to the second library and into the target custom group.

▪
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Deleting a reference from any group deletes it from the library. If you want to remove a 
reference from a custom group, but not delete it from the library, see Removing References from a 
Custom Group. (You cannot remove a reference from a smart group because the contents of the 
group are based on search results.)

▪

Once you move a reference to the Trash group, it is no longer officially in your library (it will not 
appear in any other group or reference list, it is not included in your reference count, and it cannot be 
searched or cited). However, until you select Delete Trash References from the References menu, 
you can still drag the reference from the Trash group back to your active library.

▪
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Term Lists

Introduction to Term Lists

Term Lists are Automatically Maintained

Term Lists Help with Data Entry

Term Lists: Associating Additional Fields

Term lists help you automate data entry for the Author, Journals, and Keywords fields. They can maintain 
lists of all the authors and  keywords that have been used in your library. The Journals term list can improve 
the consistency of how journal names are formatted in your bibliographies.

You can also create your own term lists to automate other fields. For example, if you enter book references 
manually a lot, you could add a term list for the Publisher field.

EndNote’s  term lists are used to store terms such as keywords, author names, or journal names. You can 
use these stored terms when entering references to improve consistency and accuracy of information in 
your library. You can also use the Journals term list  to store abbreviated journal names that EndNote can 
substitute for the full journal name in a bibliography, or to substitute the full name for an abbreviation.

To get a general sense of how the term lists work, here’s a brief overview of how term lists can be built and 
used for someone with a new EndNote library. With the default term list settings in the preferences, updating 
of terms and auto-completion happen automatically. If you do not like this behavior, you may turn off these 
settings (see Term Lists Preferences).

When you create a new EndNote library, there are three empty term lists already set up and ready for you to 
use: Authors, Journals, and Keywords. As you enter new references into your library (whether by typing, 
importing, or pasting them) EndNote updates the term lists automatically so that the Authors, Journals, and 
Keywords lists include all of the author names, journal names, and keywords entered into your references.

When you use the New Reference command in the References menu to create new references, you will 
notice two other features associated with the term lists. As you begin entering an author name, EndNote 
attempts to complete the name for you by suggesting the closest matching name in the Authors term list. If 
you enter a new name that is not already in your Author list, the name appears in red text to indicate that it 
is a new addition to the term list. When you save the reference, that new term is added to the list.

When you are searching for references, you can also open a term list to pick the exact term or name for 
which to search.

Journals Term List:  By default, the installed Journal term list is linked to the Journal Article 
reference type. This list allows EndNote to substitute abbreviations for full journal names, or full 
names for abbreviations, in bibliographies. See The Journals Term List for more information.

▪

Authors Term List: There are several fields associated with the Authors term list. They include the 
Primary Author, Secondary Author, Tertiary Author, Subsidiary Author, and Translated Author fields. 
You can associate additional fields to the Author term list if you require them.

▪
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Important Points About Term Lists

Keywords Term List: This term list is associated with the Keywords field in an EndNote reference. 
You can associate additional fields with the Keyword term list if you require them.

▪

The following list includes useful information about term lists.

Term lists are stored with the library and therefore are specific to only that library.▪

A library must be open before you can edit its term lists.▪

If you enter many references manually, you may find it helpful to create new term lists for things like 
publisher and city names. Up to 31 term lists can be created for any library.

▪

There is no limit to the number of terms in a term list.▪

Each term can be up to 253 characters long.▪

Terms can be copied from one list and pasted into another.▪

Entire term lists can be exported and imported.▪

By default, term lists are automatically updated from the terms entered in your references. New 
terms appear in red text in the Reference window. This functionality may be turned off using 
EndNote’s Preferences.

▪

Term lists can be "linked" to specific fields so that EndNote associates the correct term list with the 
field you are editing.

▪

Term lists can be used with the "Auto-entry" feature on or off. By default, this option is turned on so 
that EndNote will suggest the closest matching term as you type in a reference.

▪

The Journals term list stores various forms of journal names that can be used when creating 
bibliographies. EndNote provides fourteen Journals lists (including Humanities, Medical, and 
Chemistry) that can be imported for use with your EndNote libraries. Look in the \\EndNote 20\Terms 
Lists folder.

▪

By default, the installed Journal term list is linked to the Journal Article reference type.▪

There are several fields associated with the Authors term list. They include the Primary Author, 
Secondary Author, Tertiary Author, Subsidiary  Author, and Translated Author fields. You can 
associate additional fields to the Author term list if you require them.

▪

The Keywords term  list is associated with the Keywords field in an EndNote reference. You can 
associate additional fields with the Keyword term list if you require them.

▪
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Adding Terms to a Term List

Automatic Updating of Term Lists

Turning Off the Automatic Updating of Term Lists

Delimiters

Using the New Term Command

By default, EndNote automatically updates the term lists in a library so they stay current with the data that 
has been entered into the references. If you enter a term into a reference, and that term is not in the 
associated term list already, the term appears in red text to alert you that you have entered a new term. This 
can help you to maintain a controlled vocabulary for keywords and other terms.

You can turn off automatic updating of term lists if you do not want to use the term lists at all. You can also 
turn this option off and manually enter terms into your lists as described in the following sections. For 
example, you can manually enter all of the terms you plan to use into a term list before entering references 
into the library. This can be extremely helpful when you have someone else entering data for you and you 
want a specific vocabulary used for keywords or other terms. As references are entered into the EndNote 
library, the term lists can speed data entry, and if a red term appears, the person doing data entry knows 
that they have entered something that was not intended to be a valid term for that field.

From the Edit menu, select Preferences.1.

Select the Term Lists panel.2.

Click the checkboxes for Update lists when importing or pasting references and Update lists during 
data entry to remove the check mark. The feature will be turned off.

3.

EndNote has predefined term lists for authors, keywords, and journals. When you enter multiple terms into 
those fields and EndNote updates the term list, it needs to know when one term ends and the next term 
begins. We call the punctuation that separates the terms "delimiters."

The following information applies when entering data into EndNote manually. For the Author fields, author 
names must always be entered one name per line. Carriage returns (end of line marks) are the only valid 
delimiter for this field. Journals normally have just one journal name per reference in this field, so delimiters 
are not needed here. Keywords are the most complex of the three. By default, EndNote uses carriage 
returns (end of line marks), semicolons, and backslashes (\) as delimiters for the Keywords field. If you 
would like to use other delimiters, see Delimiters Used for Separating Terms.

To manually add terms to a term list:

From the Library menu, select Open Term Lists and select the term list that you want to modify.1.

On the Terms tab, click New Term.2.

Enter the term and click Save Term  to add it to the list. You can then replace the text in the dialog 
with a new term and again click Save Term to save the new term to the list.

3.
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Copying Terms Between Lists

Copying Terms from Other Sources

Manually Updating Term Lists

Important Points about the Update List Command

When you have entered your last new term, click OK  to add it to the list and close the New 
Term dialog.

4.

Click Close to dismiss the Terms List dialog.5.

If you are entering terms into the Journals term list, you will have options to enter different forms of the 
journal name. See Important Points About Entering Journal Names for more information about using the 
Journal lists.

Note: The Save Term (or Save Journal) button is unavailable (dim) if the new term already exists in the 
term list.

You can copy terms from one list and paste them into another as a way to quickly transfer terms between 
lists. This is particularly useful because term lists are specific to an individual library.

To copy terms between lists:

From the Library menu, select Open Term Lists, and then select the list with terms you want to copy. 
Hold down the Ctrl key to select multiple terms; use the Shift key to select a range of terms.

1.

Right-click and select Copy from the list, or press Ctrl+C to copy the highlighted term(s).2.

Open the target list where you want to add the terms.3.

Click in the list, and then right-click and select Paste, or press Ctrl+V to paste in the term(s).4.

You can copy terms from any text, and paste them into a term list.

For example, to copy a word from a paper you are writing and paste that word into a term list, first select the 
term in your word processor and copy it. Then switch to EndNote and open the desired term list. Click in the 
list, and then right-click and select Paste, or press Ctrl+V to paste in the term(s).

To create a term list automatically from words already in your library, use the Update List button on the Term 
Lists dialog. This is useful if you have turned off the preference to automatically update your term lists, or if 
you have received a library from a colleague without a term list, or if you have deleted a term list and wish to 
recreate it.

The Update List command can  apply to just a group  or set of search results, or use the All References 
group to apply it to the whole library.

Update List does not change the terms in your references; it only adds new terms from your 
references into the term list.

▪
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Delimiters Used for Separating Terms

Update List does not add duplicate terms to a list.▪

Update List removes leading and trailing spaces, but does not change punctuation.▪

For Update List to update the Journals term list with both a full name and abbreviation, the full name 
must be entered in the Journal field and a consistent abbreviation must be entered in the Alternate 
Journal field. See Journal Names and Updating a Journal List  for more information on the special 
needs of the Journals term list.

▪

Update List does not automatically link fields to a term list. For easy data entry, you can link a single 
term list to any number of fields. See Linking Term Lists to Fields.

▪

To update a term list:

(If you are updating the Journals list, see Updating a Journal List.)

Select a group to update the terms list from, do a search to create the set of references to update 
from, or manually select a set of references to update from.

1.

From the Library menu, select Define Term Lists… and then select the term list that you would like to 
update.

2.

Click Update List.3.

The currently linked fields are listed in the dialog as the fields from which EndNote gathers new 
terms. If necessary, remove a field from this list by selecting it and clicking Remove Field; or add a 
new field by selecting it from the Add Field list. Adding or removing field names from this list does not 
affect the links between fields and term lists.  
 
The Generic field names are used in this dialog. See the List of Reference Types   to  find the 
corresponding field names for the fields of various reference types.

4.

To update a term list from only the currently selected references in your library, select the Update 
Terms From Selected References option.

5.

Click OK  to begin the updating process. When finished, EndNote displays the number of terms 
added to the list. Click OK and the process is complete.

6.

Note: Pressing Esc stops the update process, but all terms added up to that point are kept in the term list.

The text used to separate the terms in a particular field is determined by the "Delimiter" settings on the Lists 
tab of the Term Lists dialog (select Define Term Lists from the Library menu).

If your keywords are separated by a slash, such as:

Antarctica/ozone/stratosphere

you should select a slash (/) as the field’s  term delimiter. A carriage return is always interpreted as a 
delimiter, so it is not necessary to enter a delimiter for the Author fields or any other field that has terms 
entered one-per-line. If different delimiters are used for the same field in your references, you will need to do 
more than one update process, updating from the references with different delimiters separately.

Page 118 of 586

 



Clarivate EndNote 20 User Help Guide

Cleaning Up After Updating

Importing Terms Into Term Lists

Click on the Terms tab, and scroll through the term list to make sure that the Update List command had the 
desired result. If it did not, you can highlight specific terms and remove them by clicking Delete Term.

After using the Update List command, you might find that due to errors or variations in spelling, you have 
multiple entries for the same term. Scan through the list and delete the unwanted terms.

If necessary, use the Find and Replace  command from the Library  menu to change all occurrences of a 
term in your library. For example, if both "geochronology" and "geo-chronology" are entered as keywords, 
you can delete the unwanted term "geo-chronology" from the term list, then click on the Reference List, and 
select Find and Replace (Ctrl+R) from the Library  menu to change "geo-chronology" to "geochronology" 
throughout the library.

EndNote provides fourteen lists of journal names and abbreviations, including lists for Chemistry, Medicine, 
and the Humanities; all of which are stored in the \\EndNote 20\Terms Lists folder. If you are interested in 
using these abbreviated forms of the journal names in your bibliographies, you can import them into your 
term lists and adjust your styles to use the abbreviations.

Note: See List of All Journals Cited in PubMed® for  a current list of medical journal names and 
abbreviations, in case you need to add journal names in the medical sciences to the provided list. 
Sometimes you may be told to use the "Index Medicus" journal names. Index Medicus ceased publication 
in 2004 (see the May-June 2004 NLM Technical Bulletin article Index Medicus to Cease as Print 
Publication), so the PubMed list is the current resources for finding official medical abbreviations.

If you would like to look at the lists before importing them, you may open them in your word processor—but 
do not edit or save them. They must remain tab-delimited text files in order for EndNote to correctly import 
the terms.

Terms can be imported from any text file that lists the terms one per line. Make sure a carriage return is also 
inserted after the last term in the list. If you create a list of terms in a word processing document, be sure to 
save the list as plain text using the Save As command in your word processor. Then, if your terms include 
extended characters, select the Unicode (UTF-8) encoding option.

To import a text file that contains terms other than journal names (see Loading Supplied Journal 
Abbreviations for journal names):

From the Library menu, select Define Term Lists and highlight the term list to which you want to add 
terms. Use Create List if you want to create a new list.

1.

Click Import List.2.

Select the text file to be imported and click Open.3.

The new terms are imported and sorted alphabetically into the existing term list. This import must be done 
for each library in which you want to use these terms.
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Inserting Terms into References

Suggesting Terms As You Type (Auto-completion)

Inserting Terms Without Using the Auto- 
Completion Feature

Using Terms For Searches

If you are entering text into a field that is linked to a term list, EndNote finds the first matching term in the list 
and suggests that as the term you want to enter.

The suggested text appears highlighted after the cursor. Continue typing until EndNote suggests the correct 
term, and then press Enter or Tab to accept it. (Enter creates another line in the field so that you can enter 
more author names; Tab moves the cursor to the next field in the reference.)

When you enter a term that is not already in the term list, it appears in red to indicate that it is a new term. 
When you save the reference, that term is added to the term list and will no longer display in red.

These auto-completion term list features may be turned off. To turn off the display of red text, turn off the 
preference to Suggest Terms as You Type. See Term Lists Preferences.

If you have turned off the option to suggest terms as you type (auto-completion), you can still insert terms 
into your references manually.

To insert a term from a Term List window:

Open a reference and position the cursor where you want to add the term.1.

From the Library menu, select Open Term Lists and select the desired list.  
 
Or, in an Author, Journal, or Keywords field, press Ctrl+1 to display the appropriate list. (If you create 
a custom term list, the Ctrl+1 command will also work with any field you link to your custom term list.)

2.

Double-click a term to insert it directly into the reference, or select the term(s) and click the Insert 
Term button.

3.

Terms can also be selected by typing the first few letters of the term, by using the Arrow keys, or by clicking 
on the term with the mouse. Hold down the Ctrl  key to select multiple terms. Press Enter   to  insert the 
selected term or click Insert Term. If multiple terms are selected and inserted, they are listed in the reference 
one per line in alphabetical order.

To ensure that you are searching for the correct terms, you can use the term lists with EndNote’s Search 
command. Terms can be entered in the fields on the Advanced Search panel just as they are entered into 
references.

Navigate to the Advanced Search panel, select the field you want to search, and click in the field as 
though to enter data in it.

1.
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Modifying Terms

Deleting Terms

Exporting and Printing Term Lists

From the Library menu, select Open Term Lists, and then select a list. Or, in an Author, Journal, or 
Keywords field, press Ctrl+1 to  display the appropriate list. (If  you create a custom term list, 
the Ctrl+1 command will also work with any field you link to your custom term list.)

2.

Select a term and click Insert Term, or double-click on a term, to insert it into the Search field.3.

Click Search to search for your references.4.

Any term in a term list  may be modified or deleted without affecting any of the references in the library or 
any links between term lists and fields.

To edit a term in a term list:

From the Library  menu, select Open Term Lists  and select the list that contains the term to be 
modified.

1.

Select a term, and then click Edit Term. If multiple terms are selected, only the first one opens.2.

Change the term as necessary and click OK when finished. The modified term replaces the original 
term in the term list. (If the term as it is modified already exists, the OK button will be dim.)

3.

Notes: Editing a term in a term list does not change all occurrences of that term in your library. Use the 
Find and Replace command from the Library menu to find the old term in your references and replace it 
with the new one.  
 
You cannot edit a term to change the capitalization. You will need to delete it from the list and add it again 
with the new capitalization.

A term can be deleted by highlighting it in the list and clicking Delete Term. Deleting a term from a term list 
does not remove it from the references in the library. If you later use the Update List command, the term will 
be added to the term list again.

Term lists can be exported and then imported into other term lists as a way to move complete lists from one 
library to another (see Importing Terms Into Term Lists).

You can also open exported term lists in a word processor to print them.

To export a term list:

From the Library menu, select Define Term Lists.1.

Highlight the term list that you want to export.2.

Click Export List.3.
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Predefined Term Lists

Defining Term Lists

Creating a New Term List

Name and select a location for the text file that will be created during the export.4.

Click Save. The terms are exported to the text file and listed alphabetically, one term per line.5.

This file can now be imported into another EndNote term list or opened in a word processor to be printed. 
Term lists cannot be printed directly from EndNote.

Three empty term lists are available by default with every library: Authors, Journals, and Keywords. These 
lists are already linked to their corresponding fields: the Authors term list is linked to the Author, Secondary 
Author, Tertiary Author, Subsidiary Author, and Translated Author fields; the Journals term list is linked to the 
Secondary Title and Alternate Title fields; and the Keywords term list is linked to the Keywords field.

Use the Define Term Lists  command in the Library  menu to create, rename, or delete a term list. This 
command is also used to specify the punctuation that separates individual terms in a reference (delimiters).

To create a new term list:

From the Library menu, select Define Term Lists.1.

Click Create List, and then enter the name for the new list. You cannot create a term list with the 
same name as an existing term list.

2.

Click OK.3.

Check the "Journal List" box only if you want to create a term list for storing journal names and 
abbreviations. These different forms of the journal name can be used interchangeably when creating 
bibliographies. See Creating Bibliographies with Journal Abbreviations.  
 
The predefined Journals term list is already set up as a multi-column list. If you delete this list, you 
can create another one as described here, but there can only be one Journals term list in a library. 
Do not create a 4-column journal list for nonjournal fields.

4.

To add terms to the list, you can import an existing list of terms, update the list from existing EndNote field 
data, or manually enter terms into the list.

Note: New term lists must be linked to fields for the "Suggest terms as you type" and automatic updating 
features to work. See Linking Term Lists to Fields.
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Linking Term Lists to Fields

Deleting and Renaming Term Lists

Term lists are associated with fields using the Link Term Lists command from the Library menu. When a 
term list is linked to a field, the list can be used to facilitate data entry. EndNote can also keep the term lists 
current by automatically adding new terms from linked fields. By linking term lists to particular fields, you can 
use the auto-completion (Suggest terms as you type) feature whenever you are entering data into the linked 
field. Each field can be linked to only one term list. However, you can link the same term list to multiple 
fields.

The three predefined term lists (Authors, Journals, and Keywords) are already linked to their corresponding 
fields. Any new term list that you create is not linked to a field until you set up the links. The links between 
term lists and fields are specific to each library.

To change these settings or to link a new term list to one or more fields:

Open a library.1.

From the Library menu, select Link Term Lists.2.

If you have more than one library open, select a library from the drop-down list at the top of the 
dialog.

3.

The names of the available term lists appear next to the field names with which they are linked. You 
may change the links here as necessary by selecting a different term list from the drop-down lists. A 
field can only be linked to one term list.

4.

Click OK to save your changes and close the dialog.5.

These changes will not alter any data that is currently entered in either your references or your term lists. 
Term lists may be linked to multiple fields.

Note: After linking a term list to one or more fields, you should make sure the list is updated with the data 
from those fields. Go to the Library menu, select Define Term Lists, select the list, and click Update List.

To unlink a term list from a field:

With the library open, select Link Term Lists from the Library menu.1.

Scroll through the list of fields to find the field that you would like to be unlinked from a list. Select 
None from the drop-down list next to the field name.

2.

Save your changes by clicking OK.3.

Term lists can be renamed without disturbing their links to reference fields or the terms within them. Deleting 
or renaming term lists does not change the data entered into your references.

To delete or rename a term list:

From the Library menu, select Define Term Lists.1.
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Configuring Term Separators (Delimiters)

The Journals Term List

To Rename a Term List: Highlight a term list, and then click Rename List. In the Rename List 
dialog, enter the new name for the list, and click OK.

▪

To Delete a Term List: Select a term list, and then click Delete List.▪

Click OK to save your changes.2.

EndNote uses the delimiters in the Define Lists dialog to determine what punctuation separates the 
individual terms in the same field in a reference.

For example, if you import data from a source that uses semicolons (;) to separate keywords:

Adult, Age Factors; Astigmatism; Follow-Up Studies; Hospitals, University; 
Keratotomy, Radial; Myopia; Refraction, Ocular

you would want to be sure that the semicolon was selected as a separator for your Keywords term list. You 
would also want to be sure that the comma was not chosen because the commas in this example are used 
within some of the terms.

By default, EndNote uses the semicolon (;), backslash (\), and end-of-line markers as separators. Words or 
phrases entered on different lines in a field (by pressing Enter) are always interpreted as separate terms, but 
the other separators can be changed depending on your needs.

Note: Line breaks are the only allowable separators for Author and Journal lists, so the delimiter options 
cannot be changed for lists linked to the following fields: Author, Secondary Author, Tertiary Author, 
Subsidiary Author, Translated Author, Journal/Secondary Title, and Alternate Title.

To customize the delimiters for a term list:

Open a library.1.

If you have more than one library open, select a library from the drop-down list at the top of the 
dialog.

2.

From the Library menu, select Define Term Lists. (Each library has its own set of term lists.)3.

Click on the name of the term list that you intend to modify.4.

Click the checkbox to the left of the desired separator to select it (or to unselect it if it is already 
checked). The last checkbox provides a place to enter a custom term delimiter, if necessary.

5.

Close the Term Lists dialog to save your changes.6.

The Journals term list allows EndNote to format bibliographies with the version of journal names required by 
a publisher's style  requirements. For example, most humanities styles require the  full journal name, while 
scientific and medical journals generally require journal abbreviations, sometimes with periods on 
abbreviated words and sometimes without. Because the Journals term list can track up to four versions of a 
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Important Points About Entering Journal Names

Loading Supplied Journal Abbreviations

journal name, EndNote styles can use the version of the journal name required by the publisher—but only if 
a Journals term list has been set up with the different variations of the journal names.

There should be only one multi-column term list per library: the Journals  term list. If you somehow 
accidentally delete the Journals term list, it is possible to recreate it, but trying to create multi-column lists for 
other fields, such as publisher or author names, will not work properly in formatting bibliographies.

If you will never need to submit documents that require journal names formatted in different ways, you do 
not have to use the abbreviation sections in a Journals term list. However, if you do need to submit 
documents with different formats for the journal names, keep these points in mind:

Enter variations of the same journal name together in one term.▪

Enter a consistent abbreviation format in each column. For example, all abbreviations with periods 
could be entered under the Abbreviation 1, all abbreviations without periods in Abbreviation 2, and 
so on.

▪

Only the first term for each journal (the one in the Full Journal slot) is transferred when you insert a 
term into a reference. However, what will show up in the bibliography will depend on the style and 
the consistency of your Journal term list.

▪

Use the Journal Abbreviation option in the styles to pick which form of the journal names should be 
used in the bibliography (see Creating Bibliographies with Journal Abbreviations).

▪

EndNote can remove periods from abbreviations during formatting. EndNote cannot add periods to 
an abbreviated journal name.

▪

You can load one of the supplied journal name lists to use for data entry. These lists also contain journal 
abbreviations for alternate output, and are used by certain output styles. The lists are supplied as plain text 
files in the \\EndNote 20\Terms Lists folder. You can open and view one of these files with any word 
processor, but make sure to leave it a plain text file so that EndNote can import it.

To replace the existing Journals list with one of the supplied journal abbreviation lists:

From the Library menu, select Open Term Lists, and then select Journals Term List.1.

Delete all existing terms from the list (you can click and drag to highlight all terms, or use the Ctrl+A 
shortcut, and then click Delete Term. This will give you a "clean slate" to import the journal lists, with 
each version of the name in the correct column of the list.

2.

Click on the Lists tab and select the Journals list.3.

Click Import List.4.

In the File dialog, navigate to the \\EndNote 20\Terms Lists folder, select the list you want to use, and 
click Open to import the journal names and abbreviations from the file into the Journals term list.

5.

Close the Terms Lists dialog.6.
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Updating a Journal List

Creating Bibliographies with Journal Abbreviations

For EndNote to accurately use the abbreviated journal names in your bibliographies, it is important to be 
consistent when entering different formats of a journal name. The first column should always list the full 
journal name, and subsequent columns should store consistent formats of abbreviated names. See 
Important Points About Entering Journal Names.

Journal lists are updated automatically, from the Journal Article and Electronic Article reference types, 
unless you have turned off the preferences to update lists (see Term Lists Preferences). When journal lists 
are updated, the entry in the main Journal field goes into the first column of the list (Full Journal) and the 
journal entered into the Alternate Journal field goes into the second column (Abbreviation 1). Be consistent 
when entering data into these fields so that the Journals term list will be updated correctly. Note that if the 
name entered into the Journal field exists in any of the columns of the Journals term list, it is not added 
again. EndNote tries to avoid duplicate entries in the Journals list.

If you have turned off the preference to automatically update the term lists, you may manually update the 
lists as described here. When you are manually updating Journal lists, you can choose which columns in the 
list are used for which fields of data.

Note: It is best to import a terms  list, if there is one available in EndNote, before updating from your 
library. This will ensure that a large number of the journal name versions will be in the correct location 
before the update, minimizing cleanup. See Loading Supplied Journal Abbreviations.

To update a journal term list:

Select a group to update the terms list from, do a search to create the set of references to update 
from, or manually select a set of references to update from.

1.

From the Library menu, select Define Term Lists… and then select Journals.2.

Click Update List.3.

The fields to update the list from should already be selected: the Journal/Secondary Title and 
Alternate Title fields. If you wish to change these fields, select the fields from which EndNote should 
extract the journal names. If importing from selected references, check the Update from Selected 
References option.

4.

Click OK  to begin the updating process. When finished, EndNote displays the number of terms 
added to the list. Click OK and the process is complete.

5.

When the update is complete, you will see a column of journal names listed in alphabetical order.

When you insert a journal name from the Journals term list  into a reference, only the first entry for the 
journal name is entered. However, you can create a bibliography that uses any abbreviation in the term list 
by editing the style used to format the paper.

To edit a style to use journal abbreviations:

From the Tools menu, select Output Styles, then select Open Style Manager.1.

Select the style that you would like to edit, and click Edit.2.
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From the list of options at the left of the Style Editor window, click Journal Names.3.

Select one of the available options.4.

Close and save the style. Now when you format a paper or look at the Preview panel, all of the 
journal names should be replaced with the appropriate abbreviation.

5.

If a journal name in one of your references does not have the selected abbreviation entered in the Journals 
term list, the journal name appears in the bibliography exactly as it is entered in the Reference window. 
Editing the Journal term list to include all the versions of the name will fix it in the current bibliography and 
any time that journal name is used in the future. See Modifying Terms.
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Searching Online Databases

How Does It Work?

How to Search an Online Database

EndNote’s  search interface provides a simple way to do basic searches of EndNote  libraries and online 
databases. The same Advanced Search panel is used for both purposes.

This search interface is not intended to replace the advanced search options that may be available using the 
search interface offered by your information provider. There may be times when you want to use the 
information provider’s search interface (for example, to take advantage of a thesaurus of search terms) and 
then import those references into EndNote. This is still an option using EndNote’s  Import command (see 
Importing Reference Data into EndNote). But once you know the terms that you want to use in your 
searches, being able to retrieve the necessary references directly from EndNote is a very fast and efficient 
approach.

EndNote is able to provide access to these remote sources using an information retrieval protocol called 
Z39.50, which is widely supported by libraries and information providers around the world. It provides a 
convenient method to access their library catalogs and reference databases.

EndNote stores the information necessary to connect to and search these online databases in individual 
Connection Files. Preconfigured connection files are provided for a number of these sources. If necessary, 
you can also customize or configure your own connections to Z39.50-compliant databases (see Editing a 
Connection File and Creating Connection Files).

Note: If the online database that you access is not available on a Z39.50 server, EndNote will not be able 
to connect directly to it. You can still import references downloaded from non-Z39.50 databases. See 
Importing Reference Data into EndNote.

The process of searching an online database is very similar to searching an EndNote library. Here are the 
basic steps involved; more detailed descriptions of these steps are provided in additional help topics.

To search and retrieve references from a online database:

Initiate the online search in one of these two ways:1.

From the Tools menu, select Online Search to display the collection of connection files installed 
on your computer. 
 
or 
 
Click more under the Online Search group set. Select the online database that you would like to 
search, and then click Choose. See Selecting a Connection File. 
 
When the connection has been established, the Search panel appears ready for you to enter a 
search.

▪
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Next, Determine Which References to Keep

Searching an Online Database

Establishing the Connection

Once you have searched an online database, or marked the database as a favorite with the 
Connection Manager, it appears in the Online Search group set in the Groups panel.

▪

Enter your search request in the search fields on the Advanced Search panel, and then click Search. 
EndNote searches the database and displays the number of references that were found to match 
your search criteria.

2.

Click OK to retrieve the references. 
 
If you would like to pause during record retrieval, click Pause. When you are ready to continue, click 
Resume.

3.

Note: The connection to the online database is maintained only until the search is completed and the 
matching references are retrieved; when the references are downloaded, you are automatically 
disconnected. Each time you initiate another search, EndNote reconnects.

The retrieved references are stored in the Online Search group set for the library, but they are not yet in your 
EndNote library.

Select the references you want to add to your library.1.

Now you have choices on how to add the references to your library.2.

Go to the References menu and select Copy References To in order to select a new or existing 
library and copy the selected references to that selected library.

▪

Right-click  on the selected references and select Copy References To from the list in order to 
select a new or existing library and copy the selected references to that selected library.

▪

Drag and drop the references into the group you want to add them to in the library.▪

Mark the references using the checkmark boxes to the left of them, and then click the Add the 
selected records to your local library button to add them to your library. 

▪

If you used the Copy References To command, the references are copied to the selected library and are 
displayed in a Copied References group. Each time you copy references into an EndNote library, the Copied 
References group is replaced with the new set of references. Previously copied references remain in the 
library; they are just no longer part of the latest Copied References group.

The first step to searching an online database  is to connect to it. Once the connection has been made, 
you’re able to use EndNote’s Advanced Search panel to search the online database.
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Online Database Searching (Overview)

Available Search Options

If you have connected to a particular database before or if you have selected a database as one of your 
favorites (see Adding Favorite Connection Files), it will appear in the Groups panel under Online Search. 
This saves you a few steps in the process of using the Online Search command.

To connect to an online database, do one of these:

On the Groups panel, under Online Search, select the online database you want to search. That 
initiates the online connection.

▪

If the database you want to search is not listed under Online Search in the Groups panel, select 
Tools > Online Search, select the desired database, and click Choose to initiate the connection. 
 
or 
 
Click the more…  button in the Online Search group set, select the desired database, and click 
Choose to initiate the connection.

▪

This Connection dialog is very similar to the Connection Manager described in The Connection Manager, 
but it does not provide the options to edit connection files or mark them as favorites. However, it does 
contain a Quick Search field  that the Connection Manager does not. Here you can enter the name, or a 
portion of the name, of the file your are looking for, then press Enter to find files matching the text entered.

When a successful connection has been made, the Search panel opens with the online database selected 
for searching. You are now ready to begin searching the database.

The connection to the online database is maintained only until the search is completed and the matching 
references are retrieved; when the references are downloaded, you are automatically disconnected. Each 
time you initiate another search, EndNote reconnects.

Note: If you have difficulty establishing a connection, see Troubleshooting Connections.

Searching an online database  is essentially the same as searching your own EndNote library. After 
establishing a connection:

Enter your search term(s) in the fields on the Advanced Search panel.1.

Select the appropriate search options.2.

Click Search to send the search request to the online database.3.

A few significant differences between searching an online database and an EndNote library are described in 
Searching EndNote Fields vs. Online Database Indexes. See The Advanced Search Panel  for general 
information about using the Advanced Search panel interface.

Once you are connected to an online database  and that database is selected for searching, certain 
elements on the Search panel change from the settings that are available for EndNote library searches.

The search set list changes when searching an online source. You can search either the remote 
database or the list of references already retrieved and saved from the remote source.

▪
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Boolean Searches

Field Comparison 
Operator Search Term Boolean Operator

Keywords Contains parrot AND

Keywords Contains corvid NOT

Keywords Contains avian OR

Keywords Contains Emery  

Boolean Operators Table

Searching EndNote Fields vs. Online Database Indexes

The options available in the search menus (such as Author, Title, or Keywords) vary with each 
database, and they are not the same as searching the fields in an EndNote library (see Searching 
EndNote Fields vs. Online Database Indexes).

▪

The following fields are not available in the search menu for searching an online source: PDF, Any 
Field + PDF with Notes, and PDF Notes.

▪

The comparison list for each search line is always set to Contains.▪

Multiple search terms can be combined using the Boolean operators AND, OR, and NOT. EndNote 
constructs a search from the top to the bottom of the Search panel, finding the search results of the first two 
items, then combining that result set with the third search line, and so on.

For example, the search shown above could be written as:

(((parrot AND corvid) NOT avian) OR Emery)

First EndNote looks for references about parrots and corvids, then any references to avian would be omitted 
from that set, and finally all references by Emery would be added.

Keep in mind that:

OR broadens your search by adding together two result sets▪

AND narrows the focus of the search by looking for the intersection of references found▪

NOT narrows the search by omitting the results for one term from the current result set.▪

See A Strategy Tip for the AND, OR, and NOT Operators for an example search strategy to help with using 
these three operators.

When searching an online database, you are not searching the specific fields in each record, but rather the 
available search indexes for that database. The search menus on the Search panel list only available 
indexes for the online database, so you will not see all of the generic field  names listed as you do when 
searching an EndNote library.
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Understanding Search Results

Online Database Search Limitations

Changing the Focus of the Search

If the current search strategy is set up to search an EndNote field that does not exist as an online database 
search index, that field name will appear in italics. If you try to execute a search, EndNote will advise you 
that the field is not valid. Change the search field selection to a valid index for the selected online database.

The connection file for a particular database stores the names and settings for the search options listed in 
the search menus. See Search Attributes in Connection Files  if you are interested in changing the 
preconfigured options.

Note: Comparison operators other than "Contains" cannot be used when searching online databases.

When searching an online database, the search menus display a list of available search indexes supported 
at the remote site. These are not fields in the online database, but rather sets of search terms and 
synonyms designed to facilitate your searches.

It is not uncommon to search for a term in an index and notice that the exact term appears nowhere in the 
retrieved reference(s). For example, you might search for heart attack in the Title index of a medical 
database and find references that do not include heart attack in the Title field but, instead, they use the term 
myocardial infarction. This apparent discrepancy can be attributed to the search index of the online 
database, which has mapped the common term heart attack to its scientific equivalent myocardial infarction.

It is also not uncommon for some of these databases to index personal names that appear in the titles or 
keywords along with the author names. For example, a search of the Library of Congress for "Charles 
Dickens" in the Author index displays books about Dickens as well as those written by him. This form of 
indexing is most commonly seen with library book catalogs and not with the scientific reference databases. 
Sometimes you can restrict the searches to books by that particular author by setting up a search to find (for 
example) "Charles Dickens" in Author, NOT "Charles Dickens" in Keywords.

These search indexes are maintained by the providers of the databases and are not controlled by EndNote.

Some of the search options have additional limitations that you would not encounter when searching an 
EndNote library. For example, some databases prohibit searching for a year alone. The year can be 
specified only to limit a search (these are called "limit fields"). In such a case, a search for 1997 as the year 
would be denied, but searching for Smith as an author AND 1997 as the year (thereby limiting the results of 
the author search), would be allowed.

If you have set up a search that is not accepted by the online database, an error message will describe the 
source of the problem as specifically as possible. (See Troubleshooting Connections.) Keep in mind that 
these restrictions are set by the information provider, not EndNote.

Documentation from the information provider may help to clarify which search options are available.

The target of the search is the online database (represented by the database name on the Search panel) or 
the current EndNote library group that is displayed when the Search command is chosen. (If you haven’t yet 
connected to the online database or opened a library, you will need to do so before you can search it.) To 
change the focus of a search, click on a different library group or online database in the Groups panel.
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Selecting a Connection File

Access-Restricted Databases

The available search options differ among the various online databases, as well as between online 
databases and EndNote libraries. When you change the target of a search, the field options on the Search 
panel change automatically. You could set up a Keywords search for a particular online database, but when 
you select a different online database, the field selection changes because Keywords is not an option for the 
new database selection.

When switching the focus of your search from one group to another and back again, the original search 
setup is retained as long as you have not changed any settings on the Search panel and the field selections 
are available in both databases.

Before an online source may be searched, you must first connect to it by selecting the corresponding 
connection file. The connection file tells EndNote which online database you want to search, where to find it 
online, and what search options are available for it.

EndNote comes with preconfigured connection files to free reference databases and library catalogs as well 
as databases that require payment and/or authentication for access. Most of the databases offered by the 
commercial information providers (Ovid, OCLC, etc.) require an account for access. There are, however, 
numerous databases that are available at no cost to you, and no account is required (see Free Databases).

When you attempt to connect to a restricted database, by default EndNote prompts you to enter your user 
ID and/or password. If you have a user ID and/or password supplied by the data provider that hosts the 
restricted database, enter the necessary information, and click OK  to log on. (Depending on the database 
you are accessing, the passwords and IDs may be case-sensitive.)

Note: The User ID and password must be the one provided by the database provider. Student, Faculty, or 
employee logons for your system are unlikely to work because they are provided by your institution, not 
the database provider. You may be able to access the database through IP address recognition instead. If 
you find you are unable to access the database through Online Search, you can still search the database 
through a Web browser  and then import your references into EndNote. See Importing Reference Data 
into EndNote for more information. Clarivate  does not control access to databases from other database 
providers.

If you do not have a user ID and/or password, but instead have authenticated access to a database either 
by IP address recognition (for example, your computer is on your university campus or company network 
and has an IP address that is recognized as authenticated by the data provider’s server) or through a proxy 
server, it may be possible to configure the connection file and your Network Preferences so that you do not 
need to enter a user ID and password.

If you have access to a restricted database by IP address recognition, you may need to edit the connection 
file so that it does not prompt you for a user ID and/or password. In EndNote, select Tools  > Connection 
Files > Open Connection Manager. Locate the connection file for the database you wish to access, select it, 
and click Edit. Click Connection Settings  and clear the User ID  and Password  boxes under Login 
Information Required. Close  the connection file, choosing Yes  when asked if you want to save your 
changes.

Page 133 of 586

 



Clarivate EndNote 20 User Help Guide

Free Databases

Databases Not Requiring an Account

Description Information Provider/Category

PubMed (MEDLINE and pre-MEDLINE)  
references from the U.S. National Library 
of Medicine

U.S. National Library of Medicine (NLM)

Most university library catalogs Library Catalogs

Books at the U.S. Library of Congress Library of Congress

Crossref Publishers International Linking 
Association, Inc.

Adding Favorite Connection Files

Note: To access databases using IP authentication, you must be on the authenticated network. If you are 
off-site, this is usually managed through an institutional VPN. Contact your institution's library or technical 
support group for information on institutional VPN setup.

If you have access to a restricted database via a proxy server, you must make sure that your  Internet 
settings  are properly configured, because EndNote uses these settings. Note that these are operating 
system settings, not browser settings. See Problems Connecting for information about proxy servers. You 
will need the address and port number of your proxy server.

Two major databases that do not require passwords are the PubMed database  from the U.S. National 
Library of Medicine, and the Library of Congress. Many of the general library catalogs are also unrestricted. 
Additional connections may be available at the EndNote online  site. See Download EndNote Connection 
Files.

EndNote provides thousands of connection files for a variety of sources. Whenever you use a connection 
file you have not used in the past, it is automatically added to your list of favorite connection files and will 
show in the Online Search group set.

You can also add multiple connection files to favorites using the Connection Manager.

To peruse the list of installed connection files, choose Tools > Connection Files > Open Connection 
Manager. The  list includes the original connection files installed in the EndNote program folder (\ 
\EndNote 20\Connections), as well as any user created or edited files stored in your personal 
Connections folder (see Folder Locations Preferences).

1.

When you have found a connection file that you will want to use in the future, click the checkbox to 
the left of it to mark it as a favorite. Marked files (up to 500) appear under the Online Search group 
set in the Groups panel, giving you easy access to those files you use most often.

2.

Note: By default, EndNote only installs a list of popular connection files, but you can customize the 
installation to install more connection files.  See Custom Installations/Adding Content Files for  more 
information.
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What if Your Database Is Not Listed?

Adding Connection Files

If you have installed a large number of connection files, use the following features in the Connection 
Manager window to locate the connection file(s) that you want to use:

Click in the list and start typing the name of a connection file. Use the letter "u" as an abbreviation for 
"university." Other words might also be abbreviated. For example, the University of California at San 
Francisco would be searched for as "U Calif-San Francisco." EndNote will jump to the first letter that 
matches very quickly, so you may only be able to type a few letters, to help you get near the file you 
want.

▪

Click Find by  and EndNote displays the list of information providers (categories) used for all of the 
connection files. Choose one to restrict the list to show just that set of files.

▪

Click the column headings to sort the connection files by name or by information provider. Clicking 
the same column heading a second time will change the sort order from ascending to descending. 
Click again to set it back to ascending order.

▪

Click the More Info  button at the bottom of the dialog to display additional information about the selected 
connection file.

Note: For information about editing connection files or creating new ones, see Introduction to Connection 
Files.

By default, EndNote installs only the most popular connection files. For information about locating and 
installing additional files, see Installing Additional Connection Files.

If a connection file has not been provided for the database that you want to search, contact your librarian or 
information provider to see if their database is available on a Z39.50 server. If it is, you should request the 
information required to set up a Z39.50 client for that database. See Creating Connection Files.

The Connection Manager displays all of the connection files in the EndNote program folder as well as in 
your personal Connections folder. If you have received a connection file from a colleague or librarian or 
downloaded one from the Web, copy it into your personal Connections folder and it will appear in the 
Connection Manager. Keeping the file in your personal Connections folder ensures that it will not be deleted 
or overwritten with future updates to the EndNote program.

To locate your personal Connections folder or to designate a different Connections folder:

Select Preferences from the Edit menu.1.

Select the Folder Locations option.2.

Select the Connections Folder option.3.

Click Select Folder if you want to select a different folder to use for your personal Connections folder. 
The default folder should be in your Documents folder.

4.

Use your personal Connections folder to store and access connection files you have created or 
modified. They will show up in Connection Manager or when you click the more button in the Online 
Search group set.

5.
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Retrieving and Saving References

Discarding Duplicate References

The Connection Status Panel

Connection Status Panel

Note: New and updated connection files are posted on the EndNote Web site as they become available 
(Download EndNote Connection Files).

After a successful search, EndNote alerts you to the number of references that were found in The 
Connection Status Panel. You have the option of retrieving all of the references or a specific range of 
references. The order of the retrieved references reflects the way they were returned from the server—this 
is not necessarily alphabetical, chronological, or in order of relevance.)

Retrieved references are downloaded into the group selected in the Online Search group set, but are not 
automatically saved to a library. To save references, select them, and then:

Go to the References  menu and select Copy References To  in order to select a new or existing 
library and copy the selected references to that library.

▪

Click the Add the selected online records to your local library (+)  button at the right side of The 
Connection Status Panel.

▪

Drag and drop the selected references to a group in the current library.▪

Use the Copy  and Paste  commands from the Edit  menu to copy individual references from the 
Online Search group and then paste them into a library group.

▪

If you use the same search strategy to search multiple online sources, you may introduce duplicate 
references into your EndNote library. See Finding Duplicate References for  information on removing 
duplicates from the library.

The Connection Status panel provides abbreviated information on the results of an online search. You can 
select the number of results to download, or quickly add references to your library  using the Add the 
selected online records to your local library button (+) at the right.

For more detailed information on the status of connections during your current EndNote session, see The 
Connection Status Window and The Connect Log File.  This log file  can be helpful for troubleshooting 
connection files.
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The Connection Status Window

The Connect Log File

Importing a Log File

The Connection Status window provides detailed information about a connection and EndNote’s interactions 
with the online database and server. This window is useful to help you or to help EndNote Technical Support 
assist you in tracking down the source of a problem with an online database.

View the connection status information by selecting Show Connection Status from the Tools menu to display 
the Status window.

The Status window displays information for the latest connection. A menu at the top of the Status window 
lets you view either the record data for each reference or the status messages returned from the server of 
the online database.

Note: The Connection Status window displays the last 32K of text written to the Connection Log. If you 
need to see more than that, you can open the Connection.log file  in a word processor after closing the 
EndNote connection.

All messages and retrieved references for a given EndNote session are recorded in a log file. By default, the 
log file is called "Connect.log" and is saved in the folder:

C:\Users\[UserName]\App Data\Roaming\EndNote\

An existing log file is overwritten the first time EndNote establishes a connection after being started.

You may select a different name and/or location for the log file using the URLs & Links settings in the 
Preferences window. To do so, select Preferences from the Edit menu and select the URLs & Links option 
from the list. Click Choose in the Connection Log section to name the new log file and choose where to save 
it.

You may also choose not to create a log file by clearing the Use Log File option. This will slightly speed up 
the retrieval process. However, a log file can be useful for troubleshooting connection problems or when 
building or editing a custom connection file.

The log file is a regular text file. It can be viewed using a word processor and imported, if necessary, using 
the connection file. In this sense, the log file is a back up for the references retrieved in a particular EndNote 
session. You can verify that EndNote retrieved the reference data correctly by browsing through the log file 
in your word processor and comparing the unmodified data to what appears in your EndNote references. If 
necessary, you can change the settings in your connection file and import  the references again (without 
reconnecting to the online database).

Note: You cannot import from a Connect.log file saved for a search from  the Web of Science™ Core 
Collection. You must do a regular online search or a direct export.

To import a log file using the filter options of a connection file:

Open a library into which you want to import the log file.1.
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Searching the Web of Science™ Platform

Available Web of Science™ Databases

From the File menu, select Import > File.2.

Click Choose…, navigate to the folder for the Connect.log file and select  it. Substitute the name of 
your log file if you have changed the default name.

3.

Select Use Connection File from the Import Option list in the Import File dialog4.

Select the desired connection file, and then click Choose. Now you should be back in the Import File 
dialog with both the file and the import option set.

5.

Next to Text Translation, select No Translation.6.

Click Import.7.

Note: The connection file and filter file for a database are likely configured to import very different 
reference formats. Normally, a connection file is set up for MARC (Machine Readable Cataloging) data, 
whereas a filter is set up for tagged data. Because the output formats are so different, you should not use 
a filter file.

Web of Science™ is a comprehensive research platform that brings together many different types of content 
for searching. Journal articles, patents, Web sites, conference proceedings, Open Access material—all can 
be accessed through one interface, using a variety of powerful search and analysis tools.

Search the Web of Science™ Core Collection  just as you would search any other online database. Your 
search results can be copied directly to the EndNote library of your choice.

Once the records are in EndNote, you can click on an EndNote record’s URL to jump back to the original 
Web of Science Core Collection online record. Various options are available to you online, such as viewing a 
list of related references.

Note: IP authentication is required to search the Web of Science platform from EndNote.

As of this release, the following Web of Science product databases are available for direct online searching 
with EndNote. A subscription is required to access a particular product database.

Biological Abstracts▪

BIOSIS Previews▪

CAB Abstracts▪

Current Contents Connect▪

FSTA▪

MEDLINE▪
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Web of Science Core Collection: Citation Indexes

Full Record Charges

Users of Previous Versions of EndNote

Searching Author Names in Web of Science Databases 
that Contain Particles and Spaces

Finding Full Text for a Reference

Zoological Record▪

Core Collection Index▪

Science Citation Index▪

Social Sciences Citation Index▪

Arts & Humanities Citation Index▪

The Web of Science platform requires a paid subscription. You may have an online subscription with a 
username and password, or you may have access to a local Web of Science platform server.

If you used a previous version of EndNote, many of your preferences were saved when you upgraded to 
EndNote . However, if you want the ability to link back to Web of Science Core Collection records and 
product databases, you may need to update the Base URL.

From the Edit menu, select Preferences.1.

Click the EndNote Defaults button to update to the latest Base URL.2.

When searching a Web of Science product database (for example, the CABI or MEDLINE), you may need to 
add a connector to names that contains particles and spaces. For example, to search for de Bruyn A, enter 
the name in the Search field as de+Bruyn+A to ensure that the product returns all relevant results.

To search for de la Rosa, enter the name in the Search field as la+Rosa. You can also add a first name to 
restrict your search, but do not add a connector between the first name and the last name. For example, to 
search for Mario de la Rosa, enter in the Search field Mario de+la+Rosa.

EndNote can attempt to locate full text files on the Web by using data stored in your references. If found, 
EndNote downloads and attaches the files to the references.

EndNote uses these resources when searching for full text publications:

PubMed▪

Clarivate Links▪
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How to Find and Retrieve Full Text

DOI▪

OpenURL▪

EndNote will try to use all of these methods to optimize the likelihood of finding full text files associated with 
your bibliographic records.

The Web of Science™ Core Collection  free journal set is checked for all users; subscribers may have 
increased IP-based access to all resources. In cases where full text PDF files require a subscription, and 
you or your institution have the appropriate access, EndNote will attempt to authenticate and automatically 
download the appropriate files. If EndNote cannot find the full text file, it will often be able to attach the URL 
of the provider's Web page for the article for easier future access.

When you retrieve the full text file of a referenced work, it is saved to the File Attachments field as a relative 
link (the file itself it stored in the current library’s .Data folder). The file is saved in its native format, which in 
most cases is a PDF file.

When a file is downloaded and attached to a reference, a file attachment icon appears in the File 
Attachment field for the reference. In the Reference List, a paper clip icon appears in the File Attachments 
column for that reference.

The Find Full Text command can attempt to find full text documents for up to 250 records at a time; this total 
includes all full text searches run concurrently in open databases. If you want to find the full text for more 
than 250 EndNote records, you must run the Find Full Text operation more than once. Select up to 250 
references each time.

Note: References must be in an EndNote library  to use Find Full Text. You cannot find the full text for 
references in Online Search groups. Copy your references to your library, then run Find Full Text.

To find and retrieve full text:

Select the reference(s) to which you want to add full text.1.

In the Library window, highlight up to 250 references.  
 
For example, you can select a single reference, or hold down the Ctrl  key to select individual 
references, or use Edit > Select All to select an entire set of displayed references.

▪

From the References  menu, select Find Full Text  > Find Full Text. You can also right-click  a 
reference in the Reference List and select Find Full Text from the contextual menu or use the Search 
the Web for full text documents for the select references button on the toolbar.  

2.

(Optional) If you have entered an OpenURL address and authentication URL in the Find Full Text 
Preferences, you may be directed to a login web page for your institution’s  library. Follow the 
instructions to log in, such as entering the appropriate User ID and password. Once you are logged 
in, click Continue.

3.
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Find Full Text Groups

Searching...

EndNote begins searching for and downloading full text for the selected references. Full text downloading 
happens in the background, which may affect the performance of other operations.

References appear in groups under a Find Full Text group set. See Find Full Text Groups for a description of 
the resulting groups.

Note: Your institution may sever your OpenURL connection after a certain amount of time. Unfortunately, 
there is no indication when that happens. You will need to go to the References  menu, select Find Full 
Text, and then Authenticate  to restore access to the site. Just selecting Find Full Text again during this 
EndNote session will not restore authentication.

To add access to a library, see Adding Access to Your Institution's Library.

To improve the likelihood of finding full text articles for references, see Improving the Search for Full Text.

If you want to pause or cancel a Find Full Text operation, see Pausing or Canceling Find Full Text.

Note: Some institutions or data providers may have restrictions on downloading large numbers of PDFs 
using methods such as Find Full Text. If you are unsure of the restrictions for your institution, check with 
your library.

During the Find Full Text searching and downloading process, results are constantly updated under a Find 
Full Text group set.

The results of a Find Full Text search remain for the current session until you close the library. The 
categories include:

Searching…▪

Found PDF▪

Found URL▪

Not found▪

If you run the Find Full Text operation more than once during a single library session, the additional 
references are added to the references already found in the Find Full Text groups.

This group displays the current set of references for which EndNote is attempting to find either the full text 
file  of each referenced work or at least a URL to the referenced work. When the full text search is 
completed, this group is deleted. Those references to which full text or a URL was added are displayed in a 
Found PDF group or a Found URL group.

You can cancel the Find Full Text operation at any time by right-clicking on the Searching group, to display a 
context-sensitive menu, and selecting Cancel finding full text. Full text that has been retrieved until that point 
is already saved in the library.
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Found PDF

Found URL

Not Found

Pausing or Canceling Find Full Text

Improving the Search for Full Text

You can pause the Find Full Text operation at any time by right-clicking on the Searching group, to display a 
context-sensitive menu, and selecting Pause finding full text. Full text that has been retrieved until that point 
is already saved in the library.

This group displays the set of references for which EndNote inserted the PDF file of the referenced work as 
an attachment. These references display a paper clip icon in the File Attachments column of the Reference 
List. If a URL is also found, it is added to the reference, but the reference is not included in the Found URL 
group.

If the Find Full Text operation recognizes an already attached file as being the same as that found for a 
selected reference, EndNote will not attach the new file. This means the original PDF, with any personal 
annotations, will not be replaced by the newly found PDF. If it finds a different file, it will add the new file to 
the record. For example, if you manually added a PDF of related material, but not the article itself, when the 
PDF for the article is found, it will be attached to the PDF by Find Full Text.

This group displays the set of references for which EndNote inserted a URL to the referenced work, but did 
not find a full text document to attach.

This group displays the set of references for which EndNote could not identify a full text file or a URL. These 
are only from the set of references searched with the Find Full Text command during this session of the 
EndNote library.

To pause a Find Full Text operation, right-click  on the Searching…  group to display a context- 
sensitive menu, and select Pause finding full text. Full text that has been retrieved until that point is 
already saved in the library.

▪

To resume a paused Find Full Text operation, right-click on the Searching group and select Resume 
finding full text.

▪

To stop a Find Full Text operation, right-click  on the Searching  group and select Cancel finding full 
text.

▪

These are suggestions for improving the accuracy of the Find Full Text feature:

Make sure you are IP authenticated to access any premium full text resources to which you would 
like EndNote to attempt connecting.

▪

Ask your librarian whether your institution is set up with Web of Science™™ Core Collection journal 
links. If so, create a free personalized Web of Science™ Core Collection account and log in. If your 

▪
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Finding Related Online References

Adding Access to Your Institution's Library

institution does not have custom journal links set up for Web of Science Core Collection, ask your 
librarian to set it up (it is easy and free).

Create a free EndNote account and log in. Enhanced EndNote online is included for two years with 
EndNote. Make sure your EndNote account information is complete under EndNote Preferences 
(Edit > Preferences > Sync).

▪

Review your EndNote references to confirm that the DOI information is in the DOI field. If it is not, 
data for multiple records can be moved between fields with the Change/Move/Copy Fields… 
command from the Library menu. (See Move/Copy Fields.)

▪

Enable Web browser cookies.▪

If you would like Find Full Text to search a specific institutional library, see Adding Access to Your 
Institution's Library.

If Find Full Text is unable to find and download the PDF you need, you may still be able to access it using 
the OpenURL Link command. OpenURL Link connects to an OpenURL standard syntax server and uses 
EndNote’s OpenURL preferences along with data in your EndNote record to find related online references.

Highlight a reference in EndNote and use the URL > OpenURL Link command on the References menu to 
start your default  web browser and display the full text article (if available) plus a list of links to similar 
articles.

Note: This command has no relation to the URL field found in EndNote references or to the URL > Open 
Link command on the References menu (which opens the specific URL found in the URL field).

To enable this feature, and find out what preferences are available, see URLs & Links Preferences.

Many libraries are accessible with an OpenURL Path. Subscription libraries also require valid authentication, 
which usually means a user ID and password. First, you must determine the appropriate OpenURL path. If 
the library requires authentication, you must also determine the authentication URL. Next, enter these URLs 
as Find Full Text preferences. Then, you may need to authenticate access by entering your personal user ID 
and password. These definitions may be helpful to you:

OpenURL Path: This is the OpenURL web address to the online library. It is where EndNote will be directed 
to search for matching references.

Authentication URL: This is the web address to the page where you enter subscription details to access 
the online library. It is typically the page where you enter a user name and password. Once you enter the 
Authentication URL (if required), EndNote can access the full text of the matching references from the online 
library’s OpenURL path.

Proxy Server: Your institution may use a proxy server  to control access. For EndNote to automatically 
handle the proxy server when accessing http-based connections, you will need to configure your proxy 
settings.  You can do this for Windows by opening Settings  > Network & Internet  > Proxy.  Check your 
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Determining the OpenURL Path

Determining the Authentication URL

institutional library's website, or  ask your librarian or network administrator, for information on what the 
settings should be for your institution's proxy server.

The easiest way to determine your institution’s OpenURL address is to ask your librarian, or check the 
library's website.

SFX link resolvers work best, so look for a URL that begins with http://sfx.library or a similar URL that 
contains sfx in the path.

In order to use the OpenURL path to find full text articles, your institution likely requires that you log in to 
access full text. EndNote uses an authentication URL to automatically direct you to your institution’s  log-in 
web page.

Again, the easiest way to determine the authentication URL is to work with your librarian or check your 
library's website. To act as your own detective, though, you can try the suggestion below.

To determine the authentication URL:

Enter the OpenURL path as an EndNote preference.1.

From the Edit menu, select Preferences.a.

Select the Find Full Text panel.b.

Select the OpenURL box, and enter the OpenURL Path information.c.

Click OK to save the setting.d.

Then try one of these:2.

Follow the URL Path:a.
Highlight a reference—one where you believe the full text article is available from your 
institution.

(1)

Right-click on the reference and select References > URL > OpenURL Link. If you are not 
automatically directed to the full text article, use your browser to continue to try to get to the 
full text PDF file.

(2)

Browse to the URL:b.
Use a browser to go to your library’s Web site and try to access a subscription resource.(1)
Once you reach a page where you are prompted to enter credentials, copy the root of that 
URL. It may start with https://login.ezproxy. Copy everything through “/login? url=%@”.

(2)

Enter the path as an authentication preference as described next under Setting Full Text 
Preferences.

(3)

Test the URL by logging in to your institution’s site as described below.(4)
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Setting Full Text Preferences

Logging in to Your Library

Authenticate Only

Authenticate and Search

Once you have determined the appropriate OpenURL path and authentication URL for your institution, you 
must enter them as preferences in EndNote.

To enter Find Full Text preferences:

From the Edit menu, select Preferences.1.

Select the Find Full Text panel.  
 
This panel determines which methods are used when searching for full text articles. By default, 
PubMed, the Web of Science™ Core Collection Full Text Links, DOI, and OpenURL are selected.

2.

To search your institution’s  library, make sure OpenURL is selected, and enter your institution’s 
OpenURL Path. If authentication is required, enter an Authentication URL (the address of the site’s 
login page).

3.

For more information, see Find Full Text Preferences.

Once you have entered the appropriate URLs as Find Full Text preferences, you can log into your 
institution’s library. Do this in one of two ways:

From the References menu, select Find Full Text and then Authenticate.1.

This method allows you to try connecting without starting a Find Full Text search. You should be 
directed to your institution’s  login web page. Log in as indicated on the web page. You may be 
directed to a home page or a list of resources, which means you are logged in. Click Done. You are 
authenticated for this session of EndNote or until your institution times out the connection.

2.

You still need to specifically select the References  > Find Full Text  > Find Full Text  command to 
begin searching for full text articles.

3.

From the References menu, select Find Full Text, and then Find Full Text.1.

If you have an OpenURL path and authentication URL entered under Find Full Text preferences, 
EndNote will direct you to your institution’s login web page. Log in as indicated on the web page, and 
then click Continue to begin the search for full text articles for the selected references.

2.

You are authenticated for this session of EndNote or until your institution times out the connection.

Note: Your institution may sever your OpenURL connection after a certain amount of idle time. 
Unfortunately, there is no indication when that happens. You will need to go to the References  menu, 
select Find Full Text  and then Authenticate  to restore access to the site. Just selecting Find Full Text 
again during this EndNote session will not restore authentication.
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Importing Reference Data into EndNote

Retrieving References Directly from Online 
Databases

Importing Bibliographic Data to EndNote

Copyright Issues and Fair Use of Downloaded Data

If you have access to a library catalog or bibliographic database that supports the Z39.50 protocol, you can 
use EndNote as a tool to search and retrieve references directly from that database into EndNote. You do 
not need to use EndNote’s Import command. You can use the Online Search command instead. This is the 
easiest way to get data into EndNote because it involves no intermediate steps. For more information about 
the direct retrieval of references, see Searching Online Databases.

There are many sources of bibliographic data that can be used to help you create your EndNote library. To 
avoid retyping this data into EndNote, we have provided several means by which you can get references 
into EndNote:

Import PDF files.▪

Import references saved or downloaded from online data services (for example, PubMed  or 
Clarivate).

▪

Import text files that conform to a particular format (such as the Tab-Delimited or EndNote Import 
format). These files can be created by you or generated from other databases.

▪

Import text files exported from other bibliographic software programs.▪

For all of these options except importing PDF files, you need to get your data files in the right format 
(see Getting Data in the Right Format), and then determine the correct Import Options.

Once you have a file in the proper format and you know which import option or filter  to use, the import 
instructions are the same for all of these types of data. See Importing Text Files.

Note: Although we try to provide many flexible ways to get data from other sources into EndNote, we do 
not claim that EndNote can import data from all sources. In some cases, you may have to write your own 
import filter (see Creating a New Filter), or you may need to manipulate the data in a word processor 
before it can be imported. If none of these tools helps you to import your data, tips on how to quickly copy 
and paste data into EndNote are described in Copying and Pasting References from a Document into 
EndNote.

Note: When importing records, we recommend that you import into a temporary new library, determine 
which ones you want to keep, and then move those records into your permanent library.

Before you download references from an online source, consider copyright issues.
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EndNote gives you the capability to import references downloaded from online 
databases into its libraries. Some producers of online reference databases expressly 
prohibit such use and storage of their data, others charge an extra fee for a license to 
use the data in this way. Before you download references from a database, be sure to 
carefully check the copyright and fair use notices for the database. Note that different 
databases may have varying restrictions, even from the same information provider.

Importing PDF Files

EndNote Click

Download and Install the EndNote Click Plugin

Create Your EndNote Click Account

On-Campus Access

If you already have PDF files you have downloaded, or even need a little assistance with finding PDF files 
for references you have discovered online, EndNote can help.

EndNote can import PDF files, either a single PDF or an entire folder of PDF files. It can even import a 
folder of PDF files with subfolders and create a group set for the main folder and custom groups  for the 
subfolders.

EndNote Click (formerly Kopernio) can help you find PDF files for articles your institution has access to, 
quickly and easily.

EndNote Click is a free browser plugin that finds the best available PDF of an academic article while you 
browse. Behind the scenes, EndNote Click will search open databases and (where possible) your 
university's subscriptions to find the best version of the paper for you.

The EndNote Click plugin is availabre for Firefox, Chrome, Microsoft Edge, and Opera (for Opera you must 
first install the Chrome Extensions for Opera, then download the plugin for Chrome). Download ind install 
the plugin according to the requirements for your browser.

Download EndNote Click for Firefox.▪

Download EndNote Click for Chrome.▪

Download EndNote Click for Microsoft Edge.▪

The first time you click on the EndNote Click button in your browser, you will be directed to log in or create 
an account. You must create an account to use EndNote Click.

After creating your account, you will be shown a set of customization options. Select EndNote  as your 
citation management software to enable quick integration for downloading PDF files to EndNote or pushing 
them to EndNote online.

EndNote Click automatically detects your library subscriptions when you are on campus based on your IP 
address.  You don't need to do anything.
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Off-Campus Access

Using EndNote Click to Import PDF Files into EndNote

Importing PDF Files to Create New References

If your library supports off-campus access to subscriptions via EZproxy, OpenAthens, or Shibboleth, 
EndNote Click can connect through these.  You will need to log in to your library the first time you use 
EndNote Click off-campus.

Note: Neither Clarivate nor EndNote Click receive or store a user's institutional credentials. Credentials 
are stored in the Web browser, just like any other set of stored credentials, and EndNote Click simply 
uses them when attempting to retrieve fee-paid journal articles when the user is off-site.

As you are browsing the web, EndNote Click will be searching for available PDF files matching the articles 
you are looking at. When it finds one, it will show a button similar to the one below in the lower left corner of 
the window.

To download the PDF to EndNote:

Click the View PDF  button. The PDF will appear in an online viewer and a panel with options will 
appear at the left.

1.

Select Export to EndNote Desktop  to send the PDF and it's related bibliographic data to your 
desktop library. (Depending on your browser settings, you may be asked what to do with the 
downloaded file, to open it or to save it. If asked, open the file with EndNote.) An EndNote reference 
will appear in the temporary Imported References group, and the PDF will be attached.

2.

Note: The EndNote reference will have the basic information, but there may be additional information 
available. Try using the References > Find Reference Updates command to find missing information and 
add it to the reference.

This feature allows you to convert existing collections of PDF files into EndNote references with minimal 
typing or copying by extracting the Digital Object Identifier (DOI) from the PDF file. The system matches DOI 
information with data available from CrossRef (https://www.crossref.org/), capturing  bibliographic content 
and creating new EndNote references.

To import a PDF file:

Open the library into which you want to import the references.1.

From the File menu, select Import > File.2.

Click the Choose button.3.

Locate the PDF file you want to import. Select the file and click Open.4.
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Importing PDF Folders to Create New References

Select PDF from the Import Option list.5.

Select an option from the Duplicates list:6.

Import All: Imports all references, including duplicates.▪

Discard Duplicates: Imports all references except duplicates.▪

Import into Duplicates Library: Duplicate references are imported into a library called File- 
Dupl.enl, where ”File" is the name of the library into which you are importing.

▪

By default, a reference is considered a duplicate when the Author, Year, Title, and Reference Type match a 
reference already in the library. See Duplicates Preferences  if you would like to change the duplicates 
criteria.

Select No Translation for the Text Translation option.7.

Click Import to import the file.8.

Note:  See Importing PDF Folders to Create New References for instructions on how to import multiple 
PDF files stored within a single folder.

Note:  When performing the import function, if there are two DOIs found in the first two pages of a PDF 
document, EndNote will put at least one DOI in the DOI field for data extraction. The PDF is then attached 
and the file name is put in the Title field.

When the import is complete, the new record is stored in the temporary Imported References group, and will 
include bibliographic information given for the Digital Object Identifier (DOI) mined from the PDF file 
metadata, such as title, author, volume, issue, page, year, and DOI. You may be able to find more 
information for the record using the Find Reference Updates command.

The Imported References group is a temporary group that is replaced each time you import another set of 
references. It is removed when you exit EndNote (although the references remain in the library).

To return all of your references to the library display (including the newly imported ones), click the All 
References group.

This feature allows you to convert existing collections of PDF files into EndNote records with minimal typing 
or copying by extracting Digital Object identifiers (DOI) from PDF files. The system matches DOI information 
with data available from CrossRef (https://www.crossref.org/), capturing bibliographic content and creating 
new EndNote records.

To import a PDF folder with PDF files:

Open the EndNote library into which you want to import the references.1.

From the File menu, select Import > Folder to open the Import Folder dialog.2.

Click the Choose button. Navigate to the needed folder.3.

Select the needed PDF folder, and then click OK.4.
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Importing References Downloaded from Online 
Databases

If the selected folder lists subfolders, click the Include files in subfolders checkbox  to include PDF 
files in those subfolders in the import operation.

5.

If you would like EndNote to create a group set for the main folder and groups  within it for the 
subfolders, mark the box Create a Group Set for this import.

6.

Select the PDF option from the Import Option list. (It will be the only option available.)7.

Select an option from the Duplicates list:8.

Import All: Imports all references, including duplicates.▪

Discard Duplicates: Imports all references except duplicates.▪

Import into Duplicates Library: Duplicate references are imported into a library called File- 
Dupl.enl, where ”File" is the name of the library into which you are importing.

▪

By default, a reference is considered a duplicate when the Author, Year, Title, and Reference 
Type match a reference already in the library. See Duplicates Preferences if you would like to 
change the duplicates criteria.

Click the Import button to import the PDF files from the selected folder to your library.9.

Note: See Importing PDF Files to Create New References for instructions on how to import a single PDF 
file.

Note: When performing the import function, if there are two DOIs found in the first two pages of a PDF 
document, EndNote will put at least one DOI in the DOI field for data extraction. The PDF is then attached 
and the file name is put in the Title field.

When the import is complete, the new record is stored in the temporary Imported References group, and will 
include bibliographic information given for the Digital Object Identifier (DOI) mined from the PDF file 
metadata, such as title, author, volume, issue, page, year, and DOI. You  may be able to find more 
information for the record using the Find Reference Updates command.

The Imported References group is a temporary group that is replaced each time you import another set of 
references. It is removed when you exit EndNote (although the references remain in the library).

To return all of your references to the library display (including the newly imported ones), click the All 
References group.

If you have access to an online bibliographic database  or university  catalog, you can probably use 
EndNote’s  import filters to import text files saved or downloaded from these sources. EndNote filters are 
configurable so they give you the flexibility to import the reference data you need, and eliminate data you do 
not need.

There are two main things you need to know in order to correctly import downloaded references into 
EndNote:

Page 150 of 586

 



Clarivate EndNote 20 User Help Guide

Importing Text Files

How to download the data in the right output format. See Getting Data in the Right Format.1.

Which import filter to use to import the data into EndNote. See Choosing the Correct Import Filter.2.

EndNote can import structured text files to create new references in your library. This method of importing is 
extremely flexible. You can create your own structured files for importing, and your own import filters, as well 
as importing data from hundreds of online databases. This method also has the advantage of letting you 
remove duplicates of references already in your library during the import process.

Note:  See Importing EndNote Libraries for specific instructions about merging two EndNote libraries by 
importing one library into another. For another method of  merging EndNote libraries, see Merging 
Libraries through Sync.

To import a text file into an EndNote library:

Open the library into which you want to import the references.1.

From the File menu, select Import > File.2.

Click the Choose button.3.

Locate the file you want to import. All files, except for EndNote libraries and PDFs, must be plain text 
files. (The exception to this "plain text" rule is EndNote-generated XML files. See Exporting to 
EndNote XML for information an creating EndNote XML files.) Select the file and click Open.

4.

Select the appropriate filter from  the Import Option list. Filters are the customizable files EndNote 
uses to import text files. See Import Options for more information on available filters. See Creating a 
New Filter for information on creating your own custom filters.

5.

Select an option from the Duplicates list:6.

Import All: Imports all references, including duplicates.▪

Discard Duplicates: Imports all references except duplicates.▪

Import into Duplicates Library: Duplicate references are imported into a library called File- 
Dupl.enl, where ”File" is the name of the library into which you are importing.

▪

By default, a reference is considered a duplicate when the Author, Year, Title, and Reference Type 
match a reference already in the library. See Duplicates Preferences if you would like to change the 
duplicates criteria.

Select a Text Translation option.  
 
This option allows you to specify the text character encoding of the file you import, so that extended 
characters transfer correctly. You should verify the setting with your database provider. Some U.S. 
databases that contain extended characters require ANSI-Latin1 or UTF8. MARC format files may 
require ANSEL translation. You might be able to use No Translation for text files that do not contain 
any extended characters.

7.

Click Import to import the file.8.
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Import Options

Note: The time required to import a file is proportionate to the size of the library and the number of 
references being imported. Refer to the progress indicator to determine when EndNote has completed the 
task.

When the import is complete, the newly imported references are displayed in a temporary Imported 
References group. This is a perfect time to add a keyword  to each imported reference with the Change/ 
Move/Copy Fields (see Change Fields) command or to peruse the imported data to make sure it imported 
as expected. Make sure to check references that contain extended characters.

The Imported References group is a temporary group that is replaced each time you import another set of 
references. It is removed when you exit EndNote (although the references remain in the library).

To return all of your references to the library display (including the newly imported ones), click on the All 
References group.

EndNote's import options include:

PDF File or Folder: Use to import references from a PDF file that has been downloaded to your 
hard drive. This option allows you to convert existing collections of PDF files into EndNote records 
with minimal typing or copying  by extracting Digital Object identifiers (DOI) from PDF files. The 
system matches the content against the existing API services by capturing bibliographic content and 
creating new EndNote records. See Importing PDF Files to Create New References  for specific 
instructions.

▪

EndNote Library: Used to import references from one EndNote library into another. If the library you 
are importing from is closed or locked, all references are imported. If   the library you are importing 
from is open, with read/write access, the showing references are imported. See Importing EndNote 
Libraries.

▪

EndNote Import: Used to import text files that have been downloaded from online databases or 
exported from EndNote using the EndNote format. See Creating a Tagged EndNote Import File for 
more information.

▪

Refer/BibIX: Used to import text files exported from the Refer or BibIX programs. The EndNote 
import format is based on the Refer/BibIX format.

▪

Tab-Delimited: Used to import text files in which the fields within a single reference are separated by 
tabs. For details see Creating a Tab-Delimited Format.

▪

Reference Manager (RIS): Used to import text files exported from Reference Manager or any other 
source that uses the RIS format. See Converting a Reference Manager Database to EndNote if you 
need to convert a Reference Manager database.

▪

ISI-CE: Used  to import text files downloaded from Web of Science™  Core Collection and other 
Clarivate sources.

▪

Note: See Searching the Web of Science™ Platform for information about directly retrieving Web 
of Science™ Core Collection records.

Multi-Filter (Special): A special option for importing files that include references from multiple 
sources (see Identifiers).

▪
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Choosing the Correct Import Filter

Comparing a Filter to a Data File

EndNote Generated XML: Used to import EndNote’s proprietary XML format.▪

Other Filters: EndNote includes hundreds of import filters configured to import data from a variety of 
online databases. Most likely, the first time you import a file, you will not see the import filter that you 
need in this list. Select Other Filters  from the Import Option  list to find the filter that matches the 
source of the data you want to import. Import filters that you have recently used or chosen as your 
favorites will be listed in the Import Option list in the Import dialog.

▪

See Choosing the Correct Import Filter for information about how to choose the filters to appear in 
the Import Option list.

Use Connection File: EndNote provides the option of using a connection file as an import filter. This 
is useful if you need to import the Connection.log file generated by using EndNote’s Online Search 
command to search an online database. The Connection.log file should include all of the references 
from your previous session. See The Connect Log File for more information.

▪

Note: See Introduction to Filters  for information about creating and modifying import filters. All of the 
import filters (except Tab Delimited and EndNote Generated XML) can be modified.

Once you have captured and saved your data file in the appropriate format, you should identify the proper 
EndNote filter  to import the data. There are hundreds of filters included with EndNote, each designed to 
read a specific tagged format from a specific information provider.

To see a complete list of filters installed for your copy of EndNote, select Import Filters from the Tools menu, 
and select Open Filter Manager. You may see many filters with the same name, but from different data 
providers. Be sure to select the filter that matches both the database and the data provider you are working 
with or your data will not import correctly.

Use the Find by  button in the Filter Manager to  find all filters for a particular information provider. You can 
click the More Info  button to display additional information about a selected filter. The Comments section 
may provide information about how to appropriately download information from the source database.

When you have located the filters you want to use, mark them as your favorites by clicking the checkbox in 
the Favorites column to the left of the filter name. You can also mark all of the filters currently showing after 
using the Find option by clicking Mark All. Once a filter is marked as a favorite, it will appear in the Import 
Option list in the import dialog.

Note: There are many more databases and services that provide data than there are filters included with 
EndNote, so in some cases you may need to write your own filter or modify one of ours. See Introduction 
to Filters for information about creating and modifying filters. You can also check our Web site periodically 
for new and updated filters (Download EndNote Import Filters).

If you are uncertain whether a filter matches a data file that you have downloaded, you can compare the 
format from your downloaded data file to the filter. To do so, select a filter in the Filter Manager, and click the 
Edit button. When the Filter window opens, select the Templates option in the list at the left of the window to 
display the tags recognized by that filter.
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Changing the Filter Folder

Importing References from PubMed

To Save References to a Text File and Import Them

The tags and templates in the filter should match the data in the file you want to import. See The Basic 
Components of a Filter for information about editing filters.

By default, all filters provided with EndNote are stored in the Filters folder found in the EndNote program 
folder. These are the filters displayed when you open the Filter Manager. EndNote also displays filters found 
in your personal Filters folder.

When you create a new filter, it is saved to your personal Filters folder. When you attempt to save changes 
to an existing filter, you must use Save As to save a copy to your personal Filters folder. For more 
information about your personal folders, and information about how to change the location of your personal 
folders, see Folder Locations Preferences.

Follow the steps below to download your search results from PubMed as a text file and to import them into 
your EndNote library.

Go to the PubMed Web site in your Web browser at https://pubmed.ncbi.nlm.nih.gov/.1.

In the Search field, enter your search criteria. (To create an advanced search, click the Advanced 
button.)  To execute your search, click the Search button.

2.

Select the needed results and then click the Save button.3.

Select PubMed from the Format menu.4.

Click the Create File  button. This will bring up a dialog box allowing you to save your selected 
references as a text file.

5.

Save the file to your computer. Check your browser's options for where files are saved. You may 
have choices that will allow you to customize the location.

6.

Open the library into which you want to import the references.7.

From the File menu, select Import > File.8.

Click the Choose button.9.

Locate the file from PubMed you want to import. Select the file and click Open.10.

Select Other Filters…  from the Import Option list,  then select the PubMed (NLM) filter from the list. 
(After using the PubMed filter once, it will automatically be added to your favorites list.)

11.

Select an option from the Duplicates list:12.

Import All: Imports all references, including duplicates.▪

Discard Duplicates: Imports all references except duplicates.▪
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To Import References with Direct Export

Creating Structured Text Files that EndNote 
Can Import

Import into Duplicates Library: Duplicate references are imported into a library called File- 
Dupl.enl, where ”File" is the name of the library into which you are importing.

▪

By default, a reference is considered a duplicate when the Author, Year, Title, and Reference Type 
match a reference already in the library. See Duplicates Preferences if you would like to change the 
duplicates criteria.

Select No Translation for the Text Translation option.13.

Click Import  to import the file. The references will appear in the Imported References temporary 
group.

14.

Open the library into which you want to import the references.1.

Go to the PubMed Web site in your Web browser at https://pubmed.ncbi.nlm.nih.gov/.2.

In the Search field, enter your search criteria. (To create an advanced search, click the Advanced 
button.)  To execute your search, click the Search button.

3.

Select the needed results and then click the Send To button.4.

Select Citation Manager from the list.5.

Click the Create File  button. This will save the references in a format that works with EndNote's 
Direct Export feature.

6.

The references should appear in the temporary Imported References group of your library. If the 
references do not appear in your library, go to your browser's download location and double-click the 
file ending with the .nbib extension. The .nbib extension indicates the PubMed file format compatible 
with Direct Export.

7.

Note: Whether a file is recognized as being a Direct Export file type and opens in EndNote automatically 
can be affected by your browser and/or operating system settings for how file types are associated with 
programs. See Enabling Direct Export if PubMed files are not automatically added to your library with 
these Direct Export instructions.

What do you do if your data is not in a format that EndNote can automatically import? You can do one of 
several things (or even a combination these options):

Try searching for the references in another online database that might provide an importable format.▪

Rearrange the reference data using your word processor so that it is in a format that EndNote can 
import (one of the two options listed at the end of this topic).

▪

Copy and paste each piece of data from its source into the proper fields in EndNote, as described in 
Copying and Pasting References from a Document into EndNote.

▪
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Getting Data in the Right Format

Creating a Tagged EndNote Import File

Enter the data manually by typing it into EndNote as described in Entering References.▪

Creating a file that EndNote can import can be a lot of work if your data is in an arbitrary or inconsistent 
format. If you only have a few references to import (less than 30 or 40), it might be faster and easier to 
retype them or copy and paste the references than to try to put them into a format that EndNote can import.

However, if you have many references to import, it might save time to first manipulate the data in a word 
processor as best you can, and then import the references into EndNote and clean up the references there. 
Even if the imported data does not come through perfectly, it can be rearranged with EndNote’s various 
commands, drag-and-drop, and copy and paste, or it might be possible to update the data using Find 
Reference Updates if it is fairly accurate.

These are two different formats that you can put your data into that will allow it to be imported into EndNote:

A tab-delimited format. This is best if your data is in a database or spreadsheet that can export to a 
tab-delimited file. See Creating a Tab-Delimited Format.

▪

A tagged format. This  is best for when your data is in a word processor document and looks like a 
bibliography. See Creating a Tagged EndNote Import File.

▪

Note: To allow for the appropriate import of Unicode characters, save word-processing files as Unicode 
Text (UTF-8).

To import text with any of the EndNote filters, the data must be consistently "tagged," with each tag starting 
on a new line, and the file saved as text. Here are two examples:

AU- CRAMER, JOHN 
TI- AQUATIC 
PY- 1993 
SO- ENVIRONMENTAL-POLLUTION. VOL. 5, NO. 2, PG.54-79 
DE- LAKES, ACIDIFICATION, ENVIRONMENTAL EFFECTS, MACROPHYTES, ECOLOGY, 
PLANT PHYSIOLOGY
 
Author:   Cramer, John 
Title:    Aquatic macrophytes and lake acidification 
Year:     1993 
Source:   Environmental Air Pollution. Vol. 5(2) pp.54-79 
Keywords: lakes--acidification--environmental

Note: If data is inconsistently tagged, or poorly delimited, it may not be possible to import all the data 
accurately. See A Comment About Difficult Data Files.

If references are sent to you in the body of an email as tagged text, save the email to a plain text file.

The EndNote Import format is a tagged format based on the rules of the Refer/BibIX format. In this format, 
each field  of data (that is, Journal, Volume, or Title) is preceded by an identifying tag: a percent sign (%) 
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Author Names in the EndNote Import Format

Defining Reference Types

followed by a single capital letter, a number, or a special character, plus a space. Entire references are 
separated by one blank line:

%0 Book 
%A Geoffrey Chaucer 
%D 1957 
%T The Works of Geoffrey Chaucer 
%E F. Grouse 
%I Houghton 
%C Boston 
%N 2nd
 
%0 Journal Article 
%A Herbert H. Clark 
%D 1982 
%T Hearers and Speech Acts 
%B Language 
%V 58 
%P 332-373
 
%0 Thesis 
%A Cantucci, Elena 
%T Permian strata in South-East Asia 
%D 1990 
%I University of California, Berkeley 
%9 Dissertation

Author names use the %A tag. This tag should repeat for each author, with the names listed one per 
line:

▪

%A  Jones, Mary 
%A  Simon, Jeff

Author names can appear either as:▪

Geoffrey Chaucer 
or 
Chaucer, Geoffrey

Either initials or full names are accepted.▪

Set the reference type for each of the imported references by using %0 (zero) and the reference type name.

The default reference types are listed below. If you have modified a reference type, your EndNote data files 
should use the new name instead.
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%0 Aggregated Database %0 Hearing

%0 Ancient Text %0 Interview

%0 Artwork %0 Journal Article

%0 Audiovisual Material %0 Legal Rule or Regulation

%0 Bill %0 Magazine Article

%0 Blog %0 Manuscript

%0 Book %0 Map

%0 Book Section %0 Multimedia Application

%0 Case %0 Music

%0 Catalog %0 Newspaper Article

%0 Chart or Table %0 Online Database

%0 Classical Work %0 Online Multimedia

%0 Computer Program %0 Pamphlet

%0 Conference Paper %0 Patent

%0 Conference Proceeding %0 Personal Communication

%0 Dataset %0 Podcast

%0 Dictionary %0 Press Release

%0 Discussion Forum %0 Report

%0 Edited Book %0 Serial

%0 Electronic Article %0 Social Media

%0 Electronic Book %0 Standard

%0 Electronic Book Section %0 Statute

%0 Encyclopedia %0 Television Episode

%0 Equation %0 Thesis

%0 Figure %0 Unpublished Work

%0 Film or Broadcast %0 Unused 1

%0 Generic %0 Unused 2

%0 Government Document %0 Unused 3

%0 Grant %0 Web Page

EndNote Tags and Corresponding Fields

The table below shows the tags recognized in the EndNote Import format and the corresponding EndNote 
field into which each tagged item is imported for the Generic reference type. For other reference types, you 
can find the fields associated with the tags by examining the EndNote Import filter template. See Templates 
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Tag EndNote Generic Field Name

%A Author

%B Secondary Title (of a Book or Conference Name)

%C Place Published

%D Year

%E Editor/Secondary Author

%F Label

%G Language

%H Translated Author

%I Publisher

%J Journal Name

%K Keywords

%L Call Number

%M Accession Number

%N Number (Issue)

%O Alternate Title

%P Pages

%Q Translated Title

%R DOI

%S Tertiary Title

%T Title

%U URL

%V Volume

%W Database Provider

%X Abstract

%Y Tertiary Author/Translator

%Z Notes

%0 Reference Type

EndNote Tags Table

for Different Reference Types in  Import Filters and Connection Files  for information on viewing or editing 
filter templates.

Note: The Figure field is not included for importing.
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Tag Generic Field Name (Continued)

%1 Custom 1

%2 Custom 2

%3 Custom 3

%4 Custom 4

%6 Number of Volumes

%7 Edition

%8 Date

%9 Type of Work

%? Subsidiary Author

%@ ISBN/ISSN

%! Short Title

%# Custom 5

%$ Custom 6

%] Custom 7

%& Section

%( Original Publication

%) Reprint Edition

%* Reviewed Item

%+ Author Address

%f Figure

%^ Caption

%> File Attachments

%< Research Notes

%[ Access Date

%= Custom 8

%~ Name of Database

EndNote Tags Table (Continued)

Creating a Custom "Tagged" Format
If you have a large bibliography that you would like to import into EndNote, it may be possible to use your 
word processor’s Find and Replace commands to insert descriptive tags in front of some of the fields of data 
so that EndNote can accurately import the references. In addition to adding tags, you also need to make a 
filter  to read your tags. (See Choosing the Correct Import Filter  for information about using a predefined 
EndNote Import format if you would rather not create your own filter.)
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Tag Field

XX- Author (Year) "Title" Journal. Vol. Volume no. Issue.

This topic outlines the basic steps to convert a bibliography into a tagged text file.

Step 1. Save a Copy of Your File

Open your bibliography in a word processor and save a copy of the file with a new name (this is your 
backup).

▪

Remove everything but the reference data from the file.▪

Step 2. Add Descriptive Field Tags

Use your word processor’s Find and Replace commands to search for unique delimiters between fields, and 
insert paragraph marks and descriptive field tags in front of specific fields. For this example, we will show a 
very simple case where only the start of each reference is tagged, and the filter does the rest of the work. 
This works well for reference lists that have clear delimiters separating the individual components of the 
reference (author, year, title, and so on). In some cases, you may have better results making additional 
replacements in the text file before importing. The more tags you add to your data, the greater degree of 
accuracy you can get with the import filter.

Suppose your references look like this:

Jones, M. (2020) "Quail Intelligence" Avian Science. Vol. 3 no. 2.
 
Billoski, K. (2012) "Parakeet Smarts" Avian Digest. Vol. 23 no.5.

The process of converting this bibliographic format to a tagged format would be something like this:

Search for 2 paragraph marks (since the references are separated by 1 blank line), and replace with 
two paragraph marks and a tag "XX-" followed by a space.

▪

The result is a tagged data file that looks like this:

XX- Jones, M. (2020) "Quail Intelligence" Avian Science. Vol. 3, no. 2. 
 
XX- Billoski, K. (2012) "Parakeet Smarts" Avian Digest. Vol. 23, no.5.

Once you have made all the changes to tag as much of the data as necessary, save the file (as a plain text 
file), and create an import filter to match the tags and formats of the references.

Step 3: Create a Filter for Non-Delimited Data

Using EndNote, create a new filter to read your data file (see Creating a New Filter). The template of a filter 
for the above data file would look like this example.

Each field listed for the Tag must appear in each of your references. If a reference field is missing, all of the 
data will appear in a previous field. For instance, if you were using the above reference format and a Volume 
field was not present, the filter would place the Issue data in the Journal field.

To resolve this issue, each iteration of a reference must be entered into the filter according to a hierarchy of 
formats (longest is always on top).

XX- Author (Year) "Title" Journal. |Vol. Volume no. Issue|.
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Creating a Tab-Delimited Format

Preparing the Data Before Exporting

Author Names

Reference Types

Paragraph/Line Breaks within Records

XX- Author (Year) "Title" Journal. |Vol. Volume|.
XX- Author (Year) "Title" Journal. |`DOI:`DOI|.

To ensure that each source line is imported into your library during import even if it does not match one of 
the templates you set up, you can turn on the Import Source Into option from the Source Parsing option  in 
the filter. Just identify your source tag, then select import source into and select a field.

Step 4: Clean Up the Data

After you set up your file with tags and create a filter to import it, you should test and refine the filter by 
importing into a new library. Once your filter is working as you would like it, you can use it to import the data 
file into your real EndNote library.

If you cannot get the filter to import everything exactly as you want, you may have to do some manual 
editing to correct this, either before or after importing the data into EndNote. You might find it useful to 
import into a test library, then use the Change Fields Move/Copy Fields, and Find and Replace options to 
clean up the data. Then, transfer these references to your real library with drag-and-drop, copy and paste, 
or the Import command.

The Tab-delimited import option can import text files in which each reference is separated by a paragraph 
break (¶), and the fields within a reference are separated by tabs. Most databases or spreadsheets can 
export a tab-delimited text file.

Before you export data from a database or spreadsheet into a text file, we recommend that you separate 
multiple author names with a semicolon (;) or two forward slashes (//). For example:

McCartney, P.//Harrison, G.//Lennon, J.

If you cannot easily do this in your database, you can do it after exporting or manually edit the data after it is 
in EndNote.

If possible, you should make sure that each reference in your tab-delimited file includes a field indicating the 
reference type. Use EndNote’s Reference Type names so that EndNote is able to recognize the formats. If 
you have only one type of reference (such as Journal Articles), it is not necessary to do this—the import 
settings can indicate that all references should be imported as the same type.  
 
If you cannot label each reference with the appropriate Reference Type name, you should export your data 
into separate files based on reference type. This makes it easy to preserve the original reference types of 
the references when importing the data files into EndNote.

Each reference must end with a paragraph mark. There should be no paragraph marks or line breaks within 
a reference. For example, spreadsheet programs such as Excel will allow you to enter line breaks within a 
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Preparing the Data File for Import

First Line: The Default Reference Type

*Journal Article<¶>
Author <tab> Year <tab> Title <tab> Journal <tab> Volume <¶>
Jones, J//Shoe, S <tab> 1994 <tab> Easy Food <tab> J. of Eating <tab> 1 <¶>
Woo, W//Lee, L <tab> 1995 <tab> Rain Hats <tab> J. of Clothing <tab> 2 <¶>
Carlos, C//Luis, L <tab> 1991 <tab> Cell Phone <tab> J. of Phones <tab> 3 <¶>

Tab-Delimited File Example for a Single Standard EndNote Reference Type as the Default

First Line: A Custom Reference Type

*My Reference Type<¶>
[F1] <tab> [F2] <tab> [F3] <tab> [F4] <tab> [F5] <¶>
Jones, J//Shoe, S <tab> 1994 <tab> Easy Food <tab> J. of Eating <tab> 1 <¶>
Woo, W//Lee, L <tab> 1995 <tab> Rain Hats <tab> J. of Clothing <tab> 2 <¶>
Carlos, C//Luis, L <tab> 1991 <tab> Cell Phone <tab> J. of Phones <tab> 3 <¶>

Tab-Delimited File Example for a Single Custom EndNote Reference Type as the Default

cell. When saved as a tab-delimited file, these line breaks may be interpreted as the  end of a record, 
breaking the reference into separate EndNote references.

Once the tab-delimited file(s) are generated, you must open each file in a text editor or word processor and 
add two lines to it. These lines tell EndNote what the reference type is for the data and how the data should 
be interpreted.

If all the references in the file are for the same reference type, the first line of the file must define the default 
reference type for the entire file. The format for the first line is an asterisk (*) immediately followed by a valid 
EndNote reference type, followed by a paragraph break (shown below as <¶>). For example:

*Journal Article<¶>

The second line should contain the field names used for that reference type. A file of journal articles would 
contain the fields used in the Journal Article reference type. It might look like this:

Just like when importing a tab-delimited file for a standard reference type, the field names for a custom 
reference type must match the reference type, so you will need to know the field names you used in your 
custom reference type. To find them, follow these instructions.

Select Preferences from the Edit menu.1.

Select Reference Types.2.

Click the Modify Reference Types button. Find your custom reference type and make a note all the 
fields used in it.

3.

Note: You can find templates of all the reference types using the List of Reference Types. These 
templates can be printed out to help you record changes you make to the reference types.

A file for which you are using a custom reference type as the default might look like this:
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First Line: Using Multiple Reference Types

*Generic<¶>
Reference Type <tab> Author <tab> Year <tab> Title <tab> Publisher <¶>
Book <tab> Jones, J <tab> 1994 <tab> Easy Food <tab> Avalon <¶>
Book Section <tab> Woo, W//Lee, L <tab> 1995 <tab> Rain Hats <tab> Nourse <¶>
Web Page <tab> Carlos, C <tab> 2020 <tab> EndNote <tab> Clarivate <¶>

Tab-Delimited File Example with No Default Reference Type

Second Line: EndNote Field Names

*Journal Article<¶>
Author <tab> Year <tab> Title <tab> Journal <tab> Volume <¶>
Jones, J//Shoe, S <tab> 1994 <tab> Easy Food <tab> J. of Eating <tab> 1 <¶>
Woo, W//Lee, L <tab> 1995 <tab> Rain Hats <tab> J. of Clothing <tab> 2 <¶>
Carlos, C//Luis, L <tab> 1991 <tab> Cell Phone <tab> J. of Phones <tab> 3 <¶>

EndNote Field Names Table for Journal Article Fields

Additional Considerations

Note: Ensure that the field names that appear in the second line match those assigned to your custom 
reference type. In the example above "My Reference Type" would the name of the custom reference type, 
and "F1," "F2," etc. would be the name of the fields used in the custom reference type. Tabs are indicated 
by "<tab>" in the examples above.

If you could not make separate files based on reference type, you can specify each reference type  within 
one file. In this case, your first line must be an asterisk (*), followed by "Generic" and a paragraph mark. 
then the list of field names found in the Generic reference type, starting with a field for "Reference Type." 
Use the Reference Type column to define the actual EndNote reference type names. For example:

Note: Ensure that the generic field names for the reference type (Modify Reference Types dialog) appear 
in line 2. In the examples above, note that in the first example for the standard Journal Article reference 
type there is a "Journal" field name, but the Generic name for that field would be"Secondary Title." When 
importing multiple reference types, "Secondary Title" would appear in the field names, not "Journal."

As stated above, the second line of the tab-delimited file must contain the actual field names used by 
EndNote. The order of the field names does not matter as long as they correspond to the order of the data 
in the rows beneath them and correspond to the names of the default reference type (or to the generic 
names when importing multiple reference types).

For example, if your default reference type is "*Journal Article," the field names in the second line of your file 
will be those of the Journal Article reference type:

Note: The field names must be separated by tabs and a paragraph break must follow the last field name.

ANSI, ASCII, or UTF-8 formatted plain text files can be imported. This means that no font styles or 
text styles can be preserved during import.

▪

All field names and reference type names in the file must be identical to those in EndNote. See the 
List of Reference Types for a listing of all of the reference types. Use the links in the list to access 
templates showing the field names.

▪
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Importing References from Other Bibliographic 
Software Programs

Copying and Pasting References from a 
Document into EndNote

Multiple author names should be separated by semicolons (;) or by two forward slashes (//).▪

Fields cannot contain tabs or paragraph marks. Let the lines of data "wrap" to the next line.▪

Leading and trailing spaces are removed during importing.▪

No uppercase or lowercase conversion is made during importing.▪

A reserved field name called "Unused" may be used for data that you do not want imported into 
EndNote.

▪

Many programs include an option to export data in the RIS format, which can easily be imported into 
EndNote. See Importing Text Files for instructions on importing a text file in the RIS format.

If a program does not include an option to export to the RIS format, information on converting from many 
programs is available at the EndNote Support website.

If you have a bibliography that is too inconsistent or difficult to parse using your word processor (as 
suggested in Creating a Custom "Tagged" Format), you can use the Copy and Paste commands as an 
alternative method for getting your data into EndNote and still avoid a lot of retyping.

To transfer the references into EndNote:

Open the list of references in a word processor.1.

Select a reference and copy it using the Copy (Ctrl+C) command.2.

Open your EndNote library, and select New Reference (Ctrl+N) from the References menu to create 
a new reference.

3.

Put the cursor in the Title field of the new reference and select Paste (Ctrl+V) from the Edit menu.4.

This will paste the entire reference into the Title field of the Reference window. From here, you can drag- 
and-drop (or cut and paste) the individual pieces of data into their proper fields. Be sure to remove 
extraneous punctuation, and make sure author names are each on a separate line. Follow the guidelines for 
Entering References. See Default Reference Type for information about setting a default reference type for 
new references.
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Cite While You Write in Microsoft Word

Overview of the Cite While You Write Process 
in Word

How to Cite While You Write with Microsoft 
Word

Use Cite While You Write™  (CWYW) with Microsoft Word 2010, 2013, 2016, 2019, or Office 365 (locally 
installed desktop version only) to easily and quickly cite references, figures, and tables, and create a paper 
with properly formatted citations, a bibliography, figures, and tables.

Cite While You Write gives you access to EndNote references and formatting commands through an 
EndNote tab in Word.

You can start by inserting a citation  into a document. A bibliography formatted according to any one of 
thousands of styles is created. Instant formatting  technology can automatically update your citations and 
bibliography as you write. You can even insert figures and tables found in EndNote references.

A Traveling Library allows  you to reformat references in your Word document even when your EndNote 
library is not available. If you are collaborating with other authors, you can rely on the Traveling Library to 
supply reference information.

You can use your EndNote desktop application or EndNote online to Cite While You Write. See Using Cite 
While You Write with EndNote Online.

The basic steps required to cite a reference and generate a bibliography with Microsoft Word are 
summarized below.

To Cite While You Write:

Open the EndNote library or libraries that contain the references you wish to cite.1.

Start Microsoft Word and open the paper you are writing.2.

When you are ready to cite a source, position the cursor in the text where you would like to put the 
citation.

3.

On the EndNote 20  tab, click the Insert Citation  button. A Find & Insert My References dialog 
appears. (If you click on the drop-down list arrow at the bottom of this button, you will be given 
choices beyond finding and inserting citations.)

4.

In the text box at the top, enter identifying text for EndNote to locate the appropriate reference. This 
could be an author’s  last name, a year, a keyword, or any other combination of terms found in the 
reference.

5.

Click Find and EndNote compares the identifying text to your EndNote references and then lists the 
matching reference(s).

6.

Page 166 of 586

 



Clarivate EndNote 20 User Help Guide

Word Processor Compatibility

Identify and highlight the appropriate reference(s).7.

Use the Insert button drop-down to display a menu, and select from:8.

Insert: To insert the citation and format it as defined by the currently selected output style. (This 
would be the same result as simply clicking on the Insert button.)

▪

Display as: Author (Year):  Select this menu option to display both the author name and the 
year in the highlighted citation, but with the author name appearing to be outside the citation 
marker.

▪

Exclude Author: Select this to omit the author name from the formatted citation.▪

Exclude Year: Select this to omit the date from the formatted citation.▪

Exclude Author & Year: Select this to omit both the author name and the year from an Author- 
Date formatted citation. This is usually used when you want only page numbers to appear in the 
citation.

▪

Show Only in Bibliography:  Select this option to display the selected citation only in the 
bibliography, not in the body of the paper.

▪

Go back to step 3 to insert the next citation, and continue citing references this way.9.

Note:  When Instant Formatting is turned on, each time you insert a citation it is formatted and a 
bibliography is updated at the end of your document. When you are done inserting citations, your 
document is done! Instant Formatting is turned on by default. See Instant Formatting in  Microsoft 
Word for more information.

If your citations are not automatically formatted, and a bibliography is not updated each time you 
insert a citation, click the Update Citations and Bibliography button on the EndNote 20 tab.

10.

If you want your paper formatted with a different style, select the style you want from the drop-down 
Style menu. If you do not see the style you want on the list of favorites, click Select another style to 
see the list of all styles installed on your computer. See Installing Additional Output Styles  for 
information on installing more styles.

11.

Your paper is ready for publication!

If you want to insert figure or table citations, see Inserting and Formatting Figures and Tables.

To Cite While You Write in Microsoft Word, you must use Microsoft Word 2010, 2013, 2016, 2019, or Office 
365 (locally installed desktop version only).

Install the latest service pack from Microsoft. Cite While You Write can convert and use Word documents 
that used earlier versions of Cite While You Write.

Word displays Cite While You Write commands on an EndNote 20 tab.

If you use Apache OpenOffice Writer or LibreOffice 4.x-6.x (32-bit) as your word processor, see How to Cite 
While You Write with OpenOffice Writer.
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EndNote Cite While You Write Tab Missing in 
Word

If you use a word processor other than those listed above, or an older version of these word processors, 
save your document as an RTF file and use Format Paper.

To create a standalone bibliography that is not based on the citations in a paper, see Introduction to 
Independent Bibliographies.

Note: Only one word processor at a time should be open when inserting citations and formatting 
documents.

You can access and set Cite While You Write preferences from either EndNote or Word. The same dialog 
appears, and changes are saved in the same place:

From EndNote’s Tools menu, go to the Cite While You Write (CWYW) submenu and select CWYW 
Preferences.

▪

In Word, on the EndNote 20 tab, select Preferences.▪

Cite While You Write preferences include general preferences (see General Preferences in Microsoft Word), 
the ability to assign keyboard shortcuts to menu commands (see Keyboard Preferences in Microsoft Word), 
and the ability to control the placement of figures (see Figures and Tables Preferences in Microsoft Word).

For information about other EndNote preferences that directly affect Cite While You Write, see Related 
EndNote Preferences.

The following instructions describe how you can restore the EndNote Cite While You Write tab in Microsoft 
Word.

Word 2010, 2013, 2016, 2019, and Office 365: Select Options from the File menu.1.

Select Add-ins from the menu.1.

Select Disabled Items from the Manage menu, and then click the Go button.2.

Select any EndNote item in the list, and then click the Enable button.3.

Click OK to enable the EndNote 20 tab.4.

Close and reopen Word.5.

Check to ensure that the EndNote tab appears at the top of the Word document.6.

Note: If you prompted, select to allow the files to be loaded by Word.
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Go to our EndNote support page for instructions on how to restore the EndNote tab in earlier versions of 
EndNote.

See Application Preferences in Microsoft Word  for information about switching from EndNote desktop to 
EndNote online and vice-versa.

Use the Application tab to indicate which version of EndNote to use when you use Cite While You Write.

On the EndNote tab, select Preferences.1.

Select the Application tab.2.

From the drop-down Application  menu, select which version of EndNote you want to use with Cite 
While You Write.

3.

EndNote is your desktop version of the EndNote bibliographic application. Select this option if 
you want to work with your desktop libraries. This option will cause a tab called EndNote 20 to 
appear.

▪

EndNote online  is the online version of EndNote. Select this option if you want to use 
references from a group shared with you. See Sharing Groups. This option will cause a tab 
called EndNote to appear.  
 
OR  
 
Select Search: Shared Groups in the Find & Insert My References dialog to temporarily search 
shared groups  without changing the tab. Change it back to Search: Libraries  to search your 
desktop libraries again.

▪

Select EndNote online from the Application menu if you want to make any changes to your EndNote online 
accounts, such as changes to your e-mail address or your password.

Select EndNote online from the Application menu.1.

Enter or confirm the EndNote online URL: https://www.my.endnote.com:80/.2.

Enter your e-mail address and password. Your e-mail address and password are remembered in 
Sync Preferences.

3.

Mark the Remember my address and password checkbox  if you want EndNote to remember these 
changes. If you are working on a shared computer, leave this box unmarked so the next person 
using that computer does not have access to your account.

4.
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Library

Finding Cited References in a Library

Editing a Reference in the Library

Deleting a Reference from the Library

You can quickly jump from a bibliographic in-text citation (not a figure citation) to the corresponding EndNote 
reference.

To find an EndNote reference:

Make sure both your Word document and your EndNote library are open.1.

Highlight the citation(s) in your Word document.2.

On the EndNote tab, select Edit Library Reference(s).3.

EndNote goes to the corresponding reference for editing.

You may insert a citation in a Word document, and then later edit the corresponding reference in EndNote. 
Are those changes reflected in your Word document?

Your citations and bibliography will reflect the edits the next time the citations in the paper are updated with 
the EndNote library open. Open your document, open your EndNote library, and click Update Citations and 
Bibliography on the EndNote 20 tab.

EndNote will not be able to make the update if the library is not open during formatting. Instead, it will take 
the original reference information from Word’s Traveling Library (see The Traveling Library).

Note: The author’s last name and the publication year are both used to identify a reference, so changes 
to these items in an EndNote reference are not reflected in the in-text citation. Cite While You Write will no 
longer identify a match between the citation and the reference if the citation is unformatted. If the citation 
is formatted, it  will use reference information from Word’s  field  codes to update the citation and 
bibliography (The Traveling Library).

If you make changes to a figure in an EndNote reference, you must manually replace the figure in your Word 
document.

The first time a citation is formatted, EndNote uses information from the unformatted citation to look in the 
open library and find the corresponding reference. If you later reformat, EndNote again looks in the library 
for that reference. If the reference has been deleted from the library, EndNote takes the reference 
information from hidden Field Codes in Microsoft Word (The Traveling Library).

So, if you deleted a cited reference from the library, the required information is still available in the hidden 
field codes surrounding each formatted citation—even though the reference is no longer in the library.
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Cite While You Write Commands and Field 
Codes

Cite While You Write Commands

However, an unformatted citation is a temporary placeholder. If a citation is unformatted, and you have 
deleted the corresponding reference from the EndNote library, EndNote will not be able to find the reference 
information for formatting.

If you add the reference to the library again, it will be assigned a different record number. You would need to 
reinsert the citation in Word.

EndNote assigns a unique record number to each reference as it is added to your library. These record 
numbers appear in temporary citations to ensure that the correct reference is used when the paper is 
formatted:

{Argus, 1991 #11}

The record number for a reference is also visible in the title bar of the Reference panel.

Note that:

EndNote automatically assigns a record number sequentially to each reference as it is added to a 
library.

▪

If the same reference appears in two different libraries, the record numbers will most likely be 
different.

▪

Record numbers are never reused or reassigned within a library. When you delete a reference, the 
corresponding record number is never used again in that library.

▪

You cannot modify or reassign record numbers.▪

We recommend that you not rely on EndNote’s  record numbers as a means of filing or numbering 
your office reprints, because you have no control over this number. Instead, enter your own unique 
number into the Label field, and use that number for your reprints.

▪

If you add the reference to the library again, it will be assigned a new, different record number, so EndNote 
still will not be able to find a match to your unformatted citation when formatting your paper. You will need to 
reinsert the citation into the paper using the new reference in your library.

When Cite While You Write is installed, several EndNote commands appear on an EndNote 20 tab in Word. 
When you select an EndNote command from the tab, the EndNote program starts (if not already running) 
and a Cite While You Write submenu becomes active on EndNote’s Tools menu, displaying some of the 
same EndNote commands available in Word.

Note: When you use Cite While You Write Preferences to select EndNote online as the active Cite While 
You Write Application, an EndNote 20 tab appears in Word. The EndNote online tab displays a smaller set 
of CWYW commands than the EndNote desktop application.
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Bibliography Group

Below are brief descriptions of the Cite While You Write commands that are found from the EndNote 20 tab.

Insert Citation > Insert Citation: Search for EndNote references to select and insert as citations in 
your Word document. See Finding and Inserting Citations in Microsoft Word.

▪

Insert Citation > Insert Selected Citation(s): Insert a citation for each reference currently selected 
in the open EndNote library. You can insert up to 250 references in a single in-text citation. 
See Inserting Selected Citations in Microsoft Word.

▪

Insert Citation > Insert Note: Add custom text citations to your Word document. See Including 
Notes in the List of References in Microsoft Word.

▪

Insert Citation > Insert Figure: Search for an EndNote reference that contains a figure, and insert a 
figure or table in your Word document. The figure or table is numbered, and automatically added to 
the document. Figures inserted in the document will not appear in the bibliography. See Finding and 
Inserting Figures and Tables.

▪

Go To EndNote: Bring EndNote to the front of your screen. This command launches EndNote if it is 
not already running.

▪

Edit & Manage Citation(s): Edit existing individual or multiple citations. You can omit author and/or 
year from citations, add prefix or suffix text (such as page numbers) to citations, or delete formatted 
citations from the paper. See Editing Citations in Microsoft Word.

▪

Edit Library Reference(s): Select citations in your Word document, then select this command to 
directly edit the corresponding references in EndNote.

▪

Style: Select an output style from the list to format (or reformat) your paper according to the rules of 
the selected style. The styles listed are marked as "favorites" in the EndNote style manager.

▪

Update Citations and Bibliography: Format (or reformat) your paper according to the rules of the 
selected style. The formatting process replaces the temporary citations in your paper with formatted 
citations, and builds a bibliography at the end of the document. This command also updates the 
formatted figures and tables found within the body of the document or in a list at the end of the 
document.

▪

Convert Citations and Bibliography > Convert to Unformatted Citations: Unformat a selected 
citation before editing it or unformat the whole document. This removes style formatting for the 
selected citations, and leaves temporary citations, which usually consist of the author’s  last name, 
the year, and the record number surrounded by delimiters. Use Update Citations and Bibliography to 
format the paper again. See Unformatting Citations in Microsoft Word.

▪

Convert Citations and Bibliography > Convert to Plain Text: Save a copy of your document 
without formatted Cite While You Write field  codes. Formatted citations and the bibliography are 
saved as text. See Field Codes in Microsoft Word and Removing Field Codes.

▪

Convert Citations and Bibliography > Convert Reference Manager Citations to EndNote: 
Convert any Reference Manager citations in this document to EndNote Cite While You Write 
citations. This option assumes that you have converted your Reference Manager database  to an 

▪
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Field Codes in Microsoft Word

EndNote library. Values include Author Date RefID and RefID. For information on converting a 
Reference Manager database, see Converting a Reference Manager Database to EndNote.

Convert Citations and Bibliography > Convert Word Citations to EndNote: Convert any citations 
created by Microsoft Word in the document to EndNote Cite While You Write citations.

▪

Categorize References: This feature allows you to create a bibliography organized by categories 
you create. See Reference Type Categories in Output Styles.

▪

Instant Formatting: Turn instant formatting on or off for the document, set how frequently EndNote 
scans for temporary citations, and whether EndNote checks for citation changes.

▪

Configure Bibliography: Click the arrow in the bottom right corner of the Bibliography section to 
display a tabbed dialog of formatting options. When you click OK to leave the dialog, EndNote 
formats (or reformats) your paper according to the rules of the selected style. See Configuring the 
Bibliography in Microsoft Word.

▪

Note:  By default, Instant Formatting is turned on, so your citations and bibliography are automatically 
formatted as you work.

Export to EndNote > Export Traveling Library: Create an EndNote library from the references 
used in your paper. See Exporting Word’s Traveling Library to an EndNote Library.

▪

Export to EndNote > Export Word Citations: Create an EndNote library from citations created by 
Word in the document.

▪

Export to EndNote > Export Word Master List: Create an EndNote library from the master list of 
citations created by Word.

▪

Preferences: Change general Cite While You Write preferences, change the EndNote keyboard 
shortcuts available in Word, change figure and table settings, or switch to EndNote online Cite While 
You Write. See Setting Cite While You Write Preferences in Microsoft Word.

▪

Manuscript Matcher: Use Manuscript Matcher for an analysis of the journals most likely to publish a 
paper like yours. See Manuscript Matcher.

▪

EndNote Help: Display help about Cite While You Write features.▪

You may prefer to execute these commands from the keyboard. Note the keyboard shortcuts defined under 
Cite While You Write Preferences.

Note: Several Cite While You Write commands also appear on the Tools menu in EndNote. To use these 
commands from within EndNote, you must use at least one Cite While You Write command from within 
Word during the current session.

Cite While You Write places field codes around and inside your formatted citations in Word. These hidden 
codes allow EndNote to format, unformat, and reformat citations within Word.
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For example, this formatted citation:

(Pepperberg, 2009, p. 32)

contains these field codes:

Note: We recommend that you not view field codes in Word. If you choose to view field codes, do not 
modify them. Always keep backups of your papers! To automatically turn off the display of field codes 
when you open a Word document, see General Preferences in Microsoft Word.

Field codes for formatted citations include a Traveling Library of the EndNote references cited. The 
reference data saved with each citation includes all fields except Notes, Research Notes, Abstract, Figure, 
and Caption. This allows you to use the document on a computer that does not contain a copy of your 
EndNote library. See The Traveling Library.

EndNote’s Cite While You Write field codes are supported by all the versions of Word compatible with 
EndNote 20. See Word Processor Compatibility for information on if your version of Word is supported.

Once you start using Cite While You Write, you must take precautions before opening those files in other 
word processors or another version of Word. If a formatted document is opened and saved with an 
incompatible word processor, the formatted EndNote citations and bibliography lose their field codes. When 
this happens, EndNote cannot reformat the document.

Before you open a paper in a different word processor, or give a publisher an electronic copy of your final 
formatted document, see Sharing Your Word Documents.

Page 174 of 586

 



Clarivate EndNote 20 User Help Guide

Installing Cite While You Write Support in Word

Citing Sources as You Write

Forms of Citations in Microsoft Word

Unformatted (Temporary) Citations

Formatted Citations

EndNote’s  installation program installs Cite While You Write support for Microsoft Word 2010, 2013, 2016, 
2019, or Office 365 (locally installed desktop version only).

If you install Word after installing EndNote, you must  manually  install Cite While You Write.  See No 
EndNote Commands in Word or Writer.

In Word, EndNote commands appear on an EndNote 20 tab.

A "citation" is the brief bibliographic information in the body of a paper that refers the reader to a complete 
reference in the bibliography. A citation typically consists of a bibliography number or the author and year in 
parentheses:

... of the species at hand1.

... of the species at hand (Argus, 1991).

Citations can appear as either unformatted or formatted in your Word document.

An unformatted citation is a temporary placeholder, and does not reflect final output. It may appear after you 
insert selected citations.

Note: If you have Instant Formatting turned  on, you may never see an unformatted citation. Instant 
Formatting is turned on by default. See Instant Formatting in Microsoft Word.

An unformatted citation typically consists of the first author’s  last name, the year, and the EndNote record 
number, with citation delimiters at each end to identify the text:

{Author, Year #Record Number}.

For example:

 {Alvarez, 1994 #8}

EndNote relies on these temporary citations to determine which references to include in the bibliography.

The Configure Bibliography or Update Citations and Bibliography commands use an output style to convert 
all unformatted citations into formatted citations, and reflects final output.
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Note: When Instant Formatting is turned on, formatting is done as you insert citations—but you can still 
change the style or layout of your citations and bibliography.

Formatted citations include hidden Word field  codes in case you want to reformat the bibliography again 
later, even if the original library is not open.

Citations formatted in an Author-Date style might look like this:

(Alvarez 1994; Turnhouse 1987)

This is the same citation formatted in the Numbered style:

[1,2]

You can easily revert from formatted citations back to unformatted citations at any time. See Unformatting 
Citations in Microsoft Word.

You can search for EndNote references and insert them without ever leaving Word.

This is the easiest way to find and insert a citation into a Word document:

Open the EndNote libraries that contain the references you wish to cite.1.

Open the Word document and position the cursor at the location where you would like the citation.2.

On the EndNote 20 tab, click the Insert Citation button, or select the Insert Citation  drop-down and 
then Insert Citation.

3.

In the text box at the top, enter text to identify the reference you wish to cite. EndNote assumes an 
"and" between each word, and will search all fields in all the references in your open EndNote library.

4.

Press Enter or click Find and EndNote compares the text to text in your EndNote references and lists 
the matching reference(s). If no references match your text, you need to modify your search text and 
search again.

5.

Identify and highlight the appropriate reference(s).6.

Use the Insert button drop-down to display a menu, and select from:7.

Insert: To insert the citation and format it as defined by the currently selected output style. (This 
would be the same result as simply clicking on the Insert button.)

▪

Display as: Author (Year):  Select this menu option to display both the author name and the 
year in the highlighted citation, but with the author name appearing to be outside the citation 
marker.

▪

Exclude Author: Select this to omit the author name from the formatted citation.▪

Exclude Year: Select this to omit the date from the formatted citation.▪
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Finding and Inserting from Highlighted Text in Microsoft 
Word

Exclude Author & Year: Select this to omit both the author name and the year from an Author- 
Date formatted citation. This is usually used when you want only page numbers to appear in the 
citation.

▪

Show Only in Bibliography:  Select this option to display the selected citation only in the 
bibliography, not in the body of the paper.

▪

Note: You can click the Insert button (not select the drop-down) to quickly select the default Insert 
command.

Citations are inserted directly into your paper in the same font as the surrounding text, using the Normal 
style font. Once a citation is inserted and formatted, it contains complete reference information in hidden 
codes.

You can insert citations in an existing manuscript or as you write. Remember to save your document as you 
work.

To format your citations and generate a bibliography, see Configuring the Bibliography in Microsoft Word. In 
most cases, Instant Formatting applies as you insert citations (see Instant Formatting in Microsoft Word).

To insert references selected in EndNote:

Open the Word document and position the cursor at the location where you would like the citation.1.

On the EndNote 20 tab, select Go to EndNote.2.

Highlight the desired reference(s) in your EndNote library.3.

From the Tools  menu in EndNote, select the Cite While You Write submenu and select Insert 
Selected Citation(s), or click the Insert Selected Citations  button ( ), or on the EndNote 20 tab in 
Word, select the Insert Citation drop-down, and then Insert Selected Citation(s).

4.

To find and insert a citation from highlighted text:

As you are typing, enter text to identify the reference you wish to cite, and select that text.1.

On the EndNote 20 tab, click the Insert Citation button. EndNote will automatically enter the selected 
text into the search field of the Find & Insert My References  dialog and bring up a list of matching 
references from your open library.

2.

Identify and highlight the appropriate reference(s).3.

Use the Insert button drop-down to display a menu, and select from:4.

Insert: To insert the citation and format it as defined by the currently selected output style. (This 
would be the same result as simply clicking on the Insert button.)

▪
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Inserting Multiple Citations in Microsoft Word

Display as: Author (Year):  Select this menu option to display both the author name and the 
year in the highlighted citation, but with the author name appearing to be outside the citation 
marker.

▪

Exclude Author: Select this to omit the author name from the formatted citation.▪

Exclude Year: Select this to omit the date from the formatted citation.▪

Exclude Author & Year: Select this to omit both the author name and the year from an Author- 
Date formatted citation. This is usually used when you want only page numbers to appear in the 
citation.

▪

Show Only in Bibliography:  Select this option to display the selected citation only in the 
bibliography, not in the body of the paper.

▪

Note: You can click the Insert button (not select the drop-down) to quickly select the default Insert 
command.

You can drag selected citations from your EndNote library  and drop them into your paper at the desired 
location for the citation.

You can also copy citations from the EndNote Library and paste them into the document using 
Copy (Ctrl+C) from EndNote’s Edit menu and then Paste (Ctrl+V) from Word’s clipboard.

There are several ways to insert multiple references in one in-text citation. When formatted, they appear as 
one multiple citation, sorted as your bibliographic style requires:

Unformatted: {Hall, 1988 #77; Baker, 1988 #16}
Formatted: (Baker, 1988; Hall, 1988)

You can insert up to 250 references in a single in-text citation, although the limit could be lower depending 
upon limitations on the amount of data a Word field code can contain.

Note: If one of the citations in a multiple citation is not matched during formatting, the entire citation 
remains unformatted. Notes cannot be inserted as part of a multiple citation.

To insert multiple citations from Word:

On the EndNote 20 tab, click the Insert Citation button.1.

Enter a search term that will find the references you want, and press Enter or click Find.2.

Hold down the Ctrl key while clicking on the desired references in the list (or hold down the Shift key 
to select a continuous range of references) in order to highlight the references.

3.

Click the Insert button.4.

To insert multiple selected citations from EndNote:
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Inserting from Multiple Libraries in Microsoft Word

In EndNote, hold down the Ctrl  key while clicking on the desired references in your library (or hold 
down the Shift key to select a continuous range of references).

1.

From the Tools  menu in EndNote, select the Cite While You Write submenu and select Insert 
Selected Citation(s), or click the Insert Selected Citations button ( ).

2.

To insert multiple citations individually:

Another option is to insert citations individually, but immediately next to each other. Cite While You Write 
merges adjacent citations during formatting. Citations do not merge if any character separates them– 
including a space or punctuation mark.

Unformatted: {Hall, 1988 #77}{Baker, 1988 #16}
Formatted: (Baker, 1988; Hall, 1988)

Note: You can add citations to an existing in-text citation or change the order of citations within the 
delimiters with the Edit Citations dialog. See Editing Citations in Microsoft Word.

To insert, remove, or edit citations within an existing in-text citation:

Click on the formatted citation.1.

On the EndNote tab, click Edit & Manage Citation(s). All of the cited references in the document are 
listed, with the reference you clicked selected. Each citation will show how it is formatted above the 
references for that citation, as a subheading within the list. Click on the Reference tab below the list 
to see details for the reference.

2.

Highlight a citation, and then select an option from the drop-down menu at the right:3.

Click Remove Citation to delete it.▪

Click Insert Citation to add another reference within the same citation.▪

Use the arrow buttons at the left to change the order of the citation in a multiple citation. (If a 
Citation Sort Order is applied by the current output style, changing the order of citations in a 
multiple citation has no effect.)

▪

You can use the other features on this dialog as described in Customizing Individual Citations.

You can cite references from multiple libraries. Simply open the selected libraries before you begin inserting 
citations.

If possible, though, we recommend that you use a single library when writing a paper. Keeping all of your 
references in one library simplifies the writing process because you know exactly where to find each 
reference, there is little likelihood of duplicate references, and you only need to have one library open when 
inserting citations.

Note: If you plan to insert citations from more than one library into a paper, read about the Merge 
Duplicates in Bibliography preference
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Customizing Individual Citations
There may be cases where you want individual citations to differ from the standard format. You may want to 
remove the year or author from a citation if either was mentioned in the context of the sentence. Or, you 
might want to add a page reference or comment before or after the citation.

For example, assume a formatted citation looks like this:

Hall’s discovery (Hall, 1988)

You can omit the author’s name from the citation:

Hall’s discovery (1988)

You can omit the date from the citation:

the 1988 discovery (Hall)

You can add a suffix with page number(s) to the citation:

the discovery (Hall, 1988 p.4)

You can add a prefix to the citation:

the discovery (see Hall, 1988)

To customize a formatted citation:

Insert and format the citation.1.

Click on the formatted citation.2.

On the EndNote 20 tab, click Edit & Manage Citation(s). All of the cited references in the document 
are listed, with the citation you clicked on selected. Each citation will show how it is formatted above 
the reference(s) for that citation, as a subheading within the list. Click on the Reference  tab below 
the list to see details for the reference. Click on the Edit Citation  tab below the list to edit the 
reference.

3.

Select the citation you want to customize.4.

To change the format of the citation, select one of these options from the drop-down Format menu:5.

Default Format: Select this menu option to display the citation and format it as defined by the 
currently selected output style.

▪

Display as: Author (Year): Select this menu option to display both the author name and the 
year in the highlighted citation, but with the author name appearing to be outside the citation 
marker.

▪

Exclude Author: Select this to omit the author name from the formatted citation.▪

Exclude Year: Select this to omit the date from the formatted citation.▪
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Including Notes in the List of References in Microsoft 
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Exclude Author & Year: Select this to omit both the author name and the year from an 
Author-Date formatted citation. This is usually used when you want only page numbers to 
appear in the citation.

▪

Show Only in Bibliography:  Select this option to display the selected citation only in the 
bibliography, not in the body of the paper.

▪

To add additional text to the citation, use the options below:6.

Prefix: Enter text here to print immediately before the citation text (include spaces).▪

Suffix:  Enter text here to print after the citation text (spaces and punctuation should be 
included). You can enter page numbers here if you always want them to print after the citation 
in a custom format, even if the style doesn't normally include them.

▪

Pages: Page numbers entered here are considered entered into a "Cited Pages" field, so they 
can be manipulated by the style, just like any other EndNote field. In order to print, the Cited 
Pages field must be listed in the citation template and/or footnote template of your output style. 
This is typically used to print the page numbers within a full footnote citation. Most EndNote 
styles that require a special format for citations in footnotes are already configured this way. 
You can modify the Citation Template in your output style to include the Cited Pages field.

▪

Click OK to implement the change(s) to the citation.7.

Some journal styles require that you include notes along with the list of works cited at the end of the 
document. In such a system, notes are numbered just like citations, and are included in the reference list in 
order of appearance, along with bibliographic references.

Including notes in this way makes sense only when you are formatting your paper with a numbered style 
(not an author-date style). Therefore, this feature works only with numbered in-text styles.

To insert text as a numbered note in the reference list:

Position the cursor at the location in your text where you would like the number indicating the note.1.

On the EndNote 20 tab, select Insert Note from the Insert Citation drop-down menu.2.

Type your note text into the text box. There is no limit on the amount of text you can enter.3.

Click OK to insert the numbered note.4.

When your paper is formatted by EndNote using a numbered style, the note text is assigned a number and 
listed along with the references at the end of the paper.

The way that notes are displayed when unformatted can be changed in the Temporary Citations 
Preferences.

To manually type text as a numbered note in the reference list:

Type the text into the body of your document where you would want the number for the note to 
appear.

1.
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Restrictions on the Use of the "NOTE" Feature:

Inserting Citations into a Formatted Paper in Microsoft 
Word

Citing References in Footnotes and Endnotes

Be sure to surround the entire section of text with your Temporary Citation Delimiters (curly braces 
by default), and begin it with "NOTE:" followed by a space and your note text. For example:

2.

{NOTE: The authors would like to acknowledge the support of...}

This feature requires that a numbered style be used for formatting; otherwise, the note appears as 
text in the body of your paper.

▪

Enter alphanumeric text only. Do not enter graphics, equations, or symbols.▪

Do not use the temporary citation delimiters as part of the text of the note. Other markers, such as 
the record number marker, the prefix marker, and the multiple citation separator may be used.

▪

Notes cannot be combined with regular bibliographic citations within the same set of delimiters (such 
as parentheses or brackets). They must be cited separately—each in its own set of delimiters.

▪

To add a new reference to an existing citation, insert the new reference next to (not within) the existing 
citation, with no spaces or punctuation between them, like this:

(Hockney and Ellis, 1996){Argus, 1984 #1}

Adjacent citations are merged during formatting, and the formatted citations are sorted according to the 
style:

(Argus, 1984; Hockney and Ellis, 1996)

Note: Do not insert a citation into the middle of a formatted citation. Insert it immediately before or after 
the existing citation, with no space between them.

Once you have created a footnote or endnote in Microsoft Word, you can cite references in that footnote or 
endnote just like you cite them in the body of the document.

To cite a reference in a footnote or endnote:

Use the appropriate command in Word to create the footnote or endnote. (EndNote does not create 
the footnote or endnote in the document, but is used to insert and format citations in the note.)

1.

Position the cursor in the footnote or endnote where you would like the citation to appear.2.

Insert the citation as you normally would.3.

Note: You can edit a full reference footnote citation to exclude author name, year, or author/year. Note 
that the Author(Year) option does not apply to full-reference footnotes.
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Typing Citations into Your Paper

Notes About Temporary Citations

The selected EndNote style determines how citations in footnotes and endnotes are formatted. EndNote can 
format these citations as brief in-text citations or like complete references in the bibliography. It can also 
create a special format specific to footnotes or endnotes, including options like "Ibid." and other variations of 
shortened references when a citation appears more than once in the footnotes or endnotes. See 
Bibliography and Footnote Templates.

If you are citing full references in footnotes, you can include specific page numbers to be formatted like a 
regular EndNote field. See Customizing Individual Citations. Or, if you are manually typing citations, see 
Citing Specific Page Numbers in Footnotes.

There are many ways to insert citations in your paper. One way is to manually type temporary citations 
directly into your paper.

The rules described in the following topics govern how EndNote recognizes and interprets temporary 
(unformatted) citations. Use these rules when typing temporary citations directly into your document.

Note:  For new documents or documents that have never been formatted, when Instant Formatting is 
enabled, it is not triggered when you manually type a reference into a document. You must use the 
EndNote 20 tab in Word to either insert another citation or format the citations and a reference list.  If a 
document has been successfully formatted, and you manually type in a temporary citation, that citation 
will be instantly formatted.

Notes About Temporary Citations▪

Components of a Temporary Citation▪

Omitting Authors or Years from Citations▪

Citation Prefixes▪

Citation Suffixes▪

Including Semicolons and Other Citation Delimiters in a Citation▪

Examples of Modified Citations▪

Each citation must match only one reference in the library.▪

When Instant Formatting is turned off, a temporary citation is enclosed in citation delimiters and 
typically includes the first author’s last name, the year of publication, and the record number for that 
reference. For example:

▪

{Schwartz,1990 #5;Billoski,1992 #28}.

If you would prefer to use the Label field or Accession Number field instead of the record number in 
temporary citations, see Temporary Citations Preferences for information on this setting.

Within one set of citation delimiters you can have several citations separated by semicolons.▪
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Components of a Temporary Citation

Curly braces ("{" and "}") are the default temporary citation delimiters, although they can be changed 
(see Temporary Citation Delimiters). EndNote looks for these markers to find citations in your word 
processing documents.

▪

In addition to the citation delimiters, there are other possible components to a temporary citation: 
Author, Year, Record Number, Prefix Text, Suffix Text, and any other text found in the record. You 
can also use a special tag to format the citation as Author (Year). See Components of a Temporary 
Citation.

▪

Any part of a temporary citation can be omitted, as long as enough information remains to match just 
one reference in the library. If you omit an author or year from a temporary citation, those 
components are omitted from the formatted citation as well—although you can change this 
preference. See Omitting Authors or Years from Citations for more information. Additionally, you can 
omit the entire citation so that the entry only appears in the bibliography (see Components of a 
Temporary Citation).

▪

The typical EndNote temporary (unformatted) citation consists of an author’s last name, a year, and a record 
number, all enclosed in citation delimiters. However, temporary citations can take on various other formats.

Temporary citations must begin and end with the opening and closing citation delimiters, but the other 
components of a temporary citation can vary.

You can type any string of text found in the reference, as in:

{dinosaur extinction}

Or, you can type any of these items in this order (comma placement is significant):

{Prefix \Author, Year #Record Number Suffix}
{Prefix \Author, Year, Any Text, Suffix}

Each component is briefly described below; more detailed information follows.

Author’s Last Name: Only the last name of one author is listed in a temporary citation. It can be any author 
associated with the reference, not just the first author. Include a comma after the author’s name to limit the 
search only to author fields:

{Schwartz, 1990}

Year: The year should appear exactly as it does in the reference, and it should be preceded by a comma. 
Even if you leave out the author name, include a comma and a space before the year to limit the search to 
the Year field:

{, 2001}

Record Number: The record number will always be unique for the library it resides in. However, it is not a 
permanent number. If a reference is moved to a different library, it will be assigned a new record number. If it 
is synchronized across computers or shared with colleagues through  EndNote Sync, it will probably be 
assigned a new number. If it is cut and then pasted back into the same library, it will be assigned a new 
number. See Record Numbers. It is also possible to use the Accession Number or the Label fields in place 
of record numbers for temporary citations (see Temporary Citations Preferences).The record number must 
be preceded by a number sign:
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{Jones, 1987 #84}

Any Text: Any text that appears in the reference can be used to help EndNote locate the reference in the 
library. In order for this to be helpful, select words that are unique to that reference. Enter the specific text 
only or enter the text in place of the record number part of the temporary citation and after a second comma:

{greenhouse}
{Schwartz, 1990, any text}
{Schwartz, , any text}

In the third example, where the date is omitted, you must insert a space between the two commas or 
EndNote will not recognize any citation matches.

Note: When using Any Text, EndNote will not search for whole words. If the text is part of a longer word, it 
will still be found. The more complete the information in the temporary citation, the better chance of a 
match. For example, you might find it helpful to follow the format used by EndNote online. EndNote online 
does not use record numbers for the third identifier; it  uses the reference title. So an unformatted/ 
temporary citation might look something like this: {Koepke,  2015, Delayed Gratification: A Grey Parrot 
(Psittacus erithacus) Will Wait for a Better Reward}.

Prefix Text: To add text to print before the formatted citation, type the text immediately after the opening 
brace and then a backslash "\" to separate prefix text from the search text:

{see \Jones, 1987 #84}

Suffix Text: To add text to print after a formatted citation, enter the suffix text immediately after the record 
number or enter a third comma after the search text and then type the suffix text (the third comma will be 
included in the formatted citation):

{Smith, 1995 #98 p.293}
{Smith, 1995, dinosaur, p.293}
{Smith, 1995, #98, section 3}

Note: Suffix text will always appear in the formatted citation. It is not dependent on the Cited Pages field 
being included in the style. This field can be used to add any type of information, not just page numbers.

Page Numbers: To add page numbers to a temporary citation, type @ and the page numbers after the 
record number. Page numbers require the Cited Pages field be included in the style and will be formatted 
according to the style settings.

{Jones, 1987 #84@23}

Page Numbers Only: If you have a citation where you want only the page numbers to appear, formatted 
according to a style that includes the Cited Pages field, remove both the Author and the Year from the 
temporary citation:

{#95@53}

Caution: This works well only when using a single library, without using EndNote Sync. When working 
with multiple libraries, or a library on multiple computers synchronized through EndNote Sync, there is a 
danger of having the same record number assigned to different references.

Author (Year) format: To add a citation that is formatted as Author (Year) in your text, include @author-year 
after the pages designator:
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Omitting Authors or Years from Citations

{Hesse, 2003 #95@@author-year}  
   or  
{Hesse, 2003 #95@237@author-year}

Bibliography Only format: To insert a citation that only appears in the bibliography, include @@hidden, 
where the first @ is needed as the pages placeholder:

{Smith, 1995 #98@@hidden}

Note:  For an easy way to modify individual Cite While You Write citations once they are formatted, see 
Editing Citations in Microsoft Word.

While your style may normally include the author’s name and date in each in-text citation, you may want to 
omit the author and/or year from a particular citation. This is useful if you have mentioned the author or year 
in the context of the sentence and do not want to repeat the information in the citation.

To remove the author’s name or date from a citation, leave that information out of the unformatted citation.

To omit the author’s name, enter:

...Wyatt’s recent discovery {, 1993 #38}.

which will format as:

...Wyatt’s recent discovery (1993).

To omit the date, enter:

...about his 1993 discovery {Wyatt, #38}.

which will format as:

...about his 1993 discovery (Wyatt).

Note: Numbered citations do not print the author name or year in any case, so these settings would be 
ignored.

If you want a reference to appear in your bibliography, but not as a citation in your paper, you can exclude 
both the author and year, leaving only the record number. When you format your paper with a style that 
formats authors and years in the citations, this particular citation will not display in text, but will be included 
in the bibliography.

However, if you would rather have the author and year appear in the formatted citation regardless of 
whether or not they are in the temporary citation, select Preferences from EndNote’s Edit menu, select the 
Formatting  option, and uncheck the setting to Omit Author and/or Year from formatted citation if removed 
from temporary citation. With this setting turned off, you may enter just the record number {#34} as a 
temporary citation, and still format the paper accurately with a style that requires authors and years in the in- 
text citations.
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Citation Prefixes

Changing the Citation Prefix Marker

Citation Suffixes

Caution: The option immediately above works  well only when using a single library, without using 
EndNote Sync. When working with multiple libraries, or a library on multiple computers synchronized 
through EndNote Sync, there is a danger of having the same record number assigned to different 
references.

Note:  For an easy way to modify individual Cite While You Write citations once they are inserted, see 
Editing Citations in Microsoft Word.

You can type a prefix in front of any unformatted in-text citation, using a backslash to separate the prefix text 
from the reference. For example, an in-text citation such as:

{see also \Hall, 1988 #77}

formatted in the APA style would be:

(see also Hall, 1988)

When there is only one prefix in a multiple citation and it is at the beginning of the citation, it will stay there 
regardless of how the citations are sorted. For example, this citation:

{e.g. \Hall,1988 #77; Argus, 1991 #11}

 after being formatted in the APA style will appear as:

(e.g. Argus, 1991; Hall, 1988)

If the prefix is not at the beginning of the multiple citation, or if there is more than one prefix in a multiple 
citation, the prefix text remains with the reference it precedes. For example, this citation:

{Argus, 1984 #11; especially \Hall, 1988 #77}

formatted in the Author-Date style will be:

(Argus, 1984; especially Hall, 1988)

You can change the prefix marker from a backslash to another character by selecting Preferences  from 
EndNote’s Edit menu, selecting the Temporary Citations option, and changing the character in the Citation 
Prefix Marker box. Use a character that is not otherwise used in the citations. Letters, numbers, semicolons, 
"@," and commas cannot be prefix markers. See Temporary Citations Preferences.

Text typed after the record number or search text in an unformatted citation appears immediately after the 
citation when it is formatted. For example, these citations:

{Hall, 1988 #77, p. 5}
{Smith, 1995 #58, section 3}
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Including Semicolons and Other Citation Delimiters in a 
Citation

Citing Specific Page Numbers in Footnotes

 after being formatted in the APA style will appear as:

(Hall, 1988, p. 5)
(Smith, 1995, section 3)

In multiple citations, the suffix text remains with the citation that it follows, even if the citations are sorted 
differently during the formatting process. For example, this citation:

{Hall, 1988 #77 p. 5; Argus, 1991 #11}

formatted in the Author-Date style will be:

(Argus, 1991; Hall, 1988 p. 5)

Note: A space, punctuation mark, or letter should follow the record number, never a number. If a 
number appears directly after the record number, EndNote will interpret it as part of the record 
number.

In order to print an actual semicolon or the prefix marker (\) as part of a citation, type an accent grave (`) 
before the character. The accent grave tells EndNote to treat the following character as regular text, and not 
as a significant character for parsing the citation (a delimiter). For example, to create a citation that is 
formatted as:

(see Figure 1; Jackson, 1994)

the unformatted citation must look like this:

{see Figure 1`; \Jackson, 1994 #28}

The `  character before the semicolon tells EndNote not to treat the semicolon as a separator between 
citations.

When citing full references in footnotes, you might want to include specific page numbers. EndNote provides 
a way to do this where the page numbers that you type into a temporary citation can be manipulated by the 
EndNote style  just like a field  in your EndNote reference. You can add specific pages to the temporary 
citation, and have the EndNote style include them wherever they need to be in the formatted citation. The 
style can also apply special pages formatting, like deciding whether to add "p." or "pp." before the page 
numbers, and how to list the range of pages.

The easiest way to add cited pages is to use the Edit Citations dialog. See Editing Citations in Microsoft 
Word.

To manually include specific page numbers to a reference in an unformatted footnote citation, enter the 
page number preceded by "@" at the end of the temporary citation:

{Smith, 1999 #24@145-6}
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Examples of Modified Citations

All text that follows the @ symbol (up to the next space) is considered the "Cited Pages." You must also 
configure the EndNote style used to format the paper to use "Cited Pages" in the footnote template. Most 
EndNote styles that require a special format for citations in footnotes are already configured this way.

When EndNote formats the citation, the cited pages ("145-6" in the example above) are inserted in the 
correct location and formatted as appropriate for the style.

Note: If you enter page numbers at the end of the temporary citation without the "@" character, they will 
still appear in a formatted in-text citation, but EndNote will not be able to manipulate them by changing the 
page format or by moving them to a different position in the formatted citation. They will appear, as 
entered, at the end of the formatted in-text citation. This is a perfectly acceptable way to enter page 
numbers for in-text citations (or for footnotes formatted just like your in-text citations). See Citation 
Suffixes to see how this works. This method will not work for citations in footnotes that are formatted as 
full bibliographic references or with a special footnote format. For those cases, you must use the @ 
symbol to identify the cited pages in the temporary citation.

The following examples demonstrate how different modifications to a temporary citation affect its formatted 
citation in either an author/year or numbered style. In the first column is an example of a modified temporary 
citation before formatting, and to the right are two examples of that citation formatted in different styles.
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Citation

Formatted with 
APA

Formatted 
with 
Numbered

Comments

{Smirnova, #2309} (Smirnova) [1] To remove the year from the formatted 
citation, delete it from the unformatted 
citation.

{, 2011 #2309} (2011) [1] To remove the author from the 
formatted citation, delete just the 
author’s name from the unformatted 
citation. Note that the comma remains 
in the temporary citation to indicate the 
omission of the author.

{#2309} No citation 
appears

[1] This temporary citation removes the 
author and the year from the formatted 
citation. When formatted with an author- 
date style, the in-text citation is 
eliminated, but the reference still 
appears in the bibliography. Numbered 
citations appear as usual.

{Smirnova, 2011 
#2309@23}

(Smirnova, 2011, 
p. 23)

[1] Adding the page number indicator 
followed by a page number will cause 
the page number to show in styles that 
include the Cited Pages field in the 
citation. The formatting of the Cited 
Pages field in the style controls how the 
page number will look.

{Smirnova, 2011 
#2309, section 3}

(Smirnova, 2011, 
section 3)

[1, section 3] Adding suffix text after the record 
number will cause it to always appear at 
the end of the citation, exactly as 
formatted. See Citation Suffixes.

{see \Smirnova, 
2011 #2309}

(see Smirnova, 
2011)

[see 1] To add text before the formatted 
citation, type the text immediately after 
the opening curly brace, and type a 
backslash (\) to separate the text from 
the author’s name. See Citation 
Prefixes.

{Smirnova, 2011 
#2309`; check 
errata}

(Smirnova, 2011; 
check errata}

[1; check 
errata]

The accent grave (`) before the 
semicolon (;) alerts EndNote to treat the 
semicolon as text instead of as a 
delimiter. Normally the semicolon would 
indicate the end of one citation and 
beginning of another in a grouped 
citation. See Including Semicolons and 
Other Citation Delimiters in a Citation.

Editing, Moving, Copying, and Deleting 
Citations

Editing Citations in Microsoft Word
Once you have inserted and formatted a citation, you should not edit it directly (even though you are able to 
do so). Direct edits are lost the next time EndNote formats the bibliography.
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You can almost always get EndNote to format your citations exactly to your specifications by editing the 
style, the EndNote reference, or the citation (as described here).

Note:  An easy way to omit the Author or Date from an individual citation is to select the citation, right- 
click, select Edit Citation(s) and then Exclude Author or Exclude Year.

To edit a formatted citation:

Click on the citation you wish to change.1.

On the EndNote 20 tab, click Edit & Manage Citation(s). All of the cited references in the document 
are listed, with the citation you clicked on selected. Each citation will show how it is formatted above 
the reference(s) for that citation, as a subheading within the list. Click on the Reference  tab below 
the list to see details for the reference. Click on the Edit Citation  tab below the list to edit the 
reference.

2.

Select the appropriate citation from the list and make any of the following changes to the highlighted 
citation: 
 
Default Format: Select this menu option to format the citation as defined by the currently selected 
output style. 
 
Display as: Author (Year): Select this menu option to display both the author name and the year in 
the highlighted citation, but with the author name appearing outside the parentheses for the citation. 
This feature does not apply when editing a citation in a footnote. When using this option with a 
numbered in-text style, the author name(s) will appear before the citation. 
 
Exclude Author: Select this to omit the author name from the formatted citation. 
 
Exclude Year: Select this to omit the date from the formatted citation. 
 
Show Only in Bibliography: Select this option to display the selected citation only in the 
bibliography, not in the body of the paper. 
 
Prefix: Enter text here to print at the beginning of the citation text (spaces are significant). 
 
Suffix: Enter text here to print at the end of the citation (spaces are significant). 
 
Pages: Enter page numbers here to show as Cited Pages, formatted according to the selected style. 
To show, the Cited Pages field  must be included in the citation or footnote template  of the output 
style.

3.

Within the Edit & Manage Citations window, you can add or remove citations from a multiple citation 
or change the order of citations. 
  
Insert Citation: Select this option from the drop-down menu at the right of the citation to add another 
citation within the same set of delimiters. 
  
Remove Citation: Highlight a citation, then select this option from the drop-down menu at the right 
of the citation to delete it from the in-text citation. 
  
Up and Down Arrows: Highlight a reference and use the arrows to the left of the citation to change 
the order of display within the citation.  (If a Citation Sort Order is applied by the current output style, 
using this dialog to change the order of citations in a multiple citation has no effect.)

4.
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Moving or Copying Citations in Microsoft Word

Deleting Citations

Unformatting Citations in Microsoft Word

Click OK to implement your change(s).5.

On the EndNote 20  tab, select Update Citations and Bibliography  to reformat your bibliography with your 
changes.

You can highlight any text that includes citations, use the Cut or Copy commands, and then Paste the text 
elsewhere in the document. You can do this with formatted or temporary (unformatted) citations.

To move or copy only the citation itself, make sure you highlight the entire citation (including surrounding 
delimiters). Then Cut or Copy and Paste it elsewhere in the document. If the entire field code for the citation 
is not included in the cut text, it could result in corrupted citations.

Note: Some issues may arise when you use the Cut, Copy, and Paste commands in a document with 
Track Changes turned on. If this occurs, turn off Track Change when you use these edit commands.

To delete an unformatted citation, highlight the entire citation (including delimiters), and press the 
Backspace or Delete key.

While it is possible to highlight a formatted citation and press the delete key on your keyboard, we do not 
recommend that you do this. If you do not completely delete the citation and all associated codes, you could 
corrupt your citations.

To safely delete a formatted citation:

In Word, highlight the citation you want to delete.1.

On the EndNote 20 tab, select Edit & Manage Citation(s).2.

In the Edit & Manage Citation(s) dialog, ensure that the citation you want to delete is highlighted. If 
the citation is part of a multiple citation, make sure you select just the citation you want to delete.

3.

From the drop-down menu at the right of the citation, select Remove Citation.4.

Click OK.5.

Unformatting reverts formatted citations to temporary citations, removes the bibliography, and turns off 
instant formatting.

Note: Unlike formatted citations, unformatted citations require that you have the original corresponding 
EndNote library open in order to format the paper again. Unformatting removes The Traveling Library. (A 
synced copy of the library will probably not work for reformatting the citations because the record numbers 
will be different. You should use the original copy of the library.)

To unformat citations:
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Generating Bibliographies

Adding Styles to the Output Styles Menu

Determine which citations you want to unformat:1.

To unformat a particular citation, highlight only that citation.▪

If the citation you want to unformat is part of a multiple citation, highlight the multiple citation. All 
citations within the delimiters will be unformatted.

▪

To unformat a section of the document, highlight that section.▪

To unformat the entire document, either select nothing or highlight the entire document.▪

On the EndNote 20  tab, select Convert Citations and Bibliography, and then select Convert to 
Unformatted Citations. If you are unformatting the entire document, this unformats all of the in-text 
citations and removes the current bibliography.

2.

You can tell when a paper is unformatted because the citations appear in the temporary citation format 
(such as {Smith, 1999 #25}).

Unformatted citations are temporary placeholders that do not reflect final output. You can format the paper 
again at any time. To save the formatted paper as text with formatted citations, see Removing Field Codes.

Note: When you unformat citations, Instant Formatting in  Microsoft Word  is disabled. To format your 
paper, select Update Citations and Bibliography on the EndNote 20 tab.

The bibliographic style  selected determines how EndNote formats the citations in your paper and the 
references in the bibliography. The style defines the text styles, punctuation, and sorting required for the 
citations and bibliography, as well as which fields are included in the bibliography.

You can use the Styles  drop-down menu on the EndNote  tab to select a different style and reformat your 
document at any point.

For a typical installation, EndNote initially installs only the most popular output styles, although more styles 
 are available. See Installing Additional Output Styles.

To mark an installed output style as a favorite, so it will appear in the Styles menu:

In EndNote, go to the Tools menu, select Output Styles, and then select Open Style Manager.1.

Find the style that you need.2.

Select a style by typing its name or scroll through the list to find the style you need.▪

Click on the column headings to sort the styles by either name or category. Click a second time 
to reverse the sort order.

▪

Use the Find by list to find entire categories of styles.  
 
The Style Info/Preview button  can toggle between Style Info or Style Preview to display 

▪

Page 193 of 586

 



Clarivate EndNote 20 User Help Guide

Configure Categories Dialog in Microsoft Word

Using Styles with Defined Categories

Group References by Custom Categories in Word Manually

information about a style or a preview of how the selected style formats EndNote’s references. 
Use the More Info/Less Info toggle button to display or hide this dialog.

Mark the box by a style to select it as one of your favorites. The Mark All button selects all styles. 
The Unmark All clears all selections.

3.

Close the Style Manager by selecting Close Style Manager from the File menu in the Style Manager.4.

Styles marked as favorites appear in the Styles menu, wherever it appears.

You can modify any style to meet your specifications. You can also create new styles if necessary. 
See  Modifying Style Templates for more information.

This feature allows you to add categories to your Microsoft Word documents. When EndNote creates the 
bibliography in Word, it organizes your citations based on the categories set.

There are two ways to create category configurations: Use a style  with categories configured in it or 
configure custom categories manually. If using a style with categories configured already, you can still 
customize that configuration in Word.

Styles can include category definitions based on reference type. When using such a style, all references of 
a reference type defined in the Categories section of the style will automatically be sorted in Word. One 
example of such a style is APA 6th CV, which has the following preset categories.

Publications 
Book
Journal Article
 
Manuscripts under review
Unpublished Work
 
Manuscripts in Progress
Manuscript
 
Conference Presentations
Conference Proceedings
 
Posters
Conference Paper

Using or creating a style with categories defined makes it very easy to organize categories based on 
reference type, as long as all the reference types you are using are included in the style. See Reference 
Type Categories in Output Styles for information on creating or editing styles with defined categories.

If you don't want to use a style with defined categories, or want to use categories that are not based on 
reference type, you can create your bibliography categories manually when you first begin writing a paper or 
at any time during a writing project.
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References

Category Headings

Open your Microsoft Word document.1.

On the EndNote 20 tab, select Categorize References > Configure Categories to open the Configure 
Categories dialog.

2.

Create your categories by clicking the Category Headings (+) button, entering the name of your new 
category, then pressing Enter. Repeat until you have created the categories you need for your paper.

3.

Using the drag-and-drop method, drag a specific reference to the appropriate category under the 
Category Headings section. A reference can only appear in one category.

4.

Continue this process until all references are assigned a category.5.

Check the "Not Yet Assigned to a Category" section to ensure that all references have been 
assigned to a category.

6.

You can modify your categories at any time. For example, you can rename a category, delete a category, 
move a category, or move references (using drag-and-drop) from one category to another.

The left panel contains two groups: References and Category Headings. See details below.

he upper-right panel shows the list of references within the group or category selected at the left. The lower- 
right panel shows the details for the reference selected above.

This section displays the references in your paper, and which of those references have not yet been 
categorized. Select a reference to see details for that reference at the right.

All References in Bibliography: Select this group to see all the references in the bibliography in the 
right-side of the window. The following fields appear at the top of the right panel for each reference.

▪

Author▪

Year▪

Title (of publication)▪

Reference Type▪

Category (name of the category that you defined under the Category Headings section)▪

The lower part of the panel displays detailed information about the reference. For example, Reference Type, 
Author, Year, Title, and more.

Uncategorized References:  This displays each citation that has not been assigned to a category. 
Select a reference to see the details for that reference in the right panel. Use the drag-and-drop 
method to assign an unassigned citation to a category.

▪

This section displays all the categories that you have defined for the paper. The default categories for a new 
document containing categories, when your are not using a style, are Primary Sources and Secondary 
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Displaying the Categories in the Bibliography

Important Points About Categories

Creating a Bibliography from Multiple Documents

Sources. Create categories by clicking the Category Headings  (+) button in the upper left corner of the 
dialog. This will display a blank text field. Enter a unique name to identify each category. For example:

Category Headings 
References 
Suggested Reading

To rename categories, select the category, then right-click and select Rename  from the list. Type the new 
name for the category, then press Enter.

Delete categories by clicking the minus sign (-) to the left of the category. Deleting a category does not 
delete any references from your paper. Any references assigned to that category will be added to the 
Uncategorized References list.

Note: For the "Suggested Reading" category above, the references should appear in the bibliography but 
not in the text of the document. See the Show Only in Bibliography section of Editing Citations in Microsoft 
Word for information on how to hide references in the text but have them appear in the bibliography.

To display the references in your paper in the categories you have created, on the EndNote 20 tab select 
Categorize References > Group References by Custom Categories. This is a toggle, so select the option to 
Group References by Custom Categories again if you ever want to disable the categories display.

Use styles with categories defined for automatically assigning references to categories based on 
reference type.

▪

Organize categories based on how you want the categories to appear in the bibliography in Word.▪

Enter a unique name to identify each category that you want to create in the current document.▪

Use drag-and-drop to add references to the appropriate bibliography categories.▪

Go to the "Uncategorized References" list to see if any references have not been assigned to a 
category.

▪

If you delete a reference from a particular category, the reference is only removed from the category. 
The citation remains in your document and the reference goes back to the Uncategorized 
References section.

▪

EndNote maintains all references in the All References in Bibliography list. A reference added to any 
defined category will still appear in the All References list.

▪

For very large documents, you can use the Microsoft Word's Master Document feature to generate a single 
bibliography from multiple documents. This allows you to create a cumulative bibliography from any number 
of book chapters. (As an alternative for smaller documents, we recommend using a single Word document 
split into Sections. See Creating Multiple Bibliographies in a Single Document.)
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Master documents are used to assemble many smaller Word documents at the end of a project to create a 
single table of contents, bibliography, etc., when a single large document would be difficult to work with. A 
master document is usually used only for this final assembly, not for working in the individual documents.

Before creating a master document, make a backup of all the documents you will be using for sections. A 
backup is always advisable before making large changes to any project, and how smoothly this process 
goes will depend on factors such as how consistent the formatting is for all the subdocuments and the 
master document. The present author always uses copies of documents when working with a master 
document and subdocuments.

To generate a single bibliography:

In each of your documents or chapters, insert your citations to link them to references in an EndNote 
library.

1.

In each document, on the  EndNote  tab, select Convert Citations and Bibliography  > Convert to 
Unformatted Citations.

2.

Close all of your documents.3.

Create a new document.4.

Use the Outline view to designate the new document as a master document, then insert and display 
each of your chapters as subdocuments. (Check Word’s  documentation if you need step-by-step 
instructions.)

5.

Note: If you have collapsed subdocuments to hide their content in Outline view, make sure you expand 
them in order to display the contents of all subdocuments before continuing.

On the EndNote tab, in the Bibliography group, click the bottom corner arrow to open the Configure 
Bibliography dialog.

6.

Note: Your documents must allow read/write access; they cannot be designated Read-only (locked).

Verify the formatting options and click OK.7.

EndNote creates the bibliography, using citations from the master document and all displayed 
subdocuments, and places it at the end of the master document. You can move the bibliography anywhere 
within the master or subdocuments, and it will remain in that location even when you reformat.

Note: If you select Word’s  Insert > File command, and then select the Link option to insert a document 
into the text, EndNote will not format the linked document when you format the main document. The text 
from the linked document will be skipped.

If you want to format a bibliography for each subdocument plus a cumulative bibliography at the end of the 
master document, follow the instructions above, but use an output style that allows formatting of Sections. 
See Creating Multiple Bibliographies in a Single Document  and Sections Options  in Output Styles  for 
additional information. In the case of a master document, subdocuments are treated as sections.

Page 197 of 586

 



Clarivate EndNote 20 User Help Guide

Creating Multiple Bibliographies in a Single Document

In Microsoft Word, Break Your Document into Sections

Modify the Output Style as Needed

Format Your Word Document with the New Output Style

Additional Formatting Notes

By default, EndNote creates a single bibliography at the end of each of your Word documents. However, 
you may want to create a separate bibliography for each section (or chapter) in your document. Output style 
options are available so that you can choose to:

Create a single, complete bibliography at the end of the document (the default setting for almost all 
of the supplied output styles).

▪

Create a bibliography for each section in the document.▪

Create a bibliography for each section and also a complete bibliography at the end of the document.▪

EndNote can format each section individually. You may want to break each chapter into its own section.  In 
the case of a master document, subdocuments are treated as sections.

In Word, on the Layout tab, click on Breaks, and then select one of the four options under Section Breaks: 
Next Page, Continuous, Even Page, or Odd Page.

If you are using the APA style and want to add bibliographies in sections,  try APA 5th or 6th (sections). 
These styles are already defined to format a bibliography for each section, and do not require modification.

Otherwise, we recommend that you start by copying an existing output style and giving it a unique name. 
This leaves the original style intact. See Copying Styles.

Next, click on the Sections  panel in the output style. This is where you select the appropriate option for 
creating a single bibliography from all sections, a separate bibliography for each section individually, or both. 
For a complete description of the formatting options for Microsoft Word sections, see Sections Options  in 
Output Styles.

Save your changes and close the output style.

Format your bibliography as you normally would, but make sure you first select the new output style that you 
created. See Configuring the Bibliography in Microsoft Word.

When working with sections in Word, note that:

EndNote will always insert a blank line between the final text of each section and the reference list 
for that section.

▪

When you format a reference list at the end of each section, the bibliography title will be used from 
the Layout tab of the Configure Bibliography dialog. If you do not want a title for each section 

▪
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Deleting Bibliographies

Directly Editing Bibliographies

Generating Bibliographies

bibliography, make sure the "Bibliography Title" text box on the Layout tab is empty. See Configuring 
the Bibliography in Microsoft Word.

If you have instructed the output style to “Create a bibliography for each section and a complete 
bibliography at the end of the document," but you have only one section in the Word document, a 
complete bibliography will appear twice—once for the end of the section, and once as a complete 
bibliography for the entire document.

▪

If you have multiple sections in your Word document, and switch from formatting with a style that 
formats sections individually to a style that formats a single, cumulative bibliography...you will see the 
section bibliographies disappear! If you want them back, make sure to format with a style that 
formats sections individually.

▪

Word inserts section breaks when changing between portrait and landscape orientations. If you need 
to change the page orientation in your document for wide graphics or tables, the orientation changes 
will be perceived as section breaks for bibliographies when using the Sections feature in an EndNote 
style.

▪

To delete a bibliography, make sure Instant Formatting in Microsoft Word is disabled, select the bibliography, 
and then delete it.

Make sure you drag the cursor across the very beginning of the bibliography to select the entire bibliography 
field. Press the Backspace or Delete key. You can also cut the bibliography if you want to paste it 
somewhere else.

It is always best to make changes to your final bibliography by correcting the data in the EndNote library, 
editing the output style you are using, or adding or deleting citations from your paper. Then, after making the 
necessary changes, format the bibliography to make the corrections automatically.

It is not always possible for EndNote to format the bibliography exactly as needed, so you might need to 
manually edit the formatted bibliography. If you must do this, remember that if you reformat a paper after 
editing the bibliography, EndNote will not preserve your edits. When EndNote reformats a bibliography, it 
deletes the existing one and puts a new one in its place.

You can edit the bibliography as you would any text. The bibliography may be shaded, but you can still edit 
it. If you later reformat the paper, your edits will be gone.

You can add text after the bibliography, but make sure to put it after the end of the formatted bibliography— 
outside of the bibliography field.

Note: See Modifying Style Templates.

Formatting a bibliography serves two functions:

It formats each in-text citation according to the selected bibliographic style.▪

Page 199 of 586

 



Clarivate EndNote 20 User Help Guide

Configuring the Bibliography in Microsoft Word

It adds a complete bibliography to the document (unless you override this with a setting in the output 
style).

▪

The format used for citations and references is determined by the output style selected. When you 
have finished writing your paper in Word, and all of your EndNote citations have been inserted into 
the text, you are ready for EndNote to format the paper and generate a bibliography. This can be 
done in one of these ways:

▪

Instant Formatting actually works as you insert citations and is enabled when you first start using 
Cite While You Write. EndNote uses the currently selected style to format citations and update 
the bibliography each time a citation is inserted. However, if you want to change the style or 
layout of references, you can use the Format Bibliography  tab from the Configure Bibliography 
dialog. See Configuring the Bibliography in Microsoft Word.

▪

Configure Bibliography allows you to modify bibliography preferences such as style and layout 
before formatting your document.

▪

Update Citations and Bibliography is available on the EndNote tab in Word. EndNote uses the 
currently selected style to format the citations, the bibliography, plus figures and tables. You 
could also select a new style from the Style list in the Bibliography group.

▪

On the EndNote  tab,  in the Bibliography  group, click the bottom corner arrow to open the Configure 
Bibliography dialog.

On the Format Bibliography tab, use the With Output Style option to select an output style to format 
references.

1.

Click OK to format all citations and build the bibliography.2.

The Configure Bibliography dialog allows you to customize options for the citations and bibliography beyond 
those set in the style.

You may be halfway through inserting citations or you may have finished writing your paper. You may have 
instant formatting enabled or you may have manually inserted citations with formatting disabled. It does not 
matter. As long as you have citations entered in your document, you can format your paper at any time.

Note: The first time a citation is formatted, the corresponding EndNote library must be open. After that, 
EndNote can use The Traveling Library for reference information.

To format citations and generate a bibliography:

On the EndNote tab, click the bottom corner arrow in the Bibliography group.1.

On the Format Bibliography tab, change or verify these settings.  
 
Format document: Make sure the appropriate Word document is selected from the list of open 
Word documents.  
 
With output style: Select the appropriate output style to format references. You can experiment by 
reformatting with various output styles. To add more output styles to the list, see Adding Styles to the 
Output Styles Menu.  
 

2.
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Moving Bibliographies in Microsoft Word

Temporary citation delimiters: These are the opening and closing delimiters for temporary 
citations. Make sure they are unique delimiters, and not characters you would normally use in your 
paper. The defaults are curly braces.  
 
Link in-text citations to references in the bibliography: This option is selected by default, 
creating hyperlinks between in-text citations and their corresponding references in the bibliography. 
Clear the selection to remove links between in-text citations and their matching references in the 
bibliography.

Note: Links between citations and bibliography entries only works with in-text citations. You 
cannot link between full-reference footnotes or endnotes and their matching bibliography entries. 
Author-date citations within Word footnotes or endnotes can be linked, but not full-reference 
footnotes or endnotes.

Underline linked in-text citations: Select this option to add underlines to in-text citations. Clear the 
checkbox to remove underlines from in-text citations in your paper.  This option is only available if the 
"Link in-text citations to references in the bibliography" checkbox is selected.

On the Layout tab, change or verify these settings:  
 
Font and Size: These are the text font and size used for the bibliography.  
 
Bibliography Title: To print a title at the top of your bibliography, type the title in this text box. This 
title will always be centered. If you want to use Word's formatting options for the bibliography title, 
perhaps to match headings being at the left in your paper, leave this field blank and add a title above 
the bibliography manually.  
 
Text Format: Highlight  the bibliography title text and then use the Text Format  button to display a 
dialog where you can change the format of the highlighted text.  
 
Start with Bibliography Number: Enter  a starting reference number if you want a numbered 
bibliography to start with a number other than one. This works only for in-text numbered styles; it 
does not affect footnotes or endnotes.  
 
First Line Indent and Hanging indent: Use these settings to set a paragraph indent (where the first 
line of a paragraph is indented), a hanging indent, or no indent at all. The hanging indent applies to 
the second and subsequent lines of a reference in the bibliography. Type measurements as 
centimeters (cm), inches (in), lines (li), or points (pt).  
 
Line Spacing and Space After: Set the Line spacing for within a reference and the Space after for 
spacing between references.

3.

Click OK to save changes and format your citations and bibliography.4.

Note: You do not have to verify each tab every time you format. Changes set will remain in effect until you 
change them manually.

Cite While You Write always creates the initial bibliography at the end of the Word document. If you move 
the bibliography to a different location in the document, EndNote keeps it there even if you reformat the 
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Instant Formatting in Microsoft Word

Reformatting Papers in Microsoft Word

Adding New Citations to Formatted Papers

paper. You can drag-and-drop the bibliography, or, if Instant Formatting is disabled, you can Cut and Paste 
the bibliography.

If you unformat all the citations in the document, then format a new bibliography, it will again be placed at 
the end of the document. Unformatting removes the Word codes for the new location of the bibliography.

Note: When Instant Formatting is enabled, use drag-and-drop to move a bibliography, not Cut and Paste. 
If you try to use Cut and Paste, Instant Formatting will create a new bibliography at the end of the 
document before you have a chance to Paste.

Instant Formatting works while you write your paper. As you insert citations, EndNote uses the currently 
selected style to format citations and update the bibliography. By default, Instant Formatting is enabled the 
first time you insert a citation or format the bibliography.

To turn Instant Formatting on or off, use the Instant Formatting is On/Off toggle on the EndNote tab.

For new documents or documents that have never been formatted, when Instant Formatting is enabled, it is 
not triggered when you manually type a reference into a document. You must use the the EndNote tab in 
Word to either insert another citation or format the citations and a reference list. If a document has been 
successfully formatted and you manually type in a temporary citation, that citation is instantly formatted.

To enable or disable Instant Formatting in the current document, on the EndNote tab, select your preferred 
option from the Instant Formatting is On/Instant Formatting is Off drop-down. It is a toggle which will show 
the current status of Instant Formatting in the tab.

To set preferences for Instant Formatting, on the EndNote  tab, select the Turn Instant Formatting Is On/ 
Instant Formatting Is Off drop-down, then select Configure Instant Formatting. Set your options for the two 
choices shown below, then click OK to close and save your changes.

Scan for temporary citations  turns on scanning of temporary citations. This finds and formats all 
citations, including those you may have entered manually. You can select how often EndNote scans 
your document.

▪

Check for citation changes turns on background scanning that looks for citation changes.▪

When Instant Formatting is enabled, leaving the Configure Bibliography dialog will always trigger formatting 
in your document.

Note: To turn Instant Formatting on or off for new Word documents, see General Preferences in Microsoft 
Word

If you add more citations to your paper after the formatting process, you can update the citations and the 
bibliography by clicking Update Citations and Bibliography or by using the Configure Bibliography dialog. To 
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Reformatting with Different Styles

Inserting and Formatting Figures and Tables

Notes About Formatting Figures and Tables

open the Configure Bibliography dialog, on the EndNote  tab click  the bottom corner arrow  in the 
Bibliography group.

Note: You do not need to unformat your citations in order to reformat them.

To reformat your paper in a different style, select the new style from the drop-down Styles  menu on the 
EndNote tab. Your citations and bibliography are updated for the new bibliographic style. See Adding Styles 
to the Output Styles Menu for information about expanding the list of available styles.

Once images are organized in an EndNote library, they are available for inserting into a manuscript with Cite 
While You Write commands. The finishing touch is the automatic creation of a figure list and/or a table list 
that presents a sequential list of all graphics inserted in a manuscript from EndNote. Graphics not inserted 
from EndNote will not appear in figure or table lists.

A figure citation is a brief numbered citation in the body of a paper that refers the reader to a figure at the 
end of the paragraph or to a figure in a complete list of figures at the end of the paper.

In-text figure citations are sequentially numbered and formatted like this:

Marrella is a small "arthropod" somewhat reminiscent of a trilobite. This 
illustration also shows the dark "blob" produced by body contents which were 
squeezed out of the animal after burial. (Figure 1)

It includes the word "Figure" (or "Table"), the sequential number, and surrounding parentheses. The field 
may be shaded by Word to help you see citations, but shading does not print. You can turn field shading off 
in Word.

The current output style determines the placement of formatted figures and tables. They appear either within 
the body of the paper, directly after the paragraph where they are cited, or in a list at the end of the 
document, after the bibliography.

Note: Figure citations are not bibliographic citations and will not appear in the bibliography. If the figure is 
from a reference, you must insert the reference as a citation separately to have it appear in the 
bibliography.

See Finding and Inserting Figures and Tables.

Do not use Microsoft Word Captioning in conjunction with EndNote figure captioning or in-text 
citations.

▪

Images found in the "Chart or Table" reference type  are inserted into word as tables, which are 
labeled and numbered separately from figures. (You still use the generic Insert Figure command.)

▪
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Finding and Inserting Figures and Tables

If you open an existing document that already has figure citations in the body (that were not inserted 
with EndNote’s Insert Figure command), those figures will not be included in the figure list. You will 
need to add the existing figures to references in EndNote, and then use the Insert Figure command 
to insert them into the document.

▪

You can format figures either directly after the paragraph in which they are cited or in a list at the end 
of the document. See Figures and Tables Preferences in Microsoft Word.

▪

The Instant Formatting that applies to bibliographies does not apply to figures. In-text figure citations 
are always formatted as you insert them, but if you move or delete a figure citation in your paper, you 
must select Update Citations and Bibliography on the EndNote tab.

▪

Figure and table captions are added from the Caption field in the EndNote reference.▪

If more than one in-text figure citation references the same figure with the same caption, those 
citations are assigned the same figure number, and the figure appears only once in a figure list.

▪

You can manually insert a page break between figures if you prefer each figure on a separate page. 
These page breaks will be remembered if you select Update Citations and Bibliography again.

▪

You can search EndNote references and insert a graphic or file from the figure field of a reference into your 
Word document. The figure field in your references may be titled figure or have a custom name assigned by 
you.

Note: The file types accepted are dependent on your version of Word and other software installed on your 
computer.

To insert a graphic or file that is stored in an EndNote reference:

Open the EndNote library that contains the figure you wish to insert.1.

In the Word document, position the cursor at the location where you would like the figure citation to 
appear.

2.

On the EndNote tab in Word, select the Insert Citation drop-down menu, and then select Insert 
Figure.

3.

In the text box at the top, enter text to identify the reference that contains the figure. EndNote 
assumes an "and" between each word, and will search all fields in your records, including the 
Caption field.

4.

Click Find, and EndNote compares the text to text in your EndNote references and lists each 
matching reference that contains an image.  
 
EndNote displays the Author, Year, Title, and Caption field from each matching reference. Drag the 
vertical bars between the column titles to display more or less of a field. The Caption column should 
contain the contents of the record's Caption field.

5.

Select and insert the appropriate figure.  
 
If no references match your text, try modifying your search.

6.
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Updating Figures and Tables

EndNote places an in-text figure citation at the cursor location, and inserts and labels the figure itself in the 
location set by the style.

Note: Images found in the "Chart or Table" reference type  are inserted into Word as tables, which are 
labeled and numbered separately from figures.

The figure or table number represents the order of the image in the document.

You can insert figures and tables in an existing manuscript or as you write. Remember to save your 
document as you work.

Note:  The Instant Formatting that applies to bibliographies does not apply to figures. In-text figure 
citations are always formatted as you insert them, but if you move or delete a figure citation in your paper, 
you must click Update Citations and Bibliography to update your changes.

In-text figure citations are always formatted as you insert them. The graphic will appear in the location set in 
the style.

If you move or delete a figure citation in your paper, you must manually generate the figure list to update the 
figure citation numbering and placement.

On the EndNote tab, select Update Citations and Bibliography.

EndNote will number each figure and table citation sequentially in the Word document, as shown in this 
example:

This family tree is not a chronological progression. Rather, it illustrates 
how evolution incorporates traits that evolved for unrelated reasons into a 
novel structure. (Table 1) 
 
Marella is a small "arthropod" somewhat reminiscent of a trilobite. This 
illustration also shows the dark "blob" produced by body contents which were 
squeezed out of the animal after burial. (Figure 1) 
 
As researchers look at evidence, even the crest on the modern cockatiel 
provides insight into the evolution of feathers. (Figure 2)

EndNote also inserts and displays the actual figures (graphics, figures, tables, charts, equations, or files) 
and labels them with figure or table numbers (to match each in-text reference) and caption text from the 
Caption field in the EndNote reference.

If your figures are listed at the end of the document:

In a figure or table list, if more than one citation references the same figure with the same caption, 
those citations are assigned the same figure number, and the figure appears only once in the list.

▪

You can continue to add figure citations to the Word document. If you change the position of figure 
citations in your document (with the Copy and Paste commands), select Update Citations and 
Bibliography again to update figures and tables.

▪
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Placing Figures and Tables

Automatic Placement by the Output Style

Selecting a Different Output Style

Cite While You Write Override of the Output Style

Moving Figures and Tables

Moving In-text Figure and Table Citations

You can manually insert a page break between figures if you prefer each figure on a separate page. 
These page breaks will be remembered if you generate the figure list again. Or, direct the output 
style to always insert page breaks between figures.

▪

Figures and tables are formatted either after the paragraph where cited or in a list at the end of the 
manuscript. This placement is determined by the current output style.

Note: Images from any reference type other than "Chart or Table" are inserted and formatted as Figures. 
Images from the "Chart or Table" reference type are inserted and formatted as Tables. Both are inserted 
with the Insert Figure command. Both are formatted with the Update Citations and Bibliography 
command .

The selected output style determines where figures and tables are initially placed in a document and when 
you Update Citations and Bibliography.

By default, most output styles are set up to place figures and tables immediately after the paragraph in 
which they are cited. You can edit individual output styles to place figures and tables either after the 
paragraph in which they are cited or in a list at the end of the document.

For information about editing your output style for figure placement, see Figures and Tables. The Figures 
panel determines the placement of figures and their captions, the Tables panel determines the placement of 
tables (images from the Chart or Table reference  type) and their captions, and the Separation and 
Punctuation panel determines image separation and punctuation of labels and captions.

To apply a different output style in Word, on the EndNote  tab, select the new style from the Styles  drop- 
down menu.

The output style choice affects both bibliographic citations and figure and table citations.

As you work in your document, you may adjust the placement of actual figures and tables by cutting the 
pictures and pasting them elsewhere in the document. Normally, when the figure list is generated again, the 
output style puts them back in their initial location. You can override the output style, and tell EndNote to 
leave existing figures and tables where they are currently placed. See Figures and Tables Preferences in 
Microsoft Word for information about Cite While You Write preferences that affect Figures and Tables.

To move or copy a figure or table citation:

Select the entire citation, including the surrounding parentheses. For example: (Figure 1).1.
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Moving Individual Figures and Tables

Moving Figure and Table Lists

Use Copy (Ctrl+C) or Cut (Ctrl+X) commands to copy or move the citation from its current location, 
then the Paste (Ctrl+V) command to put the citation in its new location. You can also use drag-and- 
drop to move a figure citation.

2.

On the EndNote tab, select Update Citations and Bibliography to renumber the in-text citations and 
update figures and tables.

3.

The selected output style determines whether figures and tables appear directly after the paragraph where 
cited or in a list at the end of the document. To modify this section of your output style, see Figures and 
Tables.

To move an individual figure or table within the text of the manuscript:

Cut  the figure (or table), including the label and caption, and Paste  it in the appropriate position in 
your manuscript.

1.

On the EndNote tab, select Preferences.2.

On the Figures and Tables tab, select the bottom button for custom placement of figures and tables 
and click OK.

3.

On the EndNote tab, select Update Citations and Bibliography.4.

EndNote will update figure and table numbering, but will not change the position of existing figures and 
tables. See Figures and Tables Preferences in Microsoft Word.

Note: This custom placement is honored only when the current output style is set up to print figures and 
tables within the text of the manuscript. When the output style is set up to list figures and tables in lists at 
the end of the document, regenerating the figure list will move figures and tables to the appropriate list at 
the end of the document.

When an output style is modified to print figures and tables in a list at the end of a document, the lists 
appear after the bibliography. However, you may want the list to appear elsewhere in your document. Some 
publishers even require that figures be provided in a separate file.

To move a figure or table list elsewhere in your document, such as before the bibliography:

Select the entire list, especially the very beginning of the list which contains a hidden marker.1.

Cut the list to move it to the Clipboard.2.

Move the cursor to the new location.3.

Paste the Clipboard contents at the new location.4.

Each time you select Update Citations and Bibliography, EndNote looks for the beginning marker, so the list 
will be updated in its current location.

If multiple in-text figure citations reference the same figure with the same caption, those citations are 
assigned the same figure number, and the figure appears only once in a figure list.
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Deleting a Figure Citation or Figure List

Sharing Your Word Documents

To provide a figure or table list in a separate file:

Finalize your manuscript and figure list.1.

Select the entire list, and then use the Copy and Paste commands to paste the list into another Word 
document.

2.

Delete the figure or table list from the manuscript file.3.

Note: Do not select Update Citations and Bibliography again within either document.

To delete a figure or table citation:

Highlight the entire citation, including the surrounding parentheses.1.

Press the Backspace or Delete key.2.

On the EndNote  tab, select Update Citations and Bibliography  to renumber the remaining in-text 
figure and table citations and update the formatted figures and tables.

3.

To delete a figure or table list:

To remove a single figure or table from the list, delete the corresponding in-text figure citation. Then, 
use Update Citations and Bibliography to generate an updated list at the end of the document.

▪

If you want to completely remove the figure or table list, first delete all in-text figure citations and 
update the list with Update Citations and Bibliography. Then, to completely remove any mention of a 
figure or table list, select the List of Figures marker or List of Tables marker and press Delete.

▪

Note: Do not delete the figure (picture) itself from the document. Remove the in-text figure citation and 
then Update Citations and Bibliography. If you do not remove the in-text citation, regenerating the figure 
list will use the in-text citation to display the picture again!

You can directly share your Word files with colleagues. Each formatted citation is surrounded by field codes 
that contain reference information (see The Traveling Library), so colleagues may not even need access to 
your library to add citations or update the bibliography.

If you want to convert your document for use with a previous version of Word or a different word processor, 
you should Unformat Citations before saving in the different file format. Then, you may be able to reformat. 
The corresponding EndNote library (or libraries) must be available in order to format. See Unformatting 
Citations in Microsoft Word.

To send a final, formatted document to someone, you may want to remove the field codes to save the 
formatted citations and bibliography as text. See Removing Field Codes.

Of course, if you just want to print a copy of the paper for someone, you do not need to do anything to your 
document other than print it!
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The Traveling Library

Exporting Word’s Traveling Library to an EndNote Library

If you are working collaboratively with a colleague and would like to share your library as well as your 
documents, see About Shared Libraries and Working on Different Computers.

Each formatted citation in your Word document is saved with field codes that embed reference data in the 
document. The paper contains a "Traveling Library" of references cited. See Field Codes in Microsoft Word.

The first time a citation is formatted, EndNote looks in the open library  and finds the corresponding 
reference. If you later reformat, EndNote again looks in the open library for that reference. However, if the 
library is not available or not open, EndNote uses the Traveling Library for reference information.

Because reference data is kept with each formatted citation, you can collaborate with other authors on a 
paper without each author having the same EndNote library.

The reference data saved with each citation includes all fields except Notes, Research Notes, 
Abstract, Figure, and Caption.

Note: Do not unformat your document if you do not have the original references in your libraries. Unlike 
formatted citations, unformatted citations require that you have the corresponding EndNote libraries open 
in order to format references.

There may be occasions where you want to copy all of the references used in a Microsoft Word document to 
an EndNote library. Perhaps you received only the formatted Word document from a colleague, and would 
like to create EndNote references to use later. Or, you may have a large EndNote library, but want to create 
a smaller EndNote library with only the subset of references used in your paper.

Note: The Traveling Library does not contain Notes, Research Notes, Abstracts, Figures, or Captions.

To export references from a Word document to an EndNote library:

Open the document in Word.1.

On the EndNote 20 tab, select Export to EndNote, and then select Export Traveling Library.2.

On the Export Traveling Library dialog, select either:3.

An existing EndNote library: Select a library from the drop-down list of open libraries, or click 
Browse to locate a library.

▪

A new EndNote library: You will be prompted to name and save the new library.▪

Notes: We recommend that you export to a new EndNote library, so you can review the records before 
adding them to an existing library. 
 
When you use the Export Traveling Library command, the exported references are renumbered and do 
not retain their original record numbers.
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Converting Word Citations to EndNote

Working on Different Computers

EndNote Sync and Sharing

Word includes a Reference tab, where you can keep a database of references and use commands to insert 
them into Word documents as citations. These citations are not used by EndNote’s Cite While You Write 
feature. If you have references already entered into Word, or citations using Word's data format in a 
document, you can copy the reference information into an EndNote library  and then convert the Word 
citations into EndNote Cite While You Write citations.

Note: The Word citation conversion features requires that your computer have the Microsoft .Net 
Framework installed.

To export Word document citations to an EndNote library:

Open the Word document that contains the citations.1.

On the EndNote 20 tab, select Export to EndNote, and then select Export Word Citations.2.

To export the Word master citation list (this may include references not used in the paper) to an EndNote 
library:

Open the Word document that contains the citations.1.

From the EndNote 20 tab, select Export to EndNote, and then select Export Word Master List.2.

To convert Word citations to EndNote citations within the document:

Open the Word document that contains the citations.1.

From the EndNote tab, select Convert Citations and Bibliography, and then Convert Word Citations 
to EndNote.

2.

If you are working on a paper and moving between different computers, you will want to have access to 
the references  needed for your paper wherever you are. EndNote gives you options for accessing your 
references on different computers, as well as options for sharing those references with colleagues who may 
be working on the paper with you.

EndNote Sync allows you to synchronize the references in your library to multiple computers. EndNote Sync 
does not synchronize the library as a whole; it creates a new library on the second (or third, or fourth, etc.) 
computer(s) and synchronizes all the reference data within the library to the new computer. Terms lists are 
not synchronized, and record numbers change during this process, but all the reference data remains intact 
from the original library. See The Sync Feature for information on syncing an EndNote library.

After a library is synced, the library can be shared with other EndNote desktop users. See About Shared 
Libraries for information on sharing your library with other EndNote users.
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Sharing Groups through EndNote Online

The Traveling Library

Saving Files for Other Versions of Word and Other Word 
Processors

Caution: Avoid unformatting your citations and bibliography if using EndNote Sync or Sharing; the record 
numbers for the same references may be different on each computer. To work with unformatted citations, 
you need the record numbers used in the library the citations were originally inserted from; the record 
numbers in a synced library are unlikely to match.

EndNote Sync synchronizes your references with your EndNote account, making them available from 
anywhere through a Web interface. These references can also be used in Word with Cite While You Write. 
You will have access to all the references in your EndNote account, and also have the ability to share just 
selected groups with collaborators. This may be a preferred option when you don't want to share your entire 
library. See Using Cite While You Write with EndNote Online for  information on switching between using 
your desktop and online libraries in a paper; see Sharing Groups for  information on sharing groups in your 
EndNote library.

The Traveling Library refers to a copy of the reference data from your EndNote library embedded in the 
Word field codes of the paper. Most of the time you don't see the contents of those field codes, you see the 
results of them: formatted EndNote citations. Only the reference data for citations used in the paper is 
included. Because that data is present in the paper, colleagues can add EndNote citations, or even change 
the EndNote Style, and the paper will be updated to include both your citations and those added by your 
colleague. You can find more information on the field codes used in Field Codes in Microsoft Word.

Formatted citations are Word "fields" specific to the version of Word that created them and the other 
compatible versions (Microsoft Word 2010, 2013, 2016, 2019, or Office 365 (locally installed desktop version 
only)).

If you open your document with a different version of Word, or use the Save As command to save a 
formatted copy of your paper in another format, you may lose the ability to format citations in that document.

If you plan to use your document with a different word processor or an earlier version of Microsoft Word, you 
should either Unformat Citations or Remove Field Codes (Convert to Plain Text) from the Word file before 
converting the document to the other file format.

Unformatting Citations: Unformatted citations are regular text; however, they are temporary 
placeholders that do not reflect final output. See Unformatting Citations in Microsoft Word. You may 
be able to unformat citations, save the document as an RTF file, and use Format Paper with  the 
original library the citations came from to format citations from these placeholders. Because Format 
Paper has no travelling library, the record numbers for the unformatted citations must match the 
record numbers in the library. See Basic Instructions for Using Format Paper for information on using 
Format Paper.

▪

Removing Field Codes: When you remove field  codes, you save a copy of the document and 
convert formatted fields to regular formatted text. Graphics are no longer linked, but are saved as 
though you had used the Copy and Paste commands. The copy reflects final, formatted output, but 
you cannot reformat later. See Removing Field Codes.

▪
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Submitting the Final Paper to a Publisher

Removing Field Codes

For information about using your Word document with OpenOffice.org Writer, see Moving Documents 
between Microsoft Word and Writer.

Many publishers ask that you submit an electronic copy of your paper in addition to a printed copy. Because 
the field codes in your document may be incompatible with the publishing software, you may be asked to 
submit a copy of your paper without field codes, as described in Removing Field Codes.

If your publisher uses EndNote, they may ask you to leave the field codes intact, enabling them to easily 
make changes to the citations or bibliography, if needed.

You may need to remove Cite While You Write field codes in order to share your document with a publisher 
or colleague. See Field Codes in Microsoft Word for information on field codes.

If your colleague is using the same version of Word that you are, you can share your formatted 
document as is; the document includes a Traveling Library, which includes all required information 
for the formatted citations and bibliography. See The Traveling Library.

▪

If your colleague is using a different word processor or an incompatible version of Word, you could 
remove field codes to share your final document. However, removing field codes saves the formatted 
citations and bibliography as text, and does not allow reformatting.

▪

Removing field codes means deleting Word’s  Cite While You Write field codes and saving the 
formatted citations and bibliography as text. This removes only Cite While You Write field codes, and 
not all other Word field codes.

▪

When field codes are removed, in-text figure citations are no longer linked to an EndNote reference 
or to the figure list. In-text figure citations become plain text. Pictures in the figure list become picture 
files, as though they were copied and pasted into the document.

▪

Because EndNote and Cite While You Write cannot reformat or unformat your paper once field codes 
are removed, the Convert to Plain Text command makes a copy of your document without codes.

▪

Note: If you are working with master and subdocuments in Word, the Convert to Plain Text command 
warns that it will strip codes from the original documents. You should first manually save copies of the 
master and subdocuments, and then remove codes from the copies.

To remove field codes and save the formatted citations and bibliography as text:

Open your formatted Word document. If it is a new document and has not been saved, save it before 
removing field codes.  
 
If you are working with Master and Subdocuments, work with copies of your documents.

1.

On the EndNote 20 tab, select Convert Citations and Bibliography,  and then Convert to Plain Text. 
Click OK in the confirmation dialog to create a new document. A copy of the document, without field 
codes, appears in a new document window.

2.

From the File menu, select Save.3.
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Single document: In Word’s Save As dialog, type a new name for this copy of your document 
and click OK.

▪

Master and Subdocuments:  You may be advised to save a copy of the master and each 
subdocument.

▪

Word saves your document without embedded formatting codes, so you can submit your paper to a 
publisher or share your final paper with a colleague using a different word processor (including a different 
version of Word).

Note: The copy does not contain Cite While You Write field codes, so you cannot reformat with Cite While 
You Write. To reformat, start with the original document, which retains field codes.

If you find that removing EndNote field codes produces undesired layout or other formatting changes to your 
document, you can remove all Microsoft Word field codes, which may yield better results.

To remove all Microsoft Word field codes:

First save a backup copy of your document, because this will irretrievably remove the links between 
your document and your EndNote libraries as well as all other Word field codes.

1.

Select all text in the document by pressing Ctrl+A.2.

Press  Ctrl+6 to  remove all Microsoft Word field codes from the document (not just Cite While You 
Write codes!) and leave the text, citations, and bibliography as they appear. (Be sure to use the 
number 6 on your keyboard, not the 6 on the keypad. For most U.S. keyboards, this will be the key 
that also includes the caret (^) symbol.)

3.
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EndNote in PowerPoint

Introduction: Inserting Citations and 
References in PowerPoint

Use the commands at the top of the PowerPoint ribbon to easily and quickly insert citations and references 
in your PowerPoint slides. EndNote formats citations and references based on the rules defined for the 
selected output style.

We recommend that you select a style from the Style menu  before you begin inserting citations and 
references in your document. Please remember that selecting a new output style will not update the 
formatting of citations and references already inserted into the document.

This feature is compatible with Microsoft PowerPoint versions 2010, 2013, 2016, 2019, or Office 365 (locally 
installed desktop version only).

Insert Citation

Select this option to search for and insert citations in your document. Selecting this option opens the 
Find & Insert My Citations dialog. When using this option, what is inserted will be formatted according to 
the Citation template in the output style.

Insert Selected Citation(s)

Select this option to insert citations selected from your open EndNote library. First, open EndNote and 
select the needed references. Return to your PowerPoint presentation and click this button. EndNote 
inserts the citation for the selected reference where you position your cursor. When using this option, 
what is inserted will be formatted according to the Citation template in the output style.

Insert Reference

Select this option to search for and insert bibliographic references in your document. Selecting this 
option opens the Find & Insert My References dialog. When using this option, what is inserted will be 
formatted according to the Bibliography template in the output style.

Insert Selected Reference(s)

Select this option to insert bibliographic references selected from your open EndNote library. First, open 
EndNote and select the needed references. Return to your PowerPoint presentation and click this 
button. EndNote inserts the selected references where you position your cursor.   When using this 
option, what is inserted will be formatted according to the Bibliography template in the output style.

Style Menu

Use this menu to select an output style before you begin inserting citations and references in your 
document.

Go to EndNote Command

Select this option to open EndNote if it is not currently open. If EndNote is already open, this option 
brings EndNote to the front of the screen.
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Output Styles in PowerPoint

The Style Menu

Insert Citations in PowerPoint

An output style determines how EndNote formats information in citations and references in your PowerPoint 
slides.

We recommend that you select a style from the Style menu  before you begin inserting citations and 
references in your document. Please remember that selecting a new output style will not update the 
formatting of citations and references already inserted into the document.

To select a style that does not appear on the Style menu, choose the Select Another Style option to display 
the EndNote Styles dialog. Each style you select from the dialog displays on the Style menu.

By default, the Style menu will show your "favorite" styles. This list starts with a small default set of styles 
and adds styles as you use them. To add or remove styles from this list, see Adding Styles to the Output 
Styles Menu.

After citations or references are inserted, they are plain text. They do not contain field  codes that can be 
updated as they do in Word. You can edit the citations to add page numbers, or remove the author or year.

Follow these steps to insert citations in your PowerPoint slides.

Open the EndNote library that contains the references that you wish to cite.1.

Start PowerPoint and open the document you are writing.2.

Select a style from the Style menu. The Style menu lists the styles that are currently selected as your 
"favorites" in the Style Manager. To select a style that is not in the list, click Select Another Style to 
display the installed styles. To install more styles, see Installing Additional Output Styles.

3.

Position the cursor in the text where you would like to add the citation.4.

On the EndNote tab, select Insert Citation to display an EndNote Find & Insert My Citations dialog.5.

In the text box, enter your search query. This could be an author’s last name, a year, a keyword, or 
any other combination of terms found in the reference.

6.

Click Find to display a list of matching references.7.

Select one or more items from the dialog.8.

Click the Insert button. The citations will be inserted at the location of your cursor in PowerPoint.9.

Insert Selected Citation(s)

Open the EndNote library that contains the citation that you wish to insert in your PowerPoint 
document.

1.

Start PowerPoint and open the document you are writing.2.
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Insert References in PowerPoint

Select a style from the Style menu.3.

Position the cursor at the location where you would like to add the citations.4.

On the EndNote tab, select Go to EndNote.5.

Select the desired citation(s) in your EndNote library.6.

Return to PowerPoint.7.

On the EndNote tab, select Insert Selected Citation(s). The citations will be inserted at the location of 
your cursor in PowerPoint.

8.

Follow these steps to insert references in your PowerPoint slides.

Open the EndNote library  that contains the references that you wish to insert in your PowerPoint 
slides.

1.

Start PowerPoint and open the document you are writing.2.

Select a style from the Style menu. The Style menu lists the styles that are currently selected as your 
"favorites" in the Style Manager. To select a style that is not in the list, click Select Another Style to 
display the installed styles. To install more styles, see Installing Additional Output Styles.

3.

Position the cursor in the text where you would like to add the reference(s).4.

On the EndNote  tab, select Insert Reference  to display an EndNote Find & Insert My References 
dialog.

5.

In the text box, enter your search query. This could be an author’s last name, a year, a keyword, or 
any other combination of terms found in the reference.

6.

Click Find to display a list of matching references.7.

Select one or more items from the dialog.8.

Click the Insert button to insert the reference and format it as defined by the currently selected output 
style's Bibliography template.

9.

Insert Selected Reference(s)

Open the EndNote library that contains the references that you wish to insert in your PowerPoint 
document.

1.

Start PowerPoint and open the document you are writing.2.

Select a style from the Style menu.3.

Position the cursor at the location where you would like to add the reference(s).4.

On the EndNote tab, select Go to EndNote.5.
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Select the desired reference(s) in your EndNote library.6.

Return to PowerPoint.7.

On the EndNote tab, select Insert Selected Reference(s).8.
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Cite While You Write in Apache OpenOffice 
Writer

Overview of the Cite While You Write Process 
in OpenOffice Writer

Word Processor Compatibility for Apache 
OpenOffice Writer

How to Cite While You Write with OpenOffice 
Writer

The instructions in this section apply to Apache OpenOffice Writer 3.x or 4.x, but can also be adapted for 
use with LibreOffice for Windows 4.x, 5.x, or 6.x (all 32-bit).

Use Cite While You Write™  (CWYW) with Apache OpenOffice Writer 3.x or 4.x  to easily and quickly cite 
references and create a paper with properly formatted citations and a bibliography. Cite While You Write 
gives you access to EndNote references and formatting commands with an EndNote menu in Writer. See 
How to Cite While You Write with OpenOffice Writer.

You can start by inserting a citation into the document. Then, you can format the citation and a bibliography 
according to any one of thousands of styles. See Finding and Inserting Citations in OpenOffice Writer.

You can  Cite While You Write with Apache OpenOffice Writer 3.x or 4.x. Writer displays Cite While You 
Write commands on an EndNote menu.

If you use Microsoft Word as your word processor, see How to Cite While You Write with Microsoft Word.

If you use a word processor other than Microsoft Word or OpenOffice.org Writer, or an older version of these 
word processors, save your document as an RTF file  and use Format Paper. See Basic Instructions for 
Using Format Paper.

To create a stand-alone bibliography that is not based on the citations in a paper, see Introduction to 
Independent Bibliographies.

Note: Only one word processor at a time should be open when inserting citations and formatting 
documents.

The basic steps required to cite a reference and generate a bibliography with Writer are summarized below.

To Cite While You Write:

Open the EndNote library or libraries that contain the references you wish to cite.1.
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Installing Cite While You Write Support for 
OpenOffice Writer

Start OpenOffice Writer and open the paper you are writing.2.

When you are ready to cite a source, position the cursor in the text where you would like to put the 
citation.

3.

In OpenOffice Writer, go to the EndNote  menu and select Find Citation(s). A Find Citations dialog 
appears, which shows the previous search results.

4.

Note: If this is the first time you have used the Find Citations dialog, it may be completely blank 
because there are no previous search results to display.

In the Find box, enter identifying text for EndNote to locate the appropriate reference. This could be 
an author’s last name, a year, a keyword, or any other combination of terms found in the reference.

5.

Click Search  and EndNote compares the identifying text to your EndNote references and then lists 
the matching reference(s).

6.

Identify, select, and Insert the appropriate reference(s).7.

Go back to step 3 to insert the next citation, and continue citing references this way.8.

Note: Each time you insert a citation it is instantly formatted, and a bibliography is updated at the 
end of your document. When you are done inserting citations, your document is done!

If your citations are not automatically formatted, and a bibliography is not updated each time you 
insert a citation, go to the EndNote menu and select Format Bibliography. 
 
A Format Bibliography dialog appears, where you can change or verify the style  and layout of the 
bibliography. (You can Format Bibliography at any time in order to change the style or layout of your 
citations and bibliography.)

9.

Note: The dialog lists the styles that are currently selected as your "favorites" in the Style 
Manager. If you need to choose a style that is not in the list, click Browse to locate it.

Click OK. EndNote scans your paper and, using the selected style, formats any temporary citations, 
reformats formatted citations, and appends a bibliography to the end of your paper.

10.

Your paper is ready for publication!

EndNote’s  installation program installs Cite While You Write support for OpenOffice Writer. If you installed 
the OpenOffice suite after installing EndNote, you must either reinstall EndNote, or Repair or Modify your 
installation. For more information, see No EndNote Commands in Word or Writer.

EndNote commands appear on an EndNote menu in OpenOffice.org Writer.

Page 219 of 586

 



Clarivate EndNote 20 User Help Guide

Cite While You Write Commands in 
OpenOffice Writer

When Cite While You Write is installed, several EndNote commands appear on an EndNote menu in 
OpenOffice Writer.

When you select an EndNote command from the menu, the EndNote program starts (if not already running).

These are brief descriptions of the Cite While You Write commands found on the EndNote menu in 
OpenOffice Writer:

Go To EndNote: Bring EndNote to the front of your screen. This command launches EndNote if it is 
not already running.

▪

Find Citation(s): Search for EndNote references to select and insert as citations in your OpenOffice 
Writer document. See Finding and Inserting Citations in OpenOffice Writer.

▪

Format Bibliography: Format (or reformat) your paper according to the rules of the selected style. 
The formatting process replaces the temporary citations in your paper with formatted citations, and 
builds a bibliography at the end of the document. See Customizing Bibliography Settings in 
OpenOffice Writer.

▪

Insert Selected Citations: Insert a citation for each reference currently selected in the open 
EndNote library. You can insert any number of consecutive in-text citations; however, attempting to 
insert hundreds of EndNote references at one time may cause a system slowdown or freezing. See 
Inserting Selected Citations in OpenOffice Writer.

▪

Edit Citations: Edit existing individual or multiple citations. You can omit the author and/or year from 
citations, or add prefix or suffix text (such as page numbers) to citations. See Editing Citations in 
OpenOffice Writer.

▪

Unformat Citation(s): Unformat a selected citation before editing it, or unformat the whole 
document. This removes style formatting for the selected citations and  leaves temporary citations, 
which usually consist of the author’s  last name, the year, and the record number surrounded by 
delimiters. See Unformatting Citations in OpenOffice Writer.

▪

Cite While You Write Preferences: Change general Cite While You Write preferences. See Setting 
Cite While You Write Preferences in OpenOffice Writer.

▪

Help: Display help about Cite While You Write features.▪

Note: Several Cite While You Write commands also appear on the Tools menu in EndNote. To use these 
commands from within EndNote, you must use at least one Cite While You Write command from within 
OpenOffice Writer during the current session.

Troubleshooting:  See No EndNote Commands in Word or Writer if commands do not appear in Word or 
Writer.
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Forms of Citations in OpenOffice Writer

Unformatted (Temporary) Citations

Formatted Citations

A "citation" is the brief bibliographic information in the body of a paper that refers the reader to a complete 
reference in the bibliography. A citation typically consists of a bibliography number or the author and year in 
parentheses:

... of the species at hand.1

... of the species at hand. (Argus, 1991)

Citations can appear as either unformatted or formatted in your OpenOffice Writer document.

An unformatted citation is a temporary placeholder, and does not reflect final output. It will appear when you 
Unformat Citation(s) or manually enter unformatted citations. It contains information to find a unique, 
corresponding EndNote reference in the currently open library.

An unformatted citation typically consists of the first author’s  last name, year, and the EndNote record 
number, with citation delimiters at each end to identify the text:

{Author, Year #Record Number}

For example:

 {Alvarez, 1994 #8}

EndNote relies on these temporary citations to determine which references to include in the bibliography. 
See Components of a Temporary Citation for more information on temporary/unformatted citations.

The Format Bibliography command uses an EndNote output style  to convert all unformatted citations into 
formatted citations, and reflects final output.

Citations formatted in an Author-Date style might look like this:

(Alvarez 2009; Strong 2010)

This is the same citation formatted in the Numbered style:

[1,2]

Formatted citations include hidden information and should not be edited directly. See Editing Citations in 
OpenOffice Writer for information on safely editing formatted citations.

You can easily revert from formatted citations to unformatted citations at any time. See Unformatting 
Citations in OpenOffice Writer.
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Inserting Selected Citations in OpenOffice Writer

Finding and Inserting from Highlighted Text in OpenOffice 
Writer

You can search for EndNote references and insert them without ever leaving OpenOffice Writer.

This is the easiest way to find and insert a citation into an OpenOffice Writer document:

Open the EndNote libraries that contain the references you wish to cite.1.

Open the OpenOffice Writer document and position the cursor at the location where you would like 
the citation.

2.

From the EndNote menu, select Find Citation(s) to display the Find Citations dialog.3.

In the Find text box, enter text to identify the reference you wish to cite. EndNote assumes an "and" 
between each word, and will search all fields in your records.

4.

Click Search and  EndNote compares the text to text in your EndNote references and lists the 
matching reference(s).

5.

Identify and select  your reference(s), and click Insert to  insert the reference(s). If no references 
match your text, you need to modify your search text and click Search again.

6.

Citations are inserted into your paper in the same font as the surrounding text. Once a citation is inserted, it 
contains reference information in hidden codes.

You can insert citations in an existing manuscript or as you write. Remember to save your document as you 
work.

To format your citations and generate a bibliography, see Customizing Bibliography Settings in 
OpenOffice Writer.

To insert references selected in EndNote:

Open the OpenOffice Writer document and position the cursor at the location where you would like 
the citation.

1.

Go to the EndNote menu and select Go to EndNote.2.

Select the desired reference(s) in your EndNote library.3.

Click the Insert Selected Citations  button ( ) in EndNote, or switch back to the OpenOffice Writer 
document and select Insert Selected Citation(s) from the EndNote menu.

4.

To find and insert a citation from highlighted text:

As you are typing, enter text to identify the reference you wish to cite, and highlight that text.1.
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Inserting Multiple Citations in OpenOffice Writer

From the EndNote menu, select Find Citation(s) to display the Find Citations dialog.2.

EndNote inserts your highlighted text into the Find box. To insert a citation, use the Find Citation(s) dialog as 
described in Finding and Inserting Citations in OpenOffice Writer.

You can drag selected citations from your EndNote library  and drop them into your paper at the desired 
location for the citation.

You can also copy citations from the EndNote library and paste them into the document using Copy (Ctrl+C) 
from EndNote’s Edit menu and then Paste (Ctrl+V) from the OpenOffice Writer Edit menu.

There are several ways to insert multiple references in one in-text citation. When formatted, they appear as 
one multiple citation, sorted as your bibliographic style requires:

Unformatted: {Hall, 1988 #77; Baker, 1988 #16}
Formatted: (Baker, 1988; Hall, 1988)

You can insert any number of references into an in-text citation; however, attempting to insert hundreds of 
EndNote references at one time may cause a system slowdown or freezing.

Note:  If one of the citations in a multiple citation is not matched during formatting, the entire citation 
remains unformatted.

To insert multiple references as a grouped citation from within OpenOffice Writer:

Place your cursor where you want to enter the grouped citation.1.

From the EndNote menu, select Find Citation(s).2.

Enter a search term that will find the references you want, and click Search.3.

Hold down the Ctrl key while clicking on the desired references in the list (or hold down the Shift key 
to select a continuous range of references) in order to select the references.

4.

Click Insert.5.

To insert multiple selected citations from EndNote:

In OpenOffice Writer, place your cursor where you want to insert a grouped citation.1.

Select Go to EndNote from the EndNote menu.2.

In EndNote, hold down the Ctrl  key while clicking on the desired references in your library (or hold 
down the Shift key to select a continuous range of references).

3.

Click the Insert Selected Citations  button ( ) in EndNote, or switch back to the OpenOffice Writer 
document and select Insert Selected Citation(s) from the EndNote menu.

4.
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To insert multiple citations individually:

Another option is to insert citations individually, but immediately next to each other. Cite While You Write 
merges adjacent citations during formatting. Citations do not merge if any character separates them— 
including a space or punctuation mark.

Unformatted: {Hall,1988 #77}{Baker, 1988 #16}
Merged when Formatted: (Baker, 1988; Hall, 1988)

Note: You can add citations to an existing in-text citation, or change the order of citations within the 
delimiters, with the Edit Citations dialog.

To insert, remove, or edit citations within an existing in-text citation:

Click on the formatted citation.1.

In OpenOffice Writer, go to the EndNote menu and then Edit Citation(s) to display the EndNote Edit 
Citation dialog.  
 
All of the cited references in the document are listed in the left column of the dialog. Text showing 
above the citation shows  the citation formatted  according to the currently selected style. The box 
below shows details for the selected citation. To the right of the citations list are options for editing 
the selected citation.

2.

Select a citation, and then:3.

Click Remove to delete it.▪

Click Insert to insert another citation within the same set of delimiters.▪

Use the arrow buttons to change the order of the citation in a grouped citation. (If a Citation Sort 
Order is applied by the current output style, changing the order of citations in a grouped citation 
has no effect.)

▪

You can use the other features on this dialog as described in Customizing Individual Citations in OpenOffice 
Writer.

You can cite references from multiple libraries. Simply open the selected libraries before you begin inserting 
citations.

If possible, though, we recommend that you use a single library when writing a paper. Keeping all of your 
references in one library simplifies the writing process because you know exactly where to find each 
reference, there is little likelihood of duplicate references, and you only need to have one library open when 
inserting citations.

Note: If you plan to insert citations from more than one library into a paper, read about the Merge 
Duplicates in Bibliography preference.

Page 224 of 586

 



Clarivate EndNote 20 User Help Guide
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There may be cases where you want individual citations to differ from the standard format. You may want to 
remove the year or author from a citation if either was mentioned in the context of the sentence, or you 
might want to add a page reference or comment before or after the citation.

For example, assume a formatted citation looks like this:

Hall’s discovery (Hall, 1988)

You can omit the author’s name from the citation:

Hall’s discovery (1988)

You can omit the date from the citation:

the 1988 discovery (Hall)

You can add a suffix with a page number to the citation:

the discovery (Hall, 1988 p.4)

You can add a prefix to the citation:

the discovery (see Hall, 1988)

To customize a formatted citation:

Insert and format the citation.1.

Click on the formatted citation.2.

From  the EndNote menu, select Edit Citation(s) to display the Edit Citation dialog.  
 
All of the cited references in the document are listed in the left column of the dialog. Text showing 
above the citation shows  the citation formatted  according to the currently selected style. The box 
below shows details for the selected citation. To the right of the citations list are options for editing 
the selected citation.

3.

Select the citation you want to customize.4.

Customize as needed:  
 
Exclude Author: Select this to omit the author name from the formatted citation.  
 
Exclude Year: Select this to omit the date from the formatted citation.  
 
Prefix: Enter text here to print immediately before the citation text (spaces are significant).  
 
Suffix: Enter  text here to print after the citation text (spaces are significant). You can enter page 
numbers here if you always want them to print after the citation, even when not using a style that 
includes the Cited Pages field. You can also use the Suffix field to include section numbers, verse 
lines (for poetry, for example), or any other information to indicate a specific location within the cited 
reference.  
 

5.
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Pages: Page numbers entered here are considered entered into a "Cited Pages" field, so they can 
be manipulated on output just like any other EndNote field. In order to print, the Cited Pages field 
must be included in the citation template  and/or footnote template of your output style. This is 
typically used to print the page numbers within a full footnote citation. Most EndNote styles that 
require a special format for citations in footnotes are already configured this way. You can modify the 
Citation Template in your output style to include Cited Pages.  
 
Insert…: Select this option to search for and insert additional references to the selected citation, to 
create or expand a grouped citation.  
 
Remove: Select this option to remove the citation from the document.

Click OK to implement the change(s) to the citation.6.

Most citations can simply be inserted using the EndNote  menu, then the Find Citation(s)  command, as 
described in Finding and Inserting Citations in OpenOffice Writer. However, when adding new references to 
an existing formatted citation, it is important to insert the new citation adjacent to the existing citation.

To add a new reference to an existing citation, insert the new reference next to (not within) the existing 
citation, like this:

(Hockney and Ellis, 1996){Argus, 1984 #1}

Adjacent citations are merged during formatting, and the formatted citations are sorted according to the 
style:

(Argus, 1984; Hockney and Ellis, 1996)

Note: Do not insert a citation into the middle of a formatted citation. Insert it immediately before or after 
the existing citation, with no space between them.

Another option is to use the Insert button in the Edit Citation dialog:

In OpenOffice Writer, select the citation you wish to add a reference to.1.

From the EndNote menu, select Edit Citation(s) to open the Edit Citation dialog.2.

Make sure the citation you want to add a reference to is selected, then click the Insert…  button to 
open the Find Citation(s) dialog.

3.

Search for the new citation, select it, and click the Insert button to add it to the original citation. You 
will be returned to the Edit Citation dialog and will see the new reference selected in the list.

4.

Click OK to save your changes.5.
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OpenOffice Writer

Typing Citations into Your Paper in OpenOffice Writer

Once you have created a footnote or endnote in OpenOffice Writer, you can cite references in that footnote 
or endnote just like you cite them in the body of the document.

To cite a reference in a footnote or endnote:

Use the appropriate command in OpenOffice Writer to create the footnote or endnote. (EndNote 
does not create the footnote or endnote in the document, but is used to insert and format citations in 
the note.)

1.

Position the cursor in the footnote or endnote where you would like the citation(s) to appear.2.

Insert the citation as you normally would.3.

The EndNote style  that is selected when you choose Format Bibliography determines how citations in 
footnotes and endnotes are formatted. EndNote can format these citations as brief in-text citations or like 
complete references in the bibliography. It can also create a special format specific to footnotes or endnotes, 
including options like "Ibid." and other variations of shortened references when a citation appears more than 
once in the footnotes or endnotes. See Bibliography and Footnote Templates.

If you are citing full references in footnotes, you can include specific page numbers to be formatted like a 
regular EndNote field. See Customizing Individual Citations in OpenOffice Writer. Or, if you are manually 
typing citations, see Components of a Temporary Citation; the  method for adding page numbers to 
temporary citations works the same way in Word, OpenOffice Writer, and when using Format Paper with 
Rich Text Format (RTF) documents..

Manually entering citations is the same whether you are using Cite While You Write with 
OpenOffice Writer, Cite  While You Write with Microsoft Word, or Format Paper with a Rich Text 
Format (RTF) file. See these topics:

Notes About Temporary Citations▪

Components of a Temporary Citation▪

Omitting Authors or Years from Citations▪

Citation Prefixes▪

Citation Suffixes▪

Including Semicolons and Other Citation Delimiters in a Citation▪

Examples of Modified Citations▪
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Editing Citations in OpenOffice Writer

Unformatting Citations in OpenOffice Writer

Once you have inserted and formatted a citation, you should not edit it directly (although you can do so, if 
you feel you must). Direct edits are lost the next time EndNote formats the bibliography.

You can almost always get EndNote to format your citations exactly to your specifications by editing the 
style, the EndNote reference, or the citation, as described below. Changes made following these instructions 
will remain after reformatting.

To safely edit a formatted citation:

Click on the citation you wish to change.1.

From the EndNote  menu, select Edit Citation(s)  to display the Edit Citation dialog. All of the cited 
references in the document are listed in the left column of the dialog. Text showing above the 
citation shows the citation formatted according to the currently selected style. The box below shows 
details for the selected citation. To the right of the citations list are options for editing the selected 
citation.

2.

Select the appropriate citation from the list at the left of the dialog (you can scroll through all citations 
in the document) and make any of the following changes to the highlighted citation:  
 
Exclude Author:  Select this to omit the author name from the formatted citation.  
 
Exclude Year:  Select this to omit the date from the formatted citation.  
 
Prefix:  Enter text here to print immediately before the citation text (spaces are significant).  
 
Suffix:  Enter text here to print after the citation text (spaces are significant).  
 
Pages:  Enter page numbers here to appear as Cited Pages. To appear, the Cited Pages field must 
be included in the citation template or footnote template of the output style.

3.

You can add or remove citations from a grouped citation, or change the order of citations.  
 
Insert:  Use this to add another citation within the same set of delimiters.  
 
Remove:  Highlight a citation and click Remove to delete it from the in-text citation.  
 
Up and Down Arrows:  Highlight a reference and use the arrows to change the order of display.  (If 
a Citation Sort Order is applied by the current output style, using this dialog to change the order of 
citations in a grouped citation has no effect.)

4.

Click OK to implement your change(s).5.

After making changes, select Format Bibliography to reformat the new or modified citations and regenerate 
the bibliography.

Unformatting reverts formatted citations to temporary citations and removes the bibliography.
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Deleting Citations in OpenOffice Writer

If your citations are formatted in a numbered style, you can unformat your paper to easily identify citations 
as you work. You can use Format Bibliography again later to restore the formatted citations. See 
Customizing Bibliography Settings in OpenOffice Writer.

Note: You must have the corresponding EndNote library, or libraries, open in order to format the paper 
again.

To unformat citations:

Determine which citations you want to unformat:1.

To unformat a particular citation, highlight only that citation.▪

If the citation you want to unformat is part of a grouped citation, highlight the grouped citation. 
All citations within the delimiters will be unformatted. Be sure to select the entire citation.

▪

To unformat a section of the document, highlight that section.▪

To unformat the entire document, either select nothing or select the entire document.▪

From the EndNote  menu, select Unformat Citation(s). If you are unformatting the entire document, 
this unformats all of the in-text citations and removes the current bibliography.

2.

You can tell when a paper is unformatted because the citations appear in the temporary citation format 
(such as {Smith, 1999 #25}).

Unformatted citations are temporary placeholders that do not reflect final output. You can format the paper 
again at any time if you have the library, or libraries, that the citations were originally inserted from.

Note: To format your paper again, go the EndNote menu and select Format Bibliography.

You can highlight any text that includes citations, Cut  or Copy it, and then Paste it elsewhere in the 
document. You can do this with formatted or temporary (unformatted) citations.

To move or copy only the citation itself, make sure you highlight the entire citation (including any 
surrounding delimiters) as well as an extra character before and after the citation. Including the characters 
before and after the citation ensures that you include the hidden bookmark associated with the citation. (If 
the hidden bookmark is not part of the selection, you will copy plain text, and not an EndNote citation.) Then 
Cut (Ctrl+X) or Copy (Ctrl+C), and Paste (Ctrl+V) the citation elsewhere in the document.

To delete an unformatted citation, highlight the entire citation (including delimiters), and press the 
Backspace or Delete key.

While it is possible to highlight a formatted citation and press the Delete key on your keyboard, we do not 
recommend you do that. If you do not completely delete the citation and its associated bookmark, you could 
corrupt your document.

To safely delete a formatted citation:
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Generating Bibliographies

Generating Bibliographies in OpenOffice Writer

Customizing Bibliography Settings in OpenOffice Writer

In OpenOffice Writer, highlight the citation you want to delete.1.

From the EndNote menu, select Edit Citation(s) to display the EndNote Edit Citation dialog.2.

In the left column, make sure the highlighted citation is the one you want to delete. If the citation is 
part of a grouped citation, make sure you select just the citation you want to delete.

3.

Click Remove.4.

Click OK.5.

Formatting a bibliography serves two functions:

It formats each in-text citation according to the selected bibliographic style.▪

It adds a complete bibliography to the document (unless you override this with a setting in the output 
style).

▪

The format used for citations and references is determined by the output style selected.

You can format the paper and generate a bibliography at any time after inserting at least one reference. This 
can be done in one of these ways:

Instant Formatting actually works as you insert citations, and is enabled when you first start using 
Cite While You Write. EndNote uses the currently selected style to format citations and update the 
bibliography each time a citation is inserted. However, if you want to change the style or layout of 
references, you can use the Format Bibliography command to make changes manually.

▪

Format Bibliography allows you to modify bibliography preferences such as style and layout before 
formatting your document. From the EndNote menu, select Format Bibliography.

▪

These are the basic formatting instructions:

In OpenOffice Writer, go to the EndNote menu and select Format Bibliography.1.

On the Format Bibliography tab, use the With output style option to select an output style to format 
references.

2.

Click OK to format all citations and build the bibliography.3.

To customize the Format Bibliography settings, see Customizing Bibliography Settings in OpenOffice Writer.

You may be halfway through inserting citations, or you may have finished writing your paper. As long as you 
have citations entered in your document, you can format your paper at any time. You can reformat after 
adding more citations, or to change the style or layout settings.
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Reformatting Papers in OpenOffice Writer

Adding New Citations to Formatted Papers

Reformatting with Different Styles

Note: Each time a citation is formatted, the corresponding EndNote library must be open.

To format citations and generate a bibliography:

In OpenOffice Writer, go to the EndNote menu and select Format Bibliography.1.

On the Format Bibliography tab, change or verify these settings  
 
With output style: Select the appropriate output style to format references. You can experiment by 
reformatting with various output styles. To select a style not on the list, click the Browse  button. To 
add more output styles to the list, see Adding Styles to the Output Styles Menu. To install more 
EndNote styles, see Installing Additional Output Styles.  
 
Temporary citation delimiters: These  are the opening and closing delimiters for temporary 
citations. Make sure they are unique delimiters, and not characters you would normally use in your 
paper. The defaults are curly braces.

2.

On the Layout tab, change or verify these settings:  
 
Font and Size: These are the text font and size used for the bibliography.  
 
Bibliography title: To print a title at the top of your bibliography, type the title in this text box. It will 
always be centered; if you do not want it centered, leave this blank and use OpenOffice Writer to 
insert a title above the bibliography.  
 
Text Format: Highlight  the bibliography title text and then use the Text Format  button to display a 
dialog where you can change the font format of the highlighted text.  
 
Start with bibliography number: Enter a number if you want the starting number for a numbered 
bibliography to be something other than the default.

3.

Click OK to save the changes and format your citations and bibliography.4.

Note: You do not have to verify each tab every time you format. If all you want to do is change the output 
style, select Format Bibliography, select the output style on the Format Bibliography tab, and click OK.

If you add more citations to your paper after the formatting process, you can update the citations and the 
bibliography by selecting the Format Bibliography command again.

Note: You do not need to unformat your citations in order to reformat them.

To reformat your paper in a different style:

In OpenOffice Writer, go to the EndNote menu and select Format Bibliography.1.
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Directly Editing Bibliographies in OpenOffice Writer

Deleting Bibliographies in OpenOffice Writer

Setting Cite While You Write Preferences in 
OpenOffice Writer

Select a new style from the Format Bibliography dialog and click OK.2.

Your citations and bibliography are updated for the new bibliographic style. See Adding Styles to the Output 
Styles Menu for  information about expanding the list of available styles. See Installing Additional Output 
Styles for information on installing more styles.

It is always best to make changes to your final bibliography by correcting the data in the EndNote library, 
editing the output style you are using, or adding or deleting citations from your paper. Then, after making the 
necessary changes, format the bibliography to automatically make the corrections.

It is not always possible for EndNote to format the bibliography exactly as needed, so you might need to 
manually edit the formatted bibliography. If you must do this, remember that if you reformat a paper after 
editing the bibliography, EndNote will not preserve your edits. When EndNote reformats a bibliography, it 
deletes the existing one and puts a new one in its place.

You can edit the bibliography as you would any text. If you later reformat the paper, your edits will be gone.

See Modifying Style Templates for more information.

To delete a bibliography, select the bibliography and then delete it.

Make sure you drag the cursor from the line above the bibliography to the end of the bibliography in order to 
select the entire bibliography bookmark, or use the Navigator to select the EndNote Bibliography bookmark 
and delete it. Press the Backspace or Delete key.

To access and set Cite While You Write preferences, in OpenOffice Writer go  to the EndNote  menu and 
select Cite While You Write Preferences.

Open EndNote When Starting Apache OpenOffice Writer: Select this item to always open EndNote when 
you start OpenOffice Writer.

Close EndNote When Leaving Apache OpenOffice Writer: Select  this item to always close EndNote 
when you leave OpenOffice Writer. This works only when the EndNote program was launched with one of 
the Cite While You Write commands from within Writer or if the Open EndNote When Starting 
Writer preference is selected.

For information about other EndNote preferences that directly affect Cite While You Write, see Related 
EndNote Preferences.
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Editing a Reference in the Library with OpenOffice Writer

Deleting a Reference from the Library with OpenOffice 
Writer

Record Numbers

You may insert a citation into an OpenOffice Writer  document, and then later edit the corresponding 
reference in EndNote. Are those changes reflected in your Writer document?

Your citations and bibliography will reflect the edits the next time you reformat the paper with the EndNote 
library  open. Open your document, open your EndNote library, and select Format Bibliography  from the 
EndNote menu in OpenOffice Writer. EndNote will not be able to make the update if the library is not open 
during formatting.

The first time a citation is formatted, EndNote uses information from the unformatted citation to look in the 
open library and find the corresponding reference. If you later reformat, EndNote again looks in the library 
for that reference.

If you have deleted the corresponding reference from the EndNote library and unformatted the citations, 
EndNote will not be able to find the reference information for formatting.

If you add the reference to the library again, it will be assigned a different record number. You would need to 
reinsert the citation with OpenOffice Writer.

EndNote assigns a unique record number to each reference as it is added to your library. These record 
numbers appear in temporary citations to ensure that the correct reference is used when the paper is 
formatted:

{Argus, 1991 #11}

See Components of a Temporary Citation for more information on record numbers in temporary citations.

The record number for a reference is also visible in the title bar of the Reference panel.

Note that:

EndNote automatically assigns a record number sequentially to each reference as it is added to a 
library.

▪

If the same reference appears in two different libraries, the record numbers will most likely be 
different.

▪

If the same reference appears in two synced libraries or a library shared through EndNote Sync, the 
record numbers will most likely be different. This is because as the references are synced to the 
copy of the library on the new computer, they will be assigned new record numbers.

▪

Record numbers are never reused or reassigned within a library. When you delete a reference, the 
corresponding record number is never used again in that library.

▪
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Saving Files for Other Versions of Writer and Other Word 
Processors

You cannot modify or reassign record numbers.▪

We recommend that you not rely on EndNote’s  record numbers as a means of filing or numbering 
your office reprints, because you have no control over this number. Instead, enter your own unique 
number into the Label field, and use that number for your reprints.

▪

You can directly share your OpenOffice (ODT) files with colleagues.

If you want to convert your document for use with a previous version of Writer or a different word processor, 
you should Unformat Citations before saving in the different file format. Then, you may be able to reformat. 
The corresponding EndNote library (or libraries) must be available in order to reformat.

Of course, if you just want to print a copy of the paper for someone, you do not need to do anything to your 
document other than print it!

It is possible to use references from an EndNote library a colleague has shared with you through EndNote 
Sync, or with a synced copy of your own EndNote library on different computers, and more than one library 
can be open and be searched for citations at the same time. A copy of the library citation data OpenOffice 
Writer document, so you can continue to add references and format the bibliography without the original 
libraries being open, so long as the citations are formatted. If you unformat the citations, you will need to 
have copies of the original libraries the citations were inserted from to reformat the bibliography.

If you are inserting citations on only one machine, it is fine to move the document itself to other machines— 
as long as you will be accessing the document with the same version of Writer.

If you open your document with a different version of Writer, or use the Save As command to save a 
formatted copy of your paper in another format, you may lose the ability to format citations in that document.

If you plan to use your document with a different word processor or a different version of OpenOffice Writer, 
you should Unformat Citations before converting the document to the other file format.

Unformatted citations are regular text; however, they are temporary placeholders that do not reflect final 
output. See Unformatting Citations in OpenOffice Writer.

You can unformat citations and then save the document as a Microsoft Word file, as an older version Writer 
ODT file, or as an RTF file. For Word files, see How to Cite While You Write with Microsoft Word to reformat 
the paper. For older ODT files or RTF files, see Basic Instructions for Using Format Paper to format citations 
from these placeholders. You will need the original library, or libraries, the references were inserted from to 
reformat the paper.
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You can convert your Microsoft Word documents to OpenOffice Writer documents, and vice versa. Always 
start by making a backup of the original document!

With the original word processor, make sure you first unformat citations, then save the document, and then 
close the word processor. Then, open the file with the other word processor. You must have the associated 
EndNote library available and open in order to format the citations and bibliography.

Note: If you have both Microsoft Word and OpenOffice Writer open, the Cite While You Write commands 
available within EndNote are active for the word processor that was launched first.

There are several Cite While You Write functions that are available only in Microsoft Word, and not in 
OpenOffice Writer. These include:

Inserting notes. See Including Notes in the List of References in Microsoft Word.▪

Inserting figures and tables. See Finding and Inserting Figures and Tables.▪

Constant background instant formatting. See Instant Formatting in Microsoft Word.▪

Creating multiple bibliographies in a single document with sections. See Creating Multiple 
Bibliographies in a Single Document.

▪

Using a Traveling Library (although the OpenOffice Writer file stores a copy of the data for use in 
formatting, it does not have all the features available in Word's traveling library, such as the ability to 
export the document library to EndNote). See The Traveling Library.

▪
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Word Processor Compatibility for Format Paper

Basic Instructions for Using Format Paper

You can create formatted citations and bibliographies for your papers without using Cite While You Write™ 
for Microsoft® Word or OpenOffice Writer. Use Format Paper to cite references and create bibliographies for 
documents that can be saved as Rich Text Format (RTF) (see Basic Instructions for Using Format 
Paper). Word processors that can create RTF documents, including:

Microsoft® Word▪

OpenOffice Writer▪

LibreOffice Writer▪

Scrivener▪

WordPerfect®▪

WordPad▪

And almost any other application that can save as RTF (Rich Text Format)▪

Note: EndNote uses Unicode to appropriately display diacritics  and other extended characters. If these 
characters do not display correctly when you format EndNote citations and references in your document, 
it may be because your word processor lacks Unicode support. Please refer to your word processor's 
documentation.

To format references and create a bibliography (Cite While You Write) with Microsoft Word , see How to Cite 
While You Write with Microsoft Word.

To format references and create a bibliography (Cite While You Write) with OpenOffice.org Writer, see How 
to Cite While You Write with OpenOffice Writer.

While you can use the Format Paper feature to format Word files saved as RTF or OpenOffice documents 
with the extension ODT, it is much easier and more efficient to use Cite While You Write.

To create a stand-alone bibliography that is not based on the citations in a paper, see Introduction to 
Independent Bibliographies.

For up-to-date requirements and compatibility information, see our Web site at https://endnote.com/.

This topic describes how to create formatted citations and bibliographies for your papers without using Cite 
While You Write™ for Microsoft® Word or OpenOffice Writer.
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Citing References in a Paper

The basic steps are covered here. More details about how to switch between programs and various tips for 
citing references are described in the sections following these basic instructions.

Citing references is a straightforward process of copying temporary citations from EndNote and pasting 
them into your word-processing document. While writing a paper in your word processor, you can have 
EndNote running in the background so that it’s easy to switch between the two programs when you need to 
cite a source. Although you can enter the EndNote temporary citations into a paper at any time, most writers 
find it convenient to enter the citations as they are writing the paper instead of waiting to insert them after 
the text is written.

Note: The Format Paper command works on Rich Text Format (RTF) documents or OpenOffice Writer 
(ODT) documents. See Word Processor Compatibility for Format Paper. You create your paper and insert 
citations with your word processor. You can scan OpenOffice Writer documents directly. When you are 
ready to scan and format citations for other document types, you must first save a copy of your paper as 
RTF, and then scan that copy of the paper. 
 
Cite While You Write is available for OpenOffice Writer 3.x or 4.x documents. See Overview of the Cite 
While You Write Process in OpenOffice Writer.

To practice using the Format Paper feature, you can follow this procedure using one of the example 
documents found in the EndNote C:\Users\Public\Documents\EndNote\Examples  folder. We recommend 
experimenting with the Sample_RichText.RTF or Sample_OpenDocType.ODT file.

To cite a reference in a paper:

Start your word processor and open the paper you are writing. As an example, you can locate and 
open Sample_RichText.RTF found in the C:\Users\Public\Documents\EndNote\Examples  folder. If 
you use OpenOffice Writer, you can use Sample_OpenDocType.ODT as an example.

1.

When you are ready to cite a source, position the cursor in the text where you would like to put the 
citation. 
 
      …a commonly documented phenomena |.

2.

Start EndNote and open your library, or libraries, (if not already open). See Opening a Library if you 
need help with this step.

3.

Select the reference(s) in your EndNote library that you want to cite. Press the Ctrl key while clicking 
on the references to select multiple references; press the Shift key to select a range of references.

4.

Select Copy (Ctrl+C) from the Edit menu, then return to your word processor and Paste (Ctrl+V) the 
temporary citation into the text of your document, or drag-and-drop the selected citations from 
EndNote into your paper. The pasted citation appears in EndNote’s  temporary format: first author’s 
last name, year of publication, and record number, all enclosed in curly braces: 
 
     {Wiegrebe, 2008 #60} 
 
If multiple references were selected, their citations appear together within one set of delimiters in the 
order in which they are listed in the Library window. 
 
     {Wiegrebe, 2008 #60;Gorresen, 2018 #2469}

5.
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This citation is not the final citation, but rather a temporary citation that will be formatted later. The number in 
the temporary citation is not a bibliography number but a unique record number. When you format this 
paper, EndNote builds a bibliography based on the temporary citations that it finds in the paper, and 
reformats them according to the selected style.

Continue following steps 2-5 to insert citations as you write your paper.

To save your document:

When you have finished adding citations, save the changes to your document.1.

If the file you created is not an OpenOffice Writer document or an RTF document, save a copy of the 
file as RTF. From the File menu, select Save As. In the file dialog, set the type of file as RTF. RTF 
retains most styles and formatting.

2.

Close your document. You can leave your word processor running.3.

To generate the bibliography:

Return to EndNote.1.

Select Format Paper from the Tools menu, then Format Paper… (If you have previously formatted a 
paper and want to reformat it, you can also select it from the list of previously formatted papers.)

2.

Navigate to the RTF or ODT file you created, and select it.3.

Click the Open button. 
 
EndNote opens the Citations dialog and begins scanning the open library, or libraries, for matches to 
the temporary citations in the document. When scanning is complete, The Citations dialog lists the 
citations found in the paper together with the number of matching references in the open libraries. 
See The Citations Dialog for Format Paper. 
 
The citations in the Citations dialog appear in the order they are cited in the paper. If a reference is 
cited more than once in a paper, it is listed more than once in this dialog; however the reference will 
appear only once in the bibliography. 
 
Every citation listed in the Citations dialog should have a "1" next to it in the Matches column, 
meaning that EndNote found exactly one reference in the open library, or libraries, to match the 
citation in the paper. When all of the citations in the window have a "1" next to them, you are ready to 
go on to the next step of formatting a paper. If a "0" or a number greater than one appears in the 
Matches column, you may need to resolve mismatched citations.

4.

Check the Citations dialog to make sure that EndNote was able to find matching references for all of 
the citations.

5.

Select a style from the Output Style menu  on the Citations dialog. Enter a starting bibliography 
number if you wish. 
 
The individual styles listed are the styles that are currently selected as your "favorites" in the Style 
Manager. If you need to choose a style that is not in the list, choose Select Another Style… (If you 

6.
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Tips on Citing Sources

Temporary vs. Formatted Citations

chose Select Another Style…, select a style from the list and click the Choose button). If you do not 
see the style you want in the full list of installed styles, see Installing Additional Output Styles.

In the Citations dialog, click Format  to have EndNote create a copy of your paper complete with 
formatted citations and a bibliography.

7.

You are then prompted to name and save the formatted copy of the paper. 
 
By default, EndNote adds the name of the output style to your existing filename to create the new file 
name. You can change the name of the formatted document by typing a new name in the text box. 
You can also change the location where EndNote saves the file. By default EndNote saves the 
formatted file in the same location as the unformatted file.

8.

Caution: Never save the formatted paper with the same name as the original unformatted 
document. The unformatted document is needed if you ever want to format the paper again.

While EndNote is formatting, the cursor changes to a wait cursor. When the formatting has finished, the 
cursor returns to an arrow and the Citations dialog remains open. Now that EndNote has generated a 
formatted copy of the paper, you can open that paper in your word processor.

Switch to your word processor.1.

Select Open from the word processor’s File menu, and then select and open the formatted version of 
the paper. Remember that you want to open the file that has the name of the style appended to the 
file name (or the new name you assigned, if you changed the name). 
 
In the formatted paper, EndNote has replaced the temporary citations with formatted citations and 
inserted a bibliography.

2.

If you need to make changes to the paper (such as to change a citation or add more text), you should edit 
the original unformatted document, and then format it again. EndNote will generate a new formatted copy of 
the paper. See Reformatting a Paper.

A "citation" is the bibliographic information in the body of a paper that refers the reader to a complete 
reference in the bibliography. Normally a citation consists of a bibliography number or the author and year in 
parentheses:

... of the species at hand.1

... of the species at hand.(Argus, 1991)

When you first copy an EndNote citation and paste it into your paper, it appears in EndNote’s  temporary 
citation format. This format consists of the first author’s  last name, year, and the EndNote record number, 
with citation delimiters at each end.

{Author, Year #Record Number}
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Multiple References in One Citation

Citing References in Footnotes or Endnotes with Format 
Paper

When EndNote formats this paper it replaces the temporary citations with formatted citations.

Temporary Citation:  {Argus, 1991 #11}
Formatted Citation (in APA): (Argus & Matthews, 1991)

EndNote relies on the temporary citations to determine which references to include in the bibliography. 
During formatting, EndNote scans your word-processing document for temporary citations, finds their 
matching references in the EndNote library, and creates a duplicate of your document complete with 
formatted in-text citations and a bibliography at the end. This new document is called your "formatted" 
paper.

Note: By default, citation delimiters are curly braces. If you have other text within curly braces, you may 
want to change your citation delimiters.

If you need multiple references in one in-text citation, you can accomplish this in one of two ways. One 
option is to insert all of the citations together:

To insert multiple citations:

In EndNote, hold down the Ctrl  key while clicking on the desired references in your library (or hold 
down the Shift key to select a continuous range of references).

1.

From the Edit menu, select Copy (Ctrl+C).2.

Position the cursor in your word processing document where you want the citations, and select 
Paste (Ctrl+V) from the Edit menu.

3.

The citations are inserted together in one set of delimiters. Once formatted, they appear in one multiple 
citation, sorted as your bibliographic style requires:

Unformatted: {Hall, 2020 #90; Baker, 2015 #38}
Formatted: (Baker, 2015; Hall, 2020)

The other option is to add the citations to the paper individually. EndNote merges adjacent citations 
automatically during the formatting process. Citations do not merge, however, if any character, including 
spaces or punctuation, separates them.

Unformatted: {Hall, 2020 #90}{Baker, 2015 #38}
Merged when Formatted: (Baker, 2015; Hall, 2020)

Note: If one of the citations in a multiple citation cannot be matched during formatting, the entire citation 
will remain unformatted.

Once you have created a footnote or an endnote in your word-processing document, you can cite 
references in the footnotes or endnotes just like you cite them in the body of the text.
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Typing Citations into Your Paper in Rich Text Format (RTF) 
Files

Record Numbers

Record Numbers When Using Format Paper

To cite references in footnotes:

In your EndNote library, select the reference(s) that you would like to cite and select Copy (Ctrl+C) 
from the Edit menu.

1.

Create the footnote or endnote using the appropriate command in your word processor. EndNote 
does not actually create the footnote or endnote in the document, but it is used to insert and format 
the citations in the notes.

2.

Position the cursor in the footnote or endnote in your paper where you would like the citation(s) to 
appear and select Paste (Ctrl+V) from the Edit menu.

3.

Note: You can edit a full reference footnote citation to exclude author name, year, or author/year. Note 
that the Author(Year) option does not apply to footnotes. See Components of a Temporary 
Citation and Examples of Modified Citations for information on customizing temporary citations.

The EndNote style that is selected in the Citations dialog determines how the citations in the footnotes or 
endnotes will be formatted. EndNote can format these citations as brief in-text citations or like the complete 
references in the bibliography. It can also create a special format specific to footnotes or endnotes, including 
options like "Ibid." and other variations of shortened references when a citation appears more than once in 
the footnotes or endnotes.

Manually entering citations is the same whether you are using Format Paper with an RTF file or Cite While 
You Write with Microsoft Word. See these topics:

Notes About Temporary Citations▪

Components of a Temporary Citation▪

Omitting Authors or Years from Citations▪

Citation Prefixes▪

Citation Suffixes▪

Including Semicolons and Other Citation Delimiters in a Citation▪

Examples of Modified Citations▪

EndNote assigns a unique record number to each reference as it is added to your library. These record 
numbers appear in the temporary citations to ensure that the correct reference is used when the paper is 
formatted:
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Deleting References in the Library

Formatting Citations and Creating 
Bibliographies

The Citations Dialog for Format Paper

{Argus, 1991 #31}

The record number for a reference is also visible in the title bar of the Reference panel.

You may also see record numbers in the Library window by selecting Record Numbers as one of the display 
fields for the Library window. See Display Fields Preferences.

Because these record numbers are so important, keep the following points in mind:

We recommend that you do not rely on EndNote’s record numbers as a means of filing or numbering 
your office reprints, because you have no control over this number, and it is subject to change under 
certain conditions (read on). Instead, enter your own unique number into the Label field, and use that 
number for your reprints.

▪

EndNote automatically assigns a record number sequentially to each reference as it is added to a 
library.

▪

If the same reference appears in two different libraries, the record numbers will most likely be 
different.

▪

The record numbers are never reused or reassigned within a library. If you delete a reference, that 
number is never used again in that library.

▪

You cannot modify or reassign record numbers.▪

When you sync a library, or share a library through EndNote Sync, the record numbers will likely be 
different on different computers. This is because EndNote is syncing the references to a new library 
on the new computer, and each reference is assigned a new number as it is synced to that computer.

▪

You can set EndNote to use the Label, Accession Number, or Pages field instead  of the record 
number when inserting or copying temporary citations into word-processing documents using the 
Temporary Citations preferences in EndNote. This can alleviate problems arising from different 
record numbers for the same reference when working with synced libraries and Format Paper. See 
Temporary Citations Preferences.

▪

If you delete a reference from your library after you have cited it in a paper, EndNote will not be able to find it 
when it tries to format that paper. If you add the reference to the library again, it will be assigned a new, 
different record number, so EndNote still will not be able to find it when formatting your paper. You will need 
to reinsert the citation into the paper using the new reference in your library.

The Citation Matches dialog opens  in the EndNote program when you format a paper. It lists all of the 
citations found in a document, in the order in which they appear in the paper.
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Ambiguous Citations (Matches Greater than 1)

Unmatched Citations (A "Zero" Match)

Correcting Mismatched Citations

In the Citations dialog, EndNote brings special attention to unmatched and ambiguous citations. You can 
choose from the checkbox options to show only the Matched Citations, Unmatched Citations, or Ambiguous 
Citations.

The Citations dialog lists all of the citations found in the document and displays the number of matching 
references for each citation. If any number other than a 1 appears in the Matches column, the 
corresponding citation will be left unformatted in the document and will not be included in the bibliography 
EndNote generates.

A number greater than 1 indicates that multiple references in the currently open library (or libraries) match 
the citation and EndNote does not know which reference to use. (EndNote automatically checks the 
matching references to see if any are duplicates. If so, they are not listed as separate possible matches.) To 
see which references are considered matches, highlight the citation in the Citations dialog and click Lookup. 
Reinsert the correct citation into the paper.

A zero in the Matches column indicates that there is no matching reference in any open library for that 
particular citation. The Author, Year, and Record Number (if used in the temporary citation) must all match 
the Author, Year, and Record Number of a reference in an open library in order for EndNote to consider it a 
match.

If text in your document is surrounded by citation delimiters (such as "{sic}), EndNote will treat the text as a 
mismatched citation. You can ignore the warning about it being a mismatched citation, and EndNote will 
leave the text as it was before formatting. (You could also change the Citation Delimiters, see Temporary 
Citation Delimiters.)

Uncheck the Unmatched Citations box at the top of the Citations dialog to hide these items from view if you 
have numerous sections of bracketed text in your document and the corresponding unmatched citations are 
just cluttering the Citations dialog.

Mismatched citations must be corrected either in the word-processing document or in the EndNote library— 
whichever contains the incorrect information. Normally, the easiest way to fix a mismatched citation is to 
search the word processing document for the mismatched citation, delete it, and then reinsert the citation 
from the library.

If there is a citation for which EndNote lists multiple matches, you can highlight the citation in the Citations 
dialog and click Lookup. EndNote displays the matching references in the Library window. You may then 
select the appropriate reference and reinsert it into the paper. Mismatches of this type are only possible 
when the record number has been omitted from the temporary citation in the text.

After you have corrected the mismatched citations and saved your changes to the paper, Format  again. 
(The Citations dialog is still available after formatting if you want to see the list of citations.)

The best way to avoid citation mismatches:

Keep all of your references in one main library.▪

Copy and paste your citations from EndNote to your word processing documents instead of typing 
them.

▪
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Bibliographic Styles and Format Paper

Previewing Formatted References or Styles

Reformatting a Paper

Reformatting with Different Styles

The bibliographic style determines how EndNote formats the citations in your paper and the references in 
the bibliography. The style takes care of all text styles, punctuation, and sorting required for the citations and 
bibliography, as well as which fields are included in the bibliography.

Select a style on the Citations dialog after selecting Format Paper. You can always run Format Paper to 
select a different style and reformat your unformatted (original) RTF document at any point. See Formatting 
the Citations and Bibliography.

The EndNote Styles collection includes more than 7,000 styles, all of which can be modified to meet your 
specifications. You can also create completely new styles, if necessary.

See also

Adding Styles to the Output Styles Menu▪

Installing Additional Output Styles ▪

Introduction to Output Styles▪

Previewing Formatted References or Styles▪

The Preview subpanel in the Reference panel of the Library window displays how the currently selected 
reference will be formatted in the bibliography by the current style. This Preview subpanel shows only one 
reference at a time.

To preview how multiple references will appear in a bibliography:

Select the references in the reference list.1.

From the Tools menu, select Output Styles and select the style that you would like to use.2.

From the References menu, select Copy Formatted Reference (Ctrl+K).3.

Paste (Ctrl+V) the selected references into a word processor document to see how they would look 
formatted with the selected style.

4.

Since EndNote creates a copy of the paper during the formatting process, you can always reformat the 
original document, if necessary, to create a new document with the changes that you need.

The appearance of both the in-text citations and the bibliography in the formatted paper is determined by the 
selected style. If you need to create a copy of your paper in a different style than what you did originally:
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Adding New Citations to Formatted Papers

Creating One Bibliography From Several Papers

From the Tools  menu in EndNote, select Format Paper  > Format Paper. Open the original 
unformatted copy of your paper (the one with the EndNote citations surrounded by curly braces or 
brackets).

1.

On The Citations Dialog for Format Paper, select a new output style from the Output Style  drop- 
down list. You can select one of the "favorite" styles currently in the list or choose Select Another 
Style…  to pick a style from the styles installed on your computer. See Installing Additional Output 
Styles for information on installing more styles.

2.

If the Citations dialog shows that all the citations in the paper are correctly matched, click the Format 
button.

3.

EndNote will prompt you to name and save the new formatted copy of the paper. Notice that the style 
name is included as part of the new paper’s name. That will help you distinguish between various 
copies of one paper.

4.

When you open the new formatted copy of your paper, you should see that your citations and bibliography 
use the new bibliographic format.

Note: When you need to make changes in your paper, remember to work only with the unformatted copy 
of the paper (the one with the bracketed temporary citations), rather than the formatted copy that EndNote 
created.

If you have already formatted your paper, and you see that it needs to be edited by either adding or 
removing citations, you must return to the original, unformatted copy of the document (the one with 
EndNote’s temporary citations). Open that document in your word processor. Add, modify, or delete citations 
as necessary, and then save the paper as RTF. You may now format the paper (as described above) to 
create an updated copy of it.

EndNote can format a series of separate word processing documents and put a cumulative bibliography at 
the end of the last one. This is useful if you are collaborating with other EndNote users and you have each 
written a separate part of the paper or if you have separated a lengthy paper into different chapters.

To create one bibliography from several papers:

From the Tools menu, select Format Paper > Format Paper to open and scan the first paper.1.

A Scan Next button appears in the Citations dialog (see The Citations Dialog for Format 
Paper). Click Scan Next  in the dialog to open each of the subsequent papers in the correct order. 
Each paper’s citations will be added to the list of citations in the Citations dialog.

2.

When the last paper has been scanned, select an output style  in the Citations dialog and click 
Format.

3.

During the formatting process, EndNote makes a formatted copy of each paper and puts a cumulative 
bibliography at the end of the last paper. Only the last paper in the series will include the bibliography. By 
default, each formatted paper retains its original name with the style name incorporated into it; however, you 
have the option to change the names.
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Specifying the Starting Number of a Bibliography with 
Format Paper

Copying Formatted References

Rescanning the Paper

When you select Format Paper to display a Citations dialog, EndNote includes an output style list to confirm 
or change the style that should be used to format the paper. It also gives you the option to change the 
starting number for your citations and bibliography.

If you would like EndNote’s numbering to start with a number other than "1" for the document that you are 
formatting, enter that number here. This setting is ignored if you are formatting the paper with a style that 
does not create numbered references in the bibliography.

There may be times when you want to insert a fully formatted reference into the body or footnotes of your 
paper without having to format an entire document.

To insert a fully formatted reference:

Select Tools > Output Styles and select the style you want from the list. If you do not see the style 
you want, select Open Style Manager  and mark the style you want added to the list. The Style 
Manager will show all styles installed on your computer. If you do not see the style you want in the 
Style Manager, you can install more styles, see Installing Additional Output Styles.

1.

Select the reference(s) to copy.2.

Select Copy Formatted Reference (Ctrl+K) from EndNote’s References menu.3.

Switch to your word processing document, position the cursor in the text, and select Paste (Ctrl+V) 
from the Edit menu.

4.

If your word processor supports drag-and-drop, you may also drag the references and drop them on your 
paper with the Ctrl  key pressed. This produces the same results as using the Copy Formatted Reference 
command.

Multiple references are sorted according to the rules of the selected style. Fonts and character styles are 
transferred if you are pasting into a program that interprets styled text or Rich Text Format (RTF) information 
on the Clipboard.

If there is a problem with your citation matches after selecting Format Paper, leave the Citations dialog open 
and switch to your word processor to make the necessary changes. After saving your changes, close your 
document and switch back to EndNote. On the Citations dialog, click Rescan.

EndNote then updates the information in the Citations window to reflect the recent changes made to the 
paper.
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Managing Your EndNote Library

Modifying References in Your Library

Finding EndNote References for Editing When Using 
Format Paper

Formatting with Multiple Libraries

Finding and Labeling References Used in a Paper

If you add or change a reference in your library  while the Citations dialog is open, make sure you click 
Rescan to have those changes reflected in the Citations dialog and in the formatted paper.

For example, if you typed the citation {Geoffery, 1988} into your paper but forgot to enter the reference in the 
library, EndNote would list a 0 in the Matches column for that citation on the Citations dialog. You can leave 
the Citations dialog open and enter the Geoffery reference into your library. Bring the Citations dialog 
forward and use the Rescan button to recheck the library for matching references. This should change the 
"0" match to a "1."

In the Citations dialog, you can select any number of matching references and then click Lookup to search 
and display those references in EndNote’s Library window. If you edit a reference, make sure you Rescan 
your paper to reflect the changes.

Although EndNote can format papers using references from more than one library, we do not recommend 
that you use multiple libraries when writing a paper. Keeping all of your references together in one library 
simplifies the writing process because you know exactly where to find each reference, and you only need to 
have the one library open when formatting.

If you are collaborating with other authors on a document, however, using multiple libraries for a paper may 
be a useful and necessary thing to do.

If citations have been inserted into one document from multiple libraries, all of the necessary libraries must 
be opened in order for  EndNote to format the paper correctly.

Note: Read about the Merge Duplicates in Bibliography  preference if you plan to insert citations from 
more than one library into a paper.

The Citations Dialog for Format Paper appears when you format a word processing document. It lists all of 
the citations found in a document, and displays the number of matching citations found in the currently open 
libraries.

The Citations dialog is visible in the EndNote program after the formatting is finished or if the formatting 
process is canceled. (If there are problems during formatting, consult the Citations dialog. This information 
can help you resolve problems.)

Double-click  citations, or select a citation and click the Lookup  button, in the Citations dialog to find the 
matching references in your EndNote library.
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Working on Different Computers

To locate all of the references in a library that were cited in a paper:

After formatting your paper, select all of the citations listed in the Citations dialog by selecting the first 
citation in the list, holding down the Shift key and scrolling to the bottom of the list to select the last 
citation in the list.

1.

Click the Lookup button to display the list of references in the Library window. (Note that it can only 
show references from one library in the window.)

2.

To add a keyword to all of these references for your own filing purposes:

Select Change/Move/Copy Fields from the Library menu.1.

On the Change Fields  tab, select the Keyword field  (or any other field you want to use) from the 
drop-down list of fields.

2.

Enter the term or phrase you want to use to identify these references, select any Change options you 
want (such as inserting a space before the new text if you are adding it at the end of the field), and 
click OK.

3.

Note: Any changes made using the Change/Move/Copy Fields command are permanent and there is no 
undo option. We strongly suggest making a backup copy of your library before using this command. 
See Saving a Compressed Copy of a Library and Saving a Copy of a Library for options for backing up 
your library.

If you are working on a paper on different computers, be sure to keep a copy of your reference library on the 
same disk as your paper. That way, you will always access the same library when inserting citations. If you 
add references to a copy of the library at home and to a different version at work, the record numbers may 
not match, and EndNote will be unable to find references when it scans your paper.

Libraries synced to multiple computers or libraries shared through EndNote sync will have different record 
numbers than the original library, so using synced libraries is not suggested for use with Format Paper. See 
Record Numbers.

Note: A compressed library will have the same record numbers as the original library. Although a working 
EndNote library should not be kept in a cloud-syncing folder or drive, a compressed library can be stored 
in one. Just remember to make a copy of it outside the cloud-syncing folder or drive, then open the copy 
that is outside the syncing folder or drive to work.
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Independent Bibliographies and 
Exporting References

Introduction to Independent Bibliographies

Styles Determine the Look of the Bibliography

Introduction to Exporting References

There may be times when you want to create a bibliography without an associated paper. We call this an 
"independent bibliography" because EndNote does not generate the bibliography based on citations found 
in a paper—instead, the bibliography is generated independently of a paper.

Any one of the procedures described in this section can be used to create an independent bibliography. 
Each has its own advantages, so look for the option that best suits your needs:

Drag-and-drop to instantly transfer a bibliography to a word processing document.▪

Copy formatted references from a library and paste them into a word processing document.▪

Export references from a library as RTF, Text Only, or HTML.▪

Preview and/or Print references from EndNote.▪

The appearance of your independent bibliography depends entirely on which EndNote style is selected. The 
styles determine what information is included in the bibliography, how it is arranged, and what punctuation 
and text styles are used.  Select a style that meets your needs before exporting, printing, or formatting 
references.

To select a style, select Output Styles from the Tools menu. You will see a list of "favorite" styles. This list is 
based on a short list of popular styles, with your personal favorites added as you use them. If you do not see 
the style you need in the favorites list, select Open Style Manager from the Tools > Output Styles submenu, 
and mark the styles you want added to the favorites list. For more information, see Adding Styles to the 
Output Styles Menu. For information about modifying styles, see Modifying Style Templates.

The Style Manager shows all the styles installed on your computer. By default, EndNote installs only the 
more popular styles, but you can install more. For more information, see Installing Additional Output Styles.

EndNote can export references in formats that can be imported into databases or other bibliographic 
applications. The process is the much the same as exporting references in an independent bibliography, but 
the style used must be one that can be imported into the other program. See Exporting References as an 
Independent Bibliography and Exporting References for Database Import.

Page 249 of 586

 



Clarivate EndNote 20 User Help Guide

Using Drag-and-Drop to Create an Instant 
Bibliography

The Copy Formatted Reference Command

"Drag-and-drop" is a way of moving or copying selected text (or other items) by clicking on the text and 
dragging it to a new location. Simply release the mouse button when the cursor is over the destination, and 
the text will either be moved or copied to the new destination.

If your word processor supports drag-and-drop, you can drag a bibliography from EndNote directly into your 
paper.

To drag your bibliography:

Open your library and select the desired references.1.

Select the necessary style from the Output Style submenu of EndNote’s Tools menu.2.

Hold down the Ctrl  key as you drag the references from the library and drop them directly onto a 
word processing document in the background.

3.

This creates a fully formatted bibliography with the references formatted and sorted according to the 
selected style. The font used for the bibliography in this case is the EndNote default font. You can change 
the font in your word processor.

If your word processor does not support drag-and-drop, see The Copy Formatted Reference Command.

Note:  Dragging with the Ctrl  key pressed transfers the formatted references to the word processing 
document. If you do not hold down the Ctrl key, only the temporary citation is transferred. Use this latter 
method to cite references in your paper.

Use the Copy Formatted Reference command to quickly create and copy a bibliography that you can paste 
into a word-processing document. The references are sorted and formatted according to the rules of the 
selected style.

The font used for the Copy Formatted Reference command is the default EndNote display font, which can 
be changed in your word-processing document. All text style information (such as bold and italic) is retained 
if you paste into a program that recognizes RTF (Rich Text Format) or styled text.

To copy formatted references from EndNote and paste them into a word processing document:

Note: If EndNote runs out of memory during this procedure, and you are trying to format 50 or more 
references, select fewer references to copy at one time, or use the drag-and-drop or Export methods 
described in this chapter.

On the toolbar, go to the Output Style list and select the necessary style.1.

Select the desired references in EndNote.2.
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Exporting References as an Independent 
Bibliography

From the References menu, select Copy Formatted Reference (Ctrl+K) to copy the references to the 
Clipboard.

3.

Open a document in your word processor, and select Paste (Ctrl+V) from the word processor’s Edit 
menu.

4.

Exporting bibliographies from EndNote is easy and flexible. When you export from a library, EndNote 
creates a file of references formatted according to the chosen style.

You can export either all of the references in the current references list, or only the selected references in 
the current list. If any references in the Library window are selected, the EndNote export dialog gives you 
the option of exporting just those selected references.  

To export a bibliography from EndNote:

Open the library from which you will export, and select the references you want to export.1.

To export all of the references in the library, click the All References group.▪

To export a subset of references, select a group or perform a search to show the subset of 
references you want to include. You can further limit the list of references to export by selecting 
just those references from the current reference list.

▪

(Optional)  References will be exported in the order specified by the selected output style. If you want 
to change the sort order, you must modify the output style:

2.

From the Tools menu, select Output Styles, and then Open Style Manager.a.

Select the output style and click Edit.b.

In the left panel of the window, under Bibliography, select Sort Order.c.

Change the current sort order in the right panel. If you want to export references in the order in 
which they are listed in the current Library window, select Order of appearance.

d.

Close and save the output style with a new name. Make a note of the new name so you can 
select it in step 5.

e.

From the File menu, select Export.3.

From the Save as type  list at the bottom of the dialog, select the type of file to be exported. 
See Supported Formats for Export for more information on file types.

4.

From the Output style  list at the bottom of the dialog, select a style from your favorites, or choose 
Select Another Style… to choose from all installed output styles.

5.

Select the Export Selected References option, if desired. If you want to export all of the references in 
the current  list, clear the checkbox.

6.
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Creating Annotated Bibliographies

The Abstract, Notes, and Research Notes Fields

Modifying a Style to Create an Annotated Bibliography

Navigate to the folder where you want to save the file, enter a name for the exported file, and click 
the Save button to save the file.

7.

Note: The Export feature creates a new file; it does not append to an existing file. If you enter the name of 
a file that already exists, that file will be overwritten.

Open the exported file in a word processor to edit or print it. At this point, the file is just like any other 
text document. You can change the font, margins, line spacing, or other page layout features if 
necessary. (If you use the Open command in your word processor, make sure that the open file 
dialog is set to show files with the correct extension.)

8.

If you exported the references in HTML format, your exported reference list is ready to be posted 
directly to your Web site. In your Web browser, set encoding to "Unicode-UTF 8 to appropriately 
display extended Unicode characters.

9.

Note: The Export command exports only text; images are not included.

Annotated bibliographies include information beyond the standard bibliographic information. They may also 
include the abstract (the Abstract field), research notes (the Research Notes field), or other notes about the 
references (the Notes field).

To create a basic bibliography that includes abstracts, you can use the Annotated style  included with 
EndNote. The Annotated style is based on the Author-Date style, and creates an alphabetical listing of the 
references (by author), with the abstract appended to each reference.

To create a custom annotated style, see the information below.

The fields most frequently used in annotated bibliographies are the Abstract, Notes, and Research Notes 
fields. You may add any of these fields to a style to create a custom style for your annotated bibliography.

Abstract: Use this field to include an abstract of the reference material. When importing data from 
an online database, the abstract will be imported, if available.

▪

Notes: Use this field for general notes about the reference material. When importing from an online 
database, data that does not belong in a predefined field, but which might be of interest, is imported 
into the Notes field. This information may inclued variations on author names, information on related 
materials, information on photographs included in the material, etc.

▪

Research Notes: Use this field for your personal research notes and observations about the 
material. EndNote will never import data into the Research Notes field; it is reserved for your notes 
only.

▪

For this example, we will modify the APA 7th style to include the Research Notes field. (This type of style 
would be useful if a professor requested an annotated bibliography with all your personal notes on the 
references you plan to use for a thesis or dissertation.)
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Printing and Previewing References

Important Points about Printing

From the Tools menu, select Output Styles, and then select Open Style Manager.1.

Select the APA 7th (or the style of your choice) style, and then click the Edit button to open the style 
for editing.

2.

Select Layout  from the options under the Bibliography  heading and click in the text box under the 
"End each reference with" heading. Text or fields inserted into this section appear at the end of each 
reference in the bibliography.

3.

To insert the research notes on a new line after each reference: select End of Paragraph  from the 
Insert Field list. This will ensure the contents of the Research Notes field will appear on a new line 
beneath the bibliographic data.

4.

There are options available for quick insertion on the Insert Field list, including the Abstract and 
Notes fields, but the Research Notes field we need is not on the list. The field can still be added by 
typing it in manually, being very carefull the name is entered exactly as it shows in the Generic 
reference type. In this case, "Research Notes" without the quotations marks.

5.

(Optional) If you want an extra line break after the Research Notes, you can use the Insert Field list 
to add it at the end of the End each reference with text box.

6.

From the File  menu, select Save As  and give the style a new name, but keep the .ens extension. 
Your new style will be saved in an \\EndNote\Styles folder in your documents folder. By storing your 
custom styles in your documents folder, EndNote ensures they will not be removed if you uninstall 
EndNote or install a new version of EndNote that might overwrite the program styles.

7.

Close the style.8.

The new style will now appear in the Output Styles submenu of the Tools menu. If you format a paper, print, 
or export references using this style, the research notes will be included in the bibliography.

Note: Some styles, such as the APA styles, are set to have a hanging indent for each paragraph. This 
means that each new line will start at the left margin and the subsequent lines in that paragraph will be 
indented. To adjust the Hanging Indent settings in your custom style, see Hanging Indents.

To print references directly from EndNote, go to the File menu, and then select Print (Ctrl+P) to send a copy 
to your printer. Or, select Print Preview to format references onscreen. These are quick ways to view your 
formatted references on paper or onscreen—no special page layout options are provided. Typical uses 
might include trying out various output styles, printing a list of references to take to the library  with you, 
printing your notes, or generating a complete printout of the references in an EndNote library.

You can print either the selected references or all references showing in the list.

In addition to the selected style, the appearance of the printed references is determined by the following 
items:
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Printing Instructions

Previewing References

References will be printed in the order specified by the selected output style. If you want to change 
the sort order, you must modify the output style. If you want to export references in the order in which 
they are listed in the current Library window, change the output style's sort order setting to Order of 
appearance.

▪

Each printed page has 1-inch margins, left-justified text, and a header that displays the library name 
in the upper left corner and the page number in the upper right corner. There are no options to 
customize the margins, headers or footers of the printouts. Use one of the other options for creating 
an independent bibliography if you need to modify these aspects of your printout.

▪

The font and size of the printed references are determined by the EndNote display font. Use one of 
the other options for creating an independent bibliography if you need to modify the font.

▪

Select Page Setup from the File menu to specify other printing options, including the paper size and 
page orientation. Page setup options vary depending on the printer used.

▪

To print a list of references directly from EndNote:

Make sure that all of the references you want to print are either selected or showing in the Reference 
List.

1.

From the Tools menu, go to the Output Styles submenu and select a style.2.

(Optional)  References will be exported in the order specified by the selected output style. If you want 
to change the sort order, you must modify  the output style:

3.

From the Tools menu, select Output Styles, and then Open Style Manager.a.

Select the output style and click Edit.b.

In the left panel of the window, under Bibliography, select Sort Order.c.

Change the current sort order in the right panel. If you want to export references in the order in 
which they are listed in the current library window, select Order of appearance.

d.

Close and save the output style with a new name, then select that style.e.

From the File menu, select Print (Ctrl+P).  
 
In the print dialog, specify the number of copies and the range of pages to print. By default, EndNote 
prints only the selected references.  To print all of the references showing in the Reference List, 
change the print range option to All.

4.

Click OK to print the references.5.

To preview a list of references onscreen:

Make sure the references you want to preview are displayed in the Reference List.1.

If you would like to further limit the references to preview, select just those references.2.
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Exporting References for Database Import

Exporting for Other Bibliographic Applications

From the Tools menu, go to the Output Styles submenu and select a style.3.

(Optional)  References will be exported in the order specified by the selected output style. If you want 
to change the sort order, you must modify  the output style:

4.

From the Tools menu, select Output Styles, and then Open Style Manager.a.

Select the output style and click Edit.b.

In the left panel of the window, under Bibliography, select Sort Order.c.

Change the current sort order in the right panel. If you want to export references in the order in 
which they are listed in the current library window, select Order of appearance.

d.

Close and save the output style with a new name, then select that style.e.

From the File menu, select Print Preview.5.

There may be times when you want to share your references with a colleague who is not using EndNote, or 
bring your references into a spreadsheet or advanced database program for analysis. EndNote references 
can be exported in formats for this purpose, thanks to the flexibility of EndNote's output styles. EndNote 
includes several styles suited for imports into other programs, but you can also create your own styles if you 
need to.

Included styles for transferring data to other programs include:

BibTeX▪

BibTeX Using EN Label Field▪

RefMan (RIS) Export▪

EndNote Export▪

Refer Export▪

Tab-Delimited▪

When you export from a library, EndNote creates a file of references formatted according to the chosen 
style. To import those references into another application, choose a style that matches a format the other 
program can import.

You can export either all of the references in the current references list, or only the selected references in 
the current list. If any references in the Reference List are selected, the EndNote export dialog gives you the 
option of exporting just those selected references.  

To export references from EndNote:

Open the library from which you will export, and select the references you want to export.1.

Page 255 of 586

 



Clarivate EndNote 20 User Help Guide

Exporting to Spreadsheets or Databases

To export all of the references in the library, click the All References group.▪

To export a subset of references, select a group or perform a search to show the subset of 
references you want to include. You can further limit the list of references to export by selecting 
just those references from the current reference list.

▪

From the File menu, select Export.2.

From the Save as type list at the bottom of the dialog, select the type of file to be exported. For most 
databases, you will need to use the plain text (.txt) format. See Supported Formats for Export  for 
more information on file types.

3.

From the Output style list at the bottom of the dialog, select a style that matches the format needed 
for the target program. (A large number of programs can import data in the RefMan (RIS) Export 
format, so this is a good choice if you are unsure of the needed format.) If you do not see the style 
you need on your favorites list, choose Select Another Style…  to choose from all installed output 
styles.

4.

Select the Export Selected References option if desired. If you want to export all of the references in 
the current list, clear the checkbox.

5.

Navigate to the folder where you want to save the file, enter a name for the exported file, and click 
the Save button to save the file.

6.

Notes: The Export feature creates a new file; it does not append to an existing file. If you enter the name 
of a file that already exists, that file will be overwritten.  
 
The Export command exports only text; images are not included.

EndNote includes a Tab-Delimited output style  to provide an export format compatible with most 
spreadsheet or generic database programs.

To export references from EndNote in the Tab-Delimited format:

Open the library from which you will export, and select the references you want to export.1.

To export all of the references in the library, click the All References group.▪

To export a subset of references, select a group or perform a search to show the subset of 
references you want to include. You can further limit the list of references to export by selecting 
just those references from the current reference list.

▪

From the File menu, select Export.2.

From the Save as type  list at the bottom of the dialog, select the type of file to be exported. For 
databases, use the plain text (.txt) format. See Supported Formats for Export for more information on 
file types.

3.

From the Output style list at the bottom of the dialog, select the Tab-Delimited style. If you do not see 
the style on your favorites list, choose Select Another Style… to choose it from the list of all installed 
output styles.

4.
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Field Order in the Tab-Delimited Style

Select the Export Selected References option, if desired. If you want to export all of the references in 
the current  list, clear the checkbox.

5.

Navigate to the folder where you want to save the file, enter a name for the exported file, and click 
the Save button to save the file.

6.

Open your spreadsheet or database program. Follow the instructions of your database program for 
opening or importing a tab-delimited file. To add a heading row to the file, see the field list below for a 
list of fields included in the style.

7.

Notes: The Export feature creates a new file; it does not append to an existing file. If you enter the name 
of a file that already exists, that file will be overwritten.  
 
The Export command exports only text; images are not included.

To help you create column headings in your spreadsheet or databases, here are the fields included in the 
Tab-Delimited style, as of this writing, in the order they appear in the style:

Reference Type▪

Author▪

Year▪

Title▪

Secondary Author▪

Secondary Title▪

Place Published▪

Publisher▪

Volume▪

Number of Volumes▪

Number▪

Pages▪

Section▪

Tertiary Author▪

Tertiary Title▪

Edition▪

Date▪

Type of Work▪

Subsidiary Author▪

Short Title▪

Alternate Title▪

ISBN/ISSN▪

DOI▪
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Exporting to EndNote XML

Original Publication▪

Reprint Edition▪

Reviewed Item▪

Custom 1▪

Custom 2▪

Custom 3▪

Custom 4▪

Custom 5▪

Custom 6▪

Custom 7▪

Custom 8▪

Accession Number▪

Call Number▪

Label▪

Keywords▪

Abstract▪

Notes▪

Research Notes▪

URL▪

File Attachments▪

Author Address▪

Figure▪

Caption▪

Access Date▪

Translated Author▪

Translated Title▪

Name of Database▪

Database Provider▪

Language▪

EndNote includes a proprietary XML output format which will allow other EndNote users to import your 
exported data into their library. This format is not designed to work with other bibliographic software 
applications.

The advantage to this format for transferring data between EndNote users is that text formatting such as 
italics, bolding, superscripts, and subscripts will be included. This would not be possible when exporting a 
plain text file, as must be done to transfer to other applications.
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Supported Formats for Export

Formats for Exporting Independent Bibliographies

The data will be Unicode-compliant, so special characters and multiple languages will transfer without 
problems.

To export references from EndNote in the XML format:

Open the library from which you will export, and select the references you want to export.1.

To export all of the references in the library, click the All References group.▪

To export a subset of references, select a group or perform a search to show the subset of 
references you want to include. You can further limit the list of references to export by selecting 
just those references from the current reference list.

▪

From the File menu, select Export.2.

From the Save as type list at the bottom of the dialog, select the XML (.XML) format.3.

Do not select a style from the Output Styles list. This option is irrelevant when saving to XML.4.

Select the Export Selected References option, if desired. If you want to export all of the references in 
the current list, clear the checkbox.

5.

Navigate to the folder where you want to save the file, enter a name for the exported file (keep 
the .xml extension), and click the Save button to save the file.

6.

You now have a file you can give to a colleague who uses EndNote, which can easily be imported into their 
library.

Notes: The Export export feature creates a new file; it does not append to an existing file. If you enter the 
name of a file that already exists, that file will be overwritten.  
 
The Export command exports only text; images are not included.

Use the Export command to create a free-standing bibliography in either of the following formats:

RTF (Rich Text Format)  
 
The RTF export is an ideal way to create a free-standing bibliography that can be edited or printed 
using a word processor. This format can be opened by all popular word processors and preserves 
font and text style information.

▪

HTML  
 
Documents exported in HTML (HyperText Markup Language) provide an easy way to post reference 
lists on the World Wide Web.  
 

▪
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Formats for Exporting to Other EndNote Libraries or Other 
Programs

In your Web browser, set text encoding to Unicode-UTF 8 to appropriately display extended Unicode 
characters in the exported document.

Text File  
 
The Text File export option is suitable for draft purposes or exporting references to be imported into 
another bibliographic database  programs. It is usually used with styles such as EndNote Export, 
Refer Export, RefMan (RIS) Export, or Tab-Delimited, or you can create custom styles, as needed. 
This format cannot include formatting, such as italics, bolding, superscripts, or subscripts.

▪

XML  
 
The XML option exports in a proprietary EndNote XML format that can be imported into EndNote or 
EndNote online. The main advantage of this format over exporting a text file  is that it can retain 
formatting that was applied to the original reference data, such as italics for species names, or 
superscripts or subscripts in chemical names.

▪

Note:  The Export command exports only text; images are not included. To reattach figures to your 
records, see The Figure and Caption Fields.
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Subject Bibliographies and Subject Lists

Overview of Subject Bibliographies
A general bibliography is a continuous listing of citations in a particular order. A subject bibliography is made 
up of smaller listings, each appearing under a distinct heading. Despite the name, a subject bibliography (or 
a subject list) can be based on any EndNote field or combination of fields.

An example of a subject bibliography might look something like this.

REFERENCE LIST:
 
animal cognition (2)
 
Pepperberg, I. M. (2008, Nov. 12) 'Alex & me': The hidden world of animal 
minds/Interviewer: T. Gross. Fresh Air, WHYY/NPR, Phildelphia.
 
Shanahan, M. (2012). The brain's connective core and its role in animal 
cognition. Philosophical Transactions of the Royal Society B-Biological 
Sciences, 367(1603), 2704-2714. doi:10.1098/rstb.2012.0128
 
animal communication (2)
Pepperberg, I. M. (1999). The Alex studies: Cognitive and communicative 
abilities of grey parrots. Cambridge, Mass.: Harvard University Press.
 
Pepperberg, I. M. (2009). Alex & me: How a scientist and a parrot discovered 
a hidden world of animal intelligence — and formed a deep bond in the 
process [Kindle](Kindle ed.). Retrieved from http://www.amazon.com/Alex- 
scientist-discovered-intelligence-ebook/dp/B00APOWOXC/ref=sr_1_2?s=digital- 
text&ie=UTF8&qid=1363823581&sr=1-2&keywords=alex+%26+me

Subject bibliographies have diverse uses, including:  generating lists of journal abstracts, current awareness 
lists, subject indexes, or lists of holdings by category. Typical subject bibliography headings are by Keyword, 
Author, Journal Title, or Call Number.

You can print entire bibliographic citations, information from one or more fields, record IDs, or nothing at all 
under each heading.

When creating a subject bibliography, you have a large set of options to choose from. Below is a chart 
summarizing the steps and options available. This section will break these options down to help you 
understand the power available to you with this feature.
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Subject Bibliography Flowchart
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Subject Bibliography/List Dialog

Selecting a Subject Bibliography or a Subject List

Printing or Saving the Subject Bibliography or Subject List

The Subject Bibliography Setup Dialog

Select Subject Bibliography from the Tools menu to see the Subject Bibliography/List dialog.

The dialog will display either a list of formatted references grouped by headings, or a list of terms. Which of 
these shows is controlled by the Reference List setting  in the Terms  dialog of the Subject 
Bibliography Setup dialog. The dialog title will always show "Subject Bibliography," even if a list of terms is 
displayed instead.

At the top of the screen are two buttons and a drop-down list:

Output Style: Use the Output Style list in the top left corner to select a style for formatted references. 
Only the styles selected as "favorites" are listed. If the style you want to use is not listed, choose Select 
Another Style. If you are displaying a simple list of terms, and not formatted references, this item is 
ignored. (You can also select a style, plus title and sorting options for  your references, using the 
References dialog in the Subject Bibliography Setup tab. See The Subject Bibliography References 
Tab.)

Layout: Click Layout  to access the Subject Bibliography Setup  dialog. See The Subject Bibliography 
Setup Dialog.

Terms: Click Terms to return to the  term selections, to either add or remove terms from the selected 
field(s). If you want to select a different EndNote field, you must close the Subject Bibliography/List 
dialog and select Subject Bibliography again from the Tools menu.

To access the Subject Bibliography Setup panel, click the Layout  button. For information on the many 
options available in this dialog, see The Subject Bibliography Setup Dialog.

When you have finished setting options in the Subject Bibliography Setup Dialog, you can return to the 
Subject Bibliography/List Dialog and finish creating your subject bibliography or list using one, or more, of 
the buttons below.

Print Preview: Click Print Preview to display a formatted page view.

Print: Click Print to display a Print dialog. Verify settings and click OK to send the list to your printer.

Save As : Click Save As to save a file in a text, RTF, or HTML format. A dialog appears for you to name 
the file. Select the file type, name and location of the file, and click Save.

Close: Click Close to close the Subject Bibliography dialog.

The Subject Bibliography Setup dialog includes four buttons, each leading to a separate dialog controlling 
specific parts of the layout for a subject bibliography or subject list. See the topics below for details on each 
dialog.
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The Subject Bibliography References Tab

Output Style

Reference List Title

Reference List Order

The Subject Bibliography Terms Tab

The Subject Bibliography References Tab▪

The Subject Bibliography Terms Tab▪

Subject Bibliography Page Layout Tab▪

The Subject Bibliographies Bibliography Layout Tab▪

Note: Some subject bibliography settings are updated from the current output style, so changes you make 
are not saved for future subject bibliographies. If you have special settings that you want to always use for 
subject bibliographies, it may be easier to copy and modify an output style specifically for generating 
subject bibliographies.

Use the References tab to set the output style, reference list title, and reference list order. The options 
available are described below.

From the drop-down Output Style list, select the EndNote style you want to use for formatting references. If 
the style you want to use is not on the favorites list, choose Select Another Style from the list to select from 
the styles installed on your computer. To add styles to the favorites list, see Adding Styles to the Output 
Styles Menu. To install more styles, see Installing Additional Output Styles.

Enter the title that will print at the beginning of the subject list or subject bibliography. This can be more than 
one line. If the text box is empty, no title will print.

To apply character styles to the Reference List Title, select the text and use these keyboard shortcuts.

Bold: Ctrl+B▪

Italics: Ctrl+I▪

Underline: Ctrl+U▪

This allows you to select a sort order for the references that print under each subject heading. Click on the 
appropriate radio button, or create a custom sort order by choosing the Other… radio button.

To reset the values on this tab, click the EndNote Defaults button.

The Terms tab options apply specifically to subject terms (or headings), not to references.
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Selecting a Subject List or Subject Bibliography

Recycling Reference Numbers Continuous Reference Numbers

Including Subject Term Counts or Record IDs

Note: The options on this tab are saved for the current subject bibliography  session and for future 
sessions, until you change them again. So, if you generate a list of Subject Terms Only, the next time you 
select Subject Bibliography, you will produce a simple subject list again. To include formatted references, 
click the Layout button and the Terms button to select Subject Terms and Reference List.

In the Reference List area, select one of the two radio buttons:

Subject Terms Only: This  option prints each unique subject term. It does NOT print formatted 
references below each term. Use this for a simple list of terms.

▪

Subject Terms and Reference List: This option prints each subject term with related references 
listed below it.

▪

When printing subject terms with reference lists, EndNote typically prints each unique subject heading only 
once, with the related references listed below. You can select the Repeating Subject Terms  box to print a 
subject term before each and every formatted reference (example below).

Avian cognition   (2)
Pepperberg, I. M. (2011). Avian cognition and social interaction Fifty years 
of advances. Interaction Studies, 12(2), 195-207. doi:10.1075/is.12.2.01pep
 
Avian cognition   (2)
Vick, S.-J., Bovet, D., & Anderson, J. R. (2009). How do African grey 
parrots (Psittacus erithacus) perform on a delay of gratification task? 
Animal Cognition, 13(2), 351-358. doi:10.1007/s10071-009-0284-2

Select the Recycling Reference Numbers box to restart reference numbering under each subject heading. If 
your starting reference number is 1, each list of references under each subject heading will start with 1. 
Deselect this item if you want sequential numbering throughout the document. This setting is used only if the 
current output style  specifies reference numbering. To set the beginning number, see The Subject 
Bibliographies Bibliography Layout Tab.

Heading Number One
1. First formatted reference
2. Second formatted reference
Heading Number Two
1. First formatted reference
2. Second formatted reference

Heading Number One
1. First formatted reference
2. Second formatted reference
Heading Number Two
3. First formatted reference
4. Second formatted reference

Check the box to include:

Subject Term Counts: This option prints a number next to the subject term to indicate how many 
records contain the term. For example:

▪

Evolution   (1)
Excavation   (4)
Extinction   (12)
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Sorting the Subject Terms

Inserting Space or Text Around Subject Terms

Subject term counts always print on the same line as the subject term, surrounded by parentheses, 
and separated from the term by three spaces.

List of Record IDs: This option prints the record IDs (the EndNote record number) of the records 
that contain the term. For example:

▪

Excavation   34,   33,   6,   48
Extinction   34,   46,   6,   10,   125,   132,   148,   162

Note: EndNote record numbers are not permanent and apply only to the library  used to create the 
Subject Bibliography or Subject List. They can change when syncing or copying. See Record 
Numbers.

You have four options for ordering your subject terms:

By Term —  Alphabetical: This option sorts subject terms by date for Year fields, and then 
alphanumeric order (1-9, A-Z) for all other fields.

▪

By Term — Inverse Alphabetical: This option reverses the By Term — Alphabetical order (Z-A, 9-1, 
Years).

▪

By Term Count — Ascending: This option lists terms based on how often they appear in records. 
For example, a term that appears in only one reference would display at the top of the list, whereas a 
term used in 20 references would appear further down in the list.

▪

By Term Count — Descending: This option reverses the By Term Count — Ascending order, so the 
most-used terms are listed first.

▪

Note: This sort  order setting affects subject headings only. If you want to change the order of the 
references printed below each heading, do so on the References tab of the Subject Bibliography Setup 
dialog. See The Subject Bibliography References Tab.

Use the Prefix and Suffix text boxes to print text or punctuation before or after each subject term.

Each term may include a subject term count and/or a list of record IDs. The order of output is:

Text Before | Subject Term | Subject Term Count | 
List of Record IDs | Text After | Reference List
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New Paragraph ^p

New Line ^l

Tab ^t

Bold Ctrl+B

Italic Ctrl+I

Underline Ctrl+U

Applying Styles

Subject Bibliography Page Layout Tab

Font and Size

Margins

Page Numbers

You can use these special formatting codes in the text boxes:

By default, the Prefix box contains "^p" and the Suffix box contains "^p^p" in order to leave blank lines 
between each subject heading and the first citation listed below it.

When you print Subject Terms Only, you will probably want to print only a single "^p" after each term, so 
each subject term begins on a new line with no blank lines between them.

In the Styles area, check the appropriate boxes to separately apply styles to Subject Terms, Subject Term 
Counts, and the List of Record IDs. You can combine styles in any way, such as:

Antarctica (2) 144, 12
Antarctica (2) 144, 12

Apply styles to bibliographic references by modifying the output style.

If you save your list to a plain text file, all styles will be stripped.

This tab includes options for font, font size, margins and page numbers.

Type or select a font and size for the references in your subject bibliography. EndNote lists currently 
available fonts. Sizes available depend on the printer and the selected font.

The margin is the distance between the edge of the page and the printed text. Enter your margins (in 
inches) into the appropriate boxes.

Select whether or not to number the pages. If you choose to number pages, enter a starting page number. 
You can also choose whether or not to suppress the first page number for the title page.

Page numbers can appear in a header or a footer. The alignment can be left, right, or center.
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The Subject Bibliographies Bibliography Layout Tab

Starting and Ending Each Reference with a Special Character or Text

The options available on the Bibliography Layout tab affect only the bibliographic references printed in a 
subject bibliography. These settings are not used when you print a simple subject list.

Note: When you select an output style, the settings on this tab change to reflect the settings found in the 
output style. You can override those settings for the current session, but changes to this tab are not saved 
after you close the subject bibliography window. If you want to make the changes permanent, edit the 
output style. You can make a copy of the output style to edit specifically for subject bibliographies.

Use the "Start each reference with" and the "End each reference with" text boxes to enter fields, text, or 
punctuation to print before and after every formatted reference.

Simply click in one of the text boxes and type text. You can use the Insert Field button to enter control 
characters or fields of information as described below.

Use the Insert Field buttons to insert any of the control characters below in a text box. These are standard 
control characters used in EndNote output styles.

End of Paragraph inserts a paragraph marker, which moves the following text to the next line.

Tab  inserts a tab character. The spacing for tabs is determined by the ruler settings in your word 
processor.

Forced Separation  inserts a vertical bar. Use vertical bars to detach punctuation from a specific field. 
See Forced Separation—Using the Vertical Bar.

Link Adjacent Text  inserts a non-breaking space. See Link Adjacent Text (Using the Nonbreaking 
Space).

Singular/Plural works with author (including editors) and pages fields to place different characters with 
the field depending on if there are a single or multiple number of authors or pages listed. For example, if 
there was one editor listed, it might show "John Smith, ed.," but if there were two editors, it might show 
"John Smith, Matt Jones, eds." See Singular/Plural Term Separator (Caret ^).

Enter these fields of information in the "Start each reference with" box by clicking the Insert Field button and 
selecting the field name:

Reference Type prints the Reference Type of each reference.

Label prints the Label field from each reference.

Citation prints the in-text citation form of each reference.

Bibliography Number  prints a bibliography number. It is best to avoid using this option in subject 
bibliographies. Using a numbered style will include the bibliography number.

Record Number prints the Record Number from each reference.

Enter these fields of information in the "End each reference with" box by clicking the Insert Field button and 
selecting the field name:
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Setting a Hanging Indent

Numbering References

Creating a Subject Bibliography

Label prints the Label field from each reference.

Keywords prints the entire Keywords field for each reference.

Abstract prints the Abstract from each reference.

Notes prints the Notes field from each reference.

Record Number prints the Record Number from each reference.

Note: Although only the fields listed above can be entered from the drop-down list, any EndNote generic 
field name can be typed in manually. The generic field name must be typed in exactly as it appears in the 
Generic reference type.

Use the drop-down list to apply a hanging indent to paragraphs in each formatted reference.

Enter a starting reference number for bibliographic references printing below each heading. This setting is 
ignored if reference numbering is not applied from the current output style.

To create a subject bibliography:

Select a group or perform a search to find the references to include in the subject bibliography. All 
showing references will be included.

1.

Click on the All References group to include all references in the subject bibliography.▪

Click on a Group name to display only the references in a specific group.▪

Perform a search to find a subset of references for your subject bibliography. See The 
Advanced Search Panel.

▪

If none of the methods above work, you may find it easiest to create a custom group to hold the 
references you want to use for the subject bibliography.

▪

Click in the reference list to make it the active panel.2.

From the Tools menu, select Subject Bibliography to display a list of EndNote fields by default field 
name.

3.

Select the field(s) whose contents you wish to use as subject headings.4.

The most common selection is the single Keywords field to create a subject bibliography.▪

You can include any number of fields. If you build the list of headings from more than one field, 
the subject headings generated from these fields are combined into a single list.

▪
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If you mix the Year field with other fields, the year will sort before alphabetic subject headings.▪

To quickly select all fields or clear all fields, use the buttons on the right side of the dialog.▪

Select checkboxes as needed to determine whether an entire field is used as a heading, or whether 
a field should be split into multiple headings.

5.

List each author separately: When  checked, this option will list each author name as a 
separate heading. If not checked, all authors from a single field will appear as a single heading.

▪

In other fields, list each entry that is separated by slash, carriage return, or line feed:  
When checked, this option separates any nonauthor field into multiple subject headings if a 
slash, carriage return, or line feed is present.

▪

Terms in the Keywords field are always listed as separate headings.▪

Click OK to display the terms found in the fields you selected.6.

Select those terms you wish to include as subject headings.7.

To quickly select all terms or clear all terms, use the buttons to the right of the dialog.▪

You may want to select all terms and then deselect the few terms you do not want included.▪

Click OK to format the subject bibliography on the screen.  
 
If you want to modify the term selections you just set, to either add or remove terms from the 
selected field(s), click on the Terms button.

8.

Note: Subject headings print as they appear in your records. No special formatting of author names or 
keywords, and no journal title substitution is applied.

Click on the Layout  button to open the Subject Bibliography Setup dialog. Use the options on the 
tabs available here to modify the layout and style of your subject bibliography or subject list. See the 
following sections for information on modifying the tabs shown:

9.

The Subject Bibliography References Tab▪

Set options for the bibliography style and reference list sorting.▪

The Subject Bibliography Terms Tab▪

Set options to include subject terms only or subject terms and bibliography entries, subject 
term counts, and EndNote record numbers/IDs.

▪

Set the sort order for the term headings.▪

Add prefix and suffix spacing or tabs for terms. Set text options such as bolding, italics, or 
underlining for terms, term counts, and record numbers.

▪

Subject Bibliography Page Layout Tab▪

Set options for the font, font size, and margins used in the document.▪
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Creating a Subject List

Set if page numbers will be included, which number to start with, whether to put page 
numbers in the header or footer, and page number alignment.

▪

The Subject Bibliographies Bibliography Layout Tab▪

Set options to begin or end each reference with extra fields, such as the abstract, notes, 
research notes, or keywords fields, etc.

▪

Set the reference list starting number for numbered styles.▪

Use the Terms tab to set options specifically for subject headings. For a subject bibliography, it is important 
to select the Subject Terms and Reference List option to create a subject bibliography with references.

Click OK to save changes and close the Subject Bibliography Setup dialog.

Once your subject bibliography is set up the way you want it, you can do one of these:10.

Display a formatted page view by clicking Print Preview.▪

Print to your printer by clicking the Print  button. A Print dialog will appear. Verify settings and 
click Print.

▪

Save a file (Text, RTF, or HTML) by clicking the Save…  button. A dialog appears for you to 
select the location and name  the file. Select the file type, name, and location for the file, and 
then click Save.

▪

Note: In your Web browser, set encoding to Unicode-UTF 8 to appropriately display extended Unicode 
characters in an exported HTML document.

Close the Subject Bibliography window when you are done viewing it.11.

To create a subject list:

Select a group or perform a search to find the references to include in the subject list. All showing 
references will be included.

1.

Click on the All References group to include all references in the subject bibliography.▪

Click on a Group name to display only the references in a specific group.▪

Perform a search to find a subset of references for your subject bibliography. See The 
Advanced Search Panel.

▪

If none of the methods above work, you may find it easiest to create a custom group to hold the 
references you want to use for the subject bibliography.

▪

Click in the reference list to make it the active panel.2.

From the Tools menu, select Subject Bibliography to display a list of EndNote fields by default field 
name.

3.
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Select the field(s) whose contents you wish to see in your subject list.4.

The most common selection is the single Keywords field to create a list of the keywords used in 
your references.

▪

You can include any number of fields. If you build the list of headings from more than one field, 
the subject headings generated from these fields are combined into a single list.

▪

If you mix the Year field with other fields, the year will sort before alphabetic subject headings.▪

To quickly select all fields or clear all fields, use the buttons on the right side of the dialog.▪

Select checkboxes as needed to determine whether an entire field is shown in the list, or whether a 
field should be split into multiple list items.

5.

List each author separately: When  checked, this option will list each author name as a 
separate heading. If not checked, all authors from a single field will appear as a single list item.

▪

In other fields, list each entry that is separated by slash, carriage return, or line feed:  
When checked, this option separates any nonauthor field into multiple list items if a slash, 
carriage return, or line feed is present.

▪

Terms in the Keywords field are always listed separately.▪

Click OK to display the terms found in the fields you selected.6.

Select those terms you wish to include in the list.7.

To quickly select all terms or clear all terms, use the buttons to the right of the dialog.▪

You may want to select all terms and then deselect the few terms you do not want included.▪

Click OK to format the subject bibliography on the screen.  
 
The initial default setting is to show terms as headings and references beneath them. To 
show just the terms in your list, click the Layout  button to open the Subject Bibliography 
Setup dialog, then the Terms tab and select Subject Terms Only.

8.

Note:  Subject terms print as they appear in your records. No special formatting of author names or 
keywords, and no journal title substitution is applied.

On the Subject Bibliography Setup dialog, you will also have access to the tabs shown below. Use 
the options on these tabs to modify the layout and style  of your subject list. See the following 
sections for information on modifying the tabs shown:

9.

The Subject Bibliography References Tab (These options are not used for subject lists.)▪

Set options for the bibliography style and reference list sorting.▪

The Subject Bibliography Terms Tab▪

Set options to include subject terms only or subject terms and bibliography entries, subject 
term counts, and EndNote record numbers/IDs.

▪

Set the sort order for the term headings.▪
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Examples of Subject Bibliographies

Using Author Names as Subject Headings

Add prefix and suffix spacing or tabs for terms. Set text options such as bolding, italics, or 
underlining for terms, term counts, and record numbers.

▪

Subject Bibliography Page Layout Tab▪

Set options for the font, font size, and margins used in the document.▪

Set if page numbers will be included, which number to start with, whether to put page 
numbers in the header or footer, and page number alignment.

▪

The Subject Bibliographies Bibliography Layout Tab (These options are not used for subject 
lists.)

▪

Set options to begin or end each reference with extra fields, such as the abstract, notes, 
research notes, or keywords fields, etc.

▪

Set the reference list starting number for numbered styles.▪

Use the Terms tab to set options specifically for terms. For a subject list, it is important to select the Subject 
Terms Only option to create a subject list without references.

Click OK to save changes and close the Subject Bibliography Setup dialog.

Once your subject list is set up the way you want it, you can do one of these:10.

Display a formatted page view by clicking Print Preview.▪

Print to your printer by clicking the Print  button. A Print dialog will appear. Verify settings and 
click Print.

▪

Save a file (Text, RTF, or HTML) by clicking the Save…  button. A dialog appears for you to 
select the location and name  the file. Select the file type, name, and location for the file, and 
then click Save.

▪

Note: In your Web browser, set encoding to Unicode-UTF 8 to appropriately display extended Unicode 
characters in an exported HTML document.

Close the Subject Bibliography window when you are done viewing it.11.

This example uses author names as subject headings. The List each author separately box was checked on 
the Subject Fields dialog, so that single author names are used for headings rather than entire author fields. 
Uppercasing was applied to the Subject Terms on the Terms tab.

BONACCORSO, F. J.
 
Gorresen, P. M., Brinck, K. W., DeLisle, M. A., Montoya-Aiona, K., Pinzari, 
C. A., & Bonaccorso, F. J. (2018). Multi-state occupancy models of foraging 

Page 273 of 586

 



Clarivate EndNote 20 User Help Guide

Using Keywords as Subject Headings

habitat use by the Hawaiian hoary bat (Lasiurus cinereus semotus). PloS One, 
13(10), e0205150. doi:10.1371/journal.pone.0205150
 
BOON, L.
 
Van de Walle, I., Silence, K., Budding, K., Van de Ven, L., Dijkxhoorn, K., 
de Zeeuw, E., . . . Boross, P. (2021). ARGX-117, a therapeutic complement 
inhibiting antibody targeting C2. Journal of Allergy and Clinical 
Immunology, 147(4), 1420-1429.e1427. doi:10.1016/j.jaci.2020.08.028
 
BOROSS, P.
 
Van de Walle, I., Silence, K., Budding, K., Van de Ven, L., Dijkxhoorn, K., 
de Zeeuw, E., . . . Boross, P. (2021). ARGX-117, a therapeutic complement 
inhibiting antibody targeting C2. Journal of Allergy and Clinical 
Immunology, 147(4), 1420-1429.e1427. doi:10.1016/j.jaci.2020.08.028

This example uses keywords as subject headings, and restarts reference numbering after each subject 
heading. You would select Recycle Numbering  in the Subject Bibliography Setup  dialog on the Terms  tab. 
The starting reference number is set on the Bibliography Layout tab. On the Terms tab, Bold and Uppercase 
were applied to the terms.

ACOUSTIC INTERFERENCE
 
1.    Chiu, C., W. Xian, and C.F. Moss, Flying in silence: Echolocating bats 
cease vocalizing to avoid sonar jamming. Proceedings of the National Academy 
of Sciences of the United States of America, 2008. 105(35): p. 13116-13121.
 
ACOUSTIC MONITORING
 
1.    Smith, A.D. and S.R. McWilliams, Bat activity during autumn relates to 
atmospheric conditions: implications for coastal wind energy development. 
Journal of Mammalogy, 2016. 97(6): p. 1565-1577.
 
ACOUSTIC STIMULATION
 
1.    Jen, P.H. and C.H. Wu, Echo duration selectivity of the bat varies 
with pulse-echo amplitude difference. Neuroreport, 2008. 19(3): p. 373-7.
 
ACOUSTICS
 
1.    Arnett, E.B., et al., Evaluating the Effectiveness of an Ultrasonic 
Acoustic Deterrent for Reducing Bat Fatalities at Wind Turbines. PLoS One, 
2013. 8(6): p. e65794.
2.    Fujioka, E., et al., Rapid shifts of sonar attention by Pipistrellus 
abramus during natural hunting for multiple prey. Journal of the Acoustical 
Society of America, 2014. 136(6): p. 3389-3400.
3.    Patterson, D.K. and I.M. Pepperberg, A comparative-study of human and 
parrot phonation — acoustic and articulatory correlates of vowels. Journal 
of the Acoustical Society of America, 1994. 96(2): p. 634-648.
4.    Patterson, D.K. and I.M. Pepperberg, Acoustic and articulatory 
correlates of stop consonants in a parrot and a human subject. Journal of 
the Acoustical Society of America, 1998. 103(4): p. 2197-2215.
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List of Reference Types

Your EndNote library  can contain references from a variety of different sources, such as books, journal 
articles, and newspaper articles. We call these different sources reference types. EndNote provides built-in 
forms for these and other common reference types.

The reference type  table shows which fields are used in each of the 57 different  reference types (plus a 
Generic reference type) and what the fields are called. The Generic reference type is repeated several times 
so that you can easily compare an individual field to its Generic field name. For descriptions of special fields, 
see Special Fields.

In addition to an all-encompassing Generic reference type, EndNote has three Unused and numerous 
predefined reference types. Click on a link below to see the default fields included for each reference type.

Aggregated Database▪

Ancient Text▪

Artwork▪

Audiovisual Material▪

Bill▪

Blog▪

Book▪

Book Section▪

Case▪

Catalog▪

Chart or Table▪

Classical Work▪

Computer Program▪

Conference Paper▪

Conference Proceeding▪

Dataset▪

Dictionary▪

Discussion Forum▪

Edited Book▪

Electronic Article▪

Electronic Book▪

Electronic Book Section▪

Encyclopedia▪

Equation▪
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Figure▪

Film or Broadcast▪

Government Document▪

Grant▪

Hearing▪

Interview▪

Journal Article▪

Legal Rule or Regulation▪

Magazine Article▪

Manuscript▪

Map▪

Multimedia Application▪

Music▪

Newspaper Article▪

Online Database▪

Online Multimedia▪

Pamphlet▪

Patent▪

Personal Communication▪

Podcast▪

Press Release▪

Report▪

Serial▪

Social Media▪

Standard▪

Statute▪

Television Episode▪

Thesis▪

Unpublished Work▪

Unused 1▪

Unused 2▪

Unused 3▪

Web Page▪

You can assign a particular reference type to each reference entered into your library.▪
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Relationship Between Reference Types and Styles, Filters, 
and Connections

The Reference Types preference, accessible through EndNote’s  Preferences, determines which 
fields are available for each of the different reference types.

▪

The Reference Types preference allows up to 58 different types of references (including a Generic 
reference type), each capable of supporting up to 54 fields (including the name of the reference 
type). Of these, 52 fields can be edited. The Added to Library and Last Updated fields can be shown 
in the Reference List, but cannot be changed by the user.

▪

Of the 58 reference types, all but the Generic type can be modified.▪

Use the Reference Types preference to add, delete, or rename fields. You can also add or hide 
complete reference types.

▪

The layout of the Generic reference type should be used as a guide when modifying or creating 
reference types. Rows reserved for Authors should be used only for names, the Year field should be 
used only for the year of publication, etc.

▪

Changes made to the Reference Types preference apply to all libraries opened under the current 
user account.

▪

If you move your library to a different computer, your references will follow the layout of the 
Reference Types preference for the current user account on that computer, unless you also transfer 
a copy of your reference type table. See Backing Up or Sharing Your Reference Types Table.

▪

Do not enter reference data into the Reference Types preference. This dialog is designed to store 
just the names of the reference fields.

▪

When you use Cite While You Write to insert figures in Microsoft Word, figures found in the Chart or 
Table reference type are inserted as tables. Figures found in any other reference type in EndNote will 
format as figures in Word.

▪

The chosen reference type  specifies which fields appear in the Reference window. For instance, an 
EndNote journal article reference includes the fields Journal, Volume, and Issue, while a book reference 
includes fields such as Publisher and City. The Reference window only displays the fields that are relevant 
to the chosen reference type.

It is best to select the reference type before entering the bibliographic information in a reference. However, 
you can change the reference type of a reference at any time using the Reference Type list at the top of the 
Reference Edit panel.

Styles, filters, and connection files can include templates for all of the different reference types. This enables 
various types of references to be formatted differently in a bibliography or imported differently, as necessary.

The reference types and fields available to you when editing a style, filter, or connection file depend on how 
the reference types are configured in the Reference Types preference. These files update automatically to 
reflect changes made in the Reference Types preference (such as changing the name of a field).
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When entering references into your library, use the Generic type only for references that do not fit any of the 
other reference types. The more important function of the Generic reference type is to set up a guide for the 
other reference types to follow.

The Generic field  names are used throughout the EndNote program (for example, in the Sort References 
dialog and the Search panel) to refer to a similar category of fields that can be found in the different 
reference types. When you choose a Generic field name in any of these dialogs, it refers to all field names 
assigned to that Generic row of the Reference Types preference. For example, if you use the Search 
command to search the Author field, EndNote searches all fields that appear in the Generic Author row of 
the Reference Types preference, including fields such as Artist, Reporter, and Cartographer.
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The Generic Fields The Generic Fields (continued)
Author  Custom 1

Year  Custom 2

Title Custom 3

Secondary Author Custom 4

Secondary Title Custom 5

Place Published Custom 6

Publisher Custom 7

Volume Custom 8

Number of Volumes Accession Number

Number Call Number

Pages Label

Section Keywords

Tertiary Author Abstract

Tertiary Title Notes

Edition Research Notes

Date URL

Type of Work File Attachments

Subsidiary Author Author Address

Short Title Figure

Alternate Title Caption

ISBN/ISSN Access Date

DOI Translated Author

Original Publication Translated Title

Reprint Edition Name of Database

Reviewed Item Database Provider

  Language

  Added to Library

  Last Updated

Note: When editing the Reference Types preference it is important that you keep similar fields in the 
same row, as defined by the Generic field names of the row. Each reference type can call these fields by 
a different name; however, the content of the fields should be similar.
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Setting a Default Reference Type

The Reference Types Preference

Although the Generic reference type is rarely used for data entry, it plays an important role in formatting 
bibliographies. In addition to formatting Generic references, the Generic template in a style is used to format 
any reference types that are not specifically defined in the style. Consequently, every bibliographic style 
should contain a Generic template so that all references get formatted when EndNote creates a 
bibliography.

By default, the Journal Article reference type  appears when you insert a new reference. While you can 
change the assigned reference type during data entry, you may want to change the default setting.

To change the default reference type setting:

From the Edit menu, select Preferences.1.

Click on Reference Types.2.

Click the Default Reference Type list and choose from one of the available reference types.3.

Click Apply to save the change.4.

The Reference Types preference displays the available reference types and the fields that each reference 
type  contains. Use the Reference Types preference to add, remove, or rename fields—or to rename a 
reference type.

Note: Much like your EndNote library, any changes you make to your Reference Types should be 
backed up. See Backing Up or Sharing Your Reference Types Table for more information.

To access the Reference Types preference:

From the Edit menu, select Preferences.1.

Click the Reference Types option in the list of preferences.2.

Click the Modify Reference Types button and the Modify Reference Types dialog will open.3.

Use the drop-down list at the top to display one of the 57 editable reference types.4.

The first column of the Modify Reference Types dialog is reserved for the Generic reference type, which lists 
all of the available fields.

The rows correspond to the editable fields that each reference type can contain (including the name of the 
reference type). Each named cell in a column represents a field that appears in the reference. The names of 
the fields in each reference type should closely correspond to their Generic field names in the left column.
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Customizing Reference Types

The Generic column is the complete set of fields that can be included in any type of reference—no fields 
can be added to this list, nor can the names of the Generic fields be changed. The Generic Reference Type 
serves as a model for constructing all other reference types.

Use the vertical scroll bar to see the additional fields available for each reference type.▪

If you decide to undo your changes to the reference types and revert to the EndNote defaults, click 
EndNote Defaults to return all reference type settings to their original EndNote settings.

▪

Note: Clicking EndNote Defaults in the Modify Reference Types dialog will revert the reference 
type you are editing to the default, but clicking EndNote Defaults in the Reference Types 
Preference dialog will revert all changes that have ever been made to the defaults.

If you want the change you made to apply to all reference types, click Apply to All Ref Types  to 
change the field for all reference types.

▪

Caution: Use extreme caution with the Apply to All Ref Types button. It will change all fields that 
correspond to that field in the Generic reference type. For example, if you changed the Custom 2 
field in the Manuscript reference type to My Keywords, then clicked Apply to All Fields, you would 
replace the PMCID field in the Journal Article reference type to My Keywords instead of PMCID.

Click OK  to save your changes and to close the Modify Reference Types dialog. Click Apply  when 
you return to the EndNote Preference dialog to save your settings OR click Cancel  to exit from the 
Reference Types preference without saving any changes.

▪

All of the reference types, except for Generic, can be modified using the Reference Types preference. 
Whenever you make a change to a reference type, you should also edit your styles to make sure that they 
correctly format the new or modified reference types.

Note: Much  like your EndNote library, any changes you make to your Reference Types should be 
backed up. See Backing Up or Sharing Your Reference Types Table for more information.

If you plan to share your libraries with other users, you may want to limit the use of new and modified 
reference types. The changes you make to the Reference Types preference apply to all libraries opened on 
a computer from your user account. If your library is opened from a different computer or a different user 
account, your references will follow the layout of the Reference Types preference for that computer and 
user, unless you also transfer a copy of your reference type table. See Backing Up or Sharing Your 
Reference Types Table.

If you modify a reference type for records in your EndNote library, you should make sure that the reference 
type is also created or modified on other computers that will access the library.

Do not try to edit the Reference Types preference to rearrange information within your references. For 
example, if you delete the Journal field  and retype "Journal" elsewhere in the column for Journal Articles, 
you are telling EndNote to close the original Journal field and display a new field called "Journal" in another 
location—this does not move your data from the original Journal field  to the new one. Any references that 
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had data in the original Journal field will still show that information, but the field will have its Generic name of 
Secondary Title. The new Journal field will remain empty.

Note: EndNote online will always use the default EndNote reference types, so changes you make to your 
reference types on the desktop will not be reflected in your EndNote account.

These topics can guide you in editing reference types:

List of Reference Types▪

The Generic Reference Type▪

Special Fields▪

The Reference Types Preference▪

Adding, Changing, and Hiding Reference Types▪

Adding, Deleting, and Renaming Fields▪

Backing Up or Sharing Your Reference Types Table▪

There are three Reference Types titled Unused, where you can define a new type of reference. If these are 
already in use, you can overwrite other reference types that you do not need in order to create new 
reference types. For example, if your subject area never involves art, you may have no use for the Artwork 
reference type; you could replace it with another reference type.

To add a new reference type:

From the Edit menu, select Preferences.1.

Select the Reference Type option in the list of preferences, and then click Modify Reference Types to 
open the Modify Reference Types dialog.

2.

Use the drop-down list at the top to select one of the Unused reference types. If all of the 
Unused reference types are in use, select a reference type that you are willing to overwrite.

3.

Type a name for that new reference type into the column heading.4.

Note: A reference type must have fields defined in order to appear in the reference type list for 
new or existing references. If you change the name of an Unused reference type, it will not appear 
in your reference type list. You must also include fields in the reference type as described below.

Continue down the column for that reference type, adding new fields as necessary. (Delete or 
rename unwanted fields if you are overwriting another reference type.) Remember to match the 
meaning of the fields you add with the Generic row headings. It is often helpful to use other 
reference types as guides, too.

5.

Click OK after you have added all of the necessary fields, and you will return to the main Preferences 
window for Reference Types.

6.
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Adding, Deleting, and Renaming Fields

To Add a Field to a Reference Type

Click Apply to save your changes.7.

Click OK to close the Preferences window and save your changes.8.

You can now use this new reference type when entering references. You should also edit your styles so that 
they correctly reflect the type of format required for this new reference type. If you overwrite an existing 
reference type, any references that used the old reference type will change to use the new reference type.

Note:  If you ever plan to use journal articles in your library, do not overwrite the Journal Article or 
Electronic Article reference types. These two reference types are the only ones for which journal 
abbreviation replacements can be made with the Journals Term List.

From the Edit menu, select Preferences, select the Reference Type option in the list of preferences, 
and then click Modify Reference Types to open the Modify Reference Types dialog.

1.

Use the drop-down list at the top to find the reference type that you want to hide.2.

Add a period before the reference type’s name in the column header to have EndNote remove that 
item from the Reference Type list in the Reference Edit panel, when creating a new reference, and 
elsewhere. The definition, however, remains in case you later wish to restore it by removing the 
period. (To find the reference type that you hid in the future, go to the top of the list of references, the 
period (.) before the name will be at the beginning because the reference types are in alphabetical 
order.)  
 
For example, if you were hiding the Map reference type, the column heading would be .Map.

3.

Click OK to return to the main Preferences window for Reference Types.4.

Click OK to save your changes and close the Preferences window.5.

Once you have hidden a reference type, you should not select it under Preferences as the default reference 
type for new references; if you do, EndNote will default to the Generic reference type.

There are different ways you can customize the various reference types. If an existing reference type does 
not contain all of the fields that you need, you can define a new field or rename an existing field. Similarly, if 
there is a field that you know you will never use, you can delete it from the reference type so that it no longer 
appears in your references.

Note: Be sure to read about Special Fields before changing any fields.

From the Edit menu, select Preferences, select the Reference Type option in the list of preferences, 
and click Modify Reference Types to open the Modify Reference Types dialog.

1.

Use the drop-down list at the top to find the reference type that you want to change.2.
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To Delete a Field from a Reference Type

Look at the field names listed in the Generic column and find the one with the most similar meaning 
to the field that you want to add. Make sure that the corresponding cell is blank for the reference type 
that you are modifying. If it is not blank, then you should use another field.

3.

Click in the blank cell and type the name for the new field.4.

Click OK to return to the main Preferences window for Reference Types.5.

Click OK to save your changes and close the Preferences window.6.

From the Edit menu, select Preferences, select the Reference Type option in the list of preferences, 
and click Modify Reference Types to open the Modify Reference Types dialog.

1.

Use the drop-down list at the top to find the reference type that you want to change.2.

Within the column for that reference type, find the field name that you want to change, click on it, and 
type a new name for the field to replace the current name.

3.

Click OK to return to the main Preferences window for Reference Types.4.

Click OK to save your changes and close the Preferences window.5.

Styles, filters, and connection files update automatically to use the new name.

From the Edit menu, select Preferences, select the Reference Type option in the list of preferences, 
and click Modify Reference Types to open the Modify Reference Types dialog.

1.

Use the drop-down list at the top to find the reference type that you want to change.2.

Find the name of the field you want to delete and select it.3.

Press the Delete or Backspace key to clear that field name.4.

Click OK to return to the main Preferences window for Reference Types.5.

Click OK to save your changes and close the Preferences window.6.

The deleted field no longer appears in any references using that reference type. However, if there was any 
information in the deleted field, it still appears in the reference, but the field is displayed with its Generic 
name. For example, suppose you remove the Editor field from the Book reference type. Thereafter, when 
you add new book references to your library, there will be no available field for entering an editor. However, 
if you edit an old book reference, one in which you had entered an editor’s  name, the name would be 
displayed in the field titled Secondary Author. It is the same Editor field that was used originally, however it is 
now displayed with its Generic name.

Data in a field is not deleted by deleting a field from a reference type. To remove all text from a field, use the 
Clear Field option in the Change Fields command. You can also move data from one field to another using 
the Change Fields command.
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Table

Backup or Share a Reference Types Table

Importing a Reference Types Table

Special Fields

An EndNote user can share a customized reference type table with another EndNote user. Keep in mind, 
however, that when you do this, you completely replace the recipient’s existing reference type table.

From the Edit menu, select Preferences.1.

Click the Reference Types option in the list of preferences.2.

Under Reference Type Table, click Export to display the Save As dialog.3.

Name the file, select a folder where you will be able to find it later, and click Save. EndNote will 
append an .xml suffix to the file name.

4.

You now have a backup of your Reference Types Table.

To share your reference types with a colleague, send them a copy of the saved file.

Note:  When you import another user's Reference Type Table, you will overwrite the entire contents of 
your current Reference Type Table, losing any customizations you have made to your reference types. 
We suggest creating a backup of your current Reference Type Table before importing a new table, using 
the instructions above.

From the Edit menu, select Preferences.1.

Click the Reference Types option in the list of preferences.2.

Under Reference Type Table, click Import to display a file dialog.3.

In the file dialog, locate, highlight, and open the .xml file that was previously exported.4.

EndNote includes 52 editable fields (including the first field, which contains the name of the reference type). 
Each of the different EndNote data fields is available for use by the different reference types. Initially, only 
the Generic reference type  includes all fields. Few restrictions are placed on the type of text that can be 
entered. However, there are a few fields that are reserved for specific functions.

Note: Although the fields Added to Library and Last Updated are shown in the Reference Types and 
Fields tables, they do not appear in the Reference Types preferences because they cannot be edited. 
They are always present and can be shown in the Reference List, but cannot be changed by the user.
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Author Fields

Title Fields

Pages Field

The Author, Secondary Author, Tertiary Author, and Subsidiary Author rows in the Reference Types are 
specially configured to handle Author and Editor Names, and should not be used for any data other than 
names.

When EndNote creates a bibliography, the information in these fields is formatted according to the 
specifications of the selected style’s Author List and Editor List settings. (The Author List is used for the 
Author field; Editor List is used for Secondary Author, Tertiary Author, and Subsidiary Author fields.) If you 
put text other than personal names in any of these fields, EndNote will still try to interpret it and format it as 
a person’s name.

The first author's last name is used in temporary citations inserted into word-processing documents. The 
Reference List can display just the  last name of the first author that it finds in the Author field, or a list of 
author names (see Display All Authors in the Author Field).

Note: If you have a corporate author name in an Author field, put a comma after the name so that 
EndNote does not interpret it as a first and last name. See Author and Editor Names for information on 
entering corporate and complex author names.

The three fields that the Generic type uses for the Title Fields—Title, Secondary Title, and Tertiary Title—are 
usually found under different names in other reference types. For example, a section of a book which is part 
of a series will use all three title fields: the chapter title would belong in the main Title field, the book title 
corresponds to the Secondary Title field, and the series title corresponds to the Tertiary Title field.

The Generic Secondary Title and Alternate Title fields map to the Journal and Alternate Journal fields, 
respectively. The fields listed below, found in specific reference types, are the only ones that can be used 
with the Journals term list to modify journal names in formatted bibliographies.

Journal Article reference type—Journal field

Journal Article reference type—Alternate Journal field

Electronic Article reference type—Periodical Title field

Electronic Article reference type—Alternate Title field

The fields in the row reserved for page numbers are the only ones that work with the Page Numbers option 
in the styles. This feature lets you specify how EndNote should format the page numbers in the bibliography 
(first page only, or a full or abbreviated range of pages). Similarly, any field in the Pages row of the 
Reference Types Table can take advantage of a special formatting character in the styles: the caret (^). This 
character allows you to pick a singular and plural form of a term to precede or follow the pages in a 
bibliography, for example "p. 25" and "pp. 32-45." If you enter page numbers in any other part of the 
reference, they cannot be used with these features.
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URL Field

File Attachments Field

Figure and Caption Fields

Date Stamp Fields

When a correctly formatted URL is entered into this field, the Open URL command in the References menu 
can be used to launch your Web browser and take you to that site.

When a reference is selected and Open URL is chosen, EndNote checks the URL field for a URL. No other 
fields are checked. See The URL Field and Linking a URL to an EndNote Reference.

Use The File Attachments Field  to store the path to files on your hard drive (such as graphics, word 
processing documents, and PDF files). You can specify an absolute path to a specific folder, or you can 
specify a relative path to copy the file to your library’s .Data\PDF folder. You can link up to 45 files to each 
reference. See Selecting a Relative Path or an Absolute Path for File Attachments for more information on 
absolute and relative paths.

When a correctly formatted path and filename is entered into this field, the Open File command in the 
References menu can be used to open the file. See Linking a File to an EndNote Reference.

The Figure and Caption Fields  store a  single graphic or file attachment specifically for use in Microsoft 
Word, and the caption for that graphic. These fields are included in all reference types. See Figures  for 
information about adding figures to a reference.

To add or remove the Figure or Caption fields  from a reference type, use the Preferences dialog to edit 
reference types, as described in Adding, Deleting, and Renaming Fields.

Two Auto Date Stamp fields are available that you can add to the Reference List display.

The Added to Library and Last Updated date fields are inserted when you save a new reference. The Last 
Updated date is reset each time you save changes to a reference. The date format of the Auto Date Stamp 
fields matches your default operating system settings (for example, 4/16/2021).

To add the two Auto Date Stamp fields to the Reference List display, select Preferences  > Display Fields. 
From the Field  column, select the Added to Library  and/or Last Updated  fields. EndNote populates the 
Heading column with your selection.

Another way to add these fields to the Reference List display is to right-click  on a column heading, then 
choose them from the list.

You cannot edit, print, or export either of the Auto Date Stamp fields. You can, however, display and sort 
these fields just as you can any other EndNote field.

Note: For references entered with EndNote version X1 or earlier, the Added to Library field is left blank 
and the Last Updated field displays the date of conversion to EndNote.
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Aggregated Database

Generic Aggregated Database
Author  Author

Year  Year

Title Title

Secondary Author  

Secondary Title Periodical

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes  

Number Publication Number

Pages Pages

Section Screens

Tertiary Author  

Tertiary Title  

Edition Date Published

Date Date Accessed

Type of Work Type of Work

Subsidiary Author  

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN ISBN/ISSN

DOI DOI

Original Publication Original Publication

Reprint Edition  

Reviewed Item  
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Generic (continued) Aggregated Database (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number  

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date  

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated

 

Return to List of Reference Types
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Ancient Text

Generic Ancient Text
Author  Author

Year  Year

Title Title

Secondary Author Editor

Secondary Title Publication Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number Text Number

Pages Pages

Section  

Tertiary Author  

Tertiary Title Volume Title

Edition Edition

Date Date

Type of Work Type of Work

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviated Publication

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Custom 1  
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Research Notes Research Notes
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File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption
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Artwork

Generic Artwork
Author  Artist

Year  Year

Title Title

Secondary Author  

Secondary Title  

Place Published Place Published

Publisher Publisher

Volume  

Number of Volumes  

Number Size

Pages Description

Section  

Tertiary Author  

Tertiary Title  

Edition Edition

Date Date

Type of Work Type of Work

Subsidiary Author  

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN  

DOI DOI

Original Publication  

Reprint Edition  
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Generic (continued) Artwork (continued)
Custom 1  

Custom 2  

Custom 3 Size/Length

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Audiovisual Material

Generic Audiovisual Material
Author  Author

Year  Year

Title Title

Secondary Author Series Editor

Secondary Title Series Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Extent of Work

Number Number

Pages  

Section  

Tertiary Author  

Tertiary Title Album Name

Edition Edition

Date Date

Type of Work Type

Subsidiary Author Performers

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN ISBN

DOI DOI

Original Publication Contents

Reprint Edition  
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Generic (continued) Audiovisual Material (continued)
Custom 1 Cast

Custom 2 Credits

Custom 3 Size/Length

Custom 4  

Custom 5 Format

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Bill

Generic Bill
Author   

Year  Year

Title Title

Secondary Author  

Secondary Title Code

Place Published  

Publisher  

Volume Code Volume

Number of Volumes  

Number Bill Number

Pages Code Pages

Section Code Section

Tertiary Author  

Tertiary Title Legislative Body

Edition Session

Date Date

Type of Work  

Subsidiary Author Sponsor

Short Title Short Title

Alternate Title  

ISBN/ISSN  

DOI DOI

Original Publication History

Reprint Edition  
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Generic (continued) Bill (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Blog

Generic Blog
Author  Author

Year  Year

Title Title of Entry

Secondary Author Editor

Secondary Title Title of WebLog

Place Published Place Published

Publisher Publisher

Volume Access Year

Number of Volumes  

Number Date

Pages Description

Section Message Number

Tertiary Author Illustrator

Tertiary Title Institution

Edition Edition

Date Last Update Date

Type of Work Type of Medium

Subsidiary Author  

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN ISBN

DOI DOI

Original Publication Contents

Reprint Edition  
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Generic (continued) Blog (continued)
Custom 1 Author Affiliation

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Book

Generic Book
Author  Author

Year  Year

Title Title

Secondary Author Series Editor

Secondary Title Series Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number Series Volume

Pages Number of Pages

Section Pages

Tertiary Author Editor

Tertiary Title  

Edition Edition

Date Date

Type of Work Type of Work

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Book (continued)
Custom 1 Issue

Custom 2  

Custom 3 Title Prefix

Custom 4 Reviewer

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Book Section

Generic Book Section
Author  Author

Year  Year

Title Title

Secondary Author Editor

Secondary Title Book Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number Series Volume

Pages Pages

Section Chapter

Tertiary Author Series Editor

Tertiary Title Series Title

Edition Edition

Date  

Type of Work  

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Book Section (continued)
Custom 1 Section

Custom 2  

Custom 3 Title Prefix

Custom 4 Reviewer

Custom 5 Packaging Method

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Case

Generic Case
Author   

Year  Year Decided

Title Case Name

Secondary Author  

Secondary Title Reporter

Place Published  

Publisher Court

Volume Reporter Volume

Number of Volumes Reporter Abbreviation

Number Docket Number

Pages First Page

Section Filed Date

Tertiary Author Higher Court

Tertiary Title Decision

Edition Action of Higher Court

Date Date Decided

Type of Work Citation of Reversal

Subsidiary Author Counsel

Short Title Abbreviated Case Name

Alternate Title Parallel Citation

ISBN/ISSN  

DOI DOI

Original Publication History

Reprint Edition  
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Generic (continued) Case (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Catalog

Generic Catalog
Author  Author

Year  Year

Title Title

Secondary Author Institution

Secondary Title Series Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Catalog Number

Number Series Volume

Pages Pages

Section Number of Pages

Tertiary Author  

Tertiary Title  

Edition Edition

Date Date

Type of Work Type of Work

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Catalog (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5 Packaging Method

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Chart or Table

Generic Chart or Table
Author  Created By

Year  Year

Title Title

Secondary Author Name of File

Secondary Title Image Source Program

Place Published Place Published

Publisher Publisher

Volume Image Size

Number of Volumes  

Number Number

Pages Description

Section  

Tertiary Author  

Tertiary Title  

Edition Version

Date Date

Type of Work Type of Image

Subsidiary Author  

Short Title  

Alternate Title  

ISBN/ISSN  

DOI DOI

Original Publication  

Reprint Edition  
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Generic (continued) Chart or Table (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Classical Work

Generic Classical Work
Author  Attribution

Year  Year

Title Title

Secondary Author Series Editor

Secondary Title Series Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number Series Volume

Pages Number of Pages

Section  

Tertiary Author Editor

Tertiary Title  

Edition Edition

Date  

Type of Work Type

Subsidiary Author Translator

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN ISBN/ISSN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Classical Work (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Computer Program

Generic Computer Program
Author  Programmer

Year  Year

Title Title

Secondary Author Series Editor

Secondary Title Series Title

Place Published Place Published

Publisher Publisher

Volume Edition

Number of Volumes  

Number  

Pages Description

Section  

Tertiary Author  

Tertiary Title  

Edition Version

Date  

Type of Work Type

Subsidiary Author  

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN ISBN

DOI DOI

Original Publication Contents

Reprint Edition  
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Generic (continued) Computer Program (continued)
Custom 1 Computer

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Conference Paper

Generic Conference Paper
Author  Author

Year  Year

Title Title

Secondary Author Editor

Secondary Title Conference Name

Place Published Conference Location

Publisher Publisher

Volume Volume

Number of Volumes Session

Number Issue

Pages Pages

Section Paper No.

Tertiary Author  

Tertiary Title  

Edition  

Date Date

Type of Work Type

Subsidiary Author  

Short Title  

Alternate Title  

ISBN/ISSN  

DOI DOI

Original Publication  

Reprint Edition  
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Generic (continued) Conference Paper (continued)
Custom 1 Place Published

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number  

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Conference Proceeding

Generic Conference Proceeding
Author  Author

Year  Year of Conference

Title Title

Secondary Author Editor

Secondary Title Conference Name

Place Published Conference Location

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number Issue

Pages Pages

Section  

Tertiary Author Series Editor

Tertiary Title Series Title

Edition Edition

Date Date

Type of Work  

Subsidiary Author Sponsor

Short Title Short Title

Alternate Title  

ISBN/ISSN ISBN

DOI DOI

Original Publication Source

Reprint Edition  
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Generic (continued) Conference Proceeding (cont.)
Custom 1 Place Published

Custom 2 Year Published

Custom 3 Proceedings Title

Custom 4  

Custom 5 Packaging Method

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Dataset

Generic Dataset
Author  Investigators

Year  Year

Title Title

Secondary Author Producer

Secondary Title Periodical Title

Place Published Place Published

Publisher Distributor

Volume  

Number of Volumes Study Number

Number  

Pages  

Section Original Release Date

Tertiary Author  

Tertiary Title Series Title

Edition Version

Date Date of Collection

Type of Work  

Subsidiary Author Funding Agency

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISSN

DOI DOI

Original Publication Version History

Reprint Edition

Reviewed Item Geographic Coverage
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Generic (continued) Dataset (continued)
Custom 1 Time Period

Custom 2 Unit of Observation

Custom 3 Data Type

Custom 4 Dataset(s)

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Dictionary

Generic Dictionary
Author  Author

Year  Year

Title Title

Secondary Author Editor

Secondary Title Dictionary Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number Number

Pages Pages

Section Version

Tertiary Author  

Tertiary Title  

Edition Edition

Date  

Type of Work Type of Work

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition

Reviewed Item Reviewed Item
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Generic (continued) Dictionary (continued)
Custom 1 Term

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Discussion Forum

Generic Discussion Forum
Author  Author

Year  Year

Title Title of Message

Secondary Author  

Secondary Title Title of List

Place Published Place Published

Publisher Publisher

Volume Translated Message Title

Number of Volumes Translated List Title

Number  

Pages Pages

Section Description

Tertiary Author Author Affiliation

Tertiary Title Attachments

Edition Date Cited

Date Post Date

Type of Work Content Type

Subsidiary Author Original Author

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN  

DOI DOI

Original Publication Original Post

Reprint Edition  
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Generic (continued) Discussion Forum (continued)
Custom 1 E-Mail Address

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Edited Book

Generic Edited Book
Author  Editor

Year  Year

Title Title

Secondary Author Series Editor

Secondary Title Series Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number Series Volume

Pages Number of Pages

Section  

Tertiary Author  

Tertiary Title  

Edition Edition

Date Date

Type of Work Type of Work

Subsidiary Author Translator

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Edited Book (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7 Contents

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Editor Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Electronic Article

Generic Electronic Article
Author  Author

Year  Year

Title Title

Secondary Author  

Secondary Title Periodical Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Document Number

Number Issue

Pages Pages

Section E-Pub Date

Tertiary Author  

Tertiary Title Website Title

Edition Edition

Date Date Accessed

Type of Work Type of Work

Subsidiary Author  

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN ISSN

DOI DOI

Original Publication  

Reprint Edition Reprint Edition
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Generic (continued) Electronic Article (continued)
Custom 1 Year Cited

Custom 2 Date Cited

Custom 3 PMCID

Custom 4 Reviewer

Custom 5 Issue Title

Custom 6 NIHMSID

Custom 7 Article Number

Custom 8  

Accession Number Accession Number

Call Number  

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date  

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Electronic Book

Generic Electronic Book
Author  Author

Year  Year

Title Title

Secondary Author Editor

Secondary Title Secondary Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Version

Number  

Pages Number of Pages

Section  

Tertiary Author Series Editor

Tertiary Title Series Title

Edition Edition

Date Date Accessed

Type of Work Type of Medium

Subsidiary Author  

Short Title  

Alternate Title  

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition

Reviewed Item Reviewed Item
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Generic (continued) Electronic Book (continued)
Custom 1 Year Cited

Custom 2 Date Cited

Custom 3 Title Prefix

Custom 4 Reviewer

Custom 5 Last Update Date

Custom 6 NIHMSID

Custom 7 PMCID

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date  

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Electronic Book Section

Generic Electronic Book Section
Author  Author

Year  Year

Title Title

Secondary Author Editor

Secondary Title Book Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes
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Pages Pages
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Tertiary Author Series Editor
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Edition Edition
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Reprint Edition Reprint Edition
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Call Number Call Number
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Author  Author

Year  Year

Title Title

Secondary Author Editor

Secondary Title Encyclopedia Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number  

Pages Pages

Section  

Tertiary Author  

Tertiary Title  

Edition Edition

Date Date

Type of Work  

Subsidiary Author Translator

Short Title Short Title
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DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Custom 1 Term

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title
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Database Provider Database Provider
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Author  Created By

Year  Year

Title Title

Secondary Author Name of File

Secondary Title Image Source Program

Place Published Place Published

Publisher Publisher

Volume Image Size

Number of Volumes  

Number Number
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Section  

Tertiary Author  

Tertiary Title  

Edition Version

Date Date

Type of Work Type of Image

Subsidiary Author  

Short Title  

Alternate Title  
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DOI DOI

Original Publication  
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Generic (continued) Equation (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label
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Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author
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Added to Library Added to Library
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Figure

Generic Figure
Author  Created By

Year  Year

Title Title

Secondary Author Name of File

Secondary Title Image Source Program

Place Published Place Published

Publisher Publisher

Volume Image Size

Number of Volumes  

Number Number
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Tertiary Author  

Tertiary Title  

Edition Version

Date Date

Type of Work Type of Image
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ISBN/ISSN  

DOI DOI

Original Publication  

Reprint Edition  

Reviewed Item  

Page 336 of 586

 



Clarivate EndNote 20 User Help Guide

Generic (continued) Figure (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  
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Accession Number Accession Number

Call Number Call Number
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Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author
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Database Provider Database Provider

Language Language
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Generic Film or Broadcast
Author  Director

Year  Year Released

Title Title

Secondary Author Series Director

Secondary Title Series Title

Place Published Country

Publisher Distributor

Volume  

Number of Volumes  

Number

Pages Running Time

Section  

Tertiary Author Producer

Tertiary Title  

Edition Edition

Date Date Released

Type of Work Medium

Subsidiary Author Performers

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN  

DOI DOI

Original Publication Original Release

Reprint Edition Reprint Edition
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Generic (continued) Film or Broadcast (continued)
Custom 1 Cast

Custom 2 Credits

Custom 3  

Custom 4 Genre

Custom 5 Format

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Synopsis

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language
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Government Document

Generic Government Document
Author  Author

Year  Year

Title Title

Secondary Author Department

Secondary Title  

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes  

Number Issue

Pages Pages

Section Section

Tertiary Author  

Tertiary Title Series Title

Edition Edition

Date  

Type of Work  

Subsidiary Author  

Short Title  

Alternate Title  

ISBN/ISSN Report Number

DOI DOI

Original Publication  

Reprint Edition  
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Generic (continued) Government Document (cont.)
Custom 1 Government Body

Custom 2 Congress Number

Custom 3 Congress Session

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number  

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Grant

Generic Grant
Author  Investigators

Year  Year

Title Title of Grant

Secondary Author  

Secondary Title  

Place Published Activity Location

Publisher Sponsoring Agency

Volume Amount Requested

Number of Volumes Amount Received

Number Status

Pages Pages

Section Duration of Grant

Tertiary Author  

Tertiary Title  

Edition Requirements

Date Deadline

Type of Work Funding Type

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN  

DOI DOI

Original Publication Original Grant Number

Reprint Edition Review Date
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Generic (continued) Grant (continued)
Custom 1 Contact Name

Custom 2 Contact Address

Custom 3 Contact Phone

Custom 4 Contact Fax

Custom 5 Funding Number

Custom 6 CFDA Number

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author
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Name of Database Name of Database

Database Provider Database Provider
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Hearing

Generic Hearing
Author   

Year  Year

Title Title

Secondary Author  

Secondary Title Committee

Place Published Place Published

Publisher Publisher

Volume  

Number of Volumes Number of Volumes

Number Document Number

Pages Pages
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Tertiary Author  

Tertiary Title Legislative Body

Edition Session

Date Date 

Type of Work  

Subsidiary Author  

Short Title Short Title

Alternate Title  

ISBN/ISSN ISBN

DOI DOI
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Reprint Edition  
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Generic (continued) Hearing (continued)
Custom 1  

Custom 2 Congress Number

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Interview

Generic Interview
Author  Interviewee

Year  Year

Title Title

Secondary Author Interviewer

Secondary Title Program

Place Published Place Published

Publisher Publisher

Volume  

Number of Volumes

Number Number

Pages Pages

Section Section

Tertiary Author Director

Tertiary Title Location of Work

Edition Edition

Date Date

Type of Work Format

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISBN/ISSN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Interview (continued)
Custom 1  

Custom 2  

Custom 3

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author
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Database Provider Database Provider

Language Language
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Journal Article

Generic Journal Article
Author  Author

Year  Year

Title Title

Secondary Author  

Secondary Title Journal

Place Published  

Publisher  

Volume Volume

Number of Volumes Part/Supplement

Number Issue

Pages Pages

Section Start Page

Tertiary Author  

Tertiary Title Errata

Edition Epub Date

Date Date

Type of Work Type of Article

Subsidiary Author  

Short Title Short Title

Alternate Title Alternate Journal

ISBN/ISSN ISSN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Journal Article (continued)
Custom 1 Legal Note

Custom 2 PMCID

Custom 3

Custom 4  

Custom 5  

Custom 6 NIHMSID

Custom 7 Article Number

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author
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Name of Database Name of Database

Database Provider Database Provider
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Legal Rule or Regulation

Generic Legal Rule or Regulation
Author  Author

Year  Year

Title Title

Secondary Author Issuing Organization

Secondary Title Title Number

Place Published Place Published

Publisher Publisher

Volume Rule Number

Number of Volumes Session Number

Number Start Page

Pages Pages

Section Section Number

Tertiary Author  

Tertiary Title Supplement No.

Edition Edition

Date Date of Code Edition

Type of Work Type of Work

Subsidiary Author  

Short Title  

Alternate Title Abbreviation
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DOI DOI

Original Publication History

Reprint Edition  
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Generic (continued) Legal Rule or Regulation (cont.)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Magazine Article

Generic Magazine Article
Author  Author

Year  Year

Title Title

Secondary Author  

Secondary Title Magazine

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Frequency

Number Issue Number

Pages Pages

Section Start Page

Tertiary Author  

Tertiary Title  

Edition Edition

Date Date

Type of Work Type of Article

Subsidiary Author  

Short Title Short Title

Alternate Title Alternate Magazine

ISBN/ISSN ISSN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Magazine Article (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Manuscript

Generic Manuscript
Author  Author

Year  Year

Title Title

Secondary Author  

Secondary Title Collection Title

Place Published Place Published

Publisher Library/Archive

Volume Volume/Storage Container

Number of Volumes Manuscript Number

Number Folio Number

Pages Pages

Section Start Page

Tertiary Author  

Tertiary Title  

Edition Description of Material

Date Date

Type of Work Type of Work

Subsidiary Author  

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN  

DOI DOI

Original Publication  

Reprint Edition  
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Generic (continued) Manuscript (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Map

Generic Map
Author  Cartographer

Year  Year

Title Title

Secondary Author Series Editor

Secondary Title Series Title

Place Published Place Published

Publisher Publisher

Volume  

Number of Volumes  

Number  

Pages Description

Section  

Tertiary Author  

Tertiary Title  

Edition Edition

Date Date

Type of Work Type

Subsidiary Author  

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN ISBN

DOI DOI

Original Publication  

Reprint Edition Reprint Edition
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Generic (continued) Map (continued)
Custom 1 Scale

Custom 2 Area

Custom 3 Size

Custom 4  

Custom 5 Packaging Method

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language
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Multimedia Application

Generic Multimedia Application
Author  Rights Holder

Year  Year

Title App Title

Secondary Author Contributors

Secondary Title  

Place Published Place Published

Publisher Website Name

Volume Platform

Number of Volumes Content Rating

Number Version

Pages System Requirements

Section  

Tertiary Author  

Tertiary Title  

Edition Edition

Date Date

Type of Work Type of Work

Subsidiary Author  

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN  

DOI DOI

Original Publication Original Publication

Reprint Edition Reissue Date
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Generic (continued) Multimedia Application (cont.)
Custom 1  

Custom 2 Credits

Custom 3 Size/Length

Custom 4  

Custom 5 Format

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language
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Music

Generic Music
Author  Composer

Year  Year

Title Title

Secondary Author Editor

Secondary Title Album Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number  

Pages Pages

Section Section

Tertiary Author Series Editor

Tertiary Title Series Title

Edition Edition

Date Date

Type of Work Form of Item

Subsidiary Author Producer

Short Title Short Title

Alternate Title  

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Music (continued)
Custom 1 Format of Music

Custom 2 Form of Composition

Custom 3 Music Parts

Custom 4 Target Audience

Custom 5 Accompanying Matter

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title
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Database Provider Database Provider

Language Language
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Newspaper Article

Generic Newspaper Article
Author  Reporter

Year  Year

Title Title

Secondary Author  

Secondary Title Newspaper

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Frequency

Number Start Page

Pages Pages

Section Section

Tertiary Author  

Tertiary Title  

Edition Edition

Date Issue Date

Type of Work Type of Article

Subsidiary Author  

Short Title Short Title

Alternate Title  
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DOI DOI

Original Publication Original Publication
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Generic (continued) Newspaper Article (continued)
Custom 1 Column

Custom 2 Issue

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title
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Added to Library Added to Library

Last Updated Last Updated

 

Return to List of Reference Types

Page 363 of 586

 



Clarivate EndNote 20 User Help Guide

Online Database

Generic Online Database
Author  Author

Year  Year

Title Title

Secondary Author  

Secondary Title Periodical

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes  

Number  

Pages Pages

Section  

Tertiary Author  

Tertiary Title  

Edition Date Published

Date Date Accessed

Type of Work Type of Work

Subsidiary Author  

Short Title  
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Generic (continued) Online Database (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number  
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Keywords Keywords
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Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments
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Figure Figure

Caption Caption

Access Date  
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Online Multimedia

Generic Online Multimedia
Author  Created By

Year  Year

Title Title

Secondary Author Series Editor

Secondary Title Series Title

Place Published Place Published

Publisher Distributor

Volume  

Number of Volumes Date Recorded

Number Number of Screens

Pages Short URL

Section Embed URL

Tertiary Author Contributors

Tertiary Title  

Edition Time Stamp
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Generic (continued) Online Multimedia (continued)
Custom 1 Year Cited

Custom 2 Date Cited

Custom 3  

Custom 4  

Custom 5 Format/Length

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number
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Label Label
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Research Notes Research Notes
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File Attachments File Attachments
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Access Date  
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Database Provider Database Provider
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Pamphlet

Generic Pamphlet
Author  Author

Year  Year

Title Title

Secondary Author Institution

Secondary Title Published Source

Place Published Place Published

Publisher Publisher

Volume Number

Number of Volumes  

Number Series Volume

Pages Pages

Section Number of Pages

Tertiary Author  

Tertiary Title  

Edition Edition

Date Date

Type of Work Type of Work

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication
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Generic (continued) Pamphlet (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5 Packaging Method

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords
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Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date
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Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated

 

Return to List of Reference Types

Page 369 of 586

 



Clarivate EndNote 20 User Help Guide

Patent

Generic Patent
Author  Inventor

Year  Year

Title Title

Secondary Author Issuing Organization

Secondary Title Published Source

Place Published Country

Publisher Assignee

Volume Patent Version Number

Number of Volumes US Patent Classification

Number Application Number

Pages Pages

Section International Patent Number

Tertiary Author International Title

Tertiary Title International Author

Edition International Patent Classification

Date Date

Type of Work Patent Type

Subsidiary Author  

Short Title Short Title

Alternate Title  

ISBN/ISSN Patent Number

DOI DOI

Original Publication Priority Numbers

Reprint Edition  

Reviewed Item  
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Generic (continued) Patent (continued)
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Custom 2 Issue Date
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Custom 5 References

Custom 6 Legal Status

Custom 7  
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Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Inventor Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Personal Communication

Generic Personal Communication
Author  Author

Year  Year

Title Title

Secondary Author Recipient

Secondary Title  

Place Published Place Published

Publisher Publisher

Volume  

Number of Volumes Communication Number

Number Folio Number

Pages Pages

Section  

Tertiary Author  

Tertiary Title  

Edition Description

Date Date

Type of Work Type

Subsidiary Author  

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN  

DOI DOI

Original Publication  

Reprint Edition  
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Custom 1 Senders E-Mail

Custom 2 Recipients E-Mail

Custom 3  

Custom 4  

Custom 5  

Custom 6  
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Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Podcast

Generic Podcast
Author  Author

Year  Year

Title Title of Podcast

Secondary Author Narrator

Secondary Title Title of Show

Place Published Place Published

Publisher Publisher

Volume  

Number of Volumes Version

Number Number

Pages Pages

Section Running Time

Tertiary Author Producer

Tertiary Title Series Title

Edition Edition

Date Date

Type of Work Type

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISBN/ISSN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition

Reviewed Item Reviewed Item
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Generic (continued) Podcast (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Press Release

Generic Press Release
Author  Author

Year  Year

Title Title

Secondary Author Editor

Secondary Title Secondary Title

Place Published Place Published

Publisher Publisher

Volume  

Number of Volumes  

Number Number of Pages

Pages Pages

Section Section

Tertiary Author Producer

Tertiary Title Location of Work

Edition Edition

Date Date

Type of Work Type of Work

Subsidiary Author Translator

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISBN/ISSN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  
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Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title
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Database Provider Database Provider

Language Language
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Report

Generic Report
Author  Author

Year  Year

Title Title

Secondary Author Series Editor

Secondary Title Series Title

Place Published Place Published

Publisher Institution

Volume Volume

Number of Volumes Series Volume

Number Document Number

Pages Pages

Section  

Tertiary Author Publisher

Tertiary Title  

Edition Edition

Date Date

Type of Work Type

Subsidiary Author Department/Division

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN Report Number

DOI DOI

Original Publication Contents

Reprint Edition  
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Generic (continued) Report (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6 Issue

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Generic Serial
Author  Author

Year  Year

Title Title

Secondary Author Editor

Secondary Title Secondary Title

Place Published Place Published

Publisher Publisher

Volume Volume

Number of Volumes Number of Volumes

Number Series Volume

Pages Pages

Section Chapter

Tertiary Author Series Editor

Tertiary Title Series Title

Edition Edition

Date Date

Type of Work Type of Work

Subsidiary Author Volume Editor

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Publication

Reprint Edition Reprint Edition
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Generic (continued) Serial (continued)
Custom 1 Section

Custom 2 Report Number

Custom 3  

Custom 4  

Custom 5 Packaging Method

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Social Media

Generic Social Media
Author  Username

Year  Year

Title Post Text

Secondary Author Handle

Secondary Title Full Post Text

Place Published

Publisher Provider

Volume  

Number of Volumes  

Number  

Pages  

Section Share URL

Tertiary Author Affiliated Organization

Tertiary Title Embed URL

Edition Time

Date Post Date

Type of Work Type of Work

Subsidiary Author Original Author

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN ISBN

DOI DOI

Original Publication Original Post

Reprint Edition  
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Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library

Last Updated Last Updated
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Generic Standard
Author  Institution

Year  Year

Title Title

Secondary Author  

Secondary Title Section Title

Place Published Place Published

Publisher Publisher

Volume Rule Number

Number of Volumes Session Number

Number Start Page

Pages Pages

Section Section Number

Tertiary Author  

Tertiary Title Paper Number

Edition  

Date Date

Type of Work Type of Work

Subsidiary Author  

Short Title  

Alternate Title Abbreviation

ISBN/ISSN Document Number

DOI DOI

Original Publication  

Reprint Edition  
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Generic (continued) Standard (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Statute

Generic Statute
Author   

Year  Year

Title Name of Act

Secondary Author  

Secondary Title Code

Place Published Country

Publisher Source

Volume Code Number

Number of Volumes Statute Number

Number Public Law Number

Pages Pages

Section Sections

Tertiary Author  

Tertiary Title International Source

Edition Session

Date Date Enacted

Type of Work  

Subsidiary Author  

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN  

DOI DOI

Original Publication History

Reprint Edition  
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Generic (continued) Statute (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5 Publisher

Custom 6 Volume

Custom 7  

Custom 8  

Accession Number Accession Number

Call Number Call Number

Label Label

Keywords Keywords
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Notes Notes

Research Notes Research Notes
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File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title
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Database Provider Database Provider

Language Language
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Generic Television Episode
Author  Producer

Year  Year

Title Title

Secondary Author Series Director

Secondary Title Epsiode Title

Place Published Location

Publisher Distributor

Volume Season

Number of Volumes Network Name

Number Episode No.

Pages Running Time

Section Station

Tertiary Author Screenwriter

Tertiary Title  

Edition Edition

Date Broadcast Date

Type of Work Medium

Subsidiary Author Narrator

Short Title Short Title

Alternate Title Alternate Title

ISBN/ISSN  

DOI DOI

Original Publication  

Reprint Edition Reprint Edition
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Generic (continued) Television Episode (continued)
Custom 1 Performers

Custom 2 Credits

Custom 3  

Custom 4 Genre

Custom 5 Format

Custom 6  

Custom 7  

Custom 8  

Accession Number Accession Number
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Label Label

Keywords Keywords
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Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address
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Caption Caption
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Database Provider Database Provider

Language Language

Added to Library Added to Library
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Thesis

Generic Thesis
Author  Author

Year  Year

Title Title

Secondary Author  

Secondary Title Academic Department

Place Published Place Published

Publisher University

Volume Degree

Number of Volumes  

Number Document Number

Pages Number of Pages

Section  

Tertiary Author Advisor

Tertiary Title  

Edition  

Date Date

Type of Work Thesis Type

Subsidiary Author  

Short Title Short Title

Alternate Title  

ISBN/ISSN  

DOI DOI

Original Publication  

Reprint Edition  

Reviewed Item  

Page 390 of 586

 



Clarivate EndNote 20 User Help Guide

Generic (continued) Thesis (continued)
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Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  
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Keywords Keywords

Abstract Abstract
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Research Notes Research Notes
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File Attachments File Attachments
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Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author
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Database Provider Database Provider

Language Language
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Unpublished Work

Generic Unpublished Work
Author  Author

Year  Year

Title Title of Work

Secondary Author Series Editor

Secondary Title Series Title

Place Published Place Published

Publisher Institution

Volume  

Number of Volumes  

Number Number

Pages Pages

Section  

Tertiary Author  

Tertiary Title Department

Edition  

Date Date

Type of Work Type of Work

Subsidiary Author  

Short Title Short Title

Alternate Title Abbreviation

ISBN/ISSN  

DOI DOI

Original Publication  

Reprint Edition  
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Generic (continued) Unpublished Work (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number  

Call Number  

Label Label

Keywords Keywords

Abstract Abstract

Notes Notes

Research Notes Research Notes

URL URL

File Attachments File Attachments

Author Address Author Address

Figure Figure

Caption Caption

Access Date Access Date

Translated Author Translated Author

Translated Title Translated Title

Name of Database Name of Database

Database Provider Database Provider

Language Language

Added to Library Added to Library
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Generic Unused 1
Author   
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Title  

Secondary Author  
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Place Published  

Publisher  

Volume  

Number of Volumes  

Number  

Pages  

Section  

Tertiary Author  

Tertiary Title  

Edition  

Date  
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ISBN/ISSN  
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Original Publication  
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Generic (continued) Unused 1 (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number  

Call Number  

Label  

Keywords  

Abstract  

Notes  

Research Notes  

URL  

File Attachments  
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Figure  

Caption  

Access Date  

Translated Author  

Translated Title  

Name of Database  

Database Provider  
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Generic Unused 2
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Title  
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Place Published  

Publisher  

Volume  

Number of Volumes  

Number  

Pages  
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Tertiary Author  

Tertiary Title  

Edition  

Date  

Type of Work  

Subsidiary Author  

Short Title  
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ISBN/ISSN  

DOI  

Original Publication  

Reprint Edition  
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Generic (continued) Unused 2 (continued)
Custom 1  

Custom 2  

Custom 3  

Custom 4  

Custom 5  

Custom 6  

Custom 7  

Custom 8  

Accession Number  

Call Number  

Label  

Keywords  

Abstract  

Notes  

Research Notes  

URL  

File Attachments  

Author Address  

Figure  

Caption  

Access Date  

Translated Author  

Translated Title  
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Database Provider  

Language  

Added to Library Added to Library
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Generic Unused 3
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Place Published  

Publisher  

Volume  
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Number  

Pages  

Section  

Tertiary Author  
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Edition  
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Short Title  
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Original Publication  

Reprint Edition  
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Web Page

Generic Web Page
Author  Author

Year  Year

Title Title

Secondary Author Series Editor
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Place Published Place Published
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Tertiary Author  
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Edition Edition
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Subsidiary Author  
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Alternate Title Alternate Title
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Original Publication Contents

Reprint Edition  
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Custom 1 Year Cited
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File Attachments File Attachments
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Access Date  
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Output Styles

Introduction to Output Styles

What is an Output Style?
The term "output style" (or just "style") is used to describe a particular method of documenting your work. 
Each style is designed as a complete solution for formatting and editing in-text citations, footnote citations, 
and bibliographies for all types of references.

You can think of styles as templates that show EndNote how to arrange the information in each of your 
EndNote references for citations and bibliographies. For example, a single reference could be formatted in 
the Chicago style like this:

Emery, N. J., and N. S. Clayton. "Tool Use and Physical Cognition in Birds 
and Mammals." Review. Current Opinion in Neurobiology 19, no. 1 (Feb 2009): 
27-33. https://doi.org/10.1016/j.conb.2009.02.003.

Or it could be formatted in the Nature style like this:

1   Emery, N. J. & Clayton, N. S. Tool use and physical cognition in birds 
    and mammals. Curr. Opin. Neurobiol. 19, 27-33, 
    doi:10.1016/j.conb.2009.02.003 (2009).

EndNote includes over 7,000  individual bibliographic styles. With a standard installation, only the most 
popular styles are installed in the Styles folder in your EndNote folder, but you can add more styles, if you 
wish. (See Installing Additional Output Styles.)

The name of the style refers to the journal or publisher that has defined the bibliographic format. The Nature 
style, for example, is based on the format required by the journal Nature, and the Chicago style is named 
after the Chicago Manual of Style. Styles in the Export category, such as RefMan (RIS) Export are  not 
bibliographic styles, but rather export styles designed to aid in transferring EndNote data into other 
databases. (See Exporting References for Database Import  for information on exporting data from 
EndNote.)

To see the available styles in EndNote’s Styles folder, select Output Styles from the Tools menu, and select 
Open Style Manager…. If your style is not available, you can download additional styles. Any style can be 
modified to suit your needs, plus you can create new styles.

Styles can be downloaded or edited, and new styles can be customized, through EndNote's Style 
Manager. (Select EndNote Output Styles  from the Help  menu or click Get More on the Web…  to 
download styles from the EndNote site.)

▪

The Style Manager allows you to find and preview installed styles. Commonly used styles can be 
marked as "favorites," which will appear in the Output Styles submenu of the Tools menu and in the 
list of available styles in Cite While You Write.

▪
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The Output Styles Menu

The Style Manager

The style  selected from the Output Styles submenu of the Tools menu determines how references are 
formatted for the preview subpanel in the Reference panel, as well as for the Format Bibliography, Format, 
Print, Export, and Copy Formatted Reference commands.

By default, these standard bibliographic styles are set as favorites in your Output Styles menu:

Annotated: This style generates Author-Date citations. The bibliography includes abstracts.▪

APA 7th: This style displays all authors if there are twenty or less; if there are twenty-one or more, it 
displays the first nineteen authors (or editors), followed by a comma and an ellipsis, followed by the 
last author (or editor).

▪

Author-Date: This style generates a bibliography alphabetized by author name, and in-text citations 
with the Author and Year.

▪

Chicago 17th Footnote: This style is based on the Chicago Manual of Style, 17th edition. It contains 
footnotes and a bibliography.

▪

MHRA (Author-Date): This style is based on the Modern Humanities Research Association style. An 
MHRA footnote style is also available.

▪

Numbered: This  style generates a numbered bibliography with corresponding numbered in-text 
citations.

▪

Show All Fields: This style generates a list of the references as entered, including all fields and the 
names of the fields.

▪

Turabian 9th Footnote: This style is based on the 9th edition of A Manual for Writers of Research 
Papers, Theses, and Dissertations.

▪

Vancouver: This style is based on the "Medical Journal" requirements in Citing Medicine, published 
by the US National Institutes of Health at http://www.nlm.nih.gov/bsd/uniform_requirements.html.

▪

Mark individual styles as your favorites in The Style Manager  to have them appear in the Output Styles 
menu, the Reference Preview subpanel, and when using Cite While Your Write, Format Paper, or Export 
commands.

EndNote includes more than 7,000 individual bibliographic styles. By default, only the most popular styles 
are stored as individual files in the Styles folder in your EndNote folder. To install additional styles, see 
Installing Additional Output Styles.

The name of the style refers to the journal or publisher that has defined the bibliographic format. The Nature 
style, for example, is based on the format required by the journal Nature, and the Chicago style is named 
after the Chicago Manual of Style. Styles in the Export category, such as RefMan (RIS) Export are  not 
bibliographic styles, but rather export styles designed to aid in transferring EndNote data into other 
databases.

To see if your journal’s style is installed in EndNote, peruse the list of styles in the Style Manager. If your 
style is not available, any style can be modified to suit your needs, you can create new styles, or you can 
install additional styles (see Installing Additional Output Styles).
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Navigating in the Style Manager

Marking Your Favorite Styles

To see the available styles in EndNote’s Styles folder, select Output Styles from the Tools menu, and then 
select Open Style Manager.

The Style Manager lists the names of the original styles available in the C:\Program Files (x86)\EndNote 
20\Styles folder as well as any new or modified styles in your personal Styles folder. It gives you options to 
edit styles or select them as “favorites” for quick access from the Output Styles menu on the Tools menu, or 
anywhere a styles list is shown. You can click and drag the corner of the dialog to increase the size.

Use the following features to locate the output style that you want to use:

If you know the name of the style that you want to use, you may start typing it and the first file that 
matches what you type will be selected.

▪

Click the Find By button and choose a category (such as Biochemistry or Humanities) to find only the 
bibliographic styles for a specific discipline.

▪

Click the Find By button and select All Styles to return all of the installed styles to the displayed list.▪

Click the column headings to sort  the styles by name or by category. Clicking the same column 
heading a second time will change the sort order from ascending to descending. Click again to set it 
back to ascending order.

▪

Click the More Info  button at the bottom of the dialog to display additional information about the 
selected style (such as modification and creation dates, and any comments or limitations). More Info 
toggles with Less Info. You also have the option of displaying a preview of the style in the More Info 
panel.

▪

When you have found a style that you want to use, click the checkbox to mark it as a favorite. All styles that 
are marked as favorites appear in the Styles menu. This gives you easy access to the styles you use most 
often. All styles can be modified to meet your specifications. You can also create completely new styles if 
necessary.

To add a style to the Output Styles submenu on the Tools menu:

From the EndNote Tools menu, select Output Styles, and then select Open Style Manager.1.

Find the style that you need.2.

Click in the box to the left of the style's name to choose it as one of your favorites.3.

Close the Style Manager by clicking the Close button or selecting Close Style Manager from the File 
menu in the Style Manager.

4.

To select a whole category of styles as favorites, click the Find By  button in the Style Manager, select the 
category of interest, and then click Mark All when all of the styles for that category are displayed. Click the 
Find By  button and select All Styles  to bring all the styles back into view. The Unmark All  button may be 
used to unmark all of the output styles that are showing in the list.
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If You Cannot Find the Style You Need

Previewing Styles and Showing Information

Previewing Styles Using Your Own References

Many bibliographic styles are variants of a small number of well-known bibliographic formats. EndNote 
includes over 7,000  different styles, but it may not include the exact style you need. If you can't find the 
specific style you need, you can:

Check the submission guidelines for the publication to see if the style is a derivative of a well-known 
style. You may be able to use that style (perhaps with minor modifications).

▪

Try the interactive Styles Finder on the EndNote site. A shortcut to the Web Styles Finder is provided 
as EndNote Output Styles on the Help menu.

▪

Click More Info in the Style Manager to show the information panel. (When you select More Info, the button 
changes to Less Info, which would hide the panel.) The information panel is used to display more detail 
about the selected style.

Use the Style Info/Preview button to toggle between these displays:

Style Information: Details about the style are displayed in the Information panel. These include the 
creation and modification dates, category, which style guide the style is based on, and any limitations 
or comments about using the style.

▪

Style Preview: In the preview section, EndNote shows how a journal, book, and book section would 
be formatted with the selected style.

▪

EndNote uses built-in examples for the previews in the Style Manager window. If you want to preview a style 
using your own references:

In the Style Manager, mark the style as a favorite by clicking in the checkbox next to its name. This 
adds the style to the Output Styles favorites list.

1.

From the Tools menu, select Output Styles, and select the style to preview.2.

Open a library, select a reference, and then expand the Preview  subpanel in the Reference 
Summary panel. See The Preview Subpanel.

3.

Select any reference in your library to have it displayed in the Preview subpanel.4.

The Preview panel displays only one reference at a time. If you would like to preview a group of references, 
you can use the Copy Formatted Reference command:

From the Tools menu, select Output Styles and select a style.1.

Select one or more references in your library and select Copy Formatted Reference (Ctrl+K) from the 
Edit menu.

2.

Paste (Ctrl+V) the formatted references into a word processor document to see them as they would 
appear in a bibliography.

3.

Or, use the Print Preview command from the File menu to show how the formatted references would look.
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Copying Styles

Saving Styles

Deleting Styles

When you display a list of styles in EndNote, the list is comprised of the installed styles found in the  C: 
\Program  Files (x86)\EndNote 20\Styles  folder as well as new or modified styles found in your personal 
Styles folder. For an explanation of where your files are stored, see Folder Locations Preferences.

Because each style is a separate file on your hard drive, you can copy them as you would copy any file on 
your hard drive using the File Explorer.

To copy a style to a removable  or network drive, select the style on your hard drive and drag it to the new 
location, or use the Copy (Ctrl+C) and Paste (Ctrl+V) commands. We recommend that you make a backup 
copy of any new or modified styles. (See Backing Up Your EndNote Files).

To make a copy of a style from within EndNote:

From the Tools menu, select Output Styles and select Open Style Manager.1.

Select the style you want to copy and click Edit.2.

Without making any changes to the file, select Save As from the style's File menu.3.

Give this copy of the file a new name and Save it.4.

The file is saved in your personal Styles folder. The new style will remain open. The original style will be left 
untouched.

To save a new style that you have just created, or to save changes to a style you have just modified, select 
Save or Save As from the style's File menu.

If you have modified one of the styles EndNote originally installed, you must use Save As to save a copy to 
your personal Styles folder. If you have modified a style that is already located in your personal Styles folder, 
you can select either Save  to directly modify the file, or Save As  to make a copy with the changes. For a 
description of where  your styles are stored, see Folder Locations Preferences.

If you close a Style window before saving a style, EndNote prompts you to save or discard the changes you 
have made, or select Cancel to return to the style. If you quit from EndNote while a Style window is open, 
the same dialog appears.

EndNote automatically saves new styles to your personal Styles folder. You may also specify a different 
folder if necessary. For instructions see Folder Locations Preferences.

EndNote styles use the file name extension of ".ens" (for EndNote Style), as in "Nature.ens."

To delete a style from EndNote:

From the Tools menu, select Output Styles, and then select Open Style Manager.1.

Select the style to be deleted.2.
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Renaming Styles

Reverting Changes to a Style

Closing a Style

What Should I Do if My Style Is Not Included?

Right-click on the style and select Delete Style… from the menu, or press the Delete key.3.

You can also delete an unwanted style by switching to the  File Manager, opening the appropriate Styles 
folder, and deleting the file (see Folder Locations Preferences).

Note: You must have read/write access to the Styles folder in order to delete a style. If you do not have 
administrator access, you likely will not be able to delete a file located within the Program Files (x86) 
folder.

Rename styles using the Save As command from the style's File menu. This allows you to make a copy of 
any style that you want to modify, so you can keep several variations of the same style. You can also 
rename styles by switching to the File Explorer, locating the style file in the Styles folder, clicking on the file 
name, and typing a new name.

For an explanation of where your files are stored, see Folder Locations Preferences.

If at any time you need to revert your changes back to the last saved copy of the style, select Revert Style… 
from the style's File  menu. Once you close the Style window, or save the changes to a style, the changes 
are permanent until changed again.

To close a Style window, click the close button in the upper-right corner of the window, or select Close Style 
from the style's File menu. If you have not saved your changes to the style, EndNote prompts you and gives 
you the option to save or discard any changes that you have made.

EndNote supplies over 7,000 styles  for your convenience; however, because there are so many journals 
published, the style  you need may not be included. This should not be a problem because you can 
customize a style of your own or edit any of EndNote’s preconfigured styles.

If a style that you need is not included with EndNote, we recommend modifying a style that is similar to what 
you need. To download more of the predefined styles, see Installing Additional Output Styles.

To find and modify a similar style:

From the Tools menu, select Output Styles, and then select Open Style Manager.1.

In the Style Manager, change the setting in the information panel from Style Info  to Style Preview. 
The preview of the selected style should now be displayed.

2.

Scroll through the list of available styles to see if you can find one that is similar to what you need.3.

Once you have found a similar style, select it, and click the Edit button. The Style window opens.4.
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Accessing Styles in Other Places

Basic Components of a Style

The Style Window

From the style's File menu, select Save As, give this copy of the style a new name that corresponds 
to the name of the journal you want to use it for, and click Save. This will also keep the original style 
unchanged, in the event that you need to use it later.

5.

The new Style window remains open for you to edit it as you need. For more details about editing 
parts of a style, read Modifying Style Templates and Additional Style Formatting Options.

6.

Once the new copy of the style has been saved, it will be added to your style menus.

The Style Manager displays only the styles found in specific folders. We recommend that you copy 
additional styles to your personal Styles folder.

For an explanation of where your files are stored, or to change your personal Styles folder location, see 
Folder Locations Preferences.

The best way to understand how a style works is to open one up and look at it.

To create a new style: From the Tools menu, select Output Styles, and then select New Style. For 
more information on creating a new style, see Creating a New Style.

▪

To edit a style: From the Tools  menu, select Output Styles,  and then Open Style Manager. Select 
the style to edit and click Edit. The most recently used style can also be opened by selecting Output 
Styles from the Tools menu, and then selecting Edit "[recent style's name]."

▪

After choosing the option to edit an existing style or create a new one, EndNote opens the Style window.

The options for editing a style are listed on the left side of the Style window. The first six items apply to 
citations, bibliographies, and citations in footnotes. They include:

About This Style▪

Punctuation▪

Anonymous Works▪

Page Numbers▪

Journal Names▪

Sections▪

The other options in the Style window are grouped under one of following four headings.

Citations: The  items listed under the Citations heading apply only to citations in the body of 
the text.
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Style Templates

Other Style Options

Modifying Style Templates

Bibliography: The  items listed under the Bibliography heading apply to the bibliography that 
EndNote creates when you format a paper. These settings are also used with the Export, Print, 
Copy Formatted Reference, Subject Bibliography, and Preview features.

Footnotes: The items under the Footnotes heading apply to citations that have been inserted 
into the footnotes or endnotes in a word-processing document. (You must first create the 
footnotes or endnotes in your word processor, and then insert EndNote citations into them.)

Figures and Tables: The items under Figures and Tables apply to EndNote figures and tables 
that have been inserted into a Microsoft Word document.

Click the plus/minus button next to one of the headings to expand or collapse the view, or to show or hide 
the related options. Click on an item under the headings to view the associated panel. You may switch 
between panels as needed while editing the file. No changes are saved in any of the panels, however, until 
you select Save or Save As from the style's File menu.

The Citation, Bibliography, and Footnote sections of the style all have a Template panel and other options 
for fine tuning the style.

The Templates panels are the major component of the styles. They include the field names and punctuation 
organized in the way EndNote should format the references for that particular style. The templates look like 
citations or bibliography entries, except that field names are used in place of the actual data. During the 
formatting process, EndNote replaces the field names with the corresponding information from the 
references.

For details about working with style templates see Modifying Style Templates.

Under each heading in the Style window (Citations, Bibliography, and Footnotes) there are a series of 
options for how to fine-tune the formatted references in citations, bibliographies, or footnotes. Many of these 
options are repeated for the three sections (such as the settings that determine how author names are 
treated), because each of these three areas of the document might require a slightly different format. The 
Figures and Tables  section applies specifically to EndNote figures and tables inserted into a Word 
document.

If you are creating a bibliography that requires a style  not included with EndNote, then you can modify a 
style to suit your needs. (See What Should I Do if My Style Is Not Included?) Editing a style requires a 
general understanding of how styles work and the components of a style. Read Basic Components of a 
Style to become familiar with the terms. These topics can help you in creating or modifying style templates:

Citations Template▪

Bibliography and Footnote Templates▪

Changing the Punctuation in a Formatted Reference▪

Adding and Removing Fields in a Formatted Reference▪

Page 409 of 586

 



Clarivate EndNote 20 User Help Guide

Opening the Style Window

Citations Template

Adding New Reference Types▪

Fonts and Text in Output Styles▪

Rules for Working with Style Templates▪

EndNote Cleans Up▪

Special Formatting Characters▪

Additional Style Formatting Options▪

To create or modify a style, you will first need to access the Style window by opening an existing style or 
creating a new style.

To open a style for editing or create a new style:

To create a new style: From the Tools menu, select Output Styles, and then select New Style. For 
more information on creating a new style, see Creating a New Style.

▪

To edit a style: From the Tools  menu, select Output Styles,  and then Open Style Manager. Select 
the style to edit and click Edit. The most recently used style can also be opened by selecting Output 
Styles from the Tools menu, and then selecting Edit "[recent style's name]."

▪

If you have opened an existing style, you will see a style window with options already set up, but ready for 
editing, with the style name at the top of the Style window. To save your customized version of the style, 
select Save As from the style's File menu.

If you have created a new style, you will see Untitled Style at the top of the Style window until you save the 
file with a new name. To save the file, select Save As from the style's File menu.

You can move between the Style window and other windows in EndNote by selecting the window of your 
choice from the Window menu in EndNote.

To access the Citations template, first open a style for editing or create a new style.

Select Output Styles from the Tools menu, then select one of the following options1.

New Style to create a new style.▪

Edit "[name of recently used style]" to open a style you have recently used for editing.▪

Open Style Manager to access the list of styles installed on your computer, then select a style 
and click the Edit button.

▪

Then click Templates under the Citations heading.2.

The Citations template tells EndNote how to format the in-text citations in the body of your paper. The most 
popular formats for in-text citations are (Author, Year), numbered, and Author (Year). For example:
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Multiple Citation Separators

Adding Additional Fields to In-Text Citations

An (Author, Year) format displays "(Author, Year)" in the Citation area of the template. When you 
insert an in-text citation in your paper using this format, the citation would look like this example: 
 
     (Binfield, 2008)

▪

A numbered format displays "[Bibliography Number]" in the Citation area of the template. Numbered 
styles commonly enclose the bibliography number in brackets or parenthesis, or use a superscript 
number. Instead of (Binfield 2008) as your in-text citation, the citation would look like this example: 
 
     [1] or (1) or 1 
 
The bibliography number corresponds to a numbered reference in your bibliography. If the same 
reference is inserted in the paper in more than one location, the same number will be used for that 
reference in each location. This differs from footnote or endnote styles, where a new number is used 
for each footnote or endnote.

▪

An Author (Year) format displays "Author (Year)" in the Citation — Author (Year) area of the template. 
When you insert an in-text citation in your paper using this format, the citation would look like this 
example: 
 
     Binfield (2008)

▪

You may change the template by deleting unwanted field  names or punctuation, retyping the punctuation 
you want, and inserting new fields with the Insert Field button. See Modifying Style Templates  for 
information about editing templates.

Note: Both the Citation and the Citation — Author (Year) area of the template must be completed in order 
to use the Author (Year) format in a paper.

Use the Multiple Citation Separators field to specify the punctuation to separate multiple citations in your 
papers. A multiple citation is an in-text citation that includes more than one reference within a single set of 
delimiters, such as: (Argus, 1993; Billoski, 1993; Hall, 1988). This example uses a semicolon and a space 
as the separator between citations.

The separator can be changed by typing other text in the Multiple Citation Separator  field. Remember to 
include a space in the separator section, when necessary.

You can add other EndNote fields to the citation template. For example, If you would like EndNote to insert 
the journal name in the in-text citations of your paper, select the Journal/Secondary Title field from the Insert 
Field menu, as shown in the examples below.

In the Citation area of the template, insert the Journal/Secondary Title field in the (Author, Year) field. 
For example: (Author, Journal/Secondary Title Year) 
 
When you insert an in-text citation in your paper, the citation would look like this example: (Porter, 
British Journal of Aesthetics 2009)

▪
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Year Format

Bibliography and Footnote Templates

Generic Template

In the Citation — Author (Year) area of the template, insert the Journal/Secondary Title field in the 
Author (Year) field. For example: Author, Journal/Secondary Title (Year) 
 
When you insert an in-text citation in your paper using this format, the citation would look like this 
example: Porter, British Journal of Aesthetics (2009)

▪

Note: The field names shown on the Insert Field list and in the Citations Template must always be the 
EndNote generic field names. If you try to enter a field name manually that is not a generic field name, it 
will be interpreted as text to be added to the citation.

If you would like EndNote to use 2-digit years (such as '09) in the in-text citations, check the Use 2-digit 
years option. Years from all centuries will be abbreviated to display just the last two digits. This applies only 
to the in-text citations.

Note: The use of 2-digit years in citations is very rare now, but was common in the 20th century.

If you have not yet done so, open the Style window for the style you wish to work with. (See Opening the 
Style Window.)

Click Templates under the Bibliography or Footnotes heading in the Style window to see the templates for 
how those references are formatted.

For footnote and bibliography templates, each has a Generic template, and other reference-type-specific 
templates to format the various reference types in a bibliography.

The following examples show how journal articles, books, and book sections, respectively, would be 
formatted with the Numbered style. Notice that each reference type  is formatted differently, which is why 
different templates are required:

1.  Wang, L., et al., Azure-winged magpies fail to understand the principle  
    of mirror imaging. Behavioural Processes, 2020. 177: p. 8.

 
2.  Pepperberg, I.M., The Alex studies: Cognitive and communicative  
    abilities of grey parrots. 1999, Cambridge, Mass.: Harvard University  
    Press. 434.

 
3.  Clayton, N.S. and N.J. Emery, What Do Jays Know About Other Minds and  
    Other Times? in Neurobiology of “Umwelt,” A. Berthoz and Y. Christen,  
    Editors. 2009, Springer-Verlag Berlin: Berlin. p. 109-123.

The Generic template is used to format references that use the Generic reference type or do not have their 
own template in the style. For example, if a Book template had not been included in the style, book 
references would be formatted using the Generic template.
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Generic — Short Form Template

Other Reference Type Templates

Footnote Template Options

Changing the Punctuation in a Formatted Reference

The Generic — Short Form template may be defined for each reference type just like the regular footnote. 
You can edit the short form in a template. The order of use is that:

The short form definition for a specific reference is used.1.

If the definition is not available, then the generic short form definition is used.2.

If no generic definition is available, then the full form of the reference for that type is used.3.

If the full form is not available, then the generic full form is used.4.

The rest of the templates in the style tell EndNote how to format specific reference types, such as journals, 
books, and book sections. If a check mark appears next to a reference type in the Reference Type list, a 
template is already defined for it (you can edit the template).

Styles have varying requirements for how citations in footnotes should be formatted. The options at the top 
of the Footnotes Templates panel in the Style window allow for the different conditions.

For some styles, citations in footnotes are formatted just like in-text citations (in the body of the 
paper). In that case, there is no need to create a special template for footnotes; select the Same as 
citation option from the Format citations in footnotes list.

▪

Similarly, some formats request that citations in footnotes are formatted as full bibliographic 
references, exactly like the bibliography. For those styles, set the Format citations in footnotes option 
to Same as Bibliography.

▪

However, if you need the footnotes to use their own special format (most styles for the humanities 
require this), you would set the Format citations in footnotes option to Using footnote format to format 
citations in footnotes with a unique footnote format. For this option, you need to define the templates 
for how citations in footnotes should be formatted.

▪

For information about how to treat repeated citations, such as using a short form for nonconsecutive 
repeated citations, and Ibid. for consecutive repeated citations, see Repeated Citations in Footnotes.

For repeated citations, select the checkbox that tells the system to include the Title field only when needed 
to disambiguate a citation in the short form.

If you have not yet done so, open the Style window for the style you wish to work with. (See Opening the 
Style Window.) For this example, open the Numbered style.

Punctuation that appears in your formatted references can be changed by editing the style you are using. 
When you edit a style, you can delete unwanted punctuation, replace it with other punctuation, or add 
additional punctuation where necessary.
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Adding and Removing Fields in a Formatted Reference

For example, if the Numbered style creates a perfect bibliography for your document except  that it puts a 
comma after the authors’ names where you need a period, you can edit the Numbered style to make this 
change.

To edit the Numbered style:

Open the Numbered style. (See Opening the Style Window.)1.

Click the Templates option under the Bibliography heading.2.

For each reference type (such as Generic, Journal Article, and Book), delete the comma that follows 
the field name Author and type a period.  
 
The style’s  bibliographic templates should now look like the example below. Notice that the 
punctuation after the Author field in each template has been changed to a period.  
 

 

 

3.

From the style's File  menu, select Save As. In the dialog that appears, enter a new name for this 
modified Numbered style, and then click Save.

4.

Now you can use the new style to create a formatted bibliography that puts a period between the author 
names and the titles.

For information about making punctuation or spaces appear only under certain circumstances see Special 
Formatting Characters. That topic explains the use of the nonbreaking spaces (°), vertical bars (|), accent 
grave (`), and the carets (^) that you see in the style templates.

Note: If you save a new style into a folder other than your personal Styles folder, it will not be available in 
the Style Manager. You should save new styles to your Styles folder, or change Folder Locations 
Preferences if necessary.

If you have not yet done so, open the Style window for the style you wish to work with. (See Opening the 
Style Window.)
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Adding a Field to a Style Template

Deleting a Field from a Style Template

Adding New Reference Types

The field names (such as Author, Year, and Title) that you see when editing a style template indicate what 
information is included in your formatted reference. If you want to include a field, such as Notes, along with 
your references, you should add the Notes field to the style that you use. Similarly, to exclude unwanted 
information that is appearing in a bibliography, you must delete the field name that contains that information 
from the style’s bibliography template.

The examples below show two common scenarios in which fields are added to or  removed from the 
formatted bibliography. Whenever you change the fields in a style template be sure to check the surrounding 
punctuation to make sure that it is still accurate.

To insert a new field into a style template:

Click on the Templates option under the Bibliography heading, and position the cursor at the location 
in the template where you want to add a field.

1.

Click the Insert Field button and select the field to be added.2.

After the field is inserted, add any punctuation or spacing that is necessary to correctly incorporate 
the new field into the style.

3.

Note: As a short-cut, you can use the options in the Layout panel to add text or punctuation before or 
after every reference in a bibliography. See Bibliography Layout.

If EndNote includes information in your bibliography that you do not want to be there, you can edit the style 
and delete the unwanted field’s name and any associated punctuation.

For example, if a style includes the issue number in your journal references, and you do not want the issue 
to appear:

Under the Bibliography heading, click the Templates option.1.

Select the text to be deleted (for example, ". Issue|"), and press the Delete or Backspace key.2.

Along with the Issue field, also remove the space and period that precede it and the vertical bar, a special 
formatting character that  follows the Issue field. (See Special Formatting Characters  for more information 
about the vertical bar.)

If you have not yet done so, open the Style window for the style you wish to work with. (See Opening the 
Style Window.)

When a style does not include a template for a specific reference type, such as Report, EndNote uses the 
style’s Generic template to format that reference type. Although there are times when the Generic format 
suffices, often it is not sufficient because the other reference types need to be formatted differently. 
Therefore, you should make specific templates for the different reference types that you will be including in 
your bibliographies.
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Defining the Format for the New Reference Type Template

A Faster way to set up a new Reference Type Template

Fonts and Text in Output Styles

To add a new reference type template to a style:

In the Style window, click the Templates panel under the Bibliography heading.1.

Select the name of the desired reference type from the Reference Types  drop-down menu . 
(Reference Types that are already defined appear in the list with checkmarks next to their name.)

2.

An empty new template for that reference type is added at the bottom of the Style window (scroll to the 
bottom of the Style window if you do not see it).

Defining the format for a new template is a process of inserting the necessary fields and punctuation in the 
correct order. For this example, we want a report to look like this (Author, Title, Report Number. Year, 
Institution: City.):

We can insert the fields and type the punctuation to create a template for the Report reference type. Use the 
Insert Field button at the top of the Style window to insert the fields in the correct order. After inserting a field 
name, type the punctuation and spacing that should follow it. Apply text styles, such as italics for the Title, 
by selecting the text to change and using the Style toolbar.

The final template for the Report reference type looks like this:

Report  
Author,·Title,·Report·Number.·Year,·Institution:·City.

If there is another reference type template that is very close to the one you want to create, copy and paste 
the contents of that template into the new template you created. EndNote will automatically replace the field 
names from the original template with the the equivalent fields for the new reference type. Next, proofread 
the fields to be sure they are correct and change any fields or punctuation, as needed. If needed, delete 
incorrect fields and use Insert Field to insert any needed fields into the template.

By default, text entered into a Style window appears in EndNote’s Plain Font, Plain Size, and Plain Style 
settings, which allow the bibliography that EndNote creates to adopt to your word processor's Normal style 
settings in your paper. For example, if you type your paper in 10-point Times New Roman font by manually 
selecting the text and setting it to 10-point Times New Roman font, but the Normal style in your document is 
set to use 14-point Arial font,  EndNote would use the 14-point Arial font for the paper’s bibliography.

You can use the Edit menu or the Style toolbar to apply any font, size, or text style to your Style templates to 
override the default setting for specific fields that might require it, but it is generally better to use the Plain 
settings. (Note that only the standard Windows fonts are available.)

All text attributes entered into a style template will carry over into the bibliography that EndNote creates. You 
can use this feature, for example, to italicize titles or make the volume numbers bold. Any font or text style 
changes entered in an EndNote Reference window will carry through the bibliography as well. For example, 
any italicized terms in your references will still appear italicized in your bibliography, regardless of the text 
attributes that the EndNote bibliographic style applies.
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To Apply Bold, Italic, or Underline Styles to Fields or Text

To Change the Font for Selected Text

Rules for Working with Style Templates

Rule #1: Basic Dependence

Select the field or text to be formatted.1.

Choose the formatting option from the toolbar in the Style window, or select the option from the 
Font submenu in the style's Edit menu..

2.

Use the following shortcuts.3.

Ctrl+B for bold▪

Ctrl+I for italic▪

Ctrl+U for underline▪

Ctrl+Shift++ (the  last + is the plus sign, so this means to hold down the Ctrl key, the Shift key, 
and the + key together) for superscript

▪

Ctrl+Shift+‒ (the ‒ is the minus sign, so this means to hold down the Ctrl key, the Shift key, and 
the ‒ key together) for subscript

▪

Some styles require a different font to be used for some fields, usually the Title field. In these cases, the 
style must include a font change for just those fields that require it. To change the font for a specific field:

Select the field to be formatted.1.

From the style's Edit  menu, select the font you need from the Font  drop-down list. The default will 
show as Plain Font.

2.

Note: If text is italicized in the library, then the field is italicized by the style, that text will still appear in 
italics in the formatted references. EndNote cannot reverse the italics in a field to plain text when the field 
is italicized in the style. 

There are four basic rules of dependence that govern how text, spaces, and field  names influence each 
other when they are used in a style template. If necessary, these rules can be circumvented in specific 
situations using the special formatting characters described in the next section of this chapter.

Note: The middle dot (·) character indicates a space in examples.

Any text or punctuation that is not separated from a field by an ordinary space is dependent on the adjacent 
field.

In this context, "dependent" means that the text or punctuation adjacent to a field only appears in your 
bibliography if the adjacent field contains data. For example, in this excerpt:
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Rule #2: The Preceding Field Takes Precedence over the Following Field

Rule #3: The First Space after a Field Is Dependent on That 
Field; Additional Spaces Are Independent

Rule #4: Independent Text Always Appears in the Bibliography

Volume·(Issue)

the parentheses around "Issue" only appear in a formatted reference if there is an issue number for the 
reference.

When punctuation appears between two fields with no intervening spaces, it is dependent on the preceding 
field.  
In this example:

Volume:Issue

the colon is dependent on the Volume field. This means if there is no volume in the reference, the colon will 
not appear. If there is a volume, the colon will appear.

Note: This example shows a case where the rules of dependence might not do what you want. For 
example, you might want to have the colon only show when there is an issue. This can be done using the 
Forced Separation character. See Special Formatting Characters.

The first ordinary space following a field is always dependent on that field. Any consecutive spaces after that 
are independent and will always appear in the formatted references.

For example, if EndNote formats an anonymous book using a template that has the Author field followed by 
a space and the Title field:

Author.·Title

the title will not be preceded by a space in the final formatted reference because the space, just like the 
period, is dependent on the Author field. However, if the style includes two spaces between the Author and 
the Title:

 Author.··Title

the title will be preceded by one space for all anonymous references. The first space, being dependent on 
the Author field, disappears when there is no author, however the second space is independent, so it 
remains in the formatted reference.

Independent spaces can be forced to be dependent on an adjacent field using the special formatting 
characters.

Any text or punctuation that is not dependent on a field name always appears in the formatted references. 
For example, if:

Edition·ed.
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Special Formatting Characters

Link Adjacent Text (Using the Nonbreaking Space)

Forced Separation—Using the Vertical Bar

is entered into a style’s Book template using only an ordinary space to separate the text "ed." and the field 
"Edition" the text "ed." will appear in all Book references—regardless of whether or not there is an edition for 
that reference.

Note: The nonbreaking space can be used in place of a regular space to link independent text to a field. 
See Special Formatting Characters.

EndNote has special formatting characters that add flexibility and precision to the grouping of punctuation 
and fields in the style templates.

Note: Special characters appear in this color  font here to make them more visible, but in the standard 
black font in EndNote. Regular spaces are indicated by the dot (·) character.

If you type "Edition ed." into a style template and use an ordinary space to separate the field name "Edition" 
from the abbreviation "ed.", then "ed." will appear regardless of whether or not the reference has an edition 
(see Rule #4: Independent Text Always Appears in the Bibliography).

To avoid this problem, make "ed." dependent on the Edition field by linking "ed." to the Edition field with a 
nonbreaking space. Think of a nonbreaking space as bibliographic formatting glue. It joins two or more 
items together so they act as a single unit. Thus, any text or punctuation "glued" to a field will drop out of the 
bibliography if that field is empty.

You can insert a nonbreaking space by selecting Link Adjacent Text  from the Insert Field  list in the 
Templates panels. You can also enter it by typing Ctrl+Alt+Space. It appears on the screen as a degree (°) 
character.

The nonbreaking space is converted to a normal space in the formatting process. Common uses of the 
nonbreaking space include (where "°" is used as a nonbreaking space):

p^pp°Pages
Edition°ed.
vol°Volume
Editor°Ed.^Eds.

The nonbreaking space is also used in conjunction with the vertical bar (see below) to change the 
dependency of a punctuation mark from one field to another.

Volume|:°Issue|.

In this case, the colon (:) is linked to the Issue field with a nonbreaking space, so it does not print in the 
bibliography if the Issue field is empty.

If you do not want text or punctuation to be dependent on the preceding or adjacent field, use the vertical 
bar character (|), to force a separation of the text from a field. The vertical bar can be found on the same key 
as the backslash (\). It can also be inserted from the Insert Field list in the Templates panels.
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Field Names in Bibliographies

Think of a vertical bar as breaking  dependence, or forcing separation between two dependent items. (The 
vertical bar works in exactly the opposite way as the nonbreaking space.)

For example, the Journal Article templates in some styles require a period between the volume and issue. A 
template for such a style might look like this (where "·" indicates a space):

Journal Article 
Author.·"Title."·Journal·Volume.Issue·(Year):·Pages.

However, when this style formats a journal article that does not include an issue number, the bibliography 
entry will be incorrect, as in the following example:

Clark, H. and Carlson, T. "Hearers and Speech Acts." Language 58.(1982): 
332-373.

Notice that the period used to separate the volume from the issue appears here in the absence of an issue 
because it is dependent upon the Volume (Rule #2). And the space separating the volume and the year is 
lost because that space is dependent upon the Issue field (Rule #3).

EndNote has a way of avoiding these problems. The vertical bar character (|) can be used to break the 
automatic grouping of spaces and punctuation with adjacent fields.

If you insert the vertical bar before the period in our example, the period’s dependency switches from the 
Volume field to the Issue field. Add another vertical bar before the space that follows the Issue field, and the 
space will no longer be dependent on the Issue field. Use the vertical bar character in conjunction with the 
nonbreaking space. With these changes the style looks like this:

Journal Article 
Author.·"Title."·Journal·Volume|.Issue|·(Year)|:°Pages|.

And the formatted reference without an issue is correct:

Clark, H. and Carlson, T. "Hearers and Speech Acts." Language 58 (1982): 
332-373.

Other common examples for using the vertical bar include:

Publisher|:°City
Pages|. (to make the final period independent of the field before it)

Sometimes you may need to use text in a template that is also an EndNote field name for that reference 
type. For example, you may want to use the word "Editor" after the editor’s name:

Jones, V.R., B.K. Marion, and R.L. Zeiss, The Theory of Foraging, in A 
History of Foraging Behavior, B.J. Bloggs, Editor. 1976, Smith and Barnes: 
New York.

Normally, EndNote interprets the word "Editor" as a field name when it appears in a book’s style template. 
This is true even of field names that appear as part of a word, such as "Editors" or "Issued." Field names 
need not be capitalized to be recognized.

To force EndNote to interpret a word as just text and not as a field name in a template, put an accent grave 
character (`) before and after the word: `Editor`. The accent grave is found in the upper left corner of most 
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Singular/Plural Term Separator (Caret ^)

EndNote Cleans Up

keyboards, on the same key as the tilde (~). Remember to also use the nonbreaking space to link the text, 
`Editor`, to the Editor field.

Book Section 
Author,·Title|.°in°Book·Title|,°Editor,°`Editor`^`Editors`|.·Year,·Publisher 
|:°City|,·p.°Pages|.

You can specify both singular and plural forms of labels for editors or pages in a formatted reference by 
using a caret (^) to separate the terms. For example, some styles put "Ed." after a single editor and "Eds." 
after several editors’ names. Or, similarly, "p." might precede a single page, while "pp." precedes multiple 
pages. This feature can be applied to any field that corresponds to the Generic field for Author, Secondary 
Author, Tertiary Author, Subsidiary Author, Translated Author, Pages, or Cited Pages.

In the style template, enter both the singular and plural forms of the label separated by a caret (insert it from 
the Insert Field list or type Shift+6). Any text before the caret, back to but not including the preceding space, 
is used for the singular form; text after the caret, up to the next space, is used for the plural form. These 
terms must also be linked to the relevant field using a nonbreaking space. For example, a style template 
might look like this:

Edited Book 
Editor,°ed.^eds.·Title.·Number·of·Volumes°vols|.°Vol.°Volume|,·Series·Title 
|.·City|:°Publisher|,°Year|.

Or like this:

Journal Article 
Author.·"Title,"·Journal,·Volume|.°Issue|·(Year)|:p.^pp.°Pages|.

Note: Spaces in EndNote style templates appear as small dots (·), as they do here. They are not special 
characters, they are shown this way here and in EndNote to make it easy to identify spaces in the style. 
Spaces show as dots in EndNote only when working in the style templates, not in other parts of the style.

Too confused about all these rules? Well, even if you don’t get everything quite right according to the rules, 
EndNote will do its best to clean up the formatted reference. Obvious problems are fixed automatically.

Normally, field text is entered into EndNote without ending punctuation, so that the selected output style can 
supply punctuation as required by that particular style. However, when you download references from 
various sources, some information providers may include punctuation.

For example, when an output style directs EndNote to insert a period after a field, EndNote must determine 
what to do with any punctuation that already exists at the end of the field in the reference.
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Punctuation found, plus punctuation 
added by the output style: Replaced with:

spaces, period period

comma, period (,.) period

semicolon, period (;.) period

colon, period (:.) period

double periods (..) single period

question mark, period (?.) question mark

exclamation point, period (!.) exclamation point

Punctuation found, plus punctuation 
added by the output style: Replaced with:

double spaces single space

double commas (,,) single comma

double semicolons (;;) single semicolon

double question marks (??) single question mark

double periods (..) single period

comma, period (,.) period

question mark, period (?.) question mark

exclamation point, period (!.) exclamation point

question mark, exclamation point (?!) question mark

exclamation point, question mark (!?) exclamation point

Additional Style Formatting Options

EndNote treats other forms of extra punctuation like this:

One set of punctuation that is never replaced is the period, comma (.,) because it may be used for 
abbreviations like ed., et al., etc.

Templates determine the general layout of the formatted references and citations (see Modifying Style 
Templates). The remainder of the panels in the Style window can be used to fine-tune certain aspects of a 
bibliographic style. See the following topics for more information:

Punctuation in Output Styles▪

Anonymous Works▪

Page Numbers▪

Journal Names▪
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Punctuation in Output Styles

Sections Options in Output Styles (Microsoft Word Only)▪

Ambiguous Citations▪

Numbering Citations in Output Styles▪

Author Lists in the Bibliography and Footnotes▪

Citation Author Lists▪

Author Names in the Bibliography and Footnotes▪

Citation Author Names▪

Editor List and Editor Names▪

Bibliography Layout▪

Sort Order: Bibliographies and Multiple Citations▪

Title Capitalization in Output Styles▪

Repeated Citations in Footnotes▪

Figure and Table Placement and Captions▪

Style guides in some regions require a space before the colon (and other punctuation marks) in the 
formatting of references. Other style guides do not.

Select either English or French in the Punctuation option in the output style. The default selection is English.

The English option tells EndNote to remove extra spaces before the following punctuation marks. Spaces 
before other punctuation marks and symbols are retained.

Colon (:)▪

Semicolon (;)▪

Exclamation mark (!)▪

Question mark (?)▪

The French option tells EndNote that a space is required before and after the following punctuation marks.

Colon (:)▪

Semicolon (;)▪

Chevrons (<< >>) (opening and closing)▪

Exclamation mark (!)▪

Question mark (?)▪
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Anonymous Works

Page Numbers

Percent sign (%)▪

Dollar sign ($)▪

Pound sign (#)▪

Anonymous works are defined by EndNote as references where the Author field is blank (not "Anonymous"). 
The settings in the Anonymous Works panel applies to the in-text citations and bibliography templates.

Open styles for editing by selecting Tools > Output Styles > Open Style Manager, selecting a style, and then 
clicking Edit.

Leave Author Blank: The author section of the formatted reference is left empty. If the references are to be 
sorted by author names, the anonymous works would be sorted at the top of the list because they have no 
author.

Use Full Title in Place of Author: Where the author would have appeared, the title is used instead. If the 
references are sorted by author, the anonymous references will be sorted as though the title were the 
author.

Use Short Title in Place of Author: Where the author would have appeared, the short title is used instead. 
If the references are sorted by author, the anonymous references will be sorted as though the short title 
were the author. If EndNote encounters a reference that does not have anything entered into the Short Title 
field, it uses the contents of the regular Title field instead.

Use APA Specifications: The American Psychological Association format (used by many journals) requires 
a special variation of the Use Title in Place of Author option.

Insert Text: The text that you enter here appears in the author’s place in the formatted reference, and it is 
used for sorting purposes if the references are to be sorted by author names. Commonly this text would be 
something like the word "Anonymous" or "Anon."

The Page Numbers panel allows you to specify how the page numbers should be formatted in your 
references.

Don’t change page numbers 
The contents of the Pages field are used directly in the formatted reference. No changes are made.

▪

Show only the first page number 
Only the first characters in the Pages field are included in the bibliography. For example, "123-125" 
in the Pages field becomes "123" in the formatted reference.

▪

Abbreviate the last page number 
Any digits of the last page number that are the same as the first page number are eliminated. For 
example, "123-125" in the Pages field becomes "123-5" in the formatted reference.

▪

Abbreviate the last page, keeping two digits 
Any digits of the last page number that are the same as the first page number are eliminated, down 

▪
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Journal Names

to a minimum of two digits. For example, "123-125"  in the Pages field becomes "123-25" in the 
formatted reference.

Show the full range of pages 
Leading digits are added to the last page number so the full page range is used. For 
example, "123-5" in the Pages field becomes "123-125" in the formatted reference.

▪

Show only the first page for Journals, full range for others 
Journal articles are formatted differently from other types of references.

▪

Note: Special Formatting Characters describes how to instruct EndNote to add text such as "p." vs. "pp.", 
or "page" vs. "pages" to the formatted references using the caret (^).

Different journals have different standards for abbreviating journal names. For example, some styles may 
require "Proceedings of the National Academy of Science" to be abbreviated as "Proc. Nat. Acad. Sci.," 
"P.N.A.S.," or "PNAS." EndNote’s Journals term list  provides a way for you store up to four variations of 
journal names (the full name and three forms of abbreviations) to be used in your bibliographies.

The Journals term list that is created for every library  is automatically linked to the Journal and Alternate 
Journal fields, and therefore it is ready to be used with the Journal Names options. You need to be sure that 
the necessary information is in the Journals term list, and that your style is set up to use the correct form of 
the journal name.

If your Journals term list includes the name of the journal as it is entered in your EndNote references, and 
the form of the journal name that you would like to appear in your bibliographies, you may set your 
preference in a style to have EndNote substitute a form of the name in the Journals term list for what was 
entered into your references.

EndNote provides fourteen predefined journal abbreviation lists for different disciplines (including medicine, 
chemistry, and humanities). If you are interested in using one of these lists, you may import it into your 
Journals term list (see Loading Supplied Journal Abbreviations) and set up a bibliographic style to use one 
of the abbreviations for the formatted bibliography. If EndNote does not provide a journal term list that 
applies to your area of research, you may also enter the journal abbreviations yourself. See Important 
Points About Entering Journal Names.

If you have not yet done so, open the Style window for the style you wish to work with. (See Opening the 
Style Window.)

To modify a style to use the abbreviations in a Journals term list:

Select the Journal Names  panel from the list at the left of the Style window to see the available 
options:

1.

Use Full Journal Name 
When creating a bibliography, EndNote replaces the Journal name in the reference with the form of 
that name in the first column of the Journals term list. This first column is normally used for full 
names.

▪

Abbreviation 1 
Abbreviation 2 
Abbreviation 3 

▪
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Sections Options in Output Styles

In the bibliography, the journal name for each reference is replaced with the form of that name in the 
second, third, or fourth column of the Journals term list, respectively.

Don’t Replace 
In the bibliography, EndNote uses the journal name exactly as it appears in the reference in the 
EndNote library. No changes are made.

▪

Abbreviate Journal Articles Only 
The substitutions made with the Journal Names option can apply to all Secondary Title fields, or to 
the Secondary Title field  for only the Journal Article reference type. If this option is unchecked, 
EndNote applies this feature to all reference types, EndNote also abbreviates fields such as 
Conference Name, and the names of magazines and newspapers.

▪

Remove Periods 
Select this option to have EndNote eliminate the periods from all journal names in the bibliography 
that it is creating, regardless of the abbreviation being used. This option does not require that the 
journal names be in the Journals term list. For example, if the journal names are entered into your 
references using periods, and you do not have a Journals term list that includes the names without 
periods, you can still just check this option and the periods will be stripped out of the journal names 
when EndNote formats a bibliography.

▪

If a journal name is not found in the specified column of the Journals term list, the style uses the journal 
name as it appears in the Reference window. No replacement is made for that journal.

The default  setting is Don’t Replace. EndNote uses the journal name exactly as it appears in the original 
reference.

Note:  None of these changes actually takes place in the EndNote library. These options only determine 
what information goes into the bibliography that is generated using the Copy Formatted Reference, Print, 
Export, and Format Bibliography commands.

EndNote has always created a single bibliography at the end of your word processor documents. That is still 
true when you Cite While You Write in Pages, OpenOffice Writer documents, or format RTF files. However, 
EndNote includes additional output style options specifically for Microsoft Word.

You can choose to:

Create a complete bibliography at the end of each document (the default setting for almost all of the 
supplied output styles).

▪

Create a bibliography for each section in the document (as defined in the styles APA 5th and 6th 
(sections)).

▪

Create a bibliography for each section and also a complete bibliography at the end of the document.▪

For more information about using sections in a Microsoft Word document, see Creating Multiple 
Bibliographies in a Single Document.

Note:  The Sections portion of an output style is ignored by Pages, OpenOffice  Writer, and when 
formatting RTF files.
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Create a complete bibliography at the end of each document

Create a bibliography for each section in the document

Ambiguous Citations

This default setting formats a single bibliography at the end of a document. Even if you have broken the 
document into multiple sections, a single bibliography will appear at the end of the document.

When you select this option, a bibliography is created at the end of each section, and includes only the 
citations within a section.

An additional checkbox is available for sections: Continue numbering, or apply settings for disambiguation 
and repeated citations across sections.

When the checkbox is blank:▪

When a numbered bibliographic style is selected, citation numbering will be restarted at the 
beginning of each section.

▪

When a numbered bibliographic style  is not selected, ambiguous citation settings will be 
restarted and applied to each section individually. For more information about ambiguous citation 
settings, see Ambiguous Citations.

▪

When the checkbox is selected:▪

When a numbered style is selected, selecting the check box will assure that numbering is 
continued across sections. For example, if citations in the first section are numbered 1 to 10, 
citations in the next section will start with number 11.

▪

When a numbered style is not selected, ambiguous citation settings will apply across the entire 
document. For more information about ambiguous citation settings, see Ambiguous Citations.

▪

When Create a bibliography for each section and a complete bibliography at the end of the 
document is selected:

▪

This option creates a bibliography for each section as well as a complete bibliography of all the 
citations in the document.

▪

When a numbered style is selected, citation numbering continues sequentially across all 
sections, without restarting for each section.

▪

When a numbered style is not selected, ambiguous citation settings are applied across the entire 
document, without restarting for each section.

▪

If a document is not divided into sections, EndNote formats a single, complete bibliography at 
the end of the document.

▪

With in-text citations like (Smith, 1995) or (Smith 246-9), references can have identical in-text citations if 
they are by the same author or the authors have the same last name. This leads to ambiguity in the citations 
that would make it impossible for the reader of your paper to know to which reference by Smith you are 
referring. EndNote provides various ways to avoid this sort of ambiguity in your citations.
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Numbering Citations in Output Styles

Any combination of the following options may be used. Click in the checkbox next to all options that apply. 
Note that these settings assume the author is used in the in-text citation. They are not relevant for styles 
that use bibliography numbers for the in-text citations as it is not possible to have ambiguous citations when 
they are uniquely numbered.

Include author initials in citation 
 
Check this option to have EndNote include initials with author names to distinguish between citations 
by different authors that happen to have the same surname. Select how the initials should appear 
from the Initials option in the section. For example, the MLA style uses just author names and page 
numbers in citations. Initials are added to clarify which Smith wrote the cited reference:

▪

   (S. Smith 241-5) and (L. Smith 12-20)

List more authors until citation is unique 
 
Some styles request that only a fixed number of authors be listed in the in-text citation, and then "et 
al." or "and others" is inserted to indicate that the author list was abbreviated. Select this option if you 
would like EndNote to list additional authors to make the citation unique. For example, if the in-text 
citations were set to list only 3 authors, and you have two references in which the first three authors 
are the same, EndNote would add a fourth author to the citations, and continue in that manner until 
the list of authors was different between the two citations.

▪

Add the title for different works by the same author(s) 
 
If you have two works by the same author, it won’t  help to add initials or list more authors to 
differentiate the two. In this case, some styles request that the title of the reference (or a shortened 
form of the title) be added to the in-text citation. If you choose this option and select the Short Title 
option, EndNote includes the contents of the Short Title field when available. Otherwise, it uses the 
full title. The format of the title is taken directly from the bibliography. This is an example in the MLA 
style, which normally includes only the author and page number in a citation:

▪

   (Smith, History of Our Times 35)
   (Smith, Looking Forward 77)

Add a letter after the year 
 
For citations in an (Author, Year) format, EndNote can add a letter to the year to make citations from 
the same author published in the same year distinguishable from each other. The letter appended to 
the year will appear in both the in-text citations and references in the bibliography.

▪

   (Smith 1995a) 
   (Smith 1995b)

The settings in the citation Numbering panel apply only when "Bibliography Number" is used in the Citation 
template (see Citations Template). This creates uniquely numbered citations in the text of the paper; the 
numbers correspond to entries in the bibliography. For papers formatted with a numbered style, these 
options are relevant to multiple citations grouped within one set of citation delimiters. For example:

Unformatted citation: {Keys, 1998 #93; Jen, 1996 #88}
Formatted citation: (1, 2) or [1, 2] or 1, 2
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Use Number Ranges for Consecutive Citations

Grouped References

When this option is checked, consecutive bibliography numbers appearing in a multiple citation are joined 
by a single hyphen, for example:

…as shown by the Berkeley studies conducted in 20153-6 and 20171, 7.

The Grouped Reference option allows you to cite with one number any references that always appear 
together in the paper as multiple citations. The citations are not given their own numbers, but rather one 
number is used both in the text and the bibliography to identify the whole group of citations. With this setting, 
you also have the option to specify how the grouped references in the bibliography should be separated.

This option shows a semicolon and a space as a separator:

1. Wang, L., et al., Azure-winged magpies fail to understand the principle 
   of mirror imaging. Behavioural Processes, 2020. 177: p. 8; Pepperberg, 
   I.M., Symbolic communication in the grey parrot, in The Oxford Handbook 
   of Comparative Evolutionary Psychology, J. Vonk and T.K. Shackelford, 
   Editors. 2012, Oxford University Press: New York. p. 297-319; Vonk, J. 
   and T.K. Shackelford, eds. The Oxford handbook of comparative evolu- 
   tionary psychology. Oxford Library of Psychology, ed. P.E. Nathan. 
   2012, Oxford University Press: New York. 574.

Composite Citations

Within grouped references, you can differentiate individual citations with letters, as in the example below.

Citation: (1a, 1b, 1c)
Bibliography: 1. (a)Wang, L., et al., Azure-winged magpies fail to understand 
               the principle of mirror imaging. Behavioural Processes, 2020. 
               177: p. 8; (b)Pepperberg, I.M., Symbolic communication in the 
               grey parrot, in The Oxford Handbook of Comparative Evolutionary 
               Psychology, J. Vonk and T.K. Shackelford, Editors. 2012, Oxford 
               University Press: New York. p. 297-319; (c)Vonk, J. and T.K. 
               Shackelford, eds. The Oxford handbook of comparative evolution- 
               ary psychology. Oxford Library of Psychology, ed. P.E. Nathan. 
               2012, Oxford University Press: New York. 574.

To define a composite citation:

Select the box to Use letters to separate grouped references.1.

Use the Present letters in list to select Lowercase or Uppercase letters.2.

Select the appropriate letter format for in-text formatted citations. The examples shown in EndNote 
illustrate how letters and numbers appear for consecutive citations and ranges.

3.

(1a, 1b), (1a, 1b, 2a-c) 
The number always appears with a stand-alone letter or with the first letter of a range. This is 
the default setting.

▪

(1a, b), (1a, b, 2a-c) 
Only the letter of the first citation of the composite is preceded with the number.

▪
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(1a, b), (1a, 1b, 2a-c) 
The letter of the first citation of the composite is preceded with a number; additional letters 
include a number only if there could be ambiguity.

▪

(1a, 1b), (1a, 1b, 2a-2c) 
Letters are always preceded by a number.

▪

Use the “Precede by” and “Follow by” boxes to enter any character(s) that you want to surround the 
letter in the bibliography.

4.

The Author Lists panels under the Bibliography and Footnotes headings let you specify exactly how the 
authors are to appear in the formatted bibliographic references or  in your footnotes. You can format author 
names differently in the footnotes and  bibliography, so be sure that you check the Author Lists settings 
under all these headings to adjust settings. The settings in these panels apply to all reference types 
formatted with the current style.

Note: In the example text below, dots (·) are used to indicate where a space should be added in the style. 
These dots will not appear in EndNote's Author Lists panels, spaces will appear instead. They are added 
here only to make spacing clearly recognizable.

In the "Author Separators" box, enter any punctuation and spaces that separate the individual author names 
in a citation or bibliographic reference. In references with multiple authors, it is standard to separate the 
names with a comma and a space.

Use the between box to enter a comma and a space or any other required punctuation.▪

Use the before last box  to enter the separator that appears before the last author in a reference. 
Sometimes this is something other than a comma and a space, such as ",·and·" or an ampersand 
(&) followed by a space.

▪

Normally only the first row in the Author Separators box is used (with the range of authors set at "1 to 100") 
so that the separators in that row apply to all of the authors cited in a reference. However, there are styles in 
which two authors are listed as "Smith and Jones" (without a comma), and more than two are listed as 
"Smith, Jones, and Johnson" (with a comma before the word "·and·"). In this case, make "·and·" the 
"before last" separator when there are only two authors; and enter ",·and·" when there are 3 or more 
authors.

Note: Include spaces before and after the word "and" and a space after commas.

Some journals require that you abbreviate the list of authors, using "et al." or an equivalent, after a certain 
number of authors. The Abbreviated Author List section of the Author List panel allows you to specify the 
number of authors needed to trigger this abbreviation, how many authors to include in the formatted 
reference, and what the abbreviation should be.
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List all author names 
 
Select this option if you do not want to abbreviate the author lists.

▪

If ___ or more authors, list the first ___ author(s) and abbreviate with ___ 
 
Select this option and fill in the blanks with the appropriate numbers and text (such as ",·et al.") if 
you would like the list of authors abbreviated.

▪

In the Author List settings for bibliographies there is a setting within the Abbreviated Author List settings that 
is sometimes referred to as the "APA setting." For the APA 6th and 7th styles, this option includes the 
following settings:

For APA 6th: If 8 or more authors, list the first 6 authors, insert … and add the last author's name.▪

For APA 7th: If 21 or more authors, list the first 19 authors, insert … and add the last author's name.▪

This setting allows  you to display a set number of author names (or  editor names for  the Edited 
Book reference type) followed by an ellipsis (…),  followed by the last author name (or editor name for  the 
Edited Book reference type). This option is already set up for the APA styles included with EndNote, but you 
can also use it for other styles based on the APA style, if needed.

In some bibliographic styles, if there is more than one work by an author (or group of authors), the first 
appearance of that author name is formatted differently from subsequent works. For example, the first 
reference might list the full author name, while subsequent references display a line of dashes in place of 
the author name.

You can print the entire author list for each reference, completely leave out the author list for subsequent 
works, or replace repeated author lists with a text string.

List all author names 
 
Select this option if you do not want to abbreviate the author lists.

▪

If ___ or more authors, list the first ___ author(s) and abbreviate with ___ 
 
Select this option and fill in the blanks with the appropriate numbers and text (such as ",·et al.") if 
you would like the list of authors abbreviated.

▪

When entering an abbreviation such as  ",·et al."  You can italicize the abbreviation by selecting the "Italic" 
checkbox in the dialog.

Remember to save your style after making your changes. See Saving Styles.
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If the style you are using lists the author names in the Citation template of the Style window, you can use the 
Author List options (as well as the Author Names panel) to control how the authors appear in your in-text 
citations. If your citations do not include the author names, ignore the Author List panel.

Note: In the example text below, small dots (·) are used to indicate where a space should be added in the 
style. These dots will not appear in EndNote's Author Lists panels, spaces will appear instead.

In the Author Separators box, enter any punctuation and spaces that separate the individual author names 
in a citation. In references with multiple authors, it is standard to separate the names with a comma and a 
space.

Use the between box to enter a comma and a space, or any other required punctuation.▪

In the before last box, enter the separator that appears before the last author in a reference. 
Sometimes this is something other than a comma and a space, such as ",·and·" or an ampersand 
(&) followed by a space.

▪

In the before last in format: Author (Year) box, enter the separator that appears before the last author 
in the Author (Year) format. The behavior of this option is the same as the before last box. This 
allows you to meet the specifications of some styles that require different formats depending on 
whether the format used is the default format or the Author (Year) format.

▪

Normally only the first row in the Author Separators box is used (with the range of authors set at "1 to 100") 
so that the separators in that row apply to all of the authors cited in a reference. However, there are styles in 
which two authors are listed as "Smith and Jones" (without a comma), and more than two are listed as 
"Smith, Jones, and Johnson" (with a comma before the word "and"). In this case, make "·and·" the 
Separator before last author when there are only two authors; and enter ",·and·" when there are 3 or more 
authors.

Note: Include spaces before and after the word "and" and a space after commas.

Some journals require that you abbreviate the list of authors, using "et al." or an equivalent, after a certain 
number of authors. The Abbreviated Author List section of the Author Lists panel allows you to specify the 
number of authors needed to trigger this abbreviation, how many authors to include in the formatted 
reference, and what the abbreviation should be.

List all author names 
 
Select this option if you do not want to abbreviate the author lists.

▪

If ___ or more authors, list the first ___ author(s) and abbreviate with ___ 
 
Select this option and fill in the blanks with the appropriate numbers and text (such as ",·et al.") if 
you would like the list of authors abbreviated.

▪
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In some bibliographic styles, if a reference is cited more than once in your paper the first appearance of it in 
an in-text citation is formatted differently from subsequent citations. For example, the first citation might list 
all authors, while subsequent citations list only the first author followed by "·et al."

Use the First Appearance author list settings to specify the way the authors appear the first time the 
reference is cited. Use the Subsequent Appearances options to format authors in all other appearances of 
the citation.

There is an Author Names panel for bibliographies and footnotes, as well as for citations. Some styles 
request that author names are formatted differently in all three cases. Be sure that you select the Author 
Names panel from under the appropriate heading. The author names format for citations is described in 
Citation Author Names. This topic describes the options that are available for both the footnote and 
bibliography Author Names panels.

These settings are for choosing how author names should look— for example, whether the first or last name 
should come first, whether there should be a comma after the last name, and how the names should be 
capitalized.

First Author/Other Authors 
 
Using the lists for First Author and Other Authors, you can have the first author appear differently 
from the other authors in a reference. From these lists, select the example that shows the name in 
the order that you want in the reference.

▪

Capitalization 
 
Specify how author names should appear.

▪

As Is   (as entered in the reference)▪

Normal   (first letter of each name is capitalized)▪

All Uppercase (all letters are capitalized)▪

Small Caps (the first letter of a name is a large capital and other letters are smaller capitals; 
these may or may not be supported by your word processor) 
 
If you apply a capitalization option to author names, but have a specific name that you do not 
want changed, you can use the Change Case  preference to leave that name as entered. See 
Change Case Preferences.

▪

Capitalize only the author's last name 
 
This option allows you to format only the author's last name in all uppercase. For example, JONES, 
Edward.

▪
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Initials 
 
Select from the available options in the list to specify how the initials should appear in the formatted 
references. Click the Initials list to choose how the authors’  first and middle names should be 
formatted. If you have not entered the full first names and you select the Full Names option, EndNote 
uses the names as you have entered them into the reference. Select Last Only to show just the last 
name, with no first or middle initials.

▪

Note: Initials entered into an EndNote reference must be separated by a period, a space, or a period and 
a space (such as M.J. Stein, M J Stein, or M. J. Stein). Two letters together (such as MJ Stein) will not be 
interpreted as two initials, but instead as a two-letter first name.

There is an Author Names panel for displaying footnotes in the short form.

First Author/Other Authors 
 
Using the list for First Author and Other Authors, you can have the first author appear differently from 
the other authors in a footnote. From these lists, select the example that shows the name in the 
order that you want in the footnote.

▪

Jane Smith▪

Smith, Jane▪

Smith Jane▪

Capitalization 
 
Specify how author names should be capitalized. The options are:

▪

As Is▪

Normal▪

All Uppercase▪

Small Caps▪

Initials 
 
Select from the available options in the list to specify how the name or initials should appear in the 
formatted footnote. The options are:

▪

Full Name▪

Last Name Only▪

A. B.▪

A.B.▪

A B▪
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AB (You cannot enter initials in your library  in this format, but EndNote can configure them to 
look this way in the output.)

▪

When you are finished, remember to save your changes. See Saving Styles.

The Name Format section allows you to specify how the author names should look—whether the first or last 
name should come first, and whether there should be a comma after the last name.

First Author/Other Authors: Using the list for First Author and Other Authors, you can have the first author 
appear differently from the other authors in a reference. From these lists, select the example that shows the 
name in the order that you would like it to be in the citation. If the in-text citations use only the last name, 
this setting is not important.

Capitalization: Specify how you would like the author names to appear.

Specify how author names should appear.

As Is   (as entered in the reference)▪

Normal   (first letter of each name is capitalized)▪

All Uppercase (all letters are capitalized)▪

Small Caps (the first letter of a name is a large capital and other letters are smaller capitals; these 
may or may not be supported by your word processor)

▪

If you apply a capitalization option to author names, but have a specific name that you do not want changed, 
you can use the Change Case preference to leave that name as entered. See Change Case Preferences.

Capitalize only the author's last name:  This option allows you to format the author's last name in all 
uppercase. For example: JONES, Edward

Initials:  Select from the available options in the list to specify how the initials should look in the citations. 
Select Last Name Only if you only need the last name of the authors to appear in the citations.

Use initials only for primary authors with the same name: This option allows for initials to be used only 
when there are primary authors with the same last name included in the bibliography. Regardless of whether 
or not the resulting citations are ambiguous (that is, they could be from different years, so not ambiguous), 
EndNote will add the initials to those citations to clarify that they are from different authors who happen to 
have the same surname.

Note: The Publication Manual of the American Psychological Association requires this option for citations 
where different authors have the same last name, even if the citations are from different years. See 
section 6.14 of the APA 6th edition or section 8.20 of the 7th edition of the manual. EndNote APA styles 
are set to follow this requirement.
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If a multiple citation includes works by the same author, some styles request that you not repeat the author 
name. Check the setting to Omit repeated authors and EndNote will omit the author name from the citation 
after it first appears. In order for this setting to be used, the citations must all be grouped together in a 
multiple citation, and the citations by the same author must appear one right after the other.

For example, a reference such as this:

(Smith, 1993; Smith, 1999; Wyatt, 2000)

would be changed to look like this:

(Smith, 1993, 1999; Wyatt, 2000)

You may also choose the separator to use between these citations. Notice that in the example above the 
style normally uses a semicolon to separate multiple citations. But when there are a series of citations by 
the same author, the repeated author names are dropped and the years are separated by commas. In this 
case, a comma and a space should be entered as the punctuation with which to separate the consecutive 
citations by the same author.

If you have entered citations with suffixes and you would like those citations excluded from this formatting, 
check Don’t  omit authors from citations that have suffixes. For example, if two references by the same 
author included page numbers:

(Smith, 1993 p 24; Smith, 1999 p 5; Wyatt, 2000)

some styles request that you leave the author name in the second citation for clarity.

To specify how the editors’ names are to be formatted for reference types other than Edited Book, select 
Editor List  or Editor Name  from under the Bibliography  or Footnote  heading. In these panels you will find 
some of the same settings that have been described for formatting author names.

The Editor List settings apply to the generic Secondary Author, Tertiary Author, and Subsidiary Author fields. 
These fields include Editor in  the Book Section, Electronic Book Section, Encyclopedia, and Conference 
Proceedings reference types, among others, and Series Editor in  the Book and Edited Book reference 
types.

Note: "Editors" are considered primary authors for the Edited Book reference type. The Author List and 
Author Names settings apply to the primary author field of each reference type. Therefore, Author List and 
Author Names settings apply to the editor’s  name in an Edited Book, and the Editor List and  Editor 
Names settings apply to the Series Editor’s name in an Edited Book reference type.

The instructions for the Editor List panel are identical to those described for the corresponding Author List 
panel (see Author Lists in the Bibliography and Footnotes). Similarly, the Name Format options in the Editor 
Name panel are the same as those for Author Name panels (see Author Names in the Bibliography and 
Footnotes).
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To specify how the editors’ names and the abbreviated editors' list are to be formatted in the footnote short 
form, select Editor Lists or Editor Name from under the Footnote heading. In those panels you will find some 
of the same settings that have been described for formatting author names.

Use the menus to select how you want to format the following in footnotes:

First author▪

Other authors▪

Capitalization▪

Initials▪

Remember to save your style after making your changes. See Saving Styles.

Under the Bibliography heading there is a Layout setting that provides options for inserting text before and 
after each reference in a bibliography, as well as applying hanging indents to your references.

In the Start each reference with section, you can specify what information, if any, should appear before each 
reference in your bibliography. (For information on how to add a prefix before a citation, see Citation 
Prefixes).

A common reference prefix is the bibliography number, which is used by all numbered styles to number the 
references in a bibliography.

If you have not yet done so, open the Style window for the style you wish to work with. (See Opening the 
Style Window.)

To add a bibliography number before each reference:

In the Style window, select Layout from under the Bibliography heading.1.

Click in the text box below the Start each reference with section, and select Bibliography Number 
from the Insert Field list.

2.

Type the necessary punctuation after the bibliography number (such as a period and a space) or 
insert a tab from the Insert Field list.

3.

With a style configured in this way, EndNote creates a bibliography with numbered references, such as:

1. Argus, M.V. New paleontological excavation techniques. Nature 19, 234-237 
   (1993).

Note: To create a hanging indent, where the second and subsequent lines of a reference are indented, 
see Hanging Indents below.
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Example: Adding Research Notes to the Bibliography

Other commonly used reference prefixes appear in the Insert Field list.

Reference Type: This option will insert the reference type (such as Journal Article or Book) before 
each reference.

▪

Label: Some bibliographic styles use a Label in the citation and the bibliography to refer to each 
entry with a short mnemonic code, often the author’s name and the last two digits of the year. When 
you enter references into your library, you can type the mnemonic code directly into the Label field. 
When EndNote builds a bibliography, it can put that code before each reference.

▪

Citation: Selecting Citation as a reference prefix allows you to label the references in the 
bibliography with the in-text citation.

▪

Record Number: This  option will insert the record number before each reference. The record 
number is the number that EndNote assigns to each reference in the library, and it is also used in the 
unformatted in-text citations. Add Record Number as a reference prefix in any style in order to print 
all the references in your library with their unique EndNote record numbers. Record numbers are not 
unchangeable identifiers and should not be used as permanent identifiers. See Record Numbers.

▪

Use the End each reference with section  of the Layout  panel to specify what information, if any, should 
follow each reference in your bibliography. (For information on how to add text after an in-text citation in your 
document, see Citation Suffixes).

The Insert Field drop-down can be used to add the content of the Label, Keywords, Abstract, or Notes field, 
or the Record Number. Any other text or punctuation can also be entered as a reference suffix and it will 
appear at the end of each reference in the formatted bibliography. Two common uses for the Reference 
Suffix command are shown below.

Note: Although only a limited list of fields is shown on  the Insert Field  drop-down, any EndNote generic 
field name can be used in the Start each reference with  or End each reference with  sections. To add 
another field, such as Research Notes or Accession Number, just type the generic field name into the text 
box.

If you have research notes that you want to print together with your references, you should add the 
Research Notes field as a reference suffix in the style that you are using to print or format the references.

With the Style window open, select Layout from under the Bibliography heading.1.

Click in the text box below the End each reference with and  type "Research Notes" into the field. 
This will append the Research Notes field to every reference in the bibliography when you format a 
paper with the style. (Research Notes is a field reserved for your personal research notes, and 
EndNote never imports data into it. In comparison, the Notes field may contain data imported from 
online databases. Because "Research Notes" is a generic field name, it can be used to begin or end 
a reference with any reference type.)

2.

If you want the research notes to begin on a new line after the reference, select End of paragraph from the 
Insert Field  list before "Research Notes." If you want the notes to be indented, select Tab from  the Insert 
Field list before the words "Research Notes."
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Another common use for the Layout options is to add a blank  line between references. To do this, edit the 
style as described above, and insert a paragraph mark, using End of paragraph on the Insert Field list, into 
the End each reference with section.

To tighten up the bibliography and get rid of the blank line after each reference, edit the style, click on the 
Layout panel, and select and delete the paragraph mark to get rid of the blank line.

Many numbered bibliographic styles require a hanging indent, as shown in this example:

1. Vonk J, Shackelford TK, editors. The Oxford handbook of comparative 
   evolutionary psychology. New York: Oxford University Press; 2012.
 
2. Zorina ZA, Obozova TA. New Data on the Brain and Cognitive Abilities 
   of Birds. Zoologichesky Zhurnal. 2011;90(7):784-802.
 
3. Smirnova AA. On the capability of birds for symbolization. Biology 
   Bulletin. 2011;38(9):878-84.

EndNote provides a few hanging indent options. Normally, each reference is one paragraph, so some of 
these options would not apply. But if you have a reference that includes more than one paragraph, EndNote 
gives you options for which paragraph within a reference the hanging indents should apply. Examples of 
multi-paragraph references include annotated bibliographies where the research notes follow each 
reference, or a style such as those common in anthropology journals where the authors are on a line of their 
own.

Hanging indent options include: None, All Paragraphs, First Paragraph Only, Second Paragraph Only, and 
All Paragraphs but the First. The following is an example of when you would use Second Paragraph Only. 
The style requires that authors begin on the left margin, and then the year (and the rest of the reference) 
starts on a new line and is indented. The style applies a hanging indent to the second paragraph only, and 
inserts a tab before and after the year. In the word processing document, the spacing for the hanging indent 
should be aligned with the second tab stop.

Smirnova, A. A. 
    2011  On the capability of birds for symbolization. Biology Bulletin 
          38(9):878-884. 
Vonk, Jennifer, and Todd K. Shackelford, eds. 
    2012  The Oxford handbook of comparative evolutionary psychology. New 
          York: Oxford University Press. 
Zorina, Z. A., and T. A. Obozova 
    2011  New Data on the Brain and Cognitive Abilities of Birds. Zoologi- 
          chesky Zhurnal 90(7):784-802.

The spacing used for tabs and indents is determined by the ruler settings in your word processor.

Note: If you are creating a numbered bibliography, as shown in the previous example, insert a tab after 
the bibliography number to have the references line up correctly.
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Bibliography Sort Order

Tabs may be inserted from the Insert Field list. A tab entered into a style will appear as a tab in the formatted 
bibliography. The tab appears as an arrow on the screen. The width of the tab as it appears in the 
bibliography is determined by the tab settings in your word processor.

Tabs are often entered after the bibliography number as part of the Layout settings. This helps to align the 
start of each reference after the number, which is especially important if the bibliography entries use a 
hanging indent.

Each style  has instructions for sorting references in the bibliography, and how to sort  formatted multiple 
citations in the text of your paper. Select Sort Order  from under either the Citations  or Bibliography 
headings.

The Sort panel under the Citation heading allows you to set the order that the style uses to sort multiple in- 
text citations. For example, an unformatted multiple citation looks like this:

{Lee, 2015 #5; Jacob, 2020 #22; Zoler, 2011 #19}

Formatted with the Author-Date style, the citations are sorted chronologically and the formatted citation 
looks like this:

(Zoler 2011; Lee 2015; Jacob 2020)

Options for sorting multiple citations include:

Same as Bibliography: Sorts multiple citations in the same order as the Bibliography Sort Order.▪

Author + Title: Sorts multiple citations first by authors and then by title.▪

Author + Year + Title: Sorts multiple citations first by authors, then by year, and then by title.▪

Year + Author: Sorts multiple citations chronologically. Then citations from the same year are sorted 
based on author names.

▪

Don’t Sort: Multiple citations remain in the same order as they appear in the unformatted temporary 
citations.

▪

Other: A custom sort order is applied to multiple citations. See Custom Sorting.▪

The Bibliography Sort Order section determines how the bibliography should be sorted. Common options 
are listed, and you may also configure a custom sort order.

Order of Appearance: References are listed in the order in which they are cited in the paper.▪

Author + Title: References  are sorted by the Author field. References with identical authors are 
sorted by title.

▪
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Author + Year + Title: References  are sorted by the Author field, then references with identical 
authors are sorted by year. References with identical authors and years are then sorted by title.

▪

First Author + Year + Other Authors: References are sorted by just the first author, then references 
with identical primary authors are sorted by year. References with identical primary authors and 
years are then sorted based on the other authors in the reference.

▪

First Author + # of Authors + Year: References  are sorted by just the first author, then by the 
number of authors in the reference. For references with the same primary author and the same 
number of authors, they are then sorted chronologically based on the Year field.

▪

Other: A custom sort order is applied to the references in the bibliography. See Custom Sorting.▪

Sort Edited Works After Original Works By Same Author: Some styles request that if the same 
person is the author for a book and the editor for an edited book, the original works by that author 
are sorted first, and then the edited works follow. This is an exception to the sorting rules that can be 
applied to the other sort options provided.

▪

Note: When sorting by Author field, EndNote sorts based on all information in the Author field, including 
all author names (not just the first author) and initials. To see about omitting parts of author names or the 
initial words of a title when sorting, see Sorting Preferences.

To sort references or multiple citations differently from the options in the Citation Sort Order or Bibliography 
Sort Order sections,  select the option for Other, and then select from the drop-down field lists any 
combination of up to five fields, in ascending or descending order.

This dialog is identical to the one that appears when you select Sort Library from the Library menu. You do 
not need to use all five options. The button at the right of each box controls the direction of the sort, either 
ascending or descending order. Clicking these buttons toggles the sort order between ascending and 
descending order.

At the bottom of the dialog is a drop-down menu of languages. The default  will be the language used by 
your operating system, but you can change the language rules used for sorting here.

Once you have set up your sorting strategy, click OK to return to the main Sort Order panel for the style. The 
Other section will now display your custom sorting instructions.

This feature allows you to add subject categories to your Microsoft Word documents that are associated with 
specific reference types. When EndNote creates the bibliography in Word, it organizes your citations based 
on how you have set up the categories in the output style.

From the Tools menu, select Output Styles, and then select the Open Style Manager command.1.

Select a style.2.

Select the Categories option from under the Bibliography section to open a blank style template.3.
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Important Points About Categories and Reference Types

Add categories (subheadings) to the text box in the template. Enter a unique name to identify each 
category. 
 
You can align your categories to the left or center the text. You can also use various styles such as 
bold, italics, and underline to make your categories stand out.

4.

Under each category, insert one or more reference types. You can insert as many reference types as 
you like. However, insert any specific reference type only once.

5.

Continue to create categories and insert reference types until you have included all the reference 
types you think will be used in your papers.

6.

From the style's File menu, select the Save as command.7.

Give the style a name and save the style.8.

Open your Microsoft Word document.1.

Select the EndNote 20 tab.2.

Select the output style that contains the text categories and reference types defined in your new 
style.

3.

Insert the needed citations in your Word document.4.

When you are finished writing your paper, go to the end of the document to review the bibliography.5.

EndNote creates a bibliography and inserts the selected references under the appropriate categories based 
on the reference type. At this point, you can modify and edit the bibliography (see Configure Categories 
Dialog in Microsoft Word). For example, you can:

Rename a category.▪

Delete a category.▪

Move references (using drag and drop) from one category to another.▪

Insert one or more reference types under each bibliography category.▪

Enter a unique name to identify each category that you create.▪

Organize categories in the template based on how you want the categories to appear in the 
bibliography.

▪

Insert only one reference type per line.▪

Insert a reference type only once per output style. For example, do not insert the Journal reference 
type under several categories.

▪

Apply text styles only to categories—not to reference types. EndNote treats a reference type as plain 
text (not as a reference) in the bibliography if you apply any text style to it.

▪
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If Fields Are Empty

Examples of When to Use This Feature

If you have not included a reference type in the Categories section, EndNote will place undefined 
reference types into a generic Uncategorized References category.

▪

The Field Substitutions panels under the Bibliography and Footnotes headings allow you to substitute 
another field in the bibliography or footnotes of a reference if one of the following fields is empty. A set of 
common substitution options are shown as defaults, but you can change the substitution field, and the 
formatting for it, if you wish.

DOI▪

PMCID▪

Volume and Pages (Both fields must be empty.)▪

You can choose to activate field substitutions by selecting the checkbox by the field that might be empty. For 
example, if you select the If the DOI field is empty, use checkbox, by default  the URL field will be used 
instead, EndNote uses the URL if the DOI field is empty in the bibliography and footnotes of a reference. If 
the DOI field is not empty, EndNote displays the DOI information.

You can also select another field from the Insert Field list if you do not want to use the default value.

To substitute field values in a bibliography and/or footnote:

In the Style window, select Field Substitutions from under the Bibliography or Footnotes heading.1.

Activate field substitution by selecting the checkbox of each field.2.

Accept the default, or delete it from the text box and replace it with a field on the Insert Field list.3.

Add any formatting or punctuation that is needed for the new field.4.

Save your changes to the style. If unsure how to save changes, see Saving Styles.5.

Note: Even if you are using the default substitution, check the punctuation provided for it against the 
style's requirements. You may need to change the punctuation to match your journal's or style manual's 
requirements.

You are citing a prepress article that has a DOI number but not volume or page information. 
Some guidelines indicate that the DOI should be included in a reference for the prepress articles.

▪

You are citing a PubMed article; it has been assigned an NIHMSID, but it has not yet been assigned 
a PMCID. Style guidelines may indicate that the NIHMSID should be used as a substitution. 
 
What is the difference between a PMCID and an NIHMSID? The PMCID is the unique permanent 
identifier assigned when an article is approved for publication at PubMed  Central (PMC). The 
NIHMSID is a temporary identifier assigned when an article is submitted for publication at PubMed 
Central. The NIHMSID is only to be used for the first 90 days after it is assigned or until an article 

▪
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Repeated Citations in Footnotes

If the Same Reference Repeats in Consecutive Citations

If the Same Source Repeats in Consecutive Citations

has been granted a PMCID. You can find more information on this at https://www.ncbi.nlm.nih.gov/ 
pmc/about/public-access-info/.

Some style guidelines request if the editor and translator of a reference is the same person, you should 
enter only the Editor field with preceeding text indicating the same person did both.  The default is "edited 
and translated by Editor."

Most of the complex formatting in footnotes is relevant only to styles in the humanities. There are a wide 
variety of formats required for citing references that are repeated in the footnotes of a paper. Citations that 
are not repeated in consecutive footnotes are covered by the short form set in the footnote template. 
See Bibliography and Footnote Templates and Rules for Working with Style Templates for  information on 
setting up templates, including the short form template.

Some styles take the shortening of references in footnotes even farther when the repeated references 
appear in consecutive footnotes (or in the same footnote). EndNote provides additional options for the 
special handling of these cases in the Repeated Citations panel.

When the same reference repeats in consecutive footnotes, you have three general options for how the 
repeated citation will be handled.

Replace repeated data with: This option will allow you to replace the repeated data with text and/or 
a field  of your choice. This is normally "Ibid." (or a variation of the term). You may also select an 
option from the Insert Field list. For example, the Cited Pages option lists the page numbers when 
the same reference repeats in consecutive footnotes. In this instance, you would have to go to the 
Edit & Manage Citations dialog in Cite While You Write, or use the "@" sign and the page numbers to 
enter a temporary marker if using Format Paper, so the cited pages would show in the document. 
See Editing Citations in Microsoft Word, Editing Citations in OpenOffice Writer, and Citation 
Suffixes for information on editing citations to include cited pages.

▪

Omit repeated data: This option allows you to omit the repeated data and replace it with nothing.▪

Use short form: This option will use the Short Form template defined in the Footnote Templates 
panel.

▪

Note: The option to include the Volume field only applies to the Book and Book Section reference types. It 
does not apply to all reference types.

This setting does not apply to the identical reference that repeats in consecutive footnotes, but rather if any 
of the source data repeats in two consecutive citations in multiple citation format. For example, if two 
different references happen to be from the same journal, these settings would apply to the journal name, 
volume, and issue (or whatever portion of that source information is identical).
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Replace repeated data with: This option will replace the repeated data with "Ibid" (or text of your 
choice). If you choose this option, you may also limit the replacement to only the Secondary Title 
field (this includes the journal, magazine, or newspaper name, or the title of a book for a book 
section).

▪

No special handling: This option will use the Short Form template defined in the Footnote 
Templates panel.

▪

Note: We realize that many of these detailed settings for the style can be confusing. We have done our 
best to configure the styles for you so that you will not need to edit them and work through these details 
on your own. However, if you find that you need to modify these parts of your styles, consult your style 
guide for more detailed descriptions and examples of handling repeated citations in footnotes.

Both the Footnotes and Bibliography sections have a Title Capitalization panel. This lets you enter one style 
of capitalization for the titles in your bibliographic references, and another format for when the references 
appear in footnotes.

Options for title capitalization include:

Leave titles as entered: No changes are made.▪

Headline style capitalization: The first letter of every significant word is capitalized, following the 
American English rules for capitalization, wherein articles, conjunctions, and prepositions are not 
capitalized. If you are working with a language other than English, you may wish to choose Leave 
titles as entered and edit the references to match the capitalization requirements of that language.

▪

Sentence style capitalization: Only the first letter of every title is capitalized.▪

Note: See Change Case Preferences  to enter words or acronyms that should not be adjusted when 
EndNote changes the capitalization of titles.

The Figures and Tables settings apply to images inserted into a Word document from EndNote. You can 
place images where they are cited in a document or at the end of the document, and you have control over 
the placement and punctuation of labels and captions.

While style guidelines tend to be very specific in regard to formatted citations and bibliographies, they are 
often vague about figure and table placement. They may require different placement for different document 
types (theses, term papers, journal articles, and so on), or they may not offer instructions at all.

If an EndNote style's figure and table placement options do not meet your needs, you can change them. 
Please check your own style documentation (or check with your editor or teacher) for specific guidelines 
about image placement for the type of document you are creating.

Note: Additional Figures and Tables settings are available in the Cite While You Write Preferences, and 
can override output style settings. See Figures and Tables Preferences in Microsoft Word.
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Figures and Tables

Placement

Caption

Separation and Punctuation for Figures and Tables

Image Separation

Caption Punctuation

Under the Figures and Tables heading in the left column of the output style editor, select either Figures or 
Tables. Tables are images inserted from the Figure field in the "Chart or Table" reference type. Figures are 
images inserted from the Figure field of any other EndNote reference type. The same options are available 
under each, which allows you to place figures differently than tables.

Under Placement, select a button to either place the images within the text of the document, near the 
reference to the figure, or to place images in a list at the end of the document.

If your images are placed in-text, you can use Cite While You Write preferences to override this automatic 
placement when your document is reformatted. This is helpful if you have moved your images around in the 
document and want to retain their placement. See Figures and Tables Preferences in Microsoft Word.

Next, under Caption, select a button to place the label and caption either above or below the image. You can 
also select the checkbox to place the label and caption on separate lines.

Note: The label inserted by EndNote is "Figure #" for images found in the Figure and Equation reference 
types as well as for most other reference types. The label is "Table #" for images found in the "Chart or 
Table" reference type. The Caption is the text typed into the Caption field of a reference.

Under Image Separation, you can enter separators for images inserted within the text of a document and for 
images that are listed at the end of a document.

Note: The settings on this panel affect both figures and tables.

When images are inserted in-text, you can specify the number of lines to insert before and after the image to 
separate it from text. This setting affects both figures and tables that are placed in-text. If your images are 
placed in a list at the end of the document, this setting is ignored.

When images are placed in a list at the end of the document, you can separate each figure or table with a 
page break or a specified number of blank lines before and after each image. If your images are placed in- 
text, this setting is ignored.

For each figure or table inserted into Word from an EndNote reference, EndNote generates a label and then 
inserts the caption from the Caption field of the EndNote reference. For example:

Table 1. Avian Developmental Stages
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Creating an Author Date Style

Create a New Style

Create the (Author, Year) Citation Template

You can select the checkboxes to insert a period after the label and/or after the caption. This affects the 
labels and captions for both figures and tables.

EndNote will attempt to remove double punctuation in case you inadvertently include a period within the 
record as well as selecting one here.

It is often easier to modify an existing bibliographic style that closely resembles a style you need than it is to 
create a new style from scratch. (See Modifying Style Templates). If you do wish to create a new style, 
Creating an Author Date Style gives you a general overview of the process.

Creating a bibliographic style involves building templates for the in-text citations and the bibliographic 
references to mimic how you want them to appear in your paper. Then adjust the various options to be sure 
that authors, titles, pages, and other fields are being formatted according to your requirements. Creating an 
Author Date Style guides you through the creation of a fictitious author-date type of style.

A new style  need only contain a Citation template  and a Generic Bibliography template for it to produce 
citations and bibliographies for any paper. The Citation template applies to all in-text citations, and the 
Generic bibliography template applies to all reference types that do not have templates of their own in the 
style. The Generic template should be considered a default  template, and you should add additional 
templates for the standard reference types which you use. If you define a specific template for any reference 
types, they are formatted according to that template, and not the Generic format.

Note: For the example text in templates shown below, a small dot (·) is used to indicate a standard space. 
This is just to clarify spacing in the style. The dots will only show in the style when working in the 
templates; they do not show in other style panels.

To create a bibliographic style, go to the Tools menu, select Output Style, and then select New Style, 
and a new Untitled Style window appears.

1.

Select the Templates panel under the Citations heading.1.

Place the cursor in the text box under the Citation heading in the Citations Templates panel.2.

Type an open parenthesis.3.

Click the Insert Field button and select Author from the list of available fields.4.

Type a comma and a space.5.

Select Year from the Insert Field list.6.

Type the closing parenthesis.7.
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Create the Author (Year) Citation Template

Set the Number of Authors in the Citation

Set the Author Names to Show Only the Last Name in the Citation

Select the Templates panel under the Citations heading.1.

Place the cursor in the  text box under the Citation — Author  (Year)  heading in 
the Citations Templates panel.

2.

Click the Insert Field button and select Author from the list of available fields, then type a space.3.

Type an open parenthesis.4.

Select Year from the Insert Field list.5.

Type the closing parenthesis.6.

Select Author Lists under the Citations heading.1.

The default setting for Abbreviated Author List — First Appearance is to list all author names in the 
citation. For this example, let's change this setting to show up to three author names the first time a 
reference is cited, and two authors and "et al." in italics if there are more than three authors.

2.

Click the radio button under Abbreviated Author List — First Appearance that starts with If 3 or 
more authors... (3 is only the default).

a.

Change the 3 to a 4 where it says If 3 or more authors, then change 1 to 2 where it says list the 
first 1 author(s), then mark the Italic checkbox.  It should now show something like this:  
 
     If 4 or more authors, list the first 2 author(s) and abbreviate with , et al. 🗹  Italic  
 
With this setting, if there are up to three authors, all authors will appear in the citation. If there 
are more than three authors (4 or more authors), only two authors will appear, followed by 
", et al."

b.

The default setting for Abbreviated Author List — Subsequent Appearances is also to list all authors. 
Let's change this to show only the first author and when repeated citations have more three authors.

3.

Click the radio button under Abbreviated Author List — Subsequent Appearances for the option 
that begins with If 3 or more authors…

a.

Change the 3 to 4 where it says If 3 or more authors, then leave the option set to 1 where it says 
list the first 1 author(s), and finally, mark the Italic box. (If you wanted it to show something other 
than ", et al." you could change the text.) It should now show something like this:  
 
     If 4 or more authors, list the first 1 author(s) and abbreviate with , et al. 🗹  Italic  
 
With this setting, if there are up to three authors, all authors will appear in the repeated citation. 
If there are more than three authors (4 or more authors), only the first author will  appear, 
followed by ", et al."

b.

Select Author Name under the Citations heading.1.
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Create a Generic Bibliography Template

Test the Style

For the citations, we want only the author's last names to show, with no special capitalization 
options, so we will leave most of these settings as shown in the defaults. However, we would like the 
author name to be shown only once if an author has two references in the same grouped citation. 
For example, instead of (Smith, 2012; Smith, 2020), we want it to show (Smith, 2012, 2020). Set this 
by marking the checkbox Omit repeated authors under Consecutive Citation by the Same Author. To 
use a comma  instead of a semicolon between the years, mark the box Separate these citations 
with and leave the default option to use a comma and a space as it is.

2.

Next, define the Generic format which serves as the default template for reference types that do not have 
their own template.

Our style uses the author name and the year in the citation. They are surrounded by parentheses and 
separated by a comma. Most styles that show the author and year in citations also begin with those fields 
and sort  the bibliography by the author name, then by the year, then by the title, so we will create 
bibliography settings to do so.

Select Templates under the Bibliography heading, then click on Generic. Your cursor should now be 
located in the Generic text box, where you can enter the fields and punctuation for your style.

1.

Select Author  from the Insert Field  list to add the Author field to the style template. (You can also 
type "Author" but it is safer to select the field name from the list, to avoid typos.) Type a period and a 
space. Continue adding fields and punctuation until you have a line that looks like the one below.

2.

Author.·(Year).·Title.·Place·Published,·Publisher.

In this style, the title must be italicized, so double-click the word Title  to select it and apply 
italic formatting. Choose the formatting option from the toolbar in the Style window, or select the 
option from the Font submenu in the style's Edit menu. See Fonts and Text in Output Styles for more 
information on working with fonts in EndNote. You can also use the following shortcuts to apply text 
formatting.

3.

Ctrl+B for bolda.

Ctrl+I for italicb.

Ctrl+U for underlinec.

Ctrl+Shift++ (the  last + is the plus sign, so this means to hold down the Ctrl key, the Shift key, 
and the + key together) for superscript

d.

Ctrl+Shift+‒ (the ‒ is the minus sign, so this means to hold down the Ctrl key, the Shift key, and 
the ‒ key together) for subscript

e.

Save the new style by selecting Save As from the style's File menu. In the dialog that appears, type 
"Practice Style" as the name of this style and click Save. This will save the style and add it as an 
option in the Output Styles submenu of the Tools menu.

4.

Open your library,select a reference, and expand the Preview subpanel on the Reference > Summary panel. 
Select different references in your library to see how they format. You will probably see that the books look 
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Create a New Template for Journals

Setting a Sort Order

Finishing the Style

good, but journal articles do not display enough information. You will need to return to the style and create a 
template to format journal articles.

In the Templates panel under the Bibliography heading, select Journal Article from the Reference Type drop- 
down list. This will create a new section for a Journal Article template. Insert the fields and punctuation to 
create a template as shown below:

Author·(Year). Title. Journal. Volume (Issue) Pages.

Save the style by selecting Save  from the style's File  menu. Return to the Library window, and check the 
preview to see how journal article references are formatted.

Our practice style's bibliography and citations need to be sorted by Authors, Year, and then by the Title. To 
do this:

Select Sort Order under the Bibliography heading to set the sorting options for the bibliography.1.

Select the third option, Author + Year + Title.2.

Select Sort Order under the Citations heading to set the sorting option for the Citations.3.

Select the first option, Same as bibliography. This will sort citations within a grouped citation in the 
same order they would be sorted in the bibliography.

4.

To explore more options for sorting citations in a style, see Sort Order: Bibliographies and Multiple Citations.

Continue testing how other reference types format, and include additional reference type  templates as 
necessary. See Modifying Style Templates for specifics about creating and modifying style templates. See 
Special Formatting Characters for information on how to use special characters to provide more control over 
formatting in templates.

Look at how the author names are formatted, and change the necessary settings. You should also take a 
close look at pages, title capitalization, the sort order of the references, and various other options provided 
in the Style window. These are described in the section on Additional Style Formatting Options.

Additional Style Formatting Options

Punctuation in Output Styles▪

Anonymous Works▪

Page Numbers▪

Journal Names▪

Sections Options in Output Styles (Microsoft Word Only)▪

Ambiguous Citations▪
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Numbering Citations in Output Styles▪

Author Lists in the Bibliography and Footnotes▪

Citation Author Lists▪

Author Names in the Bibliography and Footnotes▪

Citation Author Names▪

Editor List and Editor Names▪

Bibliography Layout▪

Sort Order: Bibliographies and Multiple Citations▪

Title Capitalization in Output Styles▪

Repeated Citations in Footnotes▪

Figure and Table Placement and Captions▪
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Import Filters

Introduction to Filters

What is a Filter?

A Comment About Difficult Data Files

Installing Additional Filters

The Import command on the File menu provides a way to import text files of reference data into EndNote 
libraries, or EndNote XML files exported from EndNote. EndNote has a number of built-in import options as 
well as a large collection of configurable import filters. Filters are designed to import references downloaded 
from specific online bibliographic databases, or to import data exported from other bibliographic software 
programs.

You can edit and create import filters. The process of importing references using the Import command is 
described in Importing Reference Data into EndNote.

EndNote provides hundreds of import filters for a variety of sources. By default, only the most popular filters 
are stored as individual files in the Filters folder in your EndNote program folder. To install additional filters, 
see Installing Additional Filters.

Import filters provide a wide range of import options. A filter is selected during the import process to show 
EndNote exactly how to interpret the information in your data file (the records downloaded or saved from an 
online database or exported from another program). A filter does this by mapping the information in each 
downloaded reference to the corresponding fields in EndNote.

Because each database offered by the various information providers has its own way to organize reference 
data, there needs to be a different filter for each database. Each filter provided with EndNote has been 
configured to import data files from a specific database offered by a single information provider. You can 
easily modify any of the supplied filters or create a new filter to import from other databases.

Although EndNote’s  filters are very powerful and flexible import tools, there are still some data files that 
cannot be conquered. Whereas some databases provide very clean tagged data, others are almost 
impossible to discern. Lack of consistency in the source data and the omission of reference type tags often 
make it difficult for a person to understand the information: the task of creating a perfect filter to handle 
these files is futile. When fine tuning our filters, we have done our best to capture the necessary data—even 
if that means dropping it all into the Notes field. If you find filters that can be further improved, please let us 
know. It may also help to contact your information provider to let them know that the inconsistencies in the 
data entry for the database are keeping you from most efficiently making use of it.

See Installing Additional Filters for instructions on installing additional filters.
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The Filter Manager

Marking Your Favorite Import Filters

Editing Import Filters

EndNote provides hundreds of import filters for a variety of sources. By default, only the most popular filters 
are stored as individual files in the Filters folder in your EndNote program folder. To install additional filters, 
see Installing Additional Filters.

To access the Filter Manager, select Import Filters > Open Filter Manager… from the Tools menu.

The Filter Manager lists the names of the original filter files available in the C:\Program Files (x86)\EndNote 
20\Filters  folder, as well as any new or modified filters in your personal Filters folder, and gives you the 
option to edit them or select them as "favorites" for quick access when you use the Import command. You 
can click and drag the corner of the dialog to increase the size.

Use these features to locate the import filter you want to use:

If you know the name of the filter that you want to use, you may start typing it and the first filter name 
that matches what you type will be selected.

▪

Click the Find By button and select an information provider’s name (such as OCLC) to find only the 
import filters for a specific information provider.

▪

Click the Find By button and select All Filters to return all of the import filters to the displayed list.▪

Click a column heading to sort the import filters by name or by information provider. Clicking the 
same column heading a second time will change the sort order from ascending to descending order. 
Click again to set it back to ascending order.

▪

Click the More Info  button at the bottom of the dialog to display additional information about the 
selected filter.

▪

Click the Get More on the Web button to open your browser and navigate to the EndNote download 
site to access more filters.

▪

When you have found a filter that you will want to use in the future, mark the checkbox to the left of it in the 
Favorites column to add it as a favorite. All filters that are marked as favorites appear in the Import Options 
list in the Import dialog. You can get to the Import dialog by selecting Import from the File menu. This gives 
you easy access to those files you use most often.

To mark all of the filters for a specific information provider, click the Find By button and, from that list, select 
the name of the information provider. Then, with just that subset of filters listed in the Filter Manager window, 
click Mark All. The Unmark All option may be used to unmark all of the filters that are showing in the list.

If you would like to modify a filter, select it in the list and click Edit. These topics can help guide you:

The Basic Components of a Filter▪

The Filter Editor Window▪

Working with Filter Templates▪
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Saving Filters

Copying Filters

Deleting Filters

The Filter Options▪

Modifying an Existing Filter, an Example▪

To save a new filter that you have just created, or to save changes to a filter you have just modified, select 
Save As  from the  filter's File  menu. The new filter will be saved in your personal filter's folder. For  a 
description of where your styles are stored, see Folder Locations Preferences.

EndNote filters use the file name extension of ".enf" (for EndNote Filter), as in "PubMed (NLM).enf."

When you display a list of filters in EndNote, the list is comprised of the installed filters found in the  \ 
\Program Files (x86)\EndNote 20\Filters  folder, as well as new or modified filters found in your personal 
Filters folder. For an explanation of where your files are stored, see Folder Locations Preferences.

There are two ways to copy filters. Since each filter is a separate file on your hard drive, you can copy them 
as you would copy any file on your hard drive using the File Explorer.

To make a copy of a filter from within EndNote:

From the Tools menu, select Import Filters and select Open Filter Manager.1.

Select the filter you want to copy and click Edit.2.

Without making any changes to the filter, select Save As from the filter's File menu.3.

Give this copy of the filter a new name, and then save it.4.

The file is saved in your personal Filters folder. The new filter will remain open. The original filter will be left 
untouched.

To delete a filter from within EndNote:

From the Tools menu, select Import Filters > Open Filter Manager.1.

Right-click on the  filter to be deleted and select Delete Filter…  from the menu, or press the Delete 
key.

2.

You will be asked for a confirmation of if you really want to delete the filter. Select Yes to delete the 
filter or No to keep it.

3.

You can also delete an unwanted filter by opening File Explorer  and opening  the appropriate Filters folder 
(see Folder Locations Preferences). Then, drag the filter from the Filter folder to the Recycle Bin, or select 
the file and press the Delete key.
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The Basic Components of a Filter

The Filter Editor Window

About this Filter

Note: You must have read/write access to the Filters folder in order to delete a filter. If you do not have 
administrator access, you likely will not be able to delete a file located within the Program Files (x86) 
folder. 

You need to know the basic components of a filter if you want to customize or create a filter.

To create a new import filter: From the Tools menu, select Import Filters, and then select New Filter. 
If you are interested in creating a new filter, also read Creating a New Filter.

▪

To edit a filter: From the Tools  menu, select Import Filters, and then select Open Filter Manager. 
Select the filter to edit and click Edit. The most recently used filter can also be easily edited by 
selecting Import Filters from the Tools menu, and selecting Edit [Filter Name].

▪

These topics explain the basic components of a filter:

The Filter Editor Window▪

About this Filter▪

Working with Filter Templates▪

The Filter Options▪

After choosing the option to edit an existing filter  or create a new one, EndNote opens the Filter Editor 
window.

All of the different options for editing a filter are listed on the left side of the Filter Editor. Click on an item to 
view the associated settings. You may switch between panels as needed while editing the file. No changes 
are saved in any of the panels until you select Save As from the filter's File menu.

If at any time you need to revert your changes back to the last saved copy of the filter, select Revert Filter 
from the filter's File menu.

To close a Filter window, click the Close button in the upper right corner of the window, or select Close Filter 
from the filter's File menu. If you have not saved your changes to the filter, EndNote prompts you and gives 
you the option to save or discard any changes that you have made.

The Filter Editor opens to display the About This Filter panel. This panel contains descriptive information 
about the filter. None of the information used in this panel has any impact on how well the filter works, it is 
just descriptive.

File Name: Displays the name of the filter as it appears in the Filters folder in the EndNote folder. The file 
name extension (.enf) is not displayed. The name of the filter cannot be changed here; you would need to 
close this window and switch back to the File Explorer to rename the filter.

Page 455 of 586

 



Clarivate EndNote 20 User Help Guide

Working with Filter Templates

Filter Templates in Import Filters and Connection Files

Full Name: This name will not be displayed in the Filter Manager, but this field allows you to assign a longer, 
more descriptive name, if you choose.

Based On: Enter any information about what documentation was used to create the filter. Commonly the 
server documentation is available on the Web, so you could enter a URL here as well to make it easy to 
later retrieve that information.

Information Provider: The category is typically the information provider (such as OCLC), but you may enter 
anything that will help you categorize and organize your filters. The category information is also shown in 
the Filter Manager window, in the column next to the name of the filter. In that window, you may sort filters 
by category and also search for them by category.

Created: The date the filter was installed or created.

Last Modified: The date the filter was last modified.

Comments and Limitations: Enter any helpful information such as how to download references in the 
format that works with this filter.

All of the information except the Full Name in this panel is visible in the Filter Manager if you click the More 
Info option at the bottom of the Filter Manager window. (The Information Provider appears as "Category" in 
the More Info view.) This  is helpful because you do not need to edit a filter to view the comments or other 
descriptive information. You may scroll through the available filters in the Filter Manager window and view 
the information there.

The most important part of a filter or connection file is the Templates section. The templates define how the 
various lines of tagged data in your data file should be imported and filtered into the different EndNote fields 
(such as Author, Year, and Title). Different sets of templates are required for the different reference types 
that may be in your data file.

The Templates panel consists of individual Reference Type templates which correspond to the way the 
reference data is presented in the data file. These topics will help you:

Navigating in the Templates Panel in Import Filters and Connection Files▪

Tags and Fields in Import Filters and Connection Files▪

Templates for Different Reference Types in Import Filters and Connection Files▪

Adding and Deleting Rows in the Filter Template in Import Filters and Connection Files▪

Cutting, Copying and Pasting Rows in Import Filters and Connection Files▪

Literal Text vs. EndNote Fields in Import Filters and Connection Files▪

The {IGNORE} Field in Import Filters and Connection Files▪

The Source Line in Import Filters and Connection Files▪
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Navigating in the Templates Panel in Import Filters and 
Connection Files

Tag Field(s)

TI: Title

Tags and Fields in Import Filters and Connection Files

Tag Field(s)

TI: Title

Tag Field(s)

   TI: Title

The Reference Type Tag in Import Filters and Connection Files▪

Fields with Special Characteristics▪

When Punctuation Repeats within a Field in Import Filters and Connection Files▪

The Templates panel in a filter  is divided into a Tag column and a Field(s) column. The tag and its 
corresponding field(s) are two separate cells in a row. If a cell is active, an outline appears around the cell.

To move from one cell to the next, press the Tab key or click the mouse in the desired cell. To move back to 
the previous cell, hold down the Shift key while pressing the Tab key.

To change the width of the Tag column in the Filter window, position the cursor over the vertical line dividing 
the Tag and Field(s) columns. The cursor changes to indicate that you are in the correct place. Click and 
drag to the right or left to resize the column widths.

Click the Reference Types list to change the view to a different reference type (such as from Journal Article 
to Book).

There are two columns shown in the template of an import filter: Tag and Field(s). The Tag precedes the 
data that will be imported into EndNote; the Tag itself is not imported. There must be at least one space 
between the Tag and the data for EndNote to import the data.

Importing works by pattern matching. The pattern of the tag and the pattern of the field data in the text file 
must match the pattern in the Tag column and the contents of the Field(s) column of the filter.

 

Notice the difference in the Tag columns of the examples above. In the first example, there are no spaces 
before the tag. This would work when importing if the original data file had the tag at the left margin, with no 
preceding spaces. However, if the original data file had three spaces between each tag and the left margin, 
You would need to build your filter as shown in the second example, with three spaces before the tag in the 
Tag column.

When setting up the Tag for filters, include any spaces that precede the tag in the original data file.
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Templates for Different Reference Types in Import Filters 
and Connection Files

Adding and Deleting Rows in the Filter Template in Import 
Filters and Connection Files

Cutting, Copying and Pasting Rows in Import Filters and 
Connection Files

Along with the spacing needing to be the same, the tag must be capitalized the same way in the filter as it is 
in the data.

The Templates panel includes templates for all of the various reference types (Journal Article or Book, for 
example).

Click the Reference Types list to change the view to a different reference type (such as from Journal Article 
to Book). 
 
The reference types that have a check mark displayed next to them already have a template defined (you 
can edit the template if you wish). The reference type that appears in bold type is currently the default 
reference type.

The only reference types templates that need to be filled in are the ones that correspond to the reference 
types in your data file. For example, if the database from which you are downloading contains only journal 
articles, you would only need to fill in the templates for the Journal Article section in that particular filter.

Importing works through pattern matching. The pattern of the template must match the pattern of the data 
being imported. Within each reference type template there is a list of tags and their corresponding EndNote 
field names. These templates should exactly match the way the information is organized in the data file. Any 
text, leading spaces (including spaces from the left margin to the beginning of a tag), or punctuation that you 
see that is not part of a field name (such as "vol." before the Volume) is included to make the template 
exactly match the data file.

When adding and deleting rows, the order of the tags does not have to match the order of the tags in the 
data file. There is one case in which the order of the tags is important: if you are entering multiple variations 
of one tagged line, you should enter the repeated lines for that tag in order from the most complex to the 
simplest. This is because EndNote looks for matches starting from the top of the window working down the 
list of tags. It stops at the first template that matches the tagged data.

To start a new row immediately below the active row, position the cursor in the Field(s) cell, and press Enter.

To start a new row immediately above the active row, position the cursor in the Tag cell, and press Enter.

To delete a row, select the row and then select Cut from the filter's Edit menu.

You may use the Cut, Copy, and Paste commands to move or duplicate a cell or a row of cells. To do so:

Select a row by dragging the mouse across both columns. (Dragging the mouse vertically across 
more than one row selects a range of rows.)

1.
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Copying and Pasting Between Reference Type Templates

Literal Text vs. EndNote Fields in Import Filters and 
Connection Files

Tag Field(s)

SO: Journal. vVolume nIssue pPages.

To duplicate the selected row(s) elsewhere in a filter, select Copy (Ctrl+C) from the filter's Edit menu. 
If you want to delete the selected row and move it to another location, select Cut (Ctrl+X).

2.

Click where you would like the cut or copied row to appear, and select Paste (Ctrl+V) from the filter's 
Edit  menu. If the cursor is in the Tag colomn, the pasted row will be inserted above the row where 
the cursor is; if the cursor is in the Field(s) column, the pasted row will be inserted below. (Pasting 
when an entire row is selected will replace the row.)

3.

By choosing Select All (Ctrl+A) from the Edit menu, you can select all of the rows in a given Reference Type 
template. This is useful for copying an entire template to a new reference type  or filter. After copying the 
entire set of templates for a reference type, you may select a different reference type from the Reference 
Type list at the top of the window, click in the Tag cell for the new reference type, and select Paste.

When you copy information from one reference type (such as Journal Article), and paste the rows into 
another reference type (such as Newspaper), the field  names automatically change to reflect the names 
used by the new reference type. If there is not a corresponding field name in the new reference type, the 
original field name in the template is replaced with {IGNORE}, indicating that the data for that tag will be 
ignored. You can edit the new template to match the data, as needed.

When you look at a filter, you will notice that some of the templates contain information other than EndNote 
field names. For EndNote to identify which data should go into a particular EndNote field, you must include 
punctuation and any literal text  or spaces that appear in your data file. Punctuation and literal text act as 
delimiters, allowing EndNote to parse the data into multiple EndNote fields. None of these delimiters actually 
gets imported into an EndNote library, they merely serve as guides for EndNote to correctly import the data.

Here is an example of a data file’s source line where, in addition to punctuation, there is literal text such as 
"v", "n" and "p" preceding the data:

SO: Youth Theatre Journal. v6 n4 p3-6.

The "v", "n" and "p" are considered literal text because they are not EndNote field names; they represent the 
literal text from the data file that precedes the data that you want to import. In this particular source line, 
there are four different pieces of information: the journal name, volume, issue, and pages. To help EndNote 
determine when one field ends and the next one begins, you must insert the literal text, punctuation, and 
spaces found in the data file next to the appropriate field name.

As a result, the above SO: tag line should be represented in a filter like this:

In some databases, you may find lines of data that include a word that is also an EndNote field name. The 
following source line contains the word "pages" before the page numbers:

SO: Town-planning-review. vol. 62, no. 4, pages461-469.
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Tag Field(s)

SO: Journal. vol. Volume, no. Issue, `pages`Pages.

The {IGNORE} Field in Import Filters and Connection 
Files

Tag Field(s)

TI: Title. [{IGNORE}]

The Source Line in Import Filters and Connection Files

If entered into the filter, EndNote would normally interpret the word "pages" as a field name. (This is true 
whether you type it in the filter or insert it using the Insert Field list.) To force EndNote to read a field’s name 
as literal text, surround the name with accent grave characters (`), as in `pages`. The accent grave 
character is found in the upper left corner, under the tilde (~) key on most English keyboards. To match the 
source line shown above, the source line in the filter should appear as:

There may be pieces of information in a line of data that you do not want imported into your EndNote library. 
To force EndNote to ignore pieces of information, use the Insert Field list to insert {IGNORE} in  the 
appropriate place. For example, suppose you want EndNote to ignore bracketed text that sometimes follows 
the title of an article:

TI: Research funds are dwindling. [letter]

You should add a new TI tag and template to your filter that looks like the example below. This  line should 
be above the TI: Title line because this line is more complex, with added information in it. EndNote will try to 
match information to each template line with the same tag from top to bottom, so the more complex line 
goes above the simpler line.

The source line is typically the most complex line of data in a record because it contains all of the 
information about the source of the publication. For a journal article, the source line may contain the journal 
name, the volume number, the issue number, page numbers, and the year of publication. For a book, the 
source line may contain the publisher, the city, and the number of pages.

The source line in your filter  must match exactly the source line in the data file  in order for EndNote to 
distinguish one piece of information from another. You will often find more than one variation of a source line 
for a given reference type in a single data file, in which case you will need to create a separate source line 
for each variant, starting with the most complex source. The three source lines displayed below come from a 
single database:

SO: Semin-Oncol. 76(3):465-71 1998
SO: Semin-Oncol. 127:5-24 1999
SO: Eur-J-Cancer. 118/6 (654-657) 1998

In the first SO: tag line, parentheses enclose the issue number "(3)." In the second SO: tag line, there is no 
issue, so a colon separates the volume number and the page numbers "127:5-24." In the third SO: tag line, 
a slash separates the volume number and the issue number "118/6" and parentheses enclose the page 
numbers "(654-657)."
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Tag Field(s)

AU: Author

TI: Title

SO: Journal. Volume(Issue):Pages Year

SO: Journal. Volume/Issue (Pages) Year

SO: Journal. Volume:Pages Year

KW: Keywords

The Reference Type Tag in Import Filters and Connection 
Files

Each variant in the data file’s source lines must be defined in your filter. Since EndNote tries to match the 
source line in the data file with the first defined source line in your filter, you should place the most detailed 
source line first, followed by progressively less detailed source lines.

The filter for the above source lines should look like this:

Note: If the filter fails to match a variation of the source line for a journal article, it is possible to have 
EndNote interpret the data on its own. See Source Parsing in Import Filters and Connection Files.

A Reference Type tag identifies the kind of work or publication being referenced in a particular record in your 
data file. In the Filter window, a Reference Type tag is only defined by the characteristic of having literal text, 
and no fields, entered into the field column. This literal text is not imported into EndNote, but it is used only 
to identify a record’s reference type.

Although a Reference Type tag can be any tag at all, two common Reference Type tags are "DT" and 
"PT" (which stand for Document Type and Publication Type).

JN- Am J Occup Ther; 47 (11) p998-1008|
CP- UNITED STATES|
PY- Nov 1993|
SN- 0272-9490|
JC- 304|
CN- MCJ-009105|
LA- ENGLISH|
DT- Analytic; Serial| ←Reference Type Tag
JA- 9404|

To ensure that EndNote imports the data into the correct reference type, you must type the Reference Type 
tag in the Tag column, and the reference type name (or other identifying text) exactly as it appears in the 
data file in the Field(s) column. (The matching is case-sensitive.) The Reference Type tag can be placed 
anywhere in the appropriate Reference Type template.

When EndNote imports a record, it first scans the data file, looking for a Reference Type tag in your filter. 
Then it looks for a match in the record it’s  importing. The first Reference Type tag match encountered 
determines which of the Reference Type templates EndNote will use to parse the record. This match also 
determines which reference type EndNote assigns the record in the EndNote library.
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Tag Field(s)

DT: Journal Article

Tag Field(s)

DT: `Journal` Article

Fields with Special Characteristics

Removed Characters 
at End of Title

. Period

, Comma

; Semicolon

: Colon

/ Forward slash

\ Back slash

( Opening parenthesis

- Hyphen

^ Caret

When entering the Reference Type tag in your filter, the text you enter in the Field cell must be interpreted 
by EndNote as literal text. A problem can arise when you have text that contains an EndNote field name. For 
example, the following Reference Type tag contains the field name "Journal":

Because the field name "Journal" appears in the template, EndNote will not interpret this DT: tag line as the 
Reference Type tag. Instead, the filter would import the word Journal (from the data file’s DT: line) into the 
Journal field.

To force EndNote to interpret the word Journal (or any other field name) as literal text, put an accent grave 
(`) character at the start and end of the word. (The accent grave character is usually found in the upper left 
corner of the keyboard, under the tilde (~) key.) The above Reference Type tag should appear in a filter as:

If the database  you use does not specify a Reference Type tag, all reference types in your data file will 
import as the default reference type (see Reference Type in Import Filters and Connection Files).

Certain EndNote fields contain special restrictions on what sort  of data can be imported. These settings 
cannot be modified and apply to all import filters.

Author Fields: The words "And Others" get converted to "et al" and the word "and" is omitted. Years 
as well as parenthetical or bracketed text are removed by default. See Author and Editor Parsing in 
Import Filters and Connection Files.

▪

Year: Only 4-digit numbers (1### or 20##) are imported.▪

Title: The following punctuation is removed from the end of a title.▪
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When Punctuation Repeats within a Field in Import Filters 
and Connection Files

Tag Field(s)

SO: Journal. Volume (Issue): p. Pages

Tag Field(s)

SO: Journal|. Volume (Issue): p. Pages

Pages: A "P" or "p" before the number is automatically removed.▪

Volume: A "V" or "v" before the number is automatically removed, as is a number that appears to be 
a year.

▪

Issue: An "N" or "No"  or "No." before the number is automatically removed (this is not case 
sensitive).

▪

A special formatting character called a "vertical bar" (|) can be placed in a filter  to indicate a repeating 
separator within a field. For example, you may have a data file  where a period followed by a space 
separates a journal name from the volume. However, in some cases, this separator is part of the journal 
name itself, with the result that a period and a space cannot be reliably used to distinguish a journal name 
from the volume. For example:

SO:  Science. 10 (3): p. 80-90

The above source line would be defined in a filter as:

Another source line in the same data file might look like this:

SO:  Proc. Nat. Acad. 19 (5): p. 23-24

The problem arises in the second source line where the separator between the journal and volume (period 
and a space) is found repeatedly within the journal name. The SO: line in the filter instructs EndNote to 
import the data up to the period and space into the Journal field. Consequently, EndNote would parse 
"Proc." as the journal name, and everything after the period up to the open parenthesis as the volume, so 
the volume would be "Nat. Acad. 19."

There is a way to indicate a repeating separator within a field in the filter. If you place a vertical bar (|) before 
the separator, this instructs EndNote to read up to the last occurrence of this separator. In the example 
above, if we place a vertical bar before the repeating Journal field separator (period and space), the SO: line 
in the filter would look like this:

 
This SO: line in this filter instructs EndNote to import all the data up until the last period followed by a space 
separator as a journal. Here, EndNote would import "Proc. Nat. Acad." as the Journal, and "13" as the 
Volume.
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The Filter Options

EndNote’s "Smart" Settings

Author and Editor Parsing in Import Filters and 
Connection Files

Name Order

The remainder of the options listed in the Filter window below Templates provide the tools for fine tuning 
your filter. These options include, among other things, how author names should be interpreted, how text is 
indented in your data file, and which characters should be omitted when you import records into an EndNote 
library.

When possible, EndNote provides a Smart option for your choices in configuring the filters. Wherever you 
select a Smart option, it means that EndNote will do its best to interpret the data. If you do not know exactly 
how the reference is configured in the data file, or if there is a lot of variability among the format of the 
references, then the Smart options are probably going to be the most reliable settings. In cases where the 
Smart option does not work for your data file, you may try the other options provided for that particular 
setting.

These topics describe the various filter options:

Author and Editor Parsing in Import Filters and Connection Files▪

Continuation Lines in Import Filters and Connection Files▪

Reference Type in Import Filters and Connection Files▪

Field Editing in Import Filters and Connection Files▪

Record Layout in Import Filters and Connection Files▪

Source Parsing in Import Filters and Connection Files▪

Use the Author Parsing panel to specify how author names are arranged in your data file. These settings 
apply only to authors in EndNote’s main (Generic) Author field. The Editor Parsing panel applies to editors, 
translators, and other authors; all those that are in EndNote’s Generic Secondary Author, Tertiary Author, 
Subsidiary Author, and Translated Author fields.

Use the "Name Order" settings to specify the order in which first and last names are arranged in the data 
file. Examples appropriate to each setting are shown below:

Last Always Precedes First 
 
AU: Smith, J.; Caton, K.; Jordan, L.

▪

First Always Precedes Last 
 
AU: J. Smith, K. Caton, L. Jordan

▪
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Interpreting First Names

Author Name Separators

Between Authors

Name Order is Inconsistent 
 
AU: Smith, J., K. Caton, L. Jordan

▪

The Interpret First Names as option allows you to specify exactly how EndNote should interpret the part of 
the author name that it has identified as the first name or initials.

The default is set to Smart, which uses the following rule: If there are three or fewer contiguous uppercase 
letters, these letters are imported as initials. Otherwise, the letters are imported as a whole name. For 
example, if the author’s name appears in the data file as:

AU:  Childs, Jackie D.

Smart parsing will interpret "Jackie" as the first name, and "D" as the middle initial. This author name would 
import as:

Childs, Jackie D.

If the author’s name appears in the data file as:

AU:  von Braun, ED

Smart parsing will interpret ED as initials; thus the author name would import into EndNote as:

von Braun, E. D.

EndNote would only import ED as a first name "Ed" if you selected the Whole Names option.

The Whole Names and Initials Only options should only be used in special cases. The Whole Names option 
should be used in the case where the authors in your data file are all uppercase (because Smart parsing 
would recognize mixed case names as full names), and full names are used. This option prevents EndNote 
from converting names consisting of two or three uppercase letters, as in "SUE" or "AL" to initials. For 
example, if the author’s name appears in the data file as:

AU: TOBIES, SUE

the Whole Names option would correctly import the author’s  first name as "Sue." By contrast, EndNote’s 
Smart Parsing would interpret the whole name SUE as three initials, as "S.U.E. Likewise, if you select 
Initials Only, EndNote imports all first names as initials only. You would only choose this latter option if the all 
the first names in your data file are initials.

The Author Name Separators tell EndNote how to extract the individual authors from a line containing 
several authors.

The "Between Authors" option refers to the punctuation that is used to separate individual author names. It 
is extremely important that this setting is correct so that the author names import correctly into EndNote. 
Author names in an EndNote reference are listed one name per line.
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Last and First Names Separator

Parenthetical Data in Author Field

The default for the Between Authors option is set to Smart. With this option selected, EndNote looks for a 
common separator, either a semicolon (;), a carat (^) or a vertical bar (|), and uses this delimiter to identify 
where one name ends and the next name begins.

In this example, multiple authors are separated by a semicolon:

AU: Bunting ME; Hanzlik JR

EndNote’s Smart parsing recognizes the semicolon separating the two author names and correctly imports 
them into an EndNote library as:

Bunting, M. E.
Hanzlik, J. R.

Therefore, in this example, you do not need to change the setting. However, if your data file has a delimiter 
other than a semicolon (;), a caret (^), or a vertical bar (|) separating multiple authors, you must select 
another option from the adjacent list. To type any punctuation, such as a hyphen or a slash, select Other 
and type the character there. A space and a return (where the authors are listed one per line) can be 
selected directly from the list.

If you select Import As Is from the list, EndNote will not try to separate the names that follow the author tag. 
Everything that follows that tag in the data file will be imported exactly as it appears in the file.

Once EndNote knows how to identify an individual author name in a list of authors, it looks at that name and 
tries to determine what the first name is and what the last name is. The Last & First Names separator is 
used to do this, along with the Name Order settings.

The default Last & First Names setting is Smart. With this option selected, EndNote attempts to interpret an 
author’s name based on the following separators: a space, a comma, or a period. In your data file, if the 
separator used between the last name and the first name is something other than a space, a comma, or a 
period, you can select a separator from the adjacent list.

It is not uncommon for information providers to include additional information about the authors (such as 
date of birth or institutional affiliation).

AU: Takahashi, J (1974-); Izumi, R (1989-)

When this information is mixed in with the list of authors on the tagged author line, EndNote provides two 
options for what to do with it.

Discard: All parenthetical information is discarded during the import.▪

Import Into: All parenthetical data mixed in with the author names is imported into the field that you 
choose. We suggest that you import it into the Notes field, Author Address, or another custom field 
that is appropriate.

▪

Note: It is not appropriate for EndNote to import that data into the Author field because it would produce 
an incorrectly formatted bibliography to have the parenthetical data included with the author names.
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Continuation Lines in Import Filters and Connection Files
In general, EndNote ignores lines of text which do not begin with a tag unless the lines of text are 
continuations of a previous tagged item. We call these continuation lines. Here is an abstract from a data file 
illustrating the concept of continuation lines (all but the first are considered continuation lines):

AB- A single-subject research design that used 
    multiple baselines across behaviors compared 
    traditional adaptations to computers.

Because EndNote only imports tagged lines and continuation lines, it can avoid importing extraneous text 
that might interrupt a reference, such as your logging on or logging off text. Examples of extraneous lines 
are:

-->>Press any Key to continue 
 
<Record 5 of 42>

EndNote provides two general options for dealing with continuation lines:

Ignore Indents: Untagged lines are always a continuation of the preceding line▪

With this option set, every line of text in the data file will import according to the tags that are defined 
in the Templates panel. Do not select this option if there is any text in your data file that is not tagged. 
If you use this option and do not want to import certain tagged lines, you must use the {IGNORE} 
option (see The {IGNORE} Field in Import Filters and Connection Files).

Continuation lines must be indented▪

This option allows you to specify the exact number of spaces on the left margin for the continuation 
lines.

The following example is an abstract where the first line of data (including the Tag, which takes three 
"spaces") begins four spaces from the left margin, and the continuation lines are indented four 
spaces, so all the data text aligns at the left. EndNote’s default  Smart Indent Identification would 
import this abstract correctly. (Spaces are shown as periods (.) for clarity.)

AB-.Two experiments compared the performance of 23 12 
....old dyslexics with that of 8 age-matched controls on a 
....battery of tests of motor balance. A dual-task paradigm 
....was used: Ss performed each test as a single task and as 
....a task concurrent with a secondary task. In all single- 
....task conditions there was no difference between groups.

However, you may find data files where the continuation lines are not aligned with the first line of 
data. In the following example, the continuation lines are indented two spaces from the left margin, 
whereas the first line of data (including the Tag, which takes three "spaces") begins four spaces from 
the left margin.

AB-.Beyond the inevitability of countertransference feelings 
..is the question of countertransference enactments. From a 
..two-person, participant-observer or observing-participant 
..perspective, enactments are inevitable. The analyst becomes 
..influenced by the patient (and influences the patient as 
..well) and enmeshed in the patient's internalized 
..interpersonal configurations.
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Reference Type in Import Filters and 
Connection Files

Default Reference Type

Identifiers

For EndNote to treat the subsequent lines as continuation lines in the preceding example, the filter  must 
specify the exact number of spaces indented on the left margin. In the example just given, you would enter 
"2" in the Indented Spaces option.

If most of the lines in a data file import a fixed number of spaces (like two spaces in the example above), but 
one tagged field  is indented differently (perhaps keywords are indented four spaces), you can enter 
exceptions in the table provided. Simply enter the number of spaces in the left column next to the tag. You 
only need to enter a number for the tagged field with the inconsistent import. All other lines that are left 
blank will use the general indent setting.

Note: For a quick and reliable way to count how many spaces are inserted on the left margin, turn on the 
setting in your word processor to display formatting characters. It can also help to use a monospace, or 
"fixed width," font to display the data.

The default reference type tells EndNote which reference type to use if it cannot identify the reference type 
of a record. For example, suppose that in one filter you specify Journal Article as your default reference 
type, and create a template  for it. If you import a data file  containing conference proceedings records for 
which you have not defined a Reference Type template, any conference proceedings records will import as 
Journal Articles. Also, if the database  that you use does not specify a Reference Type tag, all reference 
types in your data file will import as your default reference type. (See The Reference Type Tag in Import 
Filters and Connection Files for information about defining the reference types tag in a template.)

Note: The default reference type is always indicated with bold text in the Reference Types list on the 
Templates panel.

Some information providers provide Identifier tags with the name of the vendor (the data provider) and the 
database.

These identifiers are also used to import data files that contain references from multiple databases. EndNote 
can import multi-source files like that as long as each record in the data file has a vendor and a database 
tag at the start of the reference. The identifiers must also be entered into the appropriate filters in the Filters 
folder. When you are ready to import a file that has data from multiple sources in it, be sure to select the 
Multi-Filter import option in the Import dialog.

The way that EndNote is able to know which filter to use is by these Identifier tags entered into the filter. 
Both identifiers must be used. The first identifier should be the tag that includes the name of the information 
provider. For this example it is "VN." The exact text that follows that tag for each record should be entered 
into the corresponding box in the Identifiers section. The next tag is used to identify the database, such as 
Medline or BIOSIS. Enter the tag used for the database name, and then enter the database name exactly as 
it appears in each reference.
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Field Editing in Import Filters and Connection Files

Converting Text from Uppercase to Lowercase

For example, for EndNote to read this data correctly:

<1> 
VN - Ovid Technologies 
DB - Ovid MEDLINE(R) 
AU - Jacobson, R; Campbell, S 
PY - 1999

For Vendor Identification, enter the Tag " VN -" and the Text "Ovid Technologies" and for Database 
Identification, enter the Tag "DB -" and the Text "Ovid MEDLINE(R)" as shown above.

To access this feature, select Import Filters  or Connection Files  from the Tools  menu. Open the Manager, 
select a filter or connection file, and then select the Edit option.

If all of the text for a field in your data file appears entirely in uppercase letters, EndNote can convert the text 
to either Sentence, Headline, or Lowercase format, depending on which option you specify in the Field 
Editing panel.

To control the lowercasing of a field, select the appropriate field from the Field Editing for list at the top of the 
window. The EndNote fields are listed here by their Generic names. Then pick a capitalization option from 
the Change UPPERCASE text to list.

A title that appears in a data file as "COMPOST AS A HUMAN NUTRIENT AND HORMONE CARRIER" 
would import in Headline capitalization as:

Compost as a Human Nutrient and Hormone Carrier

or in Sentence capitalization as:

Compost as a human nutrient and hormone carrier

To keep a field’s text entirely in uppercase characters, select the Do NOT Lowercase option.

You can apply lowercasing on any field as long as all the text in the field is uppercase. If any of the text in 
the field is in mixed case, EndNote will import it in mixed case.

Note:  For a list of reference type  fields and their corresponding Generic field names, use the List of 
Reference Types to access the reference type settings for any predefined reference type.

The Author, Editor, and Translator fields are treated differently from all other EndNote fields. Upon importing 
author fields into an EndNote library, these fields are automatically converted from uppercase to headline. 
Due to the special characteristics of these particular fields, the option to change the case is not available in 
the Field Editing panel.
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Omitting Unwanted Characters

Record Layout in Import Filters and Connection Files

Smart Record Identification

Some lines of data have superfluous characters, such as an asterisk (*) or a hyphen (-),  that you may not 
want to import. For example, in the following lines of data there are hyphens in the journal name, and there 
is an asterisk before each keyword:

SO- American-journal-of-preventive-medicine; 12(9)
DE- *COMPUTER SYSTEMS DESIGN; *DISPLAY DEVICES; *INTERFACES

To prevent unwanted characters from being imported into your EndNote library, use the Field Editing panel 
to specify the characters that you want to omit:

From the Field Editing for list, select the EndNote field that contains unwanted characters. You will 
find that the EndNote fields are listed by their Generic names. For a list of reference type fields and 
their corresponding Generic field names, use the List of Reference Types.

▪

Type the unwanted text in the Enter text to be omitted box,  and then click Add  to add it to the 
omission list.

▪

When you prevent characters from being imported into an EndNote field, you are omitting the characters 
from the corresponding Generic field, so the omission applies to every reference type field that corresponds 
to the particular Generic field. For example, the Secondary Title field corresponds to both the Journal field in 
a Journal Article reference type and the Series Title in a Book reference type. Therefore, if you omit a 
hyphen (-) from the journal name, any hyphens found in a Series Title for a Book reference type will also be 
omitted.

Each item that you want to omit should be entered on a separate line. For example, let’s  say that you 
wanted to omit both underscores (_) and forward slashes (/) from your records’  keywords. First add the 
underscore, and then add the forward slash. Entering both items on the same line would cause EndNote to 
omit only instances of "_/", while all other instances of underscores and forward slashes would end up in 
your keywords. You can omit up to 254 characters per EndNote field.

To remove an item from the list, select the item and click Remove. You may select more than one item by 
holding down the Shift or Ctrl key while clicking on multiple items.

Note: The more items added to the list, the longer it takes EndNote to import records into EndNote, but it 
is generally faster than running a manual Find and Replace after import. If you would prefer to manually 
replace characters after import, see Find and Replace.

Use the options in the Record Layout panel to modify how EndNote interprets the end of a reference in a 
data file.

Smart Record Identification, EndNote’s  default  setting for record termination, creates a new record in 
EndNote each time a tag in the data file repeats out of sequence and is preceded by a blank or extraneous 
line. EndNote will not create a new record if the same tag appears in succession, provided that they are not 
separated by a blank line.

For example, some databases list authors one per tagged line, with the AU tag appearing two or more times 
in succession, as in the following example:
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More Specific Record Layout Options

AU- D'Orazio, MG
AU- Tamura, TS

When EndNote sees consecutive tags, it does not start a new reference unless it finds the same tag 
preceded by a blank or extraneous line.

A more precise way of identifying a new record is to specify in your filter  exactly how the records are 
terminated in your data file. The remaining options in the Record Layout panel allow you to do this.

To determine how records are terminated, open your data file in either a word processor or text editor. 
Check for the pattern consistently separating one record from another. Once you have determined the 
correct record termination, click the appropriate button on the Record Layout panel to select the best option 
for your data file. You may choose only one option as a record terminator.

Blank line separates records 
 
Select this option if the only blank lines in a data file are the ones in between references.

▪

Using "First Tag" and "Last Tag" Options 
 
This option lets you specify a first tag that starts the record and/or a final tag that ends each record. 
Only one tag is required.

▪

Before choosing this option as your record terminator, verify that the first or last tag is 
consistently present in each record. This option will function correctly only if the chosen tag 
appears in every record.

▪

You do not need to enter both a first and last tag; either tag will suffice to distinguish one record 
from the next.

▪

Enter the tag exactly as it appears in the data file, including the delimiter that follows the tag (for 
example, a colon or hyphen following the tag). EndNote treats these delimiters as part of their 
respective tags.

▪

You do not need to include these tags in the templates of your filter, unless you wish to import 
the associated data.

▪

Each record ends with 
 
Select this option if your references consistently end with a specific set of unique characters. Note 
that whatever you enter into this option needs to be unique enough that it does not appear elsewhere 
in your references. One common set of characters that is used to terminate each record is ||.

▪

Each record starts with 
 
Select this option if your references consistently start with text that is not a tag. For example, it is 
common for some information providers to begin each reference with a counter such as:

▪

<1> 
or 
Record 1 of 53
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Example

Source Parsing in Import Filters and Connection Files

Identifying the Source Tag

When Source Data and Filter Templates Do not Match

In these cases, enter the text exactly as it appears in the data file, but substitute a number sign (#) 
for the actual number. For the examples above, you would enter "<#>" and "Record # of #" in the 
field.

The following example illustrates a data file that contains neither a blank line, nor text terminating each 
record. However, there is a consistent first tag, "ND:" starting each record. So for this example you would 
want to specify "ND:" to identify the beginning of a record by clicking the "First Tag" button, and typing "ND:" 
in the box.

ND: 430529953| 
BASE: BA83| 
AU: HILDEN

The source line  refers to the line in the data file  that represents the source information for the journal 
(typically journal, volume, issue, pages, and sometimes the year). It is usually the most complex and 
inconsistent line of data in your data file—and it is also the most important. As a result, the EndNote filters 
provide a sort of safety net to catch inconsistently entered source data.

The tags and templates defined in the Templates panel are used first to import source data. If a source line 
in a data file does not match any of the options in the templates, then EndNote provides you with additional 
options for how to handle that. The first thing you need to do is to make sure that EndNote has correctly 
identified the journal article source tag.

If the source tag for the Journal Article reference type  in the Templates section of a filter  is SO or JN, 
EndNote automatically identifies this tag as the source tag. However, if the source tag defined in your filter is 
something other than a SO or JN, you must choose the appropriate tag from the Journal Article Source Tag 
list. (All of the tags that have been defined in the Journal Article template will appear in the Source Tag list.)

If a journal article’s source line in your data file does not match a source line in your filter, you can choose 
how EndNote should treat the unmatched source line. The default option is Use Smart Parsing. EndNote’s 
Smart Parsing does its best to distinguish the journal name, the volume number, the issue number, the page 
numbers, and the year, and import each into the corresponding EndNote field. Any information that is not 
identified as a journal, volume, issue, pages, or year is imported into the Notes field, along with the 
comment "Using Smart Source Parsing." (After importing, if you suspect that some references may not have 
matched the defined source template, it is helpful to use EndNote’s Search command to search for the text 
"Using Smart Source Parsing" in the Notes field of the imported references. You may then check those 
records to see if EndNote correctly interpreted the data.)

If you choose the other option, to import the source data into a separate field, EndNote does not attempt to 
parse the source information, and instead imports the entire unmatched source line into whatever field you 
have specified.

For any reference type other than a Journal Article, unmatched source lines are automatically imported into 
the Notes field. Therefore, if you have not defined an exact match for a source line found in a book record in 
your data file, EndNote imports the entire source line into the Notes field.
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Importing MARC Records

What Are MARC Records?

The MARC Format and Connection Files

Example of a MARC Filter

Unique Aspects of MARC Records

Numeric Tags

Subfields

"MARC" stands for Machine Readable Cataloging format. It is a standardized format developed by the U.S. 
Library of Congress for producing machine-readable bibliographic records. It is much more difficult to read 
than regular tagged data formats, but it can still be imported in much the same way using EndNote’s filters.

Many connection files use the MARC format because it is specified as part of the Z39.50 standard. When 
creating a new connection file, the Templates and MARC Records portions of the connection file are 
automatically set up to import standard USMARC (MARC21) data. If you need to customize these parts of 
the connection file, the instructions in this section would apply.

For a good example of the filter options used with MARC data, look at the filter sections of the connection 
file for the U.S. Library of Congress. To open this file for editing, select Connection Files > Open Connection 
Manager from the Tools menu, then select the Library of Congress file and click Edit.

MARC records differ from other bibliographic records in three important ways; they include numeric tags and 
subfields, and they do not generally include line breaks.

The primary way in which MARC records differ from non-MARC bibliographic records is in their reliance on 
numeric tags. Numeric tags typically consist of three digits, followed by one or two spaces, and one or two 
more digits. For example:

050 00  $aPS3503.E53 $bB6 1986 
082 00  $a811/.52 $219 
100 1   $aBene ́t, Rosemary, $d1900-1962. 
245 12  $aA book of Americans / $cby Rosemary and Stephen Vincent Bene ́t ; 
illustrated by Charles Child. 
260     $aNew York : $bH. Holt, $c1986. 
300     $a114 p., [1] leaf of plates : $bill. ; $c22 cm. 
490 0   $aAn Owlet book

The second way in which MARC tags differ from other bibliographic records is the use of subfields.

Each numerically tagged line in a MARC record may contain any number of subfields. A subfield typically 
consists of two consecutive characters, the first of which is the subfield delimiter which denotes the start of a 
new subfield. Examples of subfields are "$a" and "$x." The subfields do not have to be consecutive.
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No Line Breaks

Creating a Filter for MARC Records

Data Start Column

If you were creating a conventional filter  for importing bibliographic records from a MARC database, you 
would have to anticipate a vast number of possible combinations, both of tags and of subfields.

Because it is difficult to anticipate every possible combination of tags and subfields in MARC records, 
EndNote provides you with a simplified way of creating filters for MARC records. The two sections that 
follow tell you how to create a filter specifically for MARC records, and then alert you to the different rules 
that EndNote uses when importing MARC records into an EndNote library.

When you save a text file from an online database, there are generally line breaks with tags at or near the 
left margin which can be used to create filter templates from. Line breaks are necessary for creating filters 
because the tag identifier is "read" in relation to the left margin. Raw MARC data has no line breaks, making 
it impossible to download most MARC data as a text file and build an import filter for it. For this reason, 
MARC data is seldom seen in import filters but common in connection files.

When importing data through a connection file, EndNote inserts the necessary line breaks. When looking at 
the connection log, the data is shown with the line breaks EndNote has inserted, which allows the filter 
portions of connection file to be built. This means if you see an option to download a MARC file for an online 
database, it is likely you will not be able to create a filter for it, but you can use the Import command to 
import the Connect.log file created during an online search. See The Connect Log File.

Note: It is very rare to build an Import Filter for MARC data because raw MARC data does not include line 
breaks. Therefore, these instructions will usually be applied to the filter portion of a connection file. See 
No Line Breaks in Unique Aspects of MARC Records. See Creating Connection Files for information on 
creating a new connection file.

Once you have created a new filter or connection file, or you have opened an existing filter or connection 
file, select the MARC Records panel.

Click the Process data file as a MARC  record checkbox.  The dollar sign ($) will appear in the MARC 
Subfield Delimiter box,  since this is the most common subfield  delimiter. If the subfield delimiter is 
something other than a dollar sign, delete the dollar sign and type in the appropriate delimiter.

The reference data in a MARC reference normally starts in column 8 (that is, the eighth character from the 
left margin). This is the default  setting you will find in the "Data starts in column" text box. If the MARC 
records in your data file start the actual reference data (as opposed to tags and subfield delimiters) in some 
other position, enter that number in the "Data starts in column" text box.

Note:  Always enter a value of 6 or higher in the "Data starts in column" text box. If you enter a lesser 
value (for example, you enter the number 5), the value will change back to 8 when you leave the Marc 
Records panel even if you have saved your changes. This only happens in the "Data starts in column" 
text box. If you make other changes, then those values are saved when you return to the Marc Records 
panel.

Page 474 of 586

 



Clarivate EndNote 20 User Help Guide

Accession Numbers

If the First Field Has No Subfield Delimiter

Rules for MARC Import Filters

The Accession Number is a unique number assigned to each record in a database (the  information 
provider’s database, not the EndNote library). The provider may not call it an Accession Number; PubMed 
uses PMID, and some systems use Unique Identifier. These numbers sometimes appear immediately after 
the numeric tag, and without the two-digit subfield codes seen in other MARC fields. Since a common type 
of accession number often appears after the 001 tag, EndNote includes an Import 001 tags as Accession 
Numbers checkbox which lets you import this number into EndNote’s Accession Number field. Accession 
numbers which appear in lines other than 001 often begin with a subfield, so you can set up the filter to 
import the number into the Accession Number field.

Note: Only one item can be imported into the Accession Number field. If the contents of the 001 field are 
imported to the Accession Number field and another tag is also set to import to the field, the data set to 
import into the field  under any other tag will be ignored. If there is no data already in the Accession 
Number field, then the contents of the second tagged field will be imported.

Normally the first character that precedes the record data is the subfield delimiter (commonly a dollar sign 
$). If this subfield delimiter is not present for the first field of each tagged line, you will need to tell EndNote 
how to interpret the first character by checking the appropriate option under the MARC records dialog. Is it 
part of the real data of a reference or is it a field designator (such as "a" or "b") that just happens to be 
missing the subfield delimiter?

EndNote observes these rules when importing MARC records:

EndNote allows you to specify only the first three digits of the tag when designing a filter for MARC 
records. You can disregard spaces and digits appearing immediately after the first three digits. The 
tag for both of the following examples would be 245.

▪

245 10  $a When you realize you have too many kids: 
$b a guide / $c Hugh B
245 14  $a The angel with a dirty mouth /$c NickSteel 
; illustrated by Melissa

You do not have to define all the subfields in a tagged line. There may be some subfields that 
contain information you do not want to import into your EndNote library. EndNote will ignore any 
subfields that are not defined in your filter.

▪

Source lines cannot take advantage of the Smart Source Parsing option. You may, however, enter 
multiple variations of the subfields in a source line. Be sure to enter all subfields after the same tag 
(do not repeat the tag for each), and list the most complex subfield formats first. For example:

▪

773 $gVolume(Issue), p. Pages$gVolume, p.Pages

With the exception of the reference type tag, EndNote allows you to define a MARC tag only once; 
therefore you should include all of the subfields that contain data you want to be imported. For 
example, the following line in a filter for MARC records would successfully import any or all of the 
three lines that follow:

▪
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Tag Field(s)

245 $a Title $b Title $c Notes

Modifying an Existing Filter, an Example

Adding a Tag and Field to a Filter

 
245 14  $a The hollow horn : $b Bob Dylan's reception in 
the United States and Germany / $c by Dennis Anderson.
245 10  $a Bob Dylan, spellbinding songwriter /$c Nathan
245 00  $a Down in the groove.

Modifying an existing filter is useful if you want to create a new filter for a different database by the same 
provider. Although some information providers offer radically different formats for their different databases, 
there are others who provide fairly consistent tags and organized data across their databases.

Common reasons for editing a filter include adding a tag to import additional information; removing a tag or 
using {IGNORE} to omit unwanted data; or fine-tuning the current settings for importing authors or journal 
source data. The specifics about how to work with templates and options are described earlier in this 
chapter. This example is intended to provide a general overview of the process of editing a filter.

Let’s  say that you want to modify a filter to import the language of the publication into EndNote’s 
Language field. In this hypothetical database, the language is preceded by the tag LA-.

TI- Zum beginn des mathematischen Frauenstudiums i Preussen. | 
TI- <Translated> The beginnings of mathematical studies for women 
    in Prussia | 
AU- Tobies. Renate 
JN- NTM Schr. Geschichte Natur. Tech. Medizin | 
SO- <JN> NTM Schriftenreihe fur Geschichte der Naturwissenschaften 
    Technik und Medizin | 
SO- <PY> 1991 | 
SO- <VO> 28 | 
SO- <NO> no. 2, | 
SO- <PG> 151-172. | 
LA- German | 
DT- Journal |

To add the LA- tag and direct its contents to the Language field:

From the Tools menu select Import Filters > Open Filter Manager.1.

In the Filter Manager, select the filter that you want to edit, and then click Edit. (Editing  the most 
recently used filter will also appear as an option in the Import Filters submenu.)

2.

Select the Templates option in the left panel of the window to open the Templates panel.3.

Click the mouse in any cell of the Journal Article template, and then press Enter to create a new row. 
(Tags do not need to be in the same order as in the original data.)

4.
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Creating a New Filter

Type LA- in the Tag cell (including any preceding spaces), and then press the Tab key to move to the 
Field(s) cell. Insert the Language field from the Insert Field list. Doing so tells EndNote to import the 
language information following the LA- tag into EndNote’s Language field.

5.

You can add the LA- tag to the remaining Reference Type templates in the filter. Use the Reference 
Type  list to switch to each reference type  template in your filter and repeat the process described 
above. (Reference types with check marks next to them in the list are the ones that have templates 
defined for them.

6.

From the filter's File menu, select Save As. Enter a new name for the modified version of the filter, 
and then click Save.

7.

This topic provides a general overview of how to create a new filter. For more information, you can also view 
an example of a data file, and the templates portion of a filter to match it (see Example Data File and 
Template).

The basic steps to create a new filter are:

From the Tools menu, select Import Filters, and then select New Filter.1.

In the About This Filter panel, enter a category for the filter (usually the information provider is used 
for the category), and any other comments about what the filter is based on or instructions on how to 
save the data.

2.

Click on the Templates option.3.

From the Reference Types list, select the first reference type that you would like to define, and enter 
the necessary tags and the corresponding fields into the reference type template. See the Sample 
Record from a Data File for sample fields you can use to build your template. Also see Working with 
Filter Templates.

4.

Define additional reference types, as necessary, by selecting them from the Reference Types list and 
entering the tags and fields for them as well.

5.

Click the Reference Type option in the list of panel names, and select the default reference type for 
the filter.

6.

If this were a real filter, you might have entered enough information at this point to use the filter successfully. 
You could try it out by choosing it as the import option to import your data file into a new, empty library. You 
would review the imported references to be sure that they imported correctly. If they did not, you could fine 
tune the filter as necessary (see The Filter Options).

Notes: It's a good idea to create an empty testing library for importing when working on a filter, to limit the 
chance of importing poor data into your working library. After you have perfected your filter, you can use it 
to import into your regular library. 
 
If you need a reference type that does not appear in the Reference Type list, see Adding, Changing, and 
Hiding Reference Types.

For additional help, see Tips for Entering Tags and Fields and Example Data File and Template.
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Tips for Entering Tags and Fields

Example Data File and Template

Not every tag in your data file needs to be in your filter.▪

There is no need to define every tag that appears in your data file, provided that the contents of the 
corresponding field start on the same line as the tag itself; and the records’ continuation lines are not 
flush left. If you need to define every tag that appears in a record, but only want to import the 
information associated with certain tags, insert the {IGNORE} field from the Insert Field list where 
appropriate.

Note: You do not need to specify all data fields, unless each tag appears on a line by itself, with 
the data starting below it on the next line. You may also want to specify all tags if the continuation 
lines in your records are flush left, in which case an undefined tag appearing immediately after a 
continuation line will be read in as text.

You might need to enter multiple variations of a source line.▪

You will often find more than one variation of a source line for a given reference type in a database, 
in which case you will need to define a separate source line in your template for each such variant. 
The most complex source line should appear first, followed by source lines of decreasing complexity. 
In the case of Journal Articles, be sure to specify the appropriate Source Parsing option (see Source 
Parsing in Import Filters and Connection Files).

MARC formats are an exception. See Rules for MARC Import Filters.

A colon, hyphen, space, or other character that appears along with a tag is treated as part of the tag.▪

When defining tags in a filter, these characters need to be included in the tag column of the filter for 
EndNote to find an exact match. If spaces are inserted within a tag, they need to be defined as part 
of the tag as well. See Tags and Fields in Import Filters and Connection Files.

Using a monospace font to view data files can help you count spaces which will need to be included 
in the template.

▪

Monospace, or fixed width, fonts are fonts where each letter takes up the same amount of space; 
proportional fonts are fonts where thinner letters, such as i or l, take up less space than wider letters, 
such as m or w. With proportional fonts, the size of spaces are not the same size as letters, making it 
easy to miscalculate the number of spaces used in tags or text. Examples of monospace fonts are 
Courier New, Lucida Sans Typewriter, and MS Mincho, among others.

Below is a modified sample of a record from PubMed Central, along with a  matching sample filter 
template for a Journal Article reference type. See Working with Filter Templates for details about configuring 
templates.

Red periods (.) in the text indicate spaces. They are colored red to differentiate them from periods included 
in the original text.
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Sample Record from a Data File

VI..-.105 
IP..-.6 
DP..-.2020.Jun 
TI..-.Geriatric.assessment.in.older.patients.with.a.hematologic.malignancy:.a 
......systematic.review. 
PG..-.1484-93 
FAU.-.Scheepers,.Ellen.R.M. 
AU..-.Scheepers.ER 
AD..-.Department.of.Internal.Medicine,.Diakonessenhuis.Utrecht,.Utrecht,.the 
......Netherlands 
FAU.-.Vondeling,.Ariel.M. 
AU..-.Vondeling.AM 
AD..-.Department.of.Geriatric.Medicine,.Diakonessenhuis.Utrecht,.Utrecht,.the 
......Netherlands 
LA..-.eng 
PT..-.Journal.Article 
PT..-.Review 
PHST-.2019/12/24.[received] 
PHST-.2020/04/02.[accepted] 
PMC.-.PMC7271571 
PMID-.32381581 
JT..-.Haematologica 
AID.-.10.3324/haematol.2019.245803.[doi] 
AID.-.1051484.[pii] 
SO..-.Haematologica..2020.Jun;105(6):1484-93..doi:10.3324/haematol.2019.245803.

To create a template for the Journal Article reference type in a new filter:

Select Journal Article from the Reference Types list.1.

Type "PT..-" (red periods indicate spaces) in  the first tag cell, then press Tab to move to the Field 
column. Insert "Journal Article" as the first field, typing  it exactly as entered in the data. This is the 
tag identifying the reference type and tells EndNote that any record with "Journal Article" following 
the PT tag should be imported using the Journal Article template.

2.

Press Enter to move to the next line.3.

Type the next tag to import and insert the corresponding field. Continue entering the rest of the tags 
and fields until all of the necessary information is covered by the filter. Skip or use {IGNORE} in the 
Field(s) column for any tags that you are not interested in importing.

4.
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Tag Field(s)

PT..- Journal.Article

VI..- Volume

IP..- Issue

DP..- Year.Date

DP..- Year

TI..- Title

PG..- Pages

FAU.- Notes

AU..- Author

AD..- Author.Address

LA..- Language

PHST- Notes

PMC.- PMCID

PMID- Accession.Number

JT..- Journal

AID.- DOI.[`doi`]

AID.- {IGNORE}.[pii]

SO..- Notes

This is what the resulting Templates panel of the filter should contain:

Note: For this example, the source line contained no data that was not already contained in other fields, 
so it was sent to the Notes field. If data needs to be extracted from the source line, set up the various 
source line combinations and select the appropriate Source Parsing option. See Source Parsing in Import 
Filters and Connection Files.
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Connection Files

Introduction to Connection Files

What is a Connection File?

The Connection Manager

Locating the Connection File You Want to Use

The Online Search command on EndNote’s  Tools menu,  and the Online Search groups, connect you  to 
online databases and library catalogs so that you can search them from within the EndNote program and 
retrieve references directly into EndNote. EndNote is able to make these connections using the information 
stored in the thousands of individual connection files.

This section describes how to edit and create connection files. The process of using the Online Search 
command is described in Searching an Online Database.

EndNote provides thousands of connection files for a variety of sources. By default, only the most popular 
connection files are stored in the Connections folder in your EndNote folder. You can view all available 
connection files by selecting Connection Files > Open Connection Manager from the Tools menu.

To install additional connection files, see Installing Additional Connection Files.

A connection file contains all the information necessary to connect to, search, and import references from an 
online database or online library catalog. Each connection file represents a different online database (such 
as the U.S. Library of Congress or PubMed from the National Library of Medicine).

EndNote provides thousands of connection files for a variety of sources. By default, only the most popular 
connection files are stored as individual files in the Connections folder in your EndNote program folder. To 
install additional connection files, see Installing Additional Connection Files.

To access the Connection Manager, select Connection Files  > Open Connection Manager  from the Tools 
menu.

The Connection Manager lists the names of all of the original connection files available in the  \\Program 
Files (x86)\EndNote 20\Connections folder as well as any new or modified connection files in your personal 
Connections folder, and gives you the options to edit them or select them as "favorites" for quick access in 
the Online Search group set. You can click and drag the corner of the dialog to increase the size.

If you know the name of the connection file that you want to use, start typing it to select the first file 
that matches what you type.

▪

Click Find by and select an information provider’s name (such as OvidSP or OCLC) to find only the 
connection files for a specific information provider.

▪

Click Find by and select All Connections to return all of the connection files to the displayed list.▪
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Marking Your Favorite Connection Files

Saving Connection Files

Copying Connection Files

Click the column headings  to sort the connection files by name or by information provider. Clicking 
the same column heading a second time will change the sort order from ascending to descending. 
Click again to set it back to ascending order.

▪

Click the More Info button  at the bottom of the dialog to display additional information about the 
selected connection file. Click Less Info to hide the additional information.

▪

When you have found a connection file that you will want to use in the future, click the checkbox next to it to 
mark it as a favorite. All connection files (up to 500) that are marked as favorites appear as an Online 
Search group set in the Library window. This gives you easy access to the files you use most often.

An easy way to mark a whole category of connection files (such as all of the connections for OvidSP 
databases) is to click Find by and choose a category from the list. Then, with just that subset of connection 
files listed in the Filter Manager window, click Mark All. The Unmark All option may be used to unmark all of 
the connection files that are showing in the list.

To save a new connection file that you have just created, or to save changes to a connection file you have 
just modified, select Save As from the connection file's File menu.

If you have modified one of the original installed files in the \\Program Files (x86)\EndNote 20\Connections 
folder, you must use Save As  to save a copy to your personal Connections folder. If you have modified a 
connection file that is already located in your personal Connections folder, you can select either Save  to 
directly modify the file, or Save As to make a copy with the changes. For a description of where  your styles 
are stored, see Folder Locations Preferences.

EndNote automatically saves new connection files to your personal Connections folder. You may also 
specify a different folder, if necessary. For instructions see Folder Locations Preferences.

EndNote connection files use the file name extension of .enz, as in "Medline (OvidSP).enz."

When you display a list of connection files in EndNote, the list is comprised of the installed connection files 
found in the \\Program Files (x86)\EndNote 20\Connections folder, as well as new or modified connection 
files found in your personal Connections folder. For an explanation of where your files are stored, see Folder 
Locations Preferences.

There are two ways to copy connection files. Since each connection file is a separate file on your hard drive, 
you can copy them as you would copy any file on your hard drive using the File Explorer.

To make a copy of a connection file from within EndNote:

From the Tools menu, select Connection Files, and then select Open Connection Manager.1.

Select the connection file you want to copy and click Edit.2.
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Deleting Connection Files

Basic Components of a Connection File

Editing a Connection File

Without making any changes to the connection file, select Save As  from the  connection file's File 
menu.

3.

Give this copy of the connection file a new name, and then save it.4.

The file is saved in your personal Connections folder. The new connection file will remain open. The original 
connection file will be left untouched.

To delete a Connection File from within EndNote:

From the Tools menu, select Connection Files > Open Connection Manager.1.

Right-click on the connection file  to be deleted and select Delete Connection…  from the menu, or 
press the Delete key.

2.

You will be asked for a confirmation of if you really want to delete the connection file. Select Yes to 
delete the connection file or No to keep it.

3.

You can also delete an unwanted connection file by opening  File Explorer  and opening  the appropriate 
Connections folder (see Folder Locations Preferences). Then, drag the connection file from the Connections 
folder to the Recycle Bin, or select the file and press the Delete key.

Note: You must have read/write access to the Connections folder in order to delete a Connection File. If 
you do not have administrator access, you likely will not be able to delete a file located within the Program 
Files (x86) folder. 

Topics describing the basics of a connection file  are listed below. This information is useful if you want to 
modify or create a connection file. To create a new connection file, see Creating Connection Files.

Editing a Connection File▪

The Connection Editor Window▪

About this Connection▪

The Connection Settings▪

Search Attributes in Connection Files▪

Filter Information in Connection Files▪

To edit a connection file:

From the Tools menu, select Connection Files > Open Connection Manager.1.
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The Connection Editor Window

About this Connection

Select the file to edit, and then click Edit. 
 
The most recently used connection file can also be easily edited by selecting Connection Files from 
the Tools menu, and then selecting Edit [connection_file_name].

2.

Make your changes to the connection file.3.

If you are editing one of the original, installed connection files:4.

From the connection file's File menu, select Save As (the Save command will not be available).a.

Name the file and click Save.b.

If you are editing a connection file that you created, select Save from the connection file's File menu.5.

EndNote saves the file in your personal Connections folder. For a description of where connection files are 
stored, see Folder Locations Preferences.

After choosing the option to edit an existing connection file  or create a new one, EndNote opens the 
Connection Editor window.

All of the different panels of the Connection Editor are listed on the left side of the Connection Editor. Click 
on an item to view the associated settings. You may switch between panels as needed while editing the file. 
No changes are saved in any of the panels until you select Save or Save As from the connection file's File 
menu.

To close the Connection File, select Close Connection from the connection file's File menu or click the Close 
button in the top right corner of the window.

When the Connection Editor opens,  it displays the About this Connection panel. This panel contains 
descriptive information about the connection file, and has no impact on establishing the connection.

Name: Displays the name of the file as it appears in the Connections folder of the EndNote folder. The file 
name extension (.enz) is not displayed. The name of the connection file cannot be changed here; you would 
need to close this window and switch back to the File Explorer to rename the file.

Based On: Enter any information about what documentation was used to create the connection file. 
Commonly the server documentation is available on the Web, so you could enter a URL here to make it 
easy to later retrieve that information. If this connection file is a modified copy of another connection file, it 
may be helpful to enter the name of the original file in this field for future reference.

Category: The category is typically the information provider (such as OvidSP or OCLC), but you may enter 
anything that will help you categorize and organize your connection files. The category information is also 
listed in the Connection Manager window in the column next to the name of the file. In that window, you may 
sort connection files by category and also search for them by category.

Created: The date the connection file was installed or created.

Last Modified: The date the connection file was last modified.
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The Connection Settings

Comments and Limitations:  Enter any useful comments here that would help you remember how to 
search the online database. Limitations to preconfigured connection files may be documented here as well.

All of the information in this panel is visible in the Connection Manager if you click the More Info button at 
the bottom of the Connection Manager window. This is helpful because you do not need to edit a connection 
file to view the comments or other descriptive information. You may scroll through the available connection 
files in the Connection Manager window and view the information there.

Click Connection Settings  to view the panel where the data to establish a connection is stored. The 
Connection Settings information is required for EndNote to be able to connect to the online database. These 
terms and descriptions are part of the Z39.50 standard.

Server Description: The name of the information provider or institution. EndNote displays this name in the 
title of the Retrieved References window and it is also listed in the Connection Manager window. This 
information is not used to establish the connection.

Server Address: The server address for the online database. This can be either a numerical IP address or 
a URL.

Database Description: The name used to refer to the online database. This name is displayed in the Title 
bar of the Retrieved References window to help you identify the database to which you are connected. It is 
not used to establish the connection.

Database Name: The file name command used to select the database on the remote server. This is not the 
name you would use to talk about the database; it is a command for "starting up" the exchange of 
information with the database.

Element Set Name: This is normally F for Full or B for Brief. The Element Set Name determines the amount 
of information that is provided by the server for each retrieved reference. Not all servers support both 
options, and the fields returned for each option also vary. For most databases, the Full option is preferred.

Port ID: The TCP/IP port at the server that is used for a Z39.50 connection. The two most popular ports are 
210 and 7090, but other ports can be used. The port to be used is controlled by the server and EndNote 
must match it. These are not the same ports used by your browser, except for the PubMed  and Web of 
Science™ Core Collection  connection files. Because they are not used by browsers, they are frequently 
blocked by network firewalls. See Problems Connecting.

Batch Download: EndNote typically retrieves references in batches, for speed and memory reasons. 
However, some servers are too slow, or their record data is too large, to support batch downloads. You will 
need to turn batch processing off for such sites. If you are having trouble downloading from a site, you can 
try deselecting this option.

Record Syntax: Many formats used by Z39.50 servers are supported by EndNote, such as UNIMARC 
(Universal Machine Readable Cataloging), SUTRS (Simple Unstructured Text Record Syntax), and OPAC 
(Online Public Access Catalog). When you create a new connection file, it is set up for the MARC21 format. 
For other formats, the filter section for connection files must be constructed manually. UNIMARC and OPAC 
use variations of the MARC format (OPAC commonly adds holdings data). The SUTRS format, because it is 
"unstructured," does not have a standard format among different databases. The SUTRS format often uses 
tags (such as "AU" or "Author") to identify the reference data. Check with your database provider for the 
appropriate settings.
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Custom ID Authentication String

Search Attributes in Connection Files

Text: The Text option is used to specify how EndNote should interpret the incoming text characters. Options 
include ANSEL, Unicode (UTF-8), Unicode (UTF-16), and many other language choices. If you do not have 
the correct setting, extended characters may import as asterisks, or may be dropped completely. Check with 
your database provider for the appropriate setting.

Login Information Required: This section is divided into four separate options: User ID, Password, Group 
ID, and Custom. Select the options required to login to the online database in order to have EndNote prompt 
you for that information when you connect. You can also store your password and/or IDs in the connection 
file so that you do not have to enter them each time you connect. Simply type the password or ID into the 
box provided.

Notes: Passwords and IDs may be saved in the connection file for convenience, but do so at your own 
risk: passwords are not protected or encrypted. If someone else copies or uses your connection file, they 
will be able to use your stored password. 
 
The password and User ID requested by the host will generally not be your personal password and ID. It 
is usually the User ID and password assigned to your institution (the exception to this might be if your 
institution has a local copy of the database). These institutional User IDs and passwords are usually not 
shared with individuals within an institution. However, access may be granted to anyone connecting to the 
database from an IP address within the institution. If you are off-site and cannot access a database that 
you could access when onsite, use VPN to connect to your institution's network first, then try the 
connection file again. If you do not have VPN access to your institution's network, check with your 
network administrator.

Sometimes a database server requires a custom format for presenting the password and IDs. For these 
situations, you may skip the regular password or ID option, check the "Custom" option, and enter the text 
specified by your server’s Z39.50 documentation. You may either enter your actual password and ID along 
with the text, or use one of the following placeholders to have EndNote prompt you for the necessary 
items: ?PASSWORD, ?USERID, ?GROUPID.

For example, a system may require that passwords be presented by Z39.50 clients in the following manner:

pass=?PASSWORD/ dla_ui=yes

If you wanted to store your password ("abc123" for this example) it would look like this:

pass=abc123/ dla_ui=yes

The Search Attributes section of a connection file contains a table that defines the various search options for 
a particular database.

Search Field Name: The first column identifies the name of a search. This is the word or phrase that 
appears in the menus in the Search dialog. 
 
Use EndNote’s Generic field names as the search field names whenever possible. Doing so makes it 
easier to have a search apply to various online sources and local EndNote libraries. 
 
EndNote’s preconfigured connection files often use parenthetical text after the search field name to 
help describe the search, if necessary. This parenthetical text is not considered part of the search 
field name when you change the focus of the search and EndNote looks for a matching search field 

▪
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What Is an Attribute?

Using Search Attributes

The Use Attribute

name. See Changing the Focus of the Search. Also see The Generic Fields for a list of Generic field 
names.

Attributes: The rest of the items in a particular row are the various search attributes that control 
what index is being used for the search, and how the search term is interpreted.

▪

A Z39.50 search attribute  is a value used to define the characteristics of a search term. For example, if 
your search term is "ebola virus," the various attributes would be sent to the server along with that term to 
tell the server where to look for "ebola virus" and what qualifies as a matching reference.

Available attributes, as defined by the Z39.50 standard, are:

Use: The index to be searched (such as Keywords)1.

Relation: The relation of the search term to the index (such as equal, greater than, or less than)2.

Position: The position of the search term in the MARC record field (first, last, anywhere, and so on)3.

Structure: The structure of the term, such as a word or phrase4.

Truncation: Available truncation options used to interpret the search term (for example: right 
truncation, wildcards, no truncation)

5.

Completeness: Indicates whether or not the search term should be the complete subfield in the 
MARC record corresponding to the field searched

6.

The "Use" attribute is the most important here, indicating which index will be searched to find the search 
term. The other attributes will all have varying default  values for each online database. These options are 
most often left blank to use the server’s  defaults, but the default attribute values can be overridden by 
entering another value for the attribute. See Using Search Attributes for  more information on 
customizing the search attributes.

Each database has its own supported subset of Use attributes and associated combinations of the other 
attributes. Consult the configuration information for the online database to determine which values for these 
attributes are supported. Clarivate  does not provide this information. You will need to obtain it from the 
organization (or information provider) that maintains the server.

Search attributes control the query that is sent to the server. They are independent of the information that 
will be sent back. Think of these as being how you ask the question. You can ask a general question or a 
very detailed question, depending on the attributes you use. Different databases will support different sets of 
attributes, so you may need to experiment with these settings. Most of the time, using the default settings 
will fit your needs, and to use those you can simply leave most of the fields blank. You  can use the 
information below to customize the search attributes, but please remember that the Z39.50 server you are 
connecting to controls which attributes it will accept.

This attribute describes what type of information is being searched for. It’s easy to think of this as just the 
field being searched, but it is more detailed than that. For example, Use value 1 equals a personal name, so 
you might use it when searching for a person’s name but not a corporation’s name. Use attribute 2 equals a 
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The Relation Attribute

The Position Attribute

The Structure Attribute

The Truncation Attribute

corporate name. Not all use attributes will be supported for all databases. When you create a new, blank 
connection file it will be prepopulated with the most commonly-used use attributes, but can then be edited.

For a detailed list of Use attributes, see https://www.loc.gov/z3950/agency/defns/bib1.html.

EndNote does not support editing this field.

The position attribute specifies the location of the search term within the field or subfield in which it appears.  
The options are—

1 = First in field:  The search term must be the first data in the field.▪

2 = First in subfield:  The search term may appear in any subfield but must be the first data in the 
subfield.

▪

3 = Any position in field:  The search term may appear anyplace in the field.▪

The structure attribute specifies the type of search term, for example a single word or a phrase.

1 = Phrase:  One or more groups of characters separated by blanks, in exactly the order they are 
entered.

▪

2 = Word:  A group of characters with no blanks.▪

3 = String:  The entire term is to be treated as a string, rather than a sequence or set of individual 
words.  An example might be a telephone number with blanks within it.

▪

4 = Word List:  One or more groups of characters separated by blanks, in which there is no implied 
order.

▪

Truncation determines if one or more characters may be omitted when matching the search term.  The 
effects of truncation vary depending on what the structure attribute is set to, as explained below.

1 = Right Truncation: 
Word or Phrase:  Last word of the term is right truncated. 
String:  Entire term is right truncated. 
Word List:  Each word is right truncated.

▪

2 = Left Truncation: 
Word or Phrase:  First word of the term is left truncated. 
String:  Entire term is left truncated. 
Word List:  Each word is left truncated.

▪

3 = Left and Right Truncation: 
Word or Phrase:  First word of term is left truncated and last word of term is right truncated. 

▪
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The Completeness Attribute

Tip for Editing Search Attributes

Filter Information in Connection Files

String:  Entire term is left and right truncated. 
Word List:  Each word is left and right truncated.

100 = Do Not Truncate:  No truncation is applied.▪

1 = Incomplete Subfield:  Words other than those in the search term may appear in the subfield or 
field in which the term appears.

▪

2 = Complete Subfield:  No words other than those in the search term should appear in the entire 
subfield in which the term appears, but additional words may appear in other subfields in the field.

▪

3 = Complete Field:  No words other than those in the search term should appear in the entire field 
in which the term appears.

▪

When modifying the search attributes in a connection file, it is useful to first test the search with the new 
attribute combination before actually changing the connection file. If you are an advanced user and familiar 
with Z39.50 terminology, you can do this by entering the new attribute values using the command-line 
search method. This lets you test new attribute combinations without having to edit and save the connection 
file, and then reconnect to the server every time you want to test a modification. See Using the Z39.50 
Command-Line Syntax.

You can find more information on Z39.50 search attributes at https://www.loc.gov/z3950/agency/defns/ 
bib1.html.

The Filter section of the connection file contains the information used to import each reference and get the 
reference data into the correct EndNote fields.

For most connection files, the filter is set up to interpret references in the MARC format. When you create a 
new connection file, the Filter section will be set up to interpret references in a standard MARC21 format.

This part of the connection file is identical to the regular Import Filter window. For more information about 
editing a filter, consult Importing MARC Records and Working with Filter Templates.

If the retrieved references are not importing the way you would like, you should compare the filter settings of 
the connection file to the original text that EndNote receives from the online database. To do so, select 
Show Connection Status from the Tools menu when retrieving references. Set the view in the Status window 
to show Record Data and compare the record data to what is in the filter.

The connection record data is also stored in the Connect.log file. See The Connect Log File for information 
on file location and how to import the log file. Importing the log file allows you to test new filter templates 
without having to connect to the online database repeatedly.
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Creating Connection Files

Create the File and Enter the Basic Information

Test the Connection and Searching

Before you begin actually creating or modifying a connection file, you must obtain the Z39.50  client 
configuration instructions for the database you want to access. Contact your librarian or information provider 
for this information.

Note: If the database is not available on a Z39.50 server, you will not be able to use EndNote’s Online 
Search feature to access it directly. Instead, use the Import feature to import references that have been 
downloaded to text files. See Importing Reference Data into EndNote.

Once you have the Z39.50 client configuration information in hand, follow these steps to create a new 
connection file:

From the Tools menu select Connection Files, and then select New Connection….1.

A new window opens called "Untitled Connection" and displays the About this Connection panel. 
Enter any comments or descriptions here for your own use. (These comments do not affect how the 
connection functions.)

2.

Click on the Connection Settings option and enter the connection information. (See The Connection 
Settings.)

3.

Click on the Search Attributes  option to modify the default  search attributes, if necessary. 
(See Search Attributes in Connection Files and Using Search Attributes.)

4.

From the connection file's File  menu, select Save As. Name the new connection file and save it. It 
will be saved in your personal Connections folder. To change the location your connection files are 
saved, see Folder Locations Preferences.

5.

(Optional) If you would like to add your new connection to your Favorites list, select Connection Files 
> Open Connection Manager  from the Tools  menu to open the Connection Manager. Locate your 
new connection file and mark the checkbox next to it to add it to your Favorites list. It will then appear 
in the Online Search group set.

6.

From the Tools menu, select Online Search and select your new connection file, or select it from the 
Online Search  group set if you have made it a Favorite. If the connection cannot be established, 
check the settings in the Connection Settings panel of the connection file, save your changes, and 
try again. If you still have trouble connecting, see Problems Connecting and Problems Finding the 
Host.

1.

If the connection was established, the Search panel should open automatically. Enter a simple 
search to see if the search attributes were correctly configured. If the Search does not work correctly 
or it returns an error, check the Search Attributes settings in the connection file. (If you modify the 
connection file at this point, you must save the connection file, then close the Retrieved References 
window and reconnect in order for your changes to take effect.)

2.
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Test the Filtering of Reference Data

Default Values for New Connection Files

Default settings for a new connection file are:

Once you are able to connect and search, retrieve a dozen or so references to test how accurately 
they are filtered into EndNote references. Double-click a retrieved reference to open it to verify that 
the data are in the correct fields. 
 
Note that if you are paying for the references you retrieve, these may not come through correctly, so 
it is best to retrieve only a few. All references retrieved are saved to a connection log file, so they are 
not lost and can be used for testing your filter changes without reconnecting to the online database. 
This log file is replaced the next time you open EndNote.

1.

If the reference data is not being correctly filtered into the appropriate fields in the EndNote 
references, you will need to compare the downloaded data to the filter templates in your connection 
file. 
 
Open the Connect.log file in a word processor to view the original format of the retrieved references. 
See The Connect Log File  for information on locating the log file and importing its contents to test 
your filter without needing to reconnect to the online database.

2.

From the Tools  menu, select Connection Files,  and then select Edit [Your_Connection_File]  to edit 
the newly created connection file. Look at the Templates  panel of the connection file and compare 
the templates there to the reference data in the Connect.log file. Make changes as necessary. 
See Creating a Filter for MARC Records and Working with Filter Templates  for information about 
modifying filters.

3.

When creating a new connection file, a few basic search attributes are entered by default. It is not 
guaranteed that these will work, as each database may only support its own subset of the Z39.50 attributes.

Consult the Z39.50 client configuration instructions from your information provider or your librarian to set up 
the connection file correctly for the online database you want to access.

Port ID: 210

Element Set Name: F (Full)

Record Syntax: MARC21

Text: ANSEL

Search Fields (Use Attributes): Any Field (1016), Author (1003), Year (31), Title (4), and Subject (21).

Filter: MARC21 filter settings are used. Templates are defined for the following reference types.

Artwork▪

Audiovisual Material▪

Book▪

Computer Program▪
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Using the Z39.50 Command-Line Syntax

Electronic Book▪

Generic▪

Manuscript▪

Map▪

Patent▪

Thesis▪

Web Page▪

See Working with Filter Templates and Importing MARC Records for  information on creating filters 
for additional reference types.

Note: This topic is intended only for people who are familiar with Z39.50 terminology and have access to 
the Z39.50 client configuration information for their online databases. The advanced search strategies are 
documented here only for more technical EndNote users; this knowledge is not required for basic 
searching of online databases. These command-line searches do not work with PubMed or the Web of 
Science™ Core Collection connection files.

It is possible to set up a search of an online database that is not supported by the EndNote Search panel or 
the connection file  you are using. For instance, if you know about the Z39.50 attributes supported by the 
online database, you can enter a Z39.50 search which EndNote passes directly to the server, without any 
translation. This lets you use searches that are not already supported by your connection file and is useful 
for testing various search attribute combinations when creating or modifying a connection file.

These advanced searches are entered directly into the search line just as you would enter a search term. 
EndNote ignores the search menu for that item when it detects that you have entered an advanced search. 
If other search terms are needed, enter them into the subsequent search lines and select the appropriate 
AND, OR, or NOT connectors (just like any other search).

An advanced search uses the following format:

\\search term&/ATTRIBUTE TYPE/ATTRIBUTE VALUE

The first two characters (\\) tell EndNote this is an advanced search of an online database. The next part, up 
to the ampersand (&), is the search term. The numbers of the Z39.50 attribute type and values follow. They 
are entered first with a slash and the number for the attribute type, then a slash, and the attribute’s value. 
Repeat that pattern for as many attributes as you want to specify. Not all attributes need to be included. See 
Using Search Attributes.

The following is a common search example that should work for most servers. This search, looking in Any 
Field and using the Contains operator, should find all references in which the title begins with "child."

\\child&/1/4/3/1/5/100

A Use attribute (1) of 4 has been specified, so the search will be restricted to the Title for this 
database.

▪

A Position attribute (3) of 1 further narrows the search by having the search term be found as the first 
word in the field.

▪
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Tip for Modifying Search Attributes

A Truncation attribute (5) of 100 specifies no truncation.▪

Note: Even if a search, such as the one above, is restricted to the Title field, you may see records 
downloaded that do not have the search term in the Title field of the record. This  is because the Title (4) 
Use attribute is not searching only the main Title field, but all fields considered titles, such as series titles. 
If the term is found in a field that is not included in your filter, you may not see the term appear in your 
record at all.

If you wanted to test how variations of the search attribute settings would impact your search, here’s an 
easy way to do it— without having to edit your connection file.

With the connection already established, select Show Connection Status from the Tools menu. Keep 
the view set to Status Messages.

1.

Start with a basic search using the Search panel (without the command-line syntax). For example, 
search for "child" in the Title field.

2.

Look in the Status window, and you will see which attributes are being used. For example:3.

Searching for: [child&/1/4/3/3/4/2/5/100|] 
(The complexity of what you see will depend on the Search Attribute settings in the connection 
file. This example shows looking for the word "child" in the Title field, in any position in the field, 
as a word, with no truncation.)

You can copy the search command out of the Status window, and paste it onto the Search panel 
(remember to add the "\\" prefix to identify it as a command-line search), then add or modify the 
attribute values as necessary.

4.

Click Search to try out your new combination of attributes.5.

When you have found a combination of search attributes that does what you need, edit your 
connection file and make those changes to the Search Attributes panel.

6.
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Preferences

EndNote Preferences
The settings for configuring EndNote’s display, formatting preferences, and other options are organized in 
the Preferences section of the EndNote program.

To access EndNote preferences:

From the Edit menu, select Preferences.1.

A list of the available preference panels appears on the left side of the window. Click on the name of 
a panel in the list that corresponds to the setting you would like to change. Below are the topics 
covering these preferences.

2.

Change Case Preferences▪

Display Fields Preferences▪

Display Font Preferences▪

Duplicates Preferences▪

Find Full Text Preferences▪

Folder Locations Preferences▪

Formatting Preferences▪

Libraries Preferences▪

PDF Handling Preferences▪

Read/Unread Preferences▪

Reference Types Preferences▪

Sorting Preferences▪

Sync Preferences▪

Spell Check Preferences▪

Temporary Citations Preferences▪

Term Lists Preferences▪

URLs & Links Preferences▪
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Saving or Discarding Your Changes

Where Preference Settings are Saved

Change Case Preferences

Where This Information Is Saved

All of the preferences panels have the following options:

EndNote Defaults: Reverts the settings for just the current panel to the original EndNote settings.▪

Revert Panel: Removes any changes made to the current panel since it was last saved.▪

OK: Saves all changes to the preferences and closes the Preferences window.▪

Cancel: Discards all changes to the preferences and closes the Preferences window.▪

Apply: Saves and applies all changes to the preferences and keeps the Preferences window open 
so that you can continue to modify the preferences as necessary. 

▪

Most general preferences are saved in the Windows registry. This includes many EndNote Preferences, 
subject bibliography  settings, and Cite While You Write settings. Some preferences are stored in user- 
specific folders; this allows multiple users to access a single library while preserving each user’s preferred 
settings. The preferences folders listed below store files such as the connect.log file  created during an 
online search, the RefTypeTable.xml file that contains reference type definitions, and a Searches folder that 
contains saved search strategies.

Windows 10 and 11: C:\Users\User Name\ App Data\Roaming\EndNote

To access these settings, go to the Edit menu, select Preferences, and then click Change Case in the list of 
preferences.

EndNote styles can be configured to change the capitalization of the author names or titles. Use the Change 
Case preferences to list the words that should not be modified when EndNote changes the case of titles. 
This can be used for special acronyms, equations, proper nouns, or compound names that require 
consistent capitalization.

For titles, this preference is used only when an output style is set up to apply "Headline style capitalization" 
or "Sentence style capitalization" (rather than "Leave titles as entered").

To add words to the list, enter the term in the text box at the top of the dialog, and then click Add.▪

To remove an item from the list, select the term and click Remove.▪

The list of terms entered into the Change Case preferences panel is stored in the C:\Users\[Your Folder] 
\AppData\Roaming\EndNote\ENCase.txt file.  For a quick way to duplicate the lists for another computer 
running EndNote, copy this file to the same location on the other computer.

Page 495 of 586

 



Clarivate EndNote 20 User Help Guide

Display Fields Preferences

Display All Authors in the Author Field

Display Font Preferences

Duplicates Preferences

Use the Display Fields preferences to choose which fields to display in EndNote’s Library window. These 
settings apply to all libraries opened on the computer under the same User account.

To access these settings, go to the Edit menu, select Preferences, and then click Display Fields in the list of 
preferences.

Select the desired field from each Field list. You may select up to ten fields to display in the Library window. 
To show fewer than ten fields, select [Do not display] instead of a field name.

By default, the first column in the Library window displays a File Attachment indicator followed by:

Author▪

Year▪

Title▪

Journal▪

Last Updated▪

Reference Type▪

In most cases, the column heading in the Library window is the same as the Generic name of the field. 
Exceptions to this rule include the Figure field, which is indicated by a figure icon fig.  header and the File 
Attachments field, which is headed by a paper clip icon. If you would like to change the name for the Library 
window display, enter a new name in the Heading column next to the chosen field.

If you would like to display all author names under the Author heading column in the library reference list, 
select the Display all authors in the Author field checkbox. For all new installations, this is the default setting.

If this option is not marked, only the last name of the first author will appear in the Reference List.

The Display Fonts panel gives you the option of changing the font size that EndNote uses to display text 
throughout the program.

The Duplicates preferences panel sets criteria for the Find Duplicates command on the Library menu (that 
command is described in Finding Duplicate References).

To access these settings, go to the Edit  menu, select Preferences, and click Duplicates  in the list of 
preferences.
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Compare References

Criteria Panel

Find Full Text Preferences

Folder Locations Preferences

By default, EndNote identifies duplicate references in a library as references of the same reference type with 
matching Author, Year, and Title fields. Use this panel to customize the way EndNote identifies duplicate 
references.

To select the fields that EndNote should compare when finding duplicate references, click in the checkboxes 
to the left of the field names.

The Generic names of the fields are used here. For details about which Generic field name corresponds to 
which specific field name for each reference type, see List of Reference Types. You may select as many 
fields as you want to make the duplicate detection more or less stringent.

You may also set the Criteria to have EndNote compare the fields and look for an exact match or be more 
lenient in the comparison by ignoring spacing and punctuation.

This panel allows you control over which sites, services, and technology EndNote uses when attempting to 
find the full text for a reference. You can limit the options in order to speed up the Find Full Text operation.

To access these settings, go to the Edit menu, select Preferences, and then click Find Full Text in the list of 
preferences.

The checkboxes determine which pieces of information will be used from your EndNote references. These 
represent unique identifiers for locating exact reference matches.

If your institution allows access to an OpenURL server, you can configure this panel to allow EndNote 
access to the site. Select the OpenURL checkbox and enter the OpenURL path to direct to the online site. If 
the site requires authentication to verify that you are allowed access, you can enter an Authentication URL. 
The Authentication URL directs EndNote to the site’s  login page. When you attempt to Find Full Text, you 
will be directed to that page to enter authentication information (typically a user ID and password). If you are 
unsure of your institution's OpenURL settings, consult your local library  Web page or a librarian at your 
insitution.

To learn more about using the Find Full Text feature and about adding access to your institution’s library, see 
Finding Full Text for a Reference.

The Folder Locations preferences panel is where you set the personal folder locations for new or modified 
styles, import filters, and connection files.

To access these settings, go to the Edit menu, select Preferences, and then click Folder Locations in the list 
of preferences.

The many styles, filters, and connection files provided with EndNote are installed in the Styles, Filters, and 
Connections folders, which are located in the EndNote program folder.
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C:\Program Files (x86)\EndNote 20\Styles 
C:\Program Files (x86)\EndNote 20\Filters 
C:\Program Files (x86)\EndNote 20\Connections 

When you display a list of styles, filters, or connection files in EndNote, the list is compiled from two 
locations: the installation folders listed above and your personal folders.

The default personal folder locations for your modified styles, filters, and connection files are—

C:\Users\[User Folder]\Documents\EndNote\Styles 
C:\Users\[User Folder]\Documents\EndNote\Filters 
C:\Users\[User Folder]\Documents\EndNote\Connections 

Note: To change the default installation folder for the provided styles, filters, or connection  files, see 
Changing the Default Content File Location.

Initially, your personal folders do not exist; they are created once you create a new file or save changes to 
an existing file. For example, when you open an existing style and make changes, you cannot Save, but 
must select Save As. You can give the file the same name or a modified name, but the file is saved to your 
personal Styles folder. The next time you view a list of output styles, you will see your modified style on the 
list. If you gave the file a different name than the original file, both are listed. If you gave the file the same 
name as the original, you will see the modified style listed, and not the original file, although it still resides in 
the program folder.

Why do we bother with personal folders? Why not change or add to the installation folders? We 
implemented personal folders so that:

If you reinstall EndNote for some reason, you will not overwrite a modified file with the same name. 
(We know you may have spent hours getting your file just right, and do not want to risk losing your 
work.)

▪

When you upgrade to a newer version of EndNote, you will not delete a new or modified file.▪

When you download EndNote program updates, you will not overwrite a modified file.▪

You can write protect a shared program folder, yet still use your own customized styles, filters, and 
connection files.

▪

You must have administrative rights to modify files in the Program Files (x86) folder. For many users, 
this is not an option, or not easily done. 

▪

To change your personal folder locations:

From the Edit menu, select Preferences.1.

Click on Folder Locations.2.

To change a folder location, click the Select Folder  button for the Style Folder, Filter Folder, or 
Connections Folder.

3.

Locate the folder that you would like to designate as the new Style, Filter, or Connection folder, and 
then click the Select button.

4.
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Formatting Preferences

Suggest Formatting with EndNote’s Cite While You Write if the Document 
Type Is Supported

Omit Author and/or Year from Formatted Citation if Removed from 
Temporary Citation

Merge Duplicates in Bibliography

The Formatting preferences panel allows you to control the formatting of bibliography entries in a word 
processor and whether EndNote automatically omits duplicate references from a bibliography.

To access these settings, go to the Edit menu, select Preferences, and then select Formatting from the list 
of preferences.

While the Format Paper feature for RTF files can be used on most word processor files, we recommend that 
you always use Cite While You Write for Microsoft Word or the most current versions of Apache OpenOffice 
or Libre  Office (32-bit). It is much easier and allows more control, and for Microsoft Word provides more 
options to give you the exact output you want.

When this item is selected, and you attempt to use Format Paper on a document that could be formatted 
with Cite While You Write, a message will appear recommending that you use Cite While You Write. You can 
still save the document to RTF and use Format Paper if you wish.

EndNote’s default behavior is to remove the author or year from the formatted citation if you remove either 
of those items from a temporary (unformatted) citation. For example, "{, 1999 #24}" would format as just 
"(1999)" when using a style that creates (Author, Year) citations. If you prefer to type just the record number 
into your papers as the temporary citation, you should turn this preference off so EndNote will not remove 
the author and year from all of your formatted citations.

Note: Using just the record number in the paper will cause difficulties if you are working with more than 
one library, working with the same library on multiple computers with EndNote Sync, or working with your 
library and a library shared with you through EndNote Sync. This is because the same record number 
may appear in each library for different references. See Record Numbers and Components of a 
Temporary Citation for more information.

When you select this option, EndNote automatically omits duplicate references from a bibliography. Use this 
option if you are citing references from multiple EndNote libraries in one paper. In this situation, the same 
article reference might appear in two libraries and would have two different record numbers. EndNote will 
not identify the records as duplicates unless you have this option set to merge duplicates.

When you select this option, EndNote checks the bibliography for duplicate references during the formatting 
process. If duplicates are found, they are removed. References are considered duplicates if they are the 
same reference type (such as Journal Article or Book) and the following fields are identical: Author, Year, 
Title, Secondary Title (Journal, Newspaper, Magazine, Book Title, Series Title, Conference Name, and so 
on), Volume, Issue, and Pages.

Note:  The Duplicates Preferences  settings do not apply to this feature. The criteria for determining 
duplicates is separate and fixed for the Merge Duplicates in Bibliography setting.
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Libraries Preferences

Choosing a Library to Open

PDF Handling Preferences

Auto Renaming Options

To access these settings, go to the Edit  menu, select Preferences, and then click Libraries  in the list of 
preferences.

Use the Libraries preferences section to specify which libraries should open by default  when you start 
EndNote. First, use the drop-down list to choose from these options:

Open the most recently used library▪

Open the specified libraries▪

Prompt to select a library▪

Do nothing▪

If you opt to Open the specified libraries, you must list those specified libraries here. To add a library to the 
list:

If the library is not already open, close the preferences dialog and open the library. Do this by 
selecting Open from the File menu, and then selecting the desired library. 
 
You can have more than one library open in EndNote, and you can set EndNote to open more than 
one library automatically when the program starts. Just open all the libraries you want to open 
automatically, then select the Open the specified libraries option.

1.

Return to the Libraries  section of the Preferences  dialog, and click Add Open Libraries  to add all 
open libraries to the list.

2.

To remove a library from this list, select it in the Libraries panel, and then click Remove Library.

Of course, once EndNote is started, you can always open a library by selecting Open from the File menu.

PDF Handling preferences allow you to define the automatic renaming process of PDF documents that you 
want to import to an EndNote library. These settings only apply to the renaming of PDF documents that 
have relative attachment links, and so are stored in the library's .Data folder. (See Selecting a Relative Path 
or an Absolute Path for File Attachments.)

To access these settings, go to the Edit menu, select Preferences, and then select PDF Handling from the 
list of preferences.

The renaming and auto-import processes work in  the background when you open an EndNote library and 
while you are working in a library.

Select an auto-renaming option.

Page 500 of 586

 



Clarivate EndNote 20 User Help Guide

Custom Option

Don't Rename: This is the default  option. EndNote does not rename PDF documents when they are 
imported into a library.

Author + Year + Title: EndNote uses these fields as the first, second, and third fields in the PDF 
filename. A filename is created from the available data in the selected fields.

Author + Title: EndNote uses these fields as the first and second fields in the PDF filename. A filename 
is created from the available data in the selected fields.

Author + Year: EndNote uses these fields as the first and second fields in the PDF filename. A filename 
is created from the available data in the selected fields.

Title: EndNote uses only the Title field  in the PDF filename. A filename is created from the available 
data in the selected field.

Custom: You can select up to three fields to base the name on, as described below.

The Custom option allows you to create a personalized method of renaming PDF documents.

A Rename Options dialog opens when you select this radio button. The dialog lets you choose up to three 
fields (or None) in the PDF filename. For example, you could select:

Author, Year, Title (default setting) 
 
or

▪

Title, Author, Year 
 
or

▪

Title, Year 
 
or

▪

You can select any combination of fields from the menu. However, you cannot select the following 
fields.

▪

Figure▪

File Attachments▪

Last Updated▪

Rating▪

Read Status▪

Note: Look at the text box below the Custom radio button after you have made your selections from the 
dialog to ensure that you selected the needed fields.
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PDF Auto Import Folder

File Renaming Conventions

Select the Enable automatic importing checkbox to enable automatic importing of your PDFs.

Select the folder from where you want EndNote to import PDFs into your library automatically. Download or 
copy your PDF files to this folder for automatic importing and renaming. EndNote  imports all PDFs in your 
PDF Auto Import Folder and stores them in a temporary group called Imported References. This group will 
not appear the next time you open EndNote, but the references will still be in your library. If you wish to put 
the references in a custom group, you should do so before  closing EndNote, while they  still appear in 
Imported References.

After EndNote runs the import operation, EndNote creates a subfolder called Import within the Auto Import 
Folder. During the import, EndNote creates a copy of the PDF in the .Data folder of the library, and 
then moves  the original PDF to this subfolder after importing. To save disk space, you may want to 
occasionally clean out this subfolder.

Keep in mind that EndNote does not import PDFs from subfolders within the PDF Auto Import Folder.

Files names — 50 character maximum count, including the period (.) and filename extension.▪

15 character maximum count per field.▪

Year Field — 4 character limit.▪

A hyphen (-) is used to separate fields▪

An underscore (_) is used for any characters that cannot be represented in a file name. 
 
EndNote replaces the following characters with an underscore (_) during the renaming process.

▪

Quotation Mark (")▪

Asterisk (*)▪

Slash Mark (/)▪

Colon (:)▪

Left Angle Bracket (<)▪

Right Angle Bracket (>)▪

Question Mark (?)▪

Backslash (\)▪

Vertical Bar (|)▪
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File Naming Rules

Import File and Import Folder Options

Read/Unread Preferences

Read/Unread Options

You can rename attached PDF documents at any time by selecting a reference containing a PDF 
attachment, and then selecting from the References  menu, File Attachments  > Rename PDFs. All 
the PDFs attached to that reference will  be renamed according to the rules. See Renaming 
Attachments and PDF Files.

▪

If a PDF file name exceeds the 50 character limit, then EndNote truncates the file name during the 
renaming process.

▪

Unicode characters are accepted during the renaming process.▪

If you select Author-Year-Title renaming, and the PDF document does not have a year, EndNote 
inserts a hyphen (-) between the author name and the title to replace the missing year data.

▪

EndNote renames all PDF documents that you import via the Import File and Import Folders commands 
based on your current renaming preferences.

For example, if you define renaming as Author+Title, then EndNote renames the PDF by author name and 
title and ignores the date of the published work.

This rule also applies to Custom preference settings.

Use these settings to apply Read or Unread status tags to your references in order to track your research.

To access these settings, go to the Edit menu, select Preferences, and then click Read/Unread in the list of 
preferences.

The options are Mark a References as Read Upon—

Viewing it in the Reference, PDF, or Preview within the Library window. 
 
By default, EndNote changes the status of a reference from Unread to Read after you view a 
reference in the Reference Edit or Preview panels, or open the PDF for viewing in a separate PDF 
window (see The PDF Panel). 
 
If you clear the checkbox, the status of an Unread reference remains the same after you view a 
reference in the Reference Edit or Preview panels, or in a separate window.

▪

Changing its rating. 
 
If you select this checkbox, EndNote changes the status of a reference from Unread to Read after 
you change the Rating of the reference from the Reference List. 
 
If you clear the checkbox, the status of an Unread reference remains the same after you change the 
Rating of the reference.

▪
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Library Window Option

Read/Unread Features

Reference Types Preferences

Default Reference Type

Defining Reference Types

Clear the Show unread references in bold text checkbox  to view all your references in normal text. The 
default value shows all unread references in bold text.

All new references are marked as Unread by default.▪

Each reference has either a Read or an Unread status. If the Read/Unread field  is shown in the 
Reference List, clicking the Unread  button changes the status to Read. Clicking the Read  button 
changes the status to Unread.

▪

If the Read/Unread field is not shown in the Reference List, you can change the status by right- 
clicking on a reference, or set of references, and selecting the new status from the drop-down list.

▪

EndNote automatically saves the status of a reference whenever you change the status from Read 
to Unread or vice-versa.

▪

A reference changes to an Read status if you edit a field in the Reference Edit panel.▪

In the Reference List, by default the text of a reference with an Unread status appears in bold. The 
text of a reference with a Read status appears in normal font. This can be changed using the Library 
Window option as described above.

▪

Use the Reference Types preferences panel to customize your settings for the fields (such as Author, Year, 
and Title) and reference types (such as Journal Article or Book) that are used by EndNote. Any changes that 
you make in this panel apply to all of the libraries that open on the computer for your user account.

To access these settings, go to the Edit menu, select Preferences, and then click Reference Types in the list 
of preferences.

When you create a new reference in your EndNote library (by selecting New from the References menu), 
the new reference is set up for a journal article by default. If you would rather have new references 
automatically appear as books, patents, or some other reference type, change the Default Reference 
Type setting:

Click the Default Reference Type list and choose from one of the available reference types.▪

If you need a reference type that is not in the list, you will need to create a reference type for it and define it 
yourself (see Customizing Reference Types).

If you need to modify any of EndNote’s fields or reference types, click the Modify Reference Types button. 
This opens the EndNote Reference Types preference where you can add, delete, and rename EndNote’s 
reference types and fields.
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Reference Type Table

Sorting Preferences

Author Field

Title Field

See Customizing Reference Types for more information about reference types and how to customize them.

You can use the Export and Import buttons to share a customized reference type table with another 
EndNote user. See Backing Up or Sharing Your Reference Types Table for step-by-step instructions.

Note: Replacing another user's RefTypeTable.xml file overwrites all changes to his/her current Reference 
Types table.

When EndNote sorts author names and titles, you can identify which words or names to ignore for sorting 
purposes.

To access these settings, go to the Edit  menu, select Preferences, and then click Sorting  in the list of 
preferences.

To add a word to be ignored by sorting, enter the term in the text box below either the Author Field or 
the Title Field and click Add.

▪

To remove a word from either list, select the term and click Remove.▪

Click EndNote Defaults to revert both lists to the default settings.

The Author Field list is designed so that you may enter parts of author names that may be omitted for 
sorting purposes. For example, prepositions in names such as "von," "van," and "de" can be included as 
part of the last name, but not considered part of the name for sorting purposes. The entries in the Author 
Field list are case sensitive; that is, if you enter "von" it applies only to "von" and not "Von."

These settings apply to the Generic fields for Author, Secondary Author, Tertiary Author, Subsidiary Author, 
and Translated Author. No names are entered by default.

When terms are added to the Title Field list, the sorting routine ignores them when they appear at the start 
of the title. Capitalization does not matter for these words. That is, the word "the" can be entered 
(lowercase) and still apply to "The."

These settings apply to the Generic fields for Title, Secondary Title (includes the Journal field), Tertiary Title, 
Short Title, and Alternate Title. The words "a," "an," and "the" are entered as defaults.

Note: When you close the Preference panel and return to your library list, you must manually sort your 
references to build a new sort that uses your revised list.
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 Where is this information saved?

Spell Check Preferences

General Options

Modifying Dictionaries

The lists of terms entered into the Sorting preferences panel are stored in the  C:\Users\[Your Folder] 
\AppData\Roaming\EndNote\ENSort.txt file. To duplicate the lists for another computer running EndNote, 
copy this file to the same location on the other computer. For another user account on the same machine, 
copy the file to the other user’s matching EndNote folder.

See also Sorting the Library and Special Cases in Sorting.

On the Spell Check preferences panel, you can set general spell check options and select or modify 
Dictionaries. For general information about how to start spell checking a record, see Spell Check.

To access these settings, go to the Edit menu, select Preferences, and then select Spell Check in the list of 
preferences.

Note:  If you are unable to add dictionaries, or to add words to or edit dictionaries, it is probably because 
your Windows security settings are preventing you from making changes in the \\Program Files (x86) 
folder. The best option is to copy the C:\Program Files (x86)\EndNote 20\Spell folder and all its contents 
to another location, then load the dictionary files from that location. This should allow you to make 
changes to the files or create your own dictionary files.

You can access these Spell Check Options from the EndNote Preferences Spell Check panel or from the 
dialog that appears when you run Spell Check.

Click the Options button.1.

Select the checkbox next to each item you want to apply during spell checking.2.

Select a Main Dictionary language from the list of available dictionaries.3.

For each language, EndNote uses a combination of dictionary files located in EndNote’s Spell folder. 
Select your primary language. If you want to apply additional language dictionaries, see Adding an 
Existing Dictionary below.

4.

Decide how fast and accurate you want spell checking to work. We suggest setting the option to at 
least Moderately fast and accurate.

5.

Click OK to save the changes.6.

You can access the Dictionaries preferences from the EndNote Preferences Spell Check panel or from the 
dialog that appears when you run Spell Check.

Click the Dictionaries button.1.
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Adding an Existing Dictionary

Importing/Exporting a Dictionary

Dictionaries Supplied with EndNote

Use this dialog to view or edit the content of existing dictionaries, to add existing dictionaries for use, 
to create new dictionaries, and to remove dictionaries. The dictionaries listed under Files are 
currently in use (in addition to the Main Dictionary selected under Options).

2.

To modify dictionaries:3.

Under Files, select the dictionary file you want to view or modify.4.

If it is already in the list, select it.5.

If you need to locate an existing file to use, use the Add File  button to locate the file on your 
computer and add it to the list. By default, dictionaries are kept in EndNote’s Spell folder.

6.

To create a new dictionary, click New File.7.

To remove a dictionary, display the file name in the list and click Remove File. This removes a 
dictionary from use, but does not delete the actual disk file.

8.

The words in the selected dictionary appear in the top list.9.

To add a word to the selected dictionary, type it under Words and click Add Word.10.

To delete a word from the selected dictionary, select the word and click Delete Word.11.

To change the Action applied to a word, select the word and then pick the new Action from the list.12.

You may have selected English (or a different language) as your Main Dictionary Language, but want to 
apply an additional language during spell checking.

On the Dictionaries dialog, click the Add File button.1.

In EndNote’s Spell folder, locate the dictionary file you want to use and Open  it. The dictionary is 
added to the list under Files.

2.

The Dictionaries dialog includes Import and Export buttons.

Use Import to locate and import a plain text file  of terms into the current dictionary. The text file should 
contain a list of terms, with each term on its own line. If you are typing the list into a text file, make sure each 
term is followed by a carriage return, including the last term in the list. If you are creating the list in a word 
processor, make sure to use Save As to save the file as plain text. If your terms contain extended 
characters, save with the Unicode (UTF-8) encoding option.

Use Export to save all terms from a dictionary to a plain text file, where each term starts on a new line.

These dictionaries are supplied with EndNote. When you select the main dictionary language, a combination 
of files are loaded, including files not listed here.
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Dictionary List

User Dictionary: Contains English words accent.tlx
User Dictionary: Contains common English misspellings and their 
correct replacements for auto correction correct.tlx

User Dictionary: Sample user dictionary userdic.tlx
American English ssceam.tlx
American English Medical sscema.tlx
British English sscebr.tlx
British English Medical sscemb.tlx
Danish ssceda.tlx
Dutch sscedu.tlx
Finnish sscefi.tlx
French (European and Canadian) sscefr.tlx
German sscege.tlx
Italian ssceit.tlx
Norwegian (Bokmal) sscenb.tlx
Portuguese (Brazilian) sscepb.tlx
Portuguese (Iberian) sscepo.tlx
Spanish sscesp.tlx
Swedish sscesw.tlx

Spell Check Dictionaries Dialog

When you want to add additional languages, find the Dictionary you want to use from the left column, then 
look for the corresponding File Name. When you Add a dictionary, look for the appropriate File Name in 
EndNote’s Spell folder.

The Dictionaries Dialog allows you to open and close user dictionaries, and to edit the contents of an open 
user dictionary. The contents of dictionaries are saved in disk files. You can open some or all of your user 
dictionary files at any time. Only open dictionaries are checked during a spell-checking operation.

Note:  If you are unable to add dictionaries, or to add words to or edit dictionaries, it is probably because 
your Windows security settings are preventing you from making changes in the \\Program Files (x86) 
folder. The best option is to copy the C:\Program Files (x86)\EndNote 20\Spell folder and all its contents 
to another location, then load the dictionary files from that location. This should allow you to make 
changes to the files or create your own dictionary files.

Action list: Used to select an action which is associated with words in the dictionary. The action tells 
the spelling checker what to do when it finds a word in the dictionary. The following actions can be 
selected:

▪

Auto change (use case of other word):  This action allows you to automatically replace one 
word with another, always with the same case pattern as the other word. This action is useful for 
automatically expanding abbreviations. For example, you could select the  word "TBD" in  the 
Words list, or type it in the Words text field, then type "to be determined" in the Other word field, 

▪
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and select Auto change (use case of other word)  as the action. The spelling checker will 
automatically replace "TBD" with "to be determined."

Auto change (use case of checked word): This action allows you to automatically replace one 
word with another. For example, if you often type "recieve" instead of "receive" you might select 
the word "recieve" in the Words list, or type it in the Words text field, and then type "receive" in 
the Other word  field, and select Auto change (use case of checked word) as  the action. The 
spelling checker will automatically correct "recieve" wherever it appears. If "recieve" was 
capitalized ("Recieve") the spelling checker would automatically replace it with "Receive." Note 
that the replacement is made automatically only if the Auto Change option  is enabled (see the 
Options Dialog for information on the Auto Change option).

▪

Conditionally change (use case of other word):  This action allows you to optionally replace 
one word with another, always with the same case pattern as shown in the Other word field. This 
action is useful for optionally expanding abbreviations. For example, you could select the word 
"TBD" in the Words list, or type it in the Words text field, and then type "to be determined" in the 
Other word field,  and set Conditionally change (use case of other word)  as the action. The 
spelling checker will ask if you want to replace " TBD" with "to be determined."

▪

Conditionally change (use case of checked word):  This action allows you to optionally 
replace one word with another. For example, if you often type "recieve" instead of "receive" you 
might select the word "recieve" in the Words list, or type it in the Words text field, and then type 
"receive" in the Other word field, and select Conditionally change (use case of checked word) as 
the Action. The spelling checker will ask if you want to replace "recieve" with "receive." If you 
chose to replace it, and "recieve" was capitalized ("Recieve") the spelling checker would replace 
it with "Receive."

▪

Ignore (skip): This action tells the spelling checker that the word is spelled correctly, and so can 
be skipped over. This is the most common action.

▪

Exclude (treat as misspelled): This action tells the spelling checker that the word is misspelled, 
even if it is listed in another dictionary. Words marked with this action will never be offered as 
suggestions for misspelled words, and they will be reported as misspellings when they are 
encountered by the spelling checker. Note that the spelling checker looks up words in user 
dictionaries in the order in which they appear in the Files list. If you want to exclude a word, 
make sure it doesn't appear in a previous user dictionary.

▪

Add File button: Opens a user dictionary file. When you select the Add File button, a dialog appears 
which you can use to select the dictionary file to open. The set of open dictionary files is 
remembered, so once you add a dictionary file you do not need to add it again. If you need to create 
a new user dictionary, use the New button. You can open other applications' user dictionary files, if 
they use a compatible file type. See Dictionaries Supplied with EndNote  for a list of dictionaries 
supplied with EndNote.

▪

Add Word button: Causes the word selected in the Words list to be added to the currently selected 
dictionary. The currently selected Action and Other word are associated with the word. You can use 
the Add Word button to change the action or other word associated with a word. Note that the Add 
Word button is enabled only when a new word is typed in the Words text field. The words you add 
may contain virtually any character, but only words which contain embedded periods should have 
trailing periods (for example, "U.S.A." is OK, but "USA." is not).

▪

Close button: Closes the Dictionaries dialog.▪

Delete Word button:  Causes the word appearing in the Words  text field to be removed from the 
currently selected dictionary. The associated action and other word are also removed.

▪
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Spell Check Options Dialog

Export button: Saves the contents of the currently selected dictionary to a text file. When you select 
the Export  button, a dialog appears which you can use to select the name of the text file to which 
words in the dictionary will be exported. The words are written to the file one per line.

▪

Files list: Contains the list of open dictionary files. When you select a file from the list, its contents 
are displayed in the Words list.

▪

Import button: Adds the words contained within a text file to the currently selected dictionary. When 
you select the Import button, a dialog appears which you can use to select the text file to be 
imported. Each word in the selected file is loaded into the dictionary.

▪

Language:  Displays the language (for example, English or French) of the words in the currently 
selected dictionary.

▪

New File button:  Creates a new user dictionary file. When you select the New  button, a dialog 
appears which you can use to specify attributes of the new dictionary. See the New Dictionary Dialog 
dialog for details.

▪

Other Word text box: Contains an alternate word associated with the currently selected word. The 
other word is used in the Auto change and Conditionally change actions  to supply a replacement 
word. You can enter more than one word in the Other word box, but the total length should be limited 
to 63 characters.

▪

Remove File button:  Closes the currently selected dictionary file. Closed dictionaries are not 
checked during a spelling check. Although the file is closed, it is not deleted. Closed dictionary files 
can be later reopened using the Add File button.

▪

Words list: Contains the list of words in the currently selected user dictionary.▪

You can use the Options Dialog to specify various spelling-checker options. These options affect the way 
the spelling checker operates.

Ignore capitalized words: When enabled, any words beginning with a capital letter are ignored 
(they are skipped over without being checked). You might enable this option if the text being checked 
contains many proper names.

▪

Ignore all-caps words: When enabled, any words containing all capital letters are ignored (they are 
skipped without being checked). You might enable this option if the text being checked contains 
many acronyms.

▪

Ignore words with numbers: When enabled, any words containing embedded digits are ignored 
(they are skipped without being checked). Examples of such words include "Win2000" and "Q4." You 
might enable this option if the text being checked contains many code-words or other symbols 
containing digits.

▪

Ignore words with mixed case: When enabled, any words containing an unusual mixture of upper- 
and lower-case letters are ignored (they are skipped without being checked). Examples of such 
words include "MicroHouse" and "CapsLock." You might enable this option if the text being checked 
contains many variable names or other symbols which use case changes to distinguish words.

▪

Ignore domain names: When enabled, text strings that end with a domain extension, such as 
".com," ".org," or ".edu" are ignored (they are skipped over without being checked).

▪
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Sync Preferences

Report doubled words: When enabled, any word appearing twice in a row is reported via the 
Check-Spelling Dialog.

▪

Case sensitive: When enabled, a distinction is made between capitalized and noncapitalized words. 
For example, "canada" is considered different from "Canada," so "canada" would be reported as a 
misspelling. When the option is disabled, "canada" and "Canada" are considered identical. Note that 
the performance of the spelling checker will be reduced if this option is disabled.

▪

Phonetic suggestions: When enabled, suggestions are made on the basis of phonetic (sounds-like) 
similarity to the misspelled word. This option tends to improve suggestions for badly misspelled 
words. Enabling this option will increase the time required to locate suggestions. Note that either this 
option or the Typographical Suggestions option must be enabled or no suggestions will be offered.

▪

Typographical suggestions: When enabled, suggestions are made on the basis of typographical 
(looks-like) similarity to the misspelled word. This option is appropriate for people who are generally 
good spellers. Note that either this option or the Phonetic Suggestions option must be enabled or no 
suggestions will be offered.

▪

Suggest split words: When enabled, two separate words will be suggested as a replacement for a 
misspelling containing two joined words. For example, "is the" would be suggested as a replacement 
for "isthe" in a record.

▪

Auto correct: When enabled, words marked with Auto Change actions  will automatically be 
changed to their specified replacements. When disabled, you will be prompted before the words are 
changed.

▪

Main Dictionary language: Select the primary language. This affects which dictionaries are loaded 
for spell checking.

▪

Suggestions: Determines the speed and accuracy of the initial search for suggested replacements 
for misspelled words. When a misspelled word is detected, a search is automatically made for 
suggestions. This option controls the speed and accuracy of this automatic search. Pressing the 
Suggest button in the Check-Spelling dialog causes an increasingly more accurate (but slower) 
search for suggestions. Options include:

▪

Fast but less accurate: Fast, but misspelled words may be missed.▪

Moderately fast and accurate: Less fast, but more likely to find misspelled words.▪

Slow but accurate: Slower, but with the best chance of finding misspelled words.▪

OK: Closes the Options Dialog, and saves any changes made to the option settings.▪

Cancel: Closes the Options Dialog, and discards any changes made to the option settings.▪

To access these settings, go to the Edit  menu, select Preferences, and then click Sync  in the list of 
preferences.

This dialog saves subscription credentials and sync settings to automate the process of synchronizing your 
EndNote library with your EndNote online library.

Sync Preferences allow you to set your preferences so that:
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Enable Sync Button

I Already Have an EndNote Online Account

I Do Not Have an EndNote Online Account

You only have to enter your e-mail address and password once in Sync Preferences and not each 
time you manually synchronize your references between EndNote desktop and EndNote online.

▪

You can have EndNote automatically begin the Sync process every 15 minutes (background 
processing) by selecting the Sync Automatically checkbox.

▪

You must first register and have an active EndNote online account to initiate the Sync process. Registration 
is fast and easy and activates your two-year EndNote online account enhancement. When completed, 
EndNote automatically proceeds with the Sync process and updates your new EndNote online library to 
match the groups in your EndNote library.

To access Sync Preferences, go to the Edit  menu, select Preferences, and then click Sync  in the list of 
preferences.

Your purchase of EndNote entitles you to a two-year free subscription to EndNote online—our online version 
of EndNote.

If you have not previously set up EndNote Sync, open the library you want to sync and follow the 
instructions below. You can only sync one EndNote library and it must be the active library when you begin 
the sync process.

Click the Enable Sync button to go to an EndNote online login dialog.1.

Enter your e-mail address.2.

Enter your EndNote online password.3.

Press OK.4.

Since you already have an EndNote online account, EndNote populates the fields on the Sync Preferences 
page with the e-mail address and password that you entered on the EndNote login dialog. Later you can 
change the data in these fields if you ever change your e-mail address or password.

If you do not have an EndNote online account, then you must create one. Registration is fast and easy and 
activates your two-year EndNote online account when completed.

Click the Enable Sync button to go to an EndNote login dialog.1.

Click the Sign Up button to go to an EndNote Registration dialog.2.

Enter your email address in the EndNote Registration dialog. Retype your email address, and then 
click the Submit button.

3.

Enter your name and a secure password, read the EndNote End User License Agreement, then click 
the Agree button if you wish to create your account.

4.

Click the Sync button to begin synchronizing your EndNote online library with your EndNote library.5.
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EndNote Online Account Credentials Panel

Sync This EndNote Library Panel

Sync Automatically Check Box

Before synchronizing for the first time, you will be prompted to create a compressed library backup. 
Click the Yes button to create the backup.

6.

Choose the location for your backup, then click the Save button.7.

Once you create your EndNote online account, EndNote 20 populates the fields on the Sync Preferences 
page with the e-mail address and password that you entered during registration. Later you can change the 
data in these fields if you ever change your e-mail address or password.

Note: We recommend that you create a compressed library backup the first time that you initiate the Sync 
process. See Saving a Compressed Copy of a Library for more information.

See The Sync Feature for information on how to initiate the Sync process from the Library.

Once you register and activate your EndNote online account, you can edit the fields in the EndNote Account 
Credentials panel.

Enter your e-mail address. EndNote uses your e-mail address to verify your identification.▪

Enter your EndNote online password.▪

EndNote uses these credentials to access your EndNote online library. Once you save this information, you 
will not have to enter it again. EndNote saves the information until the next time you access Sync 
Preferences and decide to make changes.

Note: If you need to change the e-mail address or password for your EndNote online account, sign in to 
your account using your browser and select the Options tab to access the Password and E-mail Address 
options. These cannot be changed in EndNote desktop. After changing them online, update the 
credentials in EndNote 20 to match.

This field contains the name of the EndNote desktop library that you have synchronized with your EndNote 
online library. You cannot edit this field.

If this field is blank when you first access Sync Preferences, EndNote will populate the field with the path 
and file name of the currently opened EndNote library after you run Sync.

Notes: You can always change the name of the library in this field by opening another library from the 
EndNote window. Click the Sync Now button in the Sync Status window to complete the process. The two 
libraries will be merged and the name of the opened library will appear in this field. See Merging Libraries 
through Sync. 
 
This field is not active until you register and create an EndNote online account.

The Sync process works automatically in the background (every 15 minutes) when you select this checkbox.
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EndNote Defaults and Revert Panels

Temporary Citations Preferences

Temporary Citation Delimiters

Record Number Marker

When you close EndNote, the system prompts you to Sync your EndNote desktop library with your EndNote 
online library.

See EndNote Preferences for a description of the EndNote Defaults and Revert Panel buttons.

To access these settings, go to the Edit menu, select Preferences, and then click Temporary Citations in the 
list of preferences.

A "temporary citation" is an unformatted citation that EndNote inserts into your word processing document 
when you use the Insert Citation(s) command from Word, OpenOffice, or LibreOffice, or when you copy and 
paste a citation into a document. You can also type temporary citations into your document. The temporary 
citation is a placeholder that EndNote later changes to a formatted citation, such as (Smith Jones, 2015).

By default  a temporary citation includes the first author’s  last name, the year, and the EndNote record 
number, enclosed in curly braces:

{Smith, 2015 #24}

If necessary, you can change the temporary citation delimiters, and can set a field  other than Record 
Number, to be used in temporary citations in this preference panel.

Curly braces are the delimiters used by default to indicate the start and end of each temporary citation. If 
you commonly use curly braces in your writing, you might want to select a different pair of markers for 
EndNote to use as Temporary Citation Delimiters.

Enter the desired markers into the appropriate boxes at the top of the Temporary Citations preferences 
panel.

Note: Be sure to use characters that are not likely to appear in the text of your document. For example, 
do not use left and right parentheses characters because these are frequently used in writing, and any 
text in them would be considered a temporary citation by EndNote.

The number sign (#) always precedes the record number in an EndNote temporary citation. You may 
change this by entering another character in the Record Number Marker box.

The EndNote record number is a unique number assigned to each reference as it is added to a library. The 
number is specific to that reference in that particular library. If you are using the same library on multiple 
computers through EndNote Sync, or collaborating with other writers who are sharing their libraries through 
EndNote Sync, you might find it easier to replace the Record Number in the temporary citation with 
something that uniquely identifies the reference but is not specific to a single EndNote  library on a single 
computer. To do so, select the Use field instead of record number option and select from the Label field, the 
Accession Number field, or the Pages field.
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Citation Prefix Marker

Including Notes in the List of References

The Label field can be used to manually enter any unique code that you would like to use for each 
record.

▪

The Accession Number field is designed to contain the unique record number assigned to a 
reference from an online database.

▪

The Pages field can contain a unique page number or another unique number for each record.▪

Notes: If you have selected the Label, Accession Number, or Pages field, and that field is empty in a 
particular reference, the Record Number will appear in the temporary citation. 
 
EndNote record numbers are unique to a library but are not permanent identifiers. They can change 
through syncing, copying a reference from one library to another, or even cutting the reference from a 
library and pasting it back into the same library. See Record Numbers for more information.

The Citation Prefix Marker separates prefix text in a citation from the citation itself. For example, if you 
wanted a citation formatted as:

(see also Smith, 2015)

you would enter the text into the temporary citation as follows, with the "\" indicating the end of the prefix text 
and the start of the citation:

{see also \Smith, 2015 #24}

If you prefer to use a different character as the Citation Prefix Delimiter, you may enter it in this preferences 
panel. Semicolons (;), letters, numbers, and characters already used as other delimiters may not be used for 
the Citation Prefix Delimiter.

Note: When you use Cite While You Write’s Edit & Manage Citation(s) command to add prefix text, the 
Citation Prefix Marker is automatically inserted as part of the temporary citation.

Some journal styles permit you to include notes with the list of works cited at the end of the document. In 
such a system, the notes are numbered just like the citations, and included in the reference list, just like the 
references. This feature is only available with numbered in-text citation styles.

To identify text to be included as a numbered note in the reference list:

Type the text into the body of your document where you would want the number for the note to 
appear (or use the Insert Note command in Word, see Including Notes in the List of References in 
Microsoft Word).

1.

Be sure to surround the entire section of text with your Temporary Citation Delimiters (curly braces 
by default), and begin it with "NOTE:". For example:

2.

{NOTE: The authors would like to acknowledge the support of...}

When the paper is formatted by EndNote using a numbered style, the text is assigned a number and listed 
along with the references at the end of the paper.
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Restrictions on the Use of the "NOTE" Feature

Term Lists Preferences

Suggest Terms as You Type (Auto-Completion)

Update Lists When Importing or Pasting References

The way that these notes are identified may be changed in the Temporary Citations preferences. Enter a 
prefix that you would like to use to signal that the text should be treated as a note.

This feature requires that a numbered style be used for the formatting; otherwise, the note will be left 
as it was entered in the body of the text.

▪

Enter text only. Do not attempt to insert graphics, equations, or symbols as note text.▪

Do not use the temporary citation delimiters as part of the text of the note. Other markers, such as 
the record number marker and the prefix marker and the multiple citation separator may be used.

▪

These types of notes cannot be combined with regular temporary citations within the same set of 
brackets. They should be cited separately—each in its own set of brackets.

▪

To access these settings, go to the Edit  menu, select Preferences, and click on Term Lists  in the list of 
preferences.

By default, every new EndNote library  has three term lists associated with it: Authors, Journals, and 
Keywords. The term lists are automatically updated as you enter references into your library. The terms in 
these lists are also used to facilitate data entry using the Suggest Terms as You Type feature. This feature 
suggests terms as you type into fields with term lists linked to them. For example, as you type into the 
Author field, EndNote suggests author names from your Authors term list to help you with data entry. When 
you enter a new term that is not currently in the associated term list, it appears in red text to indicate that it is 
a new term. This can point out typing mistakes or the use of an incorrect keyword if you thought you were 
entering a name or a term commonly used in your library.

Any of the term list settings described above can be turned off using the settings for the Term Lists 
preferences.

When selected, EndNote will automatically complete matching terms when you are typing into a field that is 
linked to a term list (see Inserting Terms into References).

If you turn this feature off, you may still insert terms into a field by opening the desired term list from the 
Library > Open Term List menu and double-clicking the desired term, or by pressing Ctrl+1 to open the term 
list associated with the field you are working in.

Note: When using auto-completion with Author fields, enter the author's last name first, followed by a 
comma, to get the quickest match.

When this option is selected, the term lists are automatically updated as you import references (using the 
Import  command from the File  menu), Direct Export, drag-and-drop references, or paste references in to 
your library. If you turn this option off, you can always manually update your term lists by selecting Define 
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Update Lists During Data Entry

URLs & Links Preferences

Connection Log File

ISI Base URL

OpenURL Arguments

Term Lists… from the Library menu, highlighting a term list, and clicking Update List (see Manually Updating 
Term Lists).

When this option is selected, the term lists are automatically updated as you type in new reference data. If 
you turn this option off, you can always manually update your term lists by selecting Define Term Lists… 
from the Library menu, highlighting a term list, and clicking Update List (see Manually Updating Term Lists).

To access these settings, go to the Edit menu, select Preferences, and click on URLs & Links in the list of 
preferences.

When you use the Online Search command to connect to an online database, EndNote keeps a copy of all 
of the retrieved references for that session in the connection log file (the file name is "Connect.log"). This 
happens by default, but you may turn this option off by clearing the Use Log File option.

We recommend keeping the option turned on because in the event that the references were not correctly 
retrieved or filtered into EndNote, you can always adjust the filter  in the connection file, and import the 
Connect.log file instead of redoing the search and download (see Importing a Log File).

By default, the Connect.log file is stored in the folder: C:\Users\[User Name]\App Data\Roaming\EndNote

You may change the name and the location of the Connect.log file by clicking the Choose  button. In the 
dialog that appears, enter a new name for the file (if desired), and select the new location for the file.

When you export references from the Web of Science™ Core Collection to EndNote, EndNote creates a Go 
to ISI link in the URL field of each reference. These links take you back to the source record where you can 
find related references, times cited, and other information. If you have upgraded from an earlier version of 
EndNote, you may need to click EndNote Defaults to update the ISI Base URL to the latest setting

The URL > OpenURL Link command on the References menu starts your default web browser and displays 
the full text article (if available) plus a list of links to similar articles. It connects to an OpenURL standard 
syntax server and uses these OpenURL preferences along with data in your EndNote record to find related 
online references.

Note: This command has no relation to the URL field found in EndNote references or the URL > Open 
Link command on the References menu (which opens the specific URL found in the URL field).

We include a default argument to search for related online records. You can use this argument as a syntax 
example if you wish to enter your own arguments here.
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Attached Files

Cite While You Write Preferences for Microsoft 
Word

Note: We  suggest checking with your institutional library  before changing these settings, as different 
institutions may have custom settings. Remember, you can revert back to the EndNote defaults at any 
time by clicking EndNote Defaults.

When you attach files to EndNote references, you have two options available to you. You can:

Insert the file as a relative link. 
 
In this case, EndNote makes a copy of the original file and places it in the .Data\PDF folder that is 
part of your EndNote library. EndNote will always be able to access the file, even when you share 
your library with a colleague. However, if you edit the original file on your computer, those changes 
will not be reflected in EndNote. You would need to make changes in your EndNote library's copy, 
or clear the file from your EndNote reference and reinsert the file.

▪

Insert the file with an absolute path. 
 
In this case, EndNote will always look in the original folder for the inserted file. This allows you to 
easily access the file from outside of EndNote. However, if you ever move the file from the original 
folder, EndNote will not be able to access it unless you clear the file from your EndNote reference 
and reinsert it from the new folder location. If you send your library to a colleague, share the library 
through EndNote Sync, or use EndNote Sync to access your library on multiple computers, the file 
will not be available.

▪

By default, the checkbox titled Copy new file attachments to the default file attachment folder and create a 
relative link is selected, so that EndNote will copy linked files to the .Data\PDF folder. You can deselect this 
box in order to save absolute paths. You can always override this default setting on the file dialog when you 
are inserting a file.

Find Full Text always saves files to the default attachment folder and creates relative links.

See Selecting a Relative Path or an Absolute Path for File Attachments  for more information on relative 
versus absolute links.

You can access the Cite While You Write preferences in two ways:

In Word, select Preferences from the EndNote 20 tab.▪

In EndNote, select Cite While You Write  [CWYW] > CWYW Preferences from the Tools menu.▪

Note: Your word processor must be open in order to access CWYW Preferences from the Tools menu in 
EndNote.

See also:

Application Preferences in Microsoft Word▪

Page 518 of 586

 



Clarivate EndNote 20 User Help Guide

General Preferences in Microsoft Word

Keyboard Preferences in Microsoft Word

EndNote Preferences▪

Figures and Tables Preferences in Microsoft Word▪

General Preferences in Microsoft Word▪

Keyboard Preferences in Microsoft Word▪

Related EndNote Preferences▪

Showing Word Processor Codes▪

General preferences are useful when you always use your EndNote library along with your word processor 
and you always use your word processor along with your EndNote library.

To access General preferences, select Preferences on the EndNote 20 tab in Word.

Open EndNote When Starting Word: Select this item to always open EndNote when you start 
Microsoft Word.

▪

Close EndNote When Leaving Word: Select this item to always close EndNote when you leave 
Microsoft Word. This works only when the EndNote program was launched with one of the Cite 
While You Write commands from within Word or if the Open EndNote When Starting Word 
preference is selected.

▪

Return to Document After Inserting Citations: Select this item to always make your document the 
active window after inserting citations with EndNote’s  Insert Selected Citation(s) command. If this 
preference is turned off so that the Word document remains in the background, you will not see the 
inserted citation in the Word document until the document becomes the active window. This is 
because the display for the Word document is not updated in the background.

▪

Enable Instant Formatting on new Word documents:  This option is available for Cite While You 
Write. It turns Instant Formatting on or off for new Word documents. When you enable Instant 
Formatting, you can also determine how often EndNote scans for temporary citations and whether it 
checks for citation changes.

▪

To turn instant formatting on or off in an existing Word document, see Instant Formatting in Microsoft 
Word.

▪

Turn off Word’s "Show field codes instead of their values option" when opening or updating 
documents that include citations: EndNote uses extensive Word field codes in order to identify 
and format citations. When field codes are displayed, your document can look confusing! See Field 
Codes in Microsoft Word for more information and an example. 
 
We recommend that you not view field codes in Word. This option ensures that you will see 
appropriate text in your document.

▪

Keyboard shortcuts for EndNote’s Cite While You Write commands are available in Word.

To add or change a keyboard shortcut:
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Figures and Tables Preferences in Microsoft Word

Application Preferences in Microsoft Word

In Word, select Preferences on the EndNote 20 tab.1.

Click the Keyboard tab.2.

From the list of commands, select the command for which you would like to add (or change) a 
shortcut.

3.

Under Press new shortcut key, enter the new shortcut key combination on the keyboard.4.

Keyboard shortcuts work in both EndNote and Microsoft Word.▪

If you enter a key command that is already assigned to another Word or Cite While You 
Write command, EndNote will note which command it is currently assigned to.

▪

Click Assign to assign the new shortcut.5.

Follow the same steps to remove an assigned shortcut key, except click Remove instead of Assign.

Click Reset All to remove custom key assignments.

See CWYW Keyboard Commands for Word for a list of the default keyboard shortcuts.

Use settings in the output style  to determine whether images are placed in-text or at the end of the 
document, where captions and labels are located, and separation and punctuation around images and 
captions. See Figures and Tables.

The figures and tables settings in the EndNote preferences in Microsoft Word override settings from the 
current output style. If your output style is set to print figures and tables in a list at the end of the document, 
the settings on this tab are ignored. However, if your output style is set to print figures and tables in-text, you 
can use this tab to override settings when you have moved figures around in your document and want to 
retain their placement.

To customize the in-text placement of EndNote figures and tables in Word.

On the EndNote 20 tab, select Preferences.1.

Select the Figures and Tables tab.2.

Select the appropriate radio button to:3.

Place each figure or table directly after the paragraph where it is first referenced, or▪

When regenerating figures, keep each figure or table in its current position. This allows you to 
move images around in your document and have them stay there when you Update Citations 
and Bibliography again.

▪

Use the Application tab in the Word Cite While You Write preferences to indicate which version of EndNote 
to use when you use Cite While You Write.

EndNote 20 is your desktop version of the EndNote application.▪

Page 520 of 586

 



Clarivate EndNote 20 User Help Guide

Showing Word Processor Codes

Microsoft Word’s Field Shading

EndNote is the online version of EndNote.▪

To select the appropriate application:

On the EndNote or EndNote 20 tab in Word, select Preferences.1.

Click the Application tab.2.

Select the appropriate application: EndNote (desktop) or EndNote online.3.

The system adds an EndNote 20 tab to Word's Tabs when you select the EndNote menu option; the system 
adds an EndNote tab when you select the EndNote online menu option.

Note: Even though selecting EndNote online will show the EndNote tab, to actually use the EndNote 
online option, you must have created an EndNote online account.

The formatted citations and bibliography in your document are not plain text; they contain hidden data that 
make it possible for EndNote to unformat and reformat citations and bibliographies.

Formatted citations and bibliographies in Word documents are Microsoft Word fields. This gives EndNote 
the ability to uniquely identify them.

When you click on a field in Word (such as a formatted EndNote citation or the bibliography), it becomes 
shaded. You can change this behavior so that the fields are always shaded, shaded only when selected, or 
never shaded. To do so:

In Word, select Options from the File menu.1.

Click the Advanced button and scroll down to the Show Document Content section.2.

From the drop-down Field shading menu, select your preferred option. These include:3.

Never: This option will always show field codes as though they were plain text, with no shading.▪

Always: This option will always shade field codes, making it easy to see them. This can be very 
helpful when troubleshooting a document because corrupted EndNote citations cannot be 
unformatted. If you think you have corrupted citations in your paper, make a copy of  the 
document (never do this to the original), then in the copy  unformat the citations and set the 
Field Codes preference to always show shading. When you scan through your document, you 
will easily spot any EndNote citations that did not unformat, indicating corruption of the code. 
You can then go back to the original document to delete those citations and reinsert them from 
EndNote.

▪

When Selected: This is the default setting. It will show shading only when you click on (select) 
a field code, such as an EndNote citation.

▪
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Related EndNote Preferences

General Preferences for OpenOffice Writer

Open EndNote When Starting OpenOffice Writer

Close EndNote When Leaving OpenOffice Writer

Shortcuts to Make Using EndNote Easier

Note: Field shading never prints; it only shows on the screen to help you locate field codes in your 
document. The Word settings of the person viewing the document control the shading, not the 
document creator. If you send your document to someone and they complain about the shading, 
they will need to adjust their Word options. You can send them these instructions to help them with 
that.

Click OK to close the preferences window and save your changes.4.

Note: If you are seeing detailed field code information, see Field Codes in Microsoft Word and General 
Preferences in Microsoft Word for information on showing and hiding field codes.

Several other EndNote preferences directly affect Cite While You Write. To access EndNote preferences, go 
to the Edit menu in EndNote and select Preferences.

See these topics for information on changing the related preferences:

Temporary Citations Preferences▪

Formatting Preferences▪

These settings are stored with the EndNote program’s preferences because they apply to formatting papers 
with Cite While You Write for Microsoft Word, Cite While You Write for OpenOffice Writer, and Format Paper 
for RTF files.

General preferences are useful when you always use your EndNote library along with your word processor, 
and you always use your word processor along with your EndNote library.

To access General preferences in OpenOffice Writer, go to the EndNote  menu and select Cite While You 
Write Preferences.

Select this item to always open EndNote when you start OpenOffice Writer.

Select this item to always close EndNote when you leave OpenOffice Writer. This works only when the 
EndNote program was launched with one of the Cite While You Write commands from within 
OpenOffice Writer or if the Open EndNote When Starting Writer preference is selected.

Keyboard commands, shortcut menus, and the EndNote toolbar can  streamline your library  building and 
citation processes. See these topics for more information.
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Contextual (Shortcut) Menus

Menu Keyboard Commands▪

Keyboard Commands▪

CWYW Keyboard Commands for Word▪

Contextual (Shortcut) Menus▪

The Library Toolbar▪

To add or change Cite While You Write keyboard shortcuts in Microsoft Word, see Keyboard Preferences in 
Microsoft Word.

As a convenience, EndNote provides contextual (shortcut) menus for some of the most commonly used 
features. Contextual menus appear when you right-click on something in the EndNote program (such as a 
reference, a group name, or an Author field).

The contents of the menu depend on where you click and what options are available for that particular item. 
Only a subset of possible commands are displayed. These are intended to represent the most commonly 
used functions for the selected target. Choosing a command from a contextual menu has exactly the same 
result as choosing the command from the main menu or the toolbar.

A contextual menu appears wherever you click. It remains open until you choose a command from the list, 
click elsewhere, or press the Escape key.

Contextual menus are available in at least the following areas: the Reference window, the Reference List, 
the Groups panel, term lists, and Managers (styles, filters, and connections).
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EndNote Online

Overview of EndNote Online

Registering with EndNote Online and Activating the Sync 
Process

I Already Have an EndNote Online Account

EndNote online is a feature set that provides a range of bibliographic management tools on the Web. You 
can import and edit references via a personal EndNote account, and then cite the references in papers and 
create bibliographies.

EndNote online can search Web of Science™, PubMed, and hundreds of other online library databases to 
help you build a personal reference collection. It includes unique integration with the Web of Science™ Core 
Collection, with dynamic links to Times Cited records and Related Records giving you one-click access to 
the latest information on a reference article.

Each EndNote online library can store thousands of records and create bibliographies in thousands of 
publishing styles. Our Cite While You Write feature is available to anyone using Microsoft Word to create 
bibliographies. (See Cite While You Write in Microsoft Word and The Application Tab in the Cite While You 
Write Preferences Dialog.)

Your purchase of EndNote entitles you to a two-year free subscription to EndNote online and the option to 
synchronize the references (including files and figures) in your EndNote library with the references in your 
EndNote online library without having to export and import files.

You must first register and have an active EndNote account to initiate the Sync process. Registration is fast 
and easy and activates your two-year EndNote account. When completed, EndNote automatically proceeds 
with the Sync process and updates your new EndNote online library to match the references and custom 
groups in your EndNote library.

Note: The Sync process includes groups, group sets, and group associations, but EndNote online can 
only display custom groups.

Click Sync Configuration  in the Groups  panel to go to a Sync Configuration dialog. Click the Sync 
Now button to go to an EndNote Login dialog.

1.

Enter your EndNote account email address.2.

Enter your EndNote account password.3.

Click OK.4.

Read the terms and conditions, then click Agree to accept the terms and conditions, and to link your 
account to your new copy of EndNote.

5.

Click Sync to begin synchronizing your EndNote online library with your EndNote library.6.
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I Do Not Have an EndNote Online Account

Sync Preferences

Since you already have an EndNote account, EndNote populates the fields on the Sync Preferences page 
with the e-mail address and password that you entered on the EndNote online login dialog. You can change 
the data in these fields if you ever change your email address or password in EndNote online.

Note: The Sync library that you defined in Sync Preferences must be open and currently active to perform 
the Sync process.

Since you do not have an EndNote account, you must create one. Registration is fast and easy and 
activates your two-year EndNote account enhancement when completed.

Click Sync Configuration in the Groups panel to go to a Sync Configuration dialog.1.

Click the Sync Now button to go to an EndNote Login dialog.2.

Click the Sign Up button to go to an EndNote Registration dialog.3.

Enter your email address in the EndNote Registration dialog. Retype your email address, and then 
click the Submit button.

4.

Enter your name and a secure password, read the EndNote End User License Agreement, then click 
the Agree button if you wish to create your account.

5.

Click the Sync button to begin synchronizing your EndNote online library with your EndNote library.6.

Before synchronizing for the first time, you will be prompted to create a compressed library backup. 
Click the Yes button to create the backup.

7.

Choose the location for your backup, then click the Save button.8.

EndNote will save the backup and begin synchronizing your library references.

Once you create your EndNote account, EndNote populates the fields on the Sync Preferences page with 
the email  address and password that you entered during registration. Later you can change the data in 
these fields if you ever change your email address or password in EndNote online.

Note: Although it is possible to synchronize your library without creating a compressed library backup 
during your first synchronization, we suggest creating the backup. You can also create a compressed 
backup of your library at any time. See Saving a Compressed Copy of a Library for more information.

Sync Preferences allow you to set your preferences so that:

You only have to enter your e-mail address and password once in Sync Preferences and not each 
time you manually synchronize your references between EndNote and EndNote online.

▪

You can have EndNote automatically begin the Sync process every 15 minutes (background 
processing) by selecting the Sync Automatically checkbox.

▪
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Accessing EndNote Online

Overview of the Sync Process

Sync Preferences

Important Points to Know About the Sync Process

To access these settings, go to the Edit  menu, select Preferences, and then click Sync  in the list of 
preferences. See Sync Preferences.

To access your EndNote online account, go to https://my.endnote.com, enter your login information, and 
click Sign in.

EndNote allows you to synchronize your entire desktop library with EndNote online and the iPad app.

The Sync process automatically synchronizes both sets of references that reside in the desktop and online 
so that the references in your library in EndNote and EndNote online are an exact match.

The Sync process is always initiated from EndNote. The data in EndNote and EndNote online are 
synchronized in both applications when you run Sync. You will have identical custom groups and references 
when Sync completes processing.

The Sync process includes all data changes to references (including file attachments) during the Sync 
process so that each library matches the other. For example, if you add or remove references and/or PDF 
files in EndNote, then those changes are updated in EndNote online and vice-versa.

The Sync process includes updates and additions to groups in both libraries. For example, if you create and 
add references to a new custom group in EndNote, then you will see this group in EndNote online the next 
time you run the Sync process.

Although the information about group sets, smart groups, and combination groups is included in the Sync 
process, these groups and group sets are not supported by EndNote online and so are not visible. If you 
sync your library with another computer, all groups and group sets will be available on the second computer.

Sync Preferences allow you to set your preferences so that:

You only have to enter your e-mail address and password once in Sync Preferences and not each 
time you manually synchronize your references between EndNote desktop and EndNote online.

▪

You can have EndNote automatically begin the Sync process every 15 minutes (background 
processing) by selecting the Sync Automatically checkbox.

▪

To access these settings, go to the Edit  menu, select Preferences, and then click Sync  in the list of 
preferences. See Sync Preferences.

Sync synchronizes the references, groups, and group sets in your library, it does not synchronize the 
library as a whole. The important difference is that the record numbers will probably not be the same 

▪
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Sync Status Dialog

Sync Details

in both copies of the library. This is because the references will be assigned new record numbers on 
the new computer. See Record Numbers.

Sync includes an unlimited number of references in your library and an unlimited amount of storage 
for file attachments and figures.

▪

Sync works with only one library and only one EndNote online account.▪

Your sync library can be shared with up to 399 other EndNote users on version 20  or later. See 
About Shared Libraries.

▪

Sync your references in EndNote (including groups, group sets, smart groups, and combination 
groups) between one desktop and another desktop on various platforms.

▪

After the Sync process completes, EndNote identifies each group that has Sharing enabled in 
EndNote online with a shared group icon. A shared group is a group in which your colleagues can 
access and see your groups in their Groups Shared by Others section.

▪

Sync will put groups, when a group set cannot be identified, in an Unfiled Groups set. Drag and drop 
the group to the appropriate group set in the desktop library.

▪

You can select any EndNote library that you created with EndNote to synchronize with your EndNote 
online library, but only one library can be synced. If you try to sync your online account to another 
desktop library, the libraries will be merged. See Merging Libraries through Sync.

▪

Sync includes references that have been moved to the Trash group. If you have references that were 
moved to Trash in the desktop version, those references will be moved to the Trash group in the 
online version.

▪

EndNote automatically prompts you to Sync your EndNote library with your EndNote online library 
when you close your default EndNote library.

▪

The Sync Status dialog allows you to review information about the EndNote library  that you selected to 
synchronize with your EndNote online library. The dialog provides information about the last Sync operation, 
including the number of references and file and figure attachments that EndNote updated during process.

Text in the status window can be copied and pasted into a text file using the standard Edit > Copy (Ctrl+C) 
and Edit > Paste (Ctrl+V) commands.

If there is a conflict during the sync process, a Sync Conflicts temporary group will appear in EndNote. 
See Resolve Sync Conflicts Dialog for information on resolving conflicts and their causes.

Note: Although the Sync Status icon appears in the Group panel, it is not really a group as defined in 
EndNote.

Check the information under this heading if processing errors occur during a Sync operation. EndNote 
displays error text and codes in the dialog detailing the problem. For example, you might see an error like 
this if you are not connected to the Internet:
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Local Library

Online Library

Limits

Resolve Sync Conflicts Dialog

Sync Conflicts Group

Error message: EndNote could not connect to the online sync service.

An authorization error might show:

Error message: The username/password specified is not valid.

If you experience problems with EndNote Sync which cannot be worked out from the messages in the Sync 
Details, contact technical support.

This section shows information about the local library, including the library name, group sets, and groups.

This section shows information about the online library. The Username field displays the e-mail address that 
you are using to Sync your EndNote library with your EndNote online library. The Serial Number field shows 
the serial number of your version of EndNote.

This section shows how many references, groups, and group sets you are allowed in your library, and how 
much attachment storage is available to you. If you are within your free two-year subscription, the 
attachment storage will be unlimited. If your subscription has expired, you will be limited to 2 gigabytes of 
attachment storage.

The Resolve Sync Conflicts dialog allows you to resolve conflicts between references in your EndNote 
library and your EndNote online library.

A conflict occurs for a reference when you edit the reference in both EndNote and in EndNote online 
between Syncs. With two different sets of changes, EndNote does not know which one(s) you want to keep.

This group contains all of the references for which EndNote has identified a conflict between an EndNote 
reference and EndNote online reference. The group only appears in the Groups panel when there are 
conflicts.

To resolve Sync conflicts:

Right-click  the Sync Conflicts  group and select the Resolve Conflicts  option from the contextual 
menu. EndNote displays the Resolve Sync Conflicts dialog.

▪

Select the Sync Conflicts group to display a list of references that EndNote has identified as having a 
conflict. Select one or more references from the list. Right-click  and select the Resolve Conflicts 
option from the contextual menu.

▪
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Resolving Conflicts

Did You Know...?

Unfiled Groups

You can keep either the EndNote desktop reference or the EndNote online reference to resolve a conflict. 
The version of the reference you do not choose to keep is permanently deleted

To resolve a conflict between two references, click the Keep Desktop Reference button or the Keep 
Online Reference button. Once you select a record to keep, EndNote updates the record in both 
EndNote desktop and EndNote online.

▪

To resolve all conflicts in favor of the desktop version or the Web version, select the Keep All 
Desktop References option or the Keep All Online References option  from the drop-down Keep All 
menu at the bottom of the dialog. Once you select either option, EndNote updates the records in 
both EndNote desktop and EndNote online.

▪

You can also:

Copy and paste information between the two records. The record that you keep will include all data 
copied to the record.

▪

Skip or Cancel a conflict. All references in conflict remain in the Sync Conflicts auto-group until they 
are resolved.

▪

Note: When you choose to keep a record, EndNote immediately sends all the data to EndNote online. If 
your connection to EndNote online fails, the process ends and the dialog closes. However, any data 
already sent to EndNote online is processed.

When you create a new group in EndNote or EndNote online, the new group is added to the other 
library when you run Sync.

▪

When you change a group’s name in both libraries, EndNote uses the most recently changed name 
so no conflict occurs when you run Sync.

▪

When you delete a group, there is no conflict. EndNote removes the group and moves the 
references to the Unfiled folder.

▪

If you delete a group in one application and rename the same group in the other application, 
EndNote deletes the group when you run Sync. Delete overrules Rename.

▪

When you move a reference from one group to another group, then a Sync conflict may occur. If you 
move a reference from Group A to Group B in EndNote desktop and in EndNote online you move the 
same reference to Group C, then the next time you run Sync the reference will be in conflict.

▪

If, during the Sync process, EndNote receives a group from EndNote online  that does not belong to any 
group set up in EndNote, then the system automatically adds the group to an Unfiled Groups folder.
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Using Cite While You Write with EndNote 
Online

Important Points about Cite While You Write and EndNote 
Online

Selecting the EndNote or EndNote Online Application

You should move all groups  from the Unfiled Groups folder to an existing group set in EndNote. If an 
appropriate group set does not currently exist, then you should create one. EndNote removes the Unfiled 
Groups folder from the Groups panel when you move all unfiled groups to a group set.

You can use Cite While You Write with either EndNote or EndNote online.

Cite While You Write support is included for both EndNote and EndNote online. However, you cannot 
use this feature simultaneously with both applications.

▪

You can insert references from your personal EndNote online library. You cannot, however, use Cite 
While You Write to insert references in folders shared by other EndNote online users by default. To 
use a group shared with you through EndNote online in Word, in EndNote online select Organize > 
Others Groups, then mark the Use for Cite While You Write checkbox. You must make this change in 
the EndNote online interface using your browser.

▪

Some Cite While You Write functions may not be active for EndNote online.▪

For general information about how to Cite While You Write, see Overview of the Cite While You Write 
Process in Word and How to Cite While You Write with Microsoft Word.

Use the Application tab in the Cite While You Write preferences to indicate which version of EndNote to use 
when you use Cite While You Write in Word.

On the EndNote tab, select Preferences.1.

Select the Application tab.2.

From the drop-down Application  menu, select which version of EndNote you want to use with Cite 
While You Write.

3.

EndNote is your desktop version of the EndNote bibliographic application. Select this option if 
you want to work with your desktop libraries. This option will cause a tab called EndNote 20 to 
appear.

▪

Page 530 of 586

 



Clarivate EndNote 20 User Help Guide

EndNote online is the online version of EndNote. Select this option if you want to use 
references from a group shared with you. See Sharing Groups. This option will cause a tab 
called EndNote to appear. 
 
OR 
 
Select Search: Shared Groups in the Find & Insert My References dialog to temporarily search 
shared groups  without changing the tab. Change it back to Search: Libraries  to search your 
desktop libraries again.

▪
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Web of Science Integration

View Source Records and Related Records

Creating Citation Reports

If your reference contains a Web of Science™  identification number, you can access the Web of Science 
source record or view a list of related records directly from the library  reference. A Web of Science 
subscription is required to access this content.

In the Reference Summary  panel, select the Web of Science article record  link or the Web of Science 
related records link. These links will appear even if you do not have a Web of Science subscription, but will 
only work if you have a valid subscription and are authenticated for access to the Web of Science.

The Web of Science Citation Report makes it easy to explore the publication trends and citation 
performance for a set of research. If you have access to both EndNote and Web of Science™, you can 
create a Web of Science Citation Report starting from a group of references in EndNote 20.

The Citation Report provides aggregate citation statistics for a set of search results. These statistics include:

The total number of results found (Results Found field).▪

The total number of times all records have been cited (Sum of Times Cited field).▪

The total number of citations to all results found in the results set minus any citation from articles in 
the set (Sum of Times Cited without Self-Citations field).

▪

The total number of citations to any of the items in the set of search results (Citing Articles field).▪

The citing articles minus any article that appears in the set of search results (Citing Articles without 
Self-citations field).

▪

The average number of times a record has been cited (Average Citations per Item field).▪

The total number of times a record has been cited for all years in the results set (Total column).▪

The h-index count that is based on the list of publications ranked in descending order by the Times 
Cited count.

▪

To create a Citation Report, in the Groups menu, right-click on a group and select Create Citation Report.

Note: At least one reference in the group must contain either a Web of Science identification number or a 
PubMed identification number (PMID) for the Citation Report to be generated.

You must have access to the Web of Science to use this feature. If you do not have access to the Web of 
Science, contact your institution about signing in and registering for an account.

For more information, see our training portal.
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Manuscript Matcher
Using complex algorithms and data from the Web of Science™  and Journal Citation Reports, Manuscript 
Matcher identifies the most relevant and impactful journals to which you may wish to submit your 
manuscript.

You can access Manuscript Matcher in the following ways:1.

In EndNote 20, right-click on a Group and select Manuscript Matcher, ora.

In EndNote 20, select a Group, and then select Manuscript Matcher from the Groups menu, orb.

In Microsoft Word, from within a manuscript click on Manuscript Matcher in the EndNote 20 tab.c.

Once the Manuscript Matcher window opens, copy and paste the article’s title and abstract into the 
appropriate boxes. If accessing Manuscript Matcher via EndNote online, select the group containing 
the manuscript’s references. This step is not needed if launching from EndNote 20 or from Cite While 
You Write.

2.

Click Find Journals.3.

Manuscript Matcher will display up to 10 journal matches for your manuscript as well as detailed information 
about each journal:

Match Score: An index of how closely your article matches with published content in this journal. 
Click on the arrow next to the Match Score bar to show or hide additional journal detail.

▪

JCR Impact Factor: A measure of a journal’s mean citation rate per citable item. The current-year 
and average 5-year scores are displayed. Click the arrow next to the Current Year  label to reverse 
the JCI Impact Factor sort order from descending to ascending, or ascending to descending.

▪

Journal Name: The journal title.▪

Similar articles: Other articles published in the journal with topics similar to yours.▪

Was this helpful?: You may optionally click Yes  or No, and optionally add a comment about 
Manuscript Matcher. This feedback will help Clarivate improve Manuscript Matcher.

▪

Submit: Links to the journal log-in page, where you may log in and submit your manuscript.▪

Journal information: Links to the journal website.▪

Clicking on the arrow next to Match Score shows or hides the following detailed journal information:

JCR Category: The Subject Category to which the journal is assigned in Web of Science and 
Journal Citation Reports (JCR). If a journal belongs to multiple categories, they will be displayed 
here.

▪

Rank in Category: The Journal rank according to the Journal Impact Factor (JIF) for the journal, for 
each JCR category to which the journal belongs. It is expressed as the rank-order position of the 
journal over the total number of journals in the category that have a JIF.

▪

Quartile in Category: Rank expressed in terms of the quartile based on the percentile rank. If a 
journal is in Q1, it ranks higher than 75% of the journals in the category; Q2 means it ranks among 
the top half or journals in the category, etc.

▪
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Publisher address: The publisher’s address of record.▪

ISSN: The publisher’s  International Standard Serial Number (ISSN) code, which is used to identify 
journals and other publications published in any media.

▪

eISSN: The publisher’s electronic International Standard Serial Number (eISSN) code, which is used 
to uniquely identify electronic journals and other publications.

▪

Note: In certain cases, Manuscript Matcher will not be able to identify journal matches for your 
manuscript. If not all citations have been entered, try again once the citations are complete; or revise your 
abstract.
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Installing EndNote Files

Program Requirements

System Requirements

Hardware Requirements

Word Processor Compatibility

Both the full EndNote program and the EndNote Demo are available by download.

EndNote 20 runs under the following operating systems:

Windows 10▪

Windows 11▪

1 gigahertz (GHz) or faster x86-bit or x64-bit processor▪

600 MB hard disk space available▪

Minimum 2 GB of available RAM▪

An Internet connection is required to register for online access, search online databases, find full text 
and automatically update references.

▪

Make sure that your computer meets the system and hardware requirements before continuing. If 
necessary, contact the distributor, dealer, or store where you purchased EndNote to arrange for a full refund. 
If you have any problem obtaining a refund, contact Clarivate  directly. You must do so within 30 days of 
purchase.

EndNote for Windows is compatible with:

Microsoft Word [CWYW] for Windows: 2010, 2013, 2016, 2019, Office 365 (locally installed desktop 
version only)

▪

Apache OpenOffice [CWYW] for Windows: 3.x, 4.x▪

LibreOffice [CWYW] for Windows: 4.x, 5.x, 6.x (32-bit)▪

Partner CWYW Integration: Wolfram Mathematica 8▪

EndNote's Format Paper feature works with almost any program that can create a standard Rich 
Text Format (RTF) file.

▪
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PowerPoint Compatibility

A Typical Installation

A Typical Installation for a Single-User License of EndNote

EndNote for PowerPoint is compatible with Microsoft PowerPoint versions 2010, 2013, 2016, 2019, Office 
365 (locally installed desktop version only).

A typical installation of EndNote will install all the essential components of the software, with a limited 
number of the most popular styles, filters, and connection files (called "content files" as a group). EndNote 
has thousands of content files, so many that installing all of them can impair program performance. Installing 
only the most popular content files as a default  still allows you to add files at  need, while improving 
performance. See the following for information on installing additional content files.

Installing Additional Output Styles▪

Installing Additional Connection Files▪

Installing Additional Filters▪

Custom Installations/Adding Content Files▪

To install EndNote 20:

Download the installer. If you do not have a copy of the installer, check here.1.

Place the installer on your desktop and double-click on it to begin the installation.2.

If asked if you want to allow the application to make changes, click Yes. (No would cancel the 
installation.)

3.

Click the Next button.4.

In the Select Installation dialog, enter your EndNote product key if you have purchased EndNote, or 
choose the I would like a 30-day free trial radio button to install a 30-day trial version of the program. 
The trial version has all the features of the paid version to allow you to evaluate the program before 
buying.  
 
You can also use the Purchase a Product Key button to purchase EndNote from this dialog.

5.

Click the Next button.6.

The Read Me Information dialog will give you updated information on the program. Click Next when 
you have finished viewing it.

7.

The License Agreement dialog allows you to view the full license agreement for use of the product. 
To continue the installation, accept the license agreement and click Next.

8.

In the Select Installation Type dialog, leave the Typical radio button marked, then click Next. (If you 
wish to do a custom installation, choose that option here. See Custom Installations/Adding Content 
Files.)

9.
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A Typical Installation for an Institutional License 
of EndNote

Click the Next button until the installation completes, then click the Finish button.10.

You have now completed the installation of EndNote and can begin using the program. Be sure to save a 
copy of the installer in a safe location, in case you want to install EndNote again or on another computer. A 
single-user copy of EndNote can be installed on up to three computers, but they must all have the same 
user.

If your institution has provided you with a site license installer for EndNote, you will need two files: the 
EN20Inst.msi installation file and a file called License.dat. These may have been provided in a zipped file. 
Both files are necessary to install EndNote 20  without a product key or the need for buying a personal 
product license.

To install EndNote 20:

If your institution has provided you with a zipped file containing the EN20Inst.msi  file and the 
License.dat file, you will first need to extract the files. You cannot install the program from the zipped 
file. Although Windows will let you see both files inside the zipped file, trying to install from within the 
zipped file will ask for a product key. Installing from the extracted files will not ask for a product key.  
 
Right-click on the zipped file and select Extract All from the menu.

1.

If asked at any time during the installation if you want to allow the application to make changes, click 
Yes. (No would cancel the installation.)

2.

Place both the EN20Inst.msi  and the License.dat  files on your desktop or in a folder on your hard 
drive. Both files must be together in the same folder.

3.

Double-click on the EN20Inst.msi file to begin the installation, then click Next.4.

Read through the EndNote 20 Volume  License Version agreement. Click Accept  to accept the 
agreement and continue the installation, or click Cancel to cancel the installation.

5.

The Read Me Information dialog will give you updated information on the program. Click Next when 
you have finished viewing it.

6.

The License Agreement dialog allows you to view the full license agreement for use of the product. 
To continue the installation, accept the license agreement and click Next.

7.

In the Select Installation Type dialog, leave the Typical radio button marked, then click Next. (If you 
wish to do a custom installation, choose that option here. See Custom Installations/Adding Content 
Files.)

8.

Click the Next button until the installation completes, then click the Finish button.9.

You have now completed the installation of EndNote and can begin using the program. Be sure to save a 
copy of both the EN20Inst.msi and the License.dat files in a safe location. They may be needed when you 
install updates or upgrades.
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Custom Installations/Adding Content Files

Selecting Features

Although we recommend that you use the Typical installation option to install EndNote, the Custom 
installation option can be useful if you are low on disk space, if you need to reinstall only certain EndNote 
components, of if you would like to add additional content files (output styles, import filters, and/or 
connection files).

To perform a new custom installation:

Follow the instructions for installing EndNote found in A Typical Installation until you reach the Select 
Installation Type dialog.

1.

On the Select Installation Type dialog, select Custom.2.

When you get to the Select Features dialog, read the section below on Selecting Features to 
determine which features you would like to select or deselect for your installation.

3.

To install components after EndNote is already installed:

Log in to the machine with administrative rights or as a user with program installation privileges.1.

Do one of these:2.

Start the EndNote installation program as you would for a new installation.▪

From the Windows Start  menu, select Settings, and  then Apps. Scroll down, click on the 
EndNote application, and select Modify.

▪

On the Application Maintenance dialog, select Modify and then click Next.1.

When you get to the Select Features  dialog, read the section below called Selecting Features to 
determine what you would like to select/deselect for installation.

2.

There are several major categories of components that can be installed with the product. The components 
you can select for installation include:

EndNote Application▪

EndNote Program▪

Sample Files▪

EndNote Help▪

Getting Started Guide▪

Cite While You Write for Microsoft Office▪

Extension for OpenOffice and LibreOffice▪

EndNote Click Browser Reference Capture▪
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Updating EndNote Files

Uninstalling EndNote

Additional Connections  
 
Install or remove files for directly retrieving references from online reference databases. These are 
grouped by information service provider.

▪

Additional Filters  
 
Install or remove files for importing text files of reference data. These are grouped by information 
service provider.

▪

Additional Styles  
 
Install or remove output styles for formatting bibliographies and citations. These are grouped by 
category, e.g., Medicine, Humanities, etc.

▪

Spelling Dictionaries  
 
These are dictionaries available for the spelling checker.

▪

Click the plus sign next to each category to display a detailed list of items. For each category or 
subcategory, click the drop-down indicator (a small arrow) next  to the name to select from the available 
installation options. To install a feature, select one of these:

Will be installed on local hard drive.  
 
This will install the selected files.

▪

Entire feature will be installed on local hard drive.  
 
When used with the major styles, filters, or connection files options, this will install all the files for that 
content type, instead of having to select each file individually.

▪

EndNote automatically checks for program updates when you open the application.

However, you can manually update EndNote when program enhancements are available.

To update your copy of the EndNote program, select Check for Updates… from the EndNote Help menu to 
launch a wizard. The wizard checks for an update, lets you know whether an update is available, and then 
downloads the file(s) and applies the update to your EndNote installation. If no updates are available, you 
will receive a message to that effect.

Note: You also have the option to download the latest files from the EndNote downloads page. We 
continually update output styles, filters, and connection files.

To uninstall EndNote:

Log in to the machine with administrative rights or as a user with program installation privileges.1.
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Windows 10 and Windows 11

Installed Files

Program Folder (C:\Program Files (x86)\EndNote 20)

From the Windows Start menu, select Settings, and then Apps.2.

Scroll down and click on the EndNote application.3.

Click the Uninstall button, then Uninstall again in the confirmation dialog.4.

We purposely do not remove any EndNote libraries or customized files. You can manually delete these files 
with File Explorer. Once you are sure you do not want to save any of the files contained in the following 
folders, you can delete them:

Sample Files 
 
C:\Users\Public\Public Documents\EndNote

▪

Custom Style, Filters, or Connection Files 
 
C:\Users\User Name\Documents\EndNote

▪

Personal Reference Type Table, Connection Log, Libraries Shared with You, Saved Searches, 
and Miscellaneous Files 
 
C:\Users\User Name\App Data\Roaming\EndNote

▪

Registry Settings 
 
Computer\HKEY_CURRENT_USER\SOFTWARE\ISI ResearchSoft

▪

Notes: The Windows App Data folder is hidden by default. To show hidden files in Windows, open File 
Explorer, select View  > Options  > View  and mark the radio button option to Show hidden files, folders, 
and drives. 
 
Errors made in editing the registry can have serious consequences. If you are not experienced with 
working in the registry, we suggest you leave the registry settings as they are.

The full EndNote installation includes the following default folders and files.

If you are running a 32-bit version of Windows, the folder will be C:\Program Files\EndNote 20.

EndNote.exe is the EndNote application file.▪

EndNote.chm  is the EndNote help file. You can double-click the file to view it. In the EndNote 
program, press the F1 key on your keyboard to open the help file.

▪

EndNote.pdf is a compilation of the Help topics in the online Help system. This is an editable PDF 
with a full table of contents via the bookmarks, allowing you to add your own comments.

▪
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Personal Folder

Preferences Folder

Readme.txt contains late-breaking news.▪

License Agreement.txt contains a copy of the current EndNote license agreement.▪

The Examples shortcut folder provides a quick link to the example files in the C:\Users\Public\Public 
Documents\EndNote folder.

▪

The Styles  folder contains bibliographic styles for formatting citations and a bibliography. A typical 
installation includes only the most popular styles. With a Custom installation, you can choose from a 
full collection of over 7,000 bibliographic styles. See Installing Additional Output Styles.

▪

The Connections  folder contains  connection files to connect to and search online bibliographic 
databases. A typical installation includes only the most popular files. With a Custom installation, you 
can choose from a collection of thousands. See Installing Additional Connection Files.

▪

The Filters folder contains import filters for importing text files downloaded from online bibliographic 
databases or data  exported from other bibliographic software programs. A typical installation 
includes only the most popular filters. With a Custom installation, you can choose from a collection of 
hundreds. See Installing Additional Filters.

▪

The Terms Lists folder contains  journal abbreviation term lists. These lists contain thousands of 
journal names and standard abbreviations. Import a list into your library’s Journals term list  to use 
the abbreviations in your bibliographies.

▪

The Spell folder contains spell check dictionaries for the EndNote spell checker.▪

Various additional folders and files are installed to support the EndNote program and to integrate 
EndNote with other software programs.

▪

Open the Documents folder in File Explorer to find the EndNote folder located at C:\Users\User 
Name\Documents\EndNote. These folders are created when you create or modify a file:

The Styles folder contains new or modified bibliographic styles.▪

The Connections folder contains new or modified connection files.▪

The Filters folder contains new or modified import filters.▪

While the program folder contains the default styles, connection files, and filters, your personal EndNote 
folder contains those files that you have created or modified. This prevents changes to the original files, and 
assures that you will not inadvertently delete a customized file when you remove or upgrade the EndNote 
program. It also allows you to make changes to files even though you may not have administrator access to 
modify files in the Program Files folder. EndNote displays a single list of the files found in both locations. If a 
file of the same name appears in both locations, EndNote will display only the file found in your personal 
folder.

You can change your personal folder locations. See Folder Locations Preferences for more information.

Depending on your settings, this folder may be hidden from view in File Explorer.
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Installing Additional Output Styles

Using the EndNote Installer to Install Additional Output 
Styles

Windows 10 or 11: C:\Users\User Name\App Data\Roaming\EndNote

While many EndNote preferences are stored in the Windows registry, some are stored in your personal 
preferences folder. It contains the connect.log file  that records your latest online search, the 
RefTypeTable.xml file which stores  your reference type  preferences, saved search strategies, libraries 
shared with you, and various other settings. See Being Invited to a Shared Library and  About Shared 
Libraries.

Note: The Windows App Data folder is hidden by default. To show hidden files in Windows, open File 
Explorer, select View  > Options  > View  and mark the radio button option to Show hidden files, folders, 
and drives.

The EndNote team has developed over 7,000 different output styles. Because installing all of these styles 
can slow performance, a typical EndNote installation includes only the most popular styles. You can install 
sets of styles by discipline with the EndNote installer or you can download individual styles from the 
EndNote site.

First, make sure EndNote is closed and not running; Microsoft Word and Microsoft Outlook should also be 
closed. You can run the EndNote installation program again, select the option to Modify the installation, and 
then select sets of output styles to install.

You can also use the Windows Apps & Features setting to add new styles.

To install sets of output styles:

Log in to the machine with administrative rights or as a user with program installation privileges.1.

From the Windows Start  menu, select Settings  and then Apps. This should default  to the Apps & 
Features setting.

2.

In Apps & Features, scroll down to the EndNote application and select it.3.

Click the Modify  button. The EndNote Application Maintenance window should appear, with Modify 
selected.

4.

With Modify selected, click the Next button.5.

In the Select Features window, expand the Additional Styles list.6.

Open the drop-down menu for the set of styles you want to add and select Will be installed on local 
hard drive. Repeat this for each set of styles you want to install.

7.

Click the Next button, and click the Next button again.8.

When the installation is done, click the Finish button.9.
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Finding Individual Styles on the EndNote Styles Page

Installing Additional Connection Files

Using the EndNote Installer to Install Additional 
Connection Files

The styles will be copied to the EndNote Styles folder, which is typically \\Program Files 
(x86)\EndNote 20\Styles, and the new files will be available for use the next time you start EndNote.

You can use the Style Manager in EndNote to find and download individual output styles.

To download individual output styles:

From the Tools menu in EndNote, select Output Styles and then Open Style Manager.1.

Click Get More on the Web  to start your default browser and go to the appropriate page on the 
EndNote site.

2.

Note: Another way to direct your browser to this web page is to select EndNote Output 
Styles from the Help menu.

Use the Style Finder to search for a style, or browse through an alphabetical listing of the available 
output styles. Download those files you want to install.

3.

Copy the downloaded files to your Styles folder, which is typically located at \\Program Files 
(x86)\EndNote 20\Styles, or to your personal Styles folder (see Folder Locations Preferences).

4.

If EndNote is still open, exit the program and then restart EndNote to update the output styles list.5.

The styles will now be available in EndNote to select for formatting.

The EndNote team has developed thousands of different connection files. Because installing all of these 
files may slow performance, a typical EndNote installation includes only the most popular connection files. 
You can install sets of connection files by provider with the EndNote installer , or you can download 
individual connection files from the EndNote desktop web site.

First, make sure EndNote is closed and not running; Microsoft Word and Microsoft Outlook should also be 
closed. You can run the EndNote installation program again, select the option to Modify the installation, and 
then select sets of connection files to install.

You can also use the Windows Apps & Features setting to add new connection files.

To install sets of connection files:

Log in to the machine with administrative rights or as a user with program installation privileges.1.

From the Windows Start  menu, select Settings  and then Apps. This should default  to the Apps & 
Features setting.

2.
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Finding Individual Connection Files on the EndNote Online 
Site

Installing Additional Filters

Using the EndNote Installer to Install Additional Filters

In Apps & Features, scroll down to the EndNote application and select it.3.

Click the Modify  button. The EndNote Application Maintenance window should appear, with Modify 
selected.

4.

With Modify selected, click the Next button.5.

In the Select Features window, expand the Additional Connections list.6.

Open the drop-down menu for the set of connection files you want to add and select Will be installed 
on local hard drive. Repeat this for each set of connection files you want to install.

7.

Click the Next button, and click the Next button again.8.

When the installation is done, click the Finish button.9.

The connection files will be copied to the EndNote 20 Connections folder, which is typically \\Program Files 
(x86)\EndNote 20\Connections, and the new files will be available for use the next time you start EndNote.

You can use the Connection Manager in EndNote to find and download individual connection files.

To download individual connection files:

From the Tools  menu in EndNote, select Connection Files, and then select Open Connection 
Manager.

1.

Click Get More on the Web  to start your default browser and go to the appropriate page on the 
EndNote site.

2.

Browse through an alphabetical listing of the available connection files, and download those files you 
want to install.

3.

Copy the downloaded files to your Connections folder, which is typically located at C:\Program Files 
(x86)\EndNote 20\Connections.

4.

The EndNote team has developed hundreds of different filter  files. A typical EndNote installation includes 
only the most popular filters. You can install sets of filters by provider with the EndNote installer, or you can 
download individual filters from the EndNote site.

First, make sure EndNote is closed and not running; Microsoft Word and Microsoft Outlook should also be 
closed. You can run the EndNote installation program again, select the option to Modify the installation, and 
then select sets of connection files to install.

You can also use the Windows Apps & Features setting to add new filters.
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To install sets of filter files:

Log in to the machine with administrative rights or as a user with program installation privileges.1.

From the Windows Start  menu, select Settings  and then Apps. This should default  to the Apps & 
Features setting.

2.

In Apps & Features, scroll down to the EndNote application and select it.3.

Click the Modify  button. The EndNote Application Maintenance window should appear, with Modify 
selected.

4.

With Modify selected, click the Next button.5.

In the Select Features window, expand the Additional Filters list.6.

Open the drop-down menu for  the set of filter files you want to add and select Will be installed on 
local hard drive. Repeat this for each set of filter files you want to install.

7.

Click the Next button, and click the Next button again.8.

When the installation is done, click the Finish button.9.

The filter files will be copied to the EndNote 20 Filters  folder, which is typically \\Program Files 
(x86)\EndNote 20\Filters, and the new files will be available for use the next time you start EndNote.

You can use the Filter Manager in EndNote to find and download individual filter files.

To download individual filters:

From the Tools menu in EndNote, select Import Filters, and then select Open Filter Manager.1.

Click Get More on the Web to  start your default browser and go to the appropriate page on the 
EndNote site.

2.

Browse through an alphabetical listing of the available filter files and download those files you want 
to install.

3.

Copy the downloaded files to your Filters folder, which is typically located at \\Program Files 
(x86)\EndNote 20\Filters.

4.
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EndNote on Networks

Using Libraries on a Network

Multi-Platform Networks

Multi-User Library Access

Special Issues in Network Environments

The volume edition of EndNote is licensed for a particular number of users; you can install EndNote locally 
for each of the licensed users. Users can access a common library on a server or their own personal library. 
See Networks and Volume Installations (Licensing of Volume Copies).

EndNote libraries (databases) are directly compatible across Windows and macOS platforms and do not 
require any special conversion procedures (see Transferring Libraries between Computers or Platforms). 
Because of this, EndNote can be used in a mixed platform network environment very easily.

Even though EndNote can be used across a network, it was not designed with specific networking 
capabilities in mind. EndNote does not perform record locking functions that would allow multiple users to 
edit one library at the same time. However, multiple users can access one EndNote library simultaneously 
as long as the library is restricted to read-only  status. This will allow the user to perform searches, copy 
information to their documents, and format their papers. Use File Explorer to change the Properties of your 
EndNote library; select the Read-Only attribute for the .enl file and the .Data folder.

The simplest way to set up an EndNote library for shared network access is to use the network’s system of 
file permissions to control the type of access allowed for users and groups. One or two people should be 
assigned the responsibility for maintaining and updating the library; these users should be granted full 
access to the library .enl file and .Data folder. All other users should be granted read-only access. See 
Multiple People Opening One Library.

EndNote does not perform record locking, but it does require file locking. Some Windows network client 
programs (for example, NFS clients used to connect to UNIX servers) do not fully support these protocols. 
File locking is an optional component in some implementations of NFS (LockD). In addition, some network 
file systems implement a compatibility mode that may prevent file locking from working properly. Network 
clients other than those provided by Microsoft should be tested to ensure that file locking is enabled.

EndNote assumes a maximum file name length based on the capabilities of the operating system on which 
it is running; under Windows, errors may occur if EndNote attempts to store a long file name on a server that 
does not support long file names.

Note: The environment in which EndNote will be used, must support long file names.

Page 546 of 586

 



Clarivate EndNote 20 User Help Guide

Custom Settings

General Preferences

Reference Types

Saved Searches

Cite While You Write

EndNote allows you to customize many areas of the program to suit your needs. Most settings are saved for 
each user.

Most general preferences are stored in the  Windows Registry. This includes many EndNote Preferences, 
subject bibliography settings, and Cite While You Write settings.

If you plan to share your libraries with other users, you may want to limit use of new and modified reference 
types.

Changes made to the reference types table apply to all libraries opened on that computer from the 
current user account.

▪

If your library  is opened from a different computer, your references will follow the layout of the 
reference types table for that computer and user.

▪

If you create a custom reference type or modify a reference type for records in your EndNote library, you 
should make sure the reference type is also created or modified on other computers that will access the 
library. See Backing Up or Sharing Your Reference Types Table.

Search strategy files are saved by default in your Searches folder:

Windows 10: C:\ Users\User Name\ AppData\Roaming\EndNote\Searches

Windows 11: C:\ Users\User Name\ AppData\Roaming\EndNote\Searches 

You may save them elsewhere if you prefer, but EndNote will open to this Searches folder when you choose 
to Load a saved search. EndNote search files use “.enq” as the file name extension.

Cite While You Write codes are directly compatible between the versions of Word EndNote 20  supports. 
See Word Processor Compatibility for information on the versions supported.

Because reference data is kept with each formatted citation, you can collaborate with other authors on a 
paper without each author having the same library.
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About Volume Installations

Before You Begin Network Installation

Networks and Volume Installations (Licensing 
of Volume Copies)

The volume edition of EndNote is licensed for a particular number of users; you can install EndNote locally 
for each of the licensed users (see Networks and Volume Installations (Licensing of Volume Copies)). Users 
can access a common library on a server or their own personal libraries. See Using Libraries on a Network 
for limitations on sharing a library on a server.

For volume installations, you must first unlock the installer as described  in  Unlocking the Volume/Site 
License Installer, and then distribute and install the program using one of the methods described in About 
Mass Program Installations.

For mass installation of the full program, see About Mass Program Installations.

Please make sure that you meet these requirements before installing:

Make sure EndNote is licensed for the appropriate number of users. See Networks and Volume 
Installations (Licensing of Volume Copies).

▪

Make sure the server supports long file names. EndNote 20 includes many files with long file names. 
If the server (or volume) does not support long file names, EndNote 20 cannot be used on it.

▪

Make sure file locking is enabled on the server. EndNote requires file locking. See Special Issues in 
Network Environments.

▪

Clarivate  expects that network administrators will take appropriate steps to maintain compliance with the 
software license. The license agreement (License Agreement.txt) can be found at  \\Program Files 
(x86)\EndNote 20\License Agreement.txt. You can purchase a single or multi-user license:

Single User License

A single EndNote product purchase is licensed to an individual, and is not to be shared.

Volume/Site License

There are three volume  license options available. (Please contact sales for  information on pricing for your 
group.)

Multi-user perpetual license: Starting at 5 users, this is a perpetual one-time fee for the latest 
version without new releases.

▪

Subscription license: Starting at 5 users, this is a yearly subscription with a contract which includes 
future releases within the term of the contract.

▪

Sitewide license: A sitewide license can be customized to your organization. Please contact 
sales for information on pricing for your group.

▪
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Unlocking the Volume/Site License Installer

Windows

Simple Method

An EndNote volume/site license allows multiple users. EndNote can be installed on individual PCs using 
mass installation (up to the number of users indicated in the license agreement).

If you have questions about the licensing of EndNote at your institution, consult your institution's software 
licensing department.

The Volume/Site license installer uses a single product key for multiple users. To automatically include the 
key for your licensed users, you must unlock the installer. This produces a new installer file, along with a 
validating License.dat file.

Note: This information applies only to the Volume/Site license installer, and does not apply to any other 
EndNote licenses.

To unlock the volume/site license installer:

Download the .msi installer and the compressed ADMIN.zip file. 
 
Download EndNote 20.msi installer 
 
Download ADMIN.zip

1.

Extract the ADMIN.zip file. The result will be an ADMIN folder with an ADMIN.BAT file in it.2.

Place the ADMIN.BAT file and the .msi installation file together in the same folder (on the desktop 
works fine).

3.

Double-click the ADMIN.BAT file to run it.4.

When prompted, enter the site's EndNote product key and mark the box saying I hereby 
acknowledge that I have read and accept all terms of the license agreement, then click Next.

5.

Click the Browse button and select a location for the new .msi installer and the .dat file. This must not 
be the same location as the original .msi installer. 
 
Do not select the option titled "Perform Administrative Installation."

6.

Click Next, and Next again.7.

When the installation is complete, you will find an EN20Inst.msi file and a License.dat file in the target folder. 
These files must both be present in the same folder to install the EndNote program. See About Mass 
Program Installations, A Typical Installation for an Institutional License of EndNote.
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For Advanced Users

macOS

Mass Program Installations

About Mass Program Installations

Windows

Deployment Methods

For creating the unlocked site license installer, you need to run the installer in administrative mode. 
 You can also do this by launching Command Prompt, and then running the following command:

msiexec.exe /a EN20Inst.msi

Because of macOS security requirements, users cannot create a site installer for EndNote. When you 
purchase a volume/site license, Clarivate will  provide a site installer for your institution. If you have any 
questions, please contact your sales representative.

Note: For updated information and instructions with screenshots, see the knowledge base article 
EndNote: Volume License Install Steps.

With the volume/site license version of EndNote, a network administrator can use mass installation to install 
EndNote on multiple Windows machines.

Please make sure that you meet these requirements before installing:

Make sure EndNote is licensed for the appropriate number of users. See Networks and Volume 
Installations (Licensing of Volume Copies).

▪

Make sure that each computer is running one of the following Windows operating systems.▪

Windows 10▪

Windows 11▪

In Administrative Mode, the EndNote installer will prompt for a volume product key, which generates a 
License.dat file. The License.dat file must accompany the installer for volume license distribution in order to 
later bypass the product key installation prompt. See Unlocking the Volume/Site License Installer.

You can deploy the EndNote installer to multiple machines in one of these ways:

Easy Deployment▪

Deploying the EndNote Installer with Group Policy▪

Scripted Program Installations▪
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Content File Installation

macOS

Easy Deployment

Recommended easy installation:

Using the volume installer to install on an individual computer:

You can use the provided MSI Command Line Options for guidance. If you need additional information, refer 
to Microsoft’s mass installation documentation and command line documentation.

Early versions  of EndNote always installed all predefined content files (output styles, import filters, and 
connection files). These number in the thousands, and when they are all installed they can affect the speed 
and performance of EndNote. In EndNote , a typical installation includes only the most popular styles, filters, 
and connection files. If you do not know what subset of files are required by your users, you may want to 
install all files. You can do this by setting the property "INSTALLALLCONTENTFILES" to "yes." See 
Installing All Content Files.

Because of macOS security requirements, users cannot create a site installer for EndNote. When you 
purchase a volume/site license, Clarivate will  provide a site installer for your institution. If you have any 
questions, please contact your sales representative.

Note: For updated information and instructions with screenshots, see the knowledge base article 
EndNote: Volume License Install Steps.

With the volume/site license version of EndNote, a network administrator can use mass installation to install 
EndNote on multiple machines.

First, unlock the installer to generate an EN20Inst.msi file and a License.dat file. See Unlocking the 
Volume/Site License Installer.

1.

Deploy the EN20Inst.msi and License.dat files together. You can deploy in any way you want, but 
make sure the two files are in the same directory when executed. You could zip the two files to 
distribute them to end users, you could create a Group Policy deployment where both files are 
delivered to the same location on the target machine, or you could drop the two files in a shared 
network location from which users execute the installer.

2.

Note: If the files are deployed in a zipped file, the user will need to extract the files before installing 
EndNote. The installation will not work correctly if run from a zipped file.

First, unlock the installer to generate an EN20Inst.msi file and a License.dat file. See  Unlocking the 
Volume/Site License Installer.

1.

Distribute both the EN20Inst.msi and License.dat files to the user. For example, you can copy them 
to a shared network drive.

2.

The user should then copy the two files, EN20Inst.msi and license.dat to the same folder on his/her 
individual computer.

3.

Page 551 of 586

 

https://endnote.com/msi


Clarivate EndNote 20 User Help Guide

Deploying the EndNote Installer with Group Policy

New Installations

Upgrade Installations

The user should log on to the computer with administrative rights, and then run EN20Inst.msi to 
install the EndNote program. See A Typical Installation.

4.

Before you begin:

Make sure all workstations are using MSI 3.0 or later. If needed, you can download an update from 
Microsoft.

▪

Make sure the share that EndNote is being deployed from is published in Active Directory.▪

Make sure the computer account has permission to access the share.▪

Note: This software has not been tested with the Windows Distributed Filing System (DFS)

Note: By default, only the most popular output styles, import filters, and connection files are installed with 
EndNote. This speeds up performance. However, if you want to install all of the available content files 
(thousands), you can create a new Transform and set the INSTALLCONTENTFILES property to "yes". 
See Installing All Content Files.

To deploy across an organization with Group Policy:

First, unlock the installer to generate an EN20Inst.msi file and a License.dat file. See Unlocking the 
Volume/Site License Installer.

1.

Open the Group Policy for the Domain or Organizational Unit (OU) you want to modify.2.

Under Computer Configuration, expand Software Settings and click Software Installation.3.

Right-click Software Installation and select New > Package.4.

Browse for the share from which EN20Inst.msi will be deployed. (Make sure the required license.dat 
file is in the same folder.)

5.

In the Deploy Software dialog, you may select either Assigned or Advanced if you wish to modify the 
advanced settings. See the appropriate Microsoft help file for help on configuring the advanced 
options. 
 
Once the Group Policy is updated and the clients are restarted, EndNote is installed upon boot.

6.

(Optional)  For each user account, you can configure EndNote as the default citation manager in 
Word.

7.

To upgrade your current installations:

First, unlock the installer to generate an EN20Inst.msi file and a License.dat file. See Unlocking the 
Volume/Site License Installer.

1.
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Scripted Program Installations

Open the Group Policy for the Domain or Organizational Unit (OU) you want to modify.2.

Under Computer Configuration, expand Software Settings and click Software Installation.3.

Right-click Software Installation and select New > Package.4.

Browse for the share from which EN20Inst.msi will be deployed. (Make sure the required License.dat 
file is in the same folder.)

5.

In the Deploy Software dialog, select Advanced and then click on the Upgrade tab. 
 
Once the Group Policy is updated and the clients are restarted, EndNote is installed upon boot.

6.

(Optional)  For each user account, you can configure EndNote as the default citation manager in 
Word.

7.

An EN20Inst.msi file is available for download.

To install via a command line:

First, run the installer in Admin mode (/a on the command line).1.

Install EN20Inst.msi from the target directory. (Make sure the required License.dat file is in the same 
directory.)

2.

Use the provided MSI Command Line Options table for guidance. If you need additional information, refer to 
Microsoft’s mass installation documentation and command line documentation.
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MSI Command Line Options

Option Parameters Description

/I Package\ProductCode Installs or configures a product.

/f [p|o|e|d|c|a|u|m|s|v]  
Package\ProductCode

Repairs a product. This option ignores any 
property values entered on the command line. 
the default argument list for this option is 
"pecms. This option shares the same argument 
list as the REINSTALLMODE property.  
p — Reinstalls only if file is missing.  
o — Reinstalls if file is missing or an older 
version is installed.  
e — Reinstalls if file is missing or an equal or 
older version is installed.  
d — Reinstalls if file is missing or a different 
version is installed.  
c — Reinstalls if file is missing or the stored 
checksum does not match the calculated value. 
Only repairs files that have 
msidbFileAttributesChecksum in the 
Attributes column of the File table.  
a — Forces all files to be reinstalled.  
u — Rewrites all required user-specific registry 
entries.  
m — Rewrites all required computer -specific 
registry entries.  
s — Overwrites all existing shortcuts.  
v — Runs from source and recaches the local 
package. Do not use the reinstall option for the 
first installation of an application or feature.

/a Package Administrative installation option. Installs a 
product on the network.

/x Package\ProductCode Uninstalls a product.

/j [u|m]Package  
or  
[u|m]Package/  
or  
[u|m]Package/

Advertises a product. This option ignores any 
property values entered on the command line.  
u — Advertises to the current user.  
m — Advertises to all users of machine.  
g — Language identifier.  
t — Applies transform to advertised package.
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Option Parameters Description

/l [i|w|e|a|r|u|c|m|o|p|v|x|+|!] Specifies path to log file. Flags indicate which 
information to log.  
i — Status messages.  
w — Nonfatal warnings.  
e — All error messages.  
a — Start up of actions.  
r — Action-specific records.  
u — User requests.  
c — Initial UI parameters  
m — Out-of-memory or fatal exit information.  
o — Out-of-disk-space messages.  
p — Terminal properties.  
v — Verbose output.  
x — Extra debugging information. Only available 
on Windows Server 2003.  
+ — Append to existing file.  
! — Flush each line to the log.  
"*" — Wildcard, log all information except for the 
v and x options. To include the v and x options, 
specify "/ l*vx".

/m filename Generates an SMS status . mif file. Must be 
used with either the install (-i), remove (-x), 
administrative installation (- a_, or reinstall (- f) 
options. The ISMIF32.DLL is installed as part of 
SMS and must be on the path.  
The fields of the status mif file are filled with the 
following information:  
Manufacturer — Author  
Product — Revision Number  
Version — Subject  
Locale — Template  
Serial Number — not set  
Installation — set by ISMIF32.DLL to "DateTime  
InstallStatus — Success or Failed  
Description — Error messages in the following 
order:    
1) Error messages generated by installer.    
2) Resource from Msi.dll if installation could not 
commence or user exit.  
3) System error message file.  
4) Formatted message: "Installer error %i", 
where %i is error returned from Msi.dll.

/p PatchPackage[;patchPackage2...] Applies a patch. To apply a patch to an installed 
administrative image you must combine options 
as follows:  
/p <PatchPackage>[;patchPackage2...] /a 
<Package>
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Option Parameters Description

/q n|b|r|f Sets User interface level.  
q,  
qb — Basic  
qr — Reduced  
qf — Full  
qn+ — No  
qb+ — Basic  
qb- — Basic  
Note that the ! option is available with Windows 
Installer version 2.0 and works only with basic 
UI. It is not valid with full UI.

/? or /h   Displays copyright information for Windows 
Installer.

/y Module Calls the system API  
This option is used only for registry information 
that cannot be added using the registry tables of 
the .msi file.

/z Module Calls the system API  
This option is used only for registry information 
that cannot be removed using the registry tables 
of the .msi file.

/c   Advertises a new instance of the product. Must 
be used in conjunction with /t.

/n ProductCode Specifies a particular instance of the product. 
Used to identify an instance installed using the 
multiple instance support through a product 
code changing transforms.

Changing the Default Content File Location
Content files include output styles, filters, and connection files. These are typically installed in the EndNote 
program folder. For example

C:\Program Files (x86)\EndNote 20\Styles 
C:\Program Files (x86)\EndNote 20\Filters 
C:\Program Files (x86)\EndNote 20\Connections

However, you may want to install the default content files in a folder other than the EndNote program folder. 
You may want to use a common, shared folder for all users in your organization.

Note: Remember that EndNote compiles style, filter, and connection file lists from both the default 
installation folder and a user’s personal content folders. For information about setting a personal folder 
location, see Folder Locations Preferences.

Below is a method that an administrator could use to run the installer and tell EndNote to relocate the "main" 
content file locations. If the Styles, Filters, and Connections folders are located at D:\Shared\Content\, then 
that path should be used for CFDIR.
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Method 1: Specify a Custom Folder Path via Command Line

Method 2: Specify a Custom Folder Path via Transform

Installing All Content Files

Method 1: Change the Setting via Command Line

Method 2: Change the Setting via Transform

This method will work for most users, who install EndNote by launching the installer. To install EndNote with 
a custom content file folder setting:

For EXE installations:

EN20Inst.exe CFDIR=”< path_to_content_folders>”

For MSI installations:

msiexec.exe /I EN20Inst.msi CFDIR=”< path_to_content_folders>”

This method is for site system administrators, who want the end user to install or deploy the application 
without the user changing settings.

Update the value of the “CFDIR” property in the Property table, save the transform, and create the group 
policy object to deploy the installer with the transform. (See the transform documentation for the tool you are 
using, such as Orca).

Content files include output styles, filters, and connection files. Earlier releases of EndNote installed all 
available content files. The number of predefined content files is now in the thousands, and may adversely 
affect the speed and performance of EndNote. Your users, however, may prefer to have access to all files.

Note: You can combine this command along with changing the default  content file path. See Changing 
the Default Content File Location.

This method will work for most users, who install EndNote by launching the installer. To install all content 
files with EndNote:

For EXE installations:

EN20Inst.exe INSTALLALLCONTENTFILES=yes

For MSI installations:

msiexec.exe /I EN20Inst.msi INSTALLALLCONTENTFILES=yes

This method is for site system administrators, who want the end user to install or deploy the application 
without the user changing settings.  
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Setting Local Find Full Text Preferences

FFTUSEISILINKS= Use “T” or “F” to select or deselect the “Web of 
Science Full Text Links” check box.

FFTUSEDOI= Use “T” or “F” to select or deselect the "DOI" check 
box.

FFTUSEPUBMED= Use “T” or “F” to select or deselect the “PubMed 
LinkOut” check box.

FFTUSEOPENURL= Use “T” or “F” to select or deselect the “OpenURL” 
check box.

FFTOPENURLRESOLVER= Enter a URL for the “OpenURL Path” text box.

FFTAUTHENTICATEURL= Enter a URL for the “Authenticate with URL” text 
box.

Change the value of the “INSTALLALLCONTENTFILES” property to "yes" in the Property table, save the 
transform, and create the group policy object to deploy the installer with the transform. (See the transform 
documentation for the tool you are using, such as Orca.)

You can globally set the values for the Find Full Text panel under EndNote Preferences.

Just as we show under Changing the Default Content File Location and Installing All Content Files, you can 
do this via command line or by changing the setting via transform. These options are available:

Page 558 of 586

 



Clarivate EndNote 20 User Help Guide

Appendices

About Direct Export and Import Formats

Copyright Issues and Fair Use of Downloaded Data

EndNote gives you the capability to import references downloaded from online 
databases into its libraries. Some producers of online reference databases expressly 
prohibit such use and storage of their data, others charge an extra fee for a license to 
use the data in this way. Before you download references from a database, be sure to 
carefully check the copyright and fair use notices for the database. Note that different 
databases may have varying restrictions, even from the same information provider.

Direct Export Providers

What do we mean by "direct export" and "import formats"?

Direct Export: The information provider  includes an option to save directly to EndNote. When you select 
this option, EndNote automatically looks for the appropriate filter in your EndNote Filters folder. You direct 
the references to the appropriate EndNote library. How well the information transfers depends on how 
accurately the information provider has tagged each item of bibliographic information.

Note: UTF-8 (Unicode) is the default  character encoding for text, XML, and HTML export from the 
product. RTF uses ASCII encoding for ASCII characters and "code page escapes" to encode characters 
beyond ASCII.

Importing: When an information provider does not provide direct export to EndNote, the process of 
importing references becomes a little more complicated. You must save references from the information 
provider to a text file in a tagged format. Then, in EndNote, you must use the File > Import feature to select 
the tagged text file for import, choose the appropriate import filter, and then start the import process. 
See Importing Text Files for more information.

You also have another option for copying references into your EndNote libraries. See How to Search an 
Online Database for information about directly searching and downloading from various online databases.

Many information providers have websites that include a direct export option, allowing you to send copies of 
references directly to an EndNote library. The direct export process automatically selects an EndNote import 
filter  to map bibliographic information into the appropriate EndNote fields. All you need to do is select the 
EndNote library into which the data should be imported.

Start by opening the EndNote library into which the data should be imported. This "direct export" or "direct 
download" method does away with the additional steps of saving the references to a text file, and then 
importing that file with the appropriate import filter.

in some cases, you may be required to select an appropriate filter. When the direct export process is 
started, EndNote first checks the file for tags that are specific to a common import type, such as the 
EndNote desktop, Web of Science™ Core Collection, or RIS format. If no match is found, EndNote searches 
through all filters for a vendor ID and database ID that match the file. If no match is found, you are prompted 
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Enabling Direct Export

Setting Firefox to Open Direct Export Files in EndNote

to select a filter. You can also check our Web site at https://endnote.com/downloads/filters/ for 
updated import filters.

Contact your data provider if  you have questions about whether their database supports direct 
export. Clarivate makes information on how to set up databases to work with direct export publicly available, 
so database providers can set their databases to work with direct export without our involvement. This 
means we cannot keep track of all the providers supporting this feature.

Note: Because of the way some browsers handle MIME types, they may try to save your references to a 
file on your desktop. You may need to use Mozilla Firefox to access the Web site and export references 
into EndNote. This application allows you to specify how to handle data when you initiate a direct export, 
so you can select the EndNote application. See Enabling Direct Export for  information on configuring 
Firefox and Google Chrome to send Direct Export files to EndNote.

EndNote's Direct Export feature allows certain file types to be associated with the EndNote application. 
When a direct export file is sent from a browser to EndNote, EndNote can recognize the filter that should be 
used to import the references, and import them automatically.

If you find that some Direct Export files that should be automatically sent to EndNote are not being sent, you 
may be able to make adjustments to how those file types are handled by the browser or operating system.

Note: Changing settings to enable Direct Export will only work consistently with file types that were 
designed for Direct Export. Changing settings for other file types, such as plain text files, can cause 
problems and is strongly discouraged.

Firefox allows you to set the option to send files to EndNote within the program. The first time it downloads a 
file with a file type it does not recognize, it will show a window similar to the one below, asking what to do 
with the file. Choose the option to Open with ResearchSoft Direct Export Helper and mark the box to Do this 
automatically for files like this from now on. In the future, Firefox should send files of this type directly to 
EndNote. (The .nbib file type below is an example of the PubMed direct export format.)
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Setting Chrome to Open Direct Export Files in EndNote

If, in the past, Firefox was instructed to save this file type instead of sending it to EndNote, you can change 
that in the settings.

In Firefox, navigate to Settings > General > Applications.1.

Locate the Direct Export file type by the extension shown in the left column.2.

In the right column for the extension, select Use other…  and select ResearchSoft Direct Export 
Helper from the list.

3.

Close the Firefox settings to save your change.4.

Google Chrome allows you to set the option to send files to EndNote within the program when the file is 
downloaded. Click on the drop-down list arrow to the right of the file name. (This can be found in the bottom- 
left corner of the window.) Select the option to Always open files of this type, then select the ResearchSoft 
Direct Export Helper as the program to open the file with, if asked.

The next time you use Google Chrome to download a file with that extension, it should automatically open in 
EndNote.
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Windows 10/11 to Open Direct Export Files in EndNote

File Extensions Associated with Direct Export

APIs and Plug-ins

Browsers other than Firefox, such as Chrome, may use the Windows settings for where to open file types. If 
the file does not automatically import into EndNote, you may be able to set Windows to recognize Direct 
Export file types and send them to EndNote.

Navigate to Windows Setting by clicking Start > Settings.1.

Select Apps from the list.2.

Select Default Apps at the left, then Choose default apps by file type at the right.3.

Scroll down the list on the left until you see the file extension you want to send to EndNote, then 
select ResearchSoft Direct Export Helper to the right.

4.

Note: These instructions worked at the time of this writing, but browsers and operating systems change 
over time. You may need to adapt these instructions to your present browser and operating system. Do 
not attempt to send files that are not appropriate for Direct Export, such as .txt files, to EndNote.

At the time of the EndNote 20 release,  these were the file type extensions EndNote will automatically 
associate with direct export:

.CIW▪

.ENW▪

.RIS▪

.NBIB▪

.OVD▪

Note: This list does not mean that only these file types will work with direct export, but that these files can 
be expected to work reliably with direct export.

The RSServices API is technology from Clarivate that provides a way to build on the power of EndNote. It 
exposes programmatic access to the core functionality of the EndNote application, allowing third parties to 
access database content and integrate EndNote with other tools. With the RSServices API users can create 
“plug-ins”  that work within the EndNote interface to add customized functionality to EndNote and extend 
connectivity with other programs. Most of the RSServices API functions work with EndNote versions X and 
later.

The basic functions of the API enable users to:

Build plug-ins that add new functionality to EndNote.▪

Provide better integration with third-party tools and products.▪
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The RSServices Development Kit (RDK)

Backing Up Your EndNote Files

Create tools that extend the GUI of EndNote.▪

Script or batch existing EndNote capabilities and features.▪

Directly access records and data in EndNote Libraries (databases).▪

Leverage the power of the EndNote formatting engine (Formatter).▪

Directly Import or Export into or out of EndNote.▪

The RSServices API is intended for technical audiences who have knowledge of object-oriented 
programming languages, particularly C and C++. Users should also be familiar with the tools needed to 
produce compiled application code or DLLs. The API is available for both the Macintosh and Windows 
operating systems and behaves identically on each, unless otherwise specified.

Individual customers and third-party partners are encouraged to use the RSServices API to develop tools 
that closely interact with EndNote. Users are also encouraged to share their code and ideas with others on 
the EndNote User Forums at:

https://community.endnote.com

While individuals are welcome to use and share their work with others, any party developing a component or 
tool that uses the RSServices API for commercial or wide-spread use must also sign a license agreement 
with Clarivate to legally employ the API, RDK and any associated tools, documentation, or code.

Supporting documentation and code samples are provided as part of the RSServices Development Kit 
(RDK), the RDK is available by request directly from the Clarivate EndNote team. The RDK is designed to 
work with several compilers and tools, including Apple's XCode and Microsoft's Visual Studio. In all cases, 
APIs are published in the C/C++ programming language, as are all samples and example code. It is 
assumed that the reader has a validly licensed copy of one or more of the aforementioned compilation 
products, as Clarivate does not supply or warrant such tools as part of the RDK. While it should be possible 
to port these interfaces to additional compilers or programming languages, readers should consult their 
license agreement or the Clarivate EndNote team before doing so.

Contact the Clarivate EndNote team at http://endnote.com//support/contact-support for more information.

We strongly recommend that you keep several backup copies of your critical computer files, especially your 
EndNote libraries and papers that you are writing. There are many ways that a file can be damaged: hard 
disks can fail, viruses can erase or corrupt files, and, of course, there is always human error and the 
possibility of accidentally throwing away your thesis or grant proposal the day before it is due. If you have 
any kind of disaster, big or little, backup copies can save you hours or days of work.

The simplest way to make a backup is to use  File Explorer  to copy your files to a thumb drive or other 
portable storage device. This will work for your EndNote libraries until they are too large to fit on one of 
these.
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EndNote Sync as a Backup

Backup Suggestions

Important Files to Back Up

Saving and Restoring Compressed Libraries

Creating a Compressed Library File

The Sync Feature provides a backup of your current library. If you accidentally delete your library files, you 
can sync your online library to a new empty desktop library and be working again in no time.

However, if you have deleted references from your library and emptied the trash, they will also be deleted 
from the online copy of the library; if you have accidentally deleted references from the online library and 
emptied the trash, they would also be deleted from the desktop library at the next sync. Making a backup of 
your library at regular intervals ensures you have access to older material, if you ever need it.

Keep at least two sets of backup disks, each at a different location. We recommend that you have sets for 
alternate days, so if you discover that something went wrong yesterday, you will have the day-before- 
yesterday’s version.

Make archival sets of all the files used when you finish an important document. An archival set should 
include all of the files that are needed to recreate a final formatted paper. Label the backup disks, lock them 
and keep them in a safe place far away from your computer (preferably off-site). If you ever need to recreate 
the document, you will have all of the necessary files.

See Important Files to Backup for more information about this topic.

Note: Although working EndNote libraries should not be kept in cloud folders or drives, a compressed 
library can safely be stored in the cloud because it is a single file. Be sure to move or copy the 
compressed library to your hard drive before opening it. See Saving a Compressed Copy of a Library.

This topic lists the important EndNote files to backup. You may want to start by backing up the EndNote 
installer.

The library  files ([filename].enl and its matching .Data folder) are where all of your references are stored. 
Note that exporting data from your library is not a backup. An export file is just a text document, whereas an 
EndNote library is a database.

If you saved your library as a package, the .enl file and .Data folder are part of the library package with the 
extension .enlp.

You can save an EndNote library (the [filename].enl file, its associated .Data folder, and all of its contents) to 
a single compressed file called [filename].enlx in order to back up your library or send a copy to a colleague. 
Later, you can restore the compressed library with EndNote. See below or see Saving a Compressed Copy 
of a Library.

Open the library in EndNote.1.
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Restoring a Compressed Library File

From the File menu, select Compress Library (.enlx) to display a Compressed Library dialog.2.

Use the radio buttons to determine these options:3.

Specify whether you want to Create a compressed library or to Create & Email the library.▪

Specify whether you want to save file attachments with the library or not.▪

Specify whether you want to save all references to the compressed library, only the selected 
(highlighted) references, or only the references in a specific group or group set.

▪

Click Next to display a file dialog.▪

Save the compressed library (the default name is [original_file_name].enlx) to a folder on your hard 
drive. You can change the file name but you cannot use the following characters.

4.

Invalid Characters for Naming 
a Compressed Library

\  back slash
/  forward slash
:  colon
*  asterisk
?  question mark
"  quotation mark
<  less than
>  greater than
|  vertical bar

If you selected the Create & Email option, EndNote will launch the Outlook application, create a new 
email, and attach the compressed library file to the email.

5.

Enter additional information to the email, such as a recipient, subject, and message. Click the Send 
button.

6.

Use EndNote to open the filename.enlx file by selecting Open Library  from the File  menu, then 
selecting the .enlx file. This will extract the .enl file and the .Data folder to the same folder where the. 
enlx file is located.

1.

Use EndNote to open the [filename].enl file as you normally would to use the library.2.

Note: EndNote libraries larger than 4 gigabytes or 65,535 files cannot be compressed with EndNote’s 
Compressed Library command. See Saving a Copy of a Library for information on making backup copies 
of larger libraries.
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Custom Reference Types

Backup a Reference Types Table

Importing a Reference Types Table

Modified Styles, Filters, and Connection Files

The current reference types table  controls the reference types and fields available to all libraries opened 
under the current user account. It controls the reference types and fields available to styles, filters, and 
connection files, so it affects importing data and formatting documents.

If you have customized your reference types, losing your reference types table will lose all your 
customizations.

From the Edit menu, select Preferences.1.

Click the Reference Types option in the list of preferences.2.

Under Reference Type Table, click Export to display the Save As dialog.3.

Name the file, select a folder where you will be able to find it later, and click Save. EndNote will 
append an .xml suffix to the file name.

4.

You now have a backup of your Reference Types Table.

Note:  When you import a Reference Type Table, you will overwrite the entire contents of your current 
Reference Type Table, losing any customizations you have made to your reference types. We suggest 
creating a backup of your current Reference Type Table  before importing a new table, using the 
instructions above.

From the Edit menu, select Preferences.1.

Click the Reference Types option in the list of preferences.2.

Under Reference Type Table, click Import to display a file dialog.3.

In the file dialog, locate, highlight, and open the .xml file that was previously exported.4.

Modified styles are important to backup so that you do not have to recreate the bibliographic format if 
something happens to your customized style. Similarly, custom filters and connection files should be backed 
up so that you do not have to redo the work to get your references to import as you want them.

When you display a list of styles, filters, or connection files, the list is compiled from both the default 
installation folders as well as your personal folders.

The default Styles, Connections, and Filters folders are installed in the EndNote program folder, and are 
typically found at—

C:\Program Files (x86)\EndNote 20\Styles 
C:\Program Files (x86)\EndNote 20\Filters 
C:\Program Files (x86)\EndNote 20\Connections 
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Word Processing Documents

EndNote Preferences

Menu Keyboard Commands

If you have not modified these files, it is not important to make backups of them because you can always 
reinstall them with the EndNote Installer.

Once you make a change to one of these files, or create a new file, it is saved to your personal Styles, 
Filters, or Connections folder. These folders are typically found at—

C:\Users\[User Folder]\Documents\EndNote\Styles 
C:\Users\[User Folder]\Documents\EndNote\Filters 
C:\Users\[User Folder]\Documents\EndNote\Connections 

You can change the location of your personal folders with Folder preferences. To locate or change your 
personal Folder locations, see Folder Locations Preferences.

The papers you have written that include EndNote citations should be kept with your EndNote backup files.

If you have customized your sorting preferences, copy the following file:   C:\Users\[Your Folder] 
\AppData\Roaming\EndNote\ENSort.txt file.

If you have customized your change case preferences, copy the following file:  C:\Users\[Your Folder] 
\AppData\Roaming\EndNote\ENCase.txt file.

The EndNote menus display equivalent key commands next to many menu commands, so you can execute 
commands without taking your hands off the keyboard to use a mouse. You can use the following tables as 
a quick reference.

All commands are not always available to you. For example, if no references are highlighted in the Library 
window, the Edit References and Move References to Trash commands are not available from the 
References menu.

These tables list only those commands with a keyboard equivalent. Not all menu commands have a 
corresponding keystroke.
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File Menu Commands

Menu Command Key Command

Open Library Ctrl+O

Open Shared Library Ctrl+Shift+O

Close Ctrl+W

Save Ctrl+S

Print Ctrl+P

Exit Ctrl+Q

Edit Menu Commands

Menu Command Key Command

Undo Ctrl+Z

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Paste with Text Styles Ctrl+Shift+V

Select All Ctrl+A

Font: Plain Font Ctrl+L

Style: Plain Ctrl+T

Style: Bold Ctrl+B

Style: Italic Ctrl+I

Style: Underline Ctrl+U

Style: Superscript Ctrl++

Style: Subscript Ctrl+‒
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References Menu Commands

Menu Command Key Command

New Reference Ctrl+N

Edit References Ctrl+E

Copy Formatted Reference Ctrl+K

Move References to Trash Ctrl+D

File Attachments: 
     Attach File 
     Open with Preview 
     Save As…

 
Ctrl+Alt+A 
Ctrl+Alt+P 
Ctrl+Shift+S

Library Menu Commands

Menu Command Key Command

Simple/Advanced Search Ctrl+Alt+F

Define Term Lists Ctrl+4

Link Term Lists Ctrl+3

Spell Check Ctrl+Y

Find and Replace Ctrl+R

Tools > Cite While You Write Menu Commands

Menu Command Key Command

Go to Word Processor Alt+1

Insert Selected Citation(s) Alt+2

Format Bibliography… Alt+3

Import Traveling Library… Alt+8

CWYW Preferences Alt+9
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Window Menu Commands

Menu Command Key Command

Previous Pane Shift+F6

Next Pane F6

Previous Tab Ctrl+Shift+Tab

Next Tab Ctrl+Tab

Close All Libraries Ctrl+Shift+W

Editing Keyboard Commands

Action Key Command

Create a new reference Ctrl+N

Select more than one reference Ctrl+Click

Select a range of references Shift+Click

Go to Reference Edit panel Ctrl+E

Switch between active library windows Alt+Tab

Close the active library window Ctrl+W

Close all library windows of the same type as the active 
library window Ctrl+Shift+W

Select the next field Tab

Select the previous field Shift+Tab

When the cursor is in a field linked to a term list, such as 
Author, Journal, or Keywords, display the appropriate term 
list for term selection

Ctrl+1

 

A full set of key commands is available so that you can enter references without using the mouse. For 
example, to create and enter a new reference without touching the mouse, type Ctrl+N  to add a new 
reference, type the bibliographic information using Tab or Shift+Tab to move forward or backward between 
the fields.
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Commands When Working with Text

Action When Entering Text Key Command

Undo the previous command Ctrl+Z

Cut selected text and put it on the clipboard Ctrl+X

Copy selected text and put it on the clipboard Ctrl+C

Paste text from the clipboard at the insertion point Ctrl+V

Select all text in a field Ctrl+A

Check spelling Ctrl+Y

Set the text style to Plain Ctrl+T

Turn bold on or off Ctrl+B

Turn italic on or off Ctrl+I

Turn underline on or off Ctrl+U

Troubleshooting EndNote

Common Issues

Other Troubleshooting Help Topics

Use the Arrow keys to navigate within a field.

For documentation updates and correction notes, refer to the Readme.txt file installed in the 
EndNote folder.

▪

For late-breaking news and updates, go to the EndNote Support page.▪

See these topics for information on these issues:

Special Characters.▪

Direct Export doesn't open the file in EndNote.▪

The EndNote Library is Corrupted.▪

Cannot Save a Style, Filter, or Connection File on Windows.▪

For help topics that are specific to Cite While You Write, go to Troubleshooting Cite While You Write.▪

For help topics that are specific to online connections, go to Troubleshooting Connections.▪

A few common issues are discussed below.
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The EndNote Library is Corrupted

Cannot Save a Style, Filter, or Connection File on 
Windows

Any time you feel your library may be corrupted:

Back up the library. Do not replace any previous backup copies, just in case you need them!1.

From the Library menu, run the Recover Library  operation to rebuild the library. See Recovering a 
Damaged Library for more information about this command.

2.

The two most frequent causes of library corruption are—

Storing a library in a cloud-syncing folder or drive. Applications like Google Drive, iCloud, 
OneDrive, Box, Dropbox, etc. do a very good job of synchronizing individual files, but EndNote 
libraries are not just a single file. They are a combination of files working together. When you make 
changes in a record, you may affect more than one file, and those files must be updated in a set 
sequence. Synchronization applications do not always update the files in the correct sequence, 
which causes small errors that can eventually lead to corruption. So, do not store your working 
EndNote libraries in any syncing folder. 
 
A compressed library can be stored in a cloud-syncing folder or drive for archival purposes because 
it is a single file. However, it should be moved or copied to a nonsyncing location on your hard drive 
before opening it or using it.

1.

Storing a library on a network drive. Read-Write libraries should not be stored on network drives, 
to avoid corruption. If you need to share a library on a network drive, it should be a read-only copy of 
the library and the original library should be maintained on a computer hard drive. See Multiple 
People Opening One Library for information on using a read-only library on a network.

2.

You have edited a content file (a style, filter, or connection file), but when you try to save the file you cannot 
choose Save, but must choose Save As to save a copy.

The styles, filters, and connection files provided with EndNote are installed in the Styles, Filters, and 
Connections folders, which are typically located in the EndNote program folder:

C:\Program Files (x86)\EndNote20\Styles 
C:\Program Files (x86)\EndNote20\Filters 
C:\Program Files (x86)\EndNote20\Connections

However, when you create a new file, or modify one of the installed files, the file is saved in one of your 
personal folders. This aligns with Windows security measures to protect the contents of the program folders. 
By default, your personal folders are set to:

Windows 10 and 11 
 
C:\ Users\User Name\ Documents\EndNote\Styles 
C:\ Users\User Name\ Documents\EndNote\Filters 
C:\ Users\User Name\ Documents\EndNote\Connections
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Commands are Dimmed and Not Available

Opening EndNote 20 Libraries in an Earlier Version of 
EndNote

Forward Compatibility to EndNote X9.3 and Later

Backward Compatibility with Earlier EndNote Versions

When you display a list of files in EndNote, the list is compiled from both folder locations: the installation 
folders found in the EndNote program folder, plus your personal folders. For more information about these 
folder locations, and how to change them, see Folder Locations Preferences.

To make a modified file available to other EndNote users:

Create the modified file and save it in your personal folder.1.

Place a copy of the file in a shared location, or email it to your colleagues.2.

Have the colleague double-click on the file to open it in EndNote, then use the File  > Save As 
command to save a copy of the file to their personal folder. The advantage of putting the file in a 
personal folder is that it will not be removed if EndNote is uninstalled or overwritten if a style of the 
same name is installed by EndNote.

3.

Commands may be dimmed depending upon which part of the window is active. For example, if no text is 
selected in an Reference Edit panel, the Font options under the Edit menu would be dimmed because there 
would be no selected text to apply font changes to.

EndNote X9.3 introduced a new database engine. Libraries created in EndNote X9.3 or later are not 
backwardly compatible with older versions of EndNote. If you work in an environment with multiple versions 
of EndNote, you can convert your libraries to the new database engine using the instructions below.

To use libraries created with EndNote X9.2 and earlier, convert the library by opening it in EndNote X9.3 or 
later. To do this, in EndNote X9.3 or later select File > Open Library, and then select the old EndNote library 
file you wish to convert. EndNote X9.3 or later will create a new library and leave the original library 
unchanged.

If you are not already syncing an EndNote library, using EndNote Sync would be the easiest way to access 
the library on a machine with an older version of EndNote. (If you are already syncing a library, syncing 
another library would merge the libraries. See Merging Libraries through Sync.) 
 
If you choose to sync the library, create a new empty library  in the older version of EndNote, then enable 
EndNote Sync with that library open as the active library. See The Sync Feature for information on syncing a 
library for the first time. You would be able to use the library on both computers and have your changes sync 
back and forth between the versions.

Note: When syncing libraries, record numbers will be different on the different computers. See Record 
Numbers for more information.
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Exporting the Data for Import to an Older Version of EndNote

Compatibility Issues

Sharing Libraries with Users of Older Versions of EndNote

Troubleshooting Connections

EndNote X9.3 and later libraries are not backward compatible with previous versions. To use EndNote X9.3 
and later libraries with an older version of EndNote without using Sync:

Export the EndNote X9.3 or later library to a XML file (.xml) by changing the File Type during 
export. See Exporting to EndNote XML for details.

1.

In the older version of EndNote, select Import > File from the File menu2.

In the Import dialog, click Choose. Locate and select the filename.xml to be imported.3.

Select EndNote Generated XML as the Import Option.4.

Set the Duplicates option to match your preferences.5.

Import All: Imports all references, including duplicates.▪

Discard Duplicates: Imports all references except duplicates.▪

Import into Duplicates Library: Duplicate references are imported into a library called File- 
Dupl.enl, where ”File" is the name of the library into which you are importing.

▪

By default, a reference is considered a duplicate when the Author, Year, Title, and Reference Type 
match a reference already in the library. See Duplicates Preferences if you would like to change the 
duplicates criteria.

Set the Text Translation to No Translation and then click on Import.6.

The older version of EndNote will not import any groups from the EndNote X9.3 or  later version of the 
library.

In order to have access to the file attachments the PDF subfolder of the EndNote X9.3 or later version of the 
library would need to be added to the new library created from the imported references.

Because Library Sharing works through EndNote Sync, it will allow libraries created with EndNote 20 and 
EndNote X9 to be shared with users  of older versions who have created EndNote online accounts with 
those older versions.

When connecting with an online database, there are at least two computers involved in completing the tasks 
you wish to perform: yours and the database server. Most often, there are intermediary computers as well, 
such as Domain Name Servers ( DNS), proxy servers, and firewalls. With more than just your computer 
involved, things can get complicated.

The most basic problem you can encounter with connections is the failure to connect at all. There are four 
ways you may experience this problem:
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Problems Connecting to the Internet

Dial-up Connections

Problems Finding the Host

Problems Connecting

EndNote cannot connect to the Internet (see Problems Connecting to the Internet)▪

EndNote cannot find the host (see Problems Finding the Host)▪

EndNote cannot connect to the host (see Problems Connecting)▪

EndNote cannot communicate with the host (see Problems Communicating with the Host)▪

In general, if you are able to use a Web browser or other Internet software, you should also be able to 
connect with EndNote. Try using your Web browser to make sure your Internet connection is working.

Your computer system includes software to connect to the Internet through a modem connected to your 
telephone line. You need to set up the dial-up connections software in order to connect with your Internet 
provider.

In most cases, trying to connect in EndNote will start up your dial up software automatically. Some 
networking packages require that you establish the dial-up connection manually before trying to connect in 
EndNote.

There are a few possibilities for what could be wrong if EndNote cannot find the host server:

The domain name specified in the connection file is wrong.▪

There may be a problem with your network's Domain Name Server.▪

If the connection file has worked in the past, the problem may lie with the Domain Name Server. If you have 
just made the connection file yourself and it’s never worked before, you probably entered the wrong Server 
Address.

If you suspect problems with the Domain Name Server, contact your network administrator.

Once the host is found, EndNote tries to connect. It sends a connection request to the host and waits for up 
to two minutes for a reply. It may receive none, or it may receive a refusal immediately. In the first case you 
will see a time-out error message, and in the second case you will see a "host refused connection" error 
message.

If you wait for two minutes and receive a time-out message, the online computer is probably down for some 
reason. Try again later.

If you receive a refusal message, and this happens no matter which connection file you try to use, you are 
most likely behind a firewall.
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Firewalls

Proxy Servers

Finding the Server Address and Port

Communicating with Local Database Servers or Gateways

Your system may be configured with a firewall to block certain ports. To connect to a database from behind a 
firewall, you must ask your network administrator to allow communication through the firewall for the port 
used by the online database you wish to search. You can open the connection file to find the appropriate 
server address and port number, as described below.

Depending upon the configuration of the firewall, the administrator may allow communication to all 
computers outside the firewall on the requested port, or communication to a specific server and port.

Your organization, or the online database provider, may use a proxy server to allow only valid users access 
to the organization’s network and/or database. Contact a network administrator from the organization to find 
out whether a proxy server is used.

If you already have access to the remote network with your Web browser, check the configuration of your 
Web browser. Look for "proxies" or "proxy server." (See your Web Browser documentation to locate proxy 
server settings, as the location changes depending on which version you are using.) The configuration for a 
proxy server has two pieces of information: an address and a port.

Note: EndNote  will automatically handle the proxy server when accessing http-based connections 
(PubMed and Web of Science™ Core Collection) if the proxy server settings are configured through  the 
operating system's Internet options.

Before you contact your network administrator, check the appropriate EndNote connection file for the 
address of the server and the port specified.

To obtain the server address and port:

From the Tools menu, select Connection Files, and then select Open Connection Manager.1.

Select the appropriate connection file and click Edit.2.

In the Connection File window, click the Connection Settings panel for the server address and port.3.

Depending upon the configuration of the firewall, the administrator may allow communication to all 
computers outside the firewall on the requested port, or communication to a specific server and port.

Some universities and organizations license Z39.50 databases for use on their own servers, or for access 
from a local gateway. The company providing the databases will include client software for accessing the 
databases. Some Z39.50 servers are designed to respond only to requests from this client software. In other 
cases, the server must be configured to allow requests from software other than the supplied client program.

If your organization maintains Z39.50 databases, but you are unable to connect to them with EndNote, ask 
your network administrator if the database server supports client software other than that supplied by the 
database provider.
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Problems Communicating with the Host

The Connection Error Dialog

Problems With Retrieved Data

Blank records

Asterisks in author names or titles

Once you are connected, the most common problem in communicating with a host server is a password 
problem. Check your password and user ID. Check the upper or lower case requirements. If a password is 
rejected, you will see an error message that says something like "Server has rejected initialization." See 
Access-Restricted Databases.

The password and User ID requested by the host will generally not be your personal password and ID. It is 
usually the User ID and password assigned to your institution (the rare exception to this might be if your 
institution has a local copy of the database). These institutional User IDs and passwords are usually not 
shared with individuals within an institution. However, access may be granted to anyone connecting to the 
database from an IP address within the institution. If you are off-site and cannot access a database that you 
could access when onsite, use VPN to connect to your institution's network first, then try the connection file 
again. If you do not have VPN access to your institution's network, check with your network administrator.

Connection files do not use the same ports that a browser uses, so they will usually not go through proxy 
servers.

If you are still unable to connect to the database, you may be able to access it through a Web browser, then 
import the references through direct export or by saving a text file and importing the text file. See Importing 
References Downloaded from Online Databases

When searching an online database, if there is a problem with the database, the search terms, or the 
connection file, EndNote presents an error message describing the source of the problem. The connection 
error dialog displays the original Z39.50  error message, if available, EndNote’s  translated version of that 
error, and any other message being sent directly from the server. You can find details of the communication 
between EndNote and the server in the Connection Status window (select Show Connection Status from the 
Tools menu), or in the connection log. See The Connect Log File.

If blank records appear in your reference list, it could be due to a number of causes. One thing to check is 
whether your filter  settings in the connection file  match the format of the retrieved records. Open the 
connection file and view the Templates section. Also show the Connection status window (Show Connection 
Status on the Tools menu), and set its view to show Record Data. The two formats need to match in order 
for the data to import.

Sometimes, when viewing the record data in the Connection Status window, you will notice that there is no 
bibliographic information for a reference that was retrieved. This happens sometimes where duplicate or 
blank entries remain in the online database. These can be ignored.

For some databases, diacritical characters in the author names and titles cannot be interpreted correctly 
when EndNote retrieves the references. In such cases, the diacritical characters are replaced with an 
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In exported references, extended characters appear as boxes

Errors Encountered While Retrieving References

Troubleshooting Cite While You Write

asterisk (*). A "quick fix" for this is to use the Find and Replace command in the Library menu to change the 
names with the asterisks to the name with the diacritical characters as they should be.

You may be able to permanently fix the problem by changing the Text setting in the connection file to use a 
text encoding that matches the online database. Whether this will work depends on the database you are 
connecting to. Older databases may not support special characters. See The Connection Settings.

You’ve downloaded references from an online source, and they display correctly in EndNote. But when you 
export those references to a text file, and open the file with a text reader such as NotePad, all extended 
characters (for example, umlauts) appear to be corrupted. What happened?

Your online data source likely provided each extended character as two characters – a base letter and a 
combining character –   rather  than as a single, precomposed character. For example, an extended 
character can be composed of an (a) and  then the combining umlaut character (¨) rather  than as a single 
character (ä).

Both character representations are perfectly valid, so initially there is no indication of a problem. Many 
applications, including EndNote and WordPad, can appropriately display extended characters in either form, 
but you happen to be using an application that cannot. Windows applications display a box character to 
indicate that the font or application cannot render the appropriate character.

Even though the characters do not display correctly in the current application, they are still valid. Try 
opening the file with a different application.

The adoption of Unicode  has solved this problem for many modern applications. If the characters do not 
appear properly in programs you need to work with, you may also need to install a language pack that 
supports those characters. See Working with Multiple Languages.

For various reasons, some references cause errors during retrieval. If EndNote encounters an error while 
retrieving references from an online source, it stops the retrieval process. In order to get the rest of the 
references, it is best to submit the search again, and this time request the references start downloading with 
the one after the reference which might have caused an error. For example, if the error appeared while the 
tenth reference out of fifty was being retrieved, submit the search again, and when prompted, ask only for 
references 11 through 50 to be retrieved.

EndNote typically retrieves references in batches, for speed and memory reasons. However, some servers 
are too slow, or their record data is too large, to support batch downloads. If you find that your connection 
with a service provider fails after approximately the same amount of data each time you attempt to 
download references, you can try turning off batch processing. You will need to open the connection file you 
are using, as described under Editing a Connection File, and deselect the Batch Download option described 
under The Connection Settings.

For a more extensive list of issues and updates concerning Cite While You Write, go to: https:// 
support.clarivate.com/Endnote/.

See these topics for help with common Cite While You Write issues:
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No EndNote Commands in Word or Writer

Repairing the Installation

Run the EndNote Installer to Repair the Installation

Repair the Installation from Windows Apps & Features

No EndNote Commands in Word or Writer▪

Bibliography Is in the Wrong Font▪

Word Crashes or Gives an Error When Inserting a Large Number of Citations▪

Garbled ADDIN EN.CITE Code▪

Inserted Citations Disappear, but Reference List is Created▪

EndNote commands are available in Microsoft Word 2010, 2013, 2016, 2019, or Office 365 (locally installed 
desktop version only), Apache OpenOffice Writer 3.x or 4.x, and LibreOffice 4.x–6.x (32-bit).

In Word, EndNote commands appear on an EndNote tab.▪

In Writer or LibreOffice, EndNote commands appear on an EndNote menu.▪

Before you attempt to Repair or Modify your EndNote installation in order to use Cite While You Write, you 
must make sure that your word processor is not running. Close all Microsoft Office and 
OpenOffice applications.

If you installed or upgraded your word processor after  installing EndNote, or Cite While You Write 
commands do not appear for some other reason, you can run the EndNote installation program again or 
modify the installation in the Apps & features settings.

Log in to the machine with administrative rights or as a user with program installation privileges.1.

Run the EndNote installer.2.

Select Repair, and then click Next.3.

Click Finish when the Repair has finished.4.

Log in to the machine with administrative rights or as a user with program installation privileges.1.

From the Windows Start menu, select Settings, and then select Apps.2.

Scroll down and click on the EndNote app, then click Modify.3.

Select the Repair radio button, then click Next.4.

Click Finish when the repair has finished.5.

Your entire EndNote installation is checked and repaired as needed.
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Modifying the Installation

Run the EndNote installer file to Modify the installation:

Modify the Installation from Windows Apps & Features

If you initially did a Custom install, and did not install Cite While You Write files, you need to modify your 
installation to include the appropriate files.

Log in to the machine with administrative rights or as a user with program installation privileges.1.

Run the EndNote installer.2.

Select Modify and click Next.3.

Make sure that the appropriate item is selected for your word processor in the Select Features 
dialog:

4.

For Microsoft Word, set Cite While You Write for Microsoft Office to Will be installed on local 
hard drive.

▪

For OpenOffice Writer or LibreOffice, set Extension for OpenOffice and LibreOffice  to Will be 
installed on local hard drive.

▪

Click Next, then continue through the rest of the modified installation.5.

Log in to the machine with administrative rights or as a user with program installation privileges.1.

From the Windows Start menu, select Settings, and then select Apps.2.

Scroll down and click on the EndNote app, then click Modify.3.

Select the Modify radio button, then click Next.4.

Make sure that the appropriate item is selected for your word processor in the Select Features 
dialog:

5.

For Microsoft Word, set Cite While You Write for Microsoft Office to Will be installed on local 
hard drive.

▪

For OpenOffice Writer or LibreOffice, set Extension for OpenOffice and LibreOffice  to Will be 
installed on local hard drive.

▪

Click Next, then continue through the rest of the modified installation.6.

When word processor support is correctly installed, you will see EndNote commands:

On an EndNote 20 tab in Microsoft Word.▪

On an EndNote 20 menu in OpenOffice Writer or LibreOffice▪
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Adding the EndNote Extension (EndNote.oxt) to OpenOffice.org Writer

CWYW Keyboard Commands for Word

It is possible that the appropriate Cite While You Write files were installed for OpenOffice Writer, but the 
extension was not appropriately loaded into Writer.

To load the EndNote extension in Writer:

In OpenOffice Writer, go to the Tools menu and select Extension Manager.1.

Click Add.2.

In the file dialog, navigate to the following folder: 
 
C:\Program Files (x86)\EndNote 20\Product-Support\CWYW

3.

Select the file called EndNote.oxt.4.

Click Open to add the EndNote Cite While You Write extension to the list.5.

Click Close.6.

Exit OpenOffice.org Writer and then restart the program to load the new extension.7.

EndNote commands should appear on an EndNote 20 menu.

These keyboard commands are available when you use Cite While You Write with Microsoft Word. The table 
below shows the initial settings, but you can change the key command assignments. See Keyboard 
Preferences in Microsoft Word.

Note that:

Alt+1 is used for both Return to Word and Go to EndNote. The program determines which 
application is currently active and switches to the other application.

▪

Some of these commands are available from Word and from EndNote.▪

While you can change key assignments, keep in mind that most other key combinations are currently 
already in use in both EndNote and Word.

▪
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Cite While You Write Command Key Command

Go to EndNote Alt+1

Return to Word Alt+1

Find Citation(s) Alt+7

Insert Selected Citation(s) Alt+2

Insert Note Alt+0

Insert Figure(s) None

Update Citations and Bibliography None

Format Bibliography Alt+3

Toggle Instant Formatting None

Configure Instant Formatting None

Group References by Custom 
Categories None

Configure Categories None

Edit Citation(s) Alt+6

Edit Library References Alt+5

Unformat Citations Alt+4

Remove Field Codes None

Export Traveling Library Alt+8

Export Word Citations to EndNote None

Export Word Citations None

Export Word Master List None

Manuscript Matcher None

Cite While You Write Preferences Alt+9

Help None
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I Don't See the Correct EndNote Tab in Word

Bibliography Is in the Wrong Font

If you see an EndNote tab with a more limited set of commands instead of an Endote 20 tab  in Microsoft 
Word, your Application preference has been changed to use an EndNote online library instead of your 
desktop library.

Use the Application tab in the Word Cite While You Write preferences to indicate which version of EndNote 
to use when you use Cite While You Write.

The EndNote 20 tab is for desktop version of the EndNote application.▪

The EndNote tab is for the online version of EndNote.▪

To select the appropriate application:

On the EndNote or EndNote 20 tab in Word, select Preferences.1.

Click the Application tab.2.

Select the appropriate application: EndNote (desktop) or EndNote online.3.

The system adds an EndNote 20 tab to Word's Tabs when you select the EndNote menu option; the system 
adds an EndNote tab when you select the EndNote online menu option.

Note: To use the EndNote online option, you must have created an EndNote account.

When EndNote creates formatted citations and bibliographies, by default it follows the Word Normal style for 
the document in choosing fonts. However, rarely you may see a bibliography appear with an unexpected 
font. This will happen if the last paragraph for the document was set to a style other than Normal before the 
first EndNote citation was inserted.

In a new document, there is no Word style called EndNote Bibliography or EndNote Bibliography Title, and 
no text or additional styles based on them. These Word styles appear in the document after the  first 
EndNote citation is inserted and a bibliography is formatted. The EndNote Bibliography style's font will be 
based on the font used in the last paragraph mark in the document. So,  if I had accidentally set the last 
paragraph in my document to use the Heading 1 style, then inserted my first EndNote citation and formatted 
the bibliography, all the references in my bibliography would be formatting with the font used for the Heading 
1 style.

One workaround for this problem is to transfer your old document to a new one without the EndNote styles 
in it.

Create a new empty document with only one line/paragraph in  it, and be sure that line is set to the 
Normal style. Use the ¶ button in Word to see the paragraph marks in the document; there should be 
only one.

1.

Go back to the original document and copy everything above the bibliography from  the old 
document to the new document. Be very careful not to include any of the bibliography codes when 
you copy to the new document.

2.
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What If Other Formatting Changed?

Garbled ADDIN EN.CITE Code

Paste the old text into the new document.3.

Save the new document with a new name; do not use the name of the orginal document. You may 
still need the original document later.

4.

In the new document, on the EndNote tab, click Update Citations & Bibliography. EndNote will create 
a new bibliography at the end of the document and new EndNote styles for Word based on the 
normal style used for the last paragraph of the new document.

5.

Continue working in the new document as a replacement for the original document.6.

If you had used custom styles in your original document that did not carry over to the new document, you 
can copy them to the new document using Word's Organizer feature.

Close the original document, if it is still open.1.

Make a backup copy of your new document, just in case you run into problems.2.

In the new document, click on the small arrow at the bottom-right corner of the Styles tab to open the 
Styles panel.

3.

Click the Manage Styles button at the bottom of the Styles panel to open the Manage Styles dialog.4.

Click the Import/Export  button at the bottom-left corner of the Manage Styles  dialog to open the 
Organizer.

5.

Click the Close File button underneath the styles list shown for In Normal.dotm at the right.6.

Click the Open File button at the right, locate and open your original document. You should now see 
the list of styles used in your original document on the right side.

7.

Select the styles you want to use from your original document at the right and click the Copy button, 
then confirm the choice to copy the styles. This will copy those styles to the new document, which 
should be showing at the left. Be careful not to copy any style starting with "EndNote."

8.

Close the Organizer.9.

You should now see the same formatting you had for your original document for any styles your copied.

When you insert a citation into a Word document, the citation is embedded in field codes, such as:
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Inserted Citations Disappear, but Reference List is 
Created

Field codes hold reference information for your formatted citations, and are typically hidden. See Field 
Codes in Microsoft Word for more information on field codes.

To hide field codes in Word:

In Word, select Options from the File menu.1.

Click Advanced.2.

Scroll to the Show document content section and clear the box titled Show field codes instead of 
their values.

3.

Click OK.4.

Your citations will now appear correct in the document. Field codes are still there, and are necessary, but 
they are hidden from view.

Note: An easy way to turn field codes on or off is to press Alt+F9.

Most likely, you are formatting with a footnote output style that doesn't include a citation definition, such as 
the Chicago 17th Footnote style. To fix this, format the bibliography with a style that uses in-text citations 
instead of footnotes.

To reformat with a different output style:

On the EndNote 20 tab in Word, click the small arrow at the bottom corner of the Bibliography group. 
 
In OpenOffice Writer, select Format Bibliography from the EndNote menu.

1.
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Word Crashes or Gives an Error When Inserting a Large 
Number of Citations

In the drop-down output style list, select the output style you would like to use. Click the Browse 
button to choose from the list of installed styles. (To add styles, see Installing Additional Output 
Styles.)

2.

Click OK to format the document using the selected style.3.

If you are using an author/year type of output style, and the reference you are citing does not include an 
author or a year, there will be nothing to display in the citation. The citation will not show up, although the full 
form will appear in the reference list at the end of the document.

EndNote uses Word's hidden field codes when formatting citations, and inserts all the reference information 
for all of the grouped citations in these codes. However, there is a limit to the amount of text that Microsoft 
allows in a single set of field codes. You may reach the maximum limit when you attempt to insert 20 or 
more references into a single grouped citation that have extensive information in them (such as large 
abstracts).

To avoid this issue, try not to insert a large group of citations all at once. Instead, insert a small group of 
references, then a space, and then insert another small group of references. This avoids having a single 
group of formatted citations that would exceed Word's field code limitations. When the document is finished, 
you can create a copy of the document with field codes removed and manually adjust the reference to 
remove the spaces. See Removing Field Codes.

Another option is to reduce the amount of text that would be in the field codes by editing the reference(s) to 
remove unnecessary notes or text. For extremely large abstracts, consider moving the abstract to a Word 
document or other text file and attaching that file to the reference. Almost any type of file can be attached to 
an EndNote record, not just PDFs. Attachments are not included in field codes.

When you use Insert Selected Citations, or highlight multiple citations to insert from the Find Citations 
dialog, EndNote limits you to 250 citations in a single group.
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